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1) Clinical Relevance & Summary of Test Principle 
 

a. 
 

Clinical Relevance: 

This method is used to achieve rapid and accurate quantification of fifteen 
elements of toxicological and nutritional interest including Antimony (Sb), Arsenic 
(As), Barium (Ba), Beryllium (Be), Cadmium (Cd), Cesium (Cs), Cobalt (Co), 
Lead (Pb), Manganese (Mn), Molybdenum (Mo), Platinum (Pt), Strontium (Sr), 
Thallium (TI), Tin (Sn), Tungsten (W), and Uranium (U).  The method may be 
used to screen urine when people are suspected to be acutely exposed to these 
elements or to evaluate chronic environmental or other non-occupational 
exposure. [1-4].   
 

b. 
 

Test Principle: 

Inductively coupled plasma dynamic reaction cell mass spectrometry (ICP-DRC-
MS) is a multi-element analytical technique capable of trace level elemental 
analysis [1-4].  This ICP-DRC-MS method is used to measure either arsenic, a 
15 element panel (Antimony, Barium, Beryllium, Cadmium, Cesium, Cobalt, 
Lead, Manganese, Molybdenum, Platinum, Strontium, Thallium, Tin, Tungsten, 
and Uranium), or any subgroup of the 15 element panel. 
 
Liquid samples are introduced into the ICP through a nebulizer and spray 
chamber carried by a flowing argon stream.  By coupling radio-frequency power 
into flowing argon, plasma is created in which the predominant species are 
positive argon ions and electrons and has a temperature of 6000-8000 K.  The 
sample passes through a region of the plasma and the thermal energy atomizes 
the sample and then ionizes the atoms.  The ions, along with the argon, enter the 
mass spectrometer through an interface that separates the ICP (at atmospheric 
pressure, ~760 torr) from the mass spectrometer (operating at a pressure of 10-5 
torr).  The ions pass through a focusing region, the dynamic reaction cell, the 
quadrupole mass filter, and finally are counted in rapid sequence at the detector 
allowing individual isotopes of an element to be determined.  The dynamic 
reaction cell operates in one of two modes.  In ‘standard’ mode the cell is not 
pressurized and ions pass through the cell to the quadrupole mass filter 
unaffected.  In ‘DRC’ mode the cell is pressurized with a gas which will collide or 
react with the incoming ions to either eliminate an interfering ion or change the 
ion of interest to a new mass which is free from interference.  In this method the 
instrument is operated in DRC mode when analyzing for cadmium, manganese 
and arsenic, but in standard mode when analyzing for all of the other analytes.  
For arsenic, the reaction cell is pressurized with a mixture of hydrogen (10%) and 
argon (90%) which causes the breakup of the 40Ar35Cl+ ion which would 
otherwise interfere with detection of 75As at m/z 75.  When analyzing for 
cadmium, the reaction cell is pressurized with oxygen.  The 98Mo16O+ ions which 
would normally interfere with detection of 114Cd at m/z 114 react with the oxygen 
in the cell creating 98Mo16O2

+ and 98Mo16O3
+ at masses which no longer 

represent an interference to 114Cd analysis.  The DRC is also pressurized with 
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oxygen gas when analyzing for 55Mn.  The 39K16O+ ions which would normally 
interfere with the detection of 55Mn at m/z 55 react with the oxygen in the cell and 
no longer represent interference to 55

 

Mn analysis.  Electrical signals resulting 
from the detection of ions are processed into digital information that is used to 
indicate first the intensity of the ions and then the concentration of the element.  
This method was originally based on the method by Mulligan et al. [5].  The DRC 
portions of the method are based on work published by Tanner et al. [2, 3].  Urine 
samples are diluted 1+ 9 with 2% (v/v) concentrated nitric acid (and 1.5% ethanol 
in the case of arsenic).  The diluent for the 15 element panel contains iridium (Ir), 
rhodium (Rh) for multi-internal standardization.  The diluent for arsenic contains 
gallium (Ga) for internal standardization.  Nitric acid is used for the purpose of 
solubilizing and stabilizing metals in solution.  Internal standards are a constant 
concentration in all blanks, calibrators and samples.  Monitoring the instrument 
signal ratio of a metal to its internal standard allows correction for instrument 
noise and drift, and sample-to-sample matrix differences.  Ethanol is used in the 
case of arsenic for the purpose of providing a constant amount of signal 
enhancement (carbon effect) across all blanks, calibrators, and samples.  

2) Limitations of Method; Interfering Substances and Conditions 
 

a. 
 

Interferences Addressed by This Method 

i. Breakup of Argon Chloride (40Ar35Cl) Interference on Arsenic (75As) Using 
DRC:  The dynamic reaction cell of the ELAN ICP-DRC-MS is used in this 
method to break apart the argon chloride (40Ar35

 

Cl) interference on arsenic at 
m/z 75 [6] which is common to urine analysis by ICP-MS (see Section 1.b for 
an explanation of this process). 

ii. Correction & Elimination of Interferences (114Sn, 98Mo16O) on Cadmium (114

 
Cd). 

1. Mathematical Correction for Tin (114Sn) Interference
The correction equation (-0.026826*Sn118) is used in the “Equations” tab 
of the method to correct the counts observed as m/z 114 to exclude counts 
due to 

:                          

114

 
Sn. 

2. Elimination of Molybdenum Oxide (98Mo16

The dynamic reaction cell of the ELAN ICP-DRC-MS is used in this 
method to eliminate interference from molybdenum oxide (

O) Interference Using DRC: 

98Mo16

 

O) onto 
cadmium at m/z 114 [7].  See Section 1.b for an explanation of this 
process. 

iii. Elimination of interference (39K16O) on manganese 55Mn using DRC
The dynamic reaction cell of the ELAN ICP-DRC-MS is used in this method to 
reduce the potassium oxide (

: 

39K16

 

O) interference on manganese at m/z 55.  
See section 1.b for an explanation of this process. 

iv. Matrix Enhancement of Arsenic Signal: 
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Matrix induced signal enhancement in ICP-MS analysis from carbon on arsenic 
has been previously reported in the literature [8, 9]. When arsenic is being 
determined by this method, ethanol (1.5% v/v) is added in the diluent and rinse 
solutions to “normalize” the arsenic signal enhancement in all blanks, 
calibrators, and samples.   
 

b. 
 

Limitations of Method (Interferences Remaining in Method) 

i. Calcium Chloride (40Ca35Cl) Interference on Arsenic (75

It has been determined that a small interference remains at m/z 75 when the 
urine matrix contains both high chloride and high calcium levels [6].  Even at 
extreme calcium and chloride levels, this interference is has not been found to 
be significant (approximately 0.4 µg/L).   

As): 

 
ii. Gallium Oxide (71Ga17O) Interference on Strontium (88

Arsenic only analysis requires Ga to be used as the internal standard and is 
added to the diluent at a concentration of 10 ug/L (see section 6.c for the 
preparation of diluent).  Gallium should not be added to the diluent (for the 
purpose of being used as an internal standard for As) when strontium is 
measured (15 element panel) due to the formation of 

Sr): 

71Ga17O+, which occurs 
at the same m/z as 88Sr+.  A 5 ug/L solution of Ga in 2% HNO3 resulted in a 
background equivalent concentration (BEC) of 50 ng/L for 88Sr.  Based on 
these results, the expected increase in 88

 

Sr concentration in a diluted urine 
sample is 1 ug/L.    

3) Procedures for Collecting, Storing, and Handling Specimens; Criteria for 
Specimen Rejection; Specimen Accountability and Tracking 
 
a. Procedures for Collecting, Storing, and Handling Specimens:  Specimen handling 

conditions, special requirements, and procedures for collection and transport are 
discussed in the division (DLS) Policies and Procedures Manual [10].  Copies are 
available in branch, laboratory, and special activities specimen-handling offices.  
An electronic copy is available at:          
 
http://intranet.nceh.cdc.gov/dls/pdf/policiesprocedures/Policy_and_Procedures_
Manual.DLS.2002mod.pdf.  In general, 

 
i. No fasting or special diets are required before collection of urine. 
 

ii. Use sterile, lot screened collectors for specimen acquisition. 
 

iii. Urine specimens should be transported frozen (packed in dry ice during 
shipment is preferred when possible). 

 
iv. Once received, store long term at ≤ -20°C until time for analysis.  Short-term 

storage at 2-4°C is acceptable.  Refreeze at ≤ -20°C portions of the sample 

http://intranet.nceh.cdc.gov/dls/pdf/policiesprocedures/Policy_and_Procedures_Manual.DLS.2002mod.pdf�
http://intranet.nceh.cdc.gov/dls/pdf/policiesprocedures/Policy_and_Procedures_Manual.DLS.2002mod.pdf�
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that remain after analytical aliquots are withdrawn.  Thawing and refreezing 
samples has not been found to compromise sample results. 

 
v. Acceptable containers for analytical aliquots include lot screened 

polypropylene (PP) cryovials or tubes (i.e. 5 mL cryogenic vial or 15mL 
centrifuge tube).  

 
b. Criteria for Specimen Rejection

 

:  Specimen characteristics that may compromise 
test results are indicated above.  Reasons for rejection of a sample for analysis 
include 

i. Low volume:  Optimal amount of urine is 1.8+ mL.  The volume of urine used 
for one analysis is 0.5 mL. 

 
ii. Contamination:  Improper collection procedures or collection devices can 

contaminate the urine by contact with dust, dirt, etc. 
 

In all cases, request a second urine specimen.   
 

c. Transfer or Referral of Specimens; Procedures for Specimen Accountability and          
Tracking

 

:  Location, status, and final disposition of the specimens will be tracked 
at least by paper document in the “Study Folder” (created before analysts receive 
the samples).  Apart from this specimen tracking form, this folder will also contain 
the paper print outs of results from analysis of the specimens.  Maintain records 
for a minimum of 3 years.  Use only numerical identifiers for samples within the 
laboratory (e.g., case ID numbers) in order to safeguard confidentiality.  Only the 
medical supervisor (MS) or project coordinator (PC) i.e. non CDC personnel 
should have access to the personal identifiers. 

4) Safety Precautions 
 

a. 
 

General Safety 

i. Observe all safety regulations as detailed in the Division (DLS) Safety Manual.  
Additional information can be found in your lab’s chemical hygiene plan. 

 
ii. Observe Universal Precautions when working with urine. 

 
iii. Wear appropriate gloves, lab coat, and safety glasses while handling all 

solutions.   Consult the laboratory chemical hygiene plan. 
 

iv. Exercise special care when handling and dispensing concentrated nitric acid.  
Add acid to water.  Nitric acid is a caustic chemical that is capable of causing 
severe eye and skin damage.  If nitric acid comes in contact with any part 
of the body, quickly wash the affected area with copious quantities of 
water for at least 15 minutes. 
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v. Use secondary containment for containers of biological or corrosive liquids. 
 

vi. The use of the foot pedal on the Micromedic Digiflex™ is recommended 
because it reduces analyst contact with work surfaces that have been in 
contact urine and also keeps the analyst’s hands free to hold the specimen 
cups and autosampler tubes and to wipe off the tip of Micromedic Digiflex™. 

 
vii. Training will be given before operating the ICP-DRC-MS, as there are many 

possible hazards including ultraviolet radiation, high voltages, radio-frequency 
radiation, and high temperatures. This information is also detailed in the 
PerkinElmer ELAN® ICP-DRC-MS System Safety Manual.   
 

viii. Use flash arrestors on oxygen and argon / hydrogen gas cylinders and properly 
secure gas cylinders with safety harnesses. 

 
ix. Wipe down all work surfaces at the end of the day with bleach-rite spray or 

freshly prepared 10% (v/v) sodium-hypochlorite solution.   
 

b. Radiation Safety

 

:  All personnel performing this method must successfully meet 
requirements of a CDC-OHS radiation worker (RW) due to the use of natural 
uranium in this method and observe all necessary radiation safety considerations 
indicated in the CDC Radiation Safety Manual [11]. 

c. Waste Disposal

 

:  Operators of this method should take the CDC-OHS Hazardous 
Chemical Waste Management Course (initial and yearly refreshers). 

i. 
 
Waste to be Placed Into Biohazard Autoclave Bags & Pans:   

1. All biological samples and diluted specimens (after analysis run).  
 
2. All disposable plastic and paper which contact urine (autosampler tubes, 

gloves, etc.).   
 
3. Used non-glass/quartz ICP-MS consumables (i.e. probes, tubing, cones, 

ion lenses). 
 

ii. Waste to be Placed Into Sharps Containers:

 

  Pipette Tips, broken glass or 
quartz instrument consumables (broken spray chambers, torches, nebulizers, 
etc. . .).  Large broken glass which will not fit in the sharps container should be 
placed in a separate autoclave pan from other waste and labeled as “broken 
glass” (see the “Autoclaving” section of the CDC safety policies and practices 
manual located in the laboratory). 

iii. 
 

Liquid Waste 



Urine Multi-Element ICP-DRC-MS                                                     Page    12 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

1. Waste discarded down sink

 

:  Only liquid waste from the ICP-DRC-MS 
instrument can be discarded at the sink.  Flush the sink with copious 
amounts of water. 

2. Waste to be Picked up by the Radiation Safety Office

 

:  Contact the 
laboratory radiation inventory person and the CDC Radiation Safety Office 
for disposal of any single element uranium standard, intermediate stock 
standard, or intermediate working standard solutions. 

3. Waste to be Picked up by Hazardous Waste Program

 

: Submit request for 
hazardous waste removal of all other liquid waste. 

 
5) Instrument & Material Sources 

 
a. 

 
Sources for ICP-MS Instrumentation 

i. ICP-MS:  Inductively Coupled Plasma Dynamic Reaction Cell Mass 
Spectrometer (ELAN® 6100 DRCPlus or ELAN® DRC II) (PerkinElmer Norwalk, 
CT, www.perkinelmer.com).  

 
1. DXi-FAST upgrade

 

: Standard peristaltic pump replaced by DXi_FAST 
micro-peristaltic pump / FAST actuator and valve combination unit.  For 
ELAN DRCII, part # DXI-54-P4-F6.  

ii. Recirculating chiller / heat exchanger for ICP-MS:  Refrigerated chiller 
(PolyScience 6105PE for ELAN® 6100 DRCPlus instruments) or heat exchanger 
(PolyScience 3370 for ELAN® DRC II instruments) (PerkinElmer Norwalk, CT, 
www.perkinelmer.com). 

 
iii. Autosampler

 

: ESI SC-4 autosampler (Elemental Scientific Inc., Omaha, NE) or 
equivalent. 

iv. 
 

FAST Sample Introduction System (Elemental Scientific Inc., Omaha, NE). 

1. 
2. 

FAST controller  
FAST actuator:

 

 CTFE high-flow valve head like part number SC-0599-1210 
(part number includes lines and probes). 

b. 
 
Sources for ICP-MS Parts & Consumables 

NOTE:

 

  The minimum number of spares recommended before reordering (if 
owning one instrument) are listed as “# Spares =” in the descriptions below.   

i. Adapter, PEEK:  Securely connects 1.6mm O.D. PFA tubing to 0.03” I.D. 
peristaltic tubing.  Composed of three PEEK parts.   

http://www.perkinelmer.com/�
http://www.perkinelmer.com/�


Urine Multi-Element ICP-DRC-MS                                                     Page    13 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

1. Female nut for 1.6mm O.D. (1/16”) tubing.  Like part P-420 (Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com). 

2. PEEK ferrule.  Like part P-260x (10pk SuperFlangeless ferrule, Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com).   

3. Conical Adapter Body.  Like part P-692 (Upchurch Scientific, Oak Harbor, 
WA, www.upchurch.com). 

ii. Bottles (for rinse solution): Four liter screw-cap polypropylene container with 2 
luer connections (like catalog# SC-0305-1, Elemental Scientific Inc., Omaha, 
NE., www.elementalscientific.com). 

iii. Carboy and cap assembly for waste collection: 10-15 L, polypropylene 
widemouth carboy (100 mm neck size) with handles and no spigot (Like part 
#7BE-25126, Lab Safety Supply, Janesville, WI, www.lss.com) with cap 
assembly like part # N0690271 (PerkinElmer, Norwalk, CT, 
www.perkinelmer.com). 

iv. Coolant, for Polyscience chiller or heat exchanger:  Only PerkinElmer part # 
WE01-6558 (PerkinElmer Norwalk, CT, www.perkinelmer.com) is approved for 
use by PerkinElmer.  # Spares = 6. 

v. Cone, sampler (nickel/platinum):  PerkinElmer part # WE021140/WE027802 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Part # SC2011-Ni (Testing 
has also found Spectron, Ventura, CA, www.spectronus.com cones to be 
comparable).  # Spares = 4. 

vi. Cone, skimmer (nickel/platinum):  PerkinElmer part # WE021137/WE027803 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Part # SC2012-Ni (Testing 
has also found Spectron, Ventura, CA, www.spectronus.com cones to be 
comparable)  # Spares = 4. 

vii. Connector (for tubing):  Use to connect 1/8” I.D. PVC tubing to 0.125” I.D 
peristaltic pump tubing.  Use part # 3140715 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 4. 

viii. Detector, electron multiplier:  Like part # N8125001 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  Available direct from manufacturer (part # 14210, 
SGE Incorporated, Austin, Texas, http://www.etpsci.com) or various 
distributors.  # Spares = 1. 

ix. 
1. 

FAST accessories 
Valve: CTFE High-flow valve head for SC-FAST (uses ¼-28 fittings).  Like 
part # SC-0599-1010 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

2. Stator:  CTFE Stator for 6 port SC-FAST high flow valve (¼-28 fittings).  
Like part # SC-0599-1010-01 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

3. Rotor:  Composite rotor for 6 port SC-FAST high flow valve (¼-28 fittings). 
Like part # SC-0599-1010-05 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

http://www.upchurch.com/�
http://www.upchurch.com/�
http://www.upchurch.com/�
http://www.elementalscientific.com/�
http://www.lss.com/�
http://www.perkinelmer.com/�
http://www.perkinelmer.com/�
http://www.spectronus.com/�
http://www.perkinelmer.com/�
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4. Sample Loop
a. Multielement analysis: 3 mL Teflon, white connector-nuts for high flow 

valve head.  Like part # SC-0315-30 (Elemental Scientific Inc., Omaha, 
NE., 

:  

www.elementalscientific.com). 
b. Arsenic only analysis:  Default volume is 1.5mL Teflon sample loop 

with white nut connectors for high flow valve head of FAST sample 
introduction system. This volume loop can be created by cutting 25% 
off the length of a 2mL Teflon sample loop was cut to the 1.5mL length. 
Like part # SC-0315-20 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com).  Volumes larger than 1.5mL can be 
used, but will require longer loop fill (ESI software) and sample flush 
(ELAN software) times, and proportionally larger volumes used in 
sample preparation (Table 7 in the Appendix). 

5. Probe, Autosampler:  Teflon, carbon fiber support, 0.8mm i.d., blue marker, 
1/4-28 fittings.  Like part number SC-5037-3751 (Elemental Scientific Inc., 
Omaha, NE., www.elementalscientific.com).  # Spares = 2. 

6. Probe, Carrier Solution: Teflon, carbon fiber support, 0.5mm i.d., orange 
marker, 1/4-28 fittings. Like part number SC-5037-3501 (Elemental 
Scientific Inc., Omaha, NE., www.elementalscientific.com).  # Spares = 2. 

7. Tubing, FAST vacuum:  Vacuum line for SC-FAST high flow valve, 
connects to port #6, black nut for connection to valve head, natural brown 
color nut on other end for connection to SC autosampler vacuum port.  Like 
part # SC-0321 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

8. Tubing, connects nebulizer to valve

x. 

:  See “Nebulizer, PolyPro-ST micro 
flow” 

Hose, for connection to chiller:  Push on hose.  I.D. = ½”, O.D. = ¾”.  Use part 
# PB-8 (per inch, Georgia Valve and Fitting, Atlanta, GA, www.swagelok.com) 
or equivalent.  Do not normally need spare hose (unless moving instrument 
into a new location). 

xi. Hose, for exhaust of ELAN:  Available as part of ELAN installation kit from 
Perkin Elmer (PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available 
direct from manufacturer as part # S-LP-10 air connector (Thermaflex, 
Abbeville, SC, www.thermaflex.net).  Equivalent part may be substituted.  # 
Spares = 10 feet of 4” diameter and 10 feet of 6” diameter hose.   

xii. Injector, quartz with ball joint:  I.D. = 2.0 mm.  PerkinElmer part # WE023948 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available direct from 
manufacturer as part # 400-30 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or from various distributors.  # Spares = 2. 

xiii. Injector support (for pass-through injector: PerkinElmer part # WE023951 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available direct from 
manufacturer as part # 400-37 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or from various distributors.  # Spares = 2. 

http://www.elementalscientific.com/�
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xiv. Ion Lens:  PerkinElmer part # WE018034 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  # Spares = 3. 

xv. Nebulizer:  PolyPro-ST micro flow polypropylene nebulizer with external 1/4-28 
threaded connector for liquid delivery, low pressure version or equivalent. Like 
part # ES-4040-7010 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com).  # Spares = 1.  Different nebulizers may be 
used, however, the nebulizer gas flow rate, sample flush time, read delay time, 
loop fill time, loop size, urine sample dilution preparation volume, and sample-
to-sample carry-over must be evaluated and optimized. 

1. Gas connection
a. 

: 
Teflon tubing: 4mm o.d., 2.4mm i.d. Teflon tubing (like part # ES-
2502, Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com).  # Spares = 1.   

b. Adapter kit: Plastic adapters to connect Teflon tubing (2.4mm i.d) to 
¼” male Swagelok (compression) port on ICP-DRC-MS.  Parts can 
be obtained as components in a “gas fittings kit for microflow 
nebulizer”, kit part # ES-2501-1000, Elemental Scientific Inc., 
Omaha, NE., www.elementalscientific.com).  # Spares = 1. 

2. Liquid connection:  Connects nebulizer to port #3 of high flow FAST valve 
head with green, 1/4- 28 fitting.  Like part # SC-0317-0250 (Elemental 
Scientific Inc., Omaha, NE., www.elementalscientific.com). # Spares = 2. 

xvi. Nut: (for flanged connections of 1.59mm (1/16”) o.d. PFA tubing) Flanged, for 
1/16” o.d. tubing, 1/4-28 threads.   Use part # P-406x (pkg. of 10, Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com) or equivalent.  Use a Teflon-
coated Viton o-ring with this nut instead of the stainless steel washer that 
comes with part # P-406x). # Spares = 10. 

xvii. Nut and Ferrule set, 1/8” Swagelok:  Such as part # SS-200-NFSET (stainless 
steel) or part # B-200-NFSET (brass) (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  For part numbers listed here a quantity of 1 
means 1 nut, 1 front ferrule, and 1 back ferrule.  Spares = 20. 

xviii. Nut and Ferrule set, 1/4” Swagelok:  Such as part # SS-400-NFSET (stainless 
steel) or part # B-400-NFSET (brass) (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  For part numbers listed here a quantity of 1 
means 1 nut, 1 front ferrule, and 1 back ferrule.  Spares = 20. 

xix. Oil, Welch Directorr Gold:  For roughing pumps.  Available direct from 
manufacturer as part # 8995G-15 (1 gallon, Welch Rietschle Thomas, Skokie, 
IL, www.welchvacuum.com) or from various distributors.  Equivalent oil may be 
substituted.  # Spares = 4. 

xx. O-ring: (for sampler cone) PerkinElmer part # N8120511 (pkg. of 5, 
PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 20 
o-rings. 
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xxi. O-ring: (for skimmer cone) PerkinElmer part # N8120512 (pkg. of 5, 
PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 20 
o-rings. 

xxii. O-ring: (for flanged connections of 1.59mm (1/16”) o.d. PFA tubing) Teflon-
coated Viton o-ring, i.d. = 1/16", thickness = 1/16”, o.d. = 3/16”.  Such as part # 
V75-003 (O-rings West, Seattle, WA, www.oringswest.com) or equivalent. # 
Spares = 20. 

xxiii. O-ring
1. 

:  (for injector support).  
Internal o-rings:  ID = ¼”, OD = 3/8”, thickness = 1/16”.  Need 2 o-rings per 
injector support setup.  PerkinElmer part # N8122008 (PerkinElmer, 
Shelton, CT, www.perkinelmer.com) or equivalent (such as part # V75-010, 
O-rings West, Seattle, WA, www.oringswest.com).  # Spares = 20. 

2. External o-rings:  ID = 3/8”, OD = 1/2”, thickness = 1/16”.  Need 2 o-rings 
for each injector support setup.  PerkinElmer part # N8122009 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent (such as 
part # V75-012, O-rings West, Seattle, WA, www.oringswest.com).  # 
Spares = 20. 

xxiv. O-ring:  (for inside spray chamber at nebulizer port) Such as part # 120-56 
(Precision Glass Blowing, Centennial, CO, www.precisionglassblowing.com).  
Additional o-rings can sometimes be obtained free of charge or at reduced 
price when acquired while purchasing spray chambers.  # Spares = 20. 

xxv. O-ring:  (for inside of torch mount):  Part # WE017284 (PerkinElmer, Shelton, 
CT, www.perkinelmer.com).  Do not substitute.  The PerkinElmer o-ring is 
specially metal impregnated to minimize RF leakage though the torch mount.   
# Spares = 2. 

xxvi. Photon Stop:  PerkinElmer part # WE018278 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  # Spares = 1. 

xxvii. Plugs, Quick Change for Roughing Pump Oil:  These plugs will only work on 
the Varian roughing pumps which come standard on ELAN DRC II ICPMS 
instruments.  These plugs will not fit the Leybold pumps which come standard 
on the ELAN DRC Plus instruments.  Part # W1011013 (PerkinElmer, Shelton, 
CT, www.perkinelmer.com).  No spares typically needed. 

xxviii. 
1. 

Probes 
for ESI autosampler:   Teflon, carbon fiber support, 0.8mm i.d., blue 
marker, 1/4-28 fittings.  Like part number SC-5037-3751 (Elemental 
Scientific Inc., Omaha, NE., www.elementalscientific.com).  # Spares = 2. 

2. for carrier solution of FAST sample introduction system: Teflon, carbon 
fiber support, 0.5mm i.d., orange marker, 1/4-28 fittings. Like part number 
SC-5037-3501 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com).  # Spares = 2. 

xxix. RF coil.  PerkinElmer part # WE02-1816 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 2. 
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xxx. Screw, for Torch Mount:  PerkinElmer part # WE011870. (PerkinElmer, 
Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 3. 

xxxi. Spray chamber, quartz concentric:  PerkinElmer part # WE025221 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  Available 
direct from manufacturer as part # 400-20 (Precision Glass Blowing, 
Centennial, CO, www.precisionglassblowing.com) or from various distributors.  
# Spares = 2. 

xxxii. Torch, quartz:  PerkinElmer part # N812-2006 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  Available direct from manufacturer as 
part # 400-10 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or various distibutors.  Damaged torches can 
often be repaired for substantially lower cost than purchasing a new one by 
companies such as Wilmad LabGlass (Buena, NJ, www.wilmad-labglass.com) 
or Precision Glass Blowing (Centennial, CO, www.precisionglassblowing.com).   
# New Spares = 2. 

xxxiii. Tubing and adapter, for SC autosampler rinse station drain:  Tygon tubing and 
adapter to attach to back of SC autosampler for draining rinse station waste 
(like part # SC-0303-002, Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

xxxiv. Tubing and adapters, for SC autosampler rinse station filling:  Teflon tubing 
and adapters (to attach to back of SC autosampler for filling rinse stations and  
to attach to rinse containers).  Like part # SC-0302-0500, Elemental Scientific 
Inc., Omaha, NE., www.elementalscientific.com). 

xxxv. Tubing and nut, for FAST carrier solution:  0.5mm i.d. Teflon tubing (orange 
marker) with red ¼-28 male nut.  Connects to high flow FAST valve head, port 
#2.  Like part # SC-0316-0500 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

xxxvi. Tubing, FAST vacuum:  Vacuum line for SC-FAST high flow valve, connects to 
port #6, black nut for connection to valve head, natural brown color nut on 
other end for connection to SC autosampler vacuum port.  Like part # SC-0321 
(Elemental Scientific Inc., Omaha, NE., www.elementalscientific.com). 

xxxvii. Tubing, main argon delivery to instrument:  I.D. = 1/8”, O.D. = ¼”.  Such as part 
# C-06500-02 (pkg. of 100ft, polypropylene, Fisher Scientific International, 
Hampton, NH, www.fishersci.com) or equivalent.  # Spares = 50ft. 

xxxviii. Tubing, PFA:

The Perfluoroalkoxy (PFA) copolymer is a form of Teflon

  I.D. = 0.5mm, O.D. = 1.59mm (1/16”).  Used to transfer liquid 
between rinse solution jug and peristaltic pump tubing 

®.  Such as part # 
1548 (20ft length, Upchurch Scientific, Oak Harbor, WA, www.upchurch.com) 
or equivalent.  # Spares = 20ft. 

xxxix. Tubing, peristaltic, 0.045” i.d. (rinse station feed): Standard PVC, 2-stop (red / 
red) peristaltic pump tubing, i.d. = 0.045”. PerkinElmer part # N0680375, 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 6 
packs of 12 tubes. 
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xl. Tubing, peristaltic, 0.03” i.d. (carrier solution for ESI autosampler)
1. Standard PVC, 2-stop (black / black) peristaltic pump tubing, i.d. = 0.03”. 

PerkinElmer part # 09908587 (PerkinElmer, Shelton, CT, 

: use either 

www.perkinelmer.com) or equivalent.  # Spares = 6 packs of 12 tubes. 
2. Standard PVC, 3-stop (black/ black/black) peristaltic pump tubing, i.d. 0.76 

mm.  Spectron part # SC0056 (Spectron, Ventura, CA, 
www.spectronus.com) or equivalent.  #Spares = 6 packs of 12 tubes.  Use 
this type of tubing with ESI DXi micro-peristaltic pump. 

xli. Tubing, peristaltic, 0.125” i.d. (spray chamber drain)
1. Standard PVC, 2-stop (black / white) peristaltic pump tubing, i.d. = 0.125” 

or equivalent.  PerkinElmer part # N812-2012 (PerkinElmer, Shelton, CT, 

: use either 

www.perkinelmer.com) or equivalent.  # Spares = 6 packs of 12 tubes. 
2. Standard Santoprene, 3-stop (grey/ grey/ grey) peristaltic pump tubing, i.d. 

1.30 mm.  Spectron part # SC0311 (Spectron, Ventura, CA, 
www.spectronus.com) or equivalent.  #Spares = 6 packs of 12 tubes.  Use 
this type of tubing with ESI DXi micro-peristaltic pump. 

xlii. Tubing, PVC, i.d. = 1/8”, o.d. = 3/16”
1. between spray chamber waste port and peristaltic pump 

.  May be used to transfer liquid 

2. between peristaltic pump and liquid waste jug 
Like part # 14-169-7A (pkg. of 50ft, Fisher Scientific International, Hampton, 
NH, www.fishersci.com) or equivalent.  # Spares = 20ft. 

xliii. Tubing, Stainless Steel, o.d. = 1/8”, wall thickness = 0.028”:  Used to connect 
DRC gas cylinders to ELAN DRC gas ports.  Also used to replace plastic 
tubing in the DRC gas path within the ELAN.  Like part # SS-T2-S-028-20 (20ft, 
Georgia Valve and Fitting, Atlanta, GA, www.swagelok.com) or equivalent.  
Spares = 20ft. 

xliv. Tubing, Teflon, corrugated, ¼” o.d.:  Connects to the auxiliary and plasma gas 
side-arms of the torch.  Part # WE015903 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  # Spares = 2.   

xlv. Tubing, vinyl (argon delivery to nebulizer):  Vinyl Tubing, 1/8" ID x 1/4" OD.  
Like part # EW-06405-02 (Cole Parmer, Vernon Hills, Illinois, 
www.coleparmer.com) or equivalent.  Equivalent tubing material may be 
substituted.  # Spares = 10ft. 

xlvi. Union Elbow, PTFE ¼” Swagelok:  Connects argon tubing to torch auxiliary 
gas sidearm on bayonet mount ELAN ICPMS instruments.  Like part # T-400-9 
(Georgia Valve and Fitting, Atlanta, GA, www.swagelok.com) or equivalent.  
Spares = 2. 

xlvii. Union Tee, PTFE, ¼” Swagelok:  Connects argon tubing to torch plasma gas 
sidearm and holds igniter inside torch sidearm on bayonet mount ELAN ICPMS 
instruments.  Like part # T-400-3 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  Spares = 2. 
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c. 

i. 
Sources for ICP-MS Maintenance Equipment & Supplies 

Anemometer: Like digital wind-vane anemometer (Model 840032, SPER 
Scientific LTD., Scottsdale, AZ, www.sperscientific.com) or equivalent.  Use to 
verify adequate exhaust ventilation for ICP-MS (check with hoses fully 
disconnected). 

ii. Pan, for changing roughing pump oil: Like part # 53216 (United States Plastics 
Corporation, Lima, OH, www.usplastic.com) or equivalent.  # On hand = 1. 

iii. Container, to hold acid baths for glassware

iv. 

:  Polypropylene or polyethylene 
containers with lids (must be large enough for torch, injector, or spray chamber 
submersion).  May be purchased from laboratory or home kitchen supply 
companies.  # On hand = 4.  
Cotton swabs

v. 
:  Any vendor.  For cleaning of cones and glassware. 

Cutter (for 1/8” o.d. metal tubing):  Terry tool with 3 replacement wheels.  Like 
part # TT-1008 (Chrom Tech, Inc., Saint Paul, MN, www.chromtech.com) or 
equivalent. 

vi. Getter Regeneration Kit: Part # WE023257 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  Use this as needed (at least annually) to clean the 
getter in the pathway of channel A DRC gas.   

vii. Magnifying glass:  Any 10x + pocket loupe for inspection of cones and other 
ICP-MS parts.  Plastic body is preferred for non-corrosion characteristics.  Like 
part # 5BC-42813 (Lab Safety Supply, Janesville, WI, www.labsafety.com). 

viii. Screw Driver, for Ion Lens Removal:  Screw driver with long, flexible shaft, and 
2mm ball-Allen end for removal of ion lens screws (if lens is not in quick-
release mount), part # W1010620.  Extra 2mm bits, part # W1010598 
(PerkinElmer, Shelton, CT, www.perkinelmer.com). 

ix. Toothbrush
x. 

:  Any vendor.  For cleaning ion lens and glassware. 
Ultrasonic bath: Like ULTRAsonik™ Benchtop Cleaners (NEYTECH, 
Bloomfield, CT, www.neytech.com) or equivalent. 

d. 
i. 
Sources for General Laboratory Consumable Supplies 

Bar Code Scanner:  Like Code Reader 2.0 (Code Corporation, Draper, UT, 
www.codecorp.com) or equivalent.  For scanning sample IDs during analysis 
setup.  Any bar code scanner capable of reading Code 128 encoding at a 3 mil 
label density can be substituted. 

ii. Carboy (for preparation of urine quality control pool and waste jug for ICPMS 
sample introduction system):  Polypropylene 10-L carboy (like catalog # 02-
960-20C, Fisher Scientific, Pittsburgh, PA, www.fischersci.com) or equivalent.  
Carboys with spouts are not advised due to potential for leaking. 

iii. Containers for diluent and Rinse Solution:  Two liter Teflon™ containers (like 
catalog# 02-923-30E, Fisher Scientific, Pittsburgh, PA., www.fishersci.com) 
and 4L polypropylene jugs (like catalog# 02-960-10A, Fisher Scientific, 

http://www.sperscientific.com/�
http://www.usplastic.com/�
http://www.chromtech.com/�
http://www.perkinelmer.com/�
http://www.labsafety.com/�
http://www.perkinelmer.com/�
http://www.codecorp.com/�
http://www.fischersci.com/�


Urine Multi-Element ICP-DRC-MS                                                     Page    20 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

Pittsburgh, PA, www.fishersci.com) have both been used. Acid rinse before 
use.  Equivalent containers may be substituted. 

iv. Cups for urine collection:  Like polypropylene 4.5 oz cup, catalog # 354013 
(Becton Dickinson Labware, Franklin Lakes, NJ, www.bd.com) or equivalent.  
Each lot of cups used must be lot screened (tested to be free of trace metal 
contamination).  Clear plastics tend to have lowest trace metal contamination. 

v. Gloves

vi. 

:  Powder-free, low particulate nitrile (like Best CleaN-DEX™ 100% 
nitrile gloves,  any vendor).  Equivalent nitrile or latex gloves may be 
substituted. 
Paper towels:  For general lab use, any low-lint paper wipes such as 
KIMWIPES®EX-L Delicate Task Wipers or KAYDRY®EX-L Delicate Task 
Wipers (Kimberly-Clark Professional, Atlanta, GA, www.kcprofessional.com).  
For sensitive applications in cleanrooms, a wipe designed for cleanroom use 
may be desired such as the Econowipe or Wetwipe (Liberty, East Berlin, CT, 
www.liberty-ind.com). 

vii. Pipette (for preparation of urine dilutions to be analyzed): Micromedic Digiflex-
CX Automatic™ pipette equipped with 10.0-mL dispensing syringe, 2 mL 
sampling syringe, 0.75-mm tip, and foot pedal (Titertek, Huntsville, AL, 
http://www.titertek.com/).   

viii. Pipettes (for preparation of intermediate stock working standards & other 
reagents):  Like Brinkmann Research Pro Electronic pipettes (Brinkmann 
Instruments, Inc., Westbury, NY, http://www.brinkmann.com/home/).  5-100 µL 
(catalog #4860 000.070), 20-300 µL (catalog #4860 000.089), 50-1000 µL 
(catalog #4860 000.097), 100-5000 µL (catalog #4860 000.100).  Note:  pipette 
catalog numbers are without individual chargers.  Can purchase individual 
chargers (pipette catalog numbers will differ) or a charging stand that will hold 
four pipettes (catalog #4860 000.860).  When purchasing pipette tips (epTips), 
purchase one or more boxes, then “reloads” for those boxes after that:  5-100 
µL (box catalog # 22 49 133-4, reload catalog # 22 49 153-9), 20-300 µL (box 
catalog # 22 49 134-2, reload catalog # 22 49 154-7), 50-1000 µL (box catalog 
# 22 49 135-1, reload catalog # 22 49 155-5), 100-5000 µL (box catalog # 22 
49 138-5, reload catalog # 22 49 198-9, bulk bag catalog # 22 49 208-0).  
Equivalent pipettes and tips can be substituted. 

ix. Tubes for sample analysis (for autosampler):  Like polypropylene 15-mL 
conical tubes, BD Falcon model #352097 (Becton Dickinson Labware, Franklin 
Lakes, NJ, www.bd.com).  Equivalent tubes may be substituted which are 
shown by lot screening to be free of trace metal contamination.  Clear plastics 
tend to have lowest trace metal contamination.  Blue colored caps have also 
been used successfully for this method. 

x. Tubes for storage of intermediate working stock standards:  Like polypropylene 
50-mL conical tubes, BD Falcon model #352098 (Becton Dickinson Labware, 
Franklin Lakes, NJ, www.bd.com).  For use in storage of intermediate working 
stock standards.  Equivalent tubes may be substituted which are shown by lot 
screening to be free of trace metal contamination. Clear plastics tend to have 
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lowest trace metal contamination.  Blue colored caps have also been used 
successfully for this method. 

xi. Vortexer:  Like MV-1 Mini Vortexer (VWR, West Chester, PA, www.vwr.com).  
Used for vortexing urine specimens before removing an aliquot for analysis.  
Equivalent item can be substituted. 

xii. Water purification system:  Like NANOpure DIamond Ultrapure Water System 
(Barnstead International, Dubuque, Iowa, www.barnstead.com).  For ultra-pure 
water used in reagent and dilution preparations.  An equivalent water 
purification unit capable of producing >18 Mega-ohm·cm water may be 
substituted. 

 
e. 

i. 
Sources of Chemicals, Gases, and Regulators 

Acid, Hydrochloric acid:  Veritas™ double-distilled grade, 30-35% (GFS 
Chemicals Inc. Columbus, OH, www.gfschemicals.com).  This is referred to as 
“concentrated” hydrochloric acid in this method write-up.  For use in 
preparation of intermediate working stock standards.  An equivalent 
hydrochloric acid product may be substituted, but it must meet or exceed the 
purity specifications of this product for trace metals content. 

ii. Acid, Nitric acid: Veritas™ double-distilled grade, 68-70% (GFS Chemicals Inc. 
Columbus, OH, www.gfschemicals.com).  For use in diluent, rinse solution, 
intermediate working stock standards, and QC pool preparations.  This is 
referred to as “concentrated” nitric acid in this method write-up.  An equivalent 
nitric acid product may be substituted, but it must meet or exceed the purity 
specifications of this product for trace metals content. 

iii. Ethanol (EtOH):

iv. 

 USP dehydrated 200 proof (Pharmco Products, Inc.) or 
equivalent. 
Argon Gas (for plasma & nebulizer) and Regulator:  High purity argon 
(>99.999% purity, Specialty Gases Southeast, Atlanta, GA, www.sgsgas.com) 
for torch and nebulizer.  Minimum tank source is a dewar of liquid argon (180-
250L).  Bulk tank (1500+

1. 
L is preferred). 

Regulator for argon (at dewar):  Stainless steel, single stage, specially 
cleaned regulator with 3000 psig max inlet, 0-100 outlet pressure range,  
CGA 580 cylinder connector, and needle valve shutoff on delivery side 
terminating in a ¼” Swagelok connector.  Part number 
KPRAFPF415A2AG10 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com). An equivalent regulator from an alternate vendor may 
be substituted.  # Spares = 1. 

2. Regulator for argon (between bulk tank and PerkinElmer filter regulator):           
Single Stage 316SS Regulator, with 0-300 psi Inlet Gauge, 0-200 psi 
Outlet Gauge, Outlet Spring Range, 0-250 psi, ¼” Swagelok Inlet 
Connection, ¼ turn Shut off Valve on Outlet with ¼” Swagelok Connection 
and Teflon Seals.  Part number KPR1GRF412A20000-AR1 (Georgia Valve 
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and Fitting, Atlanta, GA, www.swagelok.com). An equivalent regulator from 
an alternate vendor may be substituted.  # Spares = 1. 

3. Regulator for argon (PerkinElmer filter regulator on back of ELAN):  Argon 
regulator filter kit.  Catalog number N812-0508 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com). 

v. Argon / hydrogen:  Argon (90%) / hydrogen (10%) for DRC channel A.  Initial 
purity of argon = 99.9997+% (“Research grade 5.7”).  Initial purity of hydrogen 
= 99.9999+% (“Research Grade 6.0”).  Mixture is typically purchased in cylinder 
size 35 (6”x24”) (Airgas South, Atlanta, GA, www.airgas.com). 

1. Regulator for argon / hydrogen:  Stainless steel, two stage, specially 
cleaned regulator with 3000 psig max inlet, 0-25 outlet pressure range, 
CGA 350 cylinder connector, and needle valve shutoff on delivery side 
terminating in a ¼” Swagelok connector.  Like part number 
KCYADPF412A2AD10 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com). An equivalent regulator from an alternate vendor may 
be substituted.  # Spares = 1. 

2. Flash Arrestor (Stainless steel):  Like part # 6104 (Matheson Tri Gas, 
Montgomeryville, PA, www.mathesontrigas.com) or equivalent. 

vi. Disinfectant, for work surfaces:

vii. 

  Bleach-rite spray (any distributor).  On-site 
dilutions of bleach (1part bleach + 9 parts water) may be substituted, but must 
be re-made daily. 
Oxygen:  Oxygen (“Research Grade Research Grade 5.0”, 99.9999% purity) 
for DRC channel B.  Typically purchased in cylinder size 300 (9.5” x 54”) 
(Airgas South, Atlanta, GA, www.airgas.com). 

1. Regulator for oxygen:  High purity brass body with monel trim, two stage 
regulator.  Stainless steel is not used for this application due to safety 
concerns of working with oxygen at high pressure [12].  For one regulator, 
order the following parts, and ask that they be tested and assembled 
(Engineered Specialty Products, Kennesaw, GA, www.espgauges.com).  

a. 
Regulator body:  Brass bar stock, two stage, Monel trim, TFE seats, 
Elgiloy diaphragms, Cv=0.05, 3000 psig max inlet, 1-25 psig outlet 
range, 1/4 FNPT inlet / outlet / gauge ports, O

Tescom part # 44-3410S24-555 

2

 

 cleaned to ASTMG93 
and CGA4.1.  

b. 
Inlet pressure gauge: 2" diameter, 0-3000 psig range , O
Tescom part # 60500-3000N  

2

 

 cleaned, ¼” 
MNPT bottom, brass.   

c. 
Delivery pressure gauge: 2" diameter, 0-15 psig range , O
Tescom part # 60500-0015N  

2

 

 cleaned, ¼” 
MNPT bottom, brass.   

d. Tescom part # 63842-540-B 
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NPT to CGA Adaptor:  ¼” NPT to CGA 540 adapter, brass. 
 
e. Swagelok part # B-200-1-4

Adapter:  Brass male connector, ¼” MNPT to 1/8” Swagelok (Georgia 
Valve and Fitting, Atlanta, GA, 

: 

www.swagelok.com). 
 
An equivalent regulator from an alternate vendor may be substituted. 
# Spares = 1. 

2. Flash Arrestor (brass):  Like part # 6103 (Matheson Tri Gas, 
Montgomeryville, PA, www.mathesontrigas.com) or equivalent. 

viii. Standard, Gallium:  Like 1,000 mg/L, item # PLGA2-2Y.  (SPEX Industries, 
Inc., Edison, NJ, www.spexcsp.com).  Used as an internal standard in diluent.  
Any vendor whose standards are traceable to the National Institute for 
Standards and Technology may be substituted.  The standard must have low 
trace metal contamination.  Gallium is only used in the diluent for the 
measurement of arsenic (As). 

ix. Standard, Iridium:  Like 1,000 mg/L iridium, item # PLIR3-2Y (SPEX Industries, 
Inc., Edison, NJ, www.spexcsp.com).  Used as an internal standard in diluent.  
Any vendor whose standards are traceable to the National Institute for 
Standards and Technology may be substituted.  The standard must have low 
trace metal contamination.  

x. Standard, Multi-element intermediate stock standard:  Item number SM-2107-
003 (High Purity Standards, Charleston, SC, http://www.hps.net/).  This is a 
custom mix solution (see Table 3 in Appendix B for concentrations).  This 
solution is diluted to prepare the intermediate stock working standards, which 
are in turn diluted to prepare the working calibrators.  This solution can be 
prepared in-house from NIST traceable single element stock solutions if 
necessary. 

xi. Standard, Rhodium:  Like 1,000 mg/L, item # PLRH3-2Y.  (SPEX Industries, 
Inc., Edison, NJ, www.spexcsp.com).  Used as an internal standard in diluent.  
Any vendor whose standards are traceable to the National Institute for 
Standards and Technology may be substituted.  The standard must have low 
trace metal contamination.  

xii. Standard, single element stock standards for preparation of urine quality 
control pools:  National Institute of Standards and Technology (NIST) Standard 
Reference Materials (SRMs) 3103a (As), 3105a (Be), 3113 (Co), 3134 (Mo), 
3108 (Cd), 3102a (Sb), 3111a (Cs), 3104a (Ba), 3163 (W), 3128 (Pb), 3140 
(Pt), 3158 (TI), and 3164 (U) (National Institute of Standards and Technology 
(NIST), Office of Standard Reference Materials, Gaithersburg, MD, 
www.nist.gov).  Other sources of standards can be used if they are NIST 
traceable. 

xiii. Triton X-100™ surfactant:  Like “Baker Analyzed” TritonX-100™ (J.T. Baker 
Chemical Co., www.jtbaker.com).  Another source may be substituted, but it 
must be free of trace-metal contamination. 
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6) Preparation of Reagent and Materials. 
 
a. 

i. 
Internal Standard Intermediate Mixture  

For Urine 15 Element (Ir and Rh)

1. Partially fill a 200 mL acid-washed volumetric flask (PP, PMP, or Teflon™) 
with >18 Mega-ohm·cm water (approximately 100-150 mL). 

:  Preparation of single intermediate solution 
containing all internal standards will simplify the addition of the internal 
standards into the final diluent solution.  This solution can be purchased rather 
than prepared.  To prepare 200 mL of the Intermediate internal standard 
solution: 

2. Carefully add 4 mL of double-distilled, concentrated nitric acid.  Mix into 
solution. 

3. Add 0.8 mL of 10,000 ug/mL Rh standard.  If initial Rh standard 
concentration is different, adjust volume proportionally. 

4. Add 0.8 mL of 10,000 ug/mL Ir standard.  If initial Ir standard concentration 
is different, adjust volume proportionally. 

5. Fill to mark (200mL) and mix thoroughly. 
6. Label should include “Internal Standard Intermediate Mixture.  40 ug/mL 

Rh, Ir, and.  2% (v/v) HNO3”, “Store at room temperature”, preparation 
date, expiration date 1 year from preparation date, and preparer’s initials. 

ii. For Arsenic (Ga)

1. Partially fill a 200 mL acid-washed volumetric flask (PP, PMP, or Teflon™) 
with >18 Mega-ohm·cm water (approximately 100-150 mL). 

:  Dilution of a Ga standard to be used as an internal standard 
in the final diluents solution.  This solution can be purchased rather than 
prepared.  To prepare 200 mL of the Intermediate internal standard solution: 

2. Carefully add 4 mL of double-distilled, concentrated nitric acid.  Mix into 
solution. 

3. Add 0.8 mL of 10,000 ug/mL Ga standard.  If initial Ga standard 
concentration is different, adjust volume proportionally. 

4. Fill to mark (200mL) and mix thoroughly. 
5. Label should include “Internal Standard Intermediate Mixture.  40 ug/mL 

Ga,  2% (v/v) HNO3”, “Store at room temperature”, preparation date, 
expiration date 1 year from preparation date, and preparer’s initials. 

b. 
 

Diluent and Carrier 

i. Purpose:  All samples (blanks, calibrators, QC, or patient samples) are 
combined with the diluent during the sample preparation step before analysis.  
This is where the internal standards are added which during the analysis will 
compensate for instrumental variations on the analyte signal.  If using the 
FAST sample introduction system, the diluent is also used as the carrier 
solution. 
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ii. Preparation
1. 

: 

a. 

Diluent Preparation for 15 element method (not including arsenic)  
– NO ETHANOL 

Contents

b. 

:  An aqueous solution of 10 microgram/L Rh, Ir, and in 2% 
(v/v) double-distilled nitric acid.  
Preparation (4L) & storage

i. Acid-rinse a 4 L container (material may be polypropylene (PP), 
polymethylpentene (PMP), or Teflon™).   

:  This solution does not have to be made up 
in a volumetric flask.  The important thing about the concentration of 
the internal standards is that they be consistent within all samples in 
one run.  To prepare different volumes of diluent, add proportionally 
larger or smaller volumes of the solution constituents. 

ii. Partially fill the 4 L container with >18 megaohm·cm water. 
iii. Carefully add 80 mL double-distilled, concentrated nitric acid and 

mix. 
iv. Add 1 mL of the 40 ug/mL Rh, Ir, internal standard solution.  If 

other concentrations are used, the volume added should be 
adjusted proportionally. 

v. Make up to volume (4 L) with >18 megaohm·cm water. 
vi. Store at room temperature and prepare as needed.   
vii. Label should include “10 µg/L Rh, and Ir,”, “2% (v/v) HNO3

2. 

”, “Store 
at room temperature”, preparation date, expiration date (1 year 
from prep), and preparer’s initials. 

a. 
Diluent Preparation for urine arsenic method – CONTAINS ETHANOL 

Contents

b. 

:  An aqueous solution of 10 microgram/L Ga in 2% (v/v) 
double-distilled nitric acid and 1.5% (v/v) ethanol.  
Preparation (4L) & storage

i. Acid-rinse a 4 L container (material may be polypropylene (PP), 
polymethylpentene (PMP), or Teflon™).   

: This solution does not have to be made up 
in a volumetric flask.  The important thing about the concentration of 
the internal standards is that they be consistent within all samples in 
one run.  To prepare different volumes of diluent, add proportionally 
larger or smaller volumes of the solution constituents. 

ii. Partially fill the 4 L container with >18 megaohm·cm water. 
iii. Carefully add 80 mL double-distilled, concentrated nitric acid and 

mix. 
iv. Carefully add 60 mL dehydrated 200 proof ethanol and mix. 
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v. Add 1 mL of the 40 ug/mL Ga internal standard solution.  If other 
concentrations are used, the volume added should be adjusted 
proportionally. 

vi. Make up to volume (4 L) with >18 megaohm·cm water. 
vii. Store at room temperature and prepare as needed.   
viii. Label should include “10 µg/L Ga”, “2% (v/v) HNO3

c. 

”, “1.5% (v/v) 
Ethanol”, “Store at room temperature”, preparation date, expiration 
date (1 year from prep), and preparer’s initials. 

i. 
Base Urine   

Purpose

ii. 

:  This urine pool material will be mixed with the intermediate working 
calibrators just prior to analysis to matrix-match the calibration curve to the 
urine matrix of the unknown samples.   
Contents

iii. 

: A mixture of multiple urine sources collected from anonymous 
donors are used to approximate an average urine matrix. 
Preparation & Storage

1. Collect urine anonymously by placing screened containers and collection 
cups in the restrooms with a sign stating the reason the specimens are 
being collected, the name of the investigator to contact for additional 
information, and requesting that people provide a urine specimen 
(complete details can be found in CDC protocol #3994, ProTrack # 
DLSITN0313).  

: 

2. Once the urine is collected from donors, it should be analyzed to ensure 
that concentrations of the analytes in this method are relatively low, so as 
to not interfere with the proper measurement of calibrators (see Table 2 in 
Appendix B for suggested maximum base urine concentrations). 

3. Once screened, mix the urine collections together in a larger container (i.e. 
acid washed polypropylene (PP), polymethylpentene (PMP), or Teflon™) 
and stir for 30+ minutes on a large stir plate (acid wash large Teflon™ stir 
bar before use). 

4. For short term storage, store at 2-4°C.  For long-term storage, dispense 
into smaller-volume tubes (i.e., 50-mL acid-washed or lot screened 
polypropylene tubes) and store at ≤ -20°C.   

5. Labels on 50mL tubes should include “Base Urine for Multi-element 
Method”, “Store Long Term at ≤ 20° C”, “Store Short Term at 2 -4° C”, 
preparation date, expiration date 3 years from prep date, and preparer’s 
initials. 

d. 
i. 
ICP-DRC-MS Rinse Solution  

Purpose

ii. 

:  Pump this solution into the sample introduction system between 
samples to prevent carry-over of the analytes of interest from one sample 
measurement to the next. 
Preparation: 
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1. Intermediate Triton X-100 Solution

a. 

:  To avoid the process of dissolving 
pure Triton X-100 on a daily basis, prepare an intermediate 2% Triton X-
100™ / 5% (v/v) double-distilled, nitric-acid solution for daily use. 

To prepare 2L of Intermediate Triton X-100 Solution
i. Partially fill a 2 L acid-washed bottle (PP, PMP, or Teflon™) with 

>18 Mega-ohm·cm water (approximately 1-1.5 L).  Use of 
volumetric flask is not required. 

:   

ii. Add 20 mL of Triton X-100™ and stir until completely dissolved.  
Use a Teflon™ stir bar and stir plate if necessary (acid wash stir 
bar before use). 

iii. Carefully add 100 mL of double-distilled, concentrated nitric acid. 
iv. Fill to 2 L and stir thoroughly. 
v. Label should include “2% Triton X-100™ / 5% (v/v) HNO3”, “Store 

at room temperature”, preparation date, expiration date 1 year from 
preparation date, and preparer’s initials. 

2. 

a. 

Rinse Solution Preparation for 15 element method (not including arsenic)  
– NO ETHANOL 

Contents

b. 

:  A 0.002% Triton X-100™, 5% (v/v) double-distilled nitric 
acid solution.  
Preparation & Storage
i. Partially fill a 4 L acid-washed bottle (PP, PMP, or Teflon™ ) with 

>18 Mega-ohm·cm water (approximately 2-3 L).  Use of volumetric 
flask is not required. 

:  To Prepare 4 L of the Final Rinse Solution, 

ii. Add 4 mL of the 2% Triton X-100™ / 5% (v/v) double-distilled, 
nitric-acid intermediate stock solution and mix well. 

iii. Carefully add 200 mL of double distilled concentrated nitric acid 
and mix well.  

iv. Fill to 4 L using >18 Megaohm·cm water.   
v. Store at room temperature and prepare as needed.  To prepare 

volumes other than specified here, add proportionally larger or 
smaller volumes of the solution constituents. 

vi. Label should include “0.002% Triton X-100™ / 5% (v/v) HNO3”, 
“Store at room temperature”, preparation date, expiration date one 
year from preparation date, and preparer’s initials. 

3. 
a. 

Rinse Solution Preparation for arsenic method – INCLUDES ETHANOL 
Contents

b. 

:  A 0.002% Triton X-100™, 5% (v/v) double-distilled nitric 
acid solution and 1.5% (v/v) ethanol.   
Preparation & Storage:  To Prepare 4 L of the Final Rinse Solution, 
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i. Partially fill a 4 L acid-washed bottle (PP, PMP, or Teflon™ ) with 
>18 Mega-ohm·cm water (approximately 2-3 L).  Use of volumetric 
flask is not required. 

ii. Add 4 mL of the 2% Triton X-100™ / 5% (v/v) double-distilled, 
nitric-acid intermediate stock solution and mix well. 

iii. Carefully add 200 mL of double distilled concentrated nitric acid 
and mix well.  

iv. Carefully add 60 mL dehydrated 200 proof ethanol and mix well.   
v. Fill to 4 L using >18 Megaohm·cm water.   
vi. Store at room temperature and prepare as needed.  To prepare 

volumes other than specified here, add proportionally larger or 
smaller volumes of the solution constituents. 

vii. Label should include “0.002% Triton X-100™ / 5% (v/v) HNO3, 
1.5% (v/v) ethanol”, “Store at room temperature”, preparation date, 
expiration date one year from preparation date, and preparer’s 
initials. 
 

e. 
i. 
Standards and Calibrators 

1. 
Multi-element Intermediate Stock Calibration Standard 

Purpose

2. 

:  This master solution will be diluted to prepare five intermediate 
working calibrators.  
Contents

3. 

:  An aqueous solution containing all 16 elements of interest (15 
element panel analytes, arsenic, and elements for future R&D (see 
certificate of analysis), but does not include the internal standards).  
Concentrations are listed in Table 3 of the Appendix.  Matrix is 2% (v/v) 
HNO3 and 1% (v/v) HCl with traces of HF in >18 Mega-ohm·cm water. 
Preparation (Purchase) & Storage

a. 
:   

Purchasing from vendors:  Either purchased as a NIST-traceable 
custom mixture, or prepared in-house.  

Current vendor & preparation process

b. 

:  Currently purchased 
from High Purity Standards (Charleston, SC, part number 
SM-2107-003).  

In-house Preparation

c. 

:  Standard may be made in the lab from NIST-
traceable single element standards. 
Storage

 

:  Store at room temperature.  Label with additional information 
such as “store at room temperature”, date received, date opened, and 
initials of person to first open. 
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ii. 
1. 

Multi-element Intermediate Working Calibration Standards 
Purpose

2. 

:  Use each day of analysis to prepare the final five working 
calibrators that will be placed on the autosampler. 
Content

3. 

:  Five aqueous dilutions of the multi-element intermediate stock 
calibration standard solution in 2% (v/v) double-distilled nitric acid and 1% 
(v/v) hydrochloric acid.  Final concentrations are listed in Table 4 of the 
Appendix. 
Preparation & Storage

a. 

:  Different volumes may be prepared by adding 
proportionally larger or smaller volumes of solution constituents. 

Cleaning flasks:  Acid-rinse three 100-mL, one 200-mL, one 500-mL 
PP, and one 2 L PP (or PMP) volumetric flasks.  Check their 
cleanliness by comparing the counts observed on the ICP-DRC-MS for 
1% (v/v) HNO3

b. 

 before and after contact with the flasks.  Mark each 
flask according to intended use.  Dedicate to purpose.  
HNO3 & HCl Diluent Preparation:  In the cleaned 2L flask, add 1-1.5L 
>18 Megaohm·cm water, 40 mL high purity concentrated HNO3

c. 

, and 
20 mL high purity concentrated HCl.  Fill to the mark and mix 
thoroughly.  Use this diluent to fill the remaining flasks during 
preparation of the intermediate working calibration standards. 
Dilutions & Storage
i. Partially fill the 100 mL, 200 mL, and 500 mL flasks with the HNO

: 

3

ii. Using the volumes listed (Table 4 of the Appendix) pipette the 
appropriate volume of the multi-element intermediate stock 
calibration standard solution into each of the five volumetric flasks.  
Dilute each to the volumetric mark with the HNO

 
& HCl diluent (50-75% full).   

3

iii. Once mixed, transfer to acid-cleaned, labeled, 50-mL containers 
(PP, PMP, or Teflon™) for storage.  Labels should include 
information such as “Multi-element Urine Working Calibrators”, “2% 
(v/v) HNO3, 1% (v/v) HCl”, date of preparation, expiration date (1 
year from date of preparation), “store at room temperature”, initials 
of preparer, and concentrations for each element. 

 & HCl diluent 
using a pipette for the final drops.  Mix each solution thoroughly.  
Final concentrations are listed in Table 4 of the Appendix.   

iii. 
1. 

Working Multi-element Calibrators  
Purpose:  The working multi-element calibrators will be analyzed in each 
run to provide a signal-to-concentration response curve for each analyte in 
the method.  The concentration of an analyte in a patient urine sample 
dilution is determined by comparing the observed signal from the dilution of 
the patient urine sample to the response curve from the working multi-
element calibrators.   
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2. Content

3. 

:  Dilutions (1:100) of the corresponding five intermediate working 
calibration standards.  The dilutions are described in Table 7 of the 
Appendix. 
Preparation & Use

iv. 

:  Made immediately prior to analysis when the 
intermediate working calibration standards are mixed with base urine 
(Section 7.b) and diluent (Section 7.a) using a Digiflex automatic pipetter.  
See Table 7 of the Appendix and section 8.b.2 for details of sample 
preparation. 

1. 
Multi-element Intermediate Stock Calibration Verification Standard 

Purpose

2. 

:  This is the master solution from which all working calibration 
verification standards will be prepared.  It will be diluted to prepare 
intermediate working calibration verification standards which are in turn 
diluted and used to verify the accuracy of instrument response to analyte 
concentrations greater than the calibration range.  This stock solution 
contains all elements needed for both the arsenic and the 12 element 
panel. 
Contents

a. 

:  The concentrations of the elements in the intermediate stock 
calibration standards are listed in Table 3 of the Appendix.  For long shelf 
life, these four aqueous solutions have different matrices which are 
optimized to the elements in each (this was recommended for the 
calibration verification stock standard solutions because the elemental 
concentrations were very high compared to the concentrations in the 
calibration stock standard solution. 

Solution A:  HNO3

b. 
 (10%), HF (0.5%) 

Solution B:  HCl (10%), trace HNO
c. 

3 
Solution C

d. 
:  HCl (1%) 

Solution D
3. 

:  HCl (2%) 
Preparation (Purchase) & Storage

a. 
:   

Purchasing from vendors:  The intermediate stock calibration 
verification standard solutions may be purchased as custom mixtures 
from any vendor which prepares multi-element solutions that are 
traceable to the National Institute for Standards and Technology 
(NIST) for their accuracy.  

Current vendor & preparation process

b. 

:  Currently it is 
purchased from High Purity Standards (Charleston, SC, part 
number SM-2107-012, solutions A, B, C, and D).     

In-house Preparation

c. 

:  If outside laboratories were not available to 
prepare the intermediate stock calibration standard solution, it is also 
possible to make it in the laboratory from single element standards 
which are NIST traceable.   
Storage:  Due to the uranium content, and in keeping with the 
guidance of the CDC radiation safety manual [11], the intermediate 
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stock standards must be kept in a lockbox.  Store the solutions at room 
temperature.  Label these bottles from HPS with additional information 
such as “store at room temperature”, date received, date opened, and 
initials of person to first open. 

v. 
1. 

Multi-element Intermediate Working Calibration Verification Standards 
Purpose

2.  

: Verification of accuracy of instrument response to analyte 
concentrations greater than the calibration range 
Content

a. 

:  The intermediate working calibration verification standard 
solutions used in this method are aqueous dilutions of the multi-element 
intermediate stock calibration verification standard solution in 2% (v/v) 
double-distilled nitric acid and 1% (v/v) hydrochloric acid containing all 13 
elements of interest (does not include the internal standards).  The 
concentrations of the 13 elements in the intermediate stock calibration 
verification standard are listed in Table 8 in Appendix B.   

Preparation & Storage

 

: Prepare the Intermediate Calibration 
Verification Standards for analysis just as a Intermediate Working 
calibrators are prepared, but using volumes and concentrations from 
Table 8 in Appendix B. 

vi. 
1. 

Internal Quality Control Materials (“Bench” QC) 
Purpose

2. 

:  Internal (or “bench”) quality control (QC) materials are used to 
evaluate the accuracy and precision of the analysis process, and to 
determine if the analytical system is “in control” (is producing results that 
are acceptably accurate and precise).  They are included in the beginning 
and at the end of each analytical run. 
Content:  The internal (or “bench”) quality control (QC) materials used in 
this method are pooled human urine, acidified to 1-2% (v/v) HNO3

3. 

, and 
may have been spiked to reach a desired concentration.  The analyte 
concentrations in the “low QC” are in the low-normal concentration range.  
The analyte concentrations in the “high QC” are in the high-normal 
concentration range. 
Preparation & Storage

a. 

: Quality control materials can be either prepared by 
and purchased from an external laboratory or prepared within the CDC 
laboratories.  Quality control must always be traceable to the National 
Institute for Standards and Technology (NIST).  The CDC laboratory 
currently prepares its own bench QC materials using the following 
procedures: 

Collection of urine: Collect urine anonymously by placing screened 
containers and / or collection cups in the restrooms with a sign stating 
the reason the specimens are being collected, the name of the 
investigator to contact for additional information, and requesting that 
people provide a urine specimen (complete details can be found in 
CDC protocol #3994, ProTrack # DLSITN0313).  Volume of urine to 



Urine Multi-Element ICP-DRC-MS                                                     Page    32 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

collect is dependent on the desired pool size.  This write-up will 
assume a 10-L pool size for both the low and high bench QC.   

b. Screening Urine

i. Keep urine refrigerated whenever possible to minimize microbial 
growth. 

:  Screen collected samples for metal content before 
mixing together to make 2 separate base urine pools (for preparing the 
low and high bench QC materials).   Samples can be screened 
individually or after combining several together (reduces number of 
analyses). 

ii. Because this is only a quick screen of the metal content, the 
number of replicates in the urine method can be reduced to one in 
order to reduce analysis time. 

iii. Analyte concentrations in the the final urine pool to be spiked for 
the low bench QC pool should be in the low-normal population 
range.  Analyte concentrations in the final urine pool to be spiked 
for the high bench QC pool should be less than some pre-selected 
target concentration values in the high normal population range.  
See the Second National Report on Human Exposure to 
Environmental Chemicals for estimations of the normal population 
ranges for metals (http://www.cdc.gov/exposurereport/). 

c. Combining Collected Urine

i. Graduate four acid-washed 10-L carboys (PP or PMP) in 0.5 L 
increments (two will be used for decanting into). 

:  Be attentive not to combine only diluted 
matrix urine samples into the low pool and only concentrated matrix 
urine samples into the high pool.  The goal is for combining samples is 
to approach an ‘average’ matrix for each pool. 

ii. Combine collected urine samples into two separate acid-washed 
10-L carboys (PP or PMP), according to their concentrations, for 
the low bench and high bench QC pools.  

iii. Mix each urine pool using large acid washed, Teflon™ coated stir 
bars and large stir plates.  Keep urine refrigerated whenever 
possible. 

iv. Acidify each urine pool to 1% (v/v) HNO3 by adding the 
appropriate volume of double distilled HNO3.   Stir for 30+ min on 
large stir plates.   

d. Settling out of solids
i. Refrigerate the urine (no stirring) for 1-3 days to allow for settling 

out of solids. 

: 

ii. For each urine pool, decant the urine into another of the acid-
washed 10-L carboys to remove the urine from the solids settled 
out on the bottom of the carboy. 

http://www.cdc.gov/exposurereport/�
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iii. Repeat steps (i) and (ii) until minimal solids are left at the bottom of 
the carboy after sitting overnight. 

e. 
i. Analyze a sample of each urine pool.  Record these results for 

future recovery calculations. 

Spiking of urine 

ii. Use these results to determine target analyte concentrations 
possible for the pools 

iii. Calculate the volume of single element standards needed to spike 
each pool to the desired concentrations.   

iv. While stirring the pools on large stir plates, spike each pool with 
calculated volumes of single element standards (all spiking 
standards used must be traceable to NIST).   

v. Continue to stir pools for 30+ minutes after spiking, then reanalyze.   
vi. Repeat steps 4 and 5 until all analytes reach target concentrations 

keeping track of the total volume of spiking solution added to each 
urine pool. 

f. 
i. 
Dispensing and Storage of urine 

Container Types

ii. 

:  Dispense urine into lot screened containers (i.e. 
– 5 or 15 mL polypropylene tubes).  If possible, prepare tubes of 
QC which have only enough volume for one typical run + 1 repeat 
analysis.  This allows for one vial of QC to be used per day of 
analysis, reducing chances of contamination of QC materials due 
to multi-day use. 
Labels

iii. 

:  Place labels on vials after dispensing and capping if the 
vials are originally bagged separately from the caps.  This 
minimizes the chance for contamination during the process.  
Include at least the name of QC pool (text and bar code), date of 
preparation, and a vial number on the labels. 
Dispensing

1. Allow urine pool to reach room temperature before dispensing 
(to prevent temperature gradients possibly causing 
concentration gradients across the large number of vials being 
dispensed and to prevent condensation problems during 
labeling of vials).  This may require leaving the carboy of urine 
at room temperature overnight before dispensing. 

:  Dispensing can be accomplished most easily using a 
Digiflex automatic pipetter in continuous cycling dispense mode. 
This process should be done in a clean environment (i.e. a class 
100 cleanroom area or hood). 

2. Replace the tubing attached to the dispensing syringe (left 
when looking at front of Digiflex) with a length of clean 
Teflon™ tubing long enough to reach into the bottom of the 
10L carboy while it is sitting on the stir plate. 



Urine Multi-Element ICP-DRC-MS                                                     Page    34 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

3. Check cleanliness of Digiflex before use by analyzing 1-2% 
(v/v) HNO3 which has been flushed through the Digiflex with a 
portion of the same solution which has not been through the 
Digiflex. 

4. Approximately one hour before dispensing begins,  
a. With the large stir plate close to the left side of the Digiflex, 

begin stirring the urine pool to be dispensed.   
b. Also during this time, flush the Digiflex with urine from the 

pool to be dispensed.  Place the ends of the tubing 
attached to both the sample and dispensing syringes into 
the carboy of urine so that urine won’t be used up during 
this process.  Be sure to secure both ends of tubing in the 
carboy with Parafilm so they will not come out during the 
flushing process. 

5. After dispensing the urine into the vials, cap the vials and label 
them.  Placing labels on vials after capping minimizes the 
chance for contamination during the process.   

iv. Homogeneity Testing

v. 

:  After dispensing, check homogeneity of 
analyte concentrations in pool aliquots by analysis of every Nth 
sample dispensed (where N ~ 20 - 50 depending on the pool size).  
Sample more heavily from the beginning and the ending portions 
of the tubes dispensed (these are the regions where most 
homogeneity problems occur).  Keep samples pulled for 
homogeneity analysis in the sequence that they were dispensed 
for the purpose of looking for trends in concentrations.  Once 
dispensed and homogeneity has been shown to be good 
throughout the tubes of a pool, store tubes at ≤ -20°C and pull 
tubes out as needed for analysis. 
Storage

 

:  Urine pools should be stored long term at ≤ -20°C.  Short 
term storage (several days) at refrigerator temperature (~ 2-4°C). 

7) Analytical Instrumentation & Parameters  
(see Section 6 for details on hardware used, including sources) 
 
a. 

 
Instrumentation & Equipment Setup: 

i. ICP-DRC-MS:  Inductively Coupled Plasma Dynamic Reaction Cell Mass 
Spectrometer ELAN® 6100 DRCPlus or ELAN®

 
 DRC II. 

1. 
 

Modifications made to ICP-DRC-MS 

a. Plastic tubing for between mass flow controllers and dynamic reaction 
cell have been replaced with stainless steel.  Stainless steel tubing is 
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preferred between the reaction gas cylinder / regulator and the back of 
the ICP-DRC-MS instrument. 

 
b. A second mass flow controller has been added (channel B) for use 

with oxygen. 
 

c. Standard built-in peristaltic pump replaced by DXi-FAST micro-
peristaltic pump / FAST actuator unit. 
 

2. 
 

Configuration of tubing for liquid handling: 

a. Sample introduction system
i. 

: 
SC-FAST valve setup

 

:  Valve connections must match this 
description for urine total arsenic analysis.  See Appendix B, 
Figure 1a. 

1. Port 1:

2. 

  1.5mL sample loop (white nut).  See “Loop, for FAST 
valve” in section 5.b. for details. 
Port 2:

3. 

  0.5 mm ID probe (red nut) for carrier solution.  See 
“Probes” in section 5.b. for details. 
Port 3:

4. 

  nebulizer line (green nut) for transfer of liquid to 
nebulizer.  See “Nebulizers” in section 5.b. for details. 
Port 4:

5. 

  sample loop (white nut).  See “Loop, for FAST valve” in 
section 5.b. for details. 
Port 5:

6. 

  0.8 mm ID probe (blue nut) for diluted samples.  See 
“Probes, for ESI autosampler” in section 5.b. for details. 
Port 6:

 

  vacuum line (black nut).  See “Tubing, FAST vacuum” 
in section 5.b. for details. 

ii. SC autosampler setup for non-FAST applications

 

:   
See Appendix B, Figure 1b. 

b. Tubing connection between autosampler rinse station and rinse 
solution reservoir

 

:  Tubing of different inner diameters can be 
obtained from Elemental Scientific, their distributors, or custom built 
in the lab to optimize the rinse station fill rate between samples.  
Rinse station should not go empty at any point. 

c. Tubing for autosampler rinse station waste removal

 

: Use minimum 
drain tubing to make this connection.  If this tube is too long, the 
rinse station will not drain properly. 

d. Rinse solution jug:  Leave one of the caps on the top of the rinse jug 
loose to allow air venting into the jug as liquid is removed.  
Otherwise the jug will collapse on itself as the liquid is removed and 
a vacuum is created inside. Use secondary containment tray and 
label appropriately (see solution preparation instructions). 
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e. Waste solution jug

 

:  Use secondary containment tray and label 
appropriately (see solution preparation instructions). 

f. Configuration of tubing and probe for carrier solution

 

:  Use a 
‘peristaltic to Teflon tubing adapter’ (see consumables descriptions 
in section 5.b) for connections. 

3. 
Nickel and platinum cones have been used. 
Cones used 

 
4. 
 

Gases & Regulators setup: 

a. Argon

 

:  Argon stored as liquid in a dewar (180-250L) or bulk tank.  
Gaseous argon used for plasma and nebulizer.   

i. Regulator for argon source (if a dewar)

ii. 

:  Keep the inlet pressure 
(headspace pressure of liquid argon dewar) above 100 psi.  Set 
delivery pressure to 60-100psi to allow for pressure drop across 
tubing that stretches to the instrument.  See Section 6.f. for part 
numbers and details. 
Step down regulator (if source of argon is a bulk tank)

iii. 

:  Place this 
single stage regulator in the lab so that incoming argon pressure 
can be monitored and adjusted.  Set delivery pressure to 60-100 
psig.  See Section 6.f. for part numbers and details. 
Regulator at ICP-DRC-MS

 

:   Single stage “argon regulator filter 
kit” supplied with the ICP-DRC-MS.  Set the delivery pressure 
depending on the specifications for that model of ELAN ICP-DRC-
MS instrument (see the PE Hardware Manual). This will be 52±1 
psi for instruments having a 0-60psi gauge and 60+1 for 
instruments having a 0-100psi gauge. See Section 6.f. for 
regulator part numbers. 

b. Argon (90%) / hydrogen (10%) mixture for DRC channel A

 

.  NOTE:  
Only for arsenic analysis.   

i. Regulator for Ar / H2 gas mixture

 

:  Set delivery pressure to 5-7 
psig.  See Section 6.f. for part numbers and details. 

ii. Flash arrestor

 

:  Stainless steel flash arrestor is used on outlet side 
of regulator.    See Section 6.f. for part numbers and details. 

c. Oxygen (99.999+%) gas for DRC channel B

 

.   NOTE:  Only for 
cadmium and manganese analysis 

i. Regulator for O2 gas:  Set the delivery pressure = 5-7 psig.  See 
Section 6.f. for part numbers and details. 
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ii. Flash arrestor

 

:  Brass flash arrestor is used on outlet side of 
regulator.    See Section 6.f. for part numbers and details. 

5. Chiller / Heat Exchanger: Refrigerated chiller (for ELAN® 6100 DRCPlus 
instruments) or heat exchanger (for ELAN®

 

 DRC II instruments).  For 
refrigerated chiller, set temperature control to 18°C.   

ii. Computer

 

:  Dell Optiplex GX150, GX270, or GX280 have all been used.  
Processors used have included Pentium III (1 GHz) through Pentium IV (2.8 
GHz).  Recommend 512Mb - 1Gb RAM.  External hard disk drive for nightly 
backups of data connects via USB port.  Software used includes Windows XP 
Professional, service pack 2 and ELAN v3.3. 

iii. Autosampler

 

:  ESI SC4 autosampler with (arsenic) or without (multi-element) 
FAST sample introduction.  Rack calibration, tubing ID for rinse supply, 
additional rinse time, probe movement speeds, and probe depth is optimized 
per autosampler (see Table 1 in Appendix B for default settings). 

b. Parameters for Instrument and Method

 

:  See Table 1 in Appendix B for a 
complete listing of the instrument and method parameters.  Also, see Figures 2a-
2g and 3a-3g in Appendix B for images of the ELAN method screens (15 element 
panel and arsenic respectively). 

8) Method Procedures 
a. Quality Control

i. 

:  Quality control procedures implemented in this method are 
defined by the Division Procedures and Practices Guidelines and include two 
types of QC systems which are both subjected to the complete analytical 
process.  The data from these materials are then used to estimate 
methodological imprecision and to assess the magnitude of any time-associated 
trends.  The concentrations of these materials should cover the expected 
concentration range of the analytes for the method.  Before QC materials can be 
used to judge patient analytical runs, acceptable QC concentration limits must be 
calculated from the concentration results observed in at least 20 characterization 
runs.  During the 20 characterization runs, previously characterized QCs or pools 
with target values assigned by outside laboratories should be included to 
evaluate the analysis.  The process of limits calculation is performed using the 
laboratory database and the SAS division QC characterization program. 

1. 
Types of Quality Control:   

“Bench QC”

the performance of the analytical system on the day of analysis.  The 
analyst inserts both the “low” and the “high” bench QC specimens two 
times in each analytical run (a set of consecutive assays performed without 
interruption) so that judgments may be made on the day of analysis.  The 

:  The bench QC pools used in this method comprise two levels 
of concentration spanning the “low-normal” and “high-normal” ranges of the 
analyte of interest.  The intent of bench QC is for the analyst to evaluate  
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first analysis of the two bench QC pools is done after the calibration 
standards are analyzed but before any patient samples are analyzed (so 
that judgments on the calibration curves may be made before analysis of 
patient samples).  The second analysis of the two bench QC pools is done 
at the end of the run (approximately 20 patient samples total).  If more 
patient samples are analyzed on the same calibration curve after the 
second run of the bench QC, both the low-normal and high-normal bench 
QC must be reanalyzed before and after the additional samples.  For 
example, the schemes shown in Table 5 in Appendix B are both 
acceptable ways to analyze multiple consecutive “runs”.   
 

2. “Blind QC”

3. 

:  When possible, “blind” QC samples are QC materials placed in 
vials, labeled, and processed so that they are indistinguishable from the 
subject samples handled by the analyst.  Ideally, the supervisor decodes 
and reviews the results of the blind specimens without the analyst knowing 
of their presence in the runs.  When it is not possible to have blind QC 
materials processed so that they are indistinguishable by the analyst from 
the patient samples, it is acceptable for the analyst to randomly insert into 
the run a QC material which only the QC reviewer knows the acceptable 
concentration limits for.  At least one low-normal concentration and one 
high-normal concentration QC material should be kept in the laboratory for 
this purpose. 
External Reference Materials

 

:  Materials produced by laboratories outside 
of the CDC which have assigned target concentrations can be helpful in 
verifying method performance.  Some examples include Standard 
Reference Materials (SRM) from the National Institute of Standards and 
Technology (NIST) (i.e. SRM 2670a low & 2607a high) and samples from 
previous challenges of proficiency testing programs (i.e. Centre de 
Toxicologie du Quebec (CTQ)).  However, only the results for the bench 
and blind QC materials are used to determine if the run results can be 
used. 

ii. Calibration Verification
a. 

:   
Bi-annual tests as defined in the DLS Policy and Procedures manual:  CLIA 
requires the verification of accuracy of instrument response to analyte 
concentration be completed at least every 6 months.  NIST traceable 
calibrators are analyzed in each run to define this response up to the 
concentration of the highest calibrator in the run.  To verify accuracy of 
instrument response at concentrations higher than the highest calibrator in 
each run, analyze a NIST traceable standard with very high concentrations 
(see Table 8 in Appendix B for concentrations) at least every 6 months.  
Prepare the Calibration Verification Standard for analysis just as a working 
calibrator is prepared.  Use the “Urine Blank” as the blank when it is analyzed.  
If the observed concentrations for the Calibration Verification Standard are not 
within 10% of the target value (see Table 8 in Appendix B) the lab supervisor 
should be notified and the issue should be investigated.  Do not substitute 
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external reference materials (i.e. biological samples from a PT program) for 
the Calibration Verification Standard when performing this.  Solutions needed 
for the Calibration Verification checks can be purchased from standards 
vendors (i.e.SPEX, High Purity Standards, etc . . .) or prepared in-house from 
NIST traceable single element standards.  Always verify that normal 
background levels have been re-achieved through adequate rinse time 
following analysis of elevated standards for calibration verification. 

b. As-needed confirmations (per supervisor discretion):  When a sample result is 
greater than the highest calibrator in the run, the supervisor may request that 
the result be confirmed in an analysis run which includes a standard or 
external reference material with equivalent (within 10%) or greater 
concentration than the sample.  In order to avoid needless contamination of 
the instrument with high concentrations of analytes, the analyst should use the 
lowest appropriate calibration verification solution concentrations to meet the 
need. 
 
For infrequent verification needs, the calibration verification stock solutions 
can be used to prepare verification standards to appropriate concentrations.  
This will, however, introduce elevated concentrations of all elements in the 
method to the sample introduction system.  Frequent measurement of these 
very high concentrations can result in high background levels in the instrument 
which are difficult to rinse out and which may limit the ability to measure low 
concentrations.   
 
For frequent verification needs (i.e. when certain studies have many elevated 
results on particular elements) or

i. The target value has been assigned by an external source (i.e. 
NIST, or the proficiency testing program). 

 when a concentration higher than those 
shown in Table 8 in Appendix B needs to be verified,  use NIST-traceable 
single element stock standards to prepare single element verification 
standards.  This will limit the exposure of the instrument to elevated 
concentrations of only the elements needing verification. 
 
An external reference material (i.e. historical proficiency testing sample) can 
be substituted in place of the Calibration Verification Standard sample in these 
situations IF 

ii. The concentration of the external reference material is within 10% 
or is higher than the concentration of the material you need it to 
confirm. 

iii. There is confidence that there is no contamination of previously 
used external reference material. 

iv. A note to file is made that this was done.  
v. If the observed concentrations are not within 10% of the target 

value the lab supervisor should be notified and the issue should be 
investigated. 
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Always verify that normal background levels have been re-achieved through 
adequate rins

b. 

e time following analysis of calibration verification standard 3 or 
higher (including samples with those concentrations).   

i. 
Daily Analysis of Samples 

For further details on any part of this description, see the ITN Daily Startup 
SOP for ELAN ICPMS instruments. 

Preparation of the Analytical Equipment 

1. Power on

2. 

 the computer, printer, and autosampler, and log into the 
operating system. 
Peristaltic pump:  Set up the perista

3. 

ltic pump tubing with proper tension for 
the sample rinse station. 
Software

4. 

:  Starting the ESI software before starting the ELAN software may 
improve stability of software. 
Daily Pre-Ignition Maintenance Checks

5. 

: Perform daily maintenance checks 
as described in the IRAT Daily Startup SOP for ELAN instruments (i.e., Ar 
supply pressure, interface components cleanliness and positioning, 
interface pump oil condition, vacuum pressure, etc.).  Make appropriate 
notes in the Daily Maintenance Checklist and Instrument Log Book.  
Start the Plasma:  In the INSTRUMENT window of the software (or on the 
fr

6. 
ont of the ELAN), press the “Start” button to ignite the plasma.  

Aspirate rinse (multi-element method) or carrier (arsenic method) solution:

7. 

  
Send Probe to Rinse Station (multi-element method) or manually place 
carrier probe into carrier solution (arsenic method). 
Start the peristaltic pump

8. 

:  Start the peristaltic pump by pressing the 
appropriate arrow in the DEVICES window (make sure that the rotational 
direction is correct for the way the tubing is set up in the peristaltic pump).  
Set the pump speed to a slow speed in the DEVICES window during warm-
up. 
Warm-up time

9. 

:  Allow approximately 30 to 45 minutes warm-up time for the 
ICP-DRC-MS after igniting the plasma.  This warm-up time is for the RF 
generator.  There will be another “Stability time” for the DRC later in this 
procedure. 
Optimizations and Daily Performance Check

a. 

:  After this warm-up time, 
perform a daily performance check and any optimizations necessary (as 
described in the ITN Daily Startup SOP for ELANs).  Include Be (m/z 9) in 
the daily performance check.  Fill in the Daily Maintenance Checklist 
according to the optimization procedures performed. 

Magnesium (24Mg) may have high RSDs due to the use of Triton-X100 
in the rinse solution.  Avoid this problem by either temporarily using 
non-Triton-containing rinse solution during the daily check, or repeating 
the daily check multiple times in succession with no rinse time 
between.   



Urine Multi-Element ICP-DRC-MS                                                     Page    41 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

i. Saving the Files

10. 

:  Save new tuning (mass calibration) parameters 
to the file “default.tun.”  Save new optimization parameters (i.e., 
detector voltages, autolens values, nebulizer gas flow rate) to the 
file “default.dac.”   

Software setup for Analysis
a. 

: 
Workspace (files & folders)

b. 

:  Click on “Open Workspace” from the 
“File” menu.  Select the workspace file “CDC_urine multi-element.wrk” 
(or one customized for user preferences).  Select “Review Files” from 
the “File” menu.  Verify & set up the correct files and data directories 
for your analysis (See Table 1 in Appendix B). 
Samples / Batch Window

 

:  Update the window to reflect the current 
sample set.  The only fields which need to be filled in include the 
autosampler location, sample identification (id), measurement action, 
method, sample flush time, sample flush speed, read delay time, read 
delay & analysis speed, wash time, wash speed. Use a bar code 
scanner to input data whenever possible.  See Table 1 in Appendix B 
for times and speeds.  Save the Sample window file and re-use it on 
other days by simply replacing the sample IDs for the patient samples. 

1. DRC Stability Time

 

:  Best analyte-to-internal standard ratio 
stability is obtained after 1-1.5 hrs of analysis of urine samples 
using the DRC method.  Analyze enough “dummy” urine 
sample dilutions prior to any DRC analysis run to fill 1-1.5 
hours of analysis time (not necessary if analyzing only a 
subgroup of the method containing no DRC analytes).  If 
analyzing the full set of method analytes, 10 samples will be 
sufficient.  See Table 5 in Appendix B for example of setup in 
the Samples / Batch window. 

2. Urine vs. Aqueous Method Files
a. 

:   
The difference:

b. 

 There are two method files for this one 
method (see Table 1 in Appendix B).  It is necessary to use 
both to accomplish each run because the current 
PerkinElmer software will not allow for more than one blank 
per method file.  The ONLY DIFFERENCE between these 
two files is on the Sampling tab where one lists the 
autosampler positions of the urine blank and urine 
calibrators (the “urblk” method file) and the other lists the 
autosampler position of the aqueous blank (the “aqblk” 
method file).   
Use:  The ONLY TIME when it matters which of these files 
is used is when the measurement action includes “Run 
blank” or “Run standards”.  When the measurement action 
is only ‘run sample’, it does not matter whether the “urblk” 
or “aqblk” method file is used.  Analysts typically follow the 
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pattern below, however, for the sake of consistency and as 
a reminder of which blank must be used for which type of 
sample.  See Table 6 in Appendix B. 
i. The “urblk” method file:

ii. 

  Use to analyze the initial urine 
blank (blank for the calibration curve), the urine 
calibrators, and the urine blank checks (urblkchk1 & 
urblkchk2) at the very beginning of the run.  The urine 
blank method defines the autosampler location of the 
urine blank and the urine calibration standards. 
The “aqblk” method

3. 

 file must be used to analyze all QC 
materials and patient samples.  The aqueous blank 
method defines the aqueous blank in autosampler 
location. 

Notation of Dilutions

ii. 

:  To designate an extra dilution of a 
sample, edit the sample ID to reflect the level of dilution being 
performed (i.e., A 1:2 dilution of sample 1 would be reflected in 
the sample ID “sample 1 (2x dilution)”.  This sample ID will be 
edited during the data-import process to the database so that 
it is recognized as the appropriate sample.  Do not use the 
ELAN® software to automatically correct for sample dilutions.  
Extra dilution is performed on urine samples whose 
concentration is greater than the concentrations listed in Table 
8 in Appendix B (linearity of the method has been documented 
up to these concentrations). 

Preparation of Samples for Analysis
1. Thaw the frozen urine specimens; allow them to reach ambient 

temperature. 

  (See Table 7 in Appendix B) 

2. DRC stability “dummy urine matrix”.  Prepare 50+mL of standard 2 or 
standard 3 to be analyzed for 1-1.5 hr before the beginning of the run.  
This can be prepared using 50mL polypropylene tubes or a wide-mouth 
bottle (which can be put on the autosampler in place of one of the tube 
trays). 

3. Set up a series of 15-mL polypropylene tubes corresponding to the 
number of blanks, standards, QCs, and patient samples to be analyzed. 

4. Prepare the following solutions in the 15-mL falcon tubes using the 
Micromedic Digiflex™ (see Table 3 in Appendix B for a summary). 

a. Aqueous Blank:  Prepare two aqueous blanks consisting of 1,000 µL of 
>18 Mega-ohm·cm water and 9,000 µL of diluent.  One will be the 
actual aqueous blank and the other will be a backup (“Aqueous Blank 
Check”) in case the original aqueous blank gets contaminated. 

b. Urine Blank:  Prepare two urine blank dilutions consisting of 900 µL of 
base urine (same material used to prepare the urine calibration 
standards), 100 µL of >18 Mega-ohm·cm water, and 9,000 µL of 
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diluent.  One of these urine blanks will be the blank for the calibration 
standards; the other will be analyzed twice after standard 5 as 
UrBlkChk1 and UrBlkChk2, respectively.  Results from the UrBlkChks 
will be used to determine the method limit of detection. 

c. Calibrators:  Prepare the working calibration standards as 100 µL of 
the appropriate aqueous intermediate working calibration standard, 
900 µL of base urine, and 9,000 µL of diluent. 

d. Patient & QC Samples:  Before taking an aliquot for analysis, mix the 
sample so that no particulates remain on the bottom of the tube.  
Prepare urine sample dilutions as 4,500 µL of diluent and 500 µL of the 
urine sample. 

e. Cap all of the blanks, standards, and samples and mix them well.  
Uncap them and place them in the autosampler of the ELAN®

iii. 

 ICPMS 
in the order that was entered in the Samples / Batch window of the 
ELAN software. 

Specimen Storage and Handling During Testing

iv. 

:  Specimens may be left at 
room temperature during analysis in case confirmation analyses must be 
made.  Take stringent precautions to avoid external contamination by the 
metals to be determined.  Specimens may be stored short term at refrigerated 
temperatures, but should be stored long term (>4 weeks) at ≤ -20 °C. 
Starting the Analysis:

v. 

  To begin analysis, highlight (click and drag with the 
mouse) the table rows of the samples that should be included in the run, and 
then click on “Analyze Batch.” 
Monitoring the Analysis

Monitor the analysis for the following: 

:  Initiate work in a timely manner so that the run may 
be monitored.  Make every effort to complete analysis within the work day so 
that the entire run can be monitored.  If it is not possible to complete the 
analysis by the end of the work day, the run may be left to complete itself 
unattended as long as appropriate planning is made for either overnight 
operation or Auto Stop (see below).   

1. DRC stability (analyte / internal standard ratio stability) 

After the analysis of the DRC stability “dummy” samples, these results can 
be reviewed to determine if sufficient stability of the analyte-to-internal 
standard ratio was reached before beginning analysis.  Importing data into 
an MS Excel template file is useful to visualizing magnitude of drift. 

2. Proper operation of the instrument. 
3. Contaminated blanks. 
4. Linear calibration curves. 

a. Typical correlation coefficients will be 0.999 to 1.000. 
b. The ELAN software generates a “simple linear” calibration curve (using 

a least squares calculation) for each of the 13 elements in this method.  
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The curves are generated using the results from analysis of the urine 
blank and the 5 external urine calibrators whose concentrations are 
defined in the Calibration tab of the Method file.  Specifically, the 
software plots the “net intensity” (y-axis) versus the analyte 
concentration (x-axis).  The “net intensity” is the blank subtracted ratio 
of the measured intensity for the analyte to the measured intensity of 
the associated internal standard and is calculated as follows:  

 

Blank

Blank

sample

sample

IntensityMeasStdInternal
IntensityMeasAnalyte

IntensityMeasStdInternal
IntensityMeasAnalyte

ensitynet −=
.

int

` 
5. Bench QC results within the acceptable limits.   

If an analyte result for the beginning QC material(s) falls outside of the 99% 
limits, then the following steps are recommended:  

a. If a particular calibration standard is obviously in error, remake a new 
dilution at the Digiflex of that working calibrator, reanalyze it, and 
reprocess the sample analyses using this new result as part of the 
calibration curve. 

b. Prepare a fresh dilution of the failing QC material and reanalyze it. 
c. Prepare fresh dilutions at the Digiflex of all of the calibration standards 

(working urine multi-element standards) and reanalyze the entire 
calibration curve using the freshly prepared standards. 

If these three steps do not result in correction of the out-of-control values 
for QC materials, consult the supervisor for other appropriate corrective 
actions. Do not report analytical results for runs that are not in statistical 
control. 

6. Good precision among replicates. 
7. Consistent measured intensities of the internal standards.   

Some sample-to-sample variations are to be expected.  However the 
intensities should be within a few percent of one another, and should 
fluctuate around an average value (not drift continuously in one direction). 

8. Elevated patient results.  After any sample having a concentration greater 
than the third calibration verification standard (see CV3 in Table 8 of 
Appendix B), verify the instrument background levels have returned to 
normal before proceeding in analysis to the next sample, adding additional 
rinsing time if necessary.  If this cannot be done in real-time, the sample 
analyzed immediately after the elevated sample should be repeated for 
confirmation (within 10% of the original result) prior to reporting.  Report 
the first analytically verified result. 
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vi. Records of Results

1. 

:  Run results will be documented daily in both electronic 
and paper form. 

Electronic Records
a. 

: 
Transfer of Results to the Laboratory Information System / Database

b. 

:  
Transfer data electronically between computers or software to reduce 
errors.  When keyboard entry must be used, proofread transcribed 
data after entry. 
Long-Term Storage of ELAN software files

2. 

:  Files used and produced 
by the ELAN software in analyzing samples will be backed up long 
term on compact disk and kept a minimum of three years. 

Paper Records

a. A summary of the calibration curve statistics. 

:  The paper copy of the results from the run should be put 
into the study folder(s) and should include  

b. A printout of analysis of each measurement made during the run. 
c. Optional, but helpful, is a printout of the DRC stability check 

measurements in graphical form. 
d. On the front sheet of the printed records, write the following 

i. Analyst initials 
ii. Instrument ID 
iii. Date of Analysis 
iv. Run # for the day on this instrument 
v. Study ID and Group Number 
vi. Database batch ID (Not known until the run is imported into the 

database) 
vii. Transfer of Results to the Laboratory Database

1. 

:  Every analytical run 
performed for the analysis of patient samples should be entered into the 
laboratory results database unless the run is not useable for obvious reasons 
(i.e. the run is stopped for some reason before ending QC is analyzed, no 
internal standard spiked into the diluent, etc. . . ). 

Data Export Process (from ELAN® software to .TXT file):  If the data file 
was not created during the initial analysis, reprocess the data of interest 
either with “original conditions” option, or by loading the files and folders 
used during the analysis.  In the ELAN® ICP-DRC-MS software, select 
“Review Files” from the “File” menu.  From this window, you must open the 
files and directories that were used when collecting the data of the run that 
you wish to export.  (If the analysis has just ended, all of these files and 
directories will still be open.)  NOTE:  A second copy of the ELAN® 
software can be run as an Edit/Reprocess copy without affecting an 
ongoing analysis by the first copy of the software running in Windows.  
After you open the relevant files, go to the “Report” page in the METHOD 
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window.  Deselect the box that prints a paper copy of data and select the 
box that sends data to a file.  Select the “Report Options Template” named 
“CDC_Database Output.rop” and type in a report filename using a format 
such as “2005-0714a_group55.txt” to designate data from analysis of 
group 55 from July 14, 2005, run #1.  Under “Report Format”, choose the 
“Use Separator” option, and under the “File Write” section choose 
“Append.”  Finally, reprocess the data of interest.  (See PerkinElmer 
ELAN® ICPMS Software Manual.)  Make sure you apply the aqueous 
blank to all sample and quality control material analyses.  

2. Data Import Process (from .TXT file to Microsoft Access™ database)
a. Move the .TXT file to the appropriate subdirectory on the network drive 

where exported data are stored.  Directories for data storage are 
named according to instrument \ year \ month\, such as 
I:\Instruments\ELANDRC2A\2005\07\. 

:   

b. Using the ITN Database Frontends, import the instrument file into the 
database.  On the GoTo window, click on “Add Sample Results to 
Database”, then “Import Instrument Data File”. 

c. Enter the appropriate information to identify the instrument, assay, 
analysis date & time, run number, analyst, calibrator lot number and 
prep date used (use the “IS Lot Number” field) and study.  If other than 
default values for Method LOD, High Calibrator, Rep Delta Limit, and 
units were used in the run, document what was used by clicking on the 
“View/Set Batch Parameters” button, changing the appropriate values, 
and then clicking “Back”. 

d. Press the “Import” button, then browse to the correct network folder to 
select the file which contains the results from the run.  Select the file 
and click “OK”. 

e. In the “Import Instrument Results” table, pressing the “Find X’s” button 
will show only those samples whose sample ID is not recognized as a 
valid QC pool ID or sample ID for this study.  (Sample IDs are set up 
when the study is logged into the database.)  Corrections to sample 
IDs and dilution factors can be made in this table (e.g., correction of 
transcription errors and adjustment for level of dilution).  If samples 
were diluted for analysis, both the sample ID and the dilution factor 
need to be edited in this table before the values are transferred to the 
database (the Replace command under the Edit window is helpful in 
this case).  When corrections to sample IDs are made, press the 
“Check IDs” button to re-evaluate the sample IDs.  Any sample or 
analyte row marked “Not Recognized” will not be transferred to the 
database when the “Transfer” button is pressed.   Once transferred 
into the database, the data should be evaluated for QC pass / fail, then 
set with the with the appropriate settings for QC accept / reject, final 
value status, and comment(s).  See the database programmers for 
more detail on working in the database. 
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viii. Analyst Evaluation of Run Results
1. 

: 
Bench Quality Control

a. 

:  After completing a run, and importing the results 
into the database, export the QC results to the SAS program where the run 
will be judged to be in or out of control.  The QC limits are based on the 
average and standard deviation of the beginning and ending analyses of 
each of the bench QC pools, so it will not be possible to know if the run is 
officially accepted or rejected until it is completed.   

Quality Control Rules

i. If both QC run means (low & high bench QC) are within 2Sm limits 
and individual results are within 2Si limits, then accept the run. 

:  The SAS program applies the division QC rules 
to the data as follows:  

ii. If 1 of the 2 QC run means is outside a 2Sm limit - reject run if: 
1. Extreme Outlier – Run mean is beyond the characterization 

mean +/- 4Sm 
2. 1 3S Rule - Run mean is outside a 3Sm limit 
3. 2 2S Rule - Both run means are outside the same 2Sm limit 
4. 10 X-bar Rule – Current and previous 9 run means are on 

same side of the characterization mean 
iii. If one of the 4 QC individual results is outside a 2Si limit - reject 

run if: 
1. R 4S Rule – Within-run ranges for all pools in the same run 

exceed 4Sw (i.e., 95% range limit) 
Note: Since runs have multiple results per pool for 2 pools, the R 4S 
rule is applied within runs only.  
Abbreviations: 
Si = Standard deviation of individual results (the limits are not shown 

on the chart unless run results are actually single 
measurements). 

Sm = Standard deviation of the run means (the limits are shown on the 
chart). 

Sw = Within-run standard deviation (the limits are not shown on the 
chart). 

b. Implications of QC Failures

i. 

:  If the division SAS program declares the 
run out of control” for any analyte, use the following to determine the 
implications on usability of the data from the run. 

For 1 or 2 analytes:  ONLY the analytes which were “out of control” 
are invalid for reporting from the run.  Set all run results for those 1 
or 2 analytes as “QC Rejected” in the database. 
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ii. For 3 or more analytes

2. 

:  All results, regardless of analyte, are 
invalid for reporting from the run.   Set all run results for all 
analytes as “QC Rejected” in the database.  Note in the batch 
comment field why all results were marked QC rejected. 

Patient Results
a. 

: 
Elevated Results
i. 

: 
Boundaries Requiring Confirmatory Measurement

1. 
: 

Results Greater than the First Upper Boundary (1UB)

2. 

:  
Concentrations observed greater than the “first upper 
boundary” (defined in the laboratory database as the “1UB”) 
should be confirmed by repeat analysis of a new sample 
preparation.  The concentration assigned to the 1UB for an 
element is determined by study protocol but default 
concentrations are in Table 9 in Appendix B.  Report the 
original result, as long as the confirmation is within 10% of the 
original.    Continue repeat analysis until a concentration can 
be confirmed. 
Results Greater Than Highest Calibrator

3. 

:  When a sample 
result is greater than the highest calibrator in the run, the 
supervisor may request that the result be confirmed in an 
analysis run which includes a standard or external reference 
material with equivalent (within 10%) or greater concentration 
than the sample.   
Results Greater Than Calibration Verification Tested

4. 

:  Perform 
an extra dilution on any urine sample whose concentration is 
greater than those listed in Table 8 in Appendix B (the linearity 
of the method has been documented up to these 
concentrations).  See Table 7 in Appendix B for description of 
sample preparation with extra dilution.   
 
Uranium Isotope Ratio Measurement for Elevated Uranium 
Concentrations

ii. 

:  A uranium 235/238 isotope ratio analysis is 
performed for all urine uranium samples where the urine total 
uranium concentration is greater than the 2UB boundary (see 
Table 9 in Appendix B). 

Inadequate Precision in Confirmation of a Measurement

iii. 

:  If a 
sample is reanalyzed to obtain a confirmation of an initially 
elevated result, the confirmation should be within 10% of the 
original result. 
Analyst Reporting of Elevated Results:  Concentrations observed 
greater than the “second upper boundary” (defined in the 
laboratory database as the “2UB”) should be reported to the QC 
reviewer as an “elevated result”.  The concentration assigned to 
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the 2UB for an element is determined by study protocol but default 
concentrations are in Table 9 in Appendix B.  The analyst should 
report any patient results confirmed to be greater than the second 
upper boundary to the QC reviewer as an “elevated result”.  There 
is no routine notification for elevated levels for the metals 
determined in this method.  The protocol for supervisors reporting 
elevated results to medical personnel is defined according to the 
study protocol. 

b. Inadequate Precision Within One Measurement

ix. 

:  If the range of the   
three replicate readings (maximum replicate concentration value - 
minimum replicate concentration value) for a single sample analysis is 
greater than the criteria listed in Table 9 in Appendix B (“>Lim Rep 
Delta” in the database) and the range of the three replicate readings is 
greater than 10% of the observed concentration, do not use the 
measurement for reporting.  Repeat the analysis of the sample. 

Submitting Final Work for Review

1. Submit an email to the QC reviewer informing them of the readiness of the 
data for final review.  The email should include 

:  Once results have been imported, 
reviewed, and set as final in the database by the analyst,  

a. Instrument ID, run Date, run number, study ID, group ID. 
b. Any bench QC failures (include reasons if known). 
c. Any patient sample result greater than the 2UB boundaries (see Table 

9 in Appendix B). 
d. Anything out of the ordinary about this analytical work which could 

have a bearing on the availability (i.e. insufficient sample to analyze), 
accuracy, or precision of the results. 

2. Include all items called for by the study folder cover sheet in the study 
folder (i.e. printouts from the ICP-MS, bench QC evaluation) together in the 
study folder before submitting the folder for review when analysis is 
complete. 

x. Overnight Operation or Using Auto Stop

1. 24 hrs / day operation in DRC mode: 

:  Make every effort to complete 
analysis within the work day so that the entire run can be monitored.  If it is not 
possible to complete the analysis by the end of the work day, the run may be 
left to complete itself unattended as long as appropriate planning is made for 
either overnight operation or Auto Stop. 

a. To reduce startup time in the mornings, the analyst is encouraged to 
operate the ELAN in DRC mode 24hrs/day during the work week.  This 
eliminates the need for daily 45 minute RF generator warm-up, and 
possibly the need for DRC stability time (if the DRC gas is not off for 
extended periods of time before analysis).  To maintain the instrument 
in DRC mode when not analyzing patient samples, setup multiple 
sample rows in the Samples / Batch window with autosampler position 
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n zero (rinse station of autosampler) and wash time of 1800s (30 
minutes).  Repeat this sample row enough times to keep the 
instrument in analysis mode overnight (1 sample with 15 minute wash 
will take ~ 25 minutes). 

2. AutoStop:  If 24 hrs / day ELAN operation is not desired, the instrument 
can shut the plasma off unattended after analysis.  Setup this as follows: 

a. On the “Auto Start / Stop” tab of the Instrument window, enable the 
Auto Stop feature. 

b. Press the “Change” button within the Auto Stop box and set the 
Delayed shutdown time to 5 minutes.  This will rinse the sample 
introduction system of urine matrix before turning off the plasma. 

c. It will be necessary to replace the sample peristaltic pump tubing the 
next day since it will have been clamped shut overnight. 

c. Equipment Maintenance

i. 

:  Analysts are expected to follow a 4-day analysis / 1-
day maintenance schedule in the laboratory.   

ICPMS Maintenance

ii. 

:  On the maintenance day, perform all maintenance per 
the Inorganic Toxicology and Nutrition Branch ELAN ICP-MS Weekly 
Maintenance SOP.  All equipment maintenance should be documented in the 
instrument logbook.   
Data Backup

1. 

:  Data on the ELAN computer will be backed up via two backup 
routines.   

Daily Backups to External Hard Drive

2. 

:  Automatic backups of the “elandata” 
directory and all subdirectories should be programmed to occur each night 
onto an external hard disk. 
Weekly Backup to CD

a. Backup the oldest data on the hard drive to two duplicate compact 
disks and verify that the files on the CD are readable 

:  Backup all files in the active “elandata” directory 
and all subdirectories onto one recordable compact disc during the weekly 
maintenance SOP.  When the active “elandata” directory on the ICP-DRC-
MS computer hard drive becomes too large to fit onto a single recordable 
compact disk, the oldest data can be removed from the computer to make 
it easier to backup the entire directory weekly.  This can usually be done 
annually. 

b. Label them with the name of the instrument, the date range of the data, 
the current date, your name, and “Copy 1 of 2” or “Copy 2 of 2” 

c. After verifying that the CDs are readable, the oldest, backed up data 
can be deleted from the ICP-MS computer hard drive. 

d. It is best to not store duplicate copies in the same location. 
9) Interpretation of the Results 

a. Reportable Range:  Urine multi-element values are reportable in the range 
between the method LOD (see Appendix, Table 8 in Appendix B) and the highest 
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concentration verified accurate by bi-annual calibration verification tests (see 
Appendix, Table 8 in Appendix B). For example, if a urine cadmium value is less 
than the method LOD of 0.042, report it as < 0.042 µg/L).  Above the highest 
concentration verified, extra dilutions are made of the urine sample to bring the 
concentration within the verified range.  

b.  Reference Ranges (Normal Values)

c. 

:  In this method the 95% reference ranges 
(see Appendix, Table 10 in Appendix B) for these elements in urine fall within the 
range of the calibrators. 
Action Levels

10)   Method Calculations 

:  Due to the uncertainty of the health implications of elevated 
concentrations of many of the elements determined with this method, there is no 
routine notification for elevated levels of every analyte determined with this 
method.  The present NRC standard for workplace removal is 15 µg/L of U in 
urine [13].  Other action levels for reporting to supervising physicians are 
determined on a study-by-study basis.   

a. Method Limit of Detection (LODs):  The method detection limits for elements in 
blood specimens are defined as 3 times s0, where s0 is the estimate of the 
standard deviation at zero analyte concentration.  S0 is taken as the y-intercept 
of a linear or 2nd

b. 

 order polynomial regression of standard deviation versus 
concentration (4 concentration levels of the analytes in blood each measured 60 
times across at least a 2-month timeframe). Method LODs are re-evaluated 
periodically. 
Method Limit of Quantitation (LOQ)

c. 

:  The Division of Laboratory Sciences does 
not currently utilize limits of quantitation in regards to reporting limits [10]. 
QC Limits

11)   Alternate Methods for Performing Test and Storing Specimens If Test System 
Fails: 

:  Quality control limits are calculated based on concentration results 
obtained in at least 20 separate runs.  It is preferable to perform separate 
analyses on separate days and using multiple calibrator lot numbers, 
instruments, and analysts to best mimic real-life variability.  The statistical 
calculations are performed using the SAS program developed for the Division of 
Laboratory Sciences (DLS_QC_compute_char_stats.sas). 

If the analytical system fails, the analysis may be setup on other ELAN DRC 
instruments in the laboratory.  If no other instrument is available, store the 
specimens at ~4°C until the analytical system can be restored to functionality.  If 
interruption longer than 4 weeks in anticipated, then store urine specimens at           
≤ -20°C. 
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Appendix A.  Ruggedness Testing Results 
Parameter Test #1 (15 Element Panel)

 

:  Evaluate the impact on analysis results if the 
RF Power is increased to 1600W (instrument maximum) or decreased to 1150W (by 
20%) for the analytical run.   

Test Details
1. Three different RF power settings were tested in separately prepared, consecutive 

runs on the instrument without turning off the plasma.  At least 15 minutes 
stabilization time was allowed between each run after the RF power was changed.  
“Junk urine” samples (20) were analyzed between the beginning and ending QC of 
each run.  All other method parameters were kept per method. 

:  

2. Run #1 (method default, 1450W).  
3. Run #2 (Decreased RF power by 20% to 1150W). 
4. Run #3 (Increased RF power to instrument maximum, 1600W).  

 
Parameter Test 1 Results (Table 1 of 3 for 15 Element Panel).  All concentrations in 
ug/L.  Test performed 3/24/2010 by Denise Tevis using ELAN DRC-2N. 
Sample 

ID RF Power Tested  Ba Be Cd Co 

LU
-0

43
10

_U
M

P3
_e

 Characterized 
Mean 0.76 0.69 0.32 0.42 

(±2SD Range) (0.65 - 0.86) (0.59 - 0.79) (0.28 - 0.36) (0.38 - 0.47) 
1150W  

(reduced) 0.67 0.62 0.28 0.39 

1450W  
(per method) 0.70 0.66 0.31 0.32

1600W   
(increased) 

¥ 

0.75 0.75 0.33 0.42 

 H
U

-0
43

11
_U

M
P3

_e
 Characterized 

Mean 5.01 5.28 1.62 1.88 

(±2SD Range) (4.54 - 5.24) (4.48 - 6.07) (1.47 - 1.78) (1.66 - 2.09) 
1150W  

(reduced) 4.93 5.75 1.6 1.96 

1450W  
(per method) 5.55 5.28 1.75 1.67 

1600W   
(increased) 4.85 5.82 1.58 1.90 

¥Data are not statistically different according to the expected precision of the method (QC 3SD = 
0.072) 
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Appendix A.  Ruggedness Testing Results. (continued) 
 

Parameter Test 1 Results (Table 2 of 3 for 15 Element Panel).  All concentrations in 
ug/L.  Test performed 3/23/2011 by Denise Tevis using ELAN DRC-2N. 
Sample 

ID 
RF Power 

Tested Cs Mo Pb Pt 

LU
-0

43
10

_U
M

P_
e 

Characterized 
Mean 2.38 19.3 0.42 0.10 

(±2SD Range) (2.25 - 2.51) (18.6 - 20.0) (0.37 - 0.48) (0.07 - 0.13) 
1150W     

(reduced) 2.13 17.2* ¥ 0.42 0.09 

1450W  
(per method) 2.32 18.9 0.41 0.09 

1600W    
(increased) 2.42 18.8 0.43 0.10 

 H
U

-0
43

11
_U

M
P_

e 

Characterized 
Mean 9.82 136 2.95 0.85 

(±2SD Range) (9.03 - 10.6) (131 - 142) (2.82 - 3.08) (0.71 - 1.00) 
1150W     

(reduced) 9.62 136 3.03 0.93 

1450W  
(per method) 10.56 133 2.89 1.02

1600W    

# 

(increased) 9.55 135 3.05 1.08

Sample 
ID 

# 

RF Power 
Tested Sb Tl W U 

LU
-0

43
10

_U
M

P_
e 

Characterized 
Mean 0.19 0.18 0.22 0.014 

(±2SD Range) (0.17 - 0.21) (0.17 - 0.19) (0.19 - 0.24) (0.011 - 0.016) 
1150W     

(reduced) 0.21 0.16 0.19 0.017

1450W  

α 

(per method) 0.16 0.19 0.22 0.014 

1600W    
(increased) 0.20 0.18 0.22 0.017

 H
U

-0
43

11
_U

M
P_

e 

 α 

Characterized 
Mean 0.66 0.58 0.94 0.128 

(±2SD Range) (0.60 - 0.71) (0.55 - 0.61) (0.90 - 0.99) (0.115 - 0.141) 
1150W     

(reduced) 0.69 0.59 0.90 0.153

1450W  

 α 

(per method) 0.61 0.57 0.93 0.126 

1600W    
(increased) 0.66 0.60 0.91 0.150

¥Data are not statistically different; expected precision of the method (QC 3SD = 0.2) 

 α 

*Data are not statistically different; expected precision of the method (QC 3SD = 1.08) 
#Data are not statistically different; expected precision of the method (QC 3SD = 0.22) 
α

 
 Data are not statistically different; expected precision of the method (QC 3SD = 0.02) 
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Appendix A.  Ruggedness Testing Results. (continued) 
 

Parameter Test 1 Results (Table 3 of 3 for 15 Element Panel).  All concentrations in 
ug/L.  Test performed 3/23/2011 by Denise Tevis using ELAN DRC-2N. 

Sample ID RF Power Tested Mn Sn Sr 

N
YD

O
H

 U
E0

9-
05

‡ Characterized Mean 1.37 2.2   
(±2SD Range) (1.55 -1.19) (2.0-2.8)   

1150W    (reduced) 1.22 2.9   

1450W (per method) 0.98 2.8   

1600W   (increased) 1.30 3.0   

N
YD

O
H

 U
E0

9-
06

‡ Characterized Mean 31.1 61   
(±2SD Range) (26.3 -35.9) (55.0 - 67.0)   

1150W    (reduced) 29.4 67.4   

1450W (per method) 23.8 68.5   

1600W   (increased) 30.0 66.7   

Se
ro

no
rm

 T
ra

ce
 

El
em

en
ts

 U
rin

e

Characterized Mean 

§  12.3 54.6 110 

(±2SD Range) (10.9 - 13.7) (51.9 - 57.3) (104 -116) 

1150W    (reduced) 10.4 62.3 113 

1450W (per method) 8.46 62.3 111 

1600W   (increased) 10.5 61.4 111 

§Purchased from Sero AS, Billingstad, Norway. 
‡ Purchased from  Wadsworth Center, New York State Department of Health 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #1 (Arsenic)

 

:  Evaluate the impact on analysis results if the set RF 
Power is increased to 1600W (instrument maximum) or decreased to 1150W (by 20%) 
for the analytical run.   

Test Details
1. Three different RF power settings were tested in separately prepared, consecutive 

runs on the instrument without turning off the plasma.  At least 15 minutes 
stabilization time was allowed between each run after the RF power was changed.  
“Junk urine” samples (40) were analyzed between the beginning and ending QC of 
each run.  All other method parameters were kept per method. 

:  

2. Run #1 (method default, 1450W).  
3. Run #2 (Decreased RF power by 20% to 1150W). 
4. Run #3 (Increased RF power to instrument maximum, 1600W).  
 

Parameter Test 1 Results (Arsenic).  All concentrations in ug/L.  Test 
performed 3/26/10 by Graylin Mitchell using ELAN DRC-2G. 

QC Pool ID RF Power Tested As 

LU-04310_UMP_e 

Characterized Mean 
Characterized  2SD Range 
Characterized  3SD Range 

3.74 
3.21 – 4.27 
2.95 – 4.53 

1150W          (Reduced) 3.72 

1450W      (Per Method) 4.10 

1600W         (Increased) 3.66 

 

HU-04311_UMP_e 

Characterized Mean 
Characterized 2SD Range 
Characterized 2SD Range 

55.8 
53.3 – 58.3 
52.1 – 59.6 

1150W          (Reduced) 55.6 

1450W      (Per Method) 58.8 

1600W         (Increased) 52.2 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #2 (cadmium and manganese)

 

:  Evaluate the impact on analysis results 
if the cell gas flow rate is increased or decreased by 20% for the analytical run.   

Test Details
1. Three different cell gas flow rates were tested in separately prepared, consecutive 

runs on the instrument without turning off the plasma. Samples were prepared with 
diluent containing 400 ppm K and 60 ppb Mo in addition to the internal standards.  At 
least 15 minutes stabilization time was allowed between each run after the cell gas 
flow rate was changed.  “Junk urine” samples (20) were analyzed between the 
beginning and ending QC of each run 

:  

2. Run #1 (method default = 2.3 mL/min)  
3. Run #2 (decreased cell gas flow rate by 20% to 1.8 mL/min).   
4. Run #3 (increased cell gas flow rate by 20% to 2.75 mL/min). 
 
Parameter Test 2 Results (Table 1 of 2 for 15 element).  All concentrations in ug/L.  Test 
performed 4/4/11 by Denise Tevis using ELAN DRC-2N. 

Sample ID Cell gas Flow Rate 
Tested Cd Mn 

LU
-0

43
10

_U
M

P3
_e

 Characterized Mean 0.32         
(±2SD Range) (0.28 - 0.36)   

  
  

1.8 mL/min (reduced) 0.29         
        

2.3 mL/min (per method) 0.29         
        

2.75 mL/min (increased) 0.28         
        

 H
U

-0
43

11
_U

M
P3

_e
 Characterized Mean 1.62         

(±2SD Range) (1.47 - 1.78)         

1.8 mL/min (reduced) 1.65         
        

2.3 mL/min (per method) 1.62         
        

2.75 mL/min (increased) 1.57         
        

Se
ro

no
rm

 T
ra

ce
 

El
em

en
ts

 
U

rin
e§

 

Characterized Mean 
  

12.3 
(±2SD Range) (8.70 - 15.9) 

1.8 mL/min (reduced)   11.0 

2.3 mL/min (per method)   10.1 

2.75 mL/min (increased)   10.7 
§Purchased from Sero AS, Billingstad, Norway. 
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Appendix A.  Ruggedness Testing Results. (continued) 
 

Parameter Test 2 Results (Table 2 of 2 for 15 element).  All concentrations in ug/L.  
Test performed 4/4/11 by Denise Tevis using ELAN DRC-2N. 

Sample ID Cell gas Flow Rate 
Tested Cd Mn 

N
YD

O
H

 U
E 

10
-0

4‡
 Characterized Mean         24.5 

(±2SD Range)         (19.7 - 29.3) 

1.8 mL/min (reduced)         27.0         
2.3 mL/min (per 

method) 
        24.4         

2.75 mL/min 
(increased) 

        26.2         

N
YD

O
H

 U
E 

10
-1

0‡
 Characterized Mean         2.1 

(±2SD Range)         (1.1 - 3.1) 

1.8 mL/min (reduced)         1.82         
2.3 mL/min (per 

method) 
        1.60         

2.75 mL/min 
(increased) 

        1.78         
‡ Purchased from  Wadsworth Center, New York State Department of Health 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #2 (Arsenic)

 

:  Evaluate the impact on analysis results if the cell gas flow 
rate is increased or decreased by 20% for the analytical run.   

Test Details
1. Three different cell gas flow rates were tested in separately prepared, consecutive 

runs on the instrument without turning off the plasma.  At least 15 minutes 
stabilization time was allowed between each run after the cell gas flow rate was 
changed.  “Junk urine” samples (40) were analyzed between the beginning and 
ending QC of each run (diluent was prepared to a 1% HCl matrix so ArCl+ 
interference removal would be challenged).  

:  

2. Run #1 (method default = 0.95 mL/min).  
3. Run #2 (decreased cell gas flow rate by 20% to 0.76 mL/min).   
4. Run #3 (increased cell gas flow rate by 20% to 1.14 mL/min). 
 

Parameter Test 2 Results (Arsenic).   
Test performed 5/13/10 by Graylin Mitchell using ELAN DRC2-G. 

QC  
Pool ID Cell Gas Flow Rate Tested As (ug/L) 

LU-04310_UMP_e 

Characterized Mean 
Characterized  2SD Range 
Characterized  3SD Range 

3.74 
3.21 – 4.27 
2.95 – 4.53 

      0.76 mL/min      (Reduced) 4.35 

0.95 mL/min (Method Default) 4.02 

1.14 mL/min    (Increased) 4.03 

 

HU-04311_UIMP_e  

Characterized Mean 
Characterized 2SD Range 
Characterized 2SD Range 

55.8 
53.3 – 58.3 
52.1 – 59.6 

      0.76 mL/min      (Reduced) 57.6 

0.95 mL/min (Method Default) 54.2 

1.14 mL/min    (Increased) 59.2 
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Appendix A.  Ruggedness Testing Results. (continued) 
Parameter Test #3 (DRC elements: cadmium and manganese)

 

:  Evaluate the impact on 
analysis results if the RPq is increased or decreased by 20% for the analytical run.   

Test Details
1. Three RPq settings were tested for cadmium and manganese in separately 

prepared, consecutive runs on the instrument without turning off the plasma.  
Samples were prepared with diluent containing 400 ppm K and 60 ppb Mo in 
addition to the internal standards.  At least 15 minutes stabilization time was allowed 
between each run after DRC RPq was changed.  “Junk urine” samples (20) were 
analyzed between the beginning and ending QC of each run.  

:  

2.   Run #1 (instrument default DRC RPq:  0.45).  
3. Run #2 (~20% decrease; DRC RPq:  0.35). 
4. Run #3 (~20% increase; DRC RPq: 0.55 ). 

 
Parameter Test 4 Results.  All concentrations in ug/L.  Test performed 3/30/11 by 
Denise Tevis using ELAN DRC-2N. 
Sample ID RPQ Tested Cd Mn 

LU
-

04
31

0_
U

M
P

3_
e Characterized Mean 0.32 

 (±2SD Range) (0.28 - 0.36) 
 0.35 (reduced) 0.32 
 0.45 (typical) 0.31 
 0.55 (increased) 0.29 
 

 H
U

-
04

31
1_

U
M

P
3_

e Characterized Mean 1.62 
 (±2SD Range) (1.47 - 1.78) 
 0.35 (reduced) 1.58 
 0.45 (typical) 1.48 
 0.55 (increased) 1.46 
 

Se
ro

no
rm

 
Tr

ac
e 

El
em

en
ts

 
U

rin
e§

 Characterized Mean 

 

12.3 
(±2SD Range) (8.70 - 15.9) 
0.35 (reduced) 

 
10.7 

0.45 (typical) 
 

11.8 
0.55 (increased) 

 
11.0 

N
YD

O
H

 U
E 

09
-0

6‡
 Characterized Mean 

 
31.1 

(±2SD Range) 
 

(26.3 - 35.9) 
0.35 (reduced) 

 
29.3 

0.45 (typical) 
 

32.1 
0.55 (increased) 

 
30.9 

N
YD

O
H

 U
E 

09
-0

5‡
 Characterized Mean 

 
1.8 

(±2SD Range) 
 

(1.0 - 2.6) 
0.35 (reduced) 

 
1.28 

0.45 (typical) 
 

1.41 
0.55 (increased) 

 
1.29 

§Purchased from Sero AS, Billingstad, Norway. 
‡ Purchased from  Wadsworth Center, New York State Department of Health 
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Appendix A.  Ruggedness Testing Results. (continued) 
Parameter Test #3 (Arsenic)

 

:  Evaluate the impact on analysis results if the RPq is 
increased or decreased by 20% for the analytical run.   

Test Details
1. Three different RPQ settings were tested for Cadmium in separately prepared, 

consecutive runs on the instrument without turning off the plasma.  At least 15 
minutes stabilization time was allowed between each run after DRC RPQ was 
changed.  “Junk urine” samples (40) were analyzed between the beginning and 
ending QC of each run. The diluent included 1% HCl. 

:  

2. Run #1 (previous method default DRC RPQ:  0.75).  
3. Run #2 (decreased DRC RPQ 20%:  0.62). 
4. Run #3 (increased DRC RPQ 20%: 0.88 ). 
5. Additional test Run #4 (increased DRC RPQ: 0. 25). 
6. Additional test Run #5 (increased DRC RPQ: 0. 45). 
 

Parameter Test 3 Results (Arsenic).   
Test performed 3/18/10 by Gulchekhra Shakirova. 

QC  
Pool ID RPQ Tested As (ug/L) 

LU-04310_UMP_e 

Characterized Mean 
Characterized  2SD Range 
Characterized  3SD Range 

3.74 
3.21 – 4.27 
2.95 – 4.53 

DRC RPQ: 0.38          3.92 

DRC RPQ: 0.48 3.93 

DRC RPQ: 0.60 3.71 

DRC RPQ: 0.72 3.70 

 

HU-04310_UMP_e  

Characterized Mean 
Characterized 2SD Range 
Characterized 2SD Range 

55.8 
53.3 – 58.3 
52.1 – 59.6 

DRC RPQ: 0.38          54.9 

DRC RPQ: 0.48 54.9 

DRC RPQ: 0.60 55.2 

DRC RPQ: 0.72 54.2 
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Appendix A.  Ruggedness Testing Results. (continued) 
Parameter Test #4 (cadmium and manganese)

 

:  Evaluate the impact on analysis results 
if the axial field voltage (AFV) is increased or decreased by 20% for the analytical run.   

Test Details
1. Three different DRC AFV were tested in separately prepared, consecutive runs on 

the instrument without turning off the plasma. Samples were prepared with diluent 
containing 400 ppm K and 60 ppb Mo in addition to the internal standards.  At least 
15 minutes stabilization time was allowed between each run after the axial field 
voltage was changed.  “Junk urine” samples (20) were analyzed between the 
beginning and ending QC of each run.  The diluent including 60 ug/L Molybdenum. 

:  

2. Run #1 (instrument default DRC AFV = 375)  
3. Run #2 (decreased DRC AFV by 20% to 300).  
4. Run #3 (increased DRC AFV by 17% to 450). 
 

Parameter Test 4 Results.  All concentrations in ug/L.  Test performed 4/5/11 by 
Denise Tevis using ELAN DRC-2N. 

Sample ID AFV Tested Cd Mn 

LU
-

04
31

0_
U

M
P3

_e
 

Characterized Mean 0.32   

(±2SD Range) (0.28 - 0.36)   
300 (reduced) 0.32   
375 (typical) 0.34   

450 (increased) 0.31   

 H
U

-
04

31
1_

U
M

P3
_e

 

Characterized Mean 1.62   

(±2SD Range) (1.47 - 1.78)   
300 (reduced) 1.62   
375 (typical) 1.64   

450 (increased) 1.61   

Se
ro

no
rm

 
Tr

ac
e 

El
em

en
ts

 
U

rin
e§

 Characterized Mean   12.3 
(±2SD Range)   (8.70 - 15.90) 
300 (reduced)   10.8 
375 (typical)   10.7 

450 (increased)   10.8 

N
YD

O
H

 U
E 

09
-0

6‡
 Characterized Mean   31.1 
(±2SD Range)   (26.3 - 35.9) 
300 (reduced)   32.0 
375 (typical)   32.0 

450 (increased)   31.9 

N
YD

O
H

 U
E 

10
-0

6‡
 Characterized Mean   1.4 

(±2SD Range)   (0.2 - 2.6) 
300 (reduced)   0.81 
375 (typical)   0.98 

450 (increased)   1.02 
§Purchased from Sero AS, Billingstad, Norway. 
‡ Purchased from  Wadsworth Center, New York State Department of Health 

Appendix A.  Ruggedness Testing Results. (continued) 
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Parameter Test #4 (Arsenic)

 

:  Evaluate the impact on analysis results if the axial field 
voltage (AFV) is increased or decreased for the analytical run.   

Test Details
1. Four different DRC AFV were tested in separately prepared, consecutive runs on the 

instrument without turning off the plasma.  At least 15 minutes stabilization time was 
allowed between each run after the axial field voltage was changed.  “Junk urine” 
samples (40) were analyzed between the beginning and ending QC of each run.  

:  

2. Run #1 (method default DRC AFV = 250)  
3. Run #2 (increased DRC AFV to 300).  
4. Run #3 (decreased DRC AFV to 200). 
 
 

Parameter Test 4 Results (Arsenic).   
Test performed 6/2/10 by Graylin Mitchell using ELAN DRC2-G. 

QC  
Pool ID Axial Field Voltage Tested As (ug/L) 

LU-04310_UMP_e 

Characterized Mean 
Characterized  2SD Range 
Characterized 3SD Range 

3.74 
3.21 – 4.27 
2.95 – 4.53 

200          (Reduced) 4.51 

250             (Typical) 4.37 

300         (Increased) 4.08 

HU-04311_UMP_e  

Characterized Mean 
Characterized 2SD Range 

55.8 
53.3 – 58.3 

200          (Reduced) 54.2 

250             (Typical) 55.9 

300         (Increased) 54.0 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #5 (15 Element Panel)

 

:  Method descriptions and SOP assume 
preparation and analysis on same day.  Evaluate the impact on analysis results if the 
analytical run is prepared to analyze but circumstances do not allow for analysis to 
occur until 24 or 48 hours later.  

Test Details
1. Three separate run sets (A, B, and C) were prepared at one sitting from the same 

starting materials.  Set ‘A’ was analyzed immediately per the assumption of the 
method.  Set’s ‘B’ and ‘C’ were stored at room temperature for 24 and 48 hours, 
respectively before analysis.  “Junk urine samples (20) were analyzed between the 
beginning and ending QC of each run, making each a normal length run.  All other 
method parameters were kept per method.   

:  

2. On day two, a fresh run set (“D”) was prepared and analyzed immediately for 
comparison to results from set “B” (Run 2 of the day.  Results not shown).   

3. On day three, another fresh run set (“E”) was prepared and analyzed immediately for 
comparison to results from set “C” (Run 2 of the day.  Results not shown). 
 

Parameter Test 5 Results (Table 1 of 2 for 15 Element Panel).  All concentrations in ug/L.  
Test begun 3/23/11 by Denise Tevis using ELAN DRC-2N. 

Sample 
ID 

Time from 
Preparation to 

Analysis 
Ba Be Cd Co 

LU
-

04
31

0_
U

M
P

3_
e 

Characterized Mean 0.76 0.69 0.32 0.42 
(±2SD Range) (0.65 - 0.86) (0.59 - 0.79) (0.28 - 0.36) (0.38 - 0.47) 

freshly prepared 0.70 0.66 0.32 0.32 
24 hours 0.70 0.69 0.31 0.42 
48 hours 0.86 0.67 0.31 0.43 

H
U

-
04

31
1_

U
M

P
3_

e 

Characterized Mean 5.01 5.28 1.62 1.88 
(±2SD Range) (4.54 - 5.24) (4.48 - 6.07) (1.47 - 1.78) (1.66 - 2.09) 

freshly prepared 5.55 3.48 1.75 1.67 
24 hours 4.66 5.76 1.57 1.94 
48 hours 5.12 5.49 1.67 1.84 

¥Data are not statistically different according to the expected precision of the method (QC 3SD = 0.072) 
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Appendix A.  Ruggedness Test #5 Results (continued) 
 
Parameter Test 5 Results (Table 2 of 3 for 15 Element Panel).  All concentrations in ug/L.  
Test begun 3/23/11 by Denise Tevis using ELAN DRC-2N. 

Sample 
ID 

Time from 
Preparation to 

Analysis 
Cs Mo Pb Pt 

LU
-0

43
10

_U
M

P_
e Characterized Mean 2.38 19.3 0.42 0.10 

(±2SD Range) (2.25 - 2.51) (18.6 - 20.0) (0.37 - 0.48) (0.07 - 0.13) 

freshly prepared 2.32 18.9 0.41 0.09 
24 hours 2.35 19.2 0.44 0.11 
48 hours 2.30 19.0 0.46 0.10 

H
U

-0
43

11
_U

M
P_

e Characterized Mean 9.82 136 2.95 0.85 

(±2SD Range) (9.03 - 10.6) (131 - 142) (2.82 - 3.08) (0.71 - 1.00) 

freshly prepared 10.6 133 2.89 1.02 
24 hours 9.36 134 3.08 1.03 
48 hours 10.0 132 3.04 1.12 

Sample 
ID 

Time from 
Preparation to 

Analysis 
Sb Tl W U 

LU
-0

43
10

_U
M

P_
e Characterized Mean 0.19 0.18 0.22 0.014 

(±2SD Range) (0.17 - 0.21) (0.17 - 0.19) (0.19 - 0.24) (0.011 - 0.016) 

freshly prepared 0.16 0.19 0.22 0.014 
24 hours 0.19 0.18 0.21 0.013 
48 hours 0.19 0.19 0.22 0.014 

H
U

-0
43

11
_U

M
P_

e Characterized Mean 0.61 0.58 0.94 0.128 

(±2SD Range) (0.60 - 0.71) (0.55 - 0.61) (0.90 - 0.99) (0.115 - 0.141) 

freshly prepared 0.61 0.57 0.93 0.126 
24 hours 0.65 0.60 0.90 0.128 
48 hours 0.69 0.59 0.90 0.126 

* Data are not statistically different according to the expected precision of the method (QC 3SD = 0.02) 
¥Data are not statistically different according to the expected precision of the method (QC 3SD = 0.2) 
*Data are not statistically different according to the expected precision of the method (QC 3SD = 1.08) 
#Data are not statistically different according to the expected precision of the method (QC 3SD = 0.22) 
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Appendix A.  Ruggedness Testing Results. (continued) 
 

Parameter Test 5 Results (Table 3 of 3 for 15 Element Panel).  All concentrations in 
ug/L.  Test begun 3/23/11 by Denise Tevis using ELAN DRC-2N. 
Sample 
ID 

Time from Preparation 
to Analysis Mn Sn Sr 

N
YD

O
H

 
U

E0
9-

05
‡ Characterized Mean 1.37 2.2   

(±2SD Range) (1.55 -1.19) (2.0-2.8)   
freshly prepared 0.98 2.8   

24 hours 1.26 2.6   
48 hours 1.47 2.6   

N
YD

O
H

 
U

E0
9-

06
‡ Characterized Mean 31.1 61   

(±2SD Range) (26.3 -35.9) (55.0 - 67.0)   
freshly prepared 23.8 68.5   

24 hours 30.6 62.8   
48 hours 31.9 61.4   

Se
ro

no
rm

 T
ra

ce
 

El
em

en
ts

 U
rin

e Characterized Mean 

§  

12.3 54.6 110 

(±2SD Range) (10.9 - 13.7) (51.9 - 57.3) (104 -116) 
freshly prepared 8.47 62.3 111 

24 hours 10.9 57.5 112 
48 hours 10.4 58.3 114 

§Purchased from Sero AS, Billingstad, Norway. 
‡ Purchased from  Wadsworth Center, New York State Department of Health 
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Appendix A.  Ruggedness Test #5 Results (continued) 
Parameter Test #5 (Arsenic)

 

:  Method descriptions and SOP assume preparation and 
analysis on same day.  Evaluate the impact on analysis results if the analytical run is 
prepared to analyze but circumstances do not allow for analysis to occur until 24 or 48 
hours later.  

Test Details
1. Three separate run sets (A, B, and C) were prepared at one sitting from the same 

starting materials.  Set ‘A’ was analyzed immediately per the assumption of the 
method.  Set’s ‘B’ and ‘C’ were stored at room temperature for 24 and 48 hours, 
respectively before analysis.  “Junk urine samples (20) were analyzed between the 
beginning and ending QC of each run, making each a normal length run.  All other 
method parameters were kept per method.   

:  

2. On day two, a fresh run set (“D”) was prepared and analyzed immediately for 
comparison to results from set “B” (Run 2 of the day.  Results not shown).   

3. On day three, another fresh run set (“E”) was prepared and analyzed immediately for 
comparison to results from set “C” (Run 2 of the day.  Results not shown). 

 
 
 

Parameter Test 4 Results (Arsenic).   
Test performed 5/26-28/10 by Graylin Mitchell using ELAN DRC2-G. 

QC  
Pool ID Axial Field Voltage Tested As (ug/L) 

LU-04310_UMP_e 

Characterized Mean 
Characterized  2SD Range 
Characterized 3SD Range 

3.74 
3.21 – 4.27 
2.95 – 4.53 

Fresh Preparation 3.40 

After 24 Hours 3.37 

After 48 Hours 3.41 

HU-04311_UMP_e  

Characterized Mean 
Characterized 2SD Range 

55.8 
53.3 – 58.3 

Fresh Preparation 54.7 

After 24 Hours 53.8 

After 48 Hours 53.5 
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Appendix B 
Table 1.  Instrument and Method Parameters.  Parameters are the same for arsenic 
and the 15 element panel unless otherwise noted. 
Instrument:  PerkinElmer ELAN DRCPlus

Autosampler: ESI SC4 Autosampler with FAST sample introduction system 
 or DRC II ICP-MS 

Optimization Window Parameters 
RF power 1.45 KW 

Plasma Gas Flow (Ar) 15 L/min 
Auxiliary Gas Flow (Ar) 1.2 L/min 

Nebulizer Gas Flow (Ar) ~0.90 – 1.0 L/min (optimized as needed for 
sensitivity) 

Ion Lens Voltage(s) AutoLens (optimized as needed for sensitivity) 
QRO, CRO, CPV, Discriminator 

Threshold 
Optimized per instrument by service engineer, or 
advanced user. 

Parameters of x-y alignment, nebulizer gas flow, AutoLens voltages, mass calibration, 
and detector voltages are optimized regularly.  Optimization file name = default.dac. 
Configurations Window Parameters 
Cell Gas Changes Pause Times Pressurize Delay (From Standard to DRC) = 30 

Exhaust Delay (From DRC to Standard mode) = 30 
Flow Delay (Gas changes while in DRC mode) = 30 
Channel Delay (channel change in DRC mode) = 30 

File Names & Directories 
Method file names  

Dataset Create a new dataset subfolder each day. Name as 
“2011-0718” for all work done on July 18, 2011 

Sample File Create for each day’s work 
Report file name For sample results printouts 

cdc_quant comprehensive_multielement.rop 
 
For calibration curve information 
CDC_Quant Comprehensive (calib curve info).rop 

Tuning Default.tun 
Optimization Default.dac 

Calibration N/A 
Polyatomic elan.ply 

Report Options Template 
(transferring results to the 

database) 

CDC_Database Output.rop 
Report Format Options:  select only “Use Separator” 
File Write Option:  Append 
Report File name:  include date, instrument, and 
group being analyzed in file name (i.e. 2005-
0311b_DRC2A_HM-0364.txt) 

Method Parameters 
     Method Parameters:  Timing Page (see Figures 2a and 3a in the Appendix) 

Sweeps/reading 70 
Readings/replicate 1 

Replicates 3 
Enable QC Checking Off 
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Table 1.  Instrument and Method Parameters.  Parameters are the same for arsenic 
and the 15 element panel unless otherwise noted. 

Isotopes Monitored   
and Internal Standard 

Associations 
(Exact Mass) 

For Arsenic 
(use 71Ga as an internal standard) 
71Ga (70.9249), 75

 
As (74.9216) 

For 15 Element Panel 
Group 1 (use 103Rh as an internal standard) 
9Be (9.0122), 59Co (58.9332), 88Sr (87.9056) ,98Mo 
(97.9055), 103Rh (102.905), 118Sn (117.902), 121Sb 
(120.904), 133Cs (132.905), 138

 
Ba (137.905) 

Group 2 (use 193Ir as an internal standard) 
184W (183.951), 193Ir (192.963), 195Pt (194.965), 205Tl 
(204.975), 208Pb (207.977), 238

 
U (238.05) 

Group 3 (use 103Rh as an internal standard) 
103Rh (102.905), 114Cd (113.904), 55

Dwell Times 
Mn (54.9381), 

30 ms for 59Co, 88Sr,98Mo, 118Sn,103Rh in Standard 
mode, 121Sb, 133Cs, 138Ba, 184W, 193Ir, 205Tl, and 208

50 ms for 
Pb 

71Ga , 75As and 55

100 ms for 
Mn in DRC mode 

9Be, 195Pt, 238U, 103Rh in DRC mode, and 
114

Scan Mode 
Cd  

Peak Hopping for all isotopes (1 MCA channel) 
DRC channel A Gas 

Flow Rate 
For Arsenic 
10% hydrogen / 90% argon  
(5-7 psig delivery pressure) 
 
Typically 0.7 to 1.3 mL/min * 
*(optimized per instrument, and periodically verified) 
 
For 15 Element Panel 
Not used. 

DRC channel B Gas 
Flow Rate 

For Arsenic 
Not used. 
 
For 15 Element Panel 
Oxygen (5-7 psig delivery pressure) 
Typically 2.0 – 2.5 mL/min * 
* (optimized instrument, and periodically verified) 

RPa 0 for all isotopes 
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Table 1.  Instrument and Method Parameters.  Parameters are the same for arsenic 
and the 15 element panel unless otherwise noted. 

RPq For Arsenic 
DRC Mode (As group):  Typically* 0.65 - 0.75 for 
71Ga (70.9249), 75

 

As (74.9216).  Use the same RPQ 
for each. 

For 15 Element Panel 
Standard Mode:  0.25 for all standard mode isotopes 
DRC Mode (Cd and Mn group):  default 0.45 *, 
typical range 0.35 - 0.55 for 114Cd (113.904) and 
55Mn (54.9381), and 103

 (* Optimize per instrument, and periodically verified) 

Rh (102.905) in DRC mode.  
Use the same RPQ for each. 

     Method Parameters:  Processing Page (see Figures 2b and 3b in the Appendix) 
Detector mode Pulse 

Process Spectral Peak N/A 
AutoLens On 

Isotope Ratio Mode Off 
Enable Short Settling Time Off 

Blank subtraction After internal standard 
Measurement units Cps 

Process Signal Profile N/A 
      
     Method Parameters:  Equations Page (see Figures 2c and 3c in the Appendix) 

Equations On 208

On 
Pb, use “+ Pb 206 + Pb 207” 

238

On 114Cd, use “- 0.027250 * Sn 118” 
U, use “+ U 235” 

     Method Parameters:  Calibration Page (see Figures 2d and 3d in the Appendix) 
Calibration Type External Std. 

Curve type Simple Linear  
Sample units “µg/L” or “ppb” 

Calibration Standard 
Concentrations (µg/L) 

Be:  0.1, 0.3, 1, 3, 10 
Co:  0.075, 0.225, 0.75, 2.25, 7.5 
Sr: 3, 9, 30, 90, 300 
Mo:  3, 9, 30, 90, 300 
Sn: 0.3, 0.9, 3, 9, 30 
Sb:  0.08, 0.24, 0.8, 2.4, 8 
Cs:  0.2, 0.6, 2, 6, 20 
Ba:  0.2, 0.6, 2, 6, 20 
W:  0.06, 0.18, 0.6, 1.8, 6 
Pt:  0.025, 0.075, 0.25, 0.75, 2.5 
Tl:  0.04, 0.12, 0.4, 1.2, 4 
Pb:  0.1, 0.3, 1, 3, 10 
U:  0.005, 0.015, 0.05, 0.15, 0.5 
Cd:  0.08, 0.24, 0.8, 2.4, 8 
Mn:  0.1, 0.3, 1, 3, 10 
As:  2, 6, 20, 60, 200 
 

     Method Parameters:  Sampling Page (see Figures 2e and 3e in the Appendix) 
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Table 1.  Instrument and Method Parameters.  Parameters are the same for arsenic 
and the 15 element panel unless otherwise noted. 

“Peristaltic Pump Under 
Computer Control” 

On 

Autosampler 
Tray 
Port 

Sampling Device 

If using ESI autosampler 
Autosampler Type: AS-93plus 
Tray Name: esi.try  
     (either use shortcut in 
C:\Elandata\Autosampler\AS-93 or  
     link to file in C:\program files\esi\esi sc\esi.try) 
Port: GPIB1 
Sampling Device: None 
 
If using other autosampler 
Refer to autosampler user guide. 

Sample Flush FAST Defaults For Arsenic 
6s at 6 rpm (standard ELAN peristaltic pump) 
6s at 3rpm (ESI micro-peristaltic pump) 
 
FAST Defaults For 15 Element Panel 
6s at 6 rpm (standard ELAN peristaltic pump) 
6s at 3rpm (ESI micro-peristaltic pump) 
 
Can be optimized as needed to adequately fill the 
FAST loop.  As a matter of lab practice, set this time 
to equal the loop fill time in the ESI FAST program.  
As long as the combined time of sample flush + read 
delay is equal to the time required for signal to reach 
stability, analytical measurement will be good. 
 

Read Delay Default For Arsenic 
24s at 6 rpm (standard ELAN peristaltic pump) 
24s at 3rpm  (ESI micro-peristaltic pump) 
 
Default For 15 Element Panel 
30s at 6 rpm (standard ELAN peristaltic pump) 
30s at 3rpm  (ESI micro-peristaltic pump) 
 
Can be optimized as needed to reach signal stability 
before beginning analysis.  As a matter of lab 
practice, set this time equal to the total time required 
for the signal to reach stability minus the loop fill 
time.  As long as the combined time of sample flush 
+ read delay is equal to the time required for signal 
to reach stability, analytical measurement will be 
good. 
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Table 1.  Instrument and Method Parameters.  Parameters are the same for arsenic 
and the 15 element panel unless otherwise noted. 

Wash Default For Arsenic 
20s at 6 rpm (standard ELAN peristaltic pump) 
20s at 3rpm (ESI micro-peristaltic pump) 
 
Can be optimized to allow for changes in FAST loop 
rinsing (must be greater than total time of steps in 
FAST program after the initial “on rinse” command). 
 
Default For 15 Element Panel 
50s at 6 rpm (standard ELAN peristaltic pump) 
50s at 3 rpm (default for entire panel) 
 

Autosampler Locations of Blanks 
and Standards 

For Arsenic 
For calibration curve (points to urine blank) 
CDC_UMP3_DLS3018A_Urine Arsenic_urblk.mth 
Urine Blank and Calibration Stds 1 – 5 in 
autosampler positions 102 – 107 by default, but can 
be customized. 
 
For QC & patient sample analysis (points to aqueous 
blank) 
CDC_UMP3_DLS3018A_Urine Arsenic_aqblk.mth 
Aqueous Blank in autosampler position 119, but can 
be customized. 
 
For 15 Element Panel 
For calibration curve (points to urine blank) 
CDC_UMP3_DLS3018_15 elem_urblk.mth 
Urine Blank and Calibration Stds 1 – 5 in 
autosampler positions 101 – 106, but can be 
customized. 
 
For QC & patient sample analysis (points to aqueous 
blank) 
CDC_UMP3_DLS3018_15 elem_aqblk.mth 
Aqueous Blank in autosampler position 119, but can 
be customized. 

 
     FAST Parameters: See Figures 4a through 4g in Appendix B for details 

Configuration File default.sc 
(saved at C:\Program Files\ESI\ESI-SC\) 

FAST program  For Arsenic  
CDC_UMP3_DLS3018A_Urine Arsenic_SCFAST.txt 
 
For 15 Element Panel 
Urine 15 element_mthUMP3_DLS3018_SCFAST.txt 
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Table 1.  Instrument and Method Parameters.  Parameters are the same for arsenic 
and the 15 element panel unless otherwise noted. 
 
 
Potential Emergency Response Modifications:   

Cadmium Analyze cadmium in standard mode with rhodium as 
the internal standard.  Set dwell time to 50ms, DRC 
gas flow to 0, and RPq to 0.25. 

: 

Arsenic • Use pure argon in place of 10% hydrogen 90% 
argon for the DRC gas.  A tee can be setup on 
the main argon delivery line for the ICP-MS to 
provide this argon for the DRC.  No modifications 
of the DRC gas flow rate necessary. 

: 

 
• Analyze arsenic along with the 15-element 

method to create a 16-element panel.  Diluent 
and reagents should not include ethanol.  Use 
revised QC limits for arsenic (will have “_CT” at 
the end of the QC pool name). 

Non-FAST sample introduction 
system

 
:   

If the FAST sample introduction system is not 
available on any instruments, the method can still be 
implemented, but these changes will need to be 
made in the ELAN (and ESI software if present). 
 
• Sample Flush

• 

:  Default is ~90s at 10 rpm.  Set so 
that solution reaches nebulizer.   
Read Delay

• 

:  Default is 20s at 10rpm.  Set for 
best reproducibility of replicate measured 
intensities. 
Wash

• If using ESI autosampler without FAST, disable 
FAST in the ESI software before running 
analysis.  

:  Default is 120s at 24rpm.  Set to prevent 
significant carry-over from one sample to the 
next. 
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Appendix B (continued) 
Table 2. Suggested maximum analyte concentrations for base urine. 

Analyte Concentration (µg/L) 
Be 0.5 
Co 0.25 
Mo 30 
Sb 0.2 
Cs 3 
Ba 2 
W 0.2 
Pt 0.25 
Tl 0.2 
Pb 0.75 
U 0.03 

Cd 0.25 
Mn 0.1 
Sr 80 
Sn 3 
As 5 
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Table 3. Concentrations of Analytes in the Multi-Element Stock Standard from 
High Purity Standards. 
 
 
Analyte 

Stock  
Calibration  

Standard Conc. (mg/L) 
High Purity Standards  

Item # SM-2107-029 

Stock  
Calibration Verification  
Standard Conc. (mg/L) 
High Purity Standards  
Item # SM-2107-035 

Be 10 200
Co 

 A 
7.5 300

Mo 

 A 
300 1800

Sb 

 B 
8 200

Cs 

 A 
20 1000

Ba 

 C 
20 300

W 

 B 
6 200

Pt 

 A 
2.5 700

TI 

D 
4 50

Pb 

 A 
10 500

U 

 A 
0.5 40

As 

 B 
200 6000

Cd 

 A 
8 200

Sr 

A 
300 8000

Sn 

 D 
30 600

Mn 

 A 
10 200 A 

A Solution A:  HNO3 (10%), HF (0.5%)          B  Solution B:  HCl (10%), trace HNO3 
C  Solution C:  HCl (1%)                                 D

 
  Solution D:  HCl (5%) 
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Appendix B (continued) 
Table 4.  Preparation of Multi-element Intermediate Working Standards 
Standard # 1 2 3 4 5 
Volume of 
Flask (mL) 500 200 100 100 100 

Volume 
Spike of 
Int. Stock 
Std. (mL) 

0.050 0.060 0.100 0.300 1.00 

 Concentrations (ug/L)
Be* 

 ‡ 
1 (0.1) 3 (0.3) ‡ 10 (1.0) ‡ 30 (3.0) ‡ 100 (10.0) ‡ 

Co* 
 ‡ 

0.75 (0.075) 2.25 (0.225) ‡ 7.5 (0.75) ‡ 22.5 (2.25) ‡ 75 (7.5) ‡ 
Mo* 

 ‡ 
30 (3.0) 90 (9.0) ‡ 300 (30)‡ 900 (90) ‡ 3000 (300) ‡ 

Sb* 
 ‡ 

0.8 (0.08) 2.4 (0.24) ‡ 8 (0.8) ‡ 24 (2.4) ‡ 80 (8.0) ‡ 
Cs* 

 ‡ 
2 (0.2) 6 (0.6) ‡ 20 (2.0) ‡ 60 (6.0) ‡ 200 (20) ‡ 

Ba* 
 ‡ 

2 (0.2) 6 (0.6) ‡ 20 (2.0) ‡ 60 (6.0) ‡ 200 (20) ‡ 
W

 ‡ 
0.6 (0.06)† 1.8 (0.18) ‡ 6 (6.0) ‡ 18 (1.8) ‡ 60 (6.0) ‡ 

Pt
 ‡ 

0.25 (0.025)† 0.75 (0.075) ‡ 2.5 (0.25) ‡ 7.5 (0.75) ‡ 25 (2.5) ‡ 
TI

 ‡ 
0.4 (0.04)† 1.2 (0.12) ‡ 4 (0.4) ‡ 12 (1.2) ‡ 40 (4.0) ‡ 

Pb
 ‡ 

1 (0.1)† 3 (0.3) ‡ 10 (1.0) ‡ 30 (3.0) ‡ 100 (10) ‡ 
U

 ‡ 
0.05 (0.005)† 0.15 (0.015) ‡ 0.5 (0.05) ‡ 1.5 (0.15) ‡ 5 (0.5) ‡ 

Cd* 
 ‡ 

0.8 (0.08) 2.4 (0.24) ‡ 8 (0.8) ‡ 24 (2.4)‡ 80 (8.0) ‡ 
Sr 

 ‡ 
30 (3.0) 90 (9.0) ‡ 300 (30) ‡ 900 (90)‡ 3000 (300)‡ 

Sn 
‡ 

3 (0.3) 9 (0.9) ‡ 30 (3.0) ‡ 90 (9.0)‡ 300 (30)‡ 
Mn* 

‡ 
1 (0.1) 3 (0.3) ‡ 10 (1.0) ‡ 30 (3.0) ‡ 100 (10) ‡ 

As
 ‡ 

20 (2.0)¥ 60 (6.0) ‡ 200 (20) ‡ 600 (60) ‡ 2000 (200) ‡ 

*  Rh-103 used as internal standard 

 ‡ 

†  Ir-193 used as internal standard 
¥ Ga-71 used as internal standard 
‡

 

  A further 1:10 dilution occurs when added to base urine.  Enter concentrations in parentheses 
into the ELAN software (method window, calibration page).  
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Appendix B (continued) 
 

Table 5.  Acceptable ways to perform two consecutive analytical runs, bracketing 
with bench quality control samples. 

Setup 1 Setup 2 (typical) 
Run #1 

Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 

Run #2 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 

Run #1 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 

Run #2 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
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Appendix B (continued) 
 

Table 6.  A typical SAMPLE/BATCH window. 
AS 

Location* 
Sample ID Measurements Action 

236 

Method 

DRCstability1 Run sample ....15elem_urblk.mth 
236 DRCstability2 Run sample ....15elem_urblk.mth 
236 DRCstability3 Run sample ....15elem_urblk.mth 
236 DRCstability4 Run sample ....15elem_urblk.mth 

                          Continue DRC stability samples  . . .  
236 DRCstability9 Run sample ....15elem_urblk.mth 
236 DRCstability10 Run sample £ ....15elem_urblk.mth 
101 UrBlkChk1 Run blank, standards, and 

sample ** 
....15elem_urblk.mth 

113 UrBlkChk2 Run sample ....15elem_urblk.mth 
120 Aq Blk Check Run blank and sample ¥ ....15elem_aqblk.mth    
130 L Bench QC Run sample ....15elem_aqblk.mth 
160 H Bench QC Run sample ....15elem_aqblk.mth 
301 Sample 1 Run sample ....15elem_aqblk.mth 
302 Sample 2 Run sample ....15elem_aqblk.mth 
303 Sample 3 Run sample ....15elem_aqblk.mth 
129 L Bench QC Run sample ....15elem_aqblk.mth 
159 H Bench QC Run sample ....15elem_aqblk.mth 

* The exact autosampler positions of QCs and patient samples do not have to be those shown 
above, but the order in which these are run should be as shown above. 
 
**  When executing this row, the ELAN will first analyze the urine blank at AS position 114, then 
standards 1-5 at autosampler positions 102-106, then

 

 the “UrBlkChk1” sample at A/S position 
100.  The sampling information about AS positions 102-106 are stored in the “urblk” method file 
and can be customized.   

¥  When executing this row, the ELAN will first analyze the aqueous blank at AS position 119, 
then the “Aq Blk Check” at AS position 120.  The sampling information about AS positions 119 is 
stored in the “urblk” method file and can be customized.   
 
£  A larger number of DRC stability samples will need to be analyzed to make this stability period 
1-1.5 hrs when measuring only arsenic (~55 measurements = 1hour). 
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Table 7.  Preparation of samples, working standards, and QC materials for 
analysis 
Total volume of prepared sample may be changed, from what is presented here.  
However, volumes for each component should be adjusted proportionally. 

Dilution ID Water 
(µL) 

Base 
Urine (µL) 

AQ Intermediate 
Working 

Standard (µL) 

Patient or 
QC urine 

sample (µL) 

Diluent 
(µL) 

AQ Blank 1000 - - - 9000 * 
Urine Blank and 

UrBlkChk 100 900 - - 9000 * 

Working 
Calibration 
Standards  

- 900 100 - 9000 * 

Patient Urine or  
Urine-Based QC - - - 500 4500 

Patient Urine 
2x Dilution 500 H - - 500 9000 * 

Patient Urine 
10x Dilution 900 H - - 100 9000* 

* 9000 µL diluent is best dispensed from the Digiflex™ as 2 4500-µL portions (i.e.- When 
preparing a Working Calibration Standard dilution, dispense 4500 µL diluent + 100 µL water in 
one cycle of Digiflex™, then 4500 µL diluent + 900 µL base urine in the next cycle of the 
Digiflex™ to prepare a 10 mL total volume dilution.) 

H

 

 Extra dilution is performed on urine samples whose concentration is greater than the 
concentrations listed in Table 8 in the Appendix (linearity of the method has been documented 
up to these concentrations).  Any extra level of dilution can be prepared as long as the 9:10 ratio 
of diluent to total dilution volume is maintained.  Use of the lowest possible dilution level is 
preferred because matrix differences may lead to different observed concentration results as the 
sample dilution becomes greater (i.e. 2x dilution is preferred over 10x if 2x is sufficient to dilute 
analyte into the documented linearity range).  
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Table 8.  Range of Reporting and Calibration Verification Concentrations 
Standard # CV-1 CV-2 CV-3 
Volume of Flask 
(mL) 

100 100 100 

Volume Spike of Int. 
Stock Std. (mL) 

Sol A         0.150 
Sol B         0.100 
Sol C         0.025 
Sol D         0.050 

0.250 
0.500 
0.125 
0.100 

0.500 
1.000 
0.250 
0.200 

Analyte Concentration (ug/L) 
Be* 300 (30) ‡ 500 (50)  1,000 (100) ‡ 
Co* 

 ‡ 
450 (45) 750 (75) ‡ 1,500 (150) ‡ 

Mo* 
 ‡ 

1,800 (180) 9,000 (900) ‡ 18,000 (1,800) ‡ 
Sb* 

 ‡ 
300 (30) 500 (50) ‡ 1,000 (100) ‡ 

Cs* 
 ‡ 

250 (25) 1,250 (125) ‡ 2,500 (250) ‡ 
Ba* 

 ‡ 
300 (30) 1,500 (150) ‡ 3,000 (300) ‡ 

W
 ‡ 

300 (30)† 500 (50) ‡ 1,000 (100) ‡ 
Pt

 ‡ 
350 (35)† 700 (70) ‡ 1,400 (140) ‡ 

Tl
 ‡ 

75 (7.5)† 125 (12.5) ‡ 250 (25) ‡ 
Pb

 ‡ 
750 (75)† 1,250 (125) ‡ 2,500 (250) ‡ 

U
 ‡ 

40 (4)† 200 (20) ‡ 400 (40) ‡ 
Cd* 

 ‡ 
300 (30) 500 (50) ‡ 1,000 (100) ‡ 

Mn 
 ‡ 

300 (30) 500 (50) ‡ 1,000 (100) ‡ 
Sr 

 ‡ 
4,000(400) 8,000 (800) ‡ 16,000 (1600) ‡ 

Sn 
 ‡ 

900 (90) 1,500 (150) ‡ 3000 (300) ‡ 
As

 ‡ 
9,000 (900)¥ 15,000 (1,500) ‡ 30,000 (3,000) ‡ 

*  Rh-103 used as internal standard 

 ‡ 

†  Ir-193 used as internal standard 
¥ Ga-71 used as internal standard 
‡

 

  A further 1:10 dilution occurs when added to base urine. 

* If observed results are not within 10% of target, investigate the problem 
with the involvement of the lab supervisor. 
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Table 9.  Boundary Concentrations for Urine Concentrations (µ/L). 
 

Analyte 
1st

Boundary  
 Upper 

(“1UB”) * 

2nd

Boundary 
 Upper 

(“2UB”) ** 

Range  
Maximum 

(“Lim Rep Delta”) 
Be 

† 
0.2 0.4 0.3 

Co 2.83 5.66 0.3 
Mo 293.5 587 4.0 
Sb 0.8 1.6 0.2 
Cs 16.5 33 0.5 
Ba 17.1 34.2 0.4 
W 1.38 2.76 0.2 
Pt 0.2 0.4 0.2 
TI 0.62 1.24 0.2 
Pb 7.8 15.6 0.3 
U 0.277 0.554 0.03 
Cd 2.54 5.08 0.3 
Mn 4 8 0.2 
Sr 400 800 3 
Sn 25 50 0.5 
As 100 200 10 

* Typically, the 1st upper boundary (1UB) is the 99th

 

 percentile of non-weighted, non-creatinine 
corrected concentration results from the NHANES 1999-2000 subset groups.   Concentrations 
observed greater than the “first upper boundary” (defined in the laboratory database as the 
“1UB”) should be confirmed by repeat analysis of a new sample preparation.  The concentration 
assigned to the 1UB for an element is determined by study protocol but default concentrations 
are listed in this table.  Report the original result, as long as the confirmation is within 10% of the 
original.    Continue repeat analysis until a concentration can be confirmed. 

** Typically the 2nd

 

 upper boundary (2UB) is set to 2x the 1UB.   At the discretion of the 
supervisor, the 1UB may vary per study according to the concerns of the study.  Regardless of 
the study, report patient results confirmed to be greater than the 2UB to the QC reviewer as an 
“elevated result”.   

† Range maximum is the range of the three replicate readings for a single sample analysis.  This 
value is also called the “Lim RepDelta” in the database which handles data for the Inorganic and 
Radiation Analytical Toxicology Branch.  If the range of replicate readings is greater than the 
range maximum, and represents greater than a 10% relative standard deviation for the 
measurement, do not use the measurement for reporting.   
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Appendix B (continued) 
 

 
  

Table 10.  Reference Ranges for Urine Concentrations (from the Third National Report 
on Exposure to Environmental Chemicals [14] ).  All results in µg/L. 

Analyte Survey 
Years 

Geometric 
Mean 50 75th 90th th 95 N th 

Be 99-00 ≤ 0.13 * ≤ 0.13 ≤ 0.13 ≤ 0.13 ≤ 0.13 2465 
 01-02 ≤ 0.13 ≤ 0.13 ≤ 0.13 ≤ 0.13 ≤ 0.13 2690 

Co 99-00 0.375 0.400 0.630 0.940 1.32 2465 
 01-02 0.379 0.410 0.610 0.930 1.27 2690 

Mo 99-00 45.9 50.7 84.9 134 178 2257 
 01-02 45.0 52.4 83.3 124 165 2690 

Sb 99-00 0.132 0.130 0.210 0.330 0.420 2276 
 01-02 0.134 0.130 0.180 0.260 0.340 2690 

Cs 99-00 4.35 4.80 7.10 9.60 11.4 2464 
 01-02 4.81 5.49 7.91 10.4 12.6 2690 

Ba 99-00 1.50 1.50 3.00 5.40 6.80 2180 
 01-02 1.52 1.63 3.12 5.22 7.48 2690 

W 99-00 0.093 0.090 0.180 0.320 0.500 2338 
 01-02 0.082 0.060 0.150 0.300 0.450 2652 

Pt 99-00 ≤ 0.04 ** ≤ 0.04 ≤ 0.04 ≤ 0.04 ≤ 0.04 2465 
 01-02 ≤ 0.04 ≤ 0.04 ≤ 0.04 ≤ 0.04 ≤ 0.04 2690 

TI 99-00 0.176 0.200 0.280 0.400 0.450 2413 
 01-02 0.165 0.180 0.270 0.360 0.440 2653 

Pb 99-00 0.766 0.800 1.30 2.10 2.90 2465 
 01-02 0.677 0.600 1.20 2.00 2.60 2690 

U 99-00 0.008 0.007 0.013 0.026 0.046 2464 
 01-02 0.009 0.008 0.014 0.029 0.046 2690 

Cd 99-00 0.193 0.232 0.475 0.858 1.20 2257 
 01-02 0.210 0.229 0.458 0.839 1.20 2690 

As See Table 11  in Appendix B for urine arsenic reference values. † 
      *  Results were lower than the method detection limit of 0.13 ug/L. 
     ** Results were lower than the method detection limit of 0.04 ug/L. 
         †

          Environmental Chemicals.  
  Urine As was not included in the  Third National Report on Exposure to  
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Table 11.  References to Total Urine Arsenic Concentrations 
Reference Concentration (µg/L) 

Normal 
Group Type Sampled 

Stokinger, 1981 [15] <100  
Fowler, 1977 [16] 15  

Iffland, 1994 [17] 1 – 80 
(Generally < 10) 

 

Elevated 

Iffland, 1994 [17] 

300 
 

200 
 

5 - 952  
vs. 5 - 365 

 
25.9 – 667 

 
74.1 

378.1 

After seafood consumption 
 

Copper smelter workers 
 

Wood treatment workers 
 vs. comparison group (11) 

 
Seafood-preferring population 

 
Low-Inhalation exposure 

High-Inhalation exposure (12) 

Gerhardsson et al., 1996 
[18] 50 – 100 

High intake of seafood or 
increased exposure of inorganic 

arsenic from food or air 
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Table 12. Reference to urine Mn, Sn, or Sr concentrations 

Analyte Reference Concentration (ug/L) Group Type 
Sampled 

Normal (i.e. non-exposed) 
Mn Health Canada, 2010[19] 0.15 General population 
Mn Heitland et al., 2006[20] 0.1 German children 
Mn Heitland et al., 2006[20] 0.087 German adults 
Mn Paschal et al., 1998[21] 1.19 NHANES III 
Mn ASTDR[22] 1 to 8 General population 
Sr Heitland et al., 2006[20] 154 German children 
Sr Heitland et al., 2006[20] 166 German adults 
Sr Usuda et al., 2006 143.9 Japanese adults ¥ 
Sn Heitland et al., 2006[20] 1.2 German children 
Sn Heitland et al., 2006[20] 8.6 German adults 
Sn Paschal et al., 1998[21] 6.29 NHANES III 

Elevated (exposed) 

Mn Moreno et al., 2010[23] 5.2 
Children living in a 
mine tailings zone 

in Mexico 

Mn Gil et al., 2011[24] 0.43 +/- 4,00 
Iron and steel 

industry workers in 
Spain 

Mn Wang et al., 2011[25] 3.15 +/- 3.45 e-waste dismantling 
workers in China 

Sr Moreno et al., 2010[23] 49.2 
Children living in a 
mine tailings zone 

in Mexico 

Sn Juliao et al., 2007[26] 0.45 +/- 0.93 
Workers in a 

niobium mine in 
Brazil 

    
¥ 

 
concentration is a geometric mean and measurements were made via ICP-AES 
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Appendix B (continued):  Figures 
 
Figure 1a.  Configuration of tubing and devices for liquid handling using FAST 
sample introduction. 
 
Below shows the correct connections to the 6-port FAST valve.  The two diagrams show 
the differences in liquid flow directions when the valve changes from “Load” to “Inject” 
This change is internal to the valve.  The shift of the valve cannot be seen, but it can be 
heard, and felt (with hand on the valve).  The light indicators on the actuator body also 
indicate the valve position.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The connections to the valve are color-coded (see section 7.a.2). 
 
Enable the FAST program in the ESI software before running the method, but 
optimizations can be done in either FAST or non-FAST mode. 
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Appendix B (continued).   
Figure 2a.  ELAN ICP-DC-MS Method Screen Shots (timing page, 15 element 
panel).  
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Appendix B (continued). 
Figure 2b.  ELAN ICP-DC-MS Method Screen Shots (processing page, 15 element 
panel). 
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Appendix B (continued). 
Figure 2c.  ELAN ICP-DC-MS Method Screen Shots (equation page, 15 element 
panel). 
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Appendix B (continued). 
Figure 2d.  ELAN ICP-DC-MS Method Screen Shots (calibration page, 15 element 
panel). 
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Appendix B (continued). 
Figure 2e.  ELAN ICP-DC-MS Method Screen Shots (sampling page, 15 element 
panel). 
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Appendix B (continued). 
Figure 2f.  ELAN ICP-DC-MS Method Screen Shots (report page, 15 element 
panel). 
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Appendix B (continued).   
Figure 3a.  ELAN ICP-DC-MS Method Screen Shots (timing page, arsenic). 
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Appendix B(continued). 
 
Figure 3b.  ELAN ICP-DC-MS Method Screen Shots (processing page, arsenic). 
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Appendix B (continued). 
Figure 3c.  ELAN ICP-DC-MS Method Screen Shots (equation page, arsenic). 
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Appendix B (continued). 
Figure 3d.  ELAN ICP-DC-MS Method Screen Shots (calibration page, arsenic). 
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Appendix B (continued). 
Figure 3e.  ELAN ICP-DC-MS Method Screen Shots (sampling page, arsenic). 

 
 
 
 
 
  

P
um

p 
sp

ee
d 

sh
ow

n 
is

 fo
r E

S
I m

ic
ro

-
pe

ris
ta

lti
c 

pu
m

p.
   

E
LA

N
 s

ta
nd

ar
d 

pu
m

p 
sp

ee
d 

is
 6

 rp
m

. 



Urine Multi-Element ICP-DRC-MS                                                     Page    96 of 103 
IRAT-DLS Method Code:  3018 and 3018A  
 

 

Appendix B (continued). 
Figure 3f.  ELAN ICP-DC-MS Method Screen Shots (report page, arsenic). 
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Appendix B (continued). 
Figure 4a.  ESI SC4 Autosampler Screen Shots used (Main page).  Additional flush 
times and “Max Rinse Time” are default, but can be optimized for best reduction of 
elemental carry-over between samples.  Tray types can be changed to allow for 
different volumes of diluted sample digests.  ‘FAST control’ must be enabled before 
start of method, but does not need to be used in instrument optimization (pre-analysis) 
steps.  Rinse and additional flush times for eliminating carry-over from one sample to 
the next while using the minimum amount of rinse solution. 
 
A rinse time of -1 causes the rinse station to be skipped. 
A rinse time of 0 causes the probe to only dip into the station, but spends no time there. 
Additional flush times can be optimized to keep the rinse station full while not using too 
much rinse solution.  The inner diameter size of the tubing providing the rinse solution to 
the rinse station determines how quickly the station will fill.  Various sizes are available 
for purchase or can be made in the laboratory. 
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Appendix B (continued). 
Figure 4b.  ESI SC4 Autosampler Screen Shots used (“Configure” page).  “High 
Speed” option is to only be used for ‘High Speed’ models of the SC4 (look for “HS” in 
serial number).  Speeds and accel / decel values can be optimized per analyst 
preference and to minimize droplet splatter off of probe. 

 
 
Figure 4c .  ESI SC4 Autosampler Screen Shots used (“Communication” page).  
Communication ports will differ depending on available ports on instrument control 
computer. 
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Appendix B (continued). 
Figure 4d.  ESI SC4 Autosampler Screen Shots (“FAST” page) *used for Arsenic 
only*.  Timer A can be optimized to achieve proper filling of loop with diluted sample 
digestate.  Timers B, C, D, E, and F control rinsing the loop after analysis and can be 
optimized for eliminating carry-over from one sample to the next while using the 
minimum amount of rinse solution.  File should be saved with the name “Urine 
Arsenic_methITU001B_HPS2107-003_SCFAST.txt”.  It can be found in the directory 
C:\Program Files\ESI\ESI-SC\. 
 
Manually clicking the “Load” button prior to starting analysis will ensure the position of 
the actuator is always the same at the beginning of the analysis. 
 
Manually clicking the “Vacuum On” button prior to starting the analysis will help initial 
sample uptake to be consistent (the vacuum pump may be slow to start for the first 
sample if this is not done, possibly resulting in loop filling inconsistencies). 
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Appendix B (continued). 
Figure 4e.  ESI SC4 Autosampler Screen Shots (5x12 Rack Setup window). 
Settings are approximate.  To be sure the loop is filled, the probe should go down close 
to the bottom of the cup, but not touch. Optimize retraction speed for least droplet 
splatter. 

 
 
Figure 4f.  ESI SC4 Autosampler Screen Shots (50mL Tube Rack Setup window). 
Settings are approximate.  To be sure the loop is filled, the probe should go down close 
to the bottom of the cup, but not touch. Optimize retraction speed for least droplet 
splatter. 
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Appendix B (continued). 
 
Figure 4g.  ESI SC4 Autosampler Screen Shots (Rinse Station Rack Setup 
Window).  Settings are approximate.  Optimize down height for best probe cleaning, 
and retraction speed for least droplet splatter. 
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1) Clinical Relevance & Summary of Test Principle 

 
a. Clinical Relevance: 

 
Metals ions affect human health in various ways.  Some metals (i.e. lead, 
cadmium, and mercury) show only deleterious effects on human health.  Some 
(i.e. selenium and manganese) play an essential role in the human biological 
system if within certain concentration ranges, while negative health implications 
are observed when concentrations in biological systems are in deficit or excess.  
Determination of a person’s level of environmental exposure to chemicals 
through direct measurement of the substances or their metabolites in human 
specimens such as blood is called biomonitoring.  Biomonitoring reduces the 
uncertainty of determining levels of  exposure over making these determinations 
through calculations of estimated dose based on analysis of environmental 
samples and assumptions about exposure pathways[1].  Biomonitoring 
measurements are the most health-relevant assessments of exposure because 
they indicate the amount of the chemical that actually gets into people from all 
environmental sources (e.g., air, soil, water, dust, or food) combined, rather than 
the amount that may get into them.  The laboratory method described here is a 
multi-element technique for monitoring the concentrations of cadmium (Cd), lead 
(Pb), manganese (Mn), mercury (Hg), and selenium (Se) in whole human blood 
for the purpose of biomonitoring. 

 
There is no known biological role of mercury in the human body.  The main 
sources of mercury intake in humans are fish, dental amalgams, and 
occupational exposures[2].  The main organs affected by mercury are the brain 
and the kidneys. Exposure of childbearing-aged women is of particular concern 
because of the potential adverse neurologic effects of Hg in fetuses.  The health 
effects of mercury are diverse and depend on the form of mercury encountered 
and the severity and length of exposure.  The general population may be 
exposed to three forms of mercury:  elemental, inorganic, and organic 
(predominantly methyl).  However, this method tests only for the total amount of 
mercury in the blood without regard to chemical form.  In the general population, 
total blood mercury is due mostly to the dietary intake of organic forms which are 
formed through microbial action from inorganic mercury that has deposited in 
aquatic environments and bioaccumulated through the food chain (especially into 
large predatory fish)[3].  Exposure to inorganic or elemental mercury (e.g. dental 
amalgams or occupational exposures) is particularly reflected in urine excretion 
rather than blood.  Psychic and emotional disturbances are the initial signs of 
chronic intoxication by elemental mercury vapors or salts.  Parasthesia, 
neuralgias, renal disease, digestive disturbances, and ocular lesions may 
develop[4]. Massive exposure over a longer period of time results in violent 
muscular spasms, hallucinations, delirium, and death[5].  Except for 
methylmercury exposures, blood is considered useful if samples are taken within 
a few days of exposure. This is because most forms of mercury in the blood 
decrease by one-half every three days if exposure has been stopped. Thus, 
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mercury levels in the blood provide more useful information after recent 
exposures than after long-term exposures. Several months after an exposure, 
mercury levels in the blood and urine are much lower.  Table 12 in Appendix B 
lists reference concentrations which have been reported in the literature. 
 
There is no known biological role of lead in the human body.  Lead, a naturally 
occurring metal, has had many different commercial uses from which a person 
can be exposed either in the occupational / manufacturing process or by the 
manufactured products such as paint (paint chips, or dust and soil contaminated 
from deteriorating paint), solder or pipes (only now in older homes), gasoline 
(now outlawed for all but specialized applications), glazes on pottery, hobby uses 
(e.g. stained glass), commercial products (e.g. batteries, lead-containing jewelry), 
home remedy medicines containing lead compounds and non-Western 
cosmetics.  Soil may contain lead naturally, or from man-made uses of lead such 
as paint (near older homes), gasoline (near roadways), mining, manufacturing, 
and disposal.  The main target for lead toxicity is the nervous system, both in 
adults and children.  The developing biological systems of children are most 
sensitive to the effects of Pb, where effects are being recognized even at blood 
lead levels <10 g/dL[6].  In its initial phase, acute lead poisoning is associated 
with anorexia, dyspepsia, and constipation followed by diffuse paroxysmal 
abdominal pain. Lead exposure may cause encephalopathy, particularly in 
children[7].  The alkyl lead species are highly toxic to the central nervous 
system[8].  The primary screening method for lead exposure is blood lead, which 
primarily reflects recent exposures (excretory half-life in blood is approximately 
30 days)[9].  Lead in blood is primarily (99%) in the red blood cells.  Table 12 in 
Appendix B lists reference concentrations which have been reported in the 
literature. 
 
There is no known biological role of cadmium in the human body.  The 
predominant commercial use of cadmium is in battery manufacturing. Other uses 
include pigment production, coatings and plating, plastic stabilizers, and 
nonferrous alloys. Since 2001, U.S. cadmium use has declined in response to 
environmental concerns.  In the United States, for nonsmokers the primary 
source of cadmium exposure is from the food supply.  People who regularly 
consume shellfish and organ meats will have higher exposures.  In general, leafy 
vegetables such as lettuce and spinach, potatoes and grains, peanuts, 
soybeans, and sunflower seeds contain high levels of cadmium due to 
bioaccumulation from the soil.  Tobacco leaves accumulate high levels of 
cadmium from the soil, and smoking is the primary non-occupational source of 
cadmium exposure for smokers.  Generally, the critical organ for Cd is the 
kidney.  Kidney dysfunction is one of the most characteristic signs of exposure to 
Cd.  Workers in an environment with high exposure levels have developed 
proteinuria, renal glucosuria, aminoaciduria, hypercalciuria, phosphaturia, and 
polyuria. Chronic obstructive lung disease of varying degrees of severities is 
frequently seen in Cd workers. Concentration of cadmium in blood of healthy 
unexposed adults are in the range 0.1 – 4 g/L[10].  Newborn babies are 
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practically free of Cd[11].  Exposure to high concentration of fumes appearing 
from heated cadmium metal or compounds has led to acute poisoning and in 
some cases to the death of workers[7].  Principal symptoms reported were 
respiratory distress due to chemical pneumonitis and edema. It has been 
estimated that 8 hrs exposure to 5 gm Cd/m3 will be lethal[7]. Ingestion of high 
amounts of Cd may lead to a rapid onset with severe nausea, vomiting, and 
abdominal pain. Cadmium levels in blood, urine, feces, liver, kidney, hair, and 
other tissues have been used as biological indicators of exposure to cadmium.  
Blood cadmium levels are principally indicative of recent exposure(s) to cadmium 
rather than whole-body burdens[12-15].  Urine cadmium levels primarily reflect 
total body burden of cadmium, although urine levels do respond somewhat to 
recent exposure[16].  Table 12 in Appendix B lists reference concentrations 
which have been reported in the literature. 
 
Manganese (Mn) is a trace element essential to humans and is associated with 
the formation of connective and bony tissue, growth and reproductive functions 
and with carbohydrate and lipid metabolism [17]. Manganese is also a known 
neurotoxin but little information exists about levels of manganese that cause 
toxicity.  Symptoms of manganese toxicity are similar to Parkinson’s Disease and 
can also include disorientation, memory impairment, anxiety and compulsive 
behavior [18]. There is much concern for the levels of manganese in humans 
whom are occupationally exposed to it [19-25].  Recently, there are growing 
concerns over exposure due to contamination of drinking water with manganese 
[26-28] and as a result of methylcyclopentadienyl mangangese tricarbonyl (MMT) 
used as an anti-knocking additive in gasoline[29-35].  Populations suffering from 
iron deficiencies may be particularly susceptible to manganese toxicity because 
iron deficiency may lead to an accumulation of manganese in the central nervous 
system [32].  To fully understand the essentiality and toxicity of manganese, 
further investigations are needed regarding the levels of manganese in biological 
matrices. Group average levels in blood appear to be related to manganese body 
burden, while average urinary excretion levels appear to be most indicative of 
recent exposures[36].  On an individual basis the correlation between the level of 
workplace exposure and the levels in blood or urine has always been found to be 
a reliable predictor of exposure[20, 36-38].  Manganese in blood or urine may be 
useful in detecting groups with above-average current exposure, but 
measurements of manganese in these body fluids in individuals may only be 
related to exposure dose after the exposure has ceased.  In addition to individual 
variability, another factor that limits the usefulness of measuring manganese in 
blood, urine, or feces as a measure of excess manganese exposure is the 
relatively rapid rate of manganese clearance from the body.  Excess manganese 
in blood is rapidly removed by the liver and excreted into the bile, with very little 
excretion in urine[39, 40]. Thus, levels of manganese in blood or urine are not 
expected to be the most sensitive indicators of exposure[41].  Table 12 in 
Appendix B lists reference concentrations which have been reported in the 
literature. 
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Selenium is an essential element  that is required to maintain good health but 
both selenium deficiency and excessive levels of selenium are associated with 
several disorders[42, 43]. Selenium is a naturally occurring mineral element that 
is distributed widely in nature in most rocks and soils.  Most processed selenium 
is used in the electronics industry, but it is also used: as a nutritional supplement; 
in the glass industry; as a component of pigments in plastics, paints, enamels, 
inks, and rubber; in the preparation of pharmaceuticals; as a nutritional feed 
additive for poultry and livestock; in pesticide formulations; in rubber production; 
as an ingredient in antidandruff shampoos; and as a constituent of fungicides. 
Radioactive selenium is used in diagnostic medicine.  In the body, selenium is 
incorporated into proteins to make selenoproteins, which are important 
antioxidant enzymes. The antioxidant properties of selenoproteins help prevent 
cellular damage from free radicals. Free radicals are natural by-products of 
oxygen metabolism that may contribute to the development of chronic diseases 
such as cancer and heart disease[43, 44]. Other selenoproteins help regulate 
thyroid function and play a role in the immune system[45-48]. Human selenium 
deficiency is rare in the U.S. but is seen in other countries where soil 
concentration of selenium is low[49]. There is evidence that selenium deficiency 
may contribute to development of a form of heart disease, hypothyroidism, and a 
weakened immune system[50, 51]. There is also evidence that selenium 
deficiency does not usually cause illness by itself. Rather, it can make the body 
more susceptible to illnesses caused by other nutritional, biochemical or 
infectious stresses[52].  Symptoms of very high exposure to selenium, a 
condition called selenosis, include gastrointestinal upsets, hair loss, white blotchy 
nails, garlic breath odor, fatigue, irritability, and mild nerve damage[42].  
Selenium can be detected in the blood, feces, urine, hair, and nails of exposed 
individuals, however, field studies have used primarily blood or urine levels to 
indicate the degree of selenium exposure[53].  Table 12 in Appendix B lists 
reference concentrations which have been reported in the literature. 
 
The laboratory method presented here can be used to achieve rapid and 
accurate quantification of five elements of toxicological and nutritional interest 
including cadmium (Cd), lead (Pb), mercury, manganese (Mn) and selenium (Se) 
in whole human blood.  The method may be used to screen blood when people 
are suspected to be acutely exposed to these elements or to evaluate chronic 
environmental or other non-occupational exposure.   
 

b. Test Principle:   
This method directly measures the Cd, Mn, Hg, Pb, and Se content of whole 
blood specimens using mass spectrometry after a simple dilution sample 
preparation step.   
 
During the sample dilution step, a small volume of whole blood is extracted from 
a larger whole blood patient specimen after the entire specimen is mixed 
(vortexed) to create a uniform distribution of cellular components.  This mixing 
step is important because some metals (e.g. Pb) are known to be associated 
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mostly with the red blood cells in the specimen and a uniform distribution of this 
cellular material must be produced before a small volume extracted from the 
larger specimen will accurately reflect the average metal concentration of all 
fractions of the larger specimen.  Coagulation is the process in which blood forms 
solid clots from its cellular components.  If steps are not taken to prevent this 
process from occurring, i.e. addition of anti-coagulant reagents such as EDTA in 
the blood collection tube prior to blood collection, blood will immediately begin to 
form clots once leaving the body and entering the tube.  These clots prevent the 
uniform distribution of cellular material in the blood specimen even after rigorous 
mixing, making a representative sub-sample of the larger specimen unattainable.  
It is important that prior to or during sample preparation the analyst identify any 
sample having clots or micro-clots (small clots).  Consequently, blood samples 
containing clots should not be analyzed by this method due to the inhomogeneity 
issues and expected results from the sample should be documented as not 
reportable. 
 
Dilution of the blood in the sample preparation step prior to analysis is a simple 
dilution of 1 part sample + 1 part water + 48 parts diluent.  The effects of the 
chemicals in the diluent are to release metals bound to red blood cells making 
them available for ionization, reduce ionization suppression by the biological 
matrix, prevent clogging of the sample introduction system pathways by 
undissolved biological solids, and allow introduction of internal standards to be 
utilized in the analysis step.  Tetramethylammonium hydroxide (TMAH, 0.25% 
v/v) and Triton X-100 (0.05%) in the sample diluent solubilizes blood 
components.  Triton X-100 also helps prevent biological deposits on internal 
surfaces of the instrument’s sample introduction system and reduce collection of 
air bubbles in sample transport tubing.  Ammonium pyrrolidine dithiocarbamate 
(APDC) in the sample diluent (0.25%) aids in solubilizing metals released from 
the biological matrix.  Ethyl alcohol in the sample diluent (1%) aids solubility of 
blood components and aids in aerosol generation by reduction of the surface 
tension of the solution.  The internal standards, rhodium, iridium and tellurium, 
are at a constant concentration in all blanks, calibrators, QC, and samples.  
Monitoring the instrument signal ratio of a metal to its internal standard allows 
correction for instrument noise and drift, and sample-to-sample matrix 
differences. 
 
Liquid samples are introduced into the mass spectrometer through the inductively 
coupled plasma (ICP) ionization source.  The liquid diluted blood sample is 
forced through a nebulizer which converts the bulk liquid into small droplets in an 
argon aerosol.  The smaller droplets from the aerosol are selectively passed 
through the spray chamber by a flowing argon stream into the ICP.  By coupling 
radio-frequency power into flowing argon, plasma is created in which the 
predominant species are positive argon ions and electrons and has a 
temperature of 6000-8000 K.  The small aerosol droplets pass through a region 
of the plasma and the thermal energy vaporizes the liquid droplets, atomizes the 
molecules of the sample and then ionizes the atoms.  The ions, along with the 
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argon, enter the mass spectrometer through an interface that separates the ICP 
(at atmospheric pressure, ~760 torr) from the mass spectrometer (operating at a 
pressure of 10-5 torr).  The ions first pass through a focusing region, then the 
dynamic reaction cell (DRC), the quadrupole mass filter, and finally are 
selectively counted in rapid sequence at the detector allowing individual isotopes 
of an element to be determined.  

 
Generally, the DRC operates in one of two modes.  In ‘vented’ (or ‘standard’) 
mode the cell is not pressurized and ions pass through the cell to the quadrupole 
mass filter unaffected.  In ‘DRC’ mode, the cell is pressurized with a gas for the 
purpose of causing collisions and/or reactions between the fill gas and the 
incoming ions.  In general, collisions or reactions with the incoming ions 
selectively occur to either eliminate an interfering ion, change the ion of interest 
to a new mass, which is free from interference, or collisions between ions in the 
beam and the DRC gas can focus the ion beam to the middle of the cell and 
increase the ion signal.  In this method, the instrument is operated in DRC mode 
when analyzing for manganese, mercury and selenium.  For selenium, the DRC 
is pressurized with methane gas (CH4, 99.999%) which reduces the signal from 
40Ar2

+ while allowing the 80Se+ ions to pass relatively unaffected through the DRC 
on toward the analytical quadrupole and detector.  Manganese and mercury are 
both measured when the DRC is pressurized with oxygen gas (O2, 99.999%).  
They are analyzed at the same flow rate of oxygen to the DRC cell to avoid 
lengthening analysis time due to pause delays that would be necessary if 
different gas flows were used for the two analytes.  The oxygen reduces the ion 
signal from several interfering ions (37Cl18O+, 40Ar15N+, 38Ar16O1H+, 54Fe1H+) while 
allowing the Mn+ ion stream to pass relatively unaffected through the DRC on 
toward the analytical quadrupole and detector.  In the case of mercury, collisional 
focusing of the mercury ions occurs, increasing the observed mercury signal at 
the detector by approximately a factor of two (2x).   
 
Once ions pass through the DRC cell and electrically selected for passage 
through the analytical quadrupole, electrical signals resulting from the ions 
striking the discrete dynode detector are processed into digital information that is 
used to indicate the intensity of the ions.  The intensity of ions detected while 
aspirating an unknown sample is correlated to an elemental concentration 
through comparison of the analyte:internal standard signal ratio with that 
obtained when aspirating calibration standards.  This method was originally 
based on the method by Lutz et al.[54]  The DRC portions of the method are 
based on work published by Tanner et al. [55, 56].   
 

2) Limitations of Method; Interfering Substances and Conditions 
 

a. Interferences Addressed by This Method 
 

i. Reduction of argon dimer (40Ar2+) interference on selenium (80Se+) using ICP-
DRC-MS:  40Ar2+ is a polyatomic ion formed in the plasma as a result of a 
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reaction between the plasma gas (Ar) and itself.  The dynamic reaction cell of 
the ELAN ICP-DRC-MS is used to reduce ion signals from polyatomic ions via 
ion-molecule reaction chemistry [56, 57].  In the reaction cell, methane (CH4) 
molecules react with 40Ar2+ ions through a charge transfer reaction.  The 
products of the reaction are 40Ar+ (ion at a different mass) and 40Ar (neutral).  
The background ion signal at m/z 80 is reduced by six orders of magnitude 
because of this reaction. 
 

ii. Reduction of argon nitride (40Ar15N+), argon hydroxide (38Ar16O1H+) 
interference on manganese (55Mn) using ICP-DRC-MS:  40Ar15N+ and 
38Ar16O1H+ are polyatomic ions formed in the plasma as a result of reactions 
between the plasma gas (Ar) and atmospheric gases (N2, O2) or the solvent 
(H2O). The dynamic reaction cell of the ELAN ICP-DRC-MS is used to reduce 
ion signals from polyatomic ions via ion-molecule reaction chemistry[56, 57].  
In the reaction cell, oxygen molecules react with 40Ar15N+ and 38Ar16O1H+ ions 
through either charge transfer reactions or oxygen transfer reactions.  The 
products of the reactions are either neutral molecules and are not detected 
(charge transfer), or a new ion with higher mass (oxygen transfer).  In either 
case, attenuation of the background ion signal at m/z 55 occurs. 

 
iii. Reduction of 37Cl18O+, 39K16O+, 54Fe1H+ interferences on manganese (55Mn) 

using ICP-DRC-MS:  37Cl18O+, 39K16O+, 54Fe1H+ are polyatomic ions created in 
the plasma as a result of reactions between elements present in the blood 
matrix (Cl, K, and Fe) and the solvent (H2O).  Due to the high concentrations of 
Cl, K, and Fe in the blood matrix the resulting ion signals of 37Cl18O+, 39K16O+, 
and 54Fe1H+ interfere with the measurement of 55Mn+ at m/z 55.  The dynamic 
reaction cell of the ELAN ICP-DRC-MS is used to reduce ion signals from 
polyatomic ions via ion-molecule reaction chemistry[56, 57]. In the reaction 
cell, oxygen molecules react with 37Cl18O+, 39K16O+, 54Fe1H+ ions through either 
charge transfer reactions or oxygen transfer reactions.  The products of the 
reactions are either neutral molecules and are not detected (charge transfer), 
or a new ions with higher mass (oxygen transfer).  In either case, attenuation 
of the background ion signal at m/z 55 occurs.  

 
3) Procedures for Collecting, Storing, and Handling Specimens; Criteria for 

Specimen Rejection; Specimen Accountability and Tracking 
 
a. Procedures for Collecting, Storing, and Handling Specimens:  Specimen handling 

conditions, special requirements, and procedures for collection and transport are 
discussed in the division (DLS) Policies and Procedures Manual [58].  Copies are 
available in branch, laboratory, and special activities specimen-handling offices.  
An electronic copy is available at:         
http://intranet.nceh.cdc.gov/dls/pdf/policiesprocedures/Policy_and_Procedures_
Manual.DLS.2002mod.pdf.  In general, 

 
i. No fasting or special diets are required before collection of blood 
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ii. Specimen type – whole blood 

 
iii. Optimal amount of specimen is 1-2 ml.  Request a minimum volume of 0.4 ml.  

Volume for one analytical measurement is 0.1 ml. 
 

iv. Sample collection devices and containers should be verified to be free of 
significant contamination (“pre-screened”) before use. 

 
v. Draw the blood through a stainless steel needle into a pre-screened 

vacutainer. 
 

vi. Blood specimens should be transported and stored at  4oC. Once received, 
they can be frozen at  -20oC until time for analysis.  Specimen stability has 
been demonstrated for several months at ≤ -20C. 

 
b. Criteria for Specimen Rejection:  The criteria for an unacceptable specimen 

include: 
 

i. Contamination:  Improper collection procedures, collection devices, or sample 
handling can contaminate the blood through contact with dust, dirt, etc.  
Manganese is present in the general environment, found often in combination 
with iron, and is present in many alloys (especially stainless steel).  

 
ii. Low Volume:  Request a minimum volume of 0.4 ml.  Volume for one analytical 

measurement is 0.1 ml.   
 

In all cases, a second blood specimen should be requested.  
 

c. Transfer or Referral of Specimens; Procedures for Specimen Accountability and          
Tracking:  Location, status, and final disposition of the specimens will be tracked 
at least by paper document in the “Study Folder” (created before analysts receive 
the samples).  Apart from this specimen tracking form, this folder will also contain 
the paper print outs of results from analysis of the specimens.  Maintain records 
for a minimum of 3 years.  Use only numerical identifiers for samples within the 
laboratory (e.g., case ID numbers) in order to safeguard confidentiality.  Only the 
medical supervisor (MS) or project coordinator (PC) i.e. non CDC personnel 
should have access to the personal identifiers. 
 

4) Safety Precautions 
 

a. General Safety 
 

i. Observe all safety regulations as detailed in the Division (DLS) Safety Manual.  
Additional information can be found in your lab’s chemical hygiene plan.  
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Participate in training regarding blood-borne pathogens prior to performing this 
method. 

 
ii. Observe Universal Precautions when working with blood. 

 
iii. Wear appropriate gloves, lab coat, and safety glasses while handling all 

solutions.    
 

iv. Special care should be taken when handling and dispensing bases and 
concentrated acids. Wear powder free gloves, a lab coat, safety glasses, and 
face / neck protection.  If TMAH or concentrated hydrochloric acid comes 
in contact with any part of the body, quickly wash with copious 
quantities of water for at least 15 minutes. 

 
v. Use secondary containment for containers holding biological or corrosive 

liquids. 
 

vi. Dispose of all biological samples and diluted specimens in a biohazard 
autoclave bag at the end of the analysis according to CDC/DLS guidelines for 
disposal of hazardous waste. 

 
vii. The use of the foot pedal on the Digiflex™ is recommended because it 

reduces analyst contact with work surfaces that have been in contact with 
blood and also keeps the analyst’s hands free to hold the specimen cups and 
autosampler tubes and to wipe off the tip of Digiflex™. 

 
viii. Training will be given before operating the ICP-DRC-MS, as there are many 

possible hazards including ultraviolet radiation, high voltages, radio-frequency 
radiation, and high temperatures. This information is also detailed in the 
PerkinElmer ELAN® ICP-DRC-MS System Safety Manual.   

 
ix. Transport and store compressed gas cylinders with proper securing 

harnesses.  For compressed oxygen gas, use regulators which are oil-free and 
are equipped with a flash arrestor. 

 
x. Wipe down all work surfaces at the end of the day with bleach-rite spray or 

freshly prepared 10% (v/v) sodium-hypochlorite solution.   
 
 

b. Waste Disposal:  Operators of this method should take the CDC-OHS Hazardous 
Chemical Waste Management Course (initial and yearly refreshers). 

 
i. Waste to be Placed Into Biohazard Autoclave Bags & Pans:   
 

1. All biological samples and diluted specimens (after analysis run).  
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2. All disposable plastic and paper which contact blood (autosampler tubes, 
gloves, etc.).   

 
3. Used non-glass/quartz ICP-MS consumables (i.e. probes, tubing, cones, 

ion lenses). 
 

ii. Waste to be Placed Into Sharps Containers:  Pipette Tips, broken glass or 
quartz instrument consumables (broken spray chambers, torches, nebulizers, 
etc. . .).  Large broken glass which will not fit in the sharps container should be 
placed in a separate autoclave pan from other waste and labeled as “broken 
glass” (see the “Autoclaving” section of the CDC safety policies and practices 
manual located in the laboratory). 

                          
5) Instrument & Material Sources 

 
a. Sources for ICP-MS Instrumentation 

 
i. ICP-MS:  Inductively Coupled Plasma Dynamic Reaction Cell Mass 

Spectrometer (ELAN® DRC II) (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  
1. DXi-FAST upgrade:  Standard peristaltic pump replaced by DXi-FAST 

micro-peristaltic pump / FAST actuator and valve combination unit.  For 
ELAN DRC2, part # DXI-54-P4-F6. 

 
ii. Recirculating chiller / heat exchanger for ICP-MS:  Refrigerated chiller 

(PolyScience 6105PE for ELAN® 6100 DRCPlus instruments) if unit is to be 
placed remotely from ICP-MS or heat exchanger (PolyScience 3370 for ELAN® 
DRC II instruments) if unit is to be placed alongside ICP-MS (PerkinElmer 
Norwalk, CT, www.perkinelmer.com). 

 
iii. Autosampler:  
 

1. ESI SC4 autosampler: Dual rinse station supplied by two independent 
pumps built internal to the autosampler (Elemental Scientific Inc., Omaha, 
NE).  

 
2. FAST:  Purchase as an option onto the ESI SC4 autosampler (Elemental 

Scientific Inc., Omaha, NE). 
 

b. Sources for ICP-MS Parts & Consumables 
 
NOTE:  The minimum number of spares recommended before reordering (if 
owning one instrument) are listed as “# Spares = ” in the descriptions below.   

 
i. Adapter, PEEK:  Securely connects 1.6mm O.D. PFA tubing to 0.03” I.D. 

peristaltic tubing.  Composed of three PEEK parts.   
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1. Female nut for 1.6mm O.D. (1/16”) tubing.  Like part P-420 (Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com). 

2. PEEK ferrule.  Like part P-260x (10pk SuperFlangeless ferrule, Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com).   

3. Conical Adapter Body.  Like part P-692 (Upchurch Scientific, Oak Harbor, 
WA, www.upchurch.com). 

ii. Bottles (for rinse solution):  Four liter screw-cap polypropylene container with 2 
luer connections (like catalog# SC-0305-1, Elemental Scientific Inc., Omaha, 
NE., www.elementalscientific.com). 

iii. Carboy and cap assembly for waste collection:  10-15L, polypropylene wide-
mouth carboy (100 mm neck size) with handles and no spigot  (Like part # 
7BE-25126, Lab Safety Supply, Janesville, WI, www.lss.com) with cap 
assembly like part # N0690271 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com). 

iv. Coolant, for Polyscience chiller or heat exchanger:  Only PerkinElmer part # 
WE01-6558 (PerkinElmer Norwalk, CT, www.perkinelmer.com) is approved for 
use by PerkinElmer.  # Spares = 6. 

v. Cone, sampler (nickel):  PerkinElmer part # WE021140 (PerkinElmer Norwalk, 
CT, www.perkinelmer.com).  Part # SC2011-Ni (Testing has also found 
Spectron, Ventura, CA, www.spectronus.com cones to be comparable).  # 
Spares = 4. 

vi. Cone, skimmer (nickel):  PerkinElmer part # WE021137 (PerkinElmer Norwalk, 
CT, www.perkinelmer.com).  Part # SC2012-Ni (Testing has also found 
Spectron, Ventura, CA, www.spectronus.com cones to be comparable)  # 
Spares = 4. 

vii. Detector, electron multiplier:  Like part # N8125001 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  Available direct from manufacturer (part # 14210, 
SGE Incorporated, Austin, Texas, http://www.etpsci.com) or various 
distributors.  # Spares = 1. 

viii. FAST accessories 

1. Valve: CTFE High-flow valve head for SC-FAST (uses ¼-28 fittings).  Like 
part # SC-0599-1010 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

2. Stator:  CTFE Stator for 6 port SC-FAST high flow valve (¼-28 fittings).  
Like part # SC-0599-1010-01 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

3. Rotor:  Composite rotor for 6 port SC-FAST high flow valve (¼-28 fittings). 
Like part # SC-0599-1010-05 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 
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4. Sample Loop: 1 mL Teflon, white connector-nuts for high flow valve head.  
Like part # SC-0315-10 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

5. Probe, Autosampler:  Teflon, carbon fiber support, 0.8mm i.d., blue marker, 
1/4-28 fittings.  Like part number SC-5037-3751 (Elemental Scientific Inc., 
Omaha, NE., www.elementalscientific.com).  # Spares = 2. 

6. Probe, Carrier Solution: Teflon, carbon fiber support, 0.5mm i.d., orange 
marker, 1/4-28 fittings. Like part number SC-5037-3501 (Elemental 
Scientific Inc., Omaha, NE., www.elementalscientific.com).  # Spares = 2. 

7. Tubing, FAST vacuum:  Vacuum line for SC-FAST high flow valve, 
connects to port #6, black nut for connection to valve head, natural brown 
color nut on other end for connection to SC autosampler vacuum port.  Like 
part # SC-0321 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

8. Tubing, connects nebulizer to valve:  See “Nebulizer, PolyPro-ST micro 
flow” 

ix. Hose, for connection to chiller:  Push on hose.  I.D. = ½”, O.D. = ¾”.  Use part 
# PB-8 (per inch, Georgia Valve and Fitting, Atlanta, GA, www.swagelok.com) 
or equivalent.  Do not normally need spare hose (unless moving instrument 
into a new location). 

x. Hose, for exhaust of ELAN:  Available as part of ELAN installation kit from 
Perkin Elmer (PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available 
direct from manufacturer as part # S-LP-10 air connector (Thermaflex, 
Abbeville, SC, www.thermaflex.net).  Equivalent part may be substituted.  # 
Spares = 10 feet of 4” diameter and 10 feet of 6” diameter hose.   

xi. Injector, quartz:  I.D. = 2.0 mm.  PerkinElmer part # WE023948 (PerkinElmer 
Norwalk, CT, www.perkinelmer.com).  Available direct from manufacturer as 
part # 400-30 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or equivalent from various distributors.  # 
Spares = 2. 

xii. Injector support (for pass-through injector): PerkinElmer part # WE023951 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available direct from 
manufacturer as part # 400-37 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or equivalent from various distributors.  # 
Spares = 2. 

xiii. Ion Lens:  PerkinElmer part # WE018034 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  # Spares = 3. 

xiv. Nebulizer, PolyPro-ST micro flow:  Polypropylene nebulizer with external 1/4-
28 threaded connector for liquid delivery, low pressure version or equivalent. 
Like part # ES-4040-7010 (Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com).  # Spares = 1.   

1. Gas connection: 
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a. Teflon tubing: 4mm o.d., 2.4mm i.d. Teflon tubing (like part # ES-
2502, Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com).  # Spares = 1.   

b. Adapter kit: Plastic adapters to connect Teflon tubing (2.4mm i.d) to 
¼” male Swagelok (compression) port on ICP-DRC-MS.  Parts can 
be obtained as components in a “gas fittings kit for microflow 
nebulizer”, kit part # ES-2501-1000, Elemental Scientific Inc., 
Omaha, NE., www.elementalscientific.com).  # Spares = 1. 

2. Liquid connection:  Connects nebulizer to port #3 of high flow FAST valve 
head with green, 1/4- 28 fitting.  Like part # SC-0317-0250 (Elemental 
Scientific Inc., Omaha, NE., www.elementalscientific.com). # Spares = 2. 

xv. Nut and Ferrule set, 1/8” Swagelok:  Such as part # SS-200-NFSET (stainless 
steel) or part # B-200-NFSET (brass) (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  For part numbers listed here a quantity of 
1 means 1 nut, 1 front ferrule, and 1 back ferrule.  Spares = 20. 

xvi. Nut and Ferrule set, 1/4” Swagelok:  Such as part # SS-400-NFSET (stainless 
steel) or part # B-400-NFSET (brass) (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  For part numbers listed here a quantity of 
1 means 1 nut, 1 front ferrule, and 1 back ferrule.  Spares = 20. 

xvii. Oil, Welch DirecTorr Gold:  For roughing pumps.  Available direct from 
manufacturer as part # 8995G-15 (1 gallon, Welch Rietschle Thomas, Skokie, 
IL, www.welchvacuum.com) or from various distributors.  Equivalent oil may be 
substituted.  # Spares = 4. 

xviii. O-ring: (for sampler cone) PerkinElmer part # N8120511 (pkg. of 5, 
PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 
20 o-rings. 

xix. O-ring: (for skimmer cone) PerkinElmer part # N8120512 (pkg. of 5, 
PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 
20 o-rings. 

xx. O-ring:  (for ELAN DRC II standard injector support).  

1. Internal o-rings:  ID = ¼”, OD = 3/8”, thickness = 1/16”.  Need 2 o-rings per 
injector support setup.  PerkinElmer part # N8122008 (PerkinElmer, 
Shelton, CT, www.perkinelmer.com) or equivalent (such as part # V75-010, 
O-rings West, Seattle, WA, www.oringswest.com).  # Spares = 20. 

2. External o-rings:  ID = 3/8”, OD = 1/2”, thickness = 1/16”.  Need 2 o-rings 
for each injector support setup.  PerkinElmer part # N8122009 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent (such as 
part # V75-012, O-rings West, Seattle, WA, www.oringswest.com).  # 
Spares = 20. 

xxi. O-ring:  (for inside of bayonet torch mount):  Part # WE017284 (PerkinElmer, 
Shelton, CT, www.perkinelmer.com).  Do not substitute.  The PerkinElmer o-
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ring is specially metal impregnated to minimize RF leakage though the torch 
mount.   # Spares = 2. 

xxii. Photon Stop:  PerkinElmer part # WE018278 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  # Spares = 1. 

xxiii. Plugs, Quick Change for Roughing Pump Oil:  These plugs will only work on 
the Varian roughing pumps which come standard on ELAN DRC II ICPMS 
instruments.  These plugs will not fit the Leybold pumps which come standard 
on the ELAN DRC Plus instruments.  Part # W1011013 (PerkinElmer, Shelton, 
CT, www.perkinelmer.com).  No spares typically needed. 

xxiv. RF coil:  PerkinElmer part # WE02-1816 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 2. 

xxv. Spray chamber, quartz concentric:  PerkinElmer part # WE025221 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  Available 
direct from manufacturer as part # 400-20 (Precision Glass Blowing, 
Centennial, CO, www.precisionglassblowing.com) or from various distributors.  
# Spares = 2. 

a. O-ring:  (for inside spray chamber at nebulizer port) Such as part # 
120-56 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com).  Additional o-rings can sometimes 
be obtained free of charge or at reduced price when acquired while 
purchasing spray chambers.  # Spares = 20. 

xxvi. Torch, quartz:  PerkinElmer part # N812-2006 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  Available direct from manufacturer as 
part # 400-10 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or various distibutors.  Damaged torches can 
often be repaired for substantially lower cost than purchasing a new one by 
companies such as Wilmad LabGlass (Buena, NJ, www.wilmad-labglass.com) 
or Precision Glass Blowing (Centennial, CO, www.precisionglassblowing.com).   
# New Spares = 2. 

xxvii. Tubing, main argon delivery to instrument:  I.D. = 1/8”, O.D. = ¼”.  Such as 
part # C-06500-02 (pkg. of 100ft, polypropylene, Fisher Scientific International, 
Hampton, NH, www.fishersci.com) or equivalent.  # Spares = 50ft. 

xxviii. Tubing, drains waste liquid from spray chamber :   

1. PVC 1/8” i.d., 3/16” o.d tubing used to transfer waste liquid between spray 
chamber waste port and peristaltic pump waste tubing and between 
peristaltic pump waste tubing and liquid waste carboy.  Like part # 14-169-
7A (pkg. of 50ft, Fisher Scientific International, Hampton, NH, 
www.fishersci.com) or equivalent.  # Spares = 20ft. 

2. Connector:  Use to connect 1/8” I.D. PVC tubing to 0.125” I.D peristaltic 
pump tubing.  Use part # 3140715 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 4. 

xxix. Tubing, peristaltic, 0.03” i.d. (sampling/carrier solution):  



Blood Metals Panel 2 (BMP2) by ICP-DRC-MS        
 
IRAT-DLS Method Code: 3016                                                                 Page 21 of 88 
 

 

1. Standard PVC, 2-stop (black / black) peristaltic pump tubing, i.d. = 0.03”. 
PerkinElmer part # 09908587 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 6 packs of 12 tubes.  
Use this type tubing with standard ELAN peristaltic pump. 

2. Standard PVC, 3-stop. (blank / black) peristaltic pump tubing, i.d. 0.76 mm.  
Spectron part # SC0056 (Spectron, Ventura, CA, www.spectronus.com) or 
equivalent.  # Spares = 6 packs of 12 tubes.  Use this type tubing with ESI 
DXi micro-peristaltic pump. 

xxx. Tubing, peristaltic, 0.045” i.d. (spray chamber drain):  

1. Standard PVC, 2-stop (red / red) peristaltic pump tubing, i.d. = 0.045”. 
PerkinElmer part # N0680375, (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 6 packs of 12 tubes. 

2. Standard Santoprene, 3-stop (grey / grey / grey) peristaltic pump tubing, 
i.d. 1.30 mm.  Spectron part # SC0311 (Spectron, Ventura CA, 
www.spectronus.com0 or equivalent.  # Spares = 6 packs of 12 tubes.  
Use this type tubing with ESI DXi micro-peristaltic pump. 

 

xxxi. Tubing, Stainless Steel, o.d. = 1/8”, wall thickness = 0.028”:  Used to connect 
DRC gas cylinders to ELAN DRC gas ports.  Also can be used to replace 
plastic tubing in the DRC gas path within the ELAN to minimize gas 
leaks/diffusion into gas stream.  Like part # SS-T2-S-028-20 (20ft, Georgia 
Valve and Fitting, Atlanta, GA, www.swagelok.com) or equivalent.  Spares = 
20ft. 

xxxii. Tubing, Teflon, corrugated, ¼” o.d.:  Connects to the auxiliary and plasma gas 
side-arms of the torch.  Part # WE015903 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  # Spares = 2.   

xxxiii. Union Elbow, PTFE ¼” Swagelok:  Connects argon tubing to torch auxiliary 
gas sidearm.  Like part # T-400-9 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  Spares = 2. 

xxxiv. Union Tee, PTFE, ¼” Swagelok:  Connects argon tubing to torch plasma gas 
sidearm and holds igniter inside torch sidearm.  Like part # T-400-3 (Georgia 
Valve and Fitting, Atlanta, GA, www.swagelok.com) or equivalent.  Spares = 
2. 

c. Sources for ICP-MS Maintenance Equipment & Supplies 

i. Anemometer: Like digital wind-vane anemometer (Model 840032, SPER 
Scientific LTD., Scottsdale, AZ, www.sperscientific.com) or equivalent.  Use to 
verify adequate exhaust ventilation for ICP-MS (check with hoses fully 
disconnected). 

ii. Pan, for changing roughing pump oil: Like part # 53216 (United States Plastics 
Corporation, Lima, OH, www.usplastic.com) or equivalent.  # On hand = 1. 
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iii. Container, to hold acid baths for glassware:  Polypropylene or polyethylene 
containers with lids (must be large enough for torch, injector, or spray chamber 
submersion).  May be purchased from laboratory or home kitchen supply 
companies.  # On hand = 4.  

iv. Cotton swabs:  Any vendor.  For cleaning of cones and glassware. 

v. Cutter (for 1/8” o.d. metal tubing):  Terry tool with 3 replacement wheels.  Like 
part # TT-1008 (Chrom Tech, Inc., Saint Paul, MN, www.chromtech.com) or 
equivalent. 

vi. Getter Regeneration Kit: Part # WE023257 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  Use this as needed (at least annually) to clean the 
getter in the pathway of channel A DRC gas.   

vii. Magnifying glass:  Any 10x + pocket loupe for inspection of cones and other 
ICP-MS parts.  Plastic body is preferred for non-corrosion characteristics.  Like 
part # 5BC-42813 (Lab Safety Supply, Janesville, WI, www.labsafety.com). 

viii. Toothbrush:  Any vendor.  For cleaning ion lens and glassware. 

ix. Ultrasonic bath: Like ULTRAsonik™ Benchtop Cleaners (NEYTECH, 
Bloomfield, CT, www.neytech.com) or equivalent. 

d. Sources for General Laboratory Consumable Supplies 

i. Bar Code Scanner:  Like Code Reader 2.0 (Code Corporation, Draper, UT, 
www.codecorp.com) or equivalent.  For scanning sample IDs during analysis 
setup.  Any bar code scanner capable of reading Code 128 encoding at a 3 mil 
label density can be substituted. 

ii. Carboy (for preparation of blood quality control pool and waste jug for ICPMS 
sample introduction system):  Polypropylene 10-L carboy (like catalog # 02-
960-20C, Fisher Scientific, Pittsburgh, PA, www.fischersci.com) or equivalent.  
Carboys with spouts are not advised due to potential for leaking. 

iii. Containers for diluent and Rinse Solution:  Two liter Teflon™ containers (like 
catalog# 02-923-30E, Fisher Scientific, Pittsburgh, PA., www.fishersci.com) 
and 4L polypropylene jugs (like catalog# 02-960-10A, Fisher Scientific, 
Pittsburgh, PA, www.fishersci.com) have both been used. Acid rinse before 
use.  Equivalent containers may be substituted. 

iv. Gloves:  Powder-free, low particulate nitrile (like Best CleaN-DEX™ 100% 
nitrile gloves,any vendor).  Equivalent nitrile or latex gloves may be 
substituted. 

v. Paper towels:  For general lab use, any low-lint paper wipes such as 
KIMWIPES®EX-L Delicate Task Wipers or KAYDRY®EX-L Delicate Task 
Wipers (Kimberly-Clark Professional, Atlanta, GA, www.kcprofessional.com).  
For sensitive applications in cleanrooms, a wipe designed for cleanroom use 
may be desired such as the Econowipe or Wetwipe (Liberty, East Berlin, CT, 
www.liberty-ind.com). 
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vi. Pipette (for preparation of blood dilutions to be analyzed): Micromedic Digiflex-
CX Automatic™ pipette equipped with 10.0-mL dispensing syringe, 2 uL 
sampling syringe, 0.75-mm tip, and foot pedal (Titertek, Huntsville, AL, 
http://www.titertek.com/).   

vii. Pipettes (for preparation of intermediate stock working standards & other 
reagents):  Like Brinkmann Research Pro Electronic pipettes (Brinkmann 
Instruments, Inc., Westbury, NY, http://www.brinkmann.com/home/).  5-100 L 
(catalog #4860 000.070), 20-300 L (catalog #4860 000.089), 50-1000 L 
(catalog #4860 000.097), 100-5000 L (catalog #4860 000.100).  Note:  pipette 
catalog numbers are without individual chargers.  Can purchase individual 
chargers (pipette catalog numbers will differ) or a charging stand that will hold 
four pipettes (catalog #4860 000.860).  When purchasing pipette tips (epTips), 
purchase one or more boxes, then “reloads” for those boxes after that:  5-100 
L (box catalog # 22 49 133-4, reload catalog # 22 49 153-9), 20-300 L (box 
catalog # 22 49 134-2, reload catalog # 22 49 154-7), 50-1000 L (box catalog 
# 22 49 135-1, reload catalog # 22 49 155-5), 100-5000 L (box catalog # 22 
49 138-5, reload catalog # 22 49 198-9, bulk bag catalog # 22 49 208-0).  
Equivalent pipettes and tips can be substituted. 

viii. Tubes for sample analysis (for autosampler):  Like polypropylene 15-mL 
conical tubes, BD Falcon model #352097 (Becton Dickinson Labware, Franklin 
Lakes, NJ, www.bd.com).  Equivalent tubes may be substituted which are 
shown by lot screening to be free of trace metal contamination.  Clear plastics 
tend to have lowest trace metal contamination.  Blue colored caps have also 
been used successfully for this method. 

ix. Tubes for storage of intermediate working stock standards:  Like polypropylene 
50-mL conical tubes, BD Falcon model #352098 (Becton Dickinson Labware, 
Franklin Lakes, NJ, www.bd.com).  For use in storage of intermediate working 
stock standards.  Equivalent tubes may be substituted which are shown by lot 
screening to be free of trace metal contamination. Clear plastics tend to have 
lowest trace metal contamination.  Blue colored caps have also been used 
successfully for this method. 

x. Vortexer:  Like MV-1 Mini Vortexer (VWR, West Chester, PA, www.vwr.com).  
Used for vortexing blood specimens before removing an aliquot for analysis.  
Equivalent item can be substituted. 

xi. Water purification system:  Like NANOpure DIamond Ultrapure Water System 
(Barnstead International, Dubuque, Iowa, www.barnstead.com).  For ultra-pure 
water used in reagent and dilution preparations.  An equivalent water 
purification unit capable of producing >18 Mega-ohm·cm water may be 
substituted. 

e. Sources of Chemicals, Gases, and Regulators 

i. Acid, Hydrochloric acid:  Veritas™ double-distilled grade, 30-35% (GFS 
Chemicals Inc. Columbus, OH, www.gfschemicals.com).  This is referred to as 
“concentrated” hydrochloric acid in this method write-up.  For use in 



Blood Metals Panel 2 (BMP2) by ICP-DRC-MS        
 
IRAT-DLS Method Code: 3016                                                                 Page 24 of 88 
 

 

preparation of intermediate working stock standards.  An equivalent 
hydrochloric acid product may be substituted, but it must meet or exceed the 
purity specifications of this product for trace metals content. 

ii. Acid, Nitric acid: Veritas™ double-distilled grade, 68-70% (GFS Chemicals Inc. 
Columbus, OH, www.gfschemicals.com).  For use in cleaning any bottles, 
vials, tubes, and flasks.  This is referred to as “concentrated” nitric acid in this 
method write-up.  An equivalent nitric acid product may be substituted, but it 
must meet or exceed the purity specifications of this product for trace metals 
content. 

iii. Alcohol, Ethyl, USP dehydrated 200 proof (Pharmco Products, Inc.) or 
equivalent. 

iv. Ammonium pyrrolidine dithiocarbamate, laboratory grade (Fisher Scientific, 
Fairlawn, NJ) or equivalent. 

v. Argon Gas (for plasma & nebulizer) and Regulator:  High purity argon 
(>99.999% purity, Specialty Gases Southeast, Atlanta, GA, www.sgsgas.com) 
for torch and nebulizer.  Minimum tank source is a dewar of liquid argon (180-
250L).  Bulk tank (1500+L is preferred). 

1. Regulator for argon (at dewar):  Stainless steel, single stage, specially 
cleaned regulator with 3000 psig max inlet, 0-100 outlet pressure range,  
CGA 580 cylinder connector, and needle valve shutoff on delivery side 
terminating in a ¼” Swagelok connector.  Part number 
KPRAFPF415A2AG10 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com). An equivalent regulator from an alternate vendor may 
be substituted.  # Spares = 1. 

2. Regulator for argon (between bulk tank and PerkinElmer filter regulator):           
Single Stage 316SS Regulator, with 0-300 psi Inlet Gauge, 0-200 psi 
Outlet Gauge, Outlet Spring Range, 0-250 psi, ¼” Swagelok Inlet 
Connection, ¼ turn Shut off Valve on Outlet with ¼” Swagelok Connection 
and Teflon Seals.  Part number KPR1GRF412A20000-AR1 (Georgia Valve 
and Fitting, Atlanta, GA, www.swagelok.com). An equivalent regulator from 
an alternate vendor may be substituted.  # Spares = 1. 

3. Regulator for argon (PerkinElmer filter regulator on back of ELAN):  Argon 
regulator filter kit.  Catalog number N812-0508 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com). 

 

vi. Disinfectant, for work surfaces:  Bleach-rite spray (any distributor).  On-site 
dilutions of bleach (1part bleach + 9 parts water) may be substituted, but must 
be re-made daily. 

vii. Methane: Methane (Research Grade 5.0, 99.99% purity), for DRC channel A.  
Typically purchased in cylinder size 200 (part # ME R200, Airgas South, 
Atlanta, GA, www.airgas.com). 
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1. Regulator for methane:  A 2-stage, high purity brass regulator with max 
rated inlet pressures of 3,000 psi, max outlet pressures of 15-30 psi (with 
gauge maximum at 15-30psi). Like part number Y12-N145A350 (Airgas 
South, Atlanta, GA, www.airgas.com).  An equivalent regulator from an 
alternate vendor may be substituted.  # Spares = 1. 

2. Flash Arrestor:  Like part # 6103 (Matheson Tri Gas, Montgomeryville, PA, 
www.mathesontrigas.com) or equivalent. 

viii. Oxygen:  Oxygen (“Research Grade Research Grade 5.0”, 99.9999% purity) 
for DRC channel B.  Typically purchased in cylinder size 300 (9.5” x 54”) 
(Airgas South, Atlanta, GA, www.airgas.com). 

1. Regulator for oxygen:  High purity brass body with monel trim, two stage 
regulator.  Stainless steel is not used for this application due to safety 
concerns of working with oxygen at high pressure [59].  For one regulator, 
order the following parts, and ask that they be tested and assembled 
(Engineered Specialty Products, Kennesaw, GA, www.espgauges.com).  

a. Tescom part # 44-3410S24-555 
Regulator body:  Brass bar stock, two stage, Monel trim, TFE seats, 
Elgiloy diaphragms, Cv=0.05, 3000 psig max inlet, 1-25 psig outlet 
range, 1/4 FNPT inlet / outlet / gauge ports, O2 cleaned to ASTMG93 
and CGA4.1.  
 

b. Tescom part # 60500-3000N  
Inlet pressure gauge: 2" diameter, 0-3000 psig range , O2 cleaned, ¼” 
MNPT bottom, brass.   
 

c. Tescom part # 60500-0015N  
Delivery pressure gauge: 2" diameter, 0-15 psig range , O2 cleaned, ¼” 
MNPT bottom, brass.   
 

d. Tescom part # 63842-540-B 
NPT to CGA Adaptor:  ¼” NPT to CGA 540 adapter, brass. 

 
e. Swagelok part # B-200-1-4: 

Adapter:  Brass male connector, ¼” MNPT to 1/8” Swagelok (Georgia 
Valve and Fitting, Atlanta, GA, www.swagelok.com). 
 
An equivalent regulator from an alternate vendor may be substituted. 
# Spares = 1. 

2. Flash Arrestor (brass):  Like part # 6103 (Matheson Tri Gas, 
Montgomeryville, PA, www.mathesontrigas.com) or equivalent. 

ix. Standard, Iridium: Like 1,000 mg/L, item #CGIR1-1 (Inorganic Ventures, 
Christiansburg, VA http://www.inorganicventures.com). Used as an internal 
standard in diluent.  Any vendor whose standards are traceable to the National 
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Institute for Standards and Technology may be substituted.  The standard 
must have low trace metal contamination.  

x. Standard, Rhodium:  Like 1,000 mg/L, item # PLRH3-2Y.  (SPEX Industries, 
Inc., Edison, NJ, www.spexcsp.com).  Used as an internal standard in diluent.  
Any vendor whose standards are traceable to the National Institute for 
Standards and Technology may be substituted.  The standard must have low 
trace metal contamination.  

xi. Standard, Tellurium: Like 1,000 mg/L, item #CGTE1-1 (Inorganic Ventures, 
Christiansburg, VA http://www.inorganicventures.com).Used as an internal 
standard in diluent.  Any vendor whose standards are traceable to the National 
Institute for Standards and Technology may be substituted.  The standard 
must have low trace metal contamination.  

xii. Standard, single element stock standards for preparation of calibrators and 
blood quality control pools:  National Institute of Standards and Technology 
(NIST) Standard Reference Materials (SRMs): 3108 (Cd), 3132 (Mn), 3128 
(Pb), 3133 (Hg), 3149 (Se).  (Gaithersburg, MD, www.nist.gov).  Other sources 
of standards can be used if they are NIST traceable. 

xiii. Tetramethylammonium hydroxide, 25% w/w, or equivalent (AlfaAesar, 30 Bond 
St., Ward Hill, MA 01835) 

xiv. Triton X-100™ surfactant:  Like “Baker Analyzed” TritonX-100™ (J.T. Baker 
Chemical Co., www.jtbaker.com).  Another source may be substituted, but it 
must be free of trace-metal contamination. 

 

6) Preparation of Reagents and Materials 
 

a. Internal Standard Intermediate Mixture (20 g/mL Rh, Ir and Te): 

i. Purpose: Preparation of single intermediate solution containing all internal 
standards simplifies the addition of the internal standard(s) into the final diluent 
solution.  This solution can be purchased rather than prepared.   

ii. Preparation: To prepare 50 mL of the intermediate internal standard solution: 

1. Partially fill a 50 mL acid-washed volumetric flask (PP, PMP, or Teflon™) 
with 1% v/v HNO3 (approximately 25-40 mL). 

2. Add 1 mL of 1,000 g/mL Rh standard, 1 mL of 1,000 g/mL Ir standard, 
and 1 mL of 1,000 g/mL Te standard.  If initial Rh, Ir, or Te standard 
concentration is different, adjust volume proportionally. 

3. Fill to mark (50 mL) with 1% v/v HNO3 and mix thoroughly. 

4. Label appropriately (e.g. “Internal Standard Intermediate Mixture.  20 
g/mL Rh, Ir and Te, 1% v/v HNO3”, preparation date, expiration date 1 
year from preparation date, and preparer’s initials). 
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b. 20% Triton X-100 intermediate solution:   

i. Purpose: Addition to diluent and rinse solutions where Triton X-100 acts as a 
surfactant.  For ease of daily preparation of the diluent and rinse solutions, first 
prepare a 20% Triton X-100 solution. 

ii. Preparation:  To prepare 1 L of 20% Triton x-100® 

1. Add 200 ml of Triton X-100 to a pre-acid washed  1L Teflon container 
that is partially filled with 18 M-ohm water.   

2. Fill to 1 L with 18 M-ohm water and mix until the Triton X-100 has 
completely dissolved into solution (overnight).  A magnetic stirring plate 
can be used to assist mixing by adding an acid-washed Tefloncoated 
stirring bar to the bottle.   

c. Sample Diluent 
i. Purpose:  The diluent used in this method is an aqueous solution of 5 g/L 

internal standard mixture (Rh, Ir, Te), in 0.25% v/v tetramethyl ammonia 
hydroxide (TMAH), 1% ethyl alcohol, 0.01% APDC, and 0.025% v/v Triton X-
100. This solution will be used in the preparation of all calibrators and 
samples during the dilution process just prior to analysis.  It is important that all 
samples in a run should be made from the same diluent solution so that the 
concentration of the internal standards will be the same among all calibrators 
and samples in the run.  When using a flow-injection component in the sample 
introduction system (i.e. the Elemental Scientific SC4-FAST autosampler), the 
‘carrier’ solution should be the same as the diluent used for the method.  
Larger volumes of these solutions can be prepared by adjusting component 
volumes proportionally. 

 

ii. Preparation: 

1. Acid rinse a 2 L Teflon container, and partially fill with 18 M-ohm water.   

2. Add 0.2 g of APDC , 5 ml of 25% v/v TMAH, 20 ml of  ethyl alcohol, and 5 
ml of 20% Triton X-100.   

3. Dilute to volume (2L) with 18 M-ohm water  

4. Spike 500 l of 20 mg/L Rh, Ir, Te to the final diluent.   

5. Invert bottle a few times to insure thorough mixing.  Allow to sit for several 
hours or overnight before using. 

6. Label appropriately (e.g. “5 g/L Rh, Ir and Te”, “0.01% APDC in 0.25% v/v 
tetramethyl ammonia hydroxide (TMAH), 1% ethanol, and 0.05% v/v Triton 
X-100”, preparation date, expiration date (1 year from prep), and preparer’s 
initials). 

7. Store at room temperature and prepare as needed.    

d. DRC Stability Test Solution 
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i. Purpose: The DRC Stability Test Solution is a “dummy” blood matrix sample 
analyzed for 1-1.5 hr before the beginning of the analytical run. 

ii. Preparation:  
1. Fill an acid rinsed 1 L Teflon container with 960 mL of Sample Diluent. 
2. Add 20 mL of rejected screened human or bovine blood 
3. Add 1.5 mL of Intermediate Stock Calibration Standard 
4. Store at 4°C and prepare as needed. 

e. Base Blood   

i. Purpose:  This blood pool material will be mixed with the intermediate working 
calibrators just prior to analysis to matrix-match the calibration curve to the 
blood matrix of the unknown samples.   

ii. Contents: A mixture of multiple blood sources collected from anonymous 
donors are used to approximate an average blood matrix. 

iii. Preparation & Storage: 

1. Purchase several bags of whole blood.  Bovine blood or human blood can 
be used.  Human blood should be screened for infectious diseases such as 
Hepatitis B and HIV.  

2. Screen each individual bag of blood for concentration of analytes of 
interest.  See Table 2 in Appendix B for minimum acceptable values 

3. Once screened, mix the acceptable blood together in a larger container 
(i.e. acid washed polypropylene (PP), polymethylpentene (PMP), or 
Teflon™) and stir for 30+ minutes on a large stir plate (acid wash large 
Teflon™ stir bar before use). 

4. For short term storage, store at 2-4°C.  For long-term storage, dispense 
into smaller-volume tubes (i.e., 2 mL cryovials) and store at ≤ -20°C.   

5. Labels on 2 mL cryovials should be labeled appropriately (e.g. “Base Blood 
for Blood metals panel 2, Cd, Hg, Mn, Pb, Se”, dispensed date and vial 
number). 

f. ICP-DRC-MS Rinse Solution  

i. Purpose:  The rinse solution used in this method is an aqueous solution of 
0.25 % v/v TMAH, 1% ethyl alcohol, 0.01% APDC, and 0.05 % Triton X-100,.  
This solution will be pumped through the autosampler rinse station, probe, and 
sample loop between sample analyses to prevent carry-over of analytes from 
one sample measurement to the next.   

ii. Preparation: To Prepare 4 L of the Rinse Solution: 

1. Partially fill a 4 L acid-washed bottle (PP, PMP, or Teflon™) with >18 
Mega-ohm·cm water (approximately 2-3 L).  Use of volumetric flask is not 
required. 

2. Add 0.4 g of APDC 

3. Add 10 ml of  TMAH  
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4. Add 40 ml of ethyl alcohol, 

5. Add 10ml of 20% Triton X-100, (See Section 6.b for details on 
preparation) 

6. Fill to 4 L using >18 Megaohm·cm water.   

7. Store at room temperature and prepare as needed.  To prepare volumes 
other than specified here, add proportionally larger or smaller volumes of 
the solution constituents. 

8. Invert bottle a few times to ensure thorough mixing.  Allow to sit for several 
hours or overnight before using. 

9. Label appropriately (e.g. “0.25 % v/v TMAH, 1% ethyl alcohol, and 0.05 % 
Triton X-100, 0.01% (w/v) APDC”, preparation date, expiration date one 
year from preparation date, and preparer’s initials). 

g. Single-Element Stock Standards For Preparation of Intermediate Stock 
Calibration Standard 

i. Purpose:  These single-element standards will be used to prepare the 
intermediate stock calibration standard.   

ii. Contents:  Separate, aqueous single-element standards of Cd, Pb, Hg, Se, 
and Mn.  Concentrations should be 1,000 mg/L or 10,000 mg/L.  

iii. Purchase & Storage:   

1. Purchasing from vendors:  If the intermediate stock calibration standard is 
purchased as a special-mix standard, these single-element stock 
standards are not required.  Purchase only NIST-traceable single-element 
standards at the highest purity (don’t contain other metal impurities).   

2. Storage:  Store at room temperature. 

h. 3% (v/v) HCl Diluent:   

i. Purpose: 3% HCl is used to dilute single element stock standards into a single 
intermediate stock calibration solution and finally to the intermediate working 
calibration standards. 

ii. Preparation: 

1. In a cleaned 2 L flask, add 1-1.5L >18 Megaohm·cm water. 

2. Add 60 mL high purity concentrated HCl.   

3. Fill to the mark and mix thoroughly.   

4. Label appropriately (e.g. “3 % v/v HCl”, preparation date, expiration date 
one year from preparation date, and preparer’s initials). 

i. Intermediate Stock Calibration Standard 

i. Purpose: This multi-element solution will be used to prepare the five working 
calibration standards. 
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ii. Preparation & Storage:  This solution may be purchased as a special-mix 
standard or prepared in-house from separate single-element stock standards.   

1. Purchasing from vendors:  The intermediate stock calibration 
standard may be purchased as custom mixture from any vendor 
which prepares multi-element solutions that are traceable to the 
National Institute for Standards and Technology (NIST) for their 
accuracy.  

2. In-house Preparation from NIST single element standards:  Different 
volumes may be prepared by adding proportionally larger or smaller 
volumes of solution constituents.     

a. Acid-rinse one 100 mL, PP (or PMP) volumetric flask.  Mark the flask 
according to intended use.  Dedicate to purpose.  

b. Partially fill the 100 mL flask with the 3% (v/v) HCl diluent (50-75% full).   

c. Add necessary volumes of single-element stock standards to achieve 
final concentrations listed in Table 3 of Appendix B.   

d. Dilute to the volumetric mark with the 3% (v/v) HCl diluent using a 
pipette for the final drops.  Mix the flask solution thoroughly.  Final 
concentrations are listed in Table 3 of Appendix B.   

e. Once mixed, transfer to an acid-cleaned, labeled, 50-mL container 
(PP, PMP, or Teflon™) for storage.  Label appropriately (e.g. “Whole 
Blood Metals Panel 2 Intermediate Stock Calibration Standard”, “3% 
(v/v) HCl”, date of preparation, expiration date (1 year from date of 
preparation), initials of preparer, and concentrations for each element). 

3. In-house Preparation from other single element standards:  Different 
volumes may be prepared by adding proportionally larger or smaller 
volumes of solution constituents.     

a. Acid-rinse one 100 mL, PP (or PMP) volumetric flask.  Mark the flask 
according to intended use.  Dedicate to purpose.  

b. Partially fill the 100 mL flask with the 3% (v/v) HCl diluent (50-75% full).   

c. Add necessary volumes of single-element stock standards to achieve 
final concentrations listed in Table 4 of Appendix B.   

d. Dilute to the volumetric mark with the 3% (v/v) HCl diluent using a 
pipette for the final drops.  Mix the flask solution thoroughly.  Final 
concentrations are listed in Table 4 of Appendix B.   

e. Once mixed, transfer to an acid-cleaned, labeled, 50-mL container 
(PP, PMP, or Teflon™) for storage.  Label appropriately (e.g. “Whole 
Blood Metals Panel 2 Intermediate Stock Calibration Standard”, “3% 
(v/v) HCl”, date of preparation, expiration date (1 year from date of 
preparation), initials of preparer, and concentrations for each element). 

 



Blood Metals Panel 2 (BMP2) by ICP-DRC-MS        
 
IRAT-DLS Method Code: 3016                                                                 Page 31 of 88 
 

 

4. Storage:  Store at room temperature.  If purchased, label bottle with 
additional information such as “store at room temperature”, date received, 
date opened, and initials of person to first open. 

j. Intermediate Working Calibration Standards 

i. Purpose:  Used each day of analysis to prepare the final five working 
calibrators that will be placed on the autosampler. 

ii. Content:  Five aqueous dilutions of the intermediate stock calibration standard 
solution with a 3% (v/v) hydrochloric acid (HCl) matrix.  Final concentrations 
are listed in Table 5 of Appendix B. 

iii. Preparation & Storage:  Different volumes may be prepared by adding 
proportionally larger or smaller volumes of solution constituents. 

1. Cleaning flasks:  Acid-rinse five 100 mL, PP (or PMP) volumetric flasks.  
Mark each flask according to intended use.  Dedicate to purpose.  

2. 3% (v/v) HCl Diluent Preparation:  use the same 3% (v/v) HCl prepared in 
Section 6.g. 

3. Partially fill each 100 mL flask with the 3% (v/v) HCl diluent (50-75% full).   

4. Add the correct volume of the Intermediate Stock Standard Calibration 
Standard (according to Table 5) 

a. If a separate Pb Intermediate Stock Calibrator is used, add the 
appropriate volume of this solutions according to Table 5 to the same 
flask. 

5. Dilute to the volumetric mark with the 3% (v/v) HCl diluent using a pipette 
for the final drops.  Mix the flask solution thoroughly.  Final concentrations 
are listed in Table 5 of Appendix B.   

6. Once mixed, transfer to acid-cleaned, labeled, 50 mL containers (PP, PMP, 
or Teflon™) for storage.  Label appropriately (e.g. “Whole Blood Metals 
Panel 2 Intermediate Working Calibrators”, “3% (v/v) HCl”, date of 
preparation, expiration date (1 year from date of preparation), initials of 
preparer, concentration of each element, and Lot # of the stock solution). 

7. Pour 10-15 mL of each solution into 15 mL tubes for daily use. 

k. Working Calibration Standards 

i. Purpose:  The working calibration standards will be analyzed in each run to 
provide a signal-to-concentration response curve for each analyte in the 
method.  The concentration of the analyte of interest in a patient blood sample 
dilution is determined by comparing the observed signal ratio (element/internal 
standard) from the dilution of the patient blood sample to the signal ratio 
response curve from the working calibrators.   

ii. Content:  Dilutions (1:50) of the corresponding five intermediate working 
calibration standards.  The dilutions are described in Table 6 of Appendix B. 
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iii. Preparation & Use:  Make immediately prior to analysis when the intermediate 
working calibration standards are mixed with base blood (Section 6.d) and 
diluent (Section 6.c) using a Digiflex automatic pipette.  See Table 6 of 
Appendix B and Section 8.b.ii for details of sample preparation. 

l. Single-Element Stock Standards For Preparation of Intermediate Stock 
Calibration Verification Standard 

i. Purpose:  These single-element standards will be used to prepare the 
intermediate stock calibration verification standard.   

ii. Contents:  Separate, aqueous single-element standards of Cd, Pb, Hg, Se, 
and Mn.  Concentrations should be 1,000 mg/L or 10,000 mg/L.  

iii. Purchase & Storage:   

1. Purchasing from vendors:  If the intermediate stock calibration verification 
standard is purchased as a special-mix standard, these single-element 
stock standards are not required.  Purchase only NIST-traceable single-
element standards at the highest purity (don’t contain other metal 
impurities).   

2. Storage:  Store at room temperature. 

m. Intermediate Stock Calibration Verification Standard 

i. Purpose: This multi-element solution will be used to prepare the three working 
calibration verification standards. 

ii. Preparation & Storage:  This solution may be purchased as a special-mix 
standard or prepared in-house from separate single-element stock standards.   

1. Purchasing from vendors:  The intermediate stock calibration 
verification standard may be purchased as custom mixture from any 
vendor which prepares multi-element solutions that are traceable to 
the National Institute for Standards and Technology (NIST) for their 
accuracy.  

2. In-house Preparation:  Different volumes may be prepared by 
adding proportionally larger or smaller volumes of solution 
constituents.     

a. Acid-rinse two 50 mL, PP (or PMP) volumetric flask.  Mark the flasks 
according to intended use.  Dedicate to purpose.  

b. Partially fill the 50 mL flasks with the 3% (v/v) HCl diluent (50-75% full).   

c. Add necessary volumes of single-element stock standards to achieve 
final concentrations listed in Table 7 of Appendix B. 

d. Dilute to the volumetric mark with the 3% (v/v) HCl diluent using a 
pipette for the final drops.  Mix the flask solution thoroughly.  Final 
concentrations are listed in Table 7 of Appendix B.   



Blood Metals Panel 2 (BMP2) by ICP-DRC-MS        
 
IRAT-DLS Method Code: 3016                                                                 Page 33 of 88 
 

 

e. Once mixed, transfer to an acid-cleaned, labeled, 50-mL containers 
(PP, PMP, or Teflon™) for storage.  Label appropriately (e.g. “Whole 
Blood Metals Panel 2 Intermediate Stock Calibration Verification 
Standard (Cd, Mn, Hg)”, and “Whole Blood Metals Panel 2 
Intermediate Stock Calibration Verification Standard (Pb)”,  “3% (v/v) 
HCl”, date of preparation, expiration date (1 year from date of 
preparation), initials of preparer, and concentrations for each element). 

3. Storage:  Store at room temperature.  If purchased, label bottle with 
additional information such as “store at room temperature”, date received, 
date opened, and initials of person to first open. 

n. Intermediate Working Calibration Verification Standards: 

i. Purpose:  Used as needed to on the day of analysis to prepare the necessary 
working calibration verification standard(s) that will be placed on the 
autosampler. 

ii. Content:  Three aqueous dilutions of the intermediate stock calibration 
verification standard with a 3% (v/v) hydrochloric acid (HCl) matrix.  Final 
concentrations are listed in Table 8 of Appendix B. 

iii. Preparation & Storage:  Different volumes may be prepared by adding 
proportionally larger or smaller volumes of solution constituents. 

1. Cleaning flasks:  Acid-rinse three 100 mL, PP (or PMP) volumetric flasks.  
Mark each flask according to intended use.  Dedicate to purpose.  

2. 3% (v/v) HCl Diluent Preparation:  use the same 3% (v/v) HCl prepared in 
Section 6.g. 

3. Partially fill each 100 mL flask with the 3% (v/v) HCl diluent (50-75% full).   

4. Add the correct volume of the Intermediate Stock Calibration Verification 
Standard (according to Table 8 in Appendix B). 

5. Dilute to the volumetric mark with the 3% (v/v) HCl diluent using a pipette 
for the final drops.  Mix the flask solution thoroughly.  Final concentrations 
are listed in Table 8 of Appendix B.   

6. Once mixed, transfer to acid-cleaned, labeled, 50 mL containers (PP, PMP, 
or Teflon™) for storage.  Label appropriately (e.g. “Whole Blood Metals 
Panel 2 Intermediate Working Calibration Verification Standard #”, “3% 
(v/v) HCl”, date of preparation, expiration date (1 year from date of 
preparation), initials of preparer, concentration of each element and Lot # 
of the stock solution). 

7. Pour 10-15 mL of each solution into 15 mL tubes for as-needed use. 

o. Internal Quality Control Materials (“Bench” QC) 

i. Purpose:  Internal (or “bench”) quality control (QC) materials are used to 
evaluate the accuracy and precision of the analysis process, and to determine 
if the analytical system is “in control” (is producing results that are acceptably 
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accurate and precise).  They are included in the beginning and at the end of 
each analytical run. 

ii. Content:  Pooled animal or human blood, and may have been spiked with 
NIST-traceable elemental standards to reach desired low-normal and high-
normal concentrations. 

iii. Preparation & Storage: Quality control materials can be either prepared by 
purchased from an external laboratory or prepared within the CDC 
laboratories.  Quality control must always be traceable to the National Institute 
for Standards and Technology (NIST).  The CDC laboratory currently prepares 
its own bench QC materials using the following procedures: 

1. Purchase of whole blood: Bags of human blood can be purchased from 
various sources such as American Red Cross of Tennessee Blood 
services (http://tennesseebloodservices.com/).  Animal blood may be 
available from the Wisconsin State Laboratory of Hygiene (WSLH).  

2. Screening blood:  Screen bags of blood for analyte of interest 
concentration before mixing together to make 2 separate base blood pools 
(for preparing the low and high bench QC materials).   Samples can be 
screened individually  

a. Keep blood refrigerated whenever possible to minimize microbial 
growth. 

b. Because this is only a quick screen of the analyte of interest 
concentration, the number of replicates in the blood method can be 
reduced to one in order to reduce analysis time. 

c. Analyte concentrations in the final blood pool to be spiked for the low 
bench QC pool should be in the low-normal population range.  Analyte 
concentrations in the final blood pool to be spiked for the high bench 
QC pool should be less than some pre-selected target concentration 
values in the high normal population range.  See Table 2 in Appendix 
B for recommended concentration ranges.   

3. Combining Collected blood:  The goal is for combining samples is to 
approach an ‘average’ matrix for each pool. 

a. Graduate four acid-washed 10 L carboys (PP or PMP) in 0.5 L 
increments (two will be used for decanting into). 

b. Combine collected blood samples into two separate acid-washed 10 L 
carboys (PP or PMP), according to their concentrations, for the low 
bench and high bench QC pools.  

c. Mix each blood pool using carboy stirrers and large stir plates.  Keep 
blood refrigerated whenever possible. 

4. Spiking of blood 

a. Analyze three samples of each blood pool.  Record these results for 
future recovery calculations. 
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b. Use these results to determine target analyte concentrations possible 
for the pools 

c. Calculate the volume of single element standards needed to spike 
each pool to the desired concentrations.  See Table 2 in Appendix B 
for recommended concentration ranges.   

d. While stirring the pools on large stir plates, spike each pool with 
calculated volumes of single element standards (all spiking standards 
used must be traceable to NIST).   

e. Continue to stir pools overnight after spiking, then reanalyze.   

f. Repeat steps 4 and 5 until all analytes reach target concentrations 
keeping track of the total volume of spiking solution added to each 
blood pool. 

5. Dispensing and Storage of blood 

a. Container Types:  Dispense blood into lot screened containers (i.e. – 2 
mL polypropylene tubes).  If possible, prepare tubes of QC which have 
only enough volume for one typical run + 1 repeat analysis.  This 
allows for one vial of QC to be used per day of analysis, reducing 
chances of contamination of QC materials due to multi-day use. 

b. Labels:  Place labels on vials after dispensing and capping if the vials 
are originally bagged separately from the caps.  This minimizes the 
chance for contamination during the process.  Include at least the 
name of QC pool (text and bar code), date of preparation, and a vial 
number on the labels. 

c. Dispensing:  Dispensing can be accomplished most easily using a 
Digiflex automatic pipetter in continuous cycling dispense mode. This 
process should be done in a clean environment (i.e. a class 100 
cleanroom area or hood). 

1. Allow blood to reach room temperature before dispensing (to 
prevent temperature gradients possibly causing concentration 
gradients across the large number of vials being dispensed 
and to prevent condensation problems during labeling of 
vials).  This may require leaving the carboy of blood at room 
temperature overnight before dispensing. 

2. Replace the tubing attached to the dispensing syringe (left 
when looking at front of Digiflex) with a length of clean 
Teflon™ tubing long enough to reach into the bottom of the 10 
L carboy while it is sitting on the stir plate. 

3. Check cleanliness of Digiflex before use by analyzing 1-2% 
(v/v) HNO3 which has been flushed through the Digiflex with a 
portion of the same solution which has not been through the 
Digiflex. 
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4. Approximately one hour before dispensing begins,  

a. With the large stir plate close to the left side of the Digiflex, 
begin stirring the blood pool to be dispensed.   

b. Also during this time, flush the Digiflex with blood from the 
pool to be dispensed.  Place the ends of the tubing 
attached to both the sample and dispensing syringes into 
the carboy of blood so that blood won’t be used up during 
this process.  Be sure to secure both ends of tubing in the 
carboy with Parafilm so they will not come out during the 
flushing process. 

5. After dispensing the blood into the vials, cap the vials and 
label them.  Placing labels on vials after capping minimizes the 
chance for contamination during the process.   

ii. Homogeneity Testing:  After dispensing, check homogeneity of 
analyte concentrations in pool aliquots. Keep samples pulled for 
homogeneity analysis in the sequence that they were dispensed 
for the purpose of looking for trends in concentrations.  Once 
dispensed and homogeneity has been shown to be good 
throughout the tubes of a pool, store tubes at ≤ -20°C and pull 
tubes out as needed for analysis. 

iii. Storage:  Blood pools should be stored long term at ≤ -20°C.  Short 
term storage (several days) at refrigerator temperature (~ 2-4°C). 

 
7) Analytical Instrumentation & Parameters  

(see Section 5 for details on hardware used, including sources) 
 
a. Instrumentation & Equipment Setup: 

 
i. ICP-DRC-MS:  Inductively Coupled Plasma Dynamic Reaction Cell Mass 

Spectrometer ELAN® DRC II. 
 
1. Modifications made to ICP-DRC-MS 
 

a. Stainless steel tubing is preferred between the reaction gas cylinder / 
regulator and the back of the ICP-DRC-MS instrument. 

b. A second mass flow controller will be needed (channel B) that does not 
send the DRC gas through a ‘getter’. 

c. Standard built-in peristaltic pump replaced by DXi-FAST micro-
peripump / FAST actuator unit.  

 
ii. Sample Introduction Setup Notes and Tips 

 
1.  SC-FAST valve setup: Valve connections must match this description. 
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a. Port 1:  1mL sample loop (white nut).  See “Loop, for FAST valve” in 
Section 5.b. for details. 

b. Port 2:  0.5 mm ID probe (red nut) for carrier solution.  See “Probes” in 
Section 5.b. for details. 

c. Port 3:  nebulizer line (green nut) for transfer of liquid to nebulizer.  See 
“Nebulizers” in Section 5.b. for details. 

d. Port 4:  sample loop (white nut).  See “Loop” in Section 5.b. for details. 
e. Port 5:  0.8 mm ID probe (blue nut) for diluted samples.  See “Probes” 

in Section 5.b. for details. 
f. Port 6:  1/8” i.d. vacuum line (black nut).  See “Tubing, FAST vacuum” 

in Section 5.b. for details. 
 

2. Tubing connection between autosampler rinse station and rinse solution 
reservoir:  Tubing of different inner diameters can be obtained from 
Elemental Scientific, their distributors, or custom built in the lab to optimize 
the rinse station fill rate between samples.  Rinse station should not go 
empty at any point. 

 
3. Tubing for autosampler rinse station waste removal: Use minimum drain 

tubing to make this connection.  If this tube is too long, the rinse station will 
not drain properly. 

 
4. Rinse solution jug:  Leave one of the caps on the top of the rinse jug loose 

to allow air venting into the jug as liquid is removed.  Otherwise the jug will 
collapse on itself as the liquid is removed and a vacuum is created inside. 
Use secondary containment tray and label appropriately (see solution 
preparation instructions). 

 
5. Waste solution jug:  Use secondary containment tray and label 

appropriately (see solution preparation instructions). 
 

6. Configuration of tubing and probe for carrier solution:  Can use a PEEK 
adapter to help with connecting peristaltic tubing to to Teflon tubing.  
 

7. Nebulizer:  Changing the nebulizer type will require re-optimization of the 
read delay time in the ELAN software.  Polypropylene nebulizer type (ESI) 
tends to allow for shorter read delay times than quartz concentric 
nebulizers. 
 

8. Configuration of tubing for spray chamber waste removal: 
 

a. Chamber-to-peristaltic pump tubing:   
i. Spray chambers with threaded connection:  Use vendor-supplied 

threaded connector on base of chamber, connecting tubing directly 
to peristaltic pump tubing through a PEEK adapter or directly. 
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ii. Spray chambers without threaded connection:  Use push-on 
connectors with Teflon tubing available from various vendors or 
connect 1/8” i.d. x ¼” o.d. PVC tubing directly to the waste port on 
the spray chamber.  Connect other end of PVC tubing to the white 
/ black peristaltic pump tubing using a tubing connector 
(PerkinElmer item # B3140715). 

b. Waste Jug-to-peristaltic pump tubing:  Connect 1/8” i.d. x ¼” o.d. PVC 
tubing to the white / black peristaltic pump tubing using a tubing 
connector (PerkinElmer item # B3140715).  Place the free end of the 
PVC tubing through the lid of the waste jug (be sure it is secure).  
Waste jug should be sitting in a secondary containment tray in case of 
overflow. 
 

iii. Cones:  Platinum or Nickel cones have been used and tested to be 
comparable in performance from either PerkinElmer or Spectron. 

 
iv. Gases & Regulators setup: 

 
1. Argon:  Argon stored as liquid in a dewar (180-250 L) or bulk tank.  

Gaseous argon used for plasma and nebulizer.   
 

a. Regulator for argon source (if a dewar):  Keep the inlet pressure 
(headspace pressure of liquid argon dewar) above 100 psi.  Set 
delivery pressure to 90-100psi to allow for pressure drop across tubing 
that stretches to the instrument.  See Section 5.e for part numbers and 
details. 

b. Step down regulator (if source of argon is a bulk tank):  Place this single 
stage regulator in the lab so that incoming argon pressure can be 
monitored and adjusted.  Set delivery pressure to approximately 85 -
100 psig.  See Section 5.e for part numbers and details. 

c. Regulator at ICP-DRC-MS:   Single stage “argon regulator filter kit” 
supplied with the ICP-DRC-MS.  Set the delivery pressure to 
approximately 80 psi. 

2. Methane (99.99%) gas for DRC channel A 
a. Regulator for CH4 gas:  Set the delivery pressure = 5-7 psig.  See 

section 5.e for part numbers and details. 
 

3. Oxygen (99.999+%) gas for DRC channel B.    
a. Regulator for O2 gas:  Set the delivery pressure = 5-7 psig.  See 

Section 5.e for part numbers and details. 
 

b. Flash arrestor:  Brass flash arrestor is used on outlet side of regulator.    
See Section 5.e for part numbers and details. 
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v. Chiller / Heat Exchanger: Refrigerated chiller (for ELAN® 6100 DRCPlus 
instruments) or heat exchanger (for ELAN® DRC II instruments).  For 
refrigerated chiller, set temperature control to 18°C.   

 
vi. Computer:  Dell Optiplex GX150, GX270, or GX280 have all been used.  

Processors used have included Pentium III (1 GHz) through Pentium IV (2.8 
GHz).  Recommend 512Mb - 1Gb RAM.  External hard disk drive for nightly 
backups of data connects via USB port.  Software used includes Windows XP 
Professional, service pack 2 and ELAN v3.3. 

 
vii. Autosampler:  ESI SC-FAST series  

 
b. Parameters for Instrument and Method:  See Appendix B Table 1 pp 52-54 for a 

complete listing of the instrument and method parameters.  Also, see Figures 1a-
1g in Appendix B for images of the ELAN method screens. 

 
8) Method Procedures 

a. Quality Control:  Quality control procedures implemented in this method are 
defined by the Division Procedures and Practices Guidelines and include two 
types of QC systems which are both subjected to the complete analytical 
process.  The data from these materials are then used to estimate 
methodological imprecision and to assess the magnitude of any time-associated 
trends.  The concentrations of these materials should cover the expected 
concentration range of the analytes for the method.  Before QC materials can be 
used to judge patient analytical runs, acceptable QC concentration limits must be 
calculated from the concentration results observed in at least 20 characterization 
runs.  During the 20 characterization runs, previously characterized QCs or pools 
with target values assigned by outside laboratories should be included to 
evaluate the analysis.  The process of limits calculation is performed using the 
laboratory database and the SAS division QC characterization program. 

i. Types of Quality Control:   
1. “Bench QC”:  The bench QC pools used in this method comprise two levels 

of concentration spanning the “low-normal” and “high-normal” ranges of the 
analyte of interest.  The intent of bench QC is for the analyst to evaluate  
the performance of the analytical system on the day of analysis.  The 
analyst inserts both the “low” and the “high” bench QC specimens two 
times in each analytical run (a set of consecutive assays performed without 
interruption) so that judgments may be made on the day of analysis.  The 
first analysis of the two bench QC pools is done after the calibration 
standards are analyzed but before any patient samples are analyzed (so 
that judgments on the calibration curves may be made before analysis of 
patient samples).  The second analysis of the two bench QC pools is done 
at the end of the run (approximately 20 patient samples total).  If more 
patient samples are analyzed on the same calibration curve after the 
second run of the bench QC, both the low-normal and high-normal bench 
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QC must be reanalyzed before and after the additional samples.  For 
example, the schemes shown in Table 9 p.67 are both acceptable ways to 
analyze multiple consecutive “runs”.   
 

2. “Blind QC”:  When possible, “blind” QC samples are QC materials placed in 
vials, labeled, and processed so that they are indistinguishable from the 
subject samples handled by the analyst.  Ideally, the supervisor decodes 
and reviews the results of the blind specimens without the analyst knowing 
of their presence in the runs.  When it is not possible to have blind QC 
materials processed so that they are indistinguishable by the analyst from 
the patient samples, it is acceptable for the analyst to randomly insert into 
the run a QC material which only the QC reviewer knows the acceptable 
concentration limits for.  At least one low-normal concentration and one 
high-normal concentration QC material should be kept in the laboratory for 
this purpose. 

3. External Reference Materials:  Materials produced by laboratories outside 
of the CDC which have assigned target concentrations can be helpful in 
verifying method performance.  Samples from previous challenges of 
proficiency testing programs (i.e. Centre de Toxicologie du Quebec (CTQ)) 
can be used.  However, only the results for the bench and blind QC 
materials are used to determine if the run results can be used. 

ii. Calibration Verification:   

1. Bi-annual tests as defined in the DLS Policy and Procedures manual:  
CLIA requires the verification of accuracy of instrument response to analyte 
concentration be completed at least every 6 months.  NIST traceable 
calibrators are analyzed in each run to define this response up to the 
concentration of the highest calibrator in the run.  To verify accuracy of 
instrument response at concentrations higher than the highest calibrator in 
each run, analyze a NIST traceable standard with very high concentrations 
(see Table 8 p.66 in the Appendix for concentrations) at least every 6 
months.  Prepare the Calibration Verification Standard for analysis just as a 
working calibrator is prepared.  Use the “Blank” as the blank when it is 
analyzed.  If the observed concentrations for the Calibration Verification 
Standard are not within 10% of the target value (see Table 8 p.66 in the 
Appendix) the lab supervisor should be notified and the issue should be 
investigated.  Do not substitute external reference materials (i.e. biological 
samples from a PT program) for the Calibration Verification Standard when 
performing this.  Solutions needed for the Calibration Verification checks 
can be purchased from standards vendors (i.e.SPEX, High Purity 
Standards, etc . . .) or prepared in-house from NIST traceable single 
element standards.  Always verify that normal background levels have 
been re-achieved through adequate rinse time following analysis of 
elevated standards for calibration verification. 

a. As-needed confirmations (per supervisor discretion):  When a sample 
result is greater than the highest calibrator in the run, the supervisor 
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may request that the result be confirmed in an analysis run which 
includes a standard or external reference material with equivalent 
(within 10%) or greater concentration than the sample.  In order to 
avoid needless contamination of the instrument with high 
concentrations of analytes, the analyst should use the lowest 
appropriate calibration verification solution concentrations to meet the 
need. 

For infrequent verification needs, the calibration verification stock 
solutions can be used to prepare verification standards to appropriate 
concentrations.  This will, however, introduce elevated concentrations 
of manganese to the sample introduction system.  Frequent 
measurement of these very high concentrations can result in high 
background levels in the instrument which are difficult to rinse out and 
which may limit the ability to measure low concentrations. 

For frequent verification needs (i.e. when certain studies have many 
elevated results) or when a concentration higher than those shown in 
Table 8 p.66 needs to be verified,  use NIST-traceable single element 
stock standards to prepare single element verification standards.  This 
will limit the exposure of the instrument to elevated concentrations of 
only the elements needing verification. 

Always verify that normal background levels have been re-achieved 
through adequate rinse time following analysis of elevated standards 
for calibration verification.  An external reference material (i.e. historical 
proficiency testing sample) can be substituted in place of the 
Calibration Verification Standard sample in these situations IF: 

i. The target value has been assigned by an external source (i.e. 
NIST, or the proficiency testing program). 

ii. The concentration of the external reference material is within 10% 
or is higher than the concentration of the material you need it to 
confirm. 

iii. There is confidence that there is no contamination of previously 
used external reference material. 

iv. A note to file is made that this was done.  

v. If the observed concentrations are not within 10% of the target 
value the lab supervisor should be notified and the issue should be 
investigated. 

b. Daily Analysis of Samples 

i. Preparation of the Analytical Equipment 

For further details on any part of this description, see the IRAT Daily Startup 
SOP for ELAN ICPMS instruments. 
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1. Power on the computer, printer, peristaltic pump, and autosampler, and log 
into the operating system. 

2. Peristaltic pump:  Set up the peristaltic pump tubing with proper tension for 
the sample rinse station. 

3. Software:  Start the ESI autosampler and ELAN® ICPMS software from 
Windows™. 

4. Daily Pre-Ignition Maintenance Checks: Perform daily maintenance checks 
as described in the IRAT Daily Startup SOP for ELAN instruments (i.e., Ar 
supply pressure, interface component cleanliness and positioning, interface 
pump oil condition, vacuum pressure, etc.).  Make appropriate notes in the 
Daily Maintenance Checklist and Instrument Log Book.  

5. Start the Plasma:  Press the “Start” button in the software or on the 
hardware to ignite the plasma.  

a. Start the peristaltic pump:  Start the peristaltic pump in the software at 
12rpm (using a standard 6 roller peristaltic pump) or 5.4rpm if using a 
DXi mini-peristaltic pump.  Verify the rotational direction is correct. 

6. Aspirate liquid:  Place the carrier probe into dilute acid or water.   

7. Warm-up time:  Allow at least 45 minutes warm-up time for the ICP-DRC-
MS after igniting the plasma.  This warm-up time is for the RF generator.  
There will be another “Stability time” for the DRC later in this procedure. 

8. Daily Performance Check:  After this warm-up time, perform a daily 
performance check and any optimizations necessary (as described in the 
IRAT Daily Startup SOP for ELANs).  Fill in the Daily Maintenance 
Checklist according to the optimization procedures performed.  Extra detail 
than can be documented in the checklist should go into the instrument 
logbook. 

a. Magnesium (24Mg) may have high RSDs due to the use of Triton-X100 
in the rinse solution.  Avoid this problem by either temporarily using 
non-Triton-containing rinse solution during the daily check, or repeating 
the daily check multiple times in succession with no rinse time 
between.   

b. Saving the Files:  Save updated tuning and optimization parameters to 
the “default.tun” and “default.dac” files, respectively. 

9. Software setup for Analysis: 

a. Workspace (files & folders):  Open the default 
(“CDC_WBMP2_methITB006A_.wrk”) or your own personalized 
workspace in the ELAN software.  Verify & set up the correct files and 
data directories for your analysis (See Table 1 pp 60-62 “File Names & 
Directories“). 

b. Samples / Batch Window:  Update software to reflect the current 
sample set.  The only fields which need to be filled in include the 
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autosampler location, sample identification (id), measurement action, 
method, sample flush time, sample flush speed, read delay time, read 
delay & analysis speed, wash time, wash speed. Use a bar code 
scanner to input data whenever possible.  See Table 1 pp 60-62 for 
times and speeds.  Save the Sample window file and re-use it on other 
days by simply replacing the sample IDs for the patient samples. 

 
1. DRC Stability Time:  Best analyte-to-internal standard ratio 

stability is typically obtained after 1-1.5 hrs of repeated 
analysis of blood samples using the DRC method.  Analyze 
enough “dummy” blood sample dilutions prior to any DRC 
analysis run to fill 1-1.5 hours of analysis time. See Table 10 
p.68 for example of setup in the Samples / Batch window. 

 
2. Blood vs. Aqueous Method Files:   

a. The difference: There are two ELAN method files for this 
one method (see Table 1 pp 61-62).  It is necessary to use 
both to accomplish each run because the current 
PerkinElmer software will not allow for more than one blank 
per method file.  The ONLY DIFFERENCE between these 
two files is on the Sampling tab where one lists the 
autosampler positions of the blood blank and blood 
calibrators (the “bldblk” method file) and the other lists the 
autosampler position of the aqueous blank (the “aqblk” 
method file).   

b. Use:  The ONLY TIME when it matters which of these files 
is used is when the measurement action includes “Run 
blank” or “Run standards”.  When the measurement action 
is only ‘run sample’, it does not matter whether the “bldblk” 
or “aqblk” method file is used.  Analysts typically follow the 
pattern below, however, for the sake of consistency and as 
a reminder of which blank must be used for which type of 
sample.  See Table 10 p.68. 

i. The “bldblk” method file:  Use to analyze the initial 
blood blank (blank for the calibration curve), the blood 
calibrators, and the blood blank checks (WB Blank & 
WB Blank 2) at the very beginning of the run.  The 
blood blank method defines the blood blank in 
autosampler location 105 and the blood calibration 
standards 1-5 in autosampler locations 106-110, 
respectively. 

ii. The “aqblk” method file must be used to analyze all QC 
materials and patient samples.  The aqueous blank 
method (set up for a ESI SC4 autosampler) defines the 
aqueous blank in autosampler location 113.   
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3. Notation of Dilutions:  To designate an extra dilution of a 
sample, edit the sample ID to reflect the level of dilution being 
performed (e.g., A 1:2 dilution of sample 1 would be reflected 
in the sample ID “sample 1 (2x dilution)”.  This sample ID will 
be edited during the data-import process to the database so 
that it is recognized as the appropriate sample.  Do not use 
the ELAN® software to automatically correct for sample 
dilutions.  Extra dilution is performed on blood samples whose 
concentration is greater than the concentrations listed in Table 
8 in Appendix B (linearity of the method has been documented 
up to these concentrations). 

c. Method file modifications:  This method can also be used to analyze 
whole human blood samples for a subset of the listed samples (i.e. Pb 
only).  To do this delete the unnecessary elements from the method 
windows (bldblk and aqbkl) and save the file with a descriptive name 
such as “WBMP2_DLS3016_bldblk_Pb_only.mth” and 
“WBMP2_DLS3016_aqblk_Pb_only.mth”. 

ii. Preparation of Samples for Analysis  (See Table 6 in Appendix B) 

1. Thaw the frozen blood specimens; allow them to reach ambient 
temperature. 

2. Prepare enough DRC stability sample to be analyzed for 1-1.5 hr before 
the beginning of the run.  This can be prepared using 50 mL 
polypropylene tubes or a wide-mouth bottle (which can be put on the 
autosampler in place of one of the tube trays). 

3. Set up a series of 15 mL polypropylene tubes corresponding to the 
number of blanks, standards, QCs, and patient samples to be analyzed. 

4. Prepare the following solutions in the 15 mL falcon tubes using the 
Digiflex™ (see Table 6 p.65 for a summary). 

a. Aqueous Blank:  Prepare two aqueous blanks consisting of 200 L of 
>18 Mega-ohm·cm water and 4800 L of diluent.  One will be the 
actual aqueous blank and the other will be a backup (“Aqueous Blank 
Check”) in case the original aqueous blank gets contaminated. 

b. Blood Blank (Std 0):  Prepare three blood blank dilutions consisting of 
100 L of base blood (same material used to prepare the blood 
calibration standards), 100 L of > standard zero (3% (v/v) HCl), and 
4800 L of diluent.  One of these blood blanks will be the blank for the 
calibration standards; the other will be analyzed after standard 5 as 
BldBlkChk.   

c. Calibrators:  Prepare the working calibration standards as 100 L of 
the appropriate aqueous intermediate working calibration standard, 
100 L of base blood, and 4800 L of diluent. 
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d. Patient & QC Samples:  Before taking an aliquot for analysis, mix the 
sample on the vortex for approximately 15 seconds.  Prepare blood 
sample dilutions as 4,800 L of diluent and 100 L of the blood sample 
and 100 L of >18 Mega-ohm·cm water. 

e. Cap all of the blanks, standards, and samples and mix them on the 
Vortex for approximately 10 seconds.  Uncap them and place them in 
the autosampler of the ELAN® ICPMS in the order that was entered in 
the Samples / Batch window of the ELAN software. 

iii. Specimen Storage and Handling During Testing:  Specimens may be left at 
room temperature during analysis in case confirmation analyses must be 
made.  Take stringent precautions to avoid external contamination by the 
metals to be determined.  Specimens may be stored short term at refrigerated 
temperatures, but should be stored long term (>4 weeks) at ≤ -20 °C. 
 
NOTE:  Samples must be analyzed within 24 hours of preparation to obtain 
valid results for selenium.  The method has been validated to produce valid 
results for other Pb, Cd, Hg, and Mn even 48 hrs after sample preparation.  
See critical parameter test #1 in Appendix A for details. 

iv. Starting the Analysis:  Begin the analysis using the ELAN software. 

v. Monitoring the Analysis:  It is preferable to initiate work early enough in the day 
to permit the entire run to be monitored.  If it is not possible to complete the 
analysis by the end of the work day, the run may be left to complete itself 
unattended as long as appropriate planning is made for either overnight 
operation or Auto Stop (see below).   

Monitor the analysis for the following: 

1. DRC stability (analyte / internal standard ratio stability) 

After the analysis of the DRC stability “dummy” samples, the stability of the 
analyte / internal standard ratios across these samples indicates the 
instrument stability going into the run. 

2. Proper operation of the instrument. 

3. Contaminated blanks. 

4. Linear calibration curves. 

a. Typical correlation coefficients will be 0.999 to 1.000. 

b. The ELAN software generates a “simple linear” calibration curve (using 
a least squares calculation) for manganese in this method.  The curves 
are generated using the results from analysis of the blood blank and 
the 5 external blood calibrators whose concentrations are defined in 
the Calibration tab of the Method file.  Specifically, the software plots 
the “net intensity” (y-axis) versus the analyte concentration (x-axis).  
The “net intensity” is the blank subtracted ratio of the measured 
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intensity for the analyte to the measured intensity of the associated 
internal standard and is calculated as follows:  

 

Blank

Blank

sample

sample

IntensityMeasStdInternal

IntensityMeasAnalyte

IntensityMeasStdInternal

IntensityMeasAnalyte
ensitynet 

.
int

` 

c. Points (1-2) may be removed from the calibration curve if necessary to 
provide appropriate correlation coefficients.  It is preferable, however, 
to re-analyze problematic calibration standards rather than dropping 
points.  Recurring problems with calibration standards should be 
resolved expeditiously. 

5. Bench QC results within the acceptable limits.   

If an analyte result for the beginning QC material(s) falls outside of the 99% 
limits, then the following steps are recommended:  

a. If a particular calibration standard is obviously in error, remake a new 
dilution at the Digiflex of that working calibrator, reanalyze it, and 
reprocess the sample analyses using this new result as part of the 
calibration curve. 

b. Prepare a fresh dilution of the failing QC material and reanalyze it. 

c. Prepare fresh dilutions at the Digiflex of all of the calibration standards 
(working blood multi-element standards) and reanalyze the entire 
calibration curve using the freshly prepared standards. 

If these three steps do not result in correction of the out-of-control values 
for QC materials, consult the supervisor for other appropriate corrective 
actions. Do not report analytical results for runs that are not in statistical 
control. 

6. Good precision among replicates. 

7. Consistent measured intensities of the internal standards.   

Some sample-to-sample variations are to be expected.  However the 
intensities should be within a few percent of one another, and should 
fluctuate around an average value (not drift continuously in one direction). 

8. Elevated patient results: Confirmation by repeat measurement will be 
required for any result greater than the “1st upper boundary” (see Section 
8.b.viii.2).  A calibration verification check of equal or greater concentration 
must be analyzed in the same run as the elevated study sample result if it 
is to be used for reporting (see Section 8.a.ii.2). 

vi. Records of Results:  Run results will be documented daily in both electronic 
and paper form. 

1. Electronic Records: 



Blood Metals Panel 2 (BMP2) by ICP-DRC-MS        
 
IRAT-DLS Method Code: 3016                                                                 Page 47 of 88 
 

 

a. Transfer of Results to the Laboratory Information System / Database:  
Transfer data electronically between computers or software to reduce 
errors.  When keyboard entry must be used, proofread transcribed 
data after entry. 

b. Long-Term Storage of ELAN software files:  Files used and produced 
by the ELAN software in analyzing samples will be backed up long 
term on compact disk and kept a minimum of three years. 

2. Paper Records:  The paper copy of the results from the run should be put 
into the study folder(s) and should include  

a. A summary of the calibration curve statistics. 

b. A printout of analysis of each measurement made during the run. 

c. On the front sheet of the printed records, write the following 

i. Analyst initials 

ii. Instrument ID 

iii. Date of Analysis 

iv. Run # for the day on this instrument 

v. Study ID and Group Number 

vi. Database batch ID (Not known until the run is imported into the 
database) 

vii. Transfer of Results to the Laboratory Database:  Every analytical run 
performed for the analysis of patient samples should be entered into the 
laboratory results database unless the run is not useable for obvious reasons 
(e.g. the run is stopped for some reason before ending QC is analyzed, no 
internal standard spiked into the diluent, etc. . . ). 

1. Data Export Process (from ELAN® software to .TXT file):  If the data file 
was not created during the initial analysis, reprocess the data of interest 
either with “original conditions” option, or by loading the method file used 
during the analysis.  Use report options file “CDC_Database Output.rop” 
and type in a descriptive report filename using a format such as “2005-
0714a_DRC2F_group55.txt” to designate data from analysis of group 55 
from July 14, 2005, run #1 of instrument “DRC2F”.  Under “Report Format”, 
choose the “Use Separator” option, and under the “File Write” section, 
choose “Append.”  

2. Data Import Process (from .TXT file to Laboratory Information System):   

a. Move the .TXT file created in the data export process to the 
appropriate subdirectory on the network drive where exported data are 
stored.  Directories for data storage are named according to instrument 
\ year \ month. 

b. Import the instrument file into the LIMS. 
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c. Enter the appropriate information to identify the instrument, assay, 
analysis date & time, run number, analyst, calibrator lot number and 
prep date used (use the “IS Lot Number” field) and study.  If other than 
default values for Method LOD, High Calibrator, Rep Delta Limit, and 
units were used in the run, document accordingly. 

d. In the “Import Instrument Results” table, correct sample IDs and 
document dilution factors if dilution factor notations were added to the 
ID in the ELAN software prior to analysis.   

e. Once transferred into the database, the data should be evaluated for 
QC pass / fail, then appropriate settings entered for QC accept / reject, 
final value status, and comments. 

viii. Analyst Evaluation of Run Results: 

1. Bench Quality Control:  After completing a run, and importing the results 
into the LIMS, export the QC results to the SAS program where the 
analytes in the run will be judged to be in or out of control.  The QC limits 
are based on the average and standard deviation of the beginning and 
ending analyses of each of the bench QC pools, so it will not be possible to 
know if the run is officially accepted or rejected until it is completed.   

a. Quality Control Rules:  The SAS program applies the division QC rules 
to the data as follows:  

i. If both QC run means (low & high bench QC) are within 2Sm limits 
and individual results are within 2Si limits, then accept the run. 

ii. If 1 of the 2 QC run means is outside a 2Sm limit - reject run if: 

1. Extreme Outlier – Run mean is beyond the characterization 
mean +/- 4Sm 

2. 1 3S Rule - Run mean is outside a 3Sm limit 

3. 2 2S Rule - Both run means are outside the same 2Sm limit 

4. 10 X-bar Rule – Current and previous 9 run means are on 
same side of the characterization mean 

iii. If one of the 4 QC individual results is outside a 2Si limit - reject 
run if: 

1. R 4S Rule – Within-run ranges for all pools in the same run 
exceed 4Sw (i.e., 95% range limit) 

Note: Since runs have multiple results per pool for 2 pools, the R 4S 
rule is applied within runs only.  

Abbreviations: 

Si = Standard deviation of individual results (the limits are not shown 
on the chart unless run results are actually single 
measurements). 
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Sm = Standard deviation of the run means (the limits are shown on the 
chart). 

Sw = Within-run standard deviation (the limits are not shown on the 
chart). 

iv. Implications of QC Failures:  If the division SAS program declares 
the run out of control”, then all results from the run are invalid for 
reporting from the run.  Set all run results as “QC Rejected” in the 
database. 

2. Patient Results: 

a. Elevated Results: 

i. Boundaries Requiring Confirmatory Measurement: 

1. Results Greater than the First Upper Boundary (1UB):  
Concentrations observed greater than the “first upper 
boundary” (defined in the laboratory database as the “1UB”) 
should be confirmed by repeat analysis of a new sample 
preparation.  The concentration assigned to the 1UB for an 
element is determined by study protocol but default 
concentrations are in Table 11 p.69 in the Appendix.  Report 
the original result, as long as the confirmation is within 10% of 
the original.    Continue repeat analysis until a concentration 
can be confirmed. 

2. Results Greater Than Highest Calibrator:  When a sample 
result is greater than the highest calibrator in the run, the 
supervisor may request that the result be confirmed in an 
analysis run which includes a standard or external reference 
material with equivalent (within 10%) or greater concentration 
than the sample.   

3. Results Greater Than Calibration Verification Standard:  
Perform an extra dilution on any blood sample whose 
concentration is greater than those listed in Table 8 p.66 in the 
Appendix (the linearity of the method has been documented up 
to these concentrations).  See Table 6 p.65 for description of 
sample preparation with extra dilution. 

ii. Inadequate Precision in Confirmation of a Measurement:  If a 
sample is reanalyzed to obtain a confirmation of an initially 
elevated result, the confirmation should be within 10% of the 
original result. 

iii. Analyst Reporting of Elevated Results:  Concentrations observed 
greater than the “second upper boundary” (defined in the 
laboratory database as the “2UB”) should be reported to the QC 
reviewer as an “elevated result”.  The concentration assigned to 
the 2UB for an element is determined by study protocol but default 
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concentrations are in Table 11 of Appendix B.  The analyst should 
report any patient results confirmed to be greater than the second 
upper boundary to the QC reviewer as an “elevated result”.  There 
is no routine notification for elevated levels for the metals 
determined in this method.  The protocol for supervisors reporting 
elevated results to medical personnel is defined according to the 
study protocol. 

b. Inadequate Precision Within One Measurement:  If the range of the   
three replicate readings (maximum replicate concentration value - 
minimum replicate concentration value) for a single sample analysis is 
greater than the criteria listed in Table 11 of Appendix B (“>Lim Rep 
Delta” in the database) and the range of the three replicate readings is 
greater than 10% of the observed concentration, do not use the 
measurement for reporting.  Repeat the analysis of the sample. 

ix. Submitting final work for Review:  Once results have been imported, reviewed, 
and set as final in the database by the analyst,  

1. Submit an email to the QC reviewer informing them of the readiness of the 
data for final review.  The email should follow requirements specified by the 
QC reviewer and will include: 

a. Instrument ID, run Date, run number, study ID, group ID. 

b. Any bench QC failures (include reasons if known). 

c. Any patient sample result greater than the 2UB boundaries (see Table 
11 in Appendix B). 

d. Anything out of the ordinary about this analytical work which could 
have a bearing on the availability (i.e. insufficient sample to analyze), 
accuracy, or precision of the results. 

2. Include all items called for by the study folder cover sheet in the study 
folder (i.e. printouts from the ICP-MS, bench QC evaluation) together in the 
study folder before submitting the folder for review when analysis is 
complete. 

x. Overnight operation or Using Auto Stop:  Make every effort to complete 
analysis within the work day so that the entire run can be monitored.  If it is not 
possible to complete the analysis by the end of the work day, the run may be 
left to complete itself unattended as long as appropriate planning is made for 
either overnight operation or Auto Stop. 

1. 24 hrs / day operation in DRC mode: 

a. To reduce startup time in the mornings, the analyst is encouraged to 
operate the ELAN in DRC mode 24hrs/day during the work week.  This 
eliminates the need for daily 45 minute RF generator warm-up, and 
possibly the need for DRC stability time (if the DRC gas is not off for 
extended periods of time before analysis).  To maintain the instrument 
in DRC mode when not analyzing patient samples, setup multiple 
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sample rows in the Samples / Batch window with autosampler position 
in zero (rinse station of autosampler) and wash time of 1800s (30 
minutes).  Repeat this sample row enough times to keep the 
instrument in analysis mode overnight (1 sample with 15 minute wash 
will take ~ 25 minutes). 

2. AutoStop:  If 24 hrs / day ELAN operation is not desired, the instrument 
can shut the plasma off unattended after analysis.  Setup this as follows: 

a. On the “Auto Start / Stop” tab of the Instrument window, enable the 
Auto Stop feature. 

b. Press the “Change” button within the Auto Stop box and set the 
Delayed shutdown time to 5 minutes.  This will rinse the sample 
introduction system of blood matrix before turning off the plasma. 

c. It will be necessary to replace the sample peristaltic pump tubing the 
next day since it will have been clamped shut overnight. 

c. Equipment Maintenance:  Analysts are expected to follow a 4-day analysis / 1-
day maintenance schedule in the laboratory.   

i. ICPMS Maintenance:  On the maintenance day, perform all maintenance per 
the IRAT ELAN ICP-MS Weekly Maintenance SOP.  All equipment 
maintenance should be documented in the instrument checklist and logbook.   

ii. Data Backup:  Data on the ELAN computer will be backed up via two backup 
routines.   

1. Daily Backups to External Hard Drive:  Automatic backups of the “elandata” 
directory and all subdirectories should be programmed to occur each night 
onto an external hard disk using a three-file rotating backup scheme. 

2. Weekly Backup to CD:  Backup all files in the active “elandata” directory 
and all subdirectories onto one recordable compact disc during the weekly 
maintenance SOP.  When the active “elandata” directory on the ICP-DRC-
MS computer hard drive becomes too large to fit onto a single recordable 
compact disk, the oldest data can be removed from the computer to make 
it easier to backup the entire directory weekly.  This can usually be done 
annually. 

a. Backup the oldest data on the hard drive to two duplicate compact 
disks and verify that the files on the CD are readable 

b. Label them with the name of the instrument, the date range of the data, 
the current date, your name, and “Copy 1 of 2” or “Copy 2 of 2” 

c. After verifying that the CDs are readable, the oldest, backed up data 
can be deleted from the ICP-MS computer hard drive. 

d. It is best to not store duplicate copies in the same location. 
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9) Interpretation of the Results 

a. Reportable Range:  Whole blood metals values are reportable in the range 
between the method LOD (see Section 10.a) and the highest concentration 
verified accurate by bi-annual calibration verification tests (see Appendix, Table 8 
in Appendix B). For example, if a blood metals concentration is less than the 
method LOD, report it as < LOD.  Above the highest concentration verified, extra 
dilutions are made of the blood sample to bring the concentration within the 
verified range.  

b.  Reference Ranges (Normal Values):  See Appendix B, Table 12. 

c. Action Levels:  Concentrations observed greater than the “second upper 
boundary” (defined in the laboratory database as the “2UB”) should be reported 
to the QC reviewer as an “elevated result”.  The concentration assigned to the 
2UB for an element is determined by study protocol but default concentrations 
are listed in Table 11 in Appendix B.  The analyst should report any patient 
results confirmed to be greater than the second upper boundary to the QC 
reviewer as an “elevated result”.  The protocol for supervisors reporting elevated 
results to medical personnel is defined according to the study protocol.  Levels of 
concern for mercury in blood are >100 g/L for children (6 yr and younger) and 
>200 g/L for adults.  Levels of concern for lead in blood are 25 g/dL for 
children (6yr. and younger) and 40 g/dL for adults.  Levels of concern for 
cadmium in blood is >5 g/L. 

 
10)   Method Calculations 

a. Method Limit of Detection (LODs):  The method detection limits for elements in 
blood specimens are defined as 3 times s0, where s0 is the estimate of the 
standard deviation at zero analyte concentration.  S0 is taken as the y-intercept of 
a linear or 2nd order polynomial regression of standard deviation versus 
concentration (4 concentration levels of the analytes in blood each measured 60 
times across at least a 2-month timeframe). Method LODs are re-evaluated 
periodically.  

b. Method Limit of Quantitation (LOQ):  The Division of Laboratory Sciences does 
not currently utilize limits of quantitation in regards to reporting limits [58]. 

c. QC Limits:  Quality control limits are calculated based on concentration results 
obtained in at least 20 separate runs.  It is preferable to perform separate 
analyses on separate days and using multiple calibrator lot numbers, 
instruments, and analysts to best mimic real-life variability.  The statistical 
calculations are performed using the SAS program developed for the Division of 
Laboratory Sciences (DLS_QC_compute_char_stats.sas). 

11)   Alternate Methods for Performing Test and Storing Specimens If Test System 
Fails: 

If the analytical system fails, the analysis may be setup on other ELAN DRC 
instruments in the laboratory.  If no other instrument is available, store the 
specimens at 4°C until the analytical system can be restored to functionality.  If 
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interruption longer than 4 weeks in anticipated, then store blood specimens at  ≤ -
20°C. 
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Appendix A:  Critical Parameter Test Results 
 
Critical Parameter Test #1: This test documents that accurate results are attainable if 
something prevents a set of prepared samples from being analyzed immediately (per 
method).  Samples which have been diluted 1+1+48 for analysis up to one (1) day (~29 
hours) previously can still be analyzed.  Results are presented in Table 1. 
 
Test Details: 
Day 1: Prepare a set of dilutions (calibrators, blanks, reference material, fake samples) 

for analysis in triplicate (three separate sets of tubes).Analyze the first set 
immediately (normal practice).  Cap sets #2 and #3 and leave at room 
temperature for later analysis. 

Day 2: Prepared run set #4 and analyzed it sequentially with run set #2 using normal 
method practices. 

Day3: Prepared run set #5 and analyzed it sequentially with run set #3 using normal 
method practices. 

 
Table 1. Ruggedness Testing Results:  Evaluating the significance of time from preparation 
to analysis on sample stability.  Test performed on December 6 – 8, 2010 by Deanna Jones.  
Results below are the average of the beginning and ending QC results for each analytical 
run. 

ID 
Time, prep to 

analysis 
Hg (µg/L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

LB
08

70
7 

_W
B

2 

Target Mean 
and 2SD Range 

0.585 
0.407 – 0.763 

2.12 
2.03 – 2.21 

0.488 
0.398 – 0.578 

7.98 
6.91 – 9.05

 

0 hr 0.418 2.03 0.399 6.09  
24 hr 0.504 1.99 0.419 7.06  
48 hr 0.396 2.04 0.509 7.82  

H
B

08
70

8 
_W

B
2 

Target Mean 
and 2SD Range 

6.19 
5.89 – 6.48 

10.1 
9.84 – 10.3 

3.14 
2.94 – 3.34 

14.9 
13.5 – 16.4

 

0 hr 5.86 10.0 3.03 12.5  
24 hr 5.46 9.5 2.85 13.6  
48 hr 2.64 9.2 2.79 13.5  

Q
M

E
Q

A
S

 
07

B
-0

3*
 Target Mean 

and 2SD Range 
    

228 
213 - 243 

0 hr     192 
24 hr     202 
48 hr     56 

Q
M

E
Q

A
S

 
10

B
-0

6*
 Target Mean 

and 2SD Range 
    

239 
223 - 255 

0 hr     212 
24 hr     221 
48 hr     62 

*samples purchase from Le centre de toxicology du Quebec (Quebec, Canada) 
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Appendix A:  Critical Parameter Test Results (Continued) 
 
Critical Parameter Test #2: This test evaluated the significance of the RF Power setting 
of the ICP when analyzing blood samples for whole blood metals.  The RF Power 
setting per method is 1450W.  The reduced and elevated settings tested are 1150W 
and 1600W, respectively.  Results are presented in Table 2. 
 
Test Details: 
1. Prepare a set of dilutions (calibrators, blanks, reference material, dummy samples) 
for analysis in triplicate (three separate sets of tubes). 
2.  Analyze them in three separate runs on the same day, same instrument. 
3. Change the RF Power across the runs 
4. Allow 15 minutes equilibration time between runs for RF Power to stabilize 
 
Table 2. Ruggedness Testing Results:  Evaluating the significance of RF Power setting on 
sample stability.  Test performed on December 6 and December 10, 2010 by Deanna Jones.  
Results below are the average of the beginning and ending QC results for each analytical run. 

ID RF Power (W) Hg (µg /L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

LB
08

70
7_

W
B

2
 

Target Mean 
and 2SD Range 

0.585 
0.407 – 0.763 

2.12 
2.03 – 2.21 

0.488 
0.398 – 0.578 

7.98 
6.91 – 9.05

 

1150 W  0.517 2.09 0.432 7.35  
1450 W  

(per method) 
0.512 2.03 0.369 6.76  

1600 W  0.529 2.02 0.418 7.17  

H
B

08
70

8_
W

B
2

 

Target Mean 
and 2SD Range 

6.19 
5.89 – 6.48 

10.1 
9.84 – 10.3 

3.14 
2.94 – 3.34 

14.9 
13.5 – 16.4

 

1150 W  5.90 10.0 2.93 13.7  
1450 W  

(per method) 
6.23 10.2 2.90 12.8  

1600 W  5.99 10.1 3.07 13.3  

Q
M

E
Q

A
S

08
B

-0
2*

 

Target Mean 
and 2SD Range 

    
293 

273 - 313 
1150 W      269 
1450 W  

(per method) 
    288 

1600 W      314 

Q
M

E
Q

A
S

08
B

-0
8*

 

Target Mean 
and 2SD Range 

    
165 

154 - 176 
1150 W      179 
1450 W  

(per method) 
    147 

1600 W      146 
*samples purchase from Le centre de toxicology du Quebec (Quebec, Canada) 
 



Blood Metals Panel 2 (BMP2) by ICP-DRC-MS        
 
IRAT-DLS Method Code: 3016                                                                 Page 56 of 88 
 

 

Appendix A:  Critical Parameter Test Results (Continued) 
 
Critical Parameter Test #3: This test evaluated the significance of the dynamic reaction 
cell gas flow rate of the reaction gas (oxygen and methane) while analyzing blood 
samples for elements analyzed in DRC mode (Hg, Mn, and Se).  The cell gas flow rate 
for Mn and Hg is methane (CH4) and the per method setting is 1.2 mL/min.  The cell gas 
flow rate for Se is oxygen (O2) and the per method setting is 0.84 mL/min.  The reduced 
and elevated settings for O2 are 0.96 mL/min and 1.44 mL/min, respectively.  The 
reduced and elevated settings for CH4 are 0.7 mL/min and 1.0 mL/min, respectively.  
The Results are presented in Tables 3 and 4. 
 
Test Details: 
1. Prepare a set of dilutions (calibrators, blanks, reference material, dummy samples) 
for analysis in triplicate (three separate sets of tubes). 
2.  Analyze them in three separate runs on the same day using the same instrument. 
3. Change the cell gas flow rate. 
 
Table 3. Ruggedness Testing Results:  Evaluating the significance of dynamic reaction cell 
gas flow rate on sample stability.  Test performed on December 6, 2010 and January 4, 2010 
by Deanna Jones.  Results below are the average of the beginning and ending QC results for 
each analytical run. 

ID 
Cell Gas  

Flow Rate 
Hg (µg /L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

LB
08

70
7_

W
B

2 

Target Mean 
and 2SD Range 

0.585 
0.407 – 0.763 

2.12 
2.03 – 2.21 

0.488 
0.398 – 0.578 

7.98 
6.91 – 9.05

See  
Table 4 

0.96 mL/min O2;  
0.7 mL/min CH4 

0.457 2.10 0.471 8.49 

1.2 mL/min O2;  
0.84 mL/min CH4  

0.479 2.10 0.438 8.15 

1.44 mL/min O2;  
1.0 mL/min CH4  

0.555 2.11 0.457 8.12 

H
B

08
70

8_
W

B
2 

Target Mean 
and 2SD Range 

6.19 
5.89 – 6.48 

10.1 
9.84 – 10.3 

3.14 
2.94 – 3.34 

14.9 
13.5 – 16.4

0.96 mL/min O2;  
0.7 mL/min CH4 

4.71 10.0 3.19 14.4 

1.2 mL/min O2;  
0.84 mL/min CH4  

5.45 10.1 2.92 15.2 

1.44 mL/min O2;  
1.0 mL/min CH4  

5.34 10.3 3.04 14.6 
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Appendix A:  Critical Parameter Test Results (Continued) 
 
 
Table 4. Ruggedness Testing Results:  Evaluating the significance of dynamic reaction cell 
gas flow rate on sample stability.  Test performed on December 6, 2010 and January 4, 2010 
by Deanna Jones.  Results below are the average of the beginning and ending QC results for 
each analytical run. 

ID 
Cell Gas  

Flow Rate 
Hg (µg /L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

Q
M

E
Q

A
S

07
B

-0
9*

 Target Mean 
and 2SD Range 

See  
Table 3 

157 
146 - 168 

0.96 mL/min O2;  
0.7 mL/min CH4 

187 

1.2 mL/min O2;  
0.84 mL/min CH4  

186 

1.44 mL/min O2;  
1.0 mL/min CH4  

191 

Q
M

E
Q

A
S

08
B

-0
2*

 Target Mean 
and 2SD Range 

293 
273 - 313 

0.96 mL/min O2;  
0.7 mL/min CH4 

328 

1.2 mL/min O2;  
0.84 mL/min CH4  

334 

1.44 mL/min O2;  
1.0 mL/min CH4  

339 

*samples purchase from Le centre de toxicology du Quebec (Quebec, Canada) 
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Appendix A:  Critical Parameter Test Results (Continued) 
 
Critical Parameter Test #4: This test evaluated the significance of the RPq value while 
analyzing blood samples for Se, Mn and Hg.  The RPq value setting per method for Mn 
and Hg is 0.6, and for Se it is 0.65.  The reduced and elevated RPq values for Mn an Hg 
are 0.48 and 0.72, respectively.  The reduced and elevated RPq values for Se are 0.52 
and 0.78, respectively.  The results are presented in Tables 5 and 6. 
 
Test Details: 
1. Prepare a set of dilutions (calibrators, blanks, reference material, fake samples) for 
analysis in triplicate (three separate sets of tubes). 
2.  Analyze them in three separate runs on the same day, using the same instrument. 
3. Change the RPq value. 
 
Table 5. Ruggedness Testing Results:  Evaluating the significance of RPq value on sample 
stability.  Test performed on December 21, 2010 by Deanna Jones.  Results below are the 
average of the beginning and ending QC results for each analytical run. 

ID RPq Hg (µg /L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

LB
08

70
7_

W
B

2 

Target Mean 
and 2SD Range 

0.585 
0.407 – 0.763 

2.12 
2.03 – 2.21 

0.488 
0.398 – 0.578 

7.98 
6.91 – 9.05

See  
Table 6 

0.48 Mn and Hg;  
0.52 Se 

0.455 1.97 0.361 7.86 

0.6 Mn and Hg;  
0.7 Se  

0.418 2.03 0.399 6.09 

0.72 Mn and Hg;  
0.78 Se 

0.402 2.07 0.402 7.99 

H
B

08
70

8_
W

B
2 

Target Mean 
and 2SD Range 

6.19 
5.89 – 6.48 

10.1 
9.84 – 10.3 

3.14 
2.94 – 3.34 

14.9 
13.5 – 16.4

0.48 Mn and Hg;  
0.52 Se 

5.54 9.4 2.79 14.4 

0.6 Mn and Hg;  
0.7 Se  

5.86 10.0 3.03 12.5 

0.72 Mn and Hg;  
0.78 Se 

5.53 9.7 2.88 14.9 
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Table 6. Ruggedness Testing Results:  Evaluating the significance of RPq value on sample 
stability.  Test performed on December 21, 2010 by Deanna Jones.  Results below are the 
average of the beginning and ending QC results for each analytical run. 

ID RPq Hg (µg /L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

Q
M

E
Q

A
S

07
B

-0
9*

 Target Mean 
and 2SD Range 

See  
Table 5 

293 
273 – 313 

0.48 Mn and Hg;  
0.52 Se 

262 

0.6 Mn and Hg;  
0.7 Se  

250 

0.72 Mn and Hg;  
0.78 Se 

277 

Q
M

E
Q

A
S

08
B

-0
2*

 Target Mean 
and 2SD Range 

361 
337 - 385 

0.48 Mn and Hg;  
0.52 Se 

347 

0.6 Mn and Hg;  
0.7 Se  

349 

0.72 Mn and Hg;  
0.78 Se 

364 

*samples purchase from Le centre de toxicology du Quebec (Quebec, Canada) 
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Appendix A:  Critical Parameter Test Results (Continued) 
 
Critical Parameter Test #5: This test evaluated the significance of the Axial Field 
Voltage (AFT) while analyzing blood samples for whole blood metals.  The Axial Field 
Volatge may vary on each instrument.  The Axial Field Voltage was increased and 
decreased by 20%.  The results are presented in Table 7.  
 
Test Details: 
1. Prepare a set of dilutions (calibrators, blanks, reference materials, fake samples) for 
analysis in triplicate (three separate sets of tubes). 
2.  Analyze them in three separate runs on the same day, same instrument. 
3. Change the AFV value +/-  100 V. 
 
Table 7. Ruggedness Testing Results:  Evaluating the significance of Axial Field Voltage on 
sample stability.  Test performed on December 20, 2010 by Deanna Jones.  Results below are 
the average of the beginning and ending QC results for each analytical run. 

ID 
Axial Field 

Voltage 
Hg (µg /L) Pb (µg /dL) Cd (µg /L) Mn (µg /L) Se (µg /L) 

LB
08

70
7_

W
B

2 

Target Mean 
and 2SD Range 

0.585 
0.407 – 0.763 

2.12 
2.03 – 2.21 

0.488 
0.398 – 0.578 

7.98 
6.91 – 9.05

 

 (decreased) 0.511 2.00 40.415 7.77  
 (per method) 0.461 2.04 0.394 6.36  
 (increased) 0.414 2.01 0.376 6.95  

H
B

08
70

8_
W

B
2 

Target Mean 
and 2SD Range 

6.19 
5.89 – 6.48 

10.1 
9.84 – 10.3 

3.14 
2.94 – 3.34 

14.9 
13.5 – 16.4

 

 (decreased) 5.50 9.8 2.91 14.3  
 (per method) 5.62 9.8 2.84 12.0  
 (increased) 5.75 10.1 2.99 12.8  

Q
M

E
Q

A
S

07
B

-0
9*

 Target Mean 
and 2SD Range 

    
157 

146 – 168 
 (decreased)     139 
 (per method)     147 
 (increased)     138 

Q
M

E
Q

A
S

0
9B

-0
8*

 Target Mean 
and 2SD Range 

    
548 

511 - 585 
 (decreased)     501 
 (per method)     556 
 (increased)     532 

*samples purchase from Le centre de toxicology du Quebec (Quebec, Canada) 
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Appendix B 

Table 1.  Instrument and Method Parameters.   

Instrument:  PerkinElmer ELAN DRC II ICP-MS 
                      ESI SC4 autosampler with (optional) PC3 Peltier cooled spray chamber 
Optimization Window Parameters 

RF power 1.45 KW 
Plasma Gas Flow (Ar) 15 L/min 

Auxiliary Gas Flow (Ar) 1.2 L/min 
Nebulizer Gas Flow (Ar) ~0.90 – 1.0 L/min (optimized as needed for sensitivity) 

Ion Lens Voltage(s) AutoLens (optimized as needed for sensitivity) 
QRO, CRO, CPV, 

Discriminator Threshold 
Optimized per instrument by service engineer, or advanced 
user. 

Parameters of x-y alignment, nebulizer gas flow, AutoLens voltages, mass calibration, 
and detector voltages are optimized regularly.  Optimization file name = default.dac. 
Configurations Window Parameters 

Cell Gas Changes 
Pause Times 

Pressurize Delay (From Standard to DRC mode) = 60 
Exhaust Delay (From DRC to Standard mode) = 30 
Flow Delay (Gas changes while in DRC mode) = 30 
Channel Delay (Gas channel change in DRC mode) = 30 

File Names & Directories 
Method file names calibration curve (programmed for  blood blank) 

WBMP2_DLS3016_bldblk.mth 
For QC & patient sample analysis  
(programmed for  aqueous blank) 
WBMP2_DLS3016_aqblk.mth 

Dataset Create a new dataset subfolder each day. Name as “2011-
0820” for all work done on August 20, 2011 

Sample File Create for each day’s work 
Report file name For sample results printouts 

cdc_quant comprehensive.rop 
 
For calibration curve information 
CDC_Quant Comprehensive (calib curve info).rop 

Tuning Default.tun 
Optimization Default.dac 

Calibration N/A 
Polyatomic elan.ply 

Report Options 
Template (transferring 

results to the database) 

CDC_Database Output.rop 
Report Format Options:  select only “Use Separator” 
File Write Option:  Append 
Report File name:  include date, instrument, and group 
being analyzed in file name (i.e. 2005-0311b_DRC2A_HM-
0364.txt) 
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Table 1.  Instrument and Method Parameters.   

Method Parameters 
     Method Parameters:  Timing Page (see Figures 1a, 2a and 2d in Appendix B) 

Sweeps/reading 30 
Readings/replicate 1 

Replicates 3 
Enable QC Checking Off 

Isotopes Monitored  
and Internal Standard 

Associations 
(Exact Mass) 

use 103Rh, 130Te, 193Ir as internal standards 
103Rh (102.905): 55Mn (54.93805) 
130Te(129.907): 202Hg (201.971), 80Se(79.9165) 
193Ir(192.963):208Pb(207.977), 114Cd(113.904)  

Dwell Times 100 ms for 55Mn,202Hg, 80Se, 208Pb, and 114Cd 
50 ms for 130Te,103Rh, and 193Ir 
 

Scan Mode Peak Hopping for all isotopes (1 MCA channel) 
DRC channel A Gas 

Flow Rate 
99.999% Methane (5-7 psig delivery pressure) 
typically 0.84 L/min * 
*optimized per instrument, and periodically verified 

DRC channel B Gas 
Flow Rate 

99.99% Oxygen (5-7 psig delivery pressure) 
typically 1.2 L/min * 
*optimized per instrument, and periodically verified 

RPa 0 for all isotopes 

RPq 

Typically*  
0.6 for 103Rh,55Mn,130Te, and 202Hg.  
0.65 for 130Te  and 80Se.  
0.25 for 193Ir, 208Pb, and 114Cd  
Use the same RPQ for each analyte and its IS. 
(* Optimize per instrument, and periodically verified) 

     Method Parameters:  Processing Page (see Figures 1b in Appendix B) 
Detector mode Pulse 

Process Spectral Peak N/A 
AutoLens On 

Isotope Ratio Mode Off 
Enable Short Settling 

Time 
Off 

Blank subtraction After internal standard 
Measurement units Cps 

Process Signal Profile N/A 
       Method Parameters:  Equations Page (see Figures 1c in Appendix B) 

Equations None 
     Method Parameters:  Calibration Page (see Figures 1d in Appendix B) 

Calibration Type External Std. 
Curve type Simple Linear  
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Table 1.  Instrument and Method Parameters.   

Sample units “g/L” or “ppb” 
Calibration Standard 

Concentrations (g/L) 
Mn:  1.5, 4.5, 10.5, 15, 30  
Cd, Hg: 0.5, 1.5, 3.5, 5, 10 
Pb (µg /dL): 1, 3, 7, 10, 20 
Se: 30, 90, 210, 300, 600 

     Method Parameters:  Sampling Page (see Figures 1e and 1f in Appendix B) 
“Peristaltic Pump Under 

Computer Control” 
On 

Sample Flush 6s at 1.5 rpm  
Read Delay 60s at 1.5 rpm 

Wash 40s at 1.5 rpm 
Autosampler Locations 

of Blanks and Standards 
For calibration curve (points to blood blank) 
WBMP2_DLS3016_bldblk.mth 
Blood Blank and Calibration Stds 1 – 5 in autosampler 
positions 105 - 110. 
 
For QC & patient sample analysis (points to aqueous blank) 
WBMP2_DLS3016_aqblk.mthn  
Aqueous Blank in autosampler position 112 and 113. 

 

 
Table 3. Preparation of Intermediate Stock Calibration Solution from NIST primary 
standards 
Analyte Cd Pb Hg Mn Se 
Certified value (mg/g) 10.005* 9.987# 9.954^ 10.00+ 10.11% 
Target mass to add (g) 0.0101 0.201 0.0101 0.03 0.594 
Target final weight (g) 100.00 
Expected final 
concentration (µg /g) 

1.0105 20.0739 1.0054 3.000 60.0534 

* certified value for lot # 060531 
# certified value for lot # 030721 
^ certified value for lot # 061204 
+ certified value for lot # 050429 
% certified value for lot # 992106 

Table 2. Suggested maximum analyte concentrations for base blood and Quality 
control material 

Analyte Maximum Base Blood 
Concentration (µg/L) 

Low QC Spiking 
Range ( µg /L) 

High QC Spiking 
Range ( µg /L) 

Mn < 8  6 – 10 15 - 20 
Hg <0.5 0.5 – 0.75 5 – 7 
Se <200 125 – 175 225 – 275 
Cd <0.5 0.4 – 0.5 2.5 – 3.5 

Pb ( µg /dL) <2 1 – 2 9 - 11 
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Appendix B (continued) 

 
 
 
 

 
 
 
 
 
Appendix B (continued) 
 

Table 4. Preparation of Intermediate Stock Calibration Solution from single 
element stock calibrator solutions without Pb 
Analyte Cd Se Hg Mn 
Stock concentration (mg/L) 1000 1000 1000 1000 
Spike volume (mL) 0.100 6.00 0.100 0.300 
Final Volume (mL) 100 
Final  concentration ( µg /L) 1.00 60.0 1.00 3.00 

Table 5.  Preparation of Intermediate Working Standards 
      
Standard # 1 2 3 4 5 
Volume of Flask 
(mL) 

100 100 100 100 100 

Volume Spike of Int. 
Stock Std. (mL) 

0.05 0.15 0.35 0.50 1.00 

 Concentrations ( µg /L)  
Cd+ 0.5 1.5 3.5 5 10 
Hg# 0.5 1.5 3.5 5 10 
Mn* 1.5 4.5 10.5 15 30 
Pb ( µg /dL)+ 1 3 7 10 20 
Se# 30 90 210 300 600 
+ 193Ir used as internal standard 
# 130Te used as internal standard 
*  Rh-103 used as internal standard 

Table 6.  Preparation of samples, working standards, and QC materials for 
analysis 
Total volume of prepared sample may be changed, from what is presented here.  
However, volumes for each component should be adjusted proportionally. 

Dilution ID Water (L)
Base 
Blood 
(L) 

AQ 
Intermedi

ate 
Working 
Standard 

Patient or 
QC blood 
sample 

(L) 

Diluent 
(L) 
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(L) 
AQ Blank 100 - - - 2400 * 

Blood Blank and BldBlkChk 50 50 - - 2400 * 
Working Calibration Standards  - 50 50 - 2400 * 

Patient blood or  
Blood-Based QC 

50 - - 50 2400 * 

Patient Blood 
2x Dilution H 

150 - - 50 4800  

* 2400 L diluent is best dispensed from the Digiflex™ as 2 1200-L portions (i.e.- When preparing 
a Working Calibration Standard dilution, dispense 1200 L diluent + 50 L standard in one cycle of 
Digiflex™, then 1200 L diluent + 50 L base blood in the next cycle of the Digiflex™ to prepare a 
2.5 mL total volume dilution.) 

H Extra dilution is performed on blood samples whose concentration is greater than the 
concentrations listed in Table 8 in Appendix B (linearity of the method has been documented up to 
these concentrations).  Any extra level of dilution can be prepared as long as the 4.8:5 ratio of 
diluent to total dilution volume is maintained.  Use of the lowest possible dilution level is preferred 
because matrix differences may lead to different observed concentration results as the sample 
dilution becomes greater (i.e. 2x dilution is preferred over 10x if 2x is sufficient to dilute analyte into 
the documented linearity range).  
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Appendix B (continued) 
  

  

Table 7. Preparation and Final Concentrations of Intermediate Stock 
Calibration Verification Standards. * 

Flask # 1 Flask #2 
Analytes Cd Hg Mn Analyte Pb 

Stock 
Concentration 

(mg/L) 
1000 1000 1000 

Stock Concentration 
(NIST 3128) (mg/g) 

9.987 

Spike volume 
(mL) 

1 1 3 Target Mass (g) 10 

Final volume 
(mL) 

100 100 100 Final volume (mL) 100 

Final 
concentration 

(mg/L) 
10 10 30 

Final concentration 
(mg/L) 

999 

* If standards are made gravimetrically the final concentrations will not exactly 
match these and the QC ID used in the laboratory database will need to change to 
maintain proper record keeping of analysis result to target concentration. 

Table 8. Preparation and Final Concentrations of Intermediate Working 
Calibrator Verification Standards 
Calibration Verification Standard # CV1 CV2 CV3 
Volume of Flask 100 100 100 
Volume of Cd, Hg, Mn, Intermediate Stock 
Calibration Verification Standard (mL) 

0.25 0.5 1 

Volume of Pb Intermediate Stock Calibration 
Verification Standard (mL) 

0.1 0.2 0.4 

Volume of 1000 mg/L Se Stock Calibration 
Solution 

0.05 0.1 0.2 

Final Volume (mL) 100 100 100 
    

Final Concentrations * CV1 CV2 CV3 
Cd ( µg /L) 25 50 100 
Hg ( µg /L) 25 50 100 
Mn ( µg /L) 75 150 300 
Pb ( µg /dL) 100 200 400 
Se ( µg /L) 500 1000 2000 

* If standards are made gravimetrically the final concentrations will not exactly match 
these and the QC ID used in the laboratory database will need to change to maintain 
proper record keeping of analysis result to target concentration. 
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Appendix B (continued) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 9.  Acceptable ways to perform two consecutive analytical runs, 
bracketing with bench quality control samples. 

Setup 1 Setup 2 (typical) 
Run #1 

Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 

Run #2 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 

Run #1 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 

Run #2 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
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Appendix B (continued) 
 
Table 10.  A typical SAMPLE/BATCH window. 

AS 
Location* 

Sample ID Measurements Action Method 

233 DRCstability1 Run sample …DLS3016_bldblk.mth
233 DRCstability2 Run sample …DLS3016_bldblk.mth
233 DRCstability3 Run sample …DLS3016_bldblk.mth
233 DRCstability4 Run sample …DLS3016_bldblk.mth

                          Continue DRC stability samples  . . .  
233 DRCstability9 Run sample …DLS3016_bldblk.mth
233 DRCstability10 Run sample …DLS3016_bldblk.mth
103 Aq blank Run sample …DLS3016_bldblk.mth
104 WB Blank_chk Run sample …DLS3016_bldblk.mth
111 WB Blank Run blank, standards, and sample ** …DLS3016_bldblk.mth
112 WB Blank2 Run sample …DLS3016_bldblk.mth
103 Aq blank  Run blank and sample ¥   …DLS3016_aqblk.mth 
113 L Bench QC Run sample …DLS3016_aqblk.mth 
114 H Bench QC Run sample …DLS3016_aqblk.mth 
301 Sample 1 Run sample …DLS3016_aqblk.mth 
302 Sample 2 Run sample …DLS3016_aqblk.mth 
303 Sample 3 Run sample …DLS3016_aqblk.mth 
115 L Bench QC Run sample …DLS3016_aqblk.mth 
116 H Bench QC Run sample …DLS3016_aqblk.mth 

* The exact autosampler positions of QCs and patient samples do not have to be those 
shown above, but the order in which these are run should be as shown above. 
 
**  When executing this row, the ELAN will first analyze the blood blank at AS position 105, 
then standards 1-5 at autosampler positions 106-110, then the “WB Blank” sample at A/S 
position 111.  The sampling information about AS positions 105-110 are stored in the “bldblk” 
method file.   
 
¥  When executing this row, the ELAN will first analyze the aqueous blank at AS position 
112, then the “Aq blank ” at AS position 103.  The sampling information about AS positions 
112 is stored in the “aqblk” method file.   
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Appendix B (continued) 
 
Table 11.  Boundary Concentrations for Whole Blood Concentrations (/L). 

Analyte 
1st Upper 
Boundary  
(“1UB”) * 

2nd Upper 
Boundary 
(“2UB”) ** 

Range  
Maximum 

(“Lim Rep Delta”) † 
Mn 20 35 2.0 
Pb 10.0 10.0 1.0 
Cd 5.0 5.0 1.0 
Hg 10.0 10.0 1.0 
Se 400 400 20 

* Typically, the 1st upper boundary (1UB) is the 99th percentile of non-weighted, 
corrected concentration results from the NHANES 1999-2000 subset groups.  
Concentrations observed greater than the “first upper boundary” (defined in the 
laboratory database as the “1UB”) should be confirmed by repeat analysis of a new 
sample preparation.  The concentration assigned to the 1UB for an element is 
determined by study protocol but default concentrations are listed in this table.  Report 
the original result, as long as the confirmation is within 10% of the original.    Continue 
repeat analysis until a concentration can be confirmed. 
 
** Typically the 2nd upper boundary (2UB) is set to 2x the 1UB.   At the discretion of the 
supervisor, the 1UB may vary per study according to the concerns of the study.  
Regardless of the study, report patient results confirmed to be greater than the 2UB to 
the QC reviewer as an “elevated result”.   
 
† Range maximum is the range of the three replicate readings for a single sample 
analysis.  This value is also called the “Lim RepDelta” in the database which handles 
data for the Inorganic Radiation and Analytical Toxicology Branch.  If the range of 
replicate readings is greater than the range maximum, and represents greater than a 
10% relative standard deviation for the measurement, do not use the measurement for 
reporting.   
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Appendix B (continued) 
 

 
 
  

Table 12.  Reference Ranges for Blood Concentrations. 
Analyte 
(units) 

Survey 
Years 

Geometric 
Mean 

50th 75th 90th 95th N 

Cd (g/L)* 
99-00 0.412 0.300 0.600 1.00 1.30 7970 
01-02 ** 0.300 0.400 0.900 1.30 8945 

Hg (g/L)* 
(1-5 yrs)  

99-00 0.343 0.300 0.500 1.40 2.30 705 
01-02 0.318 0.300 0.700 1.20 1.90 872 

Hg (g/L)* 
(16-49 yrs, 

female) 

99-00 1.02 0.900 2.00 4.90 7.10 1709 

01-02 0.833 0.700 1.70 3.00 4.60 1928 

Pb (g/dL)* 
99-00 1.66 1.60 2.40 3.80 4.90 7970 
01-02 1.45 1.40 2.20 3.40 4.40 8945 

Se (g/L) †   157 – 265 g/L [60] 

Mn ( µg /L)† 

Non-exposed 4 – 14 ( µg /L) [41] 
Exposed workers (adults) 3.2 – 101  µg /L [23] 
Children receiving long term parenteral nutrition 33.8 – 101  µg /L [61] 
Ohio adults (N=49) residing near a refinery (possible Mn emission): 
  Mean (range) 9.4 (4.2-21.7) µg/L [25] 
Mexican infants 
  Age 1, mean (SD) = 24.3 (4.5) µg/L, median = 23.7 µg/L, N=270 
  Age 2, mean (SD) = 21.1 (6.2) µg/L, median = 20.3 µg/L, N=430 [62] 
Japanese women (N = 1420)  
  GM 13.2 µg/L overall,  
  Range of median (max) across 8 regions 12.0-14.3 (25.0-33.4) µg/L [63]
South African children, ages 8-10 years old (n = 49) 
  Mean (SD) 8.48 (2.45) µg/L, range 4.58-18.20 µg/L. [29] 

*  From the Third National Report on Exposure to Environmental Chemicals [64] 
** Not calculated. Proportion of results below limit of detection (0.3) was too high to 
provide a valid result. 
†  Blood Se and Mn were not included in the Third National Report on Exposure to  
   Environmental Chemicals. 
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Figure 1a.  ELAN ICP-DC-MS Method Screen Shots (timing page). 
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Appendix B (continued). 
Figure 1b.  ELAN ICP-DC-MS Method Screen Shots (processing page). 
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Appendix B (continued). 
Figure 1c.  ELAN ICP-DC-MS Method Screen Shots (equation page). 
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Appendix B (continued). 
Figure 1d.  ELAN ICP-DC-MS Method Screen Shots (calibration page). 
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Appendix B (continued). 
Figure 1e.  ELAN ICP-DC-MS Method Screen Shots (sampling page, AqBlank 
method). 
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Appendix B (continued). 
Figure 1f.  ELAN ICP-DC-MS Method Screen Shots (sampling page, BldBlank 
method). 
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Appendix B (continued). 
Figure 1g.  ELAN ICP-DC-MS Method Screen Shots (report page). 
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Appendix B (continued). 
Figure 2a.  ESI SC4 Autosampler Screen Shots (Main page).  Additional flush times 
and “Max Rinse Time” are approximate.  Optimize these for best reduction of elemental 
carry-over between samples.  Tray types can be changed to allow for different volumes 
of diluted sample digests.  ‘FAST control’ must be enabled before start of method, but 
does not need to be used in instrument optimization (pre-analysis) steps.  Rinse and 
additional flush times for eliminating carry-over from one sample to the next while using 
the minimum amount of rinse solution. 
 
A rinse time of -1 causes the rinse station to be skipped. 
A rinse time of 0 causes the probe to only dip into the station, but spends no time there. 
 
Additional flush times can be optimized to keep the rinse station full while not using too 
much rinse solution.  The inner diameter size of the tubing providing the rinse solution to 
the rinse station determines how quickly the station will fill.  Various sizes are available 
for purchase or can be made in the laboratory. 
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Appendix B (continued). 
Figure 2b.  ESI SC4 Autosampler Screen Shots (“Configure” page).  “High Speed” 
option is to only be used for ‘High Speed’ models of the SC4 (look for “HS” in serial 
number).  Speeds and accel / decel values can be optimized per analyst preference and 
to minimize droplet splatter off of probe. 
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Figure 2c .  ESI SC4 Autosampler Screen Shots (“Communication” page).  
Communication ports will differ depending on available ports on instrument control 
computer. 
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Appendix B (continued). 
Figure 2d .  ESI SC4 Autosampler Screen Shots (“FAST” page).  Timer A can be 
optimized to achieve proper filling of loop with diluted sample digestate.  Timers B, C, D, 
E, and F control rinsing the loop after analysis and can be optimized for eliminating 
carry-over from one sample to the next while using the minimum amount of rinse 
solution.  File should be saved with the name “Blood Clotted 
PbCdHgSe_ITB004A_2008-March-1_SCFAST.txt”.  It can be found in the directory 
C:\Program Files\ESI\ESI-SC\. 
 
Manually clicking the “Load” button prior to starting analysis will ensure the position of 
the actuator is always the same at the beginning of the analysis. 
 
Manually clicking the “Vacuum On” button prior to starting the analysis will help initial 
sample uptake to be consistent (the vacuum pump may be slow to start for the first 
sample if this is not done, possibly resulting in loop filling inconsistencies). 
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Appendix B (continued). 
Figure 2e.  ESI SC4 Autosampler Screen Shots (5x12 Rack Setup window). 
Settings are approximate.  To be sure the loop is filled, the probe should go down close 
to the bottom of the cup, but not touch. Optimize retraction speed for least droplet 
splatter. 
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Figure 2f.  ESI SC4 Autosampler Screen Shots (50mL Tube Rack Setup window). 
Settings are approximate.  To be sure the loop is filled, the probe should go down close 
to the bottom of the cup, but not touch. Optimize retraction speed for least droplet 
splatter. 
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Appendix B (continued). 
Figure 2g.  ESI SC4 Autosampler Screen Shots (Rinse Station Rack Setup 
Window).  Settings are approximate.  Optimize down height for best probe cleaning, 
and retraction speed for least droplet splatter. 
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I. CLINICAL RELEVANCE AND TEST PRINCIPLE  

A. Clinical Relevance 

Mercury (Hg) is widespread in the environment and found in its elemental form (Hg0), inorganic forms 
such as mercurous (Hg+), and mercuric (Hg2+) and various organic forms such as methyl mercury (MeHg), 
ethyl mercury (EtHg), phenyl mercury (PhHg), and others. The health effects of mercury are diverse and 
depend on the form of mercury encountered and the severity and length of exposure. The relative order of 
increasing toxicity is: Hg0  <  Hg2+  <<  CH3Hg+ [1]. With large acute exposures to elemental mercury vapor, 
the lungs may be injured. At levels below those that can cause lung injury, low-dose or chronic inhalation may 
affect the nervous system. Symptoms include weakness, fatigue, loss of weight (with anorexia), 
gastrointestinal disturbances, salivation, tremors, and behavioral and personality changes, including 
depression and emotional instability [2]. Exposure to inorganic mercury usually occurs by ingestion. The most 
significant effect is on the kidneys, where mercury accumulates, leading to tubular necrosis. In addition, there 
may be an irritant or corrosive effect on the gastrointestinal tract involving stomatitis, ulceration, diarrhea, 
vomiting, and bleeding. Psychomotor and neuromuscular effects also may occur [3].  

Methyl mercury is more toxic than inorganic mercury. The effects of methyl mercury include changes in 
vision, sensory disturbances in the arms and legs, cognitive disturbances, dermatitis, and muscle wasting. 
The critical organ for methyl mercury is the brain. Methyl mercury readily crosses the blood-brain barrier due 
to its lipid solubility and accumulates in the brain where it is slowly converted to inorganic mercury. Whether 
CNS damage is due to methyl mercury or inorganic mercury, or both, is still controversial [4]. Ethyl mercury is 
another organic form of mercury. Very little is actually known about ethyl mercury metabolism in humans, 
including whether it has the same potency as a neurotoxin, whether the blood concentration is ever 
significant, and even whether it crosses the blood-brain barrier.  But the use of thimerosal, which metabolizes 
to ethyl mercury and thiosalicylate, as a vaccine preservative makes this subject very important. 
In the general population, total blood mercury is due mostly to the dietary intake of organic forms, particularly 
methyl mercury and ranges from 0.2 to 5.8µg/L [5].  Urinary mercury mainly comprises inorganic mercury due 
generally to dental amalgam containing elemental mercury and occupational exposure and ranges from 0.2 
to 10µg/L [5] 

The method described in this manual assesses mercury exposure, as defined by exposure to individual 
mercury species, by analyzing blood through the use of Solid Phase Micro Extraction (SPME) fiber for 
delivering sample to gas chromatography (GC) coupled to inductively coupled plasma-dynamic reaction cell-
mass spectrometry (ICP-DRC-MS). Blood is chosen as a matrix because it might contain various organic 
mercury species as well as inorganic mercury while urine contains mostly inorganic mercury. This hyphenated 
method will provide accurate quantification of three mercury blood species: inorganic mercury (Hg2+), methyl 
mercury (MeHg), and ethyl mercury (EtHg).  
 

Species Name Abbreviation Molecular Structure 

Inorganic mercury InHg Hg2+ 

Methyl mercury MeHg CH3Hg+ 

Ethyl mercury EtHg C2H5Hg+ 

 

B. Test Principle 

The quantification of InHg, MeHg, and EtHg is determined by using species-specific isotope dilution 
(SSID) method employing gas chromatography (GC) to separate the species followed by introduction into an 
ICP-DRC-MS for detection. SSID is a specialized extension of the Isotope Dilution (ID) technique. SSID 
measures individual chemical species (inorganic, methyl and ethyl mercury species) in samples using ID 
principles. The blood sample is spiked with known amounts of each Hg species that have been enriched with 
isotopic variants of the target element of interest.  
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The first step of this method involves the addition ("spiking") of enriched isotopes (199Hg2+, CH3200Hg+, 
and C2H5200Hg+) to the blood sample. Each Hg species spike is labeled with an enriched Hg isotope such that 
its isotopic pattern is unique to the species' chemical identity, i.e., the manner of isotope spiking is "species 
specific". Next, the spiked sample is digested in tetramethylammonium hydroxide (TMAH) which disassociates 
bound mercury species from proteins, polypeptides and other biomolecules. The digested blood sample with 
freed mercury species is chemically reacted ("derivatized") with a reagent* that adds 3-carbon chains (n-
propyl groups) to the mercury atom of each species molecule without compromising species identity. This 
type of chemical derivatization results in loss of ionic charge and reduced polarity; the net effect is to make 
each mercury species molecule volatile so it can escape the liquid phase and accumulate in the gas phase 
("headspace") directly above the sample. Derivatization is performed inside a partially filled vial sealed with a 
rubber septa cap that can be penetrated by a needle.  

Solid Phase Microextraction (SPME) is a sampling technique that uses a thin polymer fiber with a 
hydrophobic coating; the method described here uses a SPME fiber with a 100 µm coating of 
polydimethylsiloxane (PDMS).  The SPME assembly consists of the fiber inserted through the inside a 22 
gauge stainless steel needle. A key design feature is the fiber can be mechanically withdrawn into the needle 
during vial septum penetration and then pushed out to expose the fiber to the headspace. During headspace 
exposure (the "extraction" step), the gaseous derivatized Hg species adsorb onto the PDMS coating of the 
SPME fiber; when other factors held are constant, the adsorbed mass increases as a function of sample 
concentration. After a predetermined time, the SPME fiber is retracted into the injection needle; the needle is 
withdrawn from sample vial; it moves to the injector port of the programmable temperature gradient gas 
chromatograph (GC) and, on programmatic command, performs a programmed temperature ramp injection 
sequence. This action transfers the propylated inorganic, methyl and ethyl Hg species to the head of a 30 m 
capillary GC column which, using He as the carrier gas, ramps the column temperature to 280 °C. The order 
of chromatographic separation of the Hg species is based on increasing molecular weight: 
methylpropylmercury (derivatized methyl Hg), ethylpropylmercury (derivatized ethyl Hg), last peak is 
dipropylmercury (derivatized inorganic Hg). Hg species exiting the GC column are seen as chromatographic 
peaks detected using an inductively-couple argon plasma (ICP) as the ion source and a quadrupole mass 
spectrometer (Q-MS) for mass specific quantification. Species identification is based on chromatographic 
retention time; species specific isotope ratios are calculated from integrated peak areas derived from m/z 
signals corresponding to 199Hg, 200Hg, 201Hg and 202Hg isotopes. The ICP-MS is equipped with a Dynamic 
Reaction Cell (DRC(tm)) for minimizing polyatomic interferences. Operating the ICP-MS in DRC mode has an 
added benefit of enhancing Hg signal strength through an effect known as "collisional focusing" [6,7].  

II. SAFETY PRECAUTIONS 

Important 

Precautionary information that is important to protecting personnel and safeguarding equipment will be 
presented inside a box, like this one, throughout the procedure where appropriate.  

Follow universal precautions when handling blood samples. Wear gloves, a lab coat, and safety glasses 
while handling human blood, plasma, serum, urine, or other bodily fluid or tissue. Place disposable plastic, 
glass, and paper (e.g., pipette tips, autosampler tubes, and gloves) that come in contact with human 
biological fluids, such as blood, in a biohazard autoclave bag. Keep these bags in appropriate containers until 
they are sealed and autoclaved. When work is finished, wipe down all work surfaces where human biological 
fluid was handled with a 10% (v/v) sodium hypochlorite solution (or equivalent). Dispose of all biological 
samples and diluted specimens in a biohazard autoclave bag at the end of the analysis according to 
CDC/DLS guidelines for disposal of hazardous waste. 

PerkinElmer provides safety information that should be read before operating the instrument.  This 
information is found in the PerkinElmer ELAN® 6100 ICP-DRC-MS System Safety Manual.  Possible hazards 
include ultraviolet radiation, high voltages, radio-frequency radiation, and high temperatures. 
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Caution! 

Exercise caution when handling and dispensing concentrated nitric and hydrochloric acid.  Always 
remember to add acid to water.  Nitric and hydrochloric acid are caustic chemicals that are capable of 
severe eye and skin damage.  Wear powder-free gloves, a lab coat, and safety glasses.  If nitric or 
hydrochloric acid comes in contact with any part of the body, quickly wash the exposed area with copious 
quantities of water for at least 15 minutes. 

III. DATA SYSTEM MANAGEMENT 

To maintain the integrity of specimen and analytical data generated by this method, eliminate hand entry 
of specimen identifiers or analytical results whenever possible, proofread all transcribed data, and regularly 
defragment and back up the ICP-MS computer's hard drive. 

A. Data Entry and Transfer 

Whenever possible, use bar code scanners to enter sample identifiers into the GC-ICP-DRC-MS computer 
software to avoid errors associated with the keyboard-entry process and to speed up sample processing.  
When bar code scanners cannot be used, proofread transcribed data after entry.  Handle or transfer data 
electronically when reporting or moving data to other computerized data-handling software.  In the Inorganic 
and Radiation Analytical Toxicology Branch sample analysis results generated by this method are stored for 
long periods in Microsoft Access™ or MS SQL Server (Frontends) database software.  The results should 
include at least the analysis date, analytical run number, quality-control (QC) results for the run, results of 
specimen analysis by specimen identification (ID), and method identifier. 

B. Routine Computer Hard Drive Maintenance 

Defragment the computer hard drive regularly by using software such as Microsoft Windows® Disk 
Defragmenter (located in Start > Programs > Accessories > System Tools) or an equivalent defragmentation 
program to maximize computer performance and maintain data integrity for files on the hard drive.  An entry 
will automatically be made in the Windows™ system event log when this process is done and will provide 
documentation of this step. 

C. Electronic Data Backup 

1. Schedule of Data Backups 

 Weekly:  Full data backups onto one or more recordable compact discs (CD-R) or digital 
video discs (DVD).  

 Daily:  Full data backups onto an secondary hard drive.  

2. Backup Procedures 

 Whenever making a backup (daily or weekly) include the directories and subdirectories : 

 C:\elandata (include all subdirectories) 

 C:\gc (must include subdirectories "data" and "methods", also include other relevant 
directories) 

 Before making weekly backups, saving a copy of the Windows™ event log in the active 
"elandata" directory will ensure archiving of all recent software system events (including 
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communications between ICP-DRC-MS and ELAN software, as well as times of hard drive 
defragmentation, and other Windows™ system events). 

b) Secondary Hard Disk Backups 

 If available, use the computer’s secondary hard disk to store backup files. 

 Configure Microsoft Windows® Backup™ (Start > Programs > Accessories > System 
Tools) program to do a daily backup of the computer's data directories (see Backup 
Procedures) 

c) Compact Disc (CD) Backups 

 Use the CD writing program installed on the computer to create CD backups (e.g., "Easy 
CD Creator"™ by Adaptec, or equivalent software). Select the option that “closes” the CD 
at the end of the writing session so the CD cannot be accidentally over-written.  

 Use CD-R disks only (recordable compact disks), not CD-RW disks (rewritable compact 
disks). 

d) Backup of Sensitive Data 

 Make a backup for sensitive data on duplicate, recordable compact disk. Store the two 
CD-R disks in two different buildings. 

D. Documentation of System Maintenance  

1. Computer Maintenance: Record any maintenance of computer hardware, GC or ICP-DRC-MS 
software in the instrument logbook.  Place other electronic records relating to integrity of the data 
and hard drive in the Windows™ event log.  Back up the event log on a regular basis by saving a copy 
in the active "elandata" directory.  The event log will then be backed up along with the ELAN data 
when backup CD-R disks and tapes are made. 

2. Instrument Maintenance: Document system maintenance in hard copies of data records (i.e., daily 
maintenance checklists, PerkinElmer service records, and instrument log book) as well as in 
electronic records relating to instrument optimization (default.dac) and tuning (default.tun).  

IV. COLLECTING, STORING, AND HANDLING SPECIMENS; CRITERIA FOR 
REJECTING SPECIMENS 

A. Specimen Type 

Specimen type is whole blood. No special instructions for fasting or special diets are required of patient or 
study subjects.  

B. Specimen Collection, Handling and Storage 

1) The preferred volume of blood specimen is ≥0.5 mL; the minimum volume is 0.25 mL.   

2) Acceptable containers for specimen acquisition include pre-screened polyethylene vials and 
pre-screened blood collection tubes.  

3) Samples should be stored in the dark at –20°C or lower temperature. Long term storage at 
–70°C or less is preferred.  

4) Specimen handling conditions are outlined in the Division protocol for blood collection and 
handling (copies available in Branch, laboratory and Special Activities specimen handling 
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offices).  Collection, transport, and special requirements are discussed.  If more than one 
blood collection tube is used to draw blood from a subject, the blood tube for trace metals 
tube should be drawn last. Draw the blood through a stainless steel needle into a pre-
screened blood collection tube. Blood specimens should be transported and stored at ≤ 
4°C. Once received, they can be frozen at ≤ –20°C until time for analysis.  Portions of the 
sample that remain after analytical aliquots are withdrawn can be refrozen at ≤ –20°C. 
Thawing and refreezing of samples before analysis is discouraged.  

C. Criteria for an Unacceptable Specimen 

 The criteria for an unacceptable specimen are either a low volume (< 0.25 mL) or suspected 
contamination due to improper collection procedures or collection devices.  Specimen contact with dust 
or dirt may compromise test results. In all cases, request a second blood specimen.   

V. PROCEDURES FOR MICROSCOPIC EXAMINATIONS 

Not applicable for this procedure. 

VI. CHEMICALS, STANDARDS, AND QUALITY CONTROL MATERIAL 

A. Chemicals  

1) Deionized (DI) water, ≥18 MΩ cm resistivity.  

2) Sodium acetate anhydrous, (CAS# 127-09-3), (C2H3NaO2--MW 82.04), (Sigma-Aldrich, 
Milwaukee, WI) or equivalent vendor.  

3) Glacial acetic acid, (CAS# 64-19-7), (CH3COOH--MW 60.05), reagent ACS grade (GFS 
Chemicals, Powell, OH) or equivalent vendor. 

4) Double-distilled Hydrochloric Acid, (CAS# 7647-01-0), (HCl-MW 36.461--37.0%--12.1M) (GFS 
Chemicals Inc., Columbus, OH) or equivalent vendor. 

5) Double-distilled Nitric Acid (CAS# 7697-37-2), (HNO3-MW 63.013-70.0%--15.8M) (GFS 
Chemicals Inc., Columbus, OH) or equivalent vendor 

6) Tetramethylammonium hydroxide, 25% w/w in methanol (CAS# 75-59-2), (C4H13NO-MW 
91.15), (Alfa Aesar, Ward Hill, MA) or equivalent vendor. 

7) Sodium tetra(n-propyl)borate, (CAS# 45067-99-0), (NaPr4B -MW 206.16), (ABCR, Germany) 
or equivalent vendor. 

8) Bleach (10% sodium hypochlorite solution) from any vendor. 

9) Base whole blood, donated or purchased.  

10) Inorganic mercury, 1000 mg/L  in 10% nitric acid (SPEX, CertiPrep) or equivalent.  

11) Methyl mercury chloride, standard solution 1000 mg/L (AlfaAesar) or equivalent.   

12) Ethyl mercury chloride, powder (AlfaAesar) or equivalent  
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B. Isotope Dilution Standards 

1) 199Hg-Isotopically-Enriched Inorganic Mercury (199HgCl2), (Applied Isotope Technologies, Inc. - 
Sunnyvale, CA) P/N 30530 or equivalent. 

2) 200Hg-Isotopically-Enriched Methylmercury (CH3200HgCl), (Applied Isotope Technologies, Inc. - 
Sunnyvale, CA) P/N 30521 or equivalent. 

3) 201Hg-Isotopically-Enriched Ethylmercury (CH3CH2HgCl), (Applied Isotope Technologies, Inc. - 
Sunnyvale, CA) P/N 35025 or equivalent. 

C. Quality Control Material 

Quality control (QC) materials are made from pools of whole blood obtained from a donor source or 
purchased from the vendor. See the Preparation of Quality Control Material section for details of preparation. 
The control "base" blood and two QC blood pools intended for the mercury speciation assay are designated 
as:  
 

QC level QC Designation ID 

Base pool BB-yy### 

Low pool LB-yy### 

High pool HB-yy### 

 
Where substitutions are: yy = the last two digits of production year and ### = assigned pool identification 

number. QC material intended for bench quality control purposes needs to be "characterized" as described in 
the section Establish QC limits for each QC pool. 

VII. INSTRUMENTATION, EQUIPMENT, SOFTWARE AND SUPPLIES 

A. Instrumentation 

1. Gas Chromatography System 

1) Gas Chromatograph: Perkin Elmer® Clarus 500, or equivalent system.  

2) GC capillary column: Perkin Elmer® Elite-5 30m (meter), 0.25mmID, 0.25µm df (Catalog # 
N9316076, Shelton, CT), or equivalent. 

3) GC Transfer Line, noncoated capillary column: Perkin Elmer® Fused Silica Tubing 5m, 
0.25mmID (Catalog # N9301356, S/N 920620, Shelton, CT) ), or equivalent. 

4) GC-ICP-MS Heated Transfer Line accessory: Redshift® (P/N N0777440 for 115V or P/N 
N40777361 for 230V, Italy), or equivalent. 

5) Solid Phase Micro Extraction (SPME) Fiber Assembly, specifically, Supelco Analytical 100µm 
Polydimethylsiloxane (PDMS) Coating (Red - Pack of 3), (Catalog # 57301, Supelco 
Analytical, Bellefonte, PA), or equivalent. 

2. ICP-DRC-MS System 

1) Inductively-coupled plasma mass spectrometer, specifically, the ELAN™ DRCII (PerkinElmer 
Instruments, Shelton CT), or equivalent.  

2) Platinum (Pt) cones (Catalogue # SC2013-Pt and SC2014-Pt Perkin Elmer Instruments, 
Shelton, CT) or equivalent.  
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3) Perkin Elmer ICP-MS injector (Perkin Elmer Instruments, Shelton, CT), or equivalent.  

3. Robotic Sample Processing Station 

1) Robotic Liquid Sample Processing Workstation: LEAP® Technologies CombiPal® twin head 
system, or equivalent system (Figure 1).   

 

 

Figure 1: Twin Head SPME Processing Workstation (LEAP Technologies, Inc.) 

The Twin Head SPME CombiPAL (LEAP Technology, Inc.) sample processing workstation, mounted on 
top of the GC, has a unique design: features two (2) computer-controlled SPME fiber injection heads 
that run on a dual rail system. The two SPME Heads are independently-controlled and perform SPME 
fiber equilibration/injection operations in tandem. This configuration allows for increased SPME fiber 
equilibration time up to 20 minutes per SPME head while maintaining a sample-to-sample injection cycle 
time of 10 minutes. The result is improved SPME efficiency and faster duty rates (6 injections per hour). 

4. Equipment  

1) Water purification system for providing ultrapure water with a resistivity ≥18 MΩ cm.  

2) High-precision analytical balance capable of accurately weighing milligram amounts of 
material to the tenth of a milligram or better.  

3) A pH meter with one hundredth's of a pH unit readout or better, fitted with glass electrode 
(pH probe). Temperature compensation probe for pH meter.  
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4) Calibrated hand-held adjustable pipettors that cover the range of accurate liquid delivery 
from 5 µL to 5000 µL. Research Pro™ Eppendorf® electronic programmable pipettors 
(distributed by Brinkmann Instruments, Westbury NY) or equivalent.  

5) Gas regulators for argon, helium and xenon (Airgas, Atlanta, GA) or equivalent. 

6) Conventional oven (FREAS Model 605, Thermo scientific, Catalog No. 3166188), or 
equivalent.  

7) Plastic tent (Captair Pyramid, Erlab, North Andover, MA) or equivalent for preparation of 
sodium tetra(n-propyl)borate solution. 

5. Computer Software 

1) The ELAN Instrument Control version 3.4 with Service Pack 2 (or later version) should be 
installed on the computer controlling the ELAN DRC II™.  

2) Chromatography data handling software, specifically, TotalChrom™ Workstation, version 
6.3.1 or later (PerkinElmer® Instruments, Shelton CT). Install PerkinElmer's TotalChrom 
Workstation package on the same computer containing the ELAN Instrument Control 
software*.  Contact PerkinElmer for installation and configuration of TotalChrom. Or consult 
theTotalChrom Workstation User's Guide. This method assumes that version 6.3.1 of 
TotalChrom Workstation package is installed.  

3) Operating software for CombiPal autosampler, specifically, Chronos (2007-2010  Axel 
Semrau GmbH & Co KG)  

4) ChromLink™ 2.1 software (PerkinElmer Instruments). The installation of ChromLink™ is 
straightforward when using the supplied installation utility. 

5) pdFactory Pro (FinePrint Software, LLC, www.fineprint.com) or equivalent software. This 
product is used for creating electronic Portable Document Files (pdf) directly from any 
Windows® compatible application print dialog box.  

6) A custom Microsoft Excel® macro procedure named "Extract TC Data".  See Appendix B for 
description and macro code.  

6. Supplies 

1) 200 µL pipette tips, 960 tips per case (Eppendorf® catalogue # 2235137-1, distributed by 
Brinkmann Instruments, Westbury NY), or equivalent.  

2) 300 µL pipette tips, 960 tips per case (Eppendorf® catalogue # 2235144-3, distributed by 
Brinkmann Instruments, Westbury NY), or equivalent. 

3) 1000 µL pipette tips, 960 tips per case (Eppendorf® catalogue # 2249044-3, distributed by 
Brinkmann Instruments, Westbury NY), or equivalent. 

4) 5 mL pipette tips, 500 tips per case (Eppendorf® catalogue # 2235081-1, distributed by 
Brinkmann Instruments, Westbury NY), or equivalent. 

5) 50-mL acid-cleaned volumetric flasks for triple spiked solution preparation (polypropylene or 
Teflon flasks preferred).  To acid-wash flasks, rinse with 1.2M hydrochloric acid followed by 
rigorous rinsing with DI water.  Repeat this process several times depending on prior use of 
the containers. 

6) 250-mL acid-cleaned volumetric flasks for derivitaizing reagent (NaPr4B) preparation 
(polypropylene or Teflon flasks preferred).  To acid-wash flasks, rinse with 1.2M hydrochloric 
acid followed by rigorous rinsing with DI water.  Repeat this process several times depending 
on prior use of the containers. 
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7) Acid-cleaned 1L PE bottles for buffer solution preparation. To acid-wash flasks, rinse with 
1.2M hydrochloric acid followed by rigorous rinsing with DI water.  Repeat this process 
several times depending on prior use of the containers. 

8) 50 mL polypropylene tubes pre-screened for Hg (Becton Dickinson) or equivalent. 

9) 15 mL polypropylene tubes pre-screened for Hg (Becton Dickinson) or equivalent. 

10) 1.5 mL polypropylene (PP) microcentrifuge tubes (Eppendorf® catalogue # 2236380-8, 
distributed by Brinkmann Instruments, Westbury NY), or equivalent.  

11) Tube racks for 1.5 mL microcentrifuge tubes (Eppendorf® catalogue # 2236422-7, 
distributed by Brinkmann Instruments, Westbury NY), or equivalent.  

12) Six or more PAL Tray20mL (part# 65487454, CTC Analytics, PAL system accesories) 

13) CombiPal autosampler vials 20 mL, glass,  (Microliter Analytical Supplies, Inc. product #16-
2000) or equivalent. 

14) Head space caps for 20mL glass vials (Microliter Analytical Supplies, Inc. product #16-
0050M) or equivalent 

15) Kay-Dry™ paper towels and Kim-Wipe™ tissues (Kimberly-Clark Corp., Roswell GA, or 
equivalent vendor). 

16) Teflon™-coated magnetic stirs bars (4).  (Catalog Number 58948-974 or equivalent), VWR 
Scientific Products, Buffalo Grove, IL. 

17) Teflon™-coated magnetic stirs bars.  (Catalog Number 58947-140 or equivalent, VWR 
Scientific Products, Buffalo Grove, IL). 

18) Cotton swabs (Hardwood Products Co. ME, or equivalent vendor). 

19) Nitrile, powder-free examination gloves (N-Dex®, Best Manufacturing Co., Menlo, GA, or 
equivalent vendor). 

20) Biohazard autoclave bags (Curtin-Matheson Scientific, Inc., Florence, KY, or equivalent 
vendor). 

VIII. STANDARD PROCEDURE 

A. Preparation of Stock Solutions 

a) NaOAc Buffer Solution (0.1 M sodium acetate anhydrous) 

1) Dissolve 16.41g Sodium acetate anhydrous into approximately 1900 mL of DI water in a 
2000 mL polypropylene vessel with a magnetic stir bar on a magnetic stir plate, and mix 
thoroughly.   

2) Measure pH and adjust pH to 4.75 with glacial acetic acid. Make final volume adjustment to 
2000mL with DI water. 

b) Sodium tetra(n-propyl)borate (NaPr4B, 2% w/v) 

1) Place one unopened vial containing 5.00 g of sodium tetra(n-propyl)borate, a squirt bottle of 
DI water, and a clean 50 mL conical centrifuge tube inside a glove box or tent. Fully purge 
glove box or tent with 100% nitrogen for 5 minutes to remove oxygen.  

2) Open the vial containing sodium tetra(n-propyl)borate and add 10-20 mL of DI water with 
constant swirling.  
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3) Pour the dissolved contents into the clean 50 mL conical centrifuge tube. Wash the reagent 
vial with additional DI water to dissolve remaining solids and quantitatively transfer 
remaining reagent to the 50 mL tube. Cap the 50mL tube and remove from tent. Once 
dissolved, the NaPr4B solution may now be safely used in normal atmosphere.  

4) Inside a chemical fume hood, quantitatively transfer reagent solution containing 5.00 g of 
NaPr4B to a 250 mL volumetric flask.  Dilute to the final volume with DI water. Makes a 2% 
(w/v) NaPr4B solution. Store at 4°C.  

B. Preparation of Working Spike Solution 

Caution! 

Mercury compounds are toxic!  Take extra care to avoid accidental dermal contact, ingestion or inhalation 
of these materials.  Wear appropriate personal protective equipment.  Above all, wear a laboratory coat and 
latex or nitrile gloves.  Clean up any spill that might occur according to applicable hazardous material spill 
procedures.   

 Exercise the utmost care in executing all measurements precisely to obtain the best accuracy for the 
final concentrations. Use only pipettes, disposable tips and volumetric flasks that have been tested for 
accuracy and will deliver liquid volumes with a precision of ±1% or better.  

1. Preparation of Working Triple-Spiked Standards Solution 

 On the day samples will be digested, prepare fresh working spike solution. Take out of the 4°C 
refrigerator bottles of vendor-supplied standard solutions of the following: In199Hg, Me200Hg , and 
Et201Hg. Allow bottles to come to room temperature.  The following intermediate and working 
solutions should be prepared by weighing, thus the final concentrations of “spike” material in 
working solution should be determined by weight. 

a) Intermediate standard solution 

1) Pipette 50 µL of In199Hg and Me200Hg standards into separately labeled 1.5 mL centrifuge 
tubes. Add 1200 µL of DI water to each and mix thoroughly.  

2) Pipette 50 µL of Et201Hg standards into a third 1.5 mL centrifuge tube. Add 150 µL of DI 
water to each and mix thoroughly. 

b) Working solution (containing mixture of 3 isotope standards):  

1) Fill the 50 mL volumetric flask approximately half full with DI water.  

2) Pipette 100 µL of each intermediate standard solution (In199Hg, Me200Hg, and Et201Hg) into 
the flask. Complete the volume to the 50 mL mark with DI water.   

3) The concentration of each isotope standard should be within a range of 0.7–1.3 µg Hg/L. 
Note that units of concentration are expressed in terms of elemental Hg (not molecular 
mass). Calculate the exact concentration of each isotope standard contained in the Working 
Triple-Spike Standard Solution by dividing the starting concentrations (indicated by the 
isotope standard’s certificate of analysis) by the dilution factors shown in Table 8-1 (dilution 
factors may be adjusted to produce isotope standard concentrations in the range of 0.7–1.3 
µg Hg/L) . Make appropriate adjustments to the calculations if volumes are deviate from the 
prescribed amounts.  
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TABLE 8-1: Dilutions Factors for Preparing Working Triple-Spike Standards 

Mercury Species Calculation (units = mL) Dilution Factor 

In199Hg 1.2 ÷ 0.05 × 50 ÷ 0.1 = 12000 

Me200Hg 1.2 ÷ 0.05 × 50 ÷ 0.1 = 12000 

Et201Hg 0.15 ÷ 0.05 × 50 ÷ 0.1 = 1500 

C. Preparation of Quality Control Material 

 Order bovine blood from a proper vendor and characterize for total Hg (use DLS Method ITB001A 3001 
"Whole Blood Hg/Pb/Cd" or an equivalent method).   

1. Base pool preparation:  Bovine blood with the lowest mercury content should be used.  Distribute 
base blood into pre-labeled 2 ml vials by 1.5 ml aliquots. 

2. Low and High pool preparation:  Analyze base blood for InHg, MeHg, and EtHg species.  On the basis 
of this calculation, spike add with each specie to the desiredappropriate volumes of InHg, MeHg, and 
EtHg (not enriched) species values to obtain "low" and "high" pools. While maintaining constant 
stirring of each pool, aliquot 0.5 mL of blood into a sufficient number of pre-labeled 2 mL vials to 
provide QC material for 1000 or more runs. Store aliquoted QC material at a temperature of –70°C 
or colder.  

D. Sample preparation 

Caution! 

Work with open vials containing biological samples inside of a biological safety cabinet (BSC). Recap vials 
before removing them from BSC. Wear appropriate personal protective equipment (lab coat, safety glasses 
and gloves). 

Preparation of blood samples for digestion:  

1) Pipette 100 µL of blood samples into pre-labeled 1.5 mL tubes.  

2) Add 100 µL of Triple Spiked Standards Solution. Recap and vortex each tube before 
continuing to the next tube.  

3) Add 500 µL of TMAH to all tubes. Cap and vortex.  

2. Digestion:  

1) Place rack containing capped tubes in an incubator or oven set to 80 ± 3°C  for ≥ 20 hours.  

3. Derivatization of the digested samples:  

1) Aliquot 200 µL of digested samples into pre-labeled 20 mL SPME vials containing a “mini” 
stir bar in each vial.  

2) Add 7.7 mL of NaOAc Buffer Solution and 250 µL of NaPr4B Derivatization Reagent. Cap the 
vial immediately and mix.  

E. Requirements for Batch Analysis of Samples and QC Material 

Process a predetermined set of samples and QC material for batch analysis. One “batch” run is defined 
as the analysis of a contiguous set of samples (typically 20, may be more) bracketed by “Bench QC” material 
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at the beginning and end of the set. Each Bench QC level (typically, a “high” and a “low”) should be analyzed 
at the beginning and again at the end of the batch run. QC needs to be treated like the unknown samples, 
i.e., each QC sample is individually prepared and goes through all the steps as is done for unknown samples. 
It is not appropriate to report the QC results coming from the split analysis of a single QC sample if it has 
already been processed (i.e., diluted, centrifuged, filtered, digested, derivatized, etc.). Note that this limitation 
does not apply to the duplicate use QC material originating from the same original vial as long as they both 
are processed identically like unknown samples and on the same day. It is permissible to "piggyback" two 
runs in succession that are separated by at least two blanks during a single autosampler load (such as for an 
overnight analysis), as long as each run of samples is bracketed by their own uniquely co-prepared bench QC 
material. 

1) Identify, gather, and thaw a predetermined number of sample tubes/vials containing the 
blood samples to be analyzed in a batch run.  

2) For each batch of samples run, thaw one tube of low and high bench QC  (often identified as 
"LB-yyxxx" and "HB-yyxxx"; for explanation of nomenclature, see Quality Control Material 
section).   

3) Label the necessary number of 1.5 mL microcentrifuge vials with appropriate identification 
to ensure that they will be matched to their corresponding unknown samples and QC. 
Similarly, label an equal number of 20 mL SPME vials.  

4) Use the TMAH digestion procedure for blood samples and QC material. 

5) Use the preparation of digested samples for analysis procedure to prepare samples and QC 
material. 

6) Cap all autosampler vials with the proper fitting septum caps. 
 

The use of a barcode scanning device to electronically record sample identification from barcodes 
printed on vial labels should be utilized if available.  

F. GC Instrument Program  

1) Set the GC analytical run parameters according to Table 8-2. Refer to the Clarus 500 User 
Guide for programming specifics.  

2) One or more parameters specified in Table 8-2 may be changed, if determined necessary, to 
meet analytical performance goals.  
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TABLE 8-2: GC Settings 

Parameter Setting 

GC injector Temperature Step #1: 1 min @ 220°C  
Step #2: linear ramp to 280°C, hold 

Carrier gas flow rate (Helium) 2 mL/min 

Oven Temperature Step #1: 1 min @ 75°C 
Step #2: linear ramp to 250°C  (at 
rate = 45 °C/min) 

Total flow ratio 28:1 @ 0.25 min 

Transfer line Temperature (Aux - 
auxiliary zone) 

250°C 

(Aux - auxiliary pneumatics) OFF (all) 

G. CombiPal Autosampler Program 

1) CombiPal is initially set up and optimized by LEAP technology service engineers. The settings 
can be optimized according to analyst needs (refer to PAL system user manual). The 
following procedures present the key steps that are taken to set up the CombiPal 
autosampler system for this method.  

(a) Using PAL control terminal start at a window displaying "JOB QUEUE". Press the 
ESCape key to return to the previous menu. Press function key F1 - "MENU". Rotate 
the outer knob to scroll through items in a menu list. To select a highlighted item 
press the central knob (ENTER button). Then use the outer knob to scroll through 
available options for that item or to change a numeric value. Then press the inner 
knob again to ENTER the displayed option.  

(b) In the "MENU" window select "Utilities" followed by "Tray" then select "Agitator" and 
enter parameters in Table 8-3. Then press "ESC" to get back to "Tray" option scroll 
to the right select "Tray" (this "tray" is an option for first "Tray" selection) - enter 
parameters  

(c) In the "Utilities" window select "Injector" and select "GCInj1" - enter parameters. Also 
in the "Utilities" window select "Vial" and select "Standard" - enter parameters in 
Table 8-3. 
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TABLE 8-3: CombiPAL Autosampler Settings 

Parameter Setting 

Tray (Agitator)  

Needle Penetration 20.0 mm 

Tray type SMMTray 

Offset X, Y, Z 0, 0, 55.5 mm 

Stand by Temp OFF 

Actual Temp 25.7°C (changes) 

Speed 750 RPM 

Agitation Time ON 5s 

Agitation Time OFF 2s 

Tray (Tray)  

Needle Penetration 12.0 mm 

Tray type VT32-20 

Offset X, Y, Z -55.3, -188.1, -2.0 mm 

Injector (GCInj)  

Needle Penetration 35.0 mm 

Vial (Standard)  

Needle Penetration 43.0 mm 

 

2) CombiPal is operated by Chronos software. Click on Chronos icon on the operating computer 
desktop - Chronos method files used for this method can be accessed through clicking on 
"Method Editor" on the Main Menu of Chronos. In the right corner click on tab "Load", which 
allows to upload needed method file. There are five method files used in this method: SPME 
bakeout LEFT.cam, SPME bakeout RIGHT.cam, SPME conditioning LEFT.cam, SPME 
conditioning RIGHT.cam, TWIN SPME_cdc.cam. (The settings can be changed by the analyst 
for better separation and analytical response.) 

(a) To clean SPME fibers every day before starting a run - SPME bakeout LEFT.cam and 
SPME bakeout RIGHT.cam are used.  The settings should be as shown in Table 8-4.  

TABLE 8-4: Chronos Settings (Baking) 

Parameter Setting 

Bakeout Time (s) 420  

GC Runtime + Cooling Down (s)  120  

Needle Penetration Vial (mm) 34  

Fiber Exposure (mm) 12  

Needle Penetration (mm) 35  

 

(b) To condition new SPME fibers use - SPME conditioning LEFT.cam and SPME 
conditioning RIGHT.cam.  The settings should be as shown in Table 8-5.  



Blood mercury species SSID-GC-ICP-DRC-MS IRAT-DLS 

DLS Method Code: 3020 Page 21 of 51 

 

 

TABLE 8-5: Chronos Settings (Conditioning) 

Parameter Setting 

Bakeout Time (s) 1800 

GC Runtime + Cooling Down (s) 120 

Needle Penetration Vial (mm) 34  

Fiber Exposure (mm) 12 

Needle Penetration(mm) 35 

 

(c) To perform a run, the file “TWIN SPME_cdc.cam” is used. The settings should be as 
shown in Table 8-6. 

TABLE 8-6: Chronos Parameter Settings (for Run) 

Parameter Setting 

Source Tray Tray1,1 

Time 1 s 

Enrichment Time 1200 s 

Desorption Time 420 s 

GC Cooling Down 180 s 

Needle Penetration Vial 34 mm 

Fiber Exposure 12 mm 

Needle Penetration Inlet 35 mm 

 

H. ICP-DRC-MS Instrument Setup 

To improve workflow efficiency, do the programming steps described in this section before the day of 
analysis.  

1. Programming the DRC Gas Flow Delay Parameter 

 A special ELAN DRC™ setting, called "Flow Delay", needs to be changed from its default setting to 
avoid the problem of the ELAN software forcing a time delay of several seconds before collecting 
data at the start of a chromatographic run when in DRC mode. This setting can only be changed by 
entering the ELAN software's Service Mode. This change only needs to be done once per software 
installation or upgrade, or if the setting was deliberately changed by a field service engineer. It is a 
good idea to inform the service engineer who intends to perform work on the instrument of the 
importance of returning the "Flow Delay" to the non-default value of 1.  

Important! 

While in Service Mode, DO NOT make changes to any setting except for the one change described below.  

1) From within the ELAN program and in the window entitled "Instrument Control Session", 
choose menu item "Options" > "Service Mode."  You will be prompted to enter a Service 
Mode password. Enter the password "Elan6000" (omit the quotes and pay attention to 
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capitalization) and click OK. If this password is not accepted, you will have to contact a 
supervisor or a PerkinElmer service technician.  

2) You will be presented with a new tab called "Service" within the Instrument window.  
Maximize the window. At the bottom will be a row of tabs, click on "Gas".  Look for the 
parameter called "Flow Delay (Gas changes while in DRC Mode)".  If its setting is a value 
other than "1", click on the "Set Pauses..." button.  Change the value in the field named 
"Flow Change" to 1.  Click the "Apply" button then click the "Close" button.  Choose menu 
item "Options" > "Exit Service Mode."  

2. Programming the ELAN ".mth" file 

1) If it is not already open, launch the ELAN program and in the window entitled "Instrument 
Control Session", choose menu item "File" > "Review Files". Click the "Load" button for 
"Method", the first item on the list. Navigate to the folder "C:\elandata\Method" and click on 
"GC_Hg.mth" file then click the "Open" button. 

2) If the "GC_Hg" file cannot be found, or it has been changed or corrupted in a manner that 
makes its use questionable, then cancel the open file dialog box and close the Review Files 
window by clicking the "Done" button. Do the following steps; otherwise, proceed to step 3: 

(a) Make the active method file the active window (do this by clicking on the tool bar 
icon that looks like a notepad with a "Cu" on it). Then click "File" > "New" on the 
menu bar and then choose "Data Only" in the New Method window that appears. 
Click "OK" then maximize the window. Complete this window with the information in 
the Table 8-7.  

TABLE 8-7 ELAN Timing Parameters 

Parameter Setting 

Sweeps/Reading: 1 

Readings/Replicate: 2725 

Number of Replicates: 1 

Tuning File: C:\elandata\Tuning\default.tun 

Optimization File: C:\elandata\Optimization\gc_xe_drc.dac 

 

(b) On the first line of the worksheet-like table, click in the cell of row 1 of the "Analyte 
(*)" column. Type "Hg" then press "Enter" key. The row will suddenly be filled-in with 
mercury's "Begin Mass (amu)" of 201.971 (or something close) and several default 
parameters.  Right click on "Hg" and a periodic table will appear. Select five Hg 
isotopes from mass ~197.9670 to ~201.9710 and click "OK".  All five isotopes 
should be seen in the "Analyte (*)" column. Tab to next cells and fill in the 
information shown in Table 8-8.  
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TABLE 8-8: ELAN Analyte Parameters 

Parameter Setting 

Analyte: Hg 

Begin Mass (amu): 197.9670* (first row, then proceed to the 4 other 
isotopes) 

End Mass: <leave empty> 

Scan Mode: Peak Hopping 

MCA Channels: 1 

Dwell Time: 25 

Integration Time: 68125 (automatically determined by software) 

*Actual mass may differ by a few hundredth of amu. 

(c) Click on the "Processing" tab and enter the following information: 

TABLE 8-9: ELAN Processing Parameters 

Parameter Setting 

Detector: Dual 

Measurement Unit: Cps 

Process Spectral Peak: Average 

Process Signal Profile: Average 

Apply Smoothing: Checked 

Factor: 5 

Auto Lens: Off 

Isotope Ratio Mode: Off 

 

(d) Skip the "Equation" tab. Click on "Sampling" tab and enter the following information:  

TABLE 8-10: ELAN Sampling Parameters 

Parameter Setting 

Peristaltic Pump Under Computer Control: Unchecked 

Sampling: External 

 

(e)  (e) Click on the "Report" tab and enter the information in Table 8-11.  
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TABLE 8-11: ELAN Report Parameters 

Parameter Setting 

Report View | Send to 
Printer: 

Unchecked 

Report Options 
Template: 

<leave empty> * 

Automatically Generate 
NetCDF File: 

Checked 
C:\elandata\reportoutput\ 

Report to File | Send to 
File: 

Unchecked 

Report Options 
Template: 

<leave empty> * 

Report File Name: <leave empty> * 

Report Format: <leave empty> * 

File Write Option <leave empty> * 

  

*Content of these fields is not important since Send To Printer/File is unchecked. 
 

 

(f) Choose menu item "File" > "Save As" and navigate to "C:\elandata\Methods\" 
folder. Enter "GC_Hg" as the name of the method file and click the "Save" button.  

3) The ELAN method "GC_Hg" is now loaded into memory.  

3. Creating the ELAN Sample Table ".sam" file 

1) If it is not already open, launch the ELAN program and in the window entitled "Instrument 
Control Session", choose menu item "File" > "Review Files". Click the "New" button for 
"Dataset", the second item on the list. Navigate to the folder "C:\gc\data\" and enter the file 
name "Hg<yymmdd>" (where yy = last 2 digits of current year, mm = this month, and dd = 
date of run, for example, Hg110421 denotes Mercury Speciation run Apr.21, 2011, then 
click the "Open" button.  The new dataset folder has been created and is now active.  Click 
on the "DONE" button in the Review Files Window.  

2) Clicking on the tool bar icon that looks like three Erlenmeyer flasks. Then choose "File" > 
'"New" on the menu bar.  A new window will appear entitled "Samples - [Untitled]". Click the 
"Batch" tab then click on the "Sample Template" button. A dialog box entitled "Sample 
Template Data" will appear. Enter the following information:  
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TABLE 8-12: Sample Template Data  

Parameter Setting 

Sample ID:  001_ <sample name>   

Measurement Action (*): Run Sample 

Method: GC_Hg.mth 

Sample type: Sample 

Wash Override (sec) 0 

3) Parameters not mention in Table 8-12 can be left blank. Since the CombiPal autosampler 
can analyze 64 samples the sample ID can range from" 001_ <sample name>" to "064_ 
<sample name>" .   

4) From the menu bar, choose "File" > "Save As" and save the file in the directory "C:\gc\data\" 
using the name "Hg<yymmdd>.sam" (where yy = last 2 digits of current year, mm = this 
month, and dd = date of run).  

5) It is a good idea to save a copy of this file as a template, thereby avoiding the need to re-
create it every time.  

I. ICP-DRC-MS Performance Checks  

The following performance checks should be recorded in an instruments log book. 

1. Daily Performance Check  

1) Daily before samples are analyzed, Aqueous Blanks and 10X dilution of Low Bench QC 
should be analyzed to ensure that the instrument is functioning properly. Prepare all the 
following using the same technique and supplies as samples, unless stated otherwise. 

(a) Aqueous Blank.  To prepare, add 200 µL of TMAH into a 20 mL vial. Insert a stir bar 
in each tube. To each tube add 7.7 mL of NaOAc Buffer solution and 250 µL of 
derivatization reagent (NaPr4B).  Cap the vial immediately and gently mix it. 
Aqueous Blanks are ready to be analyzed.  

(b) 10X Diluted Low Bench QC. To prepare mix 0.1mL of Low Bench QC (LB) in 0.9 mL 
NIST 955C L1. This sample is digested and then analyzed exactly the same way as 
sample.   

2) After SPME-GC-ICP-MS analysis of Aqueous Blank and 10X Diluted Low Bench QC are 
complete, open the Aqueous Blank and 10X Diluted Low Bench QC RAW files in 
TotalChrome. Examine the Aqueous Blank chromatograph for possible indicators of 
contamination.  Then look at the 10X Diluted Low Bench QC chromatogram. This 
chromatogram should have visible peaks for the mass 202 isotopes of MeHg, EtHg, and 
InHg. Their intensities should be three times (3X) greater than the baseline RMS (root mean 
square) noise level, otherwise there may not be sufficient sensitivity and the instrument may 
need to be optimized (see weekly/monthly performance check section). 

2. Weekly Performance Check  

1) Visual check of Torch, injector, RF coil, and Cones: 

(a) Slide the vacuum chamber and interface away from the torchbox, and visually 
check the cleanliness of these components.  Notate any cleaning / replacing done 
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in the "Daily Maintenance / Performance Checklist". For details on cleaning 
procedures refer to IRAT Weekly Maintenance SOP. 

(b) Injector: There should not be deposits on the inside of the injector.  If there is, 
remove and clean with 1-5 % v/v ultrapure nitric acid, a cotton swab.  Alternatively, 
replace injector with spare and clean dirty one in an overnight soak in 5% v/v nitric 
acid (can be ultrasonicated, but is not typically necessary). 

(c) Torch:  Check for melting or cracking, and cleanliness.  If necessary, replace with 
spare and soak overnight in 5% v/v nitric acid bath.  If torch is only dirty, 
replacement / cleaning can be deferred to the regular weekly maintenance day. 

(d) RF coil:  Check for excessive corrosion (flaking).  Replace if necessary. 

(e) Sampler cone:  Check for excessive buildup of matrix, cracking, or pitting.  If 
necessary, replace dirty cones with clean spare cones and clean. 

2) Replace GC injector septum.   

3) Visually check level and condition of oil in roughing pumps. Appropriate level for oil is ~¾ 
full.  If color indicates the need to change oil soon, do so at the next weekly maintenance. Oil 
is clear yellow when new.  Light brown or “tea colored” is ok to use.  Dark brown or “coffee 
colored” indicates need to replace. 

4) Weekly GC-ICP-MS system is optimized with Xe gas because of its similarities in ionization 
potential to Hg. 

(a) Start Plasma, soon after the plasma ignites set flow rate of Xe gas mixture (0.1% Xe 
in Ar) at 0.01 - 0.25 mL/min on the GC main display to achieve Xe intensity > 
350,000 cps (counts per second). In ELAN upload "gc_xe_daily_drc.mth". After gas 
signal stabilizes (30-60min) in the "Sample" window press "Analyze Sample" in 
"manual" mode. If Xe intensity > 350,000 cps, the instrument is optimized. If not 
proceed with the following steps to optimize this instrumental setup. (The proffered 
number of counts varies with the instrument.) 

(b) In ELAN upload "gc_xe_xy_drc.mth". Also in ELAN program and in the window 
entitled "Instrument Control Session", choose menu item "File" > "Review Files". 
Click the "Load" button for "Optimization", the sixth item on the list. Navigate to the 
folder "C:\elandata\Optimize" and click on "gc_xe_drc.dac" file then click the "Open" 
button.  

(c) SmartTune™ is used for DRC Mode optimization.  Optimization parameters can be 
selected from "edit list".  Appropriate method file in "method" section to be selected. 
The optimization for maximum Xe intensity should be performed (see IRAT 
Optimization SOP).  

(d) After recommended parameters were optimized save the optimized file as 
"gc_xe_drc.dac". The current optimized values will appear automatically and will be 
similar to the ones in Table 8-13.  

(e) After optimization for maximum Xe intensity navigate to the folder 
"C:\elandata\Method" and click on "gc_xe_daily_drc.mth" file then click the "Open" 
button.  Record this data. 
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TABLE 8-13: ELAN Optimization Parameters 

Parameter Setting Parameter Setting 

Nebulizer Gas Flow 
(NEB): 

1.5 Cell Path Voltage Std - 14† 

Auxiliary Gas Flow: 1.2 Rpa 0 

Plasma Gas Flow: 15 Rpq .5† 

Lens Voltage: 4.75* Cell Gas A 0.3 

ICP RF Power: 1450 Cell Gas B 0 

Analog Stage Voltage: -1950* DRC Mode NEB 1.5 

Pulse Stage Voltage: 950* DRC Mode QRO - 16.90† 

Quadrupole Rod Offset 
Std 

0 DRC Mode CRO - 1.90† 

Cell Rode Offset Std 23 DRC Mode CPV - 51† 

Discriminator Threshold 17 Axial Field Voltage 150† 

†Suggested starting values only. Optimum parameters will depend on the outcome of 
the optimization procedure.  

3. Monthly Performance Check 

1) Before starting make sure the plasma is turned off and transfer line temperature (AUX 
button on GC main menu) should be lowered to 25°C (this is the lowest temperature the 
set-up allows for). Disconnect the transfer line from ICP-MS.  

2) Carefully examine the end of capillary in transfer line: make sure the end is open, no 
melting, cracks, smooth surface, and no condensation.  Replace if not in a good condition. 
Additionally if the chromatographic peaks are progressively broadening may consider 
replacing GC capillary.  If this does not solve the problem, consider replacing GC column. 

3) Connect spray chamber with the nebulizer to ICP-MS. Place the probe into the rinse solution. 
Clamp the sample tubing in the peristaltic pump.  Start the peristaltic pump at a low to mid-
range speed (i.e. 7 - 24 rpm).  Allow at least 45 minutes warm-up time for the ICP-MS after 
igniting the plasma.  This warm-up time is for the RF generator.  

4) After this warm-up time, perform a "daily performance check". Note: for this method the 
standard IRAT Daily Startup SOP for ELANs is used monthly (since it requires changing 
instrument set up).  This monthly procedures makes sure that ICP-MS part of this 
hyphenated method is functioning properly.  

(a) Daily Performance Test 

 Open your daily performance workspace, which should contain the following 
files. 

 Method file:  Daily Performance_cdc.mth (the same as the Perkin Elmer file, with 
the addition of the analyte Be at mass 9, and with the autosampler setup under 
the sampling page). 

 Dataset:  "Daily Performance" 

 Sample file:  "daily_performance_cdc.sam"  

 Report Template:  "daily.rop" 
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 Tuning File:  default.tun 

 Optimization file:  default.dac 

 Calibration file:  none needed 

 Polyatomic file:  "elan.ply" 

(b) Place a tube of "Daily Performance Testing Solution" into the row specified in the 
sample window (batch tab).  Select row one in the sample window (batch tab), and 
click "Analyze Batch".   

(c) Inspect the daily performance report as follows: 

 Intensities and Oxides:  Intensities should be above the Perkin Elmer 
specification at 3 % oxides.  Intensities are in the "Meas. Intens. Mean" column.  
Oxides are given as a fraction under the "Net Intens. Mean" column on the "CeO" 
row. 

 

 Compare against historical information in the instrument log. 

Precision ("Net Intens. RSD"):    
6100 : < 2-3% for Be*, Mg, Rh, and Pb.    
DRC Plus and DRC II instruments:  < 2-3% for Be*, Mg, In, and U.   

Background counts:   
DRC II :  < 2 cps for masses 8.5 and 220 

Doubly Charged species:  
Typical "Meas. Intens. Mean" for Ba++ is ? < 0.03. 

(d) If the results of the daily performance test fail to meet the PerkinElmer criteria, 
optimization tests will need to be run (see SOP "ICP-MS Optimization") 

J. ICP-DRC-MS Warm Up  

1) Launch the ELAN ICP-DRC-MS Software and note whether all graphical indicators of 
instrument readiness are green.  If not, take the appropriate actions described in the 
instrument's software and hardware manual.  

2) Perform necessary maintenance checks as described in Chapter 5 of the ELAN 6100 
Hardware Guide (e.g., argon supply, interface components, cleanliness, positioning, and 
interface pump oil condition).  Note the base vacuum pressure in the INSTRUMENT window 
of the software.  (Before igniting the plasma, the vacuum is typically about 8 x 10 -6 torr.)  
Keep a record any maintenance procedures along with the base vacuum pressure in the 
Daily Maintenance Checklist notebook.  

3) In the INSTRUMENT window of the ELAN software, click the "Front Panel" tab and click the 
plasma "Start" button to ignite the plasma.  In the same window, the ignition sequence bar 
(blue progress bar) will start to expand from the right, indicating the approximate time 
before plasma ignition. The plasma may at first flicker but it should establish a more or less 
steady intensity after 5-10 seconds.  

On a rare occasion, the plasma may ignite emitting an orange, violently flickering light, 
and electrical discharge noises will be heard. In this case, immediately shut off the 
plasma by pressing the yellow "Stop" button on the ICP-DRC-MS instrument's front 

Instrument Mg In U Oxides 

DRC II (per 1 ppb) >6,000cps > 30,000cps >20,000cps 0.03 (3%) 
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control panel. Wait 30 seconds then investigate the cause of the plasma misfire. A more 
common occurrence is that the plasma may extinguish itself a few seconds after 
ignition. Promptly reignite by pressing the "Start" button on the ICP-DRC-MS 
instrument's front control panel. Usually, the plasma will stay lit after the second try. If 
not, investigate the cause of this instability (refer to the ELAN DRC II Hardware Guide).  

4) Soon after the plasma ignites perform daily performance. 

5) Fill in the Daily Maintenance Checklist Book according to the completed optimization 
procedures.  If a tuning (mass-calibration) procedure was done, save it to the file 
"default.tun," and also in a separate file containing the analysis date "default_MMDDYY.tun" 
(where MM=month, DD=day, and YY=year).  

K. GC-ICP-DRCII-MS System Startup 

1. Entering Sample Names into the ELAN Sample Table  

1) Click on the tool bar icon that looks like three Erlenmeyer flasks. If the current Samples 
window is not this run's sample file, then choose "File" > "Open" on the menu bar and 
navigate to and open this run's current data folder in "C:\gc\data\". Click on the file named 
"Hg<yymmdd>.sam" (yy = year, mm = digit month, dd = date) and open it. The Samples 
window will be the one created in the section Creating the ELAN Sample Table ".sam" file.  

2) Fill in the name of each sample by double-clicking after the "_" (underscore) in the cell 
"sample ID". Type in the sample name and press "Enter" on the keyboard. In this manner, 
enter the name of blanks, quality control, and sample that will analyzed in the run. If 
barcodes are used on the sample labels, use the barcode scanner attached to the ICP-DRC-
MS computer to scan the sample ID from the barcode on each sample before placing it into 
position in CombiPal autosampler tray.  

3) Filling out the Samples table (Table 8-14).  

TABLE 8-14: ELAN Samples Table 

A/S Loc. Batch ID Sample ID Measurement 
Action 

Method … Wash Speed 
(+/- rpm) 

1  001_ Aq.Blk Run Sample   0 

1  002_ Aq.Blk Run Sample   0 

2  003_ LB 10X Run Sample   0 

2  004_ LB 10X Run Sample   0 

3  005_ LB-yyxxx Run Sample   0 

3  006_ HB-yyxxx Run Sample   0 

4  007_ Sample Run Sample   0 

4  008_ Sample Run Sample   0 

…rows for 18 samples and SRM material were omitted for brevity 

16  031_LB-yyxxx Run Sample   0 

16  032_HB-yyxxx Run Sample   0 

 
 In the example table above, a run of 20 samples is shown so the last vial ends up being placed 

in A/S Location #16 (this location corresponds to autosampler location which is defined in 
Chronos, since there are two autosampler trays two #16 are used - "Left" and "Right". It is not 
necessary to put A/S loc in ELAN - only for analysts benefit).  
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 The numbers preceding the underscore character correspond to the order of injection. These 

numbers will later help the analyst find individual chromatograms based on injection number 
instead looking for specific sample names during post-run data processing in TotalChrom.  

4) When the sample table entries are verified to be correct choose "File" > "Save".  

5) Print the ELAN Sample table by choosing the "File" > "Print Setup" > "Reports". In the 
ensuing dialog box, select the preferred printer and click "OK". Next, choose "File" > "Print" 
and then click the "Print" button. Refer to the printout of the ELAN Sample table for the 
correct vial positions when loading samples into the CombiPal autosampler tray.   

L. Starting the Run 

1) Create daily data folder in C:\GC\Data under the name Hgyymmdd (i.e., Hg110422) 

2) Launch ELAN Instrument Control program if it is not already up. Do not launch or start any 
other programs at this time. 

3) Check that the correct ELAN method is loaded and active in the window "Instrument Control 
Session". If it is not correct, load the correct Method file. Check under the Sampling tab that 
"Peristaltic pump under computer control" is unchecked, and the pull-down menu 
"Sampling" indicates "External".  

4) Check that the correct Sample file in the window "Instrument Control Session" is active. If it 
is not correct, load the correct Sample file.  

5) Load created dataset file "Hgyymmdd" 

6) Check that the GC methods are correctly programmed. 

7) Check that CombiPal autosampler methods are correctly programmed.  

8) This step offers the advantage that the ELAN data files will be converted in real time to 
TotalChom™ ".raw" files that have names containing a date-time stamp corresponding to 
actual time of injection.  

(a) Launch TotalChrom Navigator. In the resulting TotalChrom Navigator window, 
choose menu item "Apps" > "ChromLink" (alternatively, you may launch ChromLink™ 
from the operating system "Start" > "Programs" menu).  

(b) In the ChromLink™ program window, choose the menu item "Configuration" > "Mass 
Details" and check the Nominal Name and Mass for mercury isotopes. If it is 
missing or the ELAN tune ("default.tun") file was re-optimized earlier then 
ChromLink™ needs to be configured (see Configuration of ELAN ChromLink™ on 
page 35 for details). To save time, the analyst may choose to close the TotalChom™ 
Navigator and ChromLink™ windows and skip step 6 in its entirety. Data file 
conversion via ChromLink™ can easily be done during post-run data reprocessing. 

(c) In the ChromLink program window, click on the "Browse" button just right of the 
"ELAN ChromLink file location" field.  Navigate to the current working folder, double-
click on it then click the "OK" button so that ChromLink knows where to save its 
processed files.  

(d) Otherwise, refer to step (b) of Data Processing and Analysis on page 37 for details 
on proper setting of the ELAN ChromLink™ window's parameter fields. In the ELAN 
ChromLink window, click the button "Start Processing ELAN Data Files" to put 
ChromLink in watch mode so it will process each data for each injection in real 
time. A new dialog box will open and indicate it is ready to convert data and waiting 
for the first file.  
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9) Launch Chronos program, which communicates with CombiPal autosampler and ELAN 
software. 

(a) In the main menu click on "Sample List" then upload analysis method for   SPME 
fiber cleaning "baking".   

(b) Upload "SPME bakeout LEFT.cam" (to clean the left fiber) then select "Create 
Schedule". The Schedule window will appear with time intervals required for the 
measurement.  Click "RUN" on the main menu, the run window appears and click 
"run" again to proceed with the fiber cleaning. 

(c)  Repeat step (b) to clean right fiber and use "SPME bakeout RIGHT.cam" 

(d) After fiber cleaning and daily performance check the QC and samples are ready for 
analysis using SPME fibers. On the "Main Menu" select "Sample List" then click 
"Load List".  Upload Dual SPME .csl file. This file communicates with Left and Right 
fibers. The table similar to the one below (Table 8-15) will appear.  The table should 
have Analysis Method "C:\Chronos\Methods\TWIN SPME_cdec.CAM" uploaded.   

TABLE 8-15 Chronos Samples Table 

Analysis Method Source 
Vial 

Incubation 
Time (s) 

Enrichment 
Time (s) 

Desorption 
Time (s) 

GC cooling 
down (s) 

C:\Chronos\Metho
ds\TWIN 
SPME_cdec.CAM 

1 1 1200 420 180 

 1 1 1200 420 180 

 2 1 1200 420 180 

 2 1 1200 420 180 

Rows for source vials 3 to 31 are omitted.. 

 32 1 1200 420 180 

 32 1 1200 420 180 

 

(e) "Source Vial" column shows which autosampler position will be first analyzed.  
There are two racks (left and right) with vial position 1 to 32.  Left rack gets 
analyzed by Left SPME fiber and Right rack gets analyzed by Right SPME fiber.  
There are two numbers "1" in the source vial column.  First one always corresponds 
to Left rack/Left fiber. 

(f) Chronos communicates to autosmpler though "source vial" position, the analyst has 
to make sure sample in ELAN correspond to location seen by Chronos. Example:  if 
the analyst wants to analyze slots 1-5 on both racks (total of 10 samples) the rows 
below 10 should be deleted.  To delete select the rows and click "Remove 
Samples".   

10) Check that the DRC gas is indeed flowing by making the ELAN's Instrument window active 
and clicking on the Diagnostics tab. Inspect the Cell Gas A or B, its value should be 
fluctuating at the current value ± 0.01 mL/min. If it is not, see section Turning on the 
Reaction Cell Gas for details to turn on the DRC gas flow.  

11) Check that all blanks, QC, and sample vials are loaded into their correct positions in the 
CombiPal autosampler tray as designated by the ELAN Sample window (or its printout) and 
in position seen by Chronos.  
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12) Before samples are analyzed, daily performance check should be analyzed to ensure that 
the instrument is functioning properly.   

(a) Click on the ELAN "Instrument Control Session" window to make it active.  Highlight 
the samples and click the "Analyze Batch" button. A Run Progress box will appear 
indicating that the ELAN software is now waiting for a signal from the Chronos that 
indicates the occurrence of an injection. 

(b) In Chronos: to analyze sample select "Create Schedule" then press "RUN" on main 
menu and "RUN" again on the run window. 

(c) View the chromatograms in TotalChrom and in the real time window of ELAN to 
ensure that there are no problems with the analysis.  After the Aqueous Blanks and 
10X LB been analyzed the run can be started.   

13) Open the ELAN "Instrument Control Session" Real-Time window by clicking the tool bar 
button that looks like a Gaussian distribution (the blue chromatographic peak). After the 
Real-Time window opens, click on the drop-down menu and select "Signal". Real-time data 
will now be displayed.   

14) CombiPal autosampler will seek the first vial and make an injection.  A blue bar in the 
ELAN's progress box will now indicate that data is being collected. The system can now run 
unattended. 

15) Check the progress of the run after 2 or 3 injections. Note the chromatograms appearing in 
the ELAN's Real Time window. Adjust the signal scale in the Real Time window, as 
necessary. Compare the positions and peak heights of each mercury species. It helps to 
visually compare it to a printed reference chromatogram. If abnormalities in retention time, 
peak height, or peak shape are readily apparent, the analyst may need to stop the 
autosampler and abort the run in the Chrionos program and then ELAN. Correct the 
problem(s) and restart the run. 

 

Important 

Remember to disable the ELAN's Auto Stop feature before re-enabling it otherwise the ELAN may perform 
an auto shutoff prematurely. 

M. Instrument Shut Down 

1) The autosampler will stop after all samples have been analyzed. 

2) Shut off ICP-DRC-MS plasma.  

3) At the controller computer, visit the ELAN Instrument Control Session application and open 
the "Dataset" window. Confirm that all samples ran successfully and that the corresponding 
data for each sample is listed in this window.  

4) Remove the QC and sample vials from the GC tray. Discard them according to CDC 
biohazard waste disposal guidelines.  

IX. POST-RUN DATA ANALYSIS 

A. Configuration of TotalChrom Integration Method 

The following information is presented as a starting point to help the analyst develop robust integration 
method parameters that will work best for most chromatography data. Many of these parameters will work 
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just fine as presented below. However, the separation chemistry of GC columns can vary due to frequency of 
use, column replacement, or because of individual sample "oddities". Some parameters may need to be 
adjusted from time to time to maximize the ability of TotalChom™ to properly integrate peaks and identify 
components with minimum operator intervention. Therefore, the analyst should pay particular attention to the 
chromatograms produced in every run and make necessary adjustments as warranted. The analyst should be 
familiar with the TotalChrom's frequently used integration functions, which are described in Chapter 18 of 
TotalChrom Workstation User's Guide: Volume II.  

1) The creation of a new method file in TotalChrom is done the first time TotalChrom is setup, 
or it will need to be recreated if the file "Hg.mth" cannot be found or has been corrupted. In 
the TotalChrom Navigator window, choose the menu item "Build" > "Method." In the next 
dialog box, click the "Create a new method" radio button and click "OK." The default method 
will load into the method editor.  

2) Click on the "Components" item in the menu bar in Method Editor.  If the menu item "Delete 
All Components" is not grayed out, select it and click "OK" when prompted to "Delete all 
components, calibration levels, and calibration replicates". 

3) Choose the menu Item "Process" > "Integration".  Click on the "Integration" tab in the 
"Process" window.  Enter the information shown in Table 9-1.  These values are to be used 
as a starting point, but the analyst may make appropriate changes to one or more of the 
integration parameters as necessary. 

TABLE 9-1: Integration 

Basic Parameters  Advanced Parameters 

 Value   Value 

Bunching Factor : 1  Peak Separation Criteria  

Noise Threshold : 115  Width ratio : 0.2 

Area Threshold : 577  Valley to peak ratio : 0.01 

     

   Exponential Skim Criteria  

   Peak height ratio : 5.000 

   Adjusted height ratio : 4.000 

   Valley height ratio : 3.000 

4) Click on the "Baseline Timed Events" tab.  Enter the information shown below in Table 9-2.  
The analyst may make appropriate changes to one or more of the Baseline Timed Events as 
may prove necessary. 

 



Blood mercury species SSID-GC-ICP-DRC-MS IRAT-DLS 

DLS Method Code: 3020 Page 34 of 51 

 

 

TABLE 9-2: Baseline Timed Events 

Defined Events 

Time Event Value Code Level 

0.000 Set Area Threshold  125 AT  

0.000 Set Noise Threshold 25 NT  

0.000 Smooth Peak Ends On 5 +SM  

2.222 Set Bunching Factor 4 BF   

5) Click on the "Optional Reports" tab.  Uncheck the box for "Keep temporary files". 

6) Click on the "Replot" tab. Enter the information shown in Table 9-3. The analyst may make 
appropriate changes to one or more of the Replot parameters as may prove necessary.  

TABLE 9-3: Replot 

Plots  Miscellaneous 

Generate a separate 
replot : 

checked  Start plot at end of 
delay : 

checked 

Number of pages: 1  Gradient overlay : not checked* 

Retention Labels : Top of Plot*  Draw baselines : checked* 

Component Labels : Actual time  Timed Events : checked* 

Scaling Type : Absolute 
Scaling 

 Plot Title : Chromatogram 

Scaling Parameters   X axis label : Time [min] 

Scale Factor : 1.000000*  Y axis label : Response [mV] 

*These parameters maybe altered to suit the analyst.  
 

7) It is unnecessary to click on the "User Programs" tab because it is not used.  Close the 
Process window by clicking on the "OK" button. 

8) In the Method Editor window, choose the menu item "Components" > "Global Information."  
Click on the "Integration" tab in the "Process" window. Enter the information shown in Table 
9-4: 
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TABLE 9-4: Global Information 

Volume units : µL  Unidentified Peak 
Quant. 

 

Quantitation units : ng  Calibration factor : 1.000e+06 

Sample Volume  : 1.000  Always use calib. Factor 
: 

selected 

Void time (min) : 0.000    

Calibration   RRT Calculation  

External Standard selected  Use first peak in run as 
RRT reference:  

selected 

Reject outliers during 
calibration : 

not checked    

Sample Amount 
Options 

    

Correct amounts for 
calibration standards : 

not checked    

 Convert unknown 
samples to 
concentration units: 

checked    

9) The "LIMS Results" tab is not used. Click the "OK" button to close the window. The 
parameters in Table 9-4 are starting points. The analyst may make appropriate changes to 
one or more of the Global Information parameters as may prove necessary. 

10) In the Method Editor window, choose the menu item "Components" > "New Component." The 
white list box in the left portion of the window will be empty. Click in the empty field labeled 
"Name" and type "Hg0". Press the tab key and enter "1.614" in the field labeled "Retention 
time". Select the radio button labeled "Peak" if it is not already selected. Leave the other 
fields and check boxes unaltered. Click the "New Component" button. Enter each of the 
component names and parameters listed in TABLE 9-5. 

TABLE 9-5: Method Editor - Components Settings 

Name Retention 
Time 

Absolute 
window 

Relative 
window Find tallest peak in window 

Hg0 1.614 2 3 No 

InHg 3.470 0 3 No 

MeHg 2.640 0 3 Yes 

Ethg 3.176 0 3 Yes 
 

11) Click the "New Component" button before starting a new component. After entering the last 
component, click the "OK" button. The values for Retention Time, Absolute Window and 
Relative Window serve as starting points. The analyst may alter these values as actual 
chromatographic results may dictate. 
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12) In the Method Editor window, choose the menu item "Components" > "Defaults."  Click on 
the "Identification" tab". Enter the information shown in Table 9-6. 

 

TABLE 9-6: Components Defaults – Identification 

Parameter Setting  Parameter Setting 

Component Type : Peak  Reference : blank 

Absolute window : 0   Internal Standard : blank 

Relative window : 3  Find tallest peak : Not checked 

 

13) Click on the "Calibration" tab in Components Defaults Window.  Enter the information shown 
in Table 9-7. 

TABLE 9-7: Components Defaults – Calibration 

Parameter Setting Amount 

Calibration Type : Use Calibration Factor 1.0000E-6 

Scaling : None  

Weighing :  None  

Response :  Area  

 

14) The "User Values/LIMS" tab is not used. Close the "Components Defaults" window by clicking 
the "OK" button. 

15) In the Method Editor window, Choose "File" > "Save As."  A window appears inviting you to 
enter any information pertinent to this method which will be saved with the method. Enter 
your name and the date this method was created. Click "OK" and a "TotalChrom File-Save-
As" dialog box opens. Navigate the directory tree to get to the folder C:\GC\Methods ). 
Double-click on this folder. In the "File name:" field, enter "Hg-Template.mth". If there is 
already a file in that folder with the same name, highlight that file and right-click the mouse. 
Choose "Rename" and give the file a new name (e.g. add "backup" to the name). Now, you 
can click the "Save" button. Close the "Method Editor" window. 

B. Configuration of ELAN ChromLink™ 

 ELAN ChromLink™ should be configured after initial installation of the program or when the ELAN 
tune ("default.tun") file is re-optimized, and when there is available at least one recent ELAN NetCDF 
file (with the ".nc" extension) containing data for the mass of interest that was collected since last 
update of the "default.tun" file.  

1) Launch TotalChrom Navigator. In the resulting TotalChrom Navigator window, choose menu 
item "Apps" > "ChromLink" (alternatively, you may launch ChromLink™ from the operating 
system Start > Programs menu).  

(a) Inside the ELAN ChromLink window, click on menu item "Configuration" > "Default 
TotalChrom Method". Click on the "Browse..." button and navigate to the directory 
C:\gc\methods\. Select "Hg-TC.mth" and click the "Open" button. 
"C:\gc\methods\Hg-TC.mth" will now be the ChromLink™ default method. Click "OK" 
to close the "Default TotalChrom Method" window.  
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(b) Inside the ELAN ChromLink window, click on the "Set" button. A window entitled 
"Operating Mode" will open. Inside the ELAN ChromLink window, click on the "Set" 
button. A window entitled "Operating Mode" will open. Click on the "Automatic - 
process all ELAN NetCDF files in specified location" radio button. The lower radio 
buttons will gray out. Click the "OK" button to close the window. 

(c) Click on the "Browse" button by the "ELAN NetCDF file - location/file to be 
converted" space.  Choose the path "C:\Elandata|reportOutput".  The location/file 
to be converted will now read "C:\Elandata|reportOutput\*.nc".  

(d) Click on the "Browse..." button for "ELAN NetCDF Chromlink file location (sequence 
and raw files generated by Chromlink)" field.  An open file dialog box will open; 
choose the file to which all the data should be place (usually the data file that was 
created that day). 

(e) Click on the "Start Processing ELAN Data Files" button. A window entitled 
"Processing ELAN Data" will appear. 

2) At this time, ChromLink™ may be closed by selecting "File" > "Exit." Click "OK" at the dialog 
box asking if you want to quit ChromLink™.  

3) In addition to configuring ChromLink™ itself, it is necessary to alter one value in the "seed" 
method file that ChromLink™ uses to set a select number of parameters to certain default 
values. This step only needs to be done once following the installation of ChromLink™.  

(a) In the TotalChrom Navigator window, choose the menu item "Build" > "Sequence" 
and a dialog box called "Startup" will appear. Click on the radio button labeled "Load 
sequence stored on disk" then click the "OK" button. Navigate to the folder on the C 
drive that contains the ChromLink™ program file (usually in C:\PenExe\ChromLink 
but if it is not there, check under the C:\Program Files directory). Click on the 
sequence file "seed.seq" to highlight it (if this file is missing, reinstall ChromLink™). 
Click the "Open" button. A spreadsheet style sequence table will present itself in a 
window called "Sequence Information - Channel A". There will be a minimized 
window for channel B data; ignore this window.  

(b) Choose menu item "File" > "Save." Close the Sequence Editor window by choosing 
"File" > "Exit" from the menu bar.  

 

C. Data Processing and Analysis 

 Refer to Figure 1 "Post-Run Data Processing Work Flow Diagram" (page 38) for a summary 
representation of the important aspects of post-run data processing.  

1) Open Microsoft Windows® File Explorer and open the current working GC data directory 
(e.g., C:\GC\Data\<current working folder>). Select all files ending with the .rst and .idx and 
"delete" them to the Microsoft Windows® Recycling Bin.  

2) If it is not already open, launch TotalChrom. 

3) If ChromLink was not run in real-time data collection mode during the run as described in 
step 6 under Starting the Run (see page 29), then do the following:  

(a) In the TotalChrom Navigator window, choose menu item "App" > "ChromLink." 
Choose the menu item "Configuration" > "Mass Details" and check the Nominal 
Name and Mass for mercury. If it is missing or altered then ChromLink™ needs to 
be configured (see Configuration of ELAN ChromLink™ on page 32 for details).  

(b) Check that the Mode field indicates "Automatic - Process all NetCDF files in 
specified location". If it does not, click the Set button to the right of this field and in 
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the resulting "Operating Mode" dialog box, click the "Automatic - process all ELAN 
NetCDF files in specified location" radio button, then click the OK button. Next, 
check that the Field labeled "ELAN NetCDF file - location/file to be converted" 
indicates the correct data folder. This should be "C:\elandata\Reportoutput\*.nc". If 
it is not, click the Browse button to the right of it and navigate to that folder. Double-
click on that folder then click the "OK" button to close the front most dialog box. 
Last, click the Browse button to the right of the field labeled "ELAN ChromLink file 
location..."  In the dialog box "Select TotalChrom Data Location", navigate to the 
folder containing the run data and double-click on it. Click the OK button to close 
that dialog box. In the ELAN ChromLink window, click the button "Start Processing 
ELAN Data Files" to start processing of the run data. A new dialog box will open and 
provide current information on the status of the data conversion.   

(c) When data conversion by ChromLink is completed within a minute or two, a 
message in the step field will indicate "Successfully Finished". Click the Close 
button. At this point, you may close the ELAN ChromLink application by choosing 
"File" > "Exit" or clicking on the window "x" box. In the resulting "OK to quit?" 
confirmation dialog box, click the "OK" button.  

4) In the TotalChrom Navigator window, choose the menu item "Build" > "Method." Click the 
"Load method stored on disk" radio button and click "OK." In the TotalChrom File-Open" 
dialog box, find C:\GC\Methods folder and open the "GC_Hg.mth" file. The template method 
file should now be loaded.  

 
 If, instead of loading the method file, an error message appears stating that the file is 

unavailable because it is in use and asks if you would like to open it in Read-Only mode, 
click the "No" button. Cancel the Open-File dialog box. Exit the Graphic Method Editor. In the 
Navigator window, choose menu item "Admin" > "CAM Administrator." A window will appear 
with two panes. In the left pane, click on the "+" sign in front of "TotalChrom Servers" to 
expand it. Click on the computer icon on the next line that just appeared to highlight it. In the 
right pane, under the heading "Resource/Instrument", select the first item. If there is more 
than one item, select every item by shift-clicking on each item. Every item should now be 
highlighted. Choose "Edit" > "Remove Locks" (or press the Delete key on the keyboard). Next, 
click on the "+" sign in front of "Users" to expand it. Click to highlight your TotalChrom user 
name that appeared. In the right pane, under the heading "Resource/Instrument", select 
every item and Choose "Edit" > "Remove Locks." This action serves to unlock files and make 
them available for editing. If in the future, TotalChrome™ complains that files cannot be 
edited because they are locked, use CAM Administrator to unlock them. Choose "File" > 
"Exit" to quit CAM Administrator. Start again at the beginning of this step to open the Method 
Editor.  
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Figure 1: Post-Run Data Processing Work Flow Diagram 

 
5) Choose "File" > "Save As." At the next window you will be invited to enter information about 

the method. You may enter pertinent information but this is optional. Click the "OK" button 
and a TotalChrom File-Save-As" dialog box opens. Navigate the directory tree to get to the 
folder that contains the ELAN data files for this run (typically in the folder C:\GC\Data\ ). 
Double-click on this folder. In the "File name:" field, enter the same name as it exactly 
appears for the folder that will contain it (i.e. Hg<yymmdd> convention where yy=2-digit 
year, mm=2-digit month, dd=2-digit date). Click the "Save" button then close the "Method 
Editor" window.  

6) In the TotalChrom Navigator window, choose the menu item "Build" > "Graphic Edit." A 
TotalChrom File-Open" dialog box appears, but click on cancel to close it.  On the Graphic 
Method Editor's menu bar, choose "File" > "Open" and navigate the file-open dialog box to 
the folder containing the method file created in the preceding step. Click on that file and 
click the "Open" button. Return to the Graphic Method Editor's menu bar and choose "File" > 
"New Data File." Navigate to C:\GC\Data\ and double-click on the folder containing the run 
data. Find and click on a data file (indicated by the ".raw" extension) that corresponds to the 
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"-LB0972". When this file appears in the File Name field, click the "Open" button. If a 
message box appears with the warning "Unable to open this file: default.mth", click "OK" to 
clear the message (you do not have to go to CAM Administration to unlock it). Do the same if 
another message warning box appears (i.e. click "OK" again to clear it). You should be in the 
"Graphic Method Editor - <path to method file>" window and see a chromatogram.  

7) Under the menu item "Calibration" > "Show Windows" there should be a check mark beside 
"Show Windows."  Retention window bars (looks like "H" style error bars) will be present 
when it is checked. Each retention time window bar should be located above the 
chromatographic baseline and contain an identified peak within its bounds. If there are any 
bars at the bottom of the chromatogram located below the baseline, choose menu item 
"Calibration" > "Edit Components." Click on the first mercury species peak that falls outside 
its retention time window to select it. In the group of data fields located on the right side of 
the window, click on the "Name" dropdown arrow (located on the right side of the data entry 
field) and choose the appropriate species by nameIt is usually not necessary to alter the 
retention time window's "Absolute" and "Relative" window parameters, but you may do so if 
experience dictates that a change will be beneficial. Click the "Next" or "Prev" button. Repeat 
these steps for each mercury species peak that was not properly identified because it was 
outside its retention time window. When the editing of peak retention time windows is 
complete, click on the menu bar item "Return". Next, choose "File" > "Save" followed by "File 
> Exit".  

8) "In the TotalChrom Navigator window, choose the menu item "Build" > "Sequence" and a 
dialog box called "Startup" will appear. Click on the radio button labeled "Load sequence 
stored on disk" then click the "OK" button. The following steps should be used to create the 
sequence used for reprocessing. 

(a) Navigate to the folder containing the run data and click on the sequence file (ends 
with ".seq")  corresponding to the run (named "Hgyymmdd.seq" where where yy=2-
digit year, mm=2-digit month, dd=2-digit date ). Click the "Open" button. A 
spreadsheet style sequence table will present itself in a window called "Sequence 
Information - Channel A". There will be a minimized window for channel B data, 
ignore this window. Look for the "Method" column and click on the first cell in row 1 
in this column. Right click the mouse and a contextual menu will appear; choose 
"Browse". In the resulting File-Select dialog box, navigate and choose the method 
file (ending in ".mth") created earlier. Click on the Select button. The path and name 
of the new method file will replace the default information in this cell. Right click 
this cell again and choose Fill Down. The new file name information will fill down to 
every cell in the "Method" column. Look for the "Rpt Fmt File" column and follow the 
same process that was followed with the "Method" column.  Instead of choosing the 
method file (ending in ".mth") choose the report file (ending in ".rpt).  If the report 
file is not listed, click on the "default.rpt" file.  In the bar that contains the file's path, 
change the "default" to "Hgyymmdd."  Right click this cell again and choose Fill 
Down. The new file name information will fill down to every cell in the "Rpt Fmt File" 
column.   

9) In the TotalChrom Navigator window, choose the menu item "Reprocess" > "Batch." A new 
window appears entitled "Batch Reprocessing". Choose menu item "File" > "Sequence" and 
another window appears entitled "From Sequence". Locate the top field labeled "Sequence 
file" and look for a button with an open folder icon immediately to the right of the field. Click 
this button and navigate, if necessary, to the folder containing the run's sequence files. Click 
on the sequence file and click the "Open button."  Upon return to the previous window, set 
Start Analysis to "Peak Detection" and End Analysis to "Quantitiation". Set Batch Printer to 
"pdfFactory Pro".  Change Batch Execution to "ndlb-168462" or anything other than 
"Interactive". Check "overwrite existing result files" and select "Update existing raw file 
header with new sequence".  All other parameters should remain unchanged.  The 
parameters are shown in TABLE 9-8.  



Blood mercury species SSID-GC-ICP-DRC-MS IRAT-DLS 

DLS Method Code: 3020 Page 41 of 51 

 

 

10) Click the "OK" button.  Reprocessing of the chromatographic raw data will commence.  The 
bottom panel in the window will update with each file's name as it is processed. When 
processing is done, this panel will be clear of files. Close this window.   

 

TABLE 9-8: TotalChrom™  Navigator - Reprocess Batch 

Parameter Name  Parameter Setting 

Starting Row : 1 

Ending Row : <number of rows in sequence file> 

Channel A : Checked 

Channel B : Not Checked 

Start Analysis : Peak Detection 

End Analysis : Quantitation 

Batch Execution : ”ndlab-168462” or equivalent 

Batch Printer : pdfFactoryPro 

Batch Plotter : None 

Enable Optional Reports in Method 
Use Method is Result File 

: Not Checked 
Grayed Out 

Overwrite Existing Result Files : Checked 

Raw File Treatment : Update existing raw file header with new 
sequence 

 

11) In the TotalChrom Navigator window, choose the menu item "Reprocess" > "Results."  A new 
window should open called "Reprocess Results". If you get an error message telling you that 
you can only open this in read-only mode, then unlock the files (follow the procedure 
described in step 4 of this section). Select from the menu "File" > "Open." In the open file 
dialog box, click on the "Files of type:" dropdown menu and select "IDX files (*.idx)". Navigate 
to the folder containing this run's data and click on the newest file (in the format of 
"Hg<yymmdd>-<today's date>-<time of reprocessing>"). Click "Open." In the Reprocess 
Results window will be presented a chromatogram for the first sample in the sequence. 
Carefully inspect the chromatogram one peak at a time for correct peak identification and 
accurate baseline. If you are satisfied that there are no integration problems, proceed to the 
next sample's chromatogram by selecting "File" > "Next File" from the menu bar or pressing 
"F3."  Examine all chromatograms in this manner and make corrections in peak identity and 
integration as necessary. Make notes concerning issues encountered with individual 
chromatograms and changes that were made. If a chromatogram is changed or edited in 
any way, be sure to select "File" > "Save" to save your changes. See the chapter entitled 
"Developing Processing Parameters in the Method" in the PerkinElmer TotalChrom 
Workstation Users Guide for a detailed explanation on how to use integration events to 
optimize the integration of a chromatogram. After review of each and every chromatogram, 
select "File" > "Exit" from the Reprocess Results menu bar.  

12) Repeat step 9 except set both Start and End Analysis to "Report Generation". Set Batch 
Printer to "pdfFactory Pro". A new window will open. When reprocessing has completed, click 
the "Save" button on the pdFactory Pro window. In the Save As dialog box that appears, 
navigate to the run's data folder and create a new pdf file named "Hg<yymmdd> report". Be 
sure to include a space between "report" and the first word of the new file. Click the "Save" 
button. This pdf file is to be kept and backed up, for archival purposes, in the same folder 
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with all the other chromatographic data files for this run. Click the "Close" button to close 
pdFactory Pro window.  

13) Open Microsoft Excel and choose "GCICPMS" > "Extract TC Data" from the menu.  In the 
open file dialog box, navigate to the folder containing the run's data files. A box titled 
"Choose a Sequence File" should appear.  Navigate to the folder that contains the sequence 
file that you are working with.  Double click on the sequence file.  Immediately a macro will 
run that will extract the data and put it into a format that is easily exported into the 
database. Just before the macro finishes, a "Save As" dialog box will open giving you the 
opportunity to save the file as an Excel workbook. Give the file a name as follows: 
"Hg<yymmdd> results". The multi-tabbed Excel workbook contains a worksheet suitable for 
data exportation to the Frontends (MS SQL Server 7™) database.  

14) Calculated “spike” concentrations for enriched InHg, MeHg and EtHg in Triple-spiked 
standard solution should be entered in the column “ppb Spike” in Microsoft Excel. Then, in 
Microsoft Excel toolbar choose "GCICPMS" > "Deconvolute" from the menu, sample 
concentration values will be calculated and appear in the column “ppb Result”.  

15) The data processing portion on the instrument controller computer is now complete. At this 
point you may close Microsoft Excel® and TotalChrom Navigator. 

16) Throughout the sample analysis it is important to ensure that three mercury species peaks 
(InHg, MeHg, and EtHg) are well resolved. Thus, the following criterion is followed to 
accept/reject the sample analysis.  The Microsoft Excel document containing concentration 
results displays retention times for each mercury species in the column labeled “RT”. 
Mercury species elute from a chromatographic column in the following order MeHg, EtHg, 
InHg with relative retention times tr1, tr2, tr3, respectfully.  For the purpose of establishing 
relevant criterion, relative retention time for InHg (tr3) is set to 1. Then the ratio (tr2/tr1) 
=0.91 ± 0.13 and (tr3/tr1)=0.77 ± 0.12 (± represents three times standard deviation). If the 
relative retention time ratios fall outside the allowable error- the samples should be 
repeated. 

 

 
 

X. RECORDING OF SAMPLE AND QC DATA 

A. Transferring the Data to the Branch Database  

1) Transfer the "Hg<yymmdd> results".xls file via recordable media (e.g., USB flash drive) to the 
appropriate subdirectory on the network drive where exported data are stored.  (Note that 
directories are named according to instrument/year/month/ and study name or ID, for 
example, 
\\cdc\project\CCEHIP_NCEH_DLS_IRATB_COMMON\Nutritional\Instruments\ELAN 
_DRCM/2011/04/Hg110423 Results - Study 2006-09".)   

2) From a computer that has access to Frontends database used for tracking data, log in using 
your user ID and password.  After you log into the database, open the FrontEndSet folder in 
the GO TO window.   

3) Click the "Add Sample Results to Database" button. New buttons will appear. Click the 
"Import Instrument Data File" button.  For "Instrument", choose "ELAN-DRC2M" (or the 
appropriate instrument). For "Assay", choose "HgSpecGC". Enter the appropriate Analyst and 
Study for these two fields. It is not necessary to fill-in the "IS Lot Number" Field. Select the 
location of the data file on the network drive and press the "Open" button.   
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4) In the "Imported Results" table, pressing the "Find X's" button will show only those samples 
whose sample ID is not recognized as a valid QC pool ID or sample ID for this study.  
(Sample IDs are set up when the study is logged into the database.)  If necessary, 
corrections to sample IDs and dilution factors can be made in this table (e.g., correction of 
transcription errors and adjustment for level of dilution).  If samples were diluted for 
analysis, both the sample ID and the dilution factor need to be edited in this table before the 
values are transferred to the database.  First, change the dilution factor to reflect the way 
that the sample was analyzed then edit the sample ID to remove any comments about the 
level of dilution at which the sample was analyzed. (The replace command is useful here.)   

5) When corrections to sample IDs are made, press the "Recheck" button to evaluate the 
sample IDs.  Any sample or analyte row marked "Not Recognized" will not be transferred to 
the database when the "Transfer" button is pressed.  

B. QC Data 

Store the results of the QC samples analyzed in each run in the Frontends database when all other data 
for the run is imported from the ELAN software.  Refer to "Recording of Data" described above for how to 
import data into the Frontends database.  The database allows for the printing of several types of QC reports.   

XI. FINAL DATA REVIEW 

A. Analysis Printouts and Analyst Run Report 

If the samples analyzed are part of a study that has an associated study folder place the analysis 
printouts in the study folder(s).  Store the results of the patient samples analyzed in each run in the 
Frontends database when all other data for the run is imported from the ELAN software.  Refer to "Recording 
of Data" described above for how to import data into the Frontends database.  The database allows for the 
printing of a run summary report that indicates whether any particular patient-sample results are outside of 
the normal concentration reference range or whether any measurement failed precision limits.  

B. Plotting QC Results 

When the Frontends database is used QC plots are updated automatically when the data are imported 
into the database.  Monitor these plots regularly for any trends in the bench QC results.  If trends are 
observed, contact the laboratory supervisor. 

C. Supervisor Review 

The Frontends database allows the supervisor to review the QC and sample results directly in the 
database.  The data from each analytical run is stored in pdf format on the CDC shared drive under the 
instrument that the analysis was performed on.   

XII. REPLACEMENT AND PERIODIC MAINTENANCE OF KEY COMPONENTS 

A. ICP-MS Maintenance 

Part numbers listed below are PerkinElmer part numbers from their 2010-2011 Consumables Catalog. 

1) Cross-Flow II Replacement Liquid and Gas Tip Ferrules (part #09920518 and #09920515, 
respectively).  Keep at least two spares on hand. 
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2) Injector Support/Torch Base (part #N812-0116).  Keep one spare on hand. 

3) Torch O-Ring Kit (packages of four, part #N812-0100).  Keep four spare packages on hand. 

4) Quartz torch.  At least one spare torch should be on hand (part #N812-2006). 

5) 0.8-mm i.d. sample injector (part #N8126039).  At least one spare injector should be on 
hand. 

6) RF coil (part #WE02-1816).  One spare should be on hand. 

7) Platinum (Pt) Skimmer (part WE027803) and sampler cones (part WE027802).  Keep at 
least two spares of each on hand. 

8) Skimmer and sampler cone O-rings (part #N812-0512 and #N812-0511, respectively).  
Keep at least 10 spares of each on hand. 

9) Series II replacement Ion lens (part #WE018034).  Keep two spares on hand. 

10) Pump oil for the roughing pump (part #N812-2004).  Keep two bottles on hand in general 
lab storage. 

 

B. GC Maintenance 

1) Septa (part # 20654, Supelco, Bellefonte,PA) in the GC injector should be changed weekly. 

2) Glass inlet (part # 2631405, Supelco) in the GC injector should be checked weekly, if 
condensation or any particulates are found (often parts of septa) should be replaced. 

3) GC column (Catalog # N9316076) should be replaced when the quality of chromatographs 
decreases.  

4) GC Transfer Line noncoated column (Catalog # N9301356, S/N 920620,) should be 
changed when the quality of chromatographs worsens.  

5) Graphite ferrules (part # 09903700, Perkin Elmer Instruments, Shelton, CT). 

6) Vu-Union Vespel (part # 20428, Rescek). 

XIII. LIMITS OF DETECTION 

The limit of detection (LOD) for mercury species in blood specimens are calculated using data from ≥60 
separate analytical runs.  To determine this method’s LOD’s, prepared blood samples were used containing 
known amounts of inorganic, methyl and ethyl mercury at four different concentrations (levels #1–4). Level 
#1 had concentrations of each mercury species that were close to the anticipated LOD; Level #4 had 
concentrations ~10X greater than those of Level #1. Upon final completion of this study’s analytical phase, 
the LOD for each species was obtained from summary statistics of the pooled results. The standard deviation 
of pooled results at each level was plotted against its concentration and the points fitted by least squares 
linear regression. The Y-axis intercept (standard deviation), which is in concentration units, is multiplied by 3. 
It is this value that is defined as the LOD. For reporting purposes, results below the LOD are reported as “< 
LOD”. The LOD should be reevaluated every two years.  
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TABLE 13-1: Limits of Detection (LOD)  

Species  
Chemical Name 

Abbreviated Name Limit of Detection, 
g/L 

   
Inorganic Mercury BHGI 0.27 

Methyl Mercury BHGM 0.12 

Ethyl Mercury BHGE 0.16 

   

 

XIV. REPORTABLE RANGE OF RESULTS 

Only analyte results having values within the analytical concentration range may be reported without 
requiring dilution of the sample. The analytical concentration range for this method is LOD to 10 µg/L. 
Samples having results greater than the upper limit of the analytical range must be diluted to bring the 
analyte within the analytical concentration range and reanalyzed using this method. The final result is the 
diluted sample result arithmetically corrected for the dilution. Total mercury concentration values produced 
by DLS 3001 method will be available for the analyst to predict needed dilution factors prior the analysis of 
blood samples by this method (DLS 3020).   

XV. SPECIAL PROCEDURE NOTES - CDC MODIFICATIONS  

None applicable for this operation.  

XVI. QUALITY CONTROL PROCEDURES 

The Inorganic Toxicology and Nutrition Branch uses the method described in this protocol for 
environmental and occupational health screening studies.   

This analytical method uses two types of Quality Control (QC) systems:  With one type of the QC system, 
the analyst inserts bench QC specimens two times in each analytical run (a set of consecutive assays 
performed without interruption) so that judgments may be made on the day of analysis. With the other type of 
QC system, "blind" QC samples are placed in vials, labeled, and processed so that they are indistinguishable 
from the subject samples (as many as possible).  The supervisor decodes and reviews the results of the blind 
specimens. With both systems, taking these samples through the complete analytical process assesses all 
levels of the analyte concentrations. The data from these materials are then used to estimate methodological 
imprecision and to assess the magnitude of any time-associated trends. The bench QC pools used in this 
method comprise two levels of concentration spanning the "low-normal" and "high-normal" ranges for each 
mercury species. Both of these pools are analyzed after the calibration standards, but before any patient 
samples are analyzed so that judgments on the mercury species calibration curves may be made before 
analysis of patient samples. These bench QCs should be analyzed again at the end of the run (no more than 
20 samples). If a second run of = 20 samples are analyzed using the same calibration curve as the first run, 
the QC results obtained from the second run's own bench QC samples need to be analyzed and treated 
independent of the first run. 



Blood mercury species SSID-GC-ICP-DRC-MS IRAT-DLS 

DLS Method Code: 3020 Page 46 of 51 

 

 

A. Establish QC limits for each QC pool.   

Perform an analysis of the mean and standard deviation for each pool from the concentration results 
observed in at least 20 characterization runs. During the 20 characterization runs, analyze samples from 
previously characterized QCs or pools with target values assigned by outside laboratories to evaluate each 
run's QC. In addition to providing QC limits, the characterization runs also serve to establish homogeneity of 
the pools. After the homogeneity of the bench materials is established, analysis by another independent 
reference method (e.g., isotope dilution mass spectroscopy) is useful. 

B. Precision and Accuracy  

QC Results Evaluation.  After completing a run, consult the QC limits to determine whether the run is "in 
control."  The QC rules apply to the average of the beginning and ending analyses of each of the bench QC 
pools.  The QC rules are as follows: 

1) If both the low-and the high-QC results are within the 2s limits, accept the run.  

2) If one of two QC results is outside the 2s limits, apply the rules below and reject the run if 
any condition is met. 

13s - Average of both low QCs OR average of both high QCs is outside of a 3s limit. 

22s - Average of both low QCs AND average of both high QCs is outside of 2s limit on the 
same side of the mean. 

R4s sequential - Average of both low QCs AND average of both high QCs is outside of 2s 
limit on opposite sides of the mean. 

10x sequential - The previous nine average QCs results (for the previous nine runs) were 
on the same side of the mean for either the low OR high QC.  

If the run is declared "out of control," the analysis results for all patient samples analyzed during that run 
are invalid for reporting. 

C. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable Criteria 

If an analyte result for a QC material falls outside of the limits for mean or range, the following steps 
should be taken, if possible:  

 Check the chromatograms for each blank, QC, and sample for proper peak integration and 
identification. Change integration parameters or manually reintegrate peaks, if necessary, and 
reprocess the run in TotalChom™.  

 Setup a new run for the reanalysis of the patient samples affected by the previous failed run. Be sure 
to use freshly prepared QC material.  
 

If these steps do not result in correction of the out-of-control values for QC materials, consult the 
supervisor for other appropriate corrective actions. No analytical results should be reported for runs that are 
not in statistical control. 

XVII. REFERENCE RANGES 

The reference range for each mercury species (see TABLE 17-1) is based on literature reports and from 
periodic review of accumulated data collected during the analysis of blood samples representing a normal, 
healthy population believed to be free of unusual exposure to mercury. Where data is absent or scant, 
references ranges are based on the scientific literature, if available.  
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TABLE 17-1: Reference ranges for Mercury Species  

Species Chemical Name Reference Range1, µg/L 

Inorganic Hg  

Methyl Hg < 10 µg/L (within the established linearity for the method) 

Ethyl Hg2  
1 Above ranges are estimates based on data from the Fourth National Report on Exposure to 

Environmental Chemicals. 
2 There are no established reference ranges for EtHg. 

XVIII. ACTION-LEVEL RESULTS   

The analyst should report any patient results confirmed to be greater than the second upper boundary 
(defined in the laboratory database as the "2UB" and currently 5.8 µg/L) to the QC reviewer as an "elevated 
result".  The protocol for supervisors reporting elevated results to medical personnel is defined according to 
the study protocol.  Levels of concern for mercury in blood are >100 µg/L for children (6 years and younger) 
and >200 µg/L for adults.  These values are based on total mercury results. 

XIX. SPECIMEN STORAGE AND HANDLING DURING TESTING 

Specimens may reach and maintain ambient temperature during analysis.  Take stringent precautions to 
avoid external contamination.  After the samples are analyzed, return them to ≤ –20°C freezer storage as 
soon as possible.  

XX. ALTERNATE METHODS FOR PERFORMING TEST AND STORING 
SPECIMENS IF TEST SYSTEM FAILS 

If the analytical system fails, freezer storage (≤–20°C) is recommended until the analytical system is 
restored functionality. 

XXI. TEST-RESULT REPORTING SYSTEM; PROTOCOL FOR REPORTING 
CRITICAL CALLS (IF APPLICABLE) 

For critical calls, the supervisor should notify the supervising physician or principal investigator as soon 
as possible.  The most expeditious means should be used (e.g., telephone, FAX, or E-mail). 
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XXII. TRANSFER OR REFERRAL OF SPECIMENS; PROCEDURES FOR SPECIMEN 
ACCOUNTABILITY AND TRACKING 

The analyst who receives specimens or samples delivered to Inorganic and Radiation Analytical 
Toxicology Branch sets up a "Specimen Folder."  Fill out a tracking form and place it in the folder to be given 
to the analyst performing the analysis. The form tracks location, status, and final disposition of the 
specimens.   

Use standard electronic record keeping means (e.g., Microsoft Access™, optical disk, or tape backup) to 
track specimens. Maintain records, including related quality assurance (QA) and QC data, for 3 years or 
longer. Keep duplicate records (off site, if sensitive or critical) in electronic or hardcopy format.  Use only 
numerical identifiers (e.g., case ID numbers); all personal identifiers are available only to the medical 
supervisor or project coordinator to safeguard confidentiality. 
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XXIV. APPENDIX 

A. Appendix A.  Critical Parameters Testing Results. 

1. Critical Parameter Test #1:  Evaluate the significance of the GC injector temperature 

a) Test Details (to be repeated for each temperature):  

1) Set up the analysis in accordance with the prescribed method. 

2) Set the injector temperature to 200°C (reduced temperature). 

3) Digest blood QC according to the prescribed method. 

4) Analyze all digested samples together in one run. 

5) Repeat the analysis using a column oven temperature of 220°C (the method prescribed 
temperature). 
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6) Repeat the analysis using a column oven temperature of 230°C (increased temperature). 
 

Critical Parameter Test 1 Results.  Temperature of the GC injector.  One quality control pool was tested.  Tests 
performed 8/5/10 by Mark Fresquez. Results below are the averages of observed results at each condition along with 
the 95th percent confidence intervals (in parentheses).   

QC  
Pool ID 

GC injector Temperature 
(°C ) InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

           200°C  (Reduced) 1.27 
(1.17, 1.38) 

1.04  
(0.99, 1.09) 

1.22 
 (1.14, 1.30) 

   220°C   (Per Method) 1.28 
(1.00, 1.55) 

1.08 
(1.00, 1.16) 

1.32 
(1.27, 1.36) 

     230°C   (Increased) 1.39 
(1.27, 1.51) 

1.09 
(1.02, 1.17) 

1.20 
(1.06, 1.35) 

Expected Range ( ± 2 SD)*    

*Expected range is a determined range calculated from the mean ± 2 SD of a 22 run characterization.  

 

2. Critical Parameter Test #2:  Evaluate the significance of the Combipal-agitator 
equilibration/extraction temperature 

a) Test Details (to be repeated for each temperature):  

1) Set up the analysis in accordance with the prescribed method. 

2) Set the agitator equilibration/extraction temperature to 40°C (elevated temperature). 

3) Digest blood QC according to the prescribed method. 

4) Analyze all digested samples together in one run. 

5) Repeat the analysis using an equilibration/extraction temperature at room temperatures ~ 
25°C (the method prescribed temperature). 

6) Repeat the analysis using an equilibration/extraction temperature of 50°C (increased 
temperature). 

 

Critical Parameter Test 2 Results.  Temperature of the Combipal – agitator equilibration/extraction.  One quality 
control pool was tested.  Tests performed 8/17/10 by Mark Fresquez. Results below are the averages of observed 
results at each condition along with the 95th percent confidence intervals (in parentheses).   

QC  
Pool ID 

Equilibration/Extraction 
Temperature (°C) InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

~ 25°C (Per Method) 1.42 
(1.20, 1.65) 

1.05  
(1.03, 1.07) 

1.17 
 (1.07, 1.27) 

   40°C   (Increased) 1.33 
(1.27, 1.39) 

1.05 
(1.01, 1.09) 

1.17 
(1.11, 1.23) 

     50°C   (Increased) 1.25 
(1.08, 1.42) 

1.07 
(1.05, 1.10) 

1.19 
(1.06, 1.32) 

Expected Range ( ± 2 SD)*    

 

3. Critical Parameter Test #3:  Evaluate the significance of the length of extraction of sample from 
SPME fiber in GC injector  

a) Test Details:  
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1) Set up the analysis in accordance with the prescribed method. 

2) Set the extraction time to 10 minutes (reduced time). 

3) Digest blood QC according to the prescribed method. 

4) Analyze all digested samples together in one run. 

5) Repeat the analysis using an extraction time of 15 minutes (reduced time).  

6) Repeat the analysis using an extraction time of 20 minutes (the method prescribed time). 
 

Critical Parameter Test 3.  Length of extraction time. Test performed 8/18/10 by Mark Fresquez.  Results 
below are the averages of observed results at each condition along with the 95th percent confidence 
intervals (in parentheses).   

QC  
Pool ID 

Sample extraction time 
(minutes) InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

        10 min.   (Reduced) 1.69 
(1.58, 1.80) 

1.02 
(0.97, 1.08) 

1.16 
(1.09, 1.22) 

  15 min.   (Reduced) 1.34 
(1.32, 1.38)        

1.04 
(1.02, 1.05) 

1.20 
(1.18, 1.22) 

     20 min.   (Per Method)  1.33 
(1.32, 1.37) 

1.05 
(1.05, 1.09) 

1.17 
(1.14, 1.18) 

Expected Range ( ± 2 SD)*    

 

4. Critical Parameter Test #4:  Evaluate the significance of changing GC split ratio. 

a) Test Details:  

1) Set up the analysis in accordance with the prescribed method. 

2) Set the split ratio to 20:1 (reduced ratio). 

3) Digest blood QC according to the prescribed method. 

4) Analyze all digested samples together in one run. 

5) Repeat the analysis using split ratio of 28:1 (the method prescribed).  

6) Repeat the analysis using split ratio of 35:1 (increased ratio). 
 

Critical Parameter Test 4.  GC split ratio. Test performed 8/24/10  by Mark Fresquez.  Results below are 
the averages of observed results at each condition along with the 95th percent confidence intervals (in 
parentheses).   

QC  
Pool ID GC split ratio InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

        20:1   (Reduced) 
1.31 

(1.26, 1.36) 
1.06 

(1.02, 1.10) 
1.17 

(1.14, 1.19) 

  28:1  (Per Method) 
1.34 

(1.29, 1.39)        
1.04 

(1.03, 1.05) 
1.15 

(1.13, 1.19) 

     35:1 (Increased)  
1.34 

(1.27, 1.41) 
1.06 

(1.04, 1.08) 
1.17 

(1.15, 1.20) 

Expected Range ( ± 2 SD)*    
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5. Critical Parameter Test #5:  Evaluate the significance of changing GC carrier gas flow rate. 

a) Test Details:  

1) Set up the analysis in accordance with the prescribed method. 

2) Set the flow rate 1.5 mL/min (reduced). 

3) Digest blood QC according to the prescribed method. 

4) Analyze all digested samples together in one run. 

5) Repeat the analysis using a flow rate of 2.0 mL/min (the method prescribed).  

6) Repeat the analysis using a flow rate of 2.5 mL/min (increased). 
 

Critical Parameter Test 5.  GC carrier gas flow rate. Test performed 8/24/10  by Mark Fresquez.  Results 
below are the averages of observed results at each condition along with the 95th percent confidence 
intervals (in parentheses).   

QC  
Pool ID 

GC carrier gas flow rate 
(mL/min)  InHg (µg/L) MeHg (µg/L) EtHg (µg/L) 

QC Pool 
LB07292 

1.5 mL/min  (Reduced) 
1.36 

(1.32, 1.39) 
1.07 

(1.04, 1.10) 
1.16 

(1.14, 1.18) 

2.0 mL/min (Per Method) 
1.31 

(1.25, 1.37)        
1.07 

(1.05, 1.08) 
1.16 

(1.13, 1.19) 

2.5 mL/min (Increased) 
1.35 

(1.31, 1.39) 
1.05 

(1.03, 1.07) 
1.17 

(1.12, 1.21) 

Expected Range ( ± 2 SD)*    
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1. CLINICAL RELEVANCE AND TEST PRINCIPLE  

a. Clinical Relevance 

People encounter arsenic in many chemical forms that vary in toxicity. The most toxic of the 
naturally-occurring arsenic compounds are inorganic forms of arsenic and their monomethylated 
metabolites (1). Less toxic are the organic arsenic compounds (2-5). Exposure to inorganic 
arsenic can result in a variety of adverse health effects, such as skin disorders, nerve impairment, 
cancer of the liver, bladder, kidneys, prostate, and lungs, and even death from large doses (6, 7). 
People may be exposed to inorganic arsenic through activities such as drinking water 
contaminated from geological sources (8-14) or because of occupational exposure (15-19), 
especially breathing air contaminated with sawdust or smoke from wood treated with chromated 
copper arsenic preservatives (20-25). Organic arsenic compounds are generally less toxic and 
may be encountered by ingesting various types of fish, shellfish, or seaweed (26-31).  

The method described in this manual assesses arsenic exposure, as defined by exposure to 
individual arsenic species by analyzing urine through the use of high performance liquid 
chromatography (HPLC) coupled to inductively coupled-plasma dynamic reaction cell-mass 
spectrometry (ICP-DRC-MS). Urine is analyzed because urinary excretion is the major pathway 
for eliminating arsenic from the mammalian body (32-34). This hyphenated method will provide 
accurate quantification of seven urinary arsenic species: arsenite (valence III) and arsenate 
(valence V), organic forms of arsenic to include monomethylarsonic acid (MMA) and 
dimethylarsinic acid (DMA), trimethylarsine oxide (TMAO), arsenocholine (AsCo), arsenobetaine 
(AsB) (see TABLE 1-1).  

b. Test Principle 

The concentrations of arsenate [As(V)], arsenite [As(III)], MMA, DMA, TMAO, AC, and AB are 
determined by using high performance liquid chromatography (HPLC) to separate the species 
coupled to an ICP-DRC-MS to detect the arsenic species. This analytical technique is based on 
separation by anion-exchange chromatography (IC) followed by detection using quadrupole ICP-
MS technology and includes DRC™ technology (35), which minimizes or eliminates many argon-
based polyatomic interferences (36). Column separation is largely achieved due to differences in 
charge-charge interactions of each negatively-charged arsenic component in the mobile phase 
with the positively-charged quaternary ammonium groups bound at the column’s solid-liquid 
interface. Upon exit from the column, the chromatographic eluent goes through a nebulizer where 
it is converted into an aerosol upon entering the spray chamber. Carried by a stream of argon 
gas, a portion of the aerosol is transported through the spray chamber and then through the 
central channel of the plasma, where it is heated to temperatures of 6000-8000° K. This thermal 
energy atomizes and ionizes the sample. The ions and the argon enter the mass spectrometer 
through an interface that separates the ICP, which is operating at atmospheric pressure 
(approximately 760 torr), from the mass spectrometer, which is operating at approximately 10-5 
torr. The mass spectrometer permits detection of ions at each mass-to-charge ratio in rapid 
sequence, which allows the determination of individual isotopes of an element. Once inside the 
mass spectrometer, the ions pass through the ion optics, then through the DRC™, and finally 
through the mass-analyzing quadrupole before being detected as they strike the surface of the 
detector. The ion optics uses an electrical field to focus the ion beam into the DRC™. The DRC™ 
component is pressurized with an appropriate reaction gas and contains a quadrupole. In the 
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DRC™, elimination or reduction of argon-based polyatomic interferences takes place through the 
interaction of the reaction gas with the interfering polyatomic species in the incoming ion beam. 
The quadrupole in the DRC™ allows elimination of unwanted reaction by-products that would 
otherwise react to form new interferences.  

TABLE 1-1: SPECIES OF ARSENIC  

Name Abbreviation Structural Formula pKa 

Arsenobetaine AB 

 

- 

Arsenocholine AC 

 

- 

Monomethyl arsonic acid MMA 

 

4.1, 8.7  

Dimethylarsinic acid  DMA 

 

6.2 

Trimethylarsine oxide TMAO 

 

- 

Arsenic (V) acid  
(arsenate) 

As(V) 

 

2.2, 7.0, 11.5 

Arsenous (III) acid  
(arsenite) 

As(III) 

 

9.2, 12.1, 13.4 

 

As
+

CH3

CH3

CH3

CH2COOH
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+

CH3

CH3

CH3

CH 2CH 2OH

As
(V)
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O

OH
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2. SAFETY PRECAUTIONS 

Precautionary information that is important to protecting personnel and safeguarding 
equipment will be presented inside a box, such as this one, throughout the procedure 
where appropriate.  

 
Follow universal precautions.  Wear gloves, a lab coat, and safety glasses while handling human 
blood, plasma, serum, urine or other bodily fluid or tissue. Place disposable plastic, glass, and 
paper (e.g., pipette tips, autosampler tubes, and gloves) that come in contact with human 
biological fluids, such as urine, in a biohazard autoclave bag. Keep these bags in appropriate 
containers until they are sealed and autoclaved. When work is finished, wipe down all work 
surfaces where human biological fluid was handled with a 10% (v/v) sodium hypochlorite solution. 
Dispose of all biological samples and diluted specimens in a biohazard autoclave bag at the end 
of the analysis according to CDC/DLS guidelines for disposal of hazardous waste. 

PerkinElmer provides safety information that should be read before operating the instrument.  
This information is found in the PerkinElmer ELAN® 6100 ICP-DRC-MS System Safety Manual.  
Possible hazards include ultraviolet radiation, high voltages, radio-frequency radiation, and high 
temperatures. 

Caution! 
Exercise caution when handling and dispensing concentrated nitric acid.  Always 
remember to add acid to water.  Nitric acid is a caustic chemical that is capable of severe 
eye and skin damage.  Wear powder-free gloves, a lab coat, and safety glasses.  If nitric 
acid comes in contact with any part of the body, quickly wash the exposed area with 
copious quantities of water for at least 15 minutes. 

3. DATA SYSTEM MANAGEMENT 

To maintain the integrity of specimen and analytical data generated by this method, eliminate 
hand entry of specimen identifiers or analytical results whenever possible, proofread all 
transcribed data, and regularly back up the ICP-MS computer’s hard drive. It is recommended 
that a defragmentation program be run on the computer’s hard drive on a periodic basis.  

a. Data Entry and Transfer 

Whenever possible, use bar code scanners to enter sample identifiers into the ICP-DRC-MS 
computer software to avoid errors associated with the keyboard-entry process and to speed up 
sample processing.  When bar code scanners cannot be used, proofread transcribed data after 
entry.  Handle or transfer data electronically when reporting or moving data to other computerized 
data-handling software.  In the Inorganic and Radiation Analytical Toxicology Branch, sample 
analysis results generated by this method are stored for long periods in Microsoft Access™ or MS 
SQL Server 7™ database software.  The results should include at least the analysis date, 
analytical run number, quality-control (QC) results for the run, results of specimen analysis by 
specimen identification (ID), and method identifier. 
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b. Routine Computer Hard Drive Maintenance 

Defragment the computer hard drive by using software such as Microsoft Windows® Disk 
Defragmenter (located in Start > Programs > Accessories > System Tools) or an equivalent 
program to maximize computer performance and maintain data integrity for files on the hard 
drive.  An entry will automatically be made in the Windows™ system event log when this process 
is done providing documentation of this step. 

c. Data Backup 

(1) Schedule of Data Backups 

Weekly. Full data backups onto one or more recordable compact discs (CD-R) or digital 
video discs (DVD).  

Daily. Full data backups onto an external hard drive.  

(2) Backup Procedures 

Whenever making a backup (daily or weekly) include the directories and subdirectories: 

 C:\elandata (include all subdirectories) 

 C:\hplc (include subdirectories “data” and “methods as well as other relevant 
directories) 

 Other relevant folders. 

Before making weekly backups, saving a copy of the Windows™ event log in the active 
“elandata” directory will ensure archiving of all recent software system events (including 
communications between ICP-DRC-MS and ELAN® software, as well as times of hard 
drive defragmentation, and other Windows™ system events). 

(a) External Hard Disk Backups 

 Connect the ELAN data system computer to an external hard disk with 
sufficient storage capacity to store several copies of the backup files (≥18 
gigabytes).  

 Configure Microsoft Windows® Backup™ (located in Start > Programs > 
Accessories > System Tools) program to do a daily backup of the ELAN data 
system computer’s data directories (see Backup Procedures) 

(b) Compact Disc Backups 

 Use CD-R disks only (recordable compact disks), not CD-RW disks 
(rewritable compact disks) so that after creation the recordable compact disk 
cannot be over-written. 

 Use Adaptec “Easy CD Creator”™ or equivalent software to backup.  
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(c) Removing Data from the ICP-DRC-MS Computer Hard Drive 

When the active “elandata” and “hplc” directories on the ICP-DRC-MS computer 
hard drive becomes too large to fit onto a single CD-R, remove the oldest data on 
the hard drive so that a regular backup can be done onto a single CD-R.  
Usually, this procedure can be done annually. 

 Back up the oldest data on the hard drive in duplicate onto two CD-R disks.  
Manually select each dataset folder (subdirectories under 
“C:\elandata\dataset” and “C:\hplc\data”) and other relevant files (i.e., 
optimization, tuning, and sample files) that are to be included on these 
backups.   

 Verify that backup CD-R disks operate correctly before deleting any data 
from the hard drive. To verify the operation of a CD-R disk, open any file on 
the disk by using the appropriate computer software (ICP-DRC-MS 
software).  

 After verifying that all backups are operational, delete the original data from 
the hard drive. 

 Keep one copy of the CD-R disk in a building other than the laboratory (in 
case of fire).  Keep the other near the ICP-MS laboratory.  
 

(d) Backup of Sensitive Data 

Make a backup for sensitive data on duplicate, recordable compact disk. Store 
the two CD-R disks in two different buildings. 

d. Documentation of System Maintenance  

Computer Maintenance:  Record any maintenance of computer hardware, HPLC or 
ICP-DRC-MS software in the instrument logbook.  Place other electronic records relating 
to integrity of the data and hard drive in the Windows™ event log.  Back up the event log 
on a regular basis by saving a copy in the active “elandata” directory.  The event log will 
then be backed up along with the ELAN data when backup CD-R disks and tapes are 
made. 
Instrument Maintenance: Document system maintenance in hard copies of data records 
(i.e., daily maintenance checklists, PerkinElmer service records, and instrument log book) 
as well as in electronic records relating to instrument optimization (*dac) and tuning 
(default.tun). 

4. COLLECTING, STORING, AND HANDLING SPECIMENS; CRITERIA 
FOR REJECTING SPECIMENS 

a. Specimen Type 

Specimen type is human urine. No special instructions for fasting or special diets are required of 
patient or study subjects.  
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b. Specimen Collection, Handling, and Storage 

Optimal amount of specimen is 0.5 mL; the minimum is 0.25 mL. Use sterile specimen containers 
for specimen acquisition. Acceptable containers for allotment of urine for this method include 5.0-
mL polypropylene cryogenic vials (e.g., Nalgene, Item # 5000-0050).  Screen lots of specimen 
collection cups, containers, and sample tubes for total arsenic contamination before use.  

Specimen handling conditions are outlined in the Division of Laboratory Science’s protocol for 
urine collection and handling.  To prevent inter-conversion of arsenic species, immediately store 
or transport urine specimens at  -20C.  Upon receipt, they must remain frozen at  -20°C until 
time for analysis.  Refreeze at  -20C portions of the sample that remain after analytical aliquots 
are withdrawn.  Samples thawed and refrozen several times may be compromised.   

c. Criteria for an Unacceptable Specimen 

The criteria for an unacceptable specimen are low volume sample volumes (< 0.25 mL), 
suspected contamination due to improper collection procedures or collection devices, and/or 
contamination during sample preparation/analysis.  Specimen contact with dust or dirt may 
compromise test results. In all cases, request a second urine specimen, if possible.   

5. PROCEDURES FOR MICROSCOPIC EXAMINATIONS 

Not applicable for this procedure. 

6. CHEMICALS, STANDARDS, AND QUALITY CONTROL MATERIAL 

a. Chemicals and Standards 

1. Water, high purity ( ≥ 18 Mcm resistivity).  

2. Ammonium carbonate, (CAS# 506-87-6), MW 96.09, GFS Chemicals, Item 
#839-12471, or equivalent. 

3. Tris(hydroxymethyl)aminomethane, (CAS# 77-86-1), MW 121.14, Bio-refined, 
GFS Chemicals, Item # 1948-75811, or equivalent. 

4. Ammonium Sulfate, (CAS# 7783-20-2), MW 132.13, GFS Chemicals, Item # 
1906-13341, or equivalent.  

5. Ammonium Acetate, (CAS# 631-61-8), MW 77.08, GFS Chemicals, Item # 
547-12401, or equivalent.  

6. Acetic Acid, Glacial (CAS# 64-19-7) M.W. 60.05, GFS Chemicals Inc., Item # 
624, or equivalent.  

7. Ammonium Hydroxide, (CAS# 1336-21-6) M.W. 35.05, Fisher Scientific, Item 
# A470500, or equivalent. 

8. Methanol (CAS# 67-56-1) M.W. 32.04, GFS Chemicals, Item # 2483-50441, 
or equivalent.  

9. 10% hydrogen in argon gas mixture, ≥ 99.999% purity, Matheson Tri-Gas 
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Products, San Jose, California, or equivalent.  

10. Double-distilled nitric acid, GFS Chemicals, or equivalent.  

11. 1,000 mg/L Gallium, SPEX CertiPrep, Item # PLGA2-2Y, or any equivalent 
traceable to the National Institute for Standards and Technology. 

12. Certified pH 7 and pH 10 calibration solutions. 

13. Liquid argon.  

14. Acetonitrile, HPLC or Spectrophotometer grade, GFS Chemicals, or 
equivalent.  

15. Bleach (10% sodium hypochlorite solution) from any vendor. 

16. Base urine pooled from anonymous donors or purchased from a vendor. 

17. Potassium Persulfate, purified GFS Chemicals, Item #61712, or equivalent.  

b. Standards 

The following is a list of possible sources of material for the seven arsenic species.    A 
mixture of the sources is used at any given time to provide calibration material that is from 
different sources.  Other sources can be used, and please note that the availability of the 
sources listed is subject to change without notice. 

1. Arsenic (III) oxide, As2O3, CAS 1327-53-3, MW 197.84, Sigma-Aldrich, Item # 
202673, or equivalent. 

2. Arsenic (III) speciation standard in 2%HCl, Spex CertiPrep, Item # SPEC-
AS3, or equivalent. 

3. Arsenic (V) oxide hydrate, As2O5·xH2O, CAS 12044-50-7, MW 229.84, Sigma-
Aldrich, Item # 363456, or equivalent source or vendor. 

4. Arsenic (V) speciation standard in water, Spex CertiPrep, Item # SPEC-AS5, 
or equivalent. 

5. Arsenobetaine, (CH3)3AsCH2COOH, CAS 64436-13-1, MW 178.06, Sigma-
Aldrich, Item # 11093, or equivalent.  

6. Arsenobetaine, (CH3)3AsCH2COOH, CAS 64436-13-1, MW 178.06, Wako 
USA, Item # 321-34911, or equivalent.  

7. Arsenobetaine, (CH3)3AsCH2COOH, CAS 64436-13-1, MW 178.06, Argus, 
Vernio, Italy, Item # AR60008, or equivalent.  

8. Arsenocholine bromide, (CH3)3AsCH2CH2OH·Br, MW 244.99, Argus, Vernio, 
Italy, Item # AR60010, or equivalent.  

9. Arsenocholine bromide, (CH3)3AsCH2CH2OH·Br, MW 244.99, Wako USA, 
Item # 328-34921, or equivalent. 

10. Dimethylarsinic acid, (CH3)2As(OH)2, MW 138.01, Sigma-Aldrich, Item # PS-
51, or equivalent. 

11. Cacodylic Acid, (CH3)2As(O)OH, CAS 75-60-5, MW 138.00, Sigma-Aldrich, 
Item # 20835-10G-F, or equivalent. 

12. Disodium methyl arsenate, CH3AsO3·6H2O, CAS 144-21-8, MW 291.9, 
Sigma-Aldrich, Item # PS-281, or equivalent.  



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 8 of 107 

 

 

13. Monosodium acid methane arsonate sesquihydrate, CAS 2163-80-6, Sigma-
Aldrich, Item #, PS-429, or equivalent. 

14. Trimethylarsine oxide, (CH3)3AsO, CAS 4964-14-1, MW 136.03, Argus 
Chemicals, Vernio, Italy, Item # AR60011, or equivalent.  

15. Trimethylarsine oxide, (CH3)3AsO, CAS 4964-14-1, MW 136.02, Wako USA, 
Item # 321-34891, or equivalent. 

c. Quality Control Material 

Quality control (QC) material is made from pools of human urine collected from several 
anonymous donors. See the “Error! Reference source not found. section of this method for 
details of preparation. The two urine QC pools made for arsenic speciation are designated as:  

QC level QC Designation ID 

low pool LU-yy### 

high pool HU-yy### 

 

Where yy is the last two digits of production year and ### is the assigned pool identification 
number. 

QC material that is to be used for bench quality control purposes will need to be “characterized” 
as described in the section Establish QC limits for each QC pool. 

7. INSTRUMENTATION, EQUIPMENT, SOFTWARE, AND SUPPLIES 

a. Instrumentation 

(1) HPLC System 

1. HPLC Pump, specifically, PerkinElmer® Series 200™ Pump, made with 
biocompatible materials consisting of polyethylethylketone (PEEK) and other 
polymers in the fluid path (PerkinElmer LAS), or equivalent.  

2. HPLC Autosampler, specifically, PerkinElmer® Series 200™ Autosampler, 
made with biocompatible materials consisting of PEEK and other polymers in 
the fluid path (PerkinElmer LAS), or equivalent.  

3. Autosampler temperature cooling tray for 100 samples, specifically, 
PerkinElmer® Series 200™ Peltier Cooling Tray and Assembly, or equivalent.  

4. Column oven, specifically, PerkinElmer® Series 200™ Column Oven, or 
equivalent.  

5. Chromatography data handling software, specifically, TotalChrom™ 
Workstation, version 6.0.2 or later (PerkinElmer LAS), or equivalent.  

6. Anion-exchange HPLC column, specifically, PRP-X100™, 4.6 X 150 mm 
dimensions, 5 µm particle size in PEEK hardware, Hamilton Company, Item # 
79174, or equivalent.  

7. Autosampler injection needle, stainless steel, PerkinElmer LAS, Item # 
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N2930023, or equivalent.  

8. Autosampler injector loop, 20 µL, IDEX Health & Science, Item # 9055-022, or 
equivalent.  

9. Autosampler injector loop, 200 µL, IDEX Health & Science, Item # 9055-025, 
or equivalent.  

10. Electrically-activated 6-port switching valve, IDEX Health & Science, Item #  
EV750-100-S2, or equivalent.  An additional switching valve may also be used 
as demonstrated in Section 8.  Instrument Setup and Configuration.      

 

(2) ICP-DRC-MS System 

1. Inductively-coupled plasma mass spectrometer, specifically, the ELAN™ DRC 
II with Dynamic Reaction Cell (DRC™) capability, PerkinElmer LAS, or 
equivalent.  

2. ELAN instrument control and data handling software, version 3.0 or greater, 
PerkinElmer LAS. 

3. Cyclonic spray chamber, PerkinElmer LAS, or equivalent. 

4. Concentric glass nebulizer, Precision Glassblowing, Item # 500-70QQDAC, or 
equivalent.  

5. External peristaltic 4-channel peristaltic pump, “Minipuls 3”, Gilson Inc., , or 
equivalent.  

b. Equipment  

1. Water purification system for providing ultrapure water with a resistivity ≥18 
Mcm.  

2. Eppendorf® Model 5417R refrigerated centrifuge fitted with FA45-24-11 fixed 
angle rotor or equivalent refrigerated centrifuge capable of ≥18,000 rcf for 
centrifugation of 1.5 mL capacity microcentrifuge tubes.  

3. High-precision analytical balance capable of accurately weighing milligram 
amounts of material to the tenth of a milligram or better.  

4. Analytical balance for routine weighing of material to the nearest hundredth of 
a gram and with a loading capacity of at least 200 g.  

5. pH meter with one hundredths of a pH unit readout or better, fitted with glass 
electrode (pH probe).    

6. Temperature compensation probe for pH meter.  

7. Gilson 402™ Programmable Diluter-Dispenser (or equivalent) equipped with 
10.0-mL dispensing syringe and a 2-mL sampling syringe. 

8. Calibrated hand-held adjustable pipetters that cover the range of accurate 
liquid delivery from 50 µL to 5000 µL. Research Pro™ Eppendorf® electronic 
programmable pipetters (Fisher Scientific), or equivalent.  

9. “Repeater Plus” Pipetter, Fisher Scientific, Item # 2226020-1, , or equivalent 
pipetting device(s) capable of accurately dispensing multiple microliter 
aliquots of liquid.    
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10. Gas regulator for 10% DRC gas, Matheson Tri-Gas Products, or equivalent. 

11. Gas regulator for argon gas, Matheson Tri-Gas Products, or equivalent. 

12. Ethos EZ microwave Digestion Labstation with PRO-24 High Throughput 
Rotor, Milestone, Inc.,  or equivalent. 

c. Computer Software 

1. pdFactory Pro 1.52 or later version, FinePrint Software, LLC, 
www.fineprint.com or equivalent. This product is used for creating electronic 
Portable Document Files (pdf) directly from Microsoft® Windows print dialog 
box.  

2. A custom Microsoft Excel® macro procedure named “Extract TC Data”. See 
Macro Procedure “Extract TC Data” section in the Appendix for description 
and macro code.  

d. Supplies 

1. 2-200 L pipette tips, 960 tips per case, Fisher Scientific,  Item # 05-403-66, 
or equivalent.  

2. 20-300 L pipette tips, 960 tips per case, Fisher Scientific, Item # 05-403-67, 
or equivalent. 

3. 50-1000 L pipette tips, 960 tips per case, Fisher Scientific, Item # 05-403-68, 
or equivalent. 

4. 5 mL pipette tips, 500 tips per case, Fisher Scientific, Item # 05-403-117, or 
equivalent. 

5. Acid-cleaned 2 liter polyethylene (PE) bottles.  To acid-wash containers, rinse 
with 10% (v/v) reagent-grade nitric acid, followed by rigorous rinsing with 18 
Mcm water.  Repeat this process several times depending on prior use of 
the containers.  

6. Acid-cleaned 1 liter PE bottles.  To acid-wash containers, rinse with 10% (v/v) 
reagent-grade nitric acid followed by rigorous rinsing with 18 Mcm water.  
Repeat this process several times depending on prior use of the containers. 

7. Four acid-cleaned 500 mL PE bottles.  To acid-wash containers, rinse with 
10% (v/v) reagent-grade nitric acid followed by rigorous rinsing with 18 Mcm 
water.  Repeat this process several times depending on prior use of the 
containers.  

8. Acid-cleaned 100 mL PE bottles.  To acid-wash containers, rinse with 10% 
(v/v) reagent-grade nitric acid followed by rigorous rinsing with 18 Mcm 
water.  Repeat this process several times depending on prior use of the 
containers. 

9. 1.5 mL polypropylene (PP) microcentrifuge tubes, Fisher Scientific, Catalogue 
# 05-402, or equivalent.  

10. Tube racks for 1.5 mL microcentrifuge tubes (approximately 6), Fisher 
Scientific, 05-405-3, or equivalent.  

11. Vial rack for HPLC autosampler vials, 50-position, Fisher Scientific, Item # 03-
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375-9, or equivalent.  

12. Five or more flangeless ferrules, “blue” for 1/16” O.D. tubing, ChromTech or 
IDEX Health & Science,  Item # P-200X, or equivalent.  

13. Five or more “FingerTight III” HPLC “Tefzel” fittings, 10-32 threading, for 1/16” 
O.D. tubing, ChromTech or IDEX Health & Science Item # F-300X, or 
equivalent. 

14. Repeater pipetter tips, “Combitips Plus” 5 mL, Fisher Scientific, Item # 21-381-
330, or equivalent.  

15. HPLC tubing, 0.007” I.D. X 1/16” O.D., polyethylethylketone (PEEK), 5 feet 
length.  

16. Peek sample uptake fitting, Analytical West, Item #500-QD-PEEK, or 
equivalent 

17. Tubing, 0.03” I.D. X 1/16” O.D., polypropylene (PP), 5 feet length.  

18. Four “end-of-tubing” prefilters (10 µm) for each HPLC reservoir bottle, 
(ChromTech or IDEX Health and Science, Item # A-438, or equivalent.  

19. In-line HPLC post-pump filter (2 µm), ChromTech or IDEX Health and 
Science, Item # A-430, or equivalent.  

20. Luer fitting plastic syringe, 10 mL or larger.  

21. Kay-Dry™ paper towels and Kim-Wipe™ tissues (Kimberly-Clark Corp., 
Roswell GA, or equivalent vendor). 

22. Teflon™-coated magnetic stirs bars (2), VWR, Item #58948-974, or 
equivalent. 

23. Cotton swabs (Hardwood Products Co. ME), or equivalent. 

24. Nitrile, powder-free examination gloves (N-Dex®, Best Manufacturing Co., 
Menlo, GA), or equivalent. 

25. Biohazard autoclave bags (Curtin-Matheson Scientific, Inc., Florence, KY), or 
equivalent. 

26. 15 mL 15 ml (# 352097) and 50 ml (#352098) polypropylene centrifuge tubes 
or equivalent:  Becton Dickinson Labware or equivalent. 
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8. INSTRUMENT SETUP AND CONFIGURATION 

a. HPLC Hardware Setup 

A PerkinElmer representative should perform the first installation of the Series 200™ HPLC 
system. If the instrument has been moved, laboratory personnel can assemble and configure the 
system according to the PerkinElmer supplied user manuals for the Series 200 LC Pump and the 
Series 200 Autosampler. The following should be considered in planning a new location: 

1. Two 6-outlet A/C power strips rated for 15-amp duty will be required to plug-in 
all HPLC equipment and its associated components.  

2. The HPLC equipment needs to be placed adjacent to the right side of the ICP-
DRC-MS instrument. Allow for approximately 4 feet of bench space for the 
HPLC equipment and data processing computer.  A bench height of 32–34 
inches is optimal.  

3. HPLC components need to be arranged, from left to right, in the following 
order:  

(a) Six-port switching valve “#1” (EV750-100) 

(b) Six-port switching valve “#2” (EV750-100-S2).  This switching valve must 
have a serial port for connection to an external desktop computer. 

(c) Column oven 

(d) Pump with autosampler. Set the autosampler on top of the pump.   

4. Replace the existing injection sample loop with a 20 µL loop.  

5. Replace autosampler needle with one made of stainless steel (PerkinElmer 
P/N N293-0023), if it does not already have one.  Titanium needles are 
unsuitable due to their potential to be a source of arsenic contamination. Refer 
to the PerkinElmer Series 200 LC Autosampler user manual for instructions 
on needle replacement.  

6. Replace all stainless steel HPLC tubing following the HPLC pump’s purge port 
with “yellow” PEEK tubing, 0.007” I.D. X 1/16” O.D. Use “yellow” PEEK tubing 
for the remainder of the fluid path. Keep tubing lengths short but long enough 
to allow the connected components to be moved if necessary.  

7. Install a PEEK construction in-line filter (10 µm) between the HPLC pump and 
the autosampler.  

8. Do not use the column oven’s stainless steel tubing to preheat the mobile 
phase before it enters the column. The preheating is unnecessary and the 
extra tubing length will not help the quality of the chromatography.  

9. Attach via a plastic tie clamp (or equivalent) one end of a given length of ¼” 
diameter Tygon™ tubing to the end of the bench holding the HPLC 
equipment. Position the other end of this Tygon™ tubing to  empty into a large 
waste jug. Position this tubing close enough to the 6-port switching valves so 
that HPLC drain tubing from ports 5 and 6 on switching valves #1 and #2, 
respectively, will easily fit into the Tygon tubing.  Ports 5 and 6, discussed in 
“e. Six-port Switching Valves”, are dedicated for effluent waste.   
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b. Software Installation 

The ELAN Instrument Control version 3.0 or greater should be already installed on the computer 
controlling the ELAN DRC II™. If it is not, contact a PerkinElmer service representative to get the 
latest version of the software.  

It is preferable to install PerkinElmer’s TotalChrom™ Workstation package on the same computer 
that contains the ELAN Instrument Control software*. It is advised that a PerkinElmer 
representative install and initially configure TotalChrom™. Alternatively, laboratory personnel can 
install and configure TotalChrom themselves by following instructions contained in TotalChrom 
Workstation User’s Guide, or by getting help from PerkinElmer Technical Services. As part of 
installing TotalChrom™, create a folder named “hplc” on the root level of the C drive. Create the 
following subfolders inside the “hplc” folder: “methods”, “data”, “optimization”, and “reports”. Feel 
free to create additional subfolders as the need arises. This method assumes that version 6.2.0 of 
TotalChrom™ Workstation package is installed.  

ChromLink™ 2.0 or a greater version (PerkinElmer LAS) is installed into its own program folder. 
The installation of ChromLink™ is quick and straightforward when using the supplied installation 
utility.  

pdFactory Pro 1.52 or a greater version (FinePrint Software, LLC) is software used for creating 
electronic Portable Document Files (PDF). Documents are “printed” from the Microsoft® Windows 
print dialog box, but instead of printing on paper, the document appears on the screen in preview 

                                                      
* Raw signal versus time data is collected by the ELAN software and stored on ELAN controller computer’s 
hard drive as a “NetCDF” file before it is read by the TotalChrom Workstation software. For the purposes of 
this arsenic speciation method, TotalChrom Workstation is used only for post-run data processing and is not 
used to operate the HPLC or the ELAN DRC. 
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form.  The document can then be either printed in hardcopy or saved to a hard drive or disk as a 
PDF file.   Because of the “trial and error” nature of solving chromatographic integration 
challenges, frequent reprocessing (and reprinting) may be required.  In these instances, 
generating PDF documents with the option to print a hardcopy becomes an indispensable tool.  

c. Peristaltic Pump Setup 

An external peristaltic pump offers a number of advantages over the peristaltic pump built into the 
ICP-DRC-MS. It can be started, stopped and its speed set independent of the ICP-DRC-MS 
control software. This “feature” is important when one considers that the HPLC pump “knows 
nothing” about the state of affairs beyond the HPLC system, and it will continue to pump mobile 
phase regardless of whether the spray chamber is being drained or not. Likewise, the built-in 
peristaltic pump is under ELAN software control only and cannot be operated in manual mode. 
While it is feasible to configure the ELAN software to force the built-in peristaltic pump to keep 
emptying the spray chamber after completing an analysis, it is nonetheless easy to make a 
mistake during the ELAN program setup. The built-in pump’s timing and speed is set in the 
ELAN’s sample file and not the method file. The sample file is created each time before a batch 
run posing the risk that the built-in peristaltic pump’s timing and speed could be set up incorrectly 
or forgotten by the analyst. If this happens, the software will stop the built-in peristaltic pump well 
before the HPLC pump stops, causing the spray chamber to flood and the plasma to be 
extinguished by mobile phase. It is quite possible for the HPLC to pump mobile phase for an 
extended time before it auto-stops causing extensive flooding of the torch box and the ICP-DRC-
MS which can result in damage to the instrument electronics which can only be stopped manually 
because it is not under instrument control. Set up a 4-channel peristaltic pump (Gilson “Minipuls 
3” or equivalent) on the ICP-DRC-MS spray chamber shelf behind the spray chamber.  

1. Do not connect the peristaltic pump to the control computer; connect the 
pump to A/C power only. Run the pump in manual mode only.  

2. Designate one clamp area of this pump for nebulizer waste tubing and a 
separate clamp area of this pump for post-column internal standard tubing.  

d. Electrical Connections 

Make the necessary electrical connections between specific I/O terminals of the HPLC 
autosampler, the pump, the ICP-DRC-MS, and the 6-port switching valves. The event I/O 
terminals are prominently labeled and are located on the right side of each instrument.  For the 6-
port switching valves, the terminals are located on the back of each unit.   

1. Between the HPLC pump and the autosampler, use two 12 inch long common 
telephone wires with RJ-11 connectors to connect: 

(a) The HPLC pump’s terminal labeled “RDY” to the HPLC autosampler’s 
terminal labeled “RDY IN”, and  

(b) The HPLC pump’s terminal labeled “EXT RUN” to the HPLC 
autosampler’s terminal labeled “INJ 1”.  

2. Use the supplied cable (PerkinElmer LAS Item # B3001203) to connect the 
Pump’s “RUN OUT” terminal to the ICP-DRC-MS’s “AUXILLARY I/O”.  

3. Use the supplied cable (PerkinElmer LAS Item # N2600418) to connect the 
Pump’s “TE 1” terminal to the electrically-activated terminal block I/O on the 
back of 6-port switching valve #1.   
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4. Use a standard serial cable to connect an external desktop computer to the 
back of 6-port switching valve #2. 

e. Six-Port Switching Valves 

Each 6-port switching valve’s DIP switches need to be configured upon initial installation.  If the 
switching valves are not put into “pulse mode”, the units will not respond to the ~1 second contact 
closure from the PerkinElmer Series 200 HPLC autosampler. This only needs to be done once for 
each new unit. (Note that settings of the front panel buttons should be checked before the start of 
each chromatographic run.)  For each 6-port switching valve: 

1. Turn the switching valve unit upside down and remove the 4 screws using a 
Philips head screwdriver. Remove the metal cover and look for DIP switch 
“SW3” on the printed circuit board. Use a small flat-head screw driver or the 
tip of a pen to adjust the position of each switch so it matches the following 
illustrations.  These illustrations apply to both EV750-100 and EV750-100-S2.   

 

Rheodyne® EV750-100 DIP Switch “SW3” 

DIP switch # 1 2 3 4 5 6 7 8 

Position up up down down down up up down 

2. Screw the cover back on the switching valve unit. For switching valve #1, 
connect the timed event wire leads that come from the “TE1” timed event 
output on the Series 200 HPLC pump to I/O junctions #4 and GND on the 
back of the EV750-100 (order of connection of colored wires does not matter). 
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3. For switching valve #2, connect a standard serial cable from a desktop 
computer to the serial port on the back of the EV750-100-S2.  Aside from the 
power cord, this is the only cable which will be attached to switching valve #2.   

4. Position both 6-port switching valves close to and on the left side of the HPLC 
Series 200 Column Oven, adhering to the order listed in Section 8.a.3. Using 
supplied HPLC pressure fittings, make HPLC tubing connections to the 
appropriate ports as described in TABLE 8-1-A and TABLE 8-1-B. 

 

TABLE 8-1-A: TUBING CONNECTIONS ON EV750-100 

Valve  
Port 

Flow Direction Tubing  
Description From To 

#1 Valve Port #1 Sample Loop PEEK (200 µL loop) 

#2 Valve Port #2 on 
EV750-100-S2 

Valve Port #2 HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#3 Valve Port #3 Nebulizer PEEK Sample Uptake 
Fitting 

#4 Sample Loop Valve Port #4 PEEK (200 µL loop) 

#5 Valve Port #5 Waste PP or PFA Tubing,  
0.03” i.d., 1/16” o.d.,  

#6 Internal Standard 
(via external 

peristaltic pump) 

Valve Port #6 PP or PFA Tubing,  
0.03” i.d., 1/16” o.d.,  

 
 

TABLE 8-1-B: TUBING CONNECTIONS ON EV750-100-S2 

Valve  
Port 

Flow Direction Tubing  
Description From To 

#1 HPLC column Valve Port #1 HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#2 Valve Port #2 Valve Port #2 on 
EV750-100 

HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#3 Line-In for 
Various Solutions 

(via ICP-MS 
peristaltic pump) 

Valve Port #3 PP or PFA Tubing,  
0.03” i.d., 1/16” o.d., 

#4 Valve Port #4 bridge HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#5 bridge Valve Port #5 HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#6 Valve Port #6 Tygon™ Waste 
Line 

PP or PFA Tubing,  
0.03” i.d., 1/16” o.d., 
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5. Plug-in the A/C power adapter to the back of each unit and into a regular 
110V outlet. The switching valve will automatically come on and one of the 
diode indicators will light up. Press the “Local/Remote” button on the front of 
the unit so that the top yellow indicator light is on.  

(a) For Switching Valve #1: Press the left arrow button until the LCD display 
indicates “1”. Press the “Local/Remote” button again so that the bottom 
green indicator light is now on, representing “remote.” 

(b) For Switching Valve #2: Press the left arrow button until the LCD display 
indicates “2.”  Ensure that the top yellow indicator light is on, 
representing “local.”    

Note: These LCD positions are for a typical HPLC-ICP-DRC-MS analysis 
run.  Users may toggle between “local” and “remote” and positions “1” and 
“2”, for instrument optimization or other tasks.   

6. The switching valves are now ready for operation.   
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9. STANDARD PROCEDURE 

a. Preparation of Stock Solutions 

1. 0.5 M Ammonium Acetate, pH 5.  Dissolve 27.2 g of ammonium acetate and 
8.0 mL of glacial acetic acid into approximately 950 mL of 18 Mcm water. 
Adjust pH to 5.0 by adding concentrated glacial acetic acid drop-wise. 
Complete volume to 1000 mL with 18 Mcm water. Mix thoroughly. Expires 
in 1 year. Prepare ahead of time or as needed. 

2. 0.1 M Ammonium Acetate, pH 5. Dissolve 5.44 g of ammonium acetate and 
1.68 mL of concentrated glacial acetic acid into approximately 950 mL of 18 
Mcm water. Adjust pH to 5.0 using drop wise additions of either 10% 
ammonium hydroxide or glacial acetic acid. Complete volume to 1000 mL with 
18 Mcm water. Mix thoroughly. Expires in 1 year. Prepare ahead of time or 
as needed.  Note: This solution is not prepared as a dilution of 0.5 ammonium 
acetate, pH 5. 

3. 0.5 M Ammonium Carbonate. Dissolve 48.05 g of ammonium carbonate into 
approximately 900 mL of 18 Mcm water. Complete volume to 1000 mL with 
18 Mcm water. Mix thoroughly.  Expires in 1 year. Prepare ahead of time or 
as needed.  

4. 0.5 M TRIS Buffer. Dissolve 60.57 g of tris(hydroxymethyl)aminomethane in 
approximately 900 mL of 18 Mcm water. Complete to 1000 mL with 18 
Mcm water. Mix thoroughly.  Expires in 1 year. Prepare ahead of time or as 
needed. 

5. 0.5 M Ammonium Sulfate. Dissolve 66.07 g of ammonium sulfate in 
approximately 900 mL of 18 Mcm water. Complete to 1000 mL with 18 
Mcm water. Mix thoroughly.  Expires in 1 year. Prepare ahead of time or as 
needed. 

6. 5% Acetonitrile. To make autosampler rinse solution, add 50 mL of 
acetonitrile (HPLC or Spectrophotometer grade) to 950 mL of 18 Mcm 
water. Mix thoroughly. Expires in 1 year. Prepare ahead of time or as needed.    

b. Preparation of Matrix-Matched Material (“Base Urine”) 

Collect human urine from anonymous donors following the same collection procedure 
used for the preparation of QC material. Assay each donation for, if possible, speciated 
arsenic or, alternatively, for total arsenic. Exclude urine donations that exceed 10 µg/L for 
each arsenic species or 25 µg/L total arsenic. Pool a sufficient number of urine donations 
to make a volume greater than 2 liters. Divide the pool into 40 mL aliquots and save at -
70°C in 50 mL centrifuge tubes labeled “Base Urine – Speciated Arsenic”.  
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c. Preparation of Working Solutions 

1. 25% (v/v) Base Urine Pool in 0.075 M Ammonium Acetate, pH 5. May be 
prepared ahead of time before the day of analysis. Add 30 mL of 0.5 M 
ammonium acetate pH 5 to a clean 250 mL PP bottle. Add 50 mL of “Base 
Urine – Speciated Arsenic”.  Add 120 mL of 18 Mcm water. Mix thoroughly. 
Prepare as needed. Store refrigerated at 4°C. Expiration date is 1 day from 
the date made.  

2. HPLC Buffer A Preparation. May be prepared ahead of time before the day 
of analysis. To a clean 2 liter or greater capacity beaker containing a clean 
magnetic stir bar add approximately 1.9 L of 18 Mcm water (≥ 18 M·cm). 
Add the following:  

(a) 40.0 mL of 0.50 M ammonium carbonate  

(b) 40.0 mL of 0.50 M TRIS buffer  

(c) 10 mL of methanol. 

Ensure that the temperature-adjust mode is enabled on the pH meter to be 
used.  Be sure solution is being mixed on a magnetic stir plate. Using a 
hydrogen glass electrode (pH probe), monitor pH while slowly adding either 
glacial acetic acid (to lower pH) or 10% ammonium hydroxide (to increase 
pH) drop wise to bring the pH to 8.60 ± 0.05. In this case, an Eppendorf® 
Repeater Pipetter fitted with a 500 µL syringe tip works well for adjusting pH. 
After complete mixing, transfer beaker’s contents to a 2 L graduated cylinder. 
Complete volume to 2000 mL with 18 Mcm water. Transfer entire contents 
to HPLC “Bottle A”, cap, and mix thoroughly.  Label bottle “10 mM Amm. 
Carbonate / 10 mM TRIS / 0.5% MeOH / pH 8.6” (or using other appropriate 
notation to indicate contents).  Prepare as needed.  Expiration date is 2 
weeks from the date made.  

3. HPLC Buffer B Preparation. May be prepared ahead of time before the day 
of analysis. To a clean 2 liter or greater capacity beaker containing a clean 
magnetic stir bar, add approximately 1.85 L of 18 Mcm water (≥ 18 M·cm). 
Add the following:  

(a) 40.0 mL of 0.50 M ammonium carbonate  

(b) 40.0 mL of 0.50 M TRIS buffer  

(c) 10 mL of methanol. 

(d) 60.0 mL of 0.50 M ammonium sulfate  

Ensure that the temperature-adjust mode is enabled on the pH meter to be 
used.  Be sure solution is being mixed on a magnetic stir plate. Using a 
hydrogen glass electrode (pH probe), monitor pH while slowly adding either 
glacial acetic acid (to lower pH) or 10% ammonium hydroxide (to increase 
pH) drop wise to bring the pH to 8.0 ± 0.1. After complete mixing, transfer 
beaker’s contents to a 2 L graduated cylinder and add 18 Mcm water to 
complete volume to 2000 mL. Transfer entire contents to HPLC “Bottle B”, 
cap and mix thoroughly. Label bottle “15 mM Amm. Sulfate / 10 mM Amm. 
Carbonate / 10 mM TRIS / 0.5% MeOH / pH 8.0” (or using other appropriate 
notation to indicate contents).  Prepare as needed.  Expiration date is 2 
weeks from the date made. 
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4. HPLC Buffer D Preparation. 5% (v/v) acetonitrile (HPLC grade) in 18 Mcm 
water. Mix thoroughly.  Prepare as needed.  Expiration date is 1 year from the 
date made. 

5. HPLC Buffer E Preparation. 5% (v/v) acetonitrile (HPLC grade) in 18 Mcm 
water. Mix thoroughly.  Prepare as needed.  Expiration date is 1 year from the 
date made. 

6. Internal Standard Preparation.  May be prepared ahead of time before the 
day of analysis.  To an empty 1 liter PP bottle labeled “Internal Standard”, add 
5.0 mL of methanol.  Next, add 50 µL of 50 mg/L trimethylarsine oxide (TMAO 
Internal Standard Stock Solution).  Fill with 18 Mcm water to the 1000 mL 
mark.  Mix thoroughly.  Final concentration is 2.5 µg/L TMAO.  Prepare as 
needed.  Expiration date is 1 year from the date made 

d. Preparation of Stock Standards (Concentrated) 

CAUTION! 
Arsenic compounds are toxic! Take extra care to avoid accidental ingestion or inhalation of these 
materials. Wear appropriate personal protective gear. At a minimum, wear a laboratory coat 
and latex or nitrile gloves. Clean up any spill that might occur according to applicable 
hazardous material spill procedures.   

Note 1:  All preparations should be performed gravimetrically (wt/wt), unless 
otherwise noted.  All gravimetric measurements should assume the density of 
water equal to 1g/cm3.   

 
Note 2: The steps outlined in Section 9.b – 9.h may be optionally outsourced 
under contract to a partner facility.  

Definitions: 
 

 Stock Standard: Initial solution of one of seven arsenic analytes prepared by 
dissolving solid or liquid standard material into aqueous or acidic solution.  

 Intermediate Standard:  A 10,000ppb solution prepared from dilution of a Stock 
Standard.  

 Working Calibrator: A dilution of the Intermediate Standards prepared in urine 
and ammonium acetate buffer.  A Working Calibrator is used in urine arsenic 
species HPLC-ICP-DRC-MS analysis to build a calibration curve. 

 

Use a high precision analytical balance capable of accurately weighing milligram 
amounts of material to the tenth of a milligram or better. It is important to use the 
balance in a vibration-free room that is free of air drafts and away from direct sun 
light, to the fullest extent possible.   

1. Using a clean Teflon-coated spatula, prepare the arsenic Stock Standards 
described in TABLE 9-1 into 50.0 mL centrifuge tubes or other suitable 
storage vessels. Record the weights of the initial solid arsenic material for 
each species and all final weights of the corresponding arsenic solutions after 
dissolution.   
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TABLE 9-1: PREPARATION OF STOCK STANDARDS 

Arsenic Species Range to 
Weigh (g) 

Solvent Used to Dissolve Final Weight (g) After 
Dissolution 

Arsenobetaine 0.02–0.03  Water (18 Mcm) 10.00  

Arsenocholine bromide (or 
other salt equivalent) 

0.20–0.25  Water (18 Mcm) 50.00 

Disodium methyl arsenate 0.20–0.25  Water (18 Mcm) 50.00  

Trimethylarsine oxide 0.10–0.125  Water (18 Mcm) 50.00 

Dimethylarsinic acid 0.10–0.125  Water (18 Mcm) 50.00  

Arsenic (V) oxide hydrate 0.10–0.125  Water (18 Mcm) 50.00 

Arsenic (III) oxide 0.10–0.125  Dissolve in 1.5 ml of 6N HCl with 
mild heating. Add water (18 
Mcm) to complete volume 

50.00 

               

2. Tightly cap the storage vessels for future use. Expiration date is 1 year from 
the date weighed. 

3. Calculate the concentration of each Stock Standard using the recorded 
weights for each species. The resulting units of concentration are milligrams 
per liter (mg/L). Record these values in a laboratory notebook.  

4. Calculate the “Arsenic (As) atomic equivalent” concentration of each arsenic 
species concentrated standard using Equation 1.   

Equation 1 

“As atom 
equivalent” 
conc. in mg/L 

= 
 
concentration of concentrated

 stock standard in g/L     
# As atoms per

 species molecule     74.92 atomic wt. As

 F.W. of As species    10-3 g/mg
 

 

Insert into the equation the appropriate values for the formula weights (F.W.) and 
number of arsenic atoms per molecule for each species. A list of commonly 
used formula weights for each arsenic species is shown in TABLE 9-2; 
however, formular weights provided by the chemical manufacturers, if 
different, supersede the values presented in the table and should be used 
instead.  
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Note:  All arsenic solutions from this point forward are referenced in terms of arsenic 
concentration. 

5. Record the “arsenic (As) atomic equivalent” concentration value on each 
arsenic stock standard storage vessel.  

 

e. Preparation of Intermediate Standards 

Into separate 50 mL centrifuge tubes, gravimetrically prepare 10,000 ppb 
solutions of each stock standard.  Use the arsenic atomic equivalent for each 
species to determine the appropriate dilution needed to obtain the expected 
concentration of approximately 10,000 ppb.  Record all weights, and calculate 
the expected concentration of each solution marking these values in a laboratory 
notebook.   Note: Exact arsenic concentrations will be determined by DRC-ICP-
MS in subsequent steps. 

f. Microwave Digestion for Conversion to Arsenate (AsV)   

Even at the same arsenic concentration, different arsenic species can produce different 
instrument responses during analysis.  Therefore, it is important to chemically convert 
each arsenic species to one common chemical form prior to analysis for total arsenic. 
Digestion of the arsenic species by microwave-assisted oxidation to arsenate (AsV) 
allows for analysis with an instrument calibrated using aqueous arsenate calibrators.  
This prevents introduction of systematic errors that otherwise might be caused by the 
determination of undigested arsenic species concentrations calculated from an inorganic 
arsenate calibration curve.  

1. Prepare 100 mL of 3% potassium persulfate (K2S2O8) in 18-MΩ deionized 
water.  Expiration date is 1 day from the date made.  This solution may be 
prepared by weight/volume.   

2. For each arsenic species analyte, do this step in triplicate:  For each of the 
Intermediate Standard solutions, gravimetrically transfer 0.5 g into a 

TABLE 9-2: FORMULA WEIGHTS OF ARSENIC SPECIES 

Arsenic Species Formula Weight Number of Arsenic 
Atoms per 
Molecule 

Formula 

Arsenobetaine 178.06 1 (CH3)3AsCH2COOH 

Arsenocholine bromide 244.99 1 (CH3)3AsCH2CH2OH·Br 

Disodium methyl arsenate 291.9 1 CH3AsO3· 6H2O 

Trimethylarsine oxide 136.03 1 (CH3)3AsO 

Dimethylarsinic acid 138.01 1 (CH3)2As(OH)2 

Arsenic (V) oxide hydrate 229.84 2 As2O5· xH2O 

Arsenic (III) oxide 197.84 2 As2O3 
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microwave Teflon vessel and record the weight to three significant digits.  Add 
10 mL of 3% K2S2O8 to each vessel.  (A volumetric measure is sufficient here, 
as the final solution, post-microwave assisted digestion, will be gravimetrically 
brought to 50.0 g total weight).  Additionally, triplicate blanks (0.5 g water + 
10.0 mL K2S2O8) and triplicate certified AsV solution are desired for quality 
control if space permits in the microwave. 

3. Perform microwave-assisted digestion of these solutions using the microwave 
program “10 ml K2S2O8” or a suitable program that allows for the following 
parameters listed in TABLE 9-3: 

TABLE 9-3: MICROWAVE DIGESTION OVEN PARAMETERS 

Nr t(min.) E [W] T1 [°C] 

1 00:10:00 1000 max 140°C 

2 00:05:00 1000 max 200°C 

3 00:15:00 1000 max 200°C 

4 Ventilation 10 min. 1000 max  

4. Once the microwave-assisted digestion is complete, it is important to allow 
each vessel to cool to room temperature before opening to avoid possible loss 
of volatile arsenic.  For safety purposes, open all vessels underneath a 
chemical fume hood (or equivalent) to avoid inhalation of toxic fumes.   

5. Using the analytical balance, once digestion vessels are at room temperature, 
quantitatively transfer (with 18-MΩ de-ionized water) each digested solution 
into separate labeled 50 mL Falcon tubes.  Bring the final weight to 50.0 g 
with 18-MΩ deionized water, and record the total mass to three significant 
digits.  The expected arsenic concentration of each solution should be 
approximately 100 ppb as arsenate (AsV). 

6. To determine if all arsenic species have been converted to AsV, measure an 
aliquot of each species by the current CLIA urine arsenic species HPLC-DRC-
ICP-MS method.  Since this step is performed solely to confirm that the 
species are no longer present in their original forms, this may be performed in 
a qualitative manner. 

g. Method of Standard Additions (MSA) 

Note:  It is imperative that the total arsenic concentration of each solution be determined 
by the Method of Standard Additions (MSA), and that all solutions are prepared 
gravimetrically (wt/wt) unless otherwise noted. 

1. Prepare 1000 mL of 2 ppb gallium in deionized water by diluting 2 mL of 1000 
µg/L stock Ga in 1000 mL of deionized water .  This solution will be used to 
dilute post-microwave digested solutions.  This solution does not need to be 
prepared gravimetrically.   

2. Prepare a 5 ppm AsV “spiking solution” in deionized water.  Weigh 0.25 g of 
1,000 µg/L certified arsenate solution and bring to a final weight of 50.0 g 
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using deionized water  Record all weights, and calculate the exact 
concentration of this solution.  This concentration will be used in steps e.4.ii, 
iii, and iv. 

3. Using the 2 ppb Ga solution prepared in Step 1, dilute each of the microwave-
digested solutions 1:2 into new 50 mL centrifuge tubes by weight, with a final 
weight of 50.0 g.  (For example, dilute 25.0 g of each microwave digested 
solution to 50.0 g total weight using the 2 ppb Ga solution).  Record all 
weights.  Final concentrations should be approximately 50ppb. 

4. For each new 50ppb microwave-digested solution, label four new 15mL 
centrifuge tubes, incorporating the analyte name, replicate, and MSA spike 
concentration.  An example (demonstrating only one replicate for one 
microwave-digested solution) is shown below in TABLE 9-4.  Each tube will be 
used to prepare new solutions for MSA in subsequent steps. 

Note: A spike of 0 ppb corresponds to an unspiked sample for which a value 
will be determined in subsequent steps via total arsenic analysis.                     

               TABLE 9-4: METHOD OF STANDARD ADDITIONS TABLE 1        

   Labels 

Tube #  Analyte  Replicate  Spike in pbb 

1  AB  1  0 

2  AB  1  25 

3  AB  1  50 

4  AB  1  100 
 

 

5. The solutions mentioned in Step 4 and outlined in TABLE 9-4 must be 
prepared.  For accuracy, it is important to prepare each solution in the 
following order: 

For each 50 ppb microwave-digested solution: 

(i) Into the tube labeled 0 ppb transfer by weight 10.0 g of the 
approximately the approximately 50 ppb diluted microwave-digested 
solution prepared in Step 9.3.  Record the weight.  

(ii) Into the tube labeled 25 ppb, transfer by weight approximately 0.05 g 
of the approximately 5 ppm spiking solution prepared in step 9.g.2.  
Additionally, transfer by weight 10.0 g of the approximately 50 ppb 
diluted microwave-digested solution prepared in Step 9.3. Record all 
weights. 

(iii) Into the tube labeled 50 ppb, transfer by weight approximately 0.10 g 
of the approximately 5 ppm spiking solution prepared in step 9.g.2.  
Additionally, transfer by weight 10.0 g of the approximately 50 ppb 
diluted microwave-digested solution prepared in Step 9.3. Record all 
weights. 

(iv) Into the tube labeled 100 ppb, transfer by weight approximately 0.20 
g of the approximately 5 ppm spiking solution prepared in step 9.g.2.  
Additionally, transfer by weight 10.0 g of the approximately 50 ppb 
diluted microwave-digested solution prepared in Step 9.3. Record all 
weights.  TABLE 9-5:  MSA TABLE 2 shows an example of the 
information that needs to be recorded for each analyte and 
corresponding tube. 
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TABLE 9-5: METHOD OF STANDARD ADDITIONS TABLE 2 

           

Tube 

Target 
Weight, 
Spiking 
Solution 

Measured 
Weight,  

Spiking Solution 

Target 
Weight, 
Final 

Solution 
Measured Weight,  

Final Solution 

AB, Replicate 1, 0ppb  n/a  n/a  10.0g  9.8973g 

AB, Replicate 1, 25ppb  0.05g  0.0517g  10.0g  9.8269g 

AB, Replicate 1, 50ppb  0.10g  0.0997g  10.0g  9.8738g 

AB, Replicate 1, 100ppb  0.20g  0.2051g  10.0g  9.8571g 

 

h. Determining the Total Arsenic Concentration 

1. Analyze each MSA solution for total arsenic content using a validated ICP-MS 
method.  Ensure that the method uses Ga as an internal standard. 

2. After the analysis is complete, prepare an MSA calibration curve for each 
solution, and calculate the concentration of the unknown sample by dividing 
the y-intercept by the slope. 

3. Using the recorded weights for each MSA solution, calculate the exact 
concentrations of arsenic in each tube.    

4. Once the arsenic concentration of each MSA solution has been determined, 
perform blank subtraction, and then use all recorded weights for each 
replicate to back-calculate the exact 10,000 ppb concentration of the 
Intermediate Standard solutions prepared in section 9.e.  An example of the 
necessary calculation is given below: 

Intermediate Standard Concentration Determination 

calculation  M1MSA= 
V2MSA*M2MSA/V1MSA 

M1MW= 
V2MW*M2MW/V1MW       

Key: 

V2MSA  Final Wt (g) of solution prepared in Step 9.g.3 

M2MSA  Measured concentration (ppb) as determined from MSA 

V1MSA  Initial Wt (g) of solution prepared in Step 9.g.3 

M1MSA  Exact concentration (ppb) of microwave‐digested solution (Step 9.f.2) 

V2MW  Final wt (g) of solution prepared in Step 9.f.5 

M2MW  The M1MSA concentration (ppb) 

V1MW  Added amount (g) of Intermediate Standard from step 9.f.2 

M1MW  Exact concentration (ppb) of Intermediate standard 
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5. After the concentration for each replicate of the Intermediate Standards has 
been determined, calculate the average concentration of all Intermediate 
Standard replicates per analyte.   

6. Additionally, calculate the average concentration of all microwave blanks 
prepared in Step 9.f.2.  Subtract the average blank value from all Intermediate 
Standard concentrations.     

i. Assessment of Purity by HPLC-DRC-ICP-MS 

1. From each 10,000 ppb solution, prepare a 10 ppb solution.   

2. Using the CLIA “Urine arsenic species HPLC-ICP-DRC-MS” method, analyze 
each arsenic species for the presence of significant levels (>2%) of arsenic 
species impurities which are defined as the presence of any other arsenic 
species that are included in Table 1-1 of this method.  

3. Tabulate all impurities for each solution.  If significant levels of impurities are 
found, consider purchasing additional standard solid material from an 
alternative source and remake the stock standard.  If the total amount of 
impurities is small (<2%), it is permissible to calculate a correction factor 
which will be used to adjust the volumes in the next dilution step (i.e., 
preparation of Working Calibrators) so that the final concentration reaches the 
intended value.   

4. Correct the measured Intermediate Standard concentrations based on their 
purities.  For example, if the Intermediate Standard solution of arsenobetaine 
(AB) was found to have 2% total impurities, the measured value should be 
multiplied by 98% to obtain the pure value of this Intermediate Standard.   

5. For AB, AC, DMA, MMA, AsIII, or AsV solutions that are found to have 
impurities, be sure to add the concentrations of the impurities to the value of 
the species because once combined in the mixed calibrators, the impurities 
will contribute to the final value for that species.  Impurities in the TMAO 
solution will not be used in the calculation because TMAO will not be 
combined with the other species. 

j. Preparation of Concentrated Stock Internal Standard  

Prepare ahead of time before the day of analysis.  Expiration is 1 year from date of 
preparation.    

1. Prepare concentrated Stock Internal Standard, 50 mg/L trimethylarsine oxide 
(TMAO). Dilute a calculated volume (µL) of trimethylarsine oxide (TMAO) 
stock standard in 18 Mcm water to make a total volume of 20 mL. Calculate 
the number of µL of stock TMAO standard to add using Equation 2:  

Equation 2 

µL of stock TMAO 
standard to add =  

50 ppm  20 mL  1000 µL/mL
actual ppm of stock TMAO standard  
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k. Preparation of Working Calibrators 

At any given time, it is necessary to have at least two sets of Working Calibrators in 
storage from two independent preparations of Stock Standards.  The original material 
must be from different lots, preferably from alternate vendors.  Arsenic speciation analysts 
should alternate between both sets of working calibrators from run to run. 

(1) Preparation of Intermediate “Mixed Species” Calibration Solutions 

Prepare the intermediate mixed species calibration solutions on the day of analysis.  

1. Add 7.5 mL of 0.5 M ammonium acetate (pH 5) to a clean 50 mL volumetric 
flask labeled “Mixed As Species 250 µg/L” or something similar.  Likewise, 
add 7.5 mL of ammonium acetate pH 5 to another dedicated 50 mL volumetric 
flask labeled “TMAO 250 µg/L” or something similar.  

2. To each flask, add 12.5 mL of Base Urine.   

3. Based on the pure measured value of each Intermediate Standard (which 
takes into consideration the addition of any impurities per analyte) prepare the 
250µg/L mixed as species solution.  To the flask labeled “Mixed As Species 
250 µg/L”, add each of the following Intermediate Standards: AC, AB, DMA, 
MMA, As(III) and As(V) (six solutions in all so that each analyte’s final 
concentration will be 250 µg/L at a volume of 50.0 mL).  Use of the dilution 
equation C1*V1 = C2*V2 is helpful, where C1 is the pure measured value of 
an analyte + the sum of any impurities in the form of that analyte from the 
other Intermediate Standards and V1 is the weight of each Intermediate 
Standard for which to solve.  Do not account for any impurities from TMAO in 
this step, as TMAO will be diluted in a separate flask and not mixed with the 
other arsenic species.  

4. Repeat Step 3 for the TMAO Intermediate Standard.  Using the flask labeled 
“TMAO 250 µg/L”, based on the pure measured value, weigh the appropriate 
amount of TMAO Intermediate Standard to obtain a 250 µg/L solution based 
on a final volume of 50.0 mL. 

5. Bring both flasks to a final volume of 50.0 mL using 18 Mcm water.  Mix the 
contents of each flask thoroughly.  Transfer each solution to an appropriately 
labeled 50 mL centrifuge tube or equivalent container.  This solution expires in 
8 hours unless it is frozen.   If the solution is frozen, the expiration date is 1 
year from the date made. 

(2) Preparation of Working Calibrator Series 

1. Label six clean 15 mL PP screw-top Falcon (or equivalent) tubes with caps 
as follows: “Mix S0”, “Mix S1”, “Mix S2”, “Mix S3”, “Mix S4”, and “Mix S7”. 
Label an additional five 15 mL PP screw-top tubes as follows: “TMAO T0”, 
“TMAO T1”, “TMAO T2”, “TMAO T3”, and “TMAO T4”.  Arrange these tubes in 
order and place in a test tube rack.  

2. Inspect a Gilson 402™ Dilutor/Dispenser to ensure it has a clean 10 mL 
dispensing syringe and a clean 500 µL sample syringe.  It is helpful to 
examine the rubber gasket for precipitate or dirt.  If precipitate or dirt is found 
on either syringe, replace that syringe with a new one.  If possible, it helps to 
have syringes dedicated to calibrator preparation.   
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3. Place the tubing that will draw diluent into the dilution syringe into a buffered 
solution consisting of 25% Base Urine in 0.075 M ammonium acetate (pH 5). 
Place a waste beaker in position to collect the effluent liquid from the tip of the 
sample/dispense tubing.  Next, thoroughly rinse the liquid path by pressing the 
“Prime” button on the Gilson and allow the syringes to cycle 3 to 4 times 
before stopping the prime function with a press of the “Start/Stop” button.  

4. To make the “S0” calibrator, set the diluent syringe volume to “10000” and the 
sample syringe volume to “0”.  Press the “Start/Stop” button once to draw 10 
mL of diluent solution (25% urine in 0.075 M ammonium acetate pH 5) into the 
diluent syringe then press again to dispense 10 mL to the “Mix S0” tube.  

5. To make the calibrator levels “S1” to “S4” and “S7”, set the diluent syringe 
volume to the appropriate values indicated in TABLE 9-3 for the diluent and 
sample syringe volumes.  Submerge the tip of the Gilson 402™ 
sample/dispense tubing into the “Mixed As Species 250 µg/L” intermediate 
solution and press the “Start/Stop” button on the Gilson.  A volume in µL 
(indicated in the appropriate row in the third column of TABLE 9-3) will be 
aspirated.  Place the appropriately labeled receiving tube (“S1”, “S2”…”S4” 
and “S7”) under the sample/dispense tubing and press the “Start/Stop” button. 
The indicated volume of diluent and sample will be dispensed to make a total 
volume of 10 mL of diluted calibrator in each tube.  If necessary, repeat the 
dispense step into the same tube to make a total dispensed volume equal to 
10 mL.  

  

TABLE 9-3: GILSON 402™ SETTINGS FOR MAKING DILUTED SERIES 

Calibrator 
Level 

Gilson Volume  
Setting, µL Target Arsenic Concentration  

(Nominal Conc. entered into HPLC 
software) Diluent  

Syringe 
Sample 
Syringe 

S0 / T0 10000  0  0 (0) 

S1 / T1 9980  20  0.50 (2) 

S2 / T2 9900  100  2.50 (10) 

S3 / T3 9500  500  12.5 (50) 

S4 / T4 8500  1500  37.5 (150) 

S7 0 10000  250.0 (1000) 

6. Repeat the preceding step for each calibrator level indicated in TABLE 9-3. 
Between calibrators, rinse the tip of the sample/dispense tubing with 18 
Mcm water from a squeeze bottle.  

7. Repeat the previous two steps, this time using “TMAO 250 µg/L” to make “T0” 
through “T4”.    

8. Per CLIA requirements, twice per year, an extended-range linear verification 
analysis has to be completed for each CLIA method.  Therefore, S5, S6, and 
T5, T6, and T7 calibrators are also made during this preparation step.  The 
concentrations of each are as follows: 

S5/T5 are 250 ppb, S6/T6 are 500 ppb, and S7/T7 are 1000 ppb. 
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9. Cap all tubes. Mix them thoroughly by vortexing and/or inverting repeatedly.  

10. Divide each calibrator into twenty (or less) 0.5 mL aliquots contained in 
correspondingly labeled clean HPLC autosampler vials.  Cap each with a 
“snap-cap” septum cap. Store at ≤ -70°C. Expires in 9 months.   

11. At a later date, thaw one set of calibrators (S0 – S4 and T0 – T4) as needed 
for future calibrations.  An S7 will be thawed, if necessary, for extended 
calibration range verification. 

l. Preparation of Quality Control Material 

Collect human urine from anonymous donors in clean, trace metals-free urine cups. 
Refrigerate urine donations at ≤ 4°C as soon as possible for periods of 2 days or less. 
For longer periods, freeze the urine donations until needed.  Assay each donation for, if 
possible, speciated arsenic or, alternatively, for total arsenic.  Assign urine donations to a 
“low” pool or to a “high” pool according to whether its arsenic concentration exceeds a 
predetermined threshold value (i.e. 15 µg/L). Do not pool urine donations with an arsenic 
concentration that exceeds the threshold by more than a factor of 10. After pooling urine 
donations into their respective pools, clarify each pool by centrifugation in acid-washed 
250 mL centrifuge bottles (30 minutes at 4000 rpm in a preparative table-top centrifuge).  
Pour off the supernatant and dispose of the pellets. To each pool, add a calculated 
volume of the chosen arsenic species standard solution to raise the concentration of that 
arsenic species to the desired value. While maintaining constant stirring of each pool, 
aliquot 1.0 mL (or more) of urine into a sufficient number of pre-labeled 2 mL vials to 
provide QC material for 1000 or more runs.  Store aliquotted QC material at ≤ 70°C.  

 

m. Processing of Urine Samples and QC Material 

Process a chosen number of urine samples and QC material on the day of analysis. 
One run is defined as the analysis of a contiguous set of samples (typically 20) 
bracketed by bench QC material at the beginning and end of the set.  Each bench 
QC level needs to be analyzed at the beginning and end of a run in separate 
tubes/vials.  Sharing of even a single QC tube or vial for more than a one QC 
determination is disallowed. It is permissible to “piggyback” two runs in succession 
following a single calibration done during a single autosampler load (such as for an 
overnight analysis), as long as each run of samples is bracketed by its own uniquely 
co-prepared bench QC material.  The number of samples per run can exceed 20 as 
long as the total analysis time does not exceed 24 hours. 

1. Identify, gather, and thaw the necessary specimen tubes containing the urine 
samples for the batch (“run”) to be analyzed.  

2. Likewise, for each batch run, thaw one tube each of low and high bench QC 
samples “LU-yyxxx” and “HU-yyxxx” (for explanation of nomenclature, see 
Quality Control Material above).   

3. Label the required number of Eppendorf® (or equivalent) 1.5 mL 
microcentrifuge tubes corresponding to the samples and bench QC samples 
to be run.  Label a pair of microcentrifuge tubes for each bench QC, since 
each bench QC will be injected at the beginning and end of each batch run 
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and need to be contained in separate tubes. Likewise label an equal number 
of HPLC autosampler vials and set these aside for later use.  It is helpful to 
use preprinted barcode labels to improve efficiency and reduce the chance of 
labeling errors.  

4. Attach a bottle of 0.1M ammonium acetate solution to a Gilson 402™ 
Dilutor/Dispenser diluent draw-line.  In order to minimize evaporation, it is 
helpful to use a capped bottle with a small hole in the cap that is slightly larger 
than the outer diameter of the draw-line.  Insert the draw-line through the hole 
and assure that the end of the draw line is completely submersed in 
ammonium acetate solution.  It is important that the end of the line remain 
submersed throughout sample preparation in order to prevent air bubbles.  

5. Using the “Prime” function on the Gilson 402™ Dilutor/Dispenser, flush lines 
with 0.1M ammonium acetate solution and empty into a small waste container.        

6. If not done so at a previous date, create a sample preparation method on the 
Gilson 402™ Dilutor/Dispenser that will in a step-wise, sequential, and user-
controlled fashion: 

(a) Uptake 10 µL of air into sample draw-line. 

(b) Uptake 200 µL of sample (urine) into sample draw-line. 

(c) Uptake 1600 µL of 0.1M ammonium acetate solution into the diluent 
draw-line. 

(d) Dispense 800 µL of sample + diluent mix (200 µL sample + 600 µL 0.1M 
ammonium acetate solution).  

(e) Dispense 1000 µL of diluent (for flushing). 

(f) Repeat steps (a) – (e) until the program is stopped. 

The method should be set up such that no step shall execute until the user 
has pressed the black button on the black dispenser control device.   

Name and save this method into memory.    

 

For detailed instructions on programming, please consult the Gilson 402™ 
Dilutor/Dispenser instrument manual.  

CAUTION! 
Work with open vials or tubes containing biological samples in a biological safety cabinet (BSC). 
Wear appropriate personal protective equipment (gloves, lab coat and safety glasses). 

7. Recall the sample preparation method created in step 6.  Using this method, 
follow its steps (including the 10 µL air uptake) to mix 200 µL of sample from 
each specimen tube with 600 µL 0.1M ammonium acetate solution and to 
transfer the mix to each sample’s respective 1.5 mL microcentrifuge tube.  
Note that calibrators, which have been pre-made, do not undergo this type of 
sample preparation.   

8. After each sample/diluent mix is transferred, dispense 1000 µL of 0.1M 
ammonium acetate solution (pH 5) into a waste container and repeat the 
process for each remaining sample.         
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9. After capping all 1.5 mL microcentrifuge tubes containing sample/diluent mix, 
vortex each for 3-5 seconds.  Next, centrifuge tubes for 5 minutes at 14,000 
rpm in a refrigerated centrifuge pre-cooled to ≤ 4°C. 

10. Following centrifugation, transfer approximately 0.6 mL of the supernatant to 
the appropriately pre-labeled HPLC autosampler vials. Be careful not to 
disturb any pellet that might be present at the bottom of the microcentrifuge 
tube during transfer.  

11. Cap all autosampler vials with the proper fitting “snap-cap” septum caps.  

12. Thaw one “set” of calibrators, including S0 – S4 and T0 – T4, at room 
temperature.  Vortex each thawed calibrator for 3-5 seconds. 

13. To autosampler vials labeled “Bk” (which stands for “Blank”), transfer 0.5 mL 
of 0.075M ammonium acetate (dilute from stock solution).  The number of Bk 
vials will be dependent upon the total number of samples to be analyzed.   

14. For each run, one extra sample of 200 µL LU-xxxx + 600 µL 0.1M ammonium 
acetate solution is needed.  This sample is used for instrument equilibration 
and conditioning only, so an LU-xxxx vial from a previous day’s run containing 
leftover sample will suffice.  If there are no leftover samples, one may be 
made according to step 7 of this section.   

15. If barcode labels have been affixed to the vials, at the appropriate time, use 
the barcode scanner attached to the instrument computer to scan the sample 
ID from the barcode label on each sample and QC vial before placing it into 
position in the HPLC autosampler tray.  

n. HPLC Instrument Setup 

To improve work flow, instrument setup described in this section may be completed before the 
day of analysis.  

(1) Programming the HPLC Pump Methods 

1. On the PerkinElmer Series 200 Pump control panel, press the Quit button to 
bring the pump controller to the starting screen.  

2. If the method number for the correct stored pump program is known, that 
method can be called up into active memory. Press the function key F6 
(labeled as “DIR” on screen). The screen changes and presents a table with 
column headers “Method”, “Name” and “Last Modified”.  Press function key F4 
(“RCL”) and you will be prompted to enter a 2-digit number. Press the number 
for the correct method (e.g., “1”) followed by the “enter” key. The stored 
method will be loaded into memory and becomes the active pump program. 
The method can be inspected by pressing the function key F2 (“PUMP”) and 
using the up or down arrow keys to scroll the program steps.  

3. If the correct pump program cannot be found, then the pump program will 
have to be reentered.  To do this, execute the following steps:  

(a) Press the Quit button, then the function key F6 (labeled as “DIR” on 
screen). The screen changes and presents a table with column headers 
“Method”, “Name” and “Last Modified”.  Press function key F4 (“RCL”) 
and you will be prompted to enter a 2-digit number. Press “0” followed by 
the “enter” key. The “DEFAULT” method will now be loaded.  
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(b) Press the function key F2 (“PUMP”). A new screen presents a table with 
column headers “Step”, “Time”, “Flow”, “%A”, “%B”, “%C”, “%D” and 
“Curve”.  The default method has only one line, Step “0”, with the “>” 
marker just left of it. The highlighted data field is “Time” and contains 
“10.0”. Press “6.5” on the keypad followed by the right arrow key to 
replace the previous number.  The highlight will advance right to “Flow”. 
Press 1 then the right arrow key. The next field is “%A”; enter 100 then 
press the right arrow key. Repeat this for fields “%B”, “%C” and “%D”, 
entering 0 for each.  Press the right arrow key again to return to “Time”.  

(c) Press the “insert” key on the pump controller keypad.  A new step, Step 
“1”, is added and is a replicate of the step before it.  Input the data 
indicated in the table below.  Notice that the last column “CURV” in step 
1 calls for the input of a number.  Likewise, create Step “2”, using the 
data from the table below.  Note that you can move back and forth 
between fields, and up and down from one step to another, by using the 
left, right, up and down arrow keys on the keypad. 

TABLE 9-4: HPLC PUMP PROGRAM SETTINGS 

STEP TIME FLOW %A %B %C %D CURV 

0 6.5 1.00 100 0.0 0.0 0.0  
1 5.0 1.00 0.0 100 0.0 0.0 1 
2 4.5 1.00 0.0 100 0.0 0.0  

 
(i) Press the function key F6 (“STOR”). You will be prompted to enter a 

method number, press “1” then the “enter” key. If message comes up 
asking if you want to overwrite the existing method stored at that 
location, press the “1” key for “Yes”. Next you will be prompted to 
name the method, press the “0” key for “No”. (You may enter “Yes” 
and create a name for the method but this is optional).  

(ii) Press the function key F3 (“T.E.”). This is for entering timed events. 
Since an electrical-activated external switching valve is going to be 
used, the timing of brief ~1 second contact closures needs to be 
programmed.  
 

EVENT TIME T.E.1 T.E.2 

1 0.5 YES - 

2 1.0 YES - 

 
 

(iii) Enter the parameters from the above table using the same technique 
as was used to create the pump method.  Note that to successfully 
input the minutes for each event, you need to press “enter” after the 
inputting the number, instead of using the right arrow key. Timed 
Event #1 (“T.E.1”) is turned on by pressing “1” (“Yes”) on the keypad. 
Store a “ready” time (the number of minutes the pump waits during 
re-equilibration before allowing the next injection) by pressing 
function key F8 (“RDY”) and input “30” followed by the “enter” key. 
Press function key F6 (“STOR”) and respond to the prompt for a 
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method number by inputting the same method number (e.g., “1”) 
used to store the pump program. Respond to the next two prompts 
with a “yes” then a “no”.  

4. Press the function key F4 (“PRESS”).  Press function key F4 (“MAX”) then 
input “3000” followed by the “enter” key.  Press function key F3 (“MIN”) then 
input “100” followed by the “enter” key.  Press function key F6 (“STOR”) and 
respond to the prompt for a method number by inputting the same method 
number used to store the pump program.  Respond to the next two prompts 
with a “yes” then a “no”.  

5. Create a separate HPLC pump method (e.g. method “19”) which will serve as 
a column wash method after the completion of a batch run: 

(a) Follow step 3 above to input the following in TABLE 9-5:  

TABLE 9-5: HPLC PUMP COLUMN WASH PROGRAM  

STEP TIME FLOW %A %B %C %D CURV 

0 0 1.00 100 0.0 0.0 0.0  
1 20 1.00 0.0 0.0 0.0 100 0 
2 HALT 0 - - - -  

 

(b) No Timed Events need to be programmed.  

6. Store this method using a number of your choosing (e.g. “19”).  

7. To link the pump methods into a sequence, do the following: 

(a) Press softkey F5 (“SEQ”) on the HPLC pump.  Press F8 (“DELS”) to 
clear any preexisting sequence.  The following fields will be shown: 
“SET”, “METHOD”, “FIRST”, “LAST” and “INJ”.  The “METHOD” field will 
be active highlighted field.  

(b) Input “1” then press the “enter” key.  The next highlighted field will be 
“FIRST”; input “100” then press the “enter” key. The “LAST” field will 
automatically change to 100.  Press the “enter” key again.  The last field 
“INJ” will now be highlighted; input “5” then press the “enter” key.  

(c) A second line for set 2 will automatically be created. Press the “enter” 
key to advance to the “FIRST” field and input “1” followed by the “enter” 
key.  In the “LAST” field, enter the number of samples to be analyzed.  If 
you do not yet know this number, leave the default number alone (it can 
be changed later).  Advance to the “INJ” field by pressing the “enter” key 
and input “1” followed by the “enter” key.  

(d) A third line for set 3 will automatically be created. Change the 
“METHOD” field to a value corresponding to the method number for the 
“column wash” pump method (e.g., 19), then change the “FIRST” and 
“LAST” fields to 99. Leave the “INJ” field set to “1”.  

(e) Do not press the softkey F6 (“LINK”). This will be done later before the 
start of a batch run.  

8. The HPLC pump is now programmed.  



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 34 of 107 

 

 

(2) Programming the HPLC Autosampler 

1. On the Series 200 Autosampler, press the “quit” key. This brings up the 
“READY” screen. Next, press function key F6 (“DIR”) to show the method 
names directory. Press function key F4 (“RCL”) and input “0” followed by the 
“enter” key. Answer the next prompt with “yes” and you will be returned to the 
starting screen.  

2. Press function key F2 (“METH”). A new screen presents a table with column 
headers “First”, “Last”, “Volume”, “Replicates” and “Time”. The highlighted 
data field is “First” and contains a value of “1”. Key in “100”. Complete the 
entry by pressing the “enter” key. It will automatically advance the highlight to 
the data field “Last” which already contains a value of “100”. Since this 
method will make only make injections from position “100”, press “enter”. The 
next highlighted field is “VOLUME”.  Input a value that is 2.5X the size of the 
autosampler’s injection loop.  For instance, if the autosampler’s injection valve 
has a 20 µL loop installed, input 50 for “VOLUME”. Enter 5 as the number of 
“REPLICATES” so that five replicate injections will be made from the vial in 
position 100.  Leave the default value for “TIME” unchanged. Press the 
function key F6 (“STOR”), key in “1” then “enter”. Respond to the next two 
prompts with a “yes” then a “no”.  

3. To program the second method, it is not necessary to exit the existing one. 
Since the method just programmed was stored, you can edit the existing 
method in memory and save it to a different location. Using the arrow keys on 
the autosampler panel, highlight data field “FIRST” which will contain a value 
of “100”.  Input the starting vial position from which the autosampler is to make 
its first injection, which is usually “1”. Press the “enter” key.  Enter the number 
for the last vial position for this sample set, and then press the “enter” key. 
The highlighted field is “VOLUME” which is still the volume programmed for 
Method 1.  Press the “enter” key to advance to “REPLICATES”.  Replace the 
existing value by keying in 1.  Press “enter”.  Leave the default value for 
“TIME” unchanged.  Press the function key F6 (“STOR”).  Key in “2” then 
“enter”.  Respond to the next two prompts with a “yes” then a “no”.  

4. Program a third method that will be used in conjunction with the column wash 
pump program.  This method will do an injection for a blank or empty vial in 
autosampler tray position 99.  Set “First” and “Last” vial position fields to “99”. 
Set the “Replicate” field to “1”. While the “Volume” field can be set to any 
value, a value of “1” is preferred.  Press the function key F6 (“STOR”), key in a 
number of your choosing (e.g., “19”) then press “enter”. Respond to the next 
two prompts with a “yes”.  Input a name for this method (“i.e., “WASH”) then 
press “enter”.  

If necessary, additional methods may be created following the steps in this 
section.   

5. At the “READY” screen, press function key F5 (“SEQ”). Press F8 (“DELS”) to 
delete previous sequences, if present.  Three columns will be shown: “SET”, 
“METHOD”, and “INJECTIONS”.  The “METHOD” column will be highlighted; 
key in “1” followed by the “enter” key. The table will automatically create and 
jump to a line for set 2.  Enter “2” then press “enter”. You will again be 
prompted to enter a method number for set 3. Enter “3” then press “enter”. 
You will be prompted to enter a fourth set, but that will not be necessary 
unless more than three methods need to be linked together. You can scroll 
the sets by using the up and down arrow keys.  If you inadvertently created 
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too many sets, position the “>” symbol to point at the unwanted set and press 
the “delete” key.  The “INJECTIONS” column, which shows the number of 
injections programmed for each method, cannot be edited.  

6. Link the methods together by pressing the F6 function key (“LINK”).  

7. The HPLC autosampler is now programmed.  

o. ICP-DRC-MS Instrument Setup 

To improve workflow, complete the programming steps described in this section before the day of 
analysis.  

(1) Programming the DRC Gas Flow Delay Parameter 

A special ELAN® DRC™ setting, called “Flow Delay”, needs to be changed from its default setting 
to avoid the problem of the ELAN software forcing a time delay of several seconds before 
collecting data at the start of a chromatographic run in DRC mode. This change only needs to be 
done once per software installation or upgrade, or if the setting was deliberately changed by a 
field service engineer. It is a good idea to inform the service engineer who intends to perform 
work on the instrument of the importance of returning the “Flow Delay” to the non-default value of 
1. 

Important! 
While in Service Mode, DO NOT make changes to any setting except for the one change 
described below.  

  

1. From within the ELAN program and in the window entitled “Instrument Control 
Session”, choose menu item Options > Service Mode.  You will be prompted 
to enter a Service Mode password. Enter the password “Elan6000” (omit the 
quotes and pay attention to capitalization) and click OK.  If this password is 
not accepted, you will have to contact a supervisor or a PerkinElmer service 
technician.  

2. You will be presented with a new tab called “Service” within the Instrument 
window.  Maximize the window.  Click on “Gas” in the row of tabs at the 
bottom of the window.  Look for the parameter called “Flow Delay” (Gas 
changes while in DRC Mode). If its setting is a value other than “1”, click on 
the “Set Pauses…” button.  Change the value in the field named “Flow 
Change” to “1”. Click the “Apply” button then click the “Close” button.  Choose 
menu item Options > Exit Service Mode.  

(2) Programming the ELAN “.mth” file 

1. If it is not already open, launch the ELAN program and in the “Instrument 
Control Session” window, choose menu item File > Review Files. Click the 
“Load” button for “Method”, the first item on the list. Navigate to the folder 
“C:\elandata\Method” and click on “As_HPLC-1_drc.mth” file† then click the 
“Open” button.   

2. Proceed to step three unless, the “As_HPLC-1_drc.mth” file cannot be found, 
or it has been changed or corrupted in a manner that makes its use 

                                                      
†Actual file names may differ from those presented throughout this document.  
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questionable.  If this is the case, cancel the open file dialog box and close the 
Review Files window by clicking “Done”.  Perform the following steps: 

(a)  Make the active method file the active window.  Do this by clicking on the 
tool bar icon that looks like a notepad with a “Cu” on it. Click File > New 
on the menu bar and then choose “Data Only” in the New Method 
window that appears.  Click OK then maximize the window.  Enter the 
information in TABLE 9-6 into this window :  

TABLE 9-6: ELAN® TIMING PARAMETERS 

Parameter Setting 

Sweeps/Reading: 1 

Readings/Replicate: 1403 

Number of Replicates: 1 

Tuning File: C:\elandata\Tuning\default.tun 

Optimization File: C:\elandata\Optimization\as_hplc_drc.dac 

Enable Short Settling Time: Unchecked 

  
  

(b)  On the first line of the worksheet-like table, click in the cell of row 1 of the 
“Analyte (*)” column.  Type “As” then the enter key.  The row will 
suddenly be filled-in with arsenic’s “Begin Mass (amu)” of 74.92 (or 
something close) and several default parameters.  Tab from cell to cell to 
fill in the information shown in TABLE 9-7. 

TABLE 9-7: ELAN® ANALYTE PARAMETERS 

Parameter Setting 

Analyte: As 

Begin Mass (amu): 
74.9216 (or something close will be automatically entered 
by software) 

End Mass: <leave empty> 

Scan Mode: Peak Hopping 

MCA Channels: 1 

Dwell Time: 488 

Integration Time: (automatically determined by software) 

  

  
(c) Click on the “Processing” tab and enter the following information: 
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TABLE 9-8: ELAN® PROCESSING PARAMETERS 

Parameter Setting 

Detector: Pulse 

Measurement Unit: Cps 

Process Spectral Peak: Average 

Process Signal Profile: Average 

Apply Smoothing: Checked 

Factor: 5 

Auto Lens: Off 

Isotope Ratio Mode: Off 

  

  
(d) Skip the “Equation” tab. Click on the “Sampling” tab and enter the 
following information:  

TABLE 9-9: ELAN® SAMPLING PARAMETERS 

Parameter Setting 

Peristaltic Pump Under 
Computer Control: 

Unchecked 

Sampling: External 

  
(e) Click on the “Report” tab and enter the following information:  

TABLE 9-10: ELAN® REPORT PARAMETERS 

Parameter Setting 

Report View | Send to 
Printer: 

Unchecked 

Report Options Template: <leave empty> * 

Automatically Generate 
NetCDF File: 

C:\elandata\reportoutput\ 

Report to File | Send to File: Unchecked 

Report Options Template: <leave empty> * 

Report File Name: <leave empty> * 

Report Format: <leave empty> * 

File Write Option <leave empty> * 

  

* Content of these fields is not important since Send To Printer/File is unchecked.  
 

(f)  Choose menu item File > Save As and navigate to 
“C:\elandata\Methods\” folder.  Enter “As_HPLC-1_drc.mth” as the name 
of the method file and click the “Save” button.  

3. The ELAN method “As_HPLC-1_drc.mth” is now loaded into memory.  

 

 



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 38 of 107 

 

 

(3) Programming the ELAN “.dac” file 

1. If it is not already open, launch the ELAN program and in the “Instrument 
Control Session” window, choose menu item File > Review Files.  Click the 
“Load” button for “Optimization”, the sixth item on the list.  Navigate to the 
folder “C:\elandata\Optimize” and click on the “as_hplc_drc.dac” file then 
“Open”.  

2. If the “as_hplc_drc.dac” file cannot be found, or it has been changed or 
corrupted in a manner that makes its use questionable, cancel the open file 
dialog box and close the Review Files window by clicking the “Done” button. 
Do the following steps; otherwise, proceed to step 3: 

(a) Make the active method file the active window (do this by clicking on the 
tool bar icon that looks like a peak with a red arrow on crest of it). Then 
click File > Open on the menu bar navigate to the folder 
“C:\elandata\optimize\”. Click on the most current “default.dac” file then 
click the OK button.  Complete the “Current Value” column with the 
information in TABLE 9-11.  Note: Values in TABLE 9-11 are suggested 
starting values.  Instruments vary in their optimal parameter values, and 
analysts should use their discretion.     

TABLE 9-11: ELAN® OPTIMIZATION PARAMETERS 

Parameter Setting Parameter Setting 

Nebulizer Gas Flow (NEB): 0.9* Cell Path Voltage Std - 16* 

Auxiliary Gas Flow: 1.2 Rpa 0 

Plasma Gas Flow: 15 Rpq 0.6 

Lens Voltage: 7.5* Cell Gas A 0.6* 

ICP RF Power: 1450 Cell Gas B 0 

Analog Stage Voltage: - 1750* DRC Mode NEB 0.9* 

Pulse Stage Voltage: 1000* DRC Mode QRO - 10.5* 

Quadrupole Rod Offset Std 0* DRC Mode CRO - 2* 

Cell Rode Offset Std - 8* DRC Mode CPV - 15* 

Discriminator Threshold 70*   

    

*Suggested starting values only. Optimum parameters will depend on outcome of the optimization 
procedure (see Error! Reference source not found.).  

 
 

(b) Choose menu item File > Save As in the “ELAN Instrument Control 
Session” window menu bar and navigate to “C:\elandata\Optimization\” 
folder. Enter “as_hplc_drc.dac” as the name of the optimization file and 
click the “Save” button.  

3. The ELAN method “as_hplc_drc.dac” is now loaded into memory.  

(4) Creating the ELAN Sample Table “.sam” file 

1. If it is not already open, launch the ELAN program and in the “Instrument 
Control Session” window, choose menu item File > Review Files.  Click the 
“New” button for “Dataset”, the second item on the list.  Navigate to the folder 
“C:\hplc\data\” and enter the file name “As<yymmdd>” (where yy = last 2 digits 
of current year, mm = month, and dd = date of run, for example, As110201 
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denotes a Arsenic Speciation run on Feb 1, 2011) and click the “Open” button.  
The new dataset folder has been created and is now active.  Click on the 
“DONE” button in >Review Files Window.  

2. Click on the tool bar icon that looks like three Erlenmeyer flasks.  Choose File 
> New on the menu bar.  A new window will appear entitled “Samples – 
[Untitled]”.  Click the “Batch” tab then click on the “Sample Template…” 
button. A dialog box entitled “Sample Template Data” will appear.  Enter the 
following information:  

TABLE 9-12: SAMPLE TEMPLATE DATA 

Parameter Setting 

Sample ID Prefix: 1 

Sample ID Number: 101 

Sample ID Suffix: _  <a single underscore character> 

Increment: 1 

Autosampler Position – Number: 100 

Autosampler Position – Increment: 0 

Range – Start Row: 1 

Range – End Row: 5 

  

 
Click the “Generate” button.  

3. Again, click on the “Sample Template…” button. The same dialog box entitled 
“Sample Template Data” will appear. Enter this information:  

TABLE 9-13: SAMPLE TEMPLATE DATA 

Parameter Setting 

Sample ID Prefix: <empty> 

Sample ID Number: 001 

Sample ID Suffix: _  <a single underscore character> 

Increment: 1 

Autosampler Position – Number: 1 

Autosampler Position – Increment: 1 

Range – Start Row: 6 

Range – End Row: 105 

  

 
Click the “Generate” button.  

4. Scroll the sample table to the right using the horizontal scroll bar until the 
columns “Sample Flush” through “Wash Speed” are showing.  Highlight the 
cell in the first row of the “Sample Flush” column.  Enter “0” then tab to the 
next cell to the right, enter “0” again, tab again…i.e. enter “0” for all cells in the 
first row of columns “Sample Flush” through “Wash Speed”.  Next, click on the 
column header for “Sample Flush” to select the entire column and drag right to 
select all the columns right of and including the “Sample Flush” column. While 
these six columns are highlighted (i.e. darkened), go to the menu bar and 



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 40 of 107 

 

 

choose Edit > Fill Down. Zeros will fill down to replace every value with a zero. 
Scroll left to the first leftmost cell and click on it to select it.  

5. From the menu bar, choose File > Save As and save the file in the directory 
“C:\hplc\data\” using the name “As<yymmdd>.sam” (where yy = last 2 digits of 
the current year, mm = month, and dd = date of run).  

6. It is a good idea to save a copy of this file as a template, thereby avoiding the 
need to re-create it every time.  

p. HPLC–ICP-DRC-MS System Connection and Startup 

(1) Interfacing the HPLC Column to the ICP-DRC-MS Nebulizer   

1. Turn off the ICP-MS plasma if it is on. 

2. Remove any non-HPLC tubing that may have been installed in the nebulizer.  

3. Connect the HPLC column effluent tubing (coming from port #3 of switching 
valve #1) to the ICP-DRC-MS nebulizer/spray chamber assembly as shown 
below.  Note that this tubing is the “Peek Sample Uptake Fitting (Analytical 
West item name "500-QD-PEEK") or equivalent”. 

 

 

  

4.   The PEEK Sample Uptake Fitting is a prefabricated piece of yellow PEEK 
tubing attached to a white nebulizer-connector piece.   When inserting the 
connector into the nebulizer, ensure that it is pushed in as far as it will go and 
is secure.   
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Important! 

Inspect the tubing-nebulizer interface. I t is important that there is no gap between the end of the 
HPLC tubing and the portion of the nebulizer where it abruptly narrows to a capillary tube. Small 
gaps can contribute significantly to chromatographic peak broadening and tailing.  

(2) Priming the HPLC Pump 

1. Turn on the HPLC Series 200 Vacuum Degasser (switch is on back of unit).  

2. If it has not already been done, place each mobile phase reservoir tubing into 
the correct reservoir bottles, i.e. place end of tubing “A” into the bottle 
containing HPLC Buffer A, and end of tubing “B” into the bottle containing 
HPLC Buffer B.  Reservoir tubing “D” and “E” are placed into bottles 
containing 5% acetonitrile in water.  Press the “rinse” key on the autosampler 
to prime and rinse the autosampler fluid path.   

3. On the HPLC pump, open the door that accesses the pump head. Attach a 30 
mL or larger plastic syringe to the purge port. Open purge port by turning its 
knob counterclockwise ~¼ to ½ turn. 

 

 
 
 

Important! 
Be sure the HPLC pump’s purge port is open and that a syringe is attached before 
completing the next step. While there is no specific danger to the analyst, an over-pressure 
situation can occur that, under certain circumstances, could damage the HPLC pump, column or 
other components.  

4. At the HPLC pump control panel, press the “Purge” button. Press F4 (“%A”) 
followed by F3 (“FLOW”).  Key in 10 then press the “enter” key.  The pump will 
immediately start and quickly ramp up to a flow rate of 10 mL/min.  

5. Allow the pump to fill the syringe with about 15 mL of buffer A.  During this 
time, watch the reservoir tubing for air bubbles which should be flushed out.  If 
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there are “stuck” bubbles adhering to the inside wall the tubing, strike the 
tubing sharply with several firm snaps from your finger to jar and free the 
bubble(s).  The tubing should be bubble-free after ~10 mL of buffer has been 
pumped through. 

6. Press F5 (“%B”). The pump will now switch to reservoir B.  Again, watch for 
bubbles and make sure they are flushed out of the tubing.  Allow another 15 
mL of buffer to be pumped or until the syringe is almost full, then press the 
“stop” key to stop flow.  

7. Close the purge port (turn knob clockwise), remove syringe, and close door. 
Dispose of syringe contents to waste or in a sink. 

(3) Adjusting the External Peristaltic Pump 

1. Check the external peristaltic pump’s tubing for signs of wear which will be 
evident by flattening of the tubing and pinch-roller marks. Excessively worn 
tubing should be replaced.  

2. If necessary, install new large diameter (“white-black”) peristaltic tubing on the 
bottom channel of the external peristaltic pump.  Connect the left end of the 
“white-black” to the tygon “waste line” that leads to the large liquid waste 
carboy jug.  Connect the right end of the “white-black” to the tubing that 
empties the ICP-DRC-MS’s spray chamber.  Close the bottom channel clamp. 
Do a preliminary tightening of the peristaltic pump bottom channel’s tension 
clamps on the “white-black” pump tubing. Later, when you are able to observe 
liquid actively draining from the spray chamber, you will make further 
adjustments to the tension clamps so that the spray chamber will properly 
drain without applying excessive pressure on the tubing. Close the remaining 
clamps of the other channels except the top channel. 

3. In the peristaltic pump’s top channel, install new small diameter “black-black” 
peristaltic tubing on the top channel and close its clamp. Note that the 
peristaltic pump will rotate counterclockwise. Into the right end of the “black-
black” peristaltic tubing, insert the free end of the tubing that will draw Internal 
Standard solution (i.e. the one that will come from the Internal Standard 
bottle). Into the left end of the “black-black” peristaltic tubing, insert the tubing 
that will carry Internal Standard to Port #6 of switching valve #1 (see TABLE 
8-1-A).   

q. ICP-DRC-MS Warm Up and Performance Check  

1. Perform a pre-ignition check of the ICP-DRC-MS according to PE 
recommendations specified in the manual.   

2. Ensure that the digit “1” is displayed on switching valve #1.  If it is not, press 
the “local/remote” button until a yellow light indicates local mode.  Then, 
toggle the arrows to display a value of “1” in the digital window.  Additionally, 
ensure that a value of “1” is in the display on switching valve #2.   

3. Launch the ELAN® ICP-DRC-MS program and note whether all graphical 
indicators of instrument readiness are green.  If not, take the appropriate 
actions described in the instrument’s software and hardware manual.  

4. Perform necessary daily maintenance checks as described in Chapter 5 of the 
ELAN® 6100 Hardware Guide (e.g., argon supply, interface components, 
cleanliness, positioning, and interface pump oil condition).  Note the base 
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vacuum pressure in the INSTRUMENT window of the software.  (Before 
igniting the plasma, the vacuum is typically between 8 x 10 -7 and 1.8 x 10 -6 
torr).  Keep a record any maintenance procedures along with the base 
vacuum pressure in the Daily Maintenance Checklist logbook.  

5. Start the peristaltic pump by pressing the appropriate arrow on the peristaltic 
pump control panel.  Press either the up or down arrow keys to adjust the 
peristaltic pump speed to “6”. Ensure that the direction of rotation is correct so 
that the spray chamber is being drained and that waste liquid will go to the 
waste carboy jug.  

6. In the INSTRUMENT window of the ELAN software, click the “Front Panel” tab 
and click the plasma “Start” button to ignite the plasma.  In the same window, 
the ignition sequence bar (blue progress bar) will start to expand to the right, 
indicating the approximate time before plasma ignition.  Before the bar 
reaches its end, look at the spray chamber on the ICP-DRC-MS and watch for 
plasma ignition. Proper ignition will occur suddenly and with a single audible 
“pop”.  A bright white light will emanate from the injector assembly that 
connects to the spray chamber.  The light may at first flicker, but it should 
establish a more or less steady intensity after 5–10 seconds.  

On a rare occasion, the plasma may ignite emitting an orange, violently flickering light, and 
electrical discharge noises will be heard.  In this case, immediately shut off the plasma by 
pressing the yellow “Stop” button on the ICP-DRC-MS instrument’s front control panel.  Wait 
30 seconds then investigate the cause of the plasma misfire.  A more common occurrence is that 
the plasma may extinguish itself a few seconds after ignition.  Promptly reignite by pressing the 
“Start” button on the ICP-DRC-MS instrument’s front control panel.  Usually, the plasma will stay 
lit after the second try. If not, investigate the cause of this instability (refer to the ELAN DRC II 
Hardware Guide).  

7. Soon after the plasma ignites, place the sample probe (the one connected to 
the peristaltic pump’s “black-black” tubing, PerkinElmer P/N B300-0161, 
normally used for the ELAN® autosampler) into 5% nitric acid rinse solution or 
the daily performance check solution.  Set the speed on the external peristaltic 
pump to “20”.  Watch the tubing that drains the spray chamber for a half 
minute or so.  If the tubing is filling with liquid and you do not see bubbles 
being carried away from the spray chamber drain (and especially if you see 
liquid starting to rise within the spray chamber) immediately remove the 
sample probe from the rinse solution.  Check that the peristaltic pump is 
rotating in the proper direction so that the spray chamber is draining.  If not, 
immediately correct the direction of rotation on the peristaltic pump.  Next, 
tighten the thumb screw on the bottom tension clamp of the peristaltic pump 
about ¼ turn.  Examine smoothness of flow of liquid draining from the spray 
chamber.  If there is no liquid flow or if it continually “starts and stops”, tighten 
the thumb screw again.  Keep tightening the thumb screw until large bubbles 
flow through the drain line at a consistent pace.  Now, slowly loosen the 
thumb screw until the flow stops or becomes hesitant.  Make one final 
adjustment by tightening the thumb screw ½ turn.  At this point, the tension on 
the peristaltic pump tubing should be correct.  Re-insert the sample probe into 
the rinse solution.  

8. Repeat the preceding steps for adjusting the tension clamp for the “black-
black” tubing in the top channel.  

9. Let the ICP-DRC-MS warm up for 30-45 minutes.   
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10. The following step is for the initial method setup only: 

(a) While the instrument is warming up, in the ELAN program window 
entitled “Instrument Control Session”, choose menu item File > Review 
Files.  Click the “Load” button for “Optimization”, the sixth item on the list. 
Navigate to the folder “C:\elandata\Optimize” and click on 
“as_hplc_drc.dac” file then click the “Open” button.  Return to File > 
Review Files and click the “Load” button for “Method”, the first item on 
the list. Navigate to the folder “C:\elandata\Method” and click on “Daily 
Performance.mth” file then click the “Open” button.  Add a new line for 
arsenic “As” in the Quantitative Analysis Method window.  Set the Dwell 
Time to 50. Do a File > Save and save the edited method as 
“As_HPLC_daily.mth”.  Click on the Sampling tab and uncheck 
“Peristaltic Pump under Computer Control”.  Return to the Timing tab. 

11. After warm-up, complete the appropriate daily optimization procedures as 
described in Chapter 3 of the ELAN® 6100 DRC Software Guide.  Include 
beryllium (m/z 9) in the mass calibration, and be sure to use mass calibration 
solution containing 1 g/L beryllium.  Do the autolens optimization and daily 
performance check by using a 1 g/L multielement solution that includes 1 
g/L of arsenic.  Instrument response for 1 g/L arsenic should give counts 
>2000 cps (in Standard Mode). Fill in the Daily Maintenance Checklist in the 
instrument logbook according to the completed optimization procedures.  If a 
tuning (mass-calibration) procedure was done, save it to the file “default.tun,” 
and also in a separate file containing the analysis date “default_MMDDYY.tun” 
(where MM=month, DD=day, and YY=year).  Save the new optimization 
parameters (i.e., detector voltages, autolens values and nebulizer gas flow 
rate) to the file “As_HPLC_std.dac”.  Save it again to another new file named 
“default_<yymmdd.dac>” (where yy=year, mm=month, and dd=day; do not 
include the brackets in the file name). 

If an HPLC analysis is to be run the same day, you may leave the plasma on 
until it is time to convert the nebulizer to interface with the HPLC.  If not, press 
“Stop” on the ELAN control panel to turn off the plasma. 

r. Turning on the Reaction Cell Gas 

1. Start the flow of the reaction-cell gas (10% hydrogen, 90% argon) and allow 
the cell conditions to equilibrate.  Make sure the regulator on the reaction-cell 
gas cylinder is set to approximately 7 psi.   

2. Click on the “Manual Adjust” tab of the “Optimization” window and enter a 
value of “0” in the appropriate cell-gas field (cell-gas A or B, depending on 
how the instrument is set up).  Then enter a value of 0.6* in the same field.  A 
clicking should be heard from the ICP-DRC-MS cell-gas solenoid as the flow 
turns on.   

3. Monitor the flow on the mass-flow controller by clicking on the “Diagnostics” 
tab of the INSTRUMENT window of the ELAN program and look for a field 
labeled “Cell Gas A”. The flow should reach approximately “0.6*” within 10–15 
seconds.    

4. Flush the cell gas for 30 seconds by lifting the flush level at the front of the 
instrument.  (The flush step may not be necessary if this same gas cell was 
used recently and no gas tubing has since been disconnected.)  If possible, 
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allow 30 minutes for the cell to equilibrate before beginning analysis, with the 
cell gas flowing at 0.6* mL/min.  Note:  The cell gas will automatically turn off 
after 45 minutes if the analysis has not begun. 

*Or the DRC gas value that is found to be optimal 

5. Once the cell gas has warmed up, perform a DRC neb gas optimization and a 
lens voltage optimization.  Update the values if needed.  Perform a DRC 
Mode Daily Optimization Check and record the results in the Daily 
Maintenance Checklist.   

6. After the analysis of the DRC mode Daily performance check is complete and 
deemed satisfactory, change the selections on the 6-port switching valves #1 
and #2 to match the values described below: 

(a) Switching Valve #1: Remote, “1” 

(b) Switching Valve #2: Local, “2” 

7. Place the free end of the tubing that will carry the internal standard into a 
bottle containing 1 liter of the Internal Standard solution.  

s. Entering Sample Names into the ELAN Sample Table  

1. Click on the tool bar icon that looks like three Erlenmeyer flasks. If the current 
Samples window is not this run’s sample file, then choose File > Open on the 
menu bar and navigate to and open this run’s current data folder in 
“C:\hplc\data\”. Click on the file named “As<yymmdd>.sam” (yy = year, mm = 
digit month, dd = date) and open it. The Samples window will be the one 
created in the Creating the ELAN Sample Table “.sam” file section.   

2. Fill in the name of each sample by double-clicking after the “_” (underscore) in 
the cell matching its “A/S Loc”. Type in the sample name and press “Enter” on 
the keyboard. In this manner, enter the name of every blank, calibrator, quality 
control, and sample that will analyzed in the run.  If barcodes are used on the 
sample labels, use the barcode scanner attached to the ICP-DRC-MS 
computer to scan the sample ID from the barcode on each sample before 
placing it into position in HPLC autosampler tray.  

3. Keep the following in mind while filling out the Samples table.  

 Autosampler tray position 100 will contain the vial containing excess low or 
high QC sample, called “EQ”, which will be injected with five replicates during 
the initial system equilibration period that occurs before the start of 
calibration. “EQ” is not used for QC but is strictly for equilibrating the HPLC 
and conditioning the ICP-DRC-MS. 

 Autosampler tray position 99 needs to contain a blank vial (even an empty 
vial will do).  

 Insert a “Bk” between the equilibrators.  Also insert  blank checks throughout 
the run as needed to show that carryover is not occurring.  

 No more than 24 hours should lapse between the time that the actual 
analytical run starts (the analysis of the “Bk” in austoampler location 1) and 
the analysis of the last vial is complete.  Keep this in mind when determining 
how many samples will be analyzed. 
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TABLE 9-14: ELAN SAMPLES TABLE 

A/S 
Loc. 

Batch ID Sample ID Measurement 
Action 

Method … Wash Speed (+/- rpm) 

100  101_EQ Run Sample   0 

100  102_EQ Run Sample   0 

100  103_EQ Run Sample   0 

100  104_EQ Run Sample   0 

100  105_EQ Run Sample   0 

1  001_Bk Run Sample   0 

2  002_S0 Run Sample   0 

3  003_S1 Run Sample   0 

4  004_S2 Run Sample   0 

5  005_S3 Run Sample   0 

6  006_S4 Run Sample   0 

7  007_T0 Run Sample   0 

8  008_T1 Run Sample   0 

9  009_T2 Run Sample   0 

10  010_T3 Run Sample   0 

11  011_T4 Run Sample   0 

12  012_Bk check Run Sample   0 

13  013_LU-XXXX Run Sample   0 

14  014_HU-XXXX Run Sample   0 

15  015_Bk check Run Sample   0 

… …rows for 20 samples omitted for brevity …  … 

36  036_Bk check Run Sample   0 

37  037_LU-XXXX Run Sample   0 

38  038_HU-XXXX Run Sample   0 

       
The sample names will resemble those typed in bold in the example table above. In 
the example table above, a run of 20 samples is shown so the last vial ends up being 
placed in A/S Location #38. Of course, the actual position of the last sample depends 
on the total number of vials in the autosampler tray.  Note that, if more than one 
group of samples is to be analyzed, each group shall be bracketed by its own QC.  In 
some instances, on the sample table this rule will result in four QC samples being run 
in succession (for instance, LU-xxxx, HU-xxxx, LU-xxxx, HU-xxxx).  Be sure to delete 
all unused rows after the last vial in the ELAN Samples window, i.e. clear all rows 
after the last row by selecting them and press Ctrl-Delete.   

The numbers preceding the underscore character (with the exception of sample 
numbers “101” through “105”) correspond to the order of injection. These numbers 
will later help the analyst find individual chromatograms based on injection number 
rather than being forced to scroll long lists of alphabetically-sorted file names in 
Windows Open File dialog boxes looking for specific sample names during post-run 
data processing in TotalChrom™.  
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4. When satisfied that the Sample table entries are correct, choose File > Save.  

5. Analysts may print the ELAN Sample table by choosing the File > Print Setup 
> Reports command. In the ensuing dialog box, select the preferred printer 
and click OK. Next, choose File > Print and then click the Print button. 
Printouts may be helpful for the correct vial positions when loading samples 
into the HPLC autosampler tray.   

t. Starting the Run 

1. Restart the ELAN controller computer by going to the Windows Start button 
and choosing “Restart”. This serves to purge the computer of possible 
memory/register conflicts and will give the system and ELAN software a fresh 
start. It is unnecessary to shutoff the plasma as the ELAN instrument will 
sustain it while the computer does a restart.  

2. Check the waste carboy. If more than two-thirds full, empty it.  

3. Check that the tubing that draws internal standard is inserted into the bottle 
containing Internal Standard and that there is sufficient quantity of Internal 
Standard. 

4. Check that there is sufficient mobile phase to last the entire run. In addition, 
be sure that Bottle D and the HPLC Autosampler’s wash bottle contains 
sufficient amount of 5% (v/v) acetonitrile.  It is very important that line D does 
not become filled with air bubbles at any point during analysis.  

5. Set the HPLC Series 200 Column Oven to 35°C if it is not already at that 
temperature.  

6. Check for stray “.nc” files by using Microsoft Windows® File Explorer to look 
inside the C:\elandata\ReportOutput folder.  Move any existing files that end 
with “.nc” extension to another folder so that the C:\elandata\ReportOutput 
folder is empty of “.nc” files.  Close Windows File Explorer.  

7. Launch ELAN Instrument Control program if it is not already.  Do not launch or 
start any other programs at this time. 

8. Check that the correct Sample file in the window “Instrument Control Session” 
is active. If it is not correct, load the correct Sample file. In this window, note 
the injection number of the last vial as indicated by the numbered prefix 
leading the first underscore (“_”) character (e.g., 42 from “042_samplename”). 

9. Check that the HPLC pump methods are correctly programmed according to 
Programming the HPLC Pump Methods.  On the HPLC pump, press the 
softkey F5 (“SEQ”). Confirm that there are just three lines indicating sets 1, 2 
and 3.  Check that sets 1 and 3 are configured properly. Press softkey “SET”, 
input 2 then press the “enter” key.  Press softkey F4 (“LAST”) and input the 
injection number of the last vial noted in the preceding step.  Press the “enter” 
key. Press softkey F6 (“LINK”) then press the “return” key. The display will 
return to the top level.  Confirm that the top line in the pump control panel 
display displays “METHOD01 STORD SHTDN Q01.100.00” indicating that the 
pump methods are now linked. Do not press the softkey F8 (“STRT”) at this 
time.  

10. Check that the HPLC autosampler methods are correctly programmed 
according to Programming the HPLC Autosampler.  On the HPLC 
autosampler, press the softkey F6 (“DIR”), followed by softkey F4 (“RCL”). 
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Input 2 then press “enter” followed by “yes”. Next, press F2 (“METH”).  A new 
screen presents a table with column headers “First”, “Last”, “Volume”, 
“Replicates” and “Time”.  Using the arrow keys on the autosampler panel, 
highlight data field “LAST” and input the injection number of the last vial noted 
in the preceding two steps.  Press the “enter” key.  Next, press F6 (“STOR”), 
input 2 then press the “enter” key.  Respond to the next two prompts with a 
“yes” then a “no”.  Press the “return” key. If the word “LINKED” does not 
appear on the autosampler display, then link the methods together by 
pressing the F6 function key (“LINK”).  

11. Check that the correct ELAN method is loaded and active in the window 
“Instrument Control Session”.  If it is not correct, load the correct Method file. 
Check under the Sampling tab that “Peristaltic pump under computer control” 
is unchecked, and the pull-down menu “Sampling” indicates “External”.  

12. Check that the DRC gas is indeed flowing by making the ELAN’s Instrument 
window active and clicking on the Diagnostics tab.  Inspect the Cell Gas A or 
B, its value should be fluctuating at 0.6 (or other optimal value) ± 0.01 mL/min. 
If it is not, see section Turning on the Reaction Cell Gas for details to turn on 
the DRC gas flow.  Make the optimization window active and Choose File > 
Save to save the method file.  

13. Choose File > Review Files in the “Instrument Control Session” menu bar. In 
the next window, click the “Load” button for “Dataset” (second item) and 
navigate to this run’s data folder, double-click on it and click on the “OK” 
button.  The correct Dataset path should now be indicated.  Click the “Done” 
button.  

14. Check that all blanks, calibrators, QC and sample vials are loaded into their 
correct positions in the HPLC autosampler tray, as designated by the ELAN 
Sample window (or its printout).  

15. Press function key F5 (“SEQ”) on the Autosampler and check that the total 
number of injections (i.e., the sum of all injections for each listed method) 
agrees with the number of vials + 4 (accounting for the extra 4 injections of 
the equilibrator vial in position #100) in the autosampler tray. Press the 
“return” key to get back to the main screen.  See section Programming the 
HPLC Autosampler for details on how to program the autosampler.  Check 
that the HPLC autosampler’s methods are linked and that the word “LINKED” 
appears in the autosampler’s information screen.  

16. This step is optional but offers the advantage that the ELAN data files will be 
converted in real time to TotalChom™ “.raw” files that have names containing 
a date-time stamp corresponding to actual time of injection.  

(a) Launch TotalChrom™ Navigator.  In the resulting TotalChrom™ 
Navigator window, choose menu item Apps > ChromLink (alternatively, 
you may launch ChromLink™ from the operating system Start > 
Programs menu).  

(b) In the ChromLink™ program window, choose the menu item 
Configuration > Mass Details and check the Nominal Name and Mass for 
arsenic.  If it is missing or the ELAN tune (“default.tun”) file was re-
optimized earlier then ChromLink™ needs to be configured (see 
Configuration of ELAN ChromLink™ on page 55 for details). To save 
time, the analyst may choose to close the TotalChom™ Navigator and 
ChromLink™ windows and skip step 16 in its entirety.  Data file 
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conversion via ChromLink™ can easily be done during post-run data 
reprocessing. 

(c) In the ChromLink program window, click on the “Browse” button to the 
right of the “ELAN ChromLink file location” field.  Navigate to the current 
working folder, double-click on it then click the “OK” button so that 
ChromLink knows where to save its processed files.  

(d) Otherwise, refer to step (b) of Data Processing and Analysis for details 
on proper setting of the ELAN ChromLink™ window’s parameter fields. 
In the ELAN ChromLink window, click the button “Start Processing ELAN 
Data Files” to put ChromLink in watch mode so it will process each data 
for each injection in real time. A new dialog box will open and indicate it 
is ready to convert data and waiting for the first file.  

17. Click on the ELAN “Instrument Control Session” window to make it active, 
then click the mouse in the Samples window on the corner rectangle of the 
sample table (where row headers intersect column names).  The entire 
sample table will become highlighted (dark background).  Click the “Analyze 
Batch” button.  A Run Progress box will appear indicating that the ELAN 
software is now waiting for a signal from the HPLC that indicates the 
occurrence of an injection.  

18. If the HPLC pump is not already pumping, press function key F8 (“STRT”). 
This will start the flow of Buffer A and put the pump into a “wait for injection” 
mode.  

19. On the HPLC autosampler, press the “start” key. If the equilibration wait time 
has been reached, the autosampler will immediately begin its injection 
sequence. Otherwise, it will respond with the message ‘WAITING FOR 
EXTERNAL READY” and wait for the equilibration wait time to complete.  

20. In the Instrument window, click the “Auto Start/Stop” tab. It is important to note 
that if the “Enable” radio button is already selected and an ELAN run was 
cancelled by the analyst, you will need to select the “Disable” radio button to 
reset the Auto Stop timer. Forgetting to do this will result in premature shutoff 
of the plasma. Following this action, click the “Enable” radio button. Next, click 
on the “Change” button and set the “Delayed Shutdown Time” to 30 minutes. 
Click Okay.  

21. Open the ELAN “Instrument Control Session” Real-Time window by clicking 
the tool bar button that looks like a Gaussian distribution (or a blue 
chromatographic peak, if you prefer).  After the Real-Time window opens, 
click on the drop-down menu and select “Signal”. Real-time data will now be 
displayed.   

When the HPLC pump’s equilibration time has been reached, the autosampler will 
seek the first vial and make an injection.  A blue bar in the ELAN’s progress box will 
now indicate that data is being collected.  The system can now run unattended.  

Check the progress of the run after 2 or 3 injections.  Note the chromatograms 
appearing in the ELAN’s Real Time window.  Adjust the signal scale in the Real Time 
window, as necessary.  Compare the positions and peak heights of each arsenic 
species relative to the internal standard.  It helps to visually compare it to a printed 
reference chromatogram.  If abnormalities in retention time, peak height or shape are 
readily apparent, the analyst may need to stop the autosampler and pump and abort 
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the run in the ELAN program.  The HPLC pump and autosampler are stopped by 
pressing the “stop” buttons on their respective control panels.  Correct the problem(s) 
and restart the run.  

Important 
 
Remember to disable the ELAN’s Auto Stop feature before re-enabling it.  Otherwise, the ELAN 
may perform an auto shutoff prematurely. 

u. Instrument Shut Down 

1. Shut off ICP-DRC-MS plasma if it has not already been done.  Stop all 
peristaltic pumps and loosen tensioning bars and tubing.  

2. Check that the HPLC autosampler controller readout indicates that the 
sequence was successfully completed.  If not, note the message and 
investigate the reason for the message, for example, if a sample vial is 
missing. 

3. At the controller computer, visit the ELAN Instrument Control Session 
application and open the “Dataset” window.  Confirm that all samples were 
analyzed. 

4. Remove the calibrator, QC and sample vials from the HPLC tray. Discard 
them according to CDC biohazard waste disposal guidelines. 

 

10. POST-RUN DATA ANALYSIS 

a. Configuration of TotalChrom™ Integration Method 

The following information is presented as a starting point to help the analyst develop 
robust integration method parameters that will work best for most chromatography 
data.  Many of these parameters will work just fine as presented below.  However, 
the separation chemistry of HPLC columns can vary due to frequency of use, column 
replacement, or because of individual sample “oddities”.  Some parameters may 
need to be adjusted from time to time to maximize the ability of TotalChom™ to 
properly integrate peaks and identify components with minimum operator 
intervention.  Therefore, the analyst should pay particular attention to the 
chromatograms produced in every run and make necessary adjustments as 
warranted.  The analyst should be familiar with TotalChrom™ ‘s frequently used 
integration functions which are described in Chapter 18 of TotalChrom Workstation 
User’s Guide: Volume II.  

1. The creation of a new method file in TotalChrom™ is done the first time 
TotalChrom™ is setup, or it will need to be recreated if the file “Arsenic1.mth” 
cannot be found or has been corrupted.  In the TotalChrom™ Navigator 
window, choose the menu item Build > Method.  In the next dialog box, click 
the “Create a new method” radio button and click OK. The default method will 
load into the method editor.  
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2. Choose the menu item Process > Integration. Click on the “Integration” tab in 
the “Process” window.  Enter the information shown in TABLE 10-1. 

 

TABLE 10-1: INTEGRATION 

Basic Parameters  Advanced Parameters 

     

Bunching Factor : 1  Peak Separation Criteria  

Noise Threshold : 5  Width ratio : 0.2 

Area Threshold : 25  Valley to peak ratio : 0.01 

     

   Exponential Skim Criteria  

   Peak height ratio : 5 

   Adjusted height ratio : 4 

   Valley height ratio : 2 

 
The analyst may make appropriate changes to one or more of the Integration 
parameters in TABLE 10-1 if necessary.  

Click on the “Baseline Timed Events” tab. As a guideline, enter the information shown 
in TABLE 10-2 or other parameters as determined to be appropriate.  

TABLE 10-2: BASELINE TIMED EVENTS 

Defined Events 

Time Event Value Code Level 

0.000 Smooth Peak Ends On 5 +SM  

0.000 Locate Maximum On  LM  

0.000 Set Bunching Factor 3 BF  

0.000 Disable Peak Detection  - P  

0.350 Enable Peak Detection  +P  

0.500 End Peak Detection Inhibit  +I  

1.000 End Peak Detection Enable  - I  

1.000 Locate Maximum Off  -LM  

1.000 Set Bunching Factor 1 BF  

1.200 Common Baseline On  +CB  

2.200 Set Bunching Factor 2 BF  

2.250 Common Baseline Off  - CB  

6.250 Set Noise Threshold 3 NT  

6.250 Set Area Threshold  15 AT  

8.750 Peak End Detection Inhibit  +I  

10.80 Peak End Detection Enable  - I  
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Be sure there is no checkmark in the box for “Correct actual times of all baseline 
events based on actual RT of nearest reference peak”. The parameters in TABLE 
10-2 are starting points.  The analyst may make appropriate changes to one or more 
of the Baseline Timed Events if necessary.  

3. Click on the “Optional Reports” tab.  Uncheck the box for “Keep temporary 
files”. 

4. Click on the “Replot” tab. Enter the information shown in TABLE 10-3.  

 

TABLE 10-3: REPLOT   

Plots  Miscellaneous 

     

Generate a separate replot : not checked  Start plot at end of delay : checked 

Retention Labels : Peak crests*  Gradient overlay : not checked* 

Component Labels : Actual time  Draw baselines : checked* 

Scaling Type : Autozero offset  Timed Events : checked* 

Scaling Parameters   X axis label : Time [min] 

Full scale (mV) : 2.000*  Y axis label : Intensity [cps] 

*These parameters maybe altered to suit the analyst.  
 

It is unnecessary to click on the “User Programs” tab because it is not used.  Close 
the Process window by clicking on the “OK” button. The parameters in TABLE 10-3 
are starting points. The analyst may make appropriate changes to one or more of the 
Replot parameters if necessary.  In the Method Editor window, choose the menu item 
Components > Global Information.  Click on the “Integration” tab in the “Process” 
window.  Enter the information shown in TABLE 10-4:  
 

TABLE 10-4: Global Information   

Volume units : µL  Unidentified Peak Quant.  

Quantitation units : µg/L  Calibration factor : 1.000e+99 

Sample Volume  : 1.000  Always use calib. Factor : selected 

Void time (min) : 0.000    

Calibration     

Internal Standard selected    

   RRT Calculation  

Reject outliers during 
calibration : Not checked 

 Use first peak in run as RRT 
reference:  selected 

Sample Amount Options     

Correct amounts for calibration 
standards : Not checked 

   

 Convert unknown samples to 
concentration units: Not checked 
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The “LIMS Results” tab is not used. Click the “OK” button to close the window. The 
parameters in TABLE 10-4 are starting points. The analyst may make appropriate 
changes to one or more of the Global Information parameters if necessary. 

6. In the Method Editor window, choose the menu item Components > New 
Component.  The white list box in the left portion of the window will be empty. 
Click in the empty field labeled “Name” and type “IS”. Press the tab key and 
enter “0.6” in the field labeled “Retention time”. Put a checkmark in the box 
labeled “This component is an internal standard”.  Select the radio button 
labeled “Peak” if it is not already selected.  Leave the other fields and check 
boxes unaltered.  Click the “New Component” button.  Enter each of the 
component names and parameters listed in TABLE 10-7.  

TABLE 10-5: METHOD EDITOR – COMPONENTS SETTINGS 
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IS 0.6 5 3 No No  Yes No 

AC 1.70 3 3 No No IS No No 

AB 2.00 0 3 No No IS No No 

TMAO 2.10 3 3 No No IS No No 

AsIII 2.50 5 3 No No IS No No 

DMA 4.00 5 3 No No IS No No 

MMA 9.70 50 3 No No IS No No 

AsV 11.90 0 3 No No IS No No 
 

Click the “New Component” button before starting a new component.  After 
entering the last component, click the “OK” button.  The values for Retention 
Time, Absolute Window and Relative Window serve as starting points. The 
analyst may alter these values as actual chromatographic results may 
dictate.  

7. In the Method Editor window, choose the menu item Components > Defaults. 
Click on the “Identification” tab”.  Enter the information shown in TABLE 10-6.  

8.   Click on the “Calibration” tab in Components Defaults Window.  Enter the 
information shown in TABLE 10-7. 
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TABLE 10-6: COMPONENTS DEFAULTS — IDENTIFICATION 

     

Component Type : Peak  Reference : blank 

Absolute window : 5   Internal Standard : IS 

Relative window : 5  Find tallest peak : Not checked 

     

 
 
 

TABLE 10-7: COMPONENTS DEFAULTS — CALIBRATION 

  Level Amount 

Calibration Type : Use Curve S0 1.0000E-6 

Curve Type : 1st Order S1 2 

Scaling : None S2 10 

Weighing :  None S3 50 

Purity (%) : 100 S4 150 

Response :  Area   

Origin Treatment – Include : Not checked   

Origin Treatment – Force : Not checked   

    
 

9. The “User Values/LIMS” tab is not used.  Close the “Components Defaults” 
window by clicking the “OK” button.  

10. In the Method Editor window, click on “Components” in the menu bar.  If the 
menu item “Delete All Components” is not grayed out, select it and click the 
“OK” button when prompted to “Delete all components, calibration levels, and 
calibration replicates”.  Click the “OK” button.  

11. In the Method Editor window, choose the menu item Components > New 
Component.  The white list box in the left portion of the window will be empty. 
Click in the empty field labeled “Name” and type “IS”.  Press the tab key and 
enter “0.6” in the field labeled “Retention time”.  Put a checkmark in the box 
labeled “This component is an internal standard”.  Select the radio button 
labeled “Peak” if it is not already selected.  Leave the other fields and check 
boxes unaltered.  Click the “New Component” button.  Enter each of the 
component names and parameters listed in TABLE 10-7.  

12.  In the Method Editor window, choose the menu item Components > Edit 
Component then click the “Calibration” tab.  Click to highlight “TMAO” in the 
component list box.  Click on the cell containing “S0” and type “T0” (capital 
“T”) on the keyboard followed by the Enter key.  In this manner, replace “S0” 
through “S4” with “T0” through “T4”, respectively.  Click the “OK” button when 
finished.  
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13.  In the Method Editor window, choose the menu item File > Description, and       
type in your name and date this method was created.  Add any other pertinent 
information at this time. Click the OK button to close window.  

14. In the Method Editor window, Choose File > Save As.  A window appears 
inviting you to enter any information pertinent to this method, which will be 
saved with the method.  Enter your name and the date this method was 
created.  Click “OK” and a “TotalChrom™ File-Save-As” dialog box will open. 
Navigate the directory tree to get to the folder C:\HPLC\Methods. Double-
click on this folder.  In the “File name:” field, enter “Arsenic1.mth”.  If there is 
already a file in that folder with the same name, highlight that file and right-
click the mouse.  Choose “Rename” and give the file a new name (e.g. add 
“backup” to the name).  Click “Save’ and close the Method Editor window.  

b. Configuration of ELAN ChromLink™ 

ELAN ChromLink™ should be configured after initial installation of the program or 
when the ELAN tune (“default.tun”) file is re-optimized.  At least one recent ELAN 
NetCDF file (with the “.nc” extension) containing data for the mass of interest that 
was collected since the last update of the “default.tun” file will need to be available in 
order to complete this step.  

1. Launch TotalChrom™ Navigator.  In the TotalChrom™ Navigator window that 
appears, choose the menu item Apps > ChromLink (alternatively, you may 
launch ChromLink™ from the operating system Start > Programs menu).  

(a) Inside the ELAN ChromLink window, click on Configuration > Default 
TotalChrom Method.  Click on the “Browse…” button and navigate to the 
directory C:\hplc\methods\. Select “Arsenic1.mth” and click the “Open” 
button.  “C:\hplc\methods\arsenic1.mth” will now be the ChromLink™ 
default method.  Click “OK” to close the “Default TotalChrom Method” 
window.  

(b) Inside the ELAN ChromLink window, click on “Set”.  The “Operating 
Mode” window will open.  Click on the “Manual – process single ELAN 
NetCDF file” radio button then click the “Review ELAN NetCDF mass file 
components before processing” radio button.  Click “OK” to close the 
window.  Click on the “Browse…” button for “ELAN NetCDF file – 
location/file to be converted” field.  An open file dialog box will open, 
prompting you to choose a file.  Navigate to the latest working HPLC 
Data folder and choose any file with the “.nc” extension (perhaps one of 
the calibrators).  Click “Open”.  The dialog box will disappear and you will 
be returned to the “ELAN ChromLink” window.  The path and file to be 
converted will now be shown in the field called “ELAN ChromLink file – 
location/file to be converted”.  

(c) Click on the “Start Processing ELAN Data Files” button.  The “Processing 
ELAN Data” window will briefly open, followed by a window called “Mass 
Components in ELAN Data File”.  The file name being processed will 
appear in the ELAN File Contents panel along with its “Mass” and 
“Nominal Name”.  Write down the mass value.  The next panel called 
Configured Mass Components will show the mass and nominal name of 
the mass components that will be identified from the configured list and 
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be processed as separate TotalChrom RAW files.  If the fields for “Mass” 
and “Nominal Name” are empty, or are different compared to the 
corresponding fields for Configured Mass Components, then click the 
“Edit Configured Mass Components” button.  A new window called “List 
of Mass Components” will open.  Click on the cell in the table at the top 
of the window containing the mass that you wrote down earlier.  Next, 
Click on the field named “Nominal Names” in the “Names” panel and 
enter “As”.  Be sure the field named “ELAN Name (mass)” contains the 
mass value that you wrote down earlier.  Leave the field “Expression” 
unchanged.  Next, click on the “Browse…” button and navigate to 
“C:\hplc\methods\arsenic1.mth” then click “OK”.  Put a checkmark in the 
box for “Process this mass component to produce its own TotalChrom 
RAW file”.  Make sure that the box for “Process this mass component as 
part of an expression” is unchecked.  Now, click the “Update Selected 
Mass Component” button.  One line should now show the following 
information:  

Nom. 
Name 

Mass Expression raw? In 
expr? 

TotalChrom Method File 

As 74.92†  X  C:\HPLC\Methods\Arsenic1.mth 

† Or some value close to the atomic weight of arsenic.  

If not, repeat the above steps, except this time click the “Add as a new 
mass component” button.  Delete unnecessary lines by clicking on the 
line then clicking the “Delete selected mass component” button.  When 
satisfied that the List of Mass Components window is properly 
configured, click the “Close” button.  Next, click the “Close” button to 
close the “Mass Components in ELAN Data File” window.  Close the 
“Processing ELAN Data” window by clicking its “Close” button.  

(d) Inside the ELAN ChromLink window, click on the “Set” button. A window 
entitled “Operating Mode” will open. Click on the “Automatic – process all 
ELAN NetCDF files in specified location” radio button. The lower radio 
buttons will gray out. Click “OK” to close the window.   

2. At this time, ChromLink™ may be closed by selecting File > Exit.  Click “OK” 
at the dialog box asking if you want to quit ChromLink™.  

3. In addition to configuring ChromLink™ itself, it is necessary to alter one value 
in the “seed” method file that ChromLink™ uses to set a select number of 
parameters to certain default values.  This step only needs to be done once 
following the installation of ChromLink™.  

(a) In the TotalChrom™ Navigator window, choose the menu item Build > 
Sequence and a dialog box called “Startup” will appear. Click on the 
radio button labeled “Load sequence stored on disk” then click the OK 
button.  Navigate to the folder on the C drive that contains the 
ChromLink™ program file (usually in C:\PenExe\ChromLink but if it is not 
there, check under the C:\Program Files directory).  Click on the 
sequence file “seed.seq” to highlight it.  If this file is missing, reinstall 
ChromLink™.  Click “Open”. A spreadsheet style sequence table will 
present itself in a window called “Sequence Information – Channel A”. 
There will be a minimized window for channel B data, ignore this window. 
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Scroll across to the “Int Std Amt” column and click on the first cell in row 
1 of this column.  Replace the existing value with the concentration of 
working Internal Standard which is 2.5 µg/L Error! Reference source 
not found..  

(b) Choose menu item File > Save. Close the Sequence Editor window by 
choosing File > Exit from the menu bar.  

c. Data Processing and Analysis 

Refer to Figure 1 “Post-Run Data Processing Work Flow Diagram” (page 58) for a 
summary representation of the important aspects of post-run data processing.  

1. Open Microsoft Windows® File Explorer and open the current working HPLC 
data directory (e.g., C:\HPLC\Data\<current working folder>). Select all files 
ending with the .rst and .idx and “delete” them.  

2. If it is not already open, launch TotalChrom™. 

3. If ChromLink was not run in real-time data collection mode during the run as 
described in step 16 under Starting the Run (see page 48), do the following:  

(a) In the TotalChrom™ Navigator window, choose menu item Apps > 
ChromLink.  Choose the menu item Configuration > Mass Details and 
check the Nominal Name and Mass for arsenic.  If it is missing or altered 
then ChromLink™ needs to be configured (see Configuration of ELAN 
ChromLink™ on page 55 for details).  

(b) Check that the Mode field indicates “Automatic – Process all NetCDF 
files in specified location”.  If it does not, click the “Set” button to the right 
of this field and in the resulting “Operating Mode” dialog box click the 
“Automatic – process all ELAN NetCDF files in specified location” radio 
button.  Click “OK”.  Next, check that the Field labeled “ELAN NetCDF 
file – location/file to be converted” indicates the correct data folder.  This 
should be “C:\elandata\Reportoutput\*.nc”.  If it is not, click the Browse 
button to the right of it, and in resulting dialog box, navigate to that folder. 
Double-click on that folder then click “OK” to close the front most dialog 
box.  Click the Browse button to the right of the field labeled “ELAN 
ChromLink file location…”. In the dialog box “Select TotalChrom™ Data 
Location”.  Navigate to the folder containing the run data and double-
click on it.  Click “OK” to close that dialog box.  In the ELAN ChromLink 
window, click the button “Start Processing ELAN Data Files” to start 
processing of the run data.  A new dialog box will open and provide 
current information on the status of the data conversion.   

(c) When data conversion by ChromLink is completed within a minute or 
two, a message in the Step field will indicate “Successfully Finished”. 
Click “Close”. At this point, you may close the ELAN ChromLink 
application by choosing File > Exit or clicking on the window “x” box. In 
the resulting “OK to quit?” confirmation dialog box, click “OK”.  

4. In the TotalChrom™ Navigator window, choose the menu item Build > 
Method.  Click the “Load method stored on disk” radio button and click “OK”. 
In the TotalChrom™ File-Open” dialog box, find C:\HPLC\Methods folder and 
open “Arsenic1.mth” file.  The template method file should now be loaded.  
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FIGURE 1: POST-RUN DATA PROCESSING WORK FLOW DIAGRAM 
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If instead of loading the method file an error message says the file is 
unavailable because it is in use and asks if you would like to open it in Read-
Only mode, click “No”.  Cancel the Open-File dialog box, and exit the Graphic 
Method Editor.  In the Navigator window, choose menu item Admin > CAM 
Administrator.  A window will appear with two panes.  In the left pane, click 
on the “+” sign in front of “TotalChrom Servers” to expand it.  Click on the 
computer icon on the next line that just appeared to highlight it.  In the right 
pane, under the heading “Resource/Instrument”, select the first item.  If there 
is more than one item, select every item by shift-clicking on each item.  Every 
item should now be highlighted.  Choose Edit > Remove Locks (or press the 
Delete key on the keyboard).  Next, click on the “+” sign in front of “Users” to 
expand it.  Click to highlight your TotalChrom™ user name that appeared.  In 
the right pane, under the heading “Resource/Instrument”, select every item 
and Choose Edit > Remove Locks.  This action serves to unlock files and 
make them available for editing.  If in the future, TotalChrom™ complains 
that files cannot be edited because they are locked, use CAM Administrator 
to unlock them.  Choose File > Exit to quit CAM Administrator.  Start again at 
the beginning of this step to open the Method Editor.  

5. Choose File > Save As.  At the next window you will be given the option to 
enter information about the method which can be done at your discretion.  
Click “OK” and a TotalChrom™ File-Save-As” dialog box opens.  Navigate the 
directory tree to get to the folder that contains the ELAN data files for this run 
(typically in the folder C:\HPLC\Data\).  Double-click on this folder.  In the “File 
name:” field, enter the same name as it exactly appears for the folder that will 
contain it (i.e. As<yymmdd> convention where yy = last two digits of the year, 
mm = two digit month, dd = two digit date). Click “Save” then close the 
“Method Editor” window.  

6. In the TotalChrom™ Navigator window, choose the menu item Build > 
Graphic Edit.  Choose File > Open from the menu bar and navigate the file-
open dialog box to the folder containing the method file created in the 
preceding step. Click on that file and then click “Open”.  Return to Graphic 
Method Editor’s menu bar and choose File > New Data File.  Navigate to 
C:\HPLC\Data\ and double-click on the folder containing the run data.  Find 
and click on a data file (indicated by the “.raw” extension) that corresponds to 
the “S4” calibrator run.  When this file appears in the File Name field, click the 
Open button.  In the File-Open dialog box that appears, click “Cancel”.  If a 
message box appears with the warning “Unable to open this file: default.mth”, 
click OK to clear the message (you do not have to go to CAM Administration 
to unlock it).  Do the same if another message warning box appears (i.e. click 
OK again to clear it). You should be in the “Graphic Method Editor - <path to 
method file>” window and see a chromatogram. 

7. Choose menu item Calibration > Show Windows and retention window bars 
(looks like “H” style error bars) will appear.  Each retention time window bar 
should be located above the chromatographic baseline and contain an 
identified peak within its bounds.  If there are any bars at the bottom of the 
chromatogram located below the baseline, choose menu item Calibration > 
Edit Components.  Click on the first arsenic species peak that falls outside its 
retention time window to select it.  In the group of data fields located on the 
right side of the window, click on the “Name” dropdown arrow (located on the 
right side of the data entry field) and choose the appropriate species by name. 
Next, click on the “ISTD” field’s dropdown arrow and choose “IS”. Be sure the 
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“ISTD” checkbox is unchecked unless you are editing the “IS” peak; in this 
case put a checkmark in the “ISTD” checkbox.  It is usually not necessary to 
alter the retention time window’s “Absolute” and “Relative” window 
parameters, but you may do so if experience dictates that a change will be 
beneficial.  Click the Next or Prev button.  Repeat these steps for each arsenic 
species peak that was not properly identified because it was outside its 
retention time window.  Since TMAO is not present in any of the “S” 
calibrators, choose File > New Data and open one of the “T” series calibrators 
that contain TMAO (e.g., T4) and confirm its identity and retention time 
window using the same process as was used for S4.  When the editing of 
peak retention time windows is completed, click on the menu bar item 
“Return”.  Choose File > Save followed by File > Exit.  

8. Launch Microsoft® Excel and choose menu item HPLC > Create TC 
Sequence File (the Excel macro “Extract TC Data.xls” must be installed in 
Excel’s Startup folder).  In the open file dialog box, navigate to the current 
working HPLC data folder.  Click on a RAW file then click the “Open” button. 
Wait about 30 seconds until a “Done” message box appears.  Excel will create 
two sequence files, one containing just the calibrators (name ending with 
“calib.seq”) and the other file containing all samples and calibrators (named 
As<yymmdd>.seq).  You may leave Excel open.  
 
Skip the following steps (a) through (c) unless, for some reason, the Excel 
menu item HPLC > Create TC Sequence File cannot be run:  

(a) In the TotalChrom™ Navigator window, choose the menu item Build > 
Sequence and a dialog box called “Startup” will appear.  Click on the 
radio button labeled “Load sequence stored on disk” then click the OK 
button.  Navigate to the folder containing the run data and click on the 
sequence file (ends with “.seq”) corresponding to the run (typically 
named in the As_yymmdd.seq format).  Click “Open”. A spreadsheet 
styled sequence table will present itself in a window called “Sequence 
Information – Channel A”.  There will be a minimized window for channel 
B data.  Ignore this window.  Look for the “Method” column and click on 
the first cell in row 1 in this column.  Right click the mouse and a 
contextual menu will appear, choose ”Browse”. I n the resulting File-
Select dialog box, navigate and choose the method file (ending in “.mth”) 
created earlier.  Click ”Select”.  The path and name of the new method 
file will replace the default information in this cell.  Right click this cell 
again and choose Fill Down.  The new file name information will fill down 
to every cell in the “Method” column.  Look for the “Study Name” column 
and click on the first cell in row 1 in this column.  Note that this cell 
contains redundant information that is already in the Name column. 
Press the delete key to clear this cell.  Right click the mouse and a 
contextual menu will appear, choose “Fill Down”.  Right click this cell 
again and choose Fill Down.  This will clear every cell in the “Study 
Name” column.  Choose menu item File > Save.  Do not close this 
window yet.  

(b) Position the mouse cursor over the first row number (in the Row column 
on the far left side of the window) that is NOT a calibrator. The cursor 
should be in the form of a fat plus sign. If it looks like small vertical 
double-ended arrow, move the mouse slightly up or down until it changes 
to a fat plus sign. Press and hold down the left mouse button and drag 
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down across all the row numbers that are not calibrators. Check that you 
have not accidentally included calibrators, otherwise, deselect all the 
rows and try selecting again. Once you are sure that none of the 
calibrators are selected, choose menu item Edit > Delete. Repeat this 
process until only rows corresponding to calibrators are present in the 
sequence table. Click the cell in the first row in the “Type” column and a 
dropdown menu should appear. Choose “Cal:Replace”. Right-click on 
the same cell and choose Fill Down. At this time, “Cal:Replace” should 
appear in every cell in the ‘Type” column. 

(c) Inspect the Sequence Editor window for Excel-styled workbook tabs at 
the bottom. Locate the tab labeled “Calibration” (if you do not see it on 
first look, click on the small right arrow just left of the first tab, this will 
cause the tabs to “scroll” left and reveal additional tabs). Click on the top 
cell in the “Cal Level” column. A dropdown menu will reveal “S0”, “S1”, 
“S2” through to “T4” menu choices. Moving down the column, for each 
calibrator you will need to assign its level by choosing correct menu item 
from the dropdown menu.  When all calibrators are assigned their 
appropriate level, click on the cell in the “Calib Rpt” column 
corresponding to “S4” calibrator. A pop-down menu should appear; 
choose “Short”. Likewise, change the “Calib Rpt” for “T4” from “None” to 
“Short”. Choose menu item File > Save As. A window showing a 
Description field appears, just click OK and Save As dialog box will 
appear. Name the new sequence file the same name as the original 
sequence file except add the word “calib” to the end of the file name (be 
sure to separate the words by a space). Click the Save button. Then 
close the Sequence Editor window by choosing File > Exit from the menu 
bar. 

9. In the TotalChrom™ Navigator window, choose the menu item Sequence.  
Open the calibrator sequence file created in the previous step (the file will be 
named the corresponding date Asyymmdd_calib.seq).  A sequence table will 
open.  By looking in the “name” field, ensure that this table only displays 
information regarding calibrators from the run.  (The names for calibrators 
should match those in the Elan sample table created prior to the run, e.g. 
002_S0.)  If blanks, quality control material, samples, or any other names are 
present in any row of the “name” field, delete the entire corresponding row in 
which they are present.  Once only calibrators are present in this table, ensure 
that Cal:Replace is selected in the “type” field for all rows.  Additionally, 
ensure that the “Cal Level” field is complete.  Using the drop-down menu, Cal 
level fields for each row should match each level represented in the “name” 
field.  Lastly, ensure that the correct method is shown in the “method” field for 
all rows.  Save this sequence file (File > Save) and close. 

10. In the TotalChrom™ Navigator window, again choose menu item Sequence.  
This time, open the sequence file matching the date of the run that does not 
include “calib” in the title.  (It will look like Asyymmdd.seq.)  A sequence table 
containing all of the items represented in the run’s Elan sample file will 
appear.  In a manner similar to that in step 9, various field changes will have 
to be made.  This step is important for proper database importing.  In the 
“Type” field, use the drop-down menu to select the proper representation for 
each item in the entire list.  In this field, Calibrators should be marked 
“Cal:Replace,” blanks should be marked “Blank,” quality control materials and 
other control materials should be marked “Ctrl Sample,” and all other items, 
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including those assessed for quantitative measure and equilibrators, should 
be marked “Sample,” unless another title in the drop-down menu is 
appropriate.  Next, ensure that the “Cal level” field is populated for calibrator 
sample rows only.  If this field is not populated, select calibrator levels from a 
drop down menu by clicking in the field.  Make sure these selected calibrator 
levels correspond to names in the “Type” field for each row.  (For instance, a 
name of 002_S0 in row 2 should correspond to a Cal level of “S0” in row 2.)  
Next, ensure that the proper method is listed in the “Method” field of each row.  
(This method should be the same that was “saved as” in step 5 of this 
section).  Lastly, at the bottom of the sequence table, click on the “calibration” 
tab.  A new sequence table will display; ensure that each row in the field “Cal 
levels” is accurate.  Save this sequence file (File > Save) and close.        

11. In the TotalChrom™ Navigator window, choose the menu item Reprocess > 
Batch.  A new window appears entitled “Batch Reprocessing”.  Choose menu 
item File > Sequence and the “From Sequence” window appears. Locate the 
top field labeled “Sequence file” and look for a button with an open folder icon 
immediately to the right of the field.  Click this button and navigate, if 
necessary, to the folder containing the run’s sequence files.  Click on the 
sequence file whose name ends with “calib.seq” and click the Open button. 
You will be returned to the previous window.  Set each parameter in this 
window to the values shown in TABLE 10-8.   

12. Click “OK”.  

13. Choose menu item Reprocess > Start.  The middle panel will contain a list of 
raw file waiting to be processed.  Reprocessing of the chromatographic raw 
data will commence.   The bottom panel in the window will update with each 
file’s name as it is processed.  When processing is done, this panel will be 
clear of files.  Close this window.   

 

 

 

TABLE 10-8: TOTALCHROM™  NAVIGATOR – REPROCESS BATCH 

Parameter Name  Parameter Setting 

Starting Row : 1 

Ending Row : <number of rows in sequence file> 

Channel A : Checked 

Channel B : Not Checked 

Start Analysis : Peak Detection 

End Analysis : Calibration 

Batch Execution : Interactive 

Batch Printer : None 

Batch Plotter : None 

Enable Optional Reports in Method 
Use Method is Result File 

: Not Checked 

Grayed Out 

Overwrite Existing Result Files : Checked 

Raw File Treatment : Update existing raw file header with new sequence 
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14. In the TotalChrom™ Navigator window, choose the menu item Build > Method 
and open the method file for this run. If you get an error message telling you 
that you can only open this in read-only mode, then unlock the files by doing 
these steps:  

(a) Click “No” to cancel the error message. Select File > Exit to close the 
Method Editor.  

(b) In TotalChrom Navigator, select Admin > CAM Administration.  

(c) In the CAM Admin Tool window, click in the file explorer-like window on 
top of the “+” sign in front of “TotalChrom Servers” to expand it. Click on 
the server name. A list of files will reveal themselves in the right-hand 
window panel.  

(d) Click on the first file, hold down the shift key and click on the last file in 
the list. This will highlight all the files in the list. Press the keyboard’s 
“delete” key. This does not delete the actual files but only unlocks them.  

(e) Select File > Exit in the CAM Admin Tool window to close it.  

(f) Return to Method Editor window by selecting Build > Method in the 
TotalChrom™ Navigator window.  Begin this step again.  

15. Return to the menu bar and choose Window > Component List.  Position the 
mouse on the any of the four corners or edges of the Component List window 
until the mouse cursor turns to a double-headed arrow.  Expand the window 
until it fills its parent window.  

16. The Component List window is divided into three panels. The left panel lists 
each component by peak number, retention time and component name. 
Clicking on any of the components will reveal that component’s calibration 
data and calibration curve in the middle and right panels, respectively. 
Consecutively click on each component one at a time and individually inspect 
each component’s calibration curve.  It is important to note whether the 
calibration curve meets requirements for linearity, slope and intercept.  

(a) Watch for calibration points that obviously fail to display their expected 
Response Ratio (i.e. fall away from the regression line compared to their 
neighboring points). Typically, a point with a Response Ratio equal to 
zero indicates that a component peak was missed during peak 
identification phase of calibration processing. Likewise, a point that falls 
far from the calibration curve might be because that component’s peak 
was misidentified (perhaps confused for another component).  Inspection 
of nearby eluting component’s calibration curve might reveal an 
oppositely misaligned point for the same calibration level.  Return to 
Graphic Editor and alter the retention time windows as necessary, so all 
peaks will be correctly identified upon reprocessing.  

(b) While the regression line does not have to intersect every point, be 
especially mindful of “R-squared” value at the top left of the right panel. 
R-squared must exceed 0.990 (“two nines”) for each component. R-
squared values >0.999 is common for this procedure.  
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(c) Corrective action will need to be taken in any case of failure in the above 
rules.  Possible steps include: 

(i) Checking chromatograms to see if an autosampler injection was 
missed.  If so, all samples will have to be re-analyzed.   

(ii) Inspecting previous runs in database for deviating trends among 
calibration curves from separate runs.     

(iii) Inspecting chromatograms from previous runs to assess 
chromatographic shifts in retention time, peak height, or peak 
broadness.  These shifts could be a result of errors in buffer 
preparation, contaminated buffer solutions, an alteration of pH of 
buffer solutions, or a poor column. 

(iv) Deleting one extreme outlier point from the calibration curve if, in 
doing so, adequate linearity is achieved.  This step should not be 
common practice (for no more than 2 runs in a row should an analyst 
have to perform this corrective measure).  Analysts must include 
record of this action in a run summary email to supervisor(s).      

17. If the calibration curves pass inspection, close the Method Editor.  

18. In the TotalChrom™ Navigator window, choose the menu item Reprocess > 
Batch to reopen the “Batch Reprocessing” window.  Choose File > Sequence 
and click the button with the open folder icon located right of the field labeled 
“Sequence file”.  Navigate, if necessary, to the folder containing the run’s 
sequence files and click on the other sequence file whose name does not 
contain “calib”.  Click “Open”. Upon return to the previous window, set End 
Analysis to “Quantitiation” and Batch Printer to “None”.  All other parameters 
should remain unchanged.  

19. Click “OK” to close the front window.  Next, click the green “start arrow” 
button.  Reprocessing of the chromatographic raw data will commence.  

20. In the TotalChrom™ Navigator window, choose the menu item Reprocess > 
Results.  A new window should open called “Reprocess Results”.  If you get 
an error message telling you that you can only open this in read-only mode, 
then unlock the files (follow the procedure described in step 4 of this section). 
Select from the menu File > Open.  In the open file dialog box, click on the 
“Files of type:” dropdown menu and select “IDX files (*.idx)”.  Navigate to the 
folder containing this run’s data and click on the newest file (in the format of 
“As<yymmdd>-<today’s date>-<time of reprocessing>”).  Click “Open”.  A 
chromatogram will be presented for the first sample in the sequence in the 
Reprocess Results window.  Carefully inspect the chromatogram one peak at 
a time for correct peak identification and accurate baseline.  If you are 
satisfied that there are no integration problems, proceed to the next sample’s 
chromatogram by selecting File > Next File from the menu bar.  Examine all 
chromatograms in this manner and make corrections in peak identity and 
integration as necessary.  Make notes concerning issues encountered with 
individual chromatograms and changes that were made.  If a chromatogram is 
changed or edited in any way, be sure to select File > Save to save your 
changes.  See the chapter entitled “Developing Processing Parameters in the 
Method” in the PerkinElmer TotalChrom™ Workstation Users Guide for a 
detailed explanation on how to use integration events to optimize the 
integration of a chromatogram.  After review of each and every 
chromatogram, select File > Exit from the Reprocess Results menu bar.  
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21. Repeat step 18 except set both Start and End Analysis to “Report 
Generation”.  Set Batch Printer to “Find Print Factory Pro”.  A new window will 
open entitled “pdFactory Pro: <##> Jobs (## pages, ### Kb)”.  When 
reprocessing has completed, click the Save button on the pdFactory Pro 
window.  In the Save As dialog box that appears, navigate to the run’s data 
folder and create a new pdf file named “As<yymmdd> report”.  Be sure to 
include a space between “report” and the first word of the new file.  Click the 
Save” button.  This pdf file is to be kept and backed up, for archival purposes, 
in the same folder with all the other chromatographic data files for this run. 
Click the “Close” button to close pdFactory Pro window.  

22. Open Microsoft Excel and choose HPLC > Extract TC Data.  In the dialog box 
which follows, choose the sequence file created in step 10 of this section and 
click Open.  Immediately a macro will run that will transform the data into a 
format that is easily exported into the database.  Just before the macro 
finishes, a Save As dialog box will open giving you the opportunity to save the 
file as an Excel workbook.  Give the file a name as follows: “As<yymmdd> 
results”.   Note: For runs containing multiple groups of samples (each group 
being bracketed by its own quality control material), separate filenames will be 
necessary for each group.  The newly-created  “As<yymmdd> results” Excel 
file should be broken into multiple smaller files, labeled as “As<yymmdd> 
results Run 1”, “As<yymmdd> results Run 2”, and so forth, where Run 1 
corresponds to the first unique group in the spreadsheet, Run 2 corresponds 
to the second unique group in the spreadsheet.    

Each multi-tabbed Excel workbook contains a worksheet suitable for data 
exportation to the MS SQL Server 7™ database. Clicking on additional tabs 
will show worksheets for (a) summary table for easy visual review of the 
data, (b) quality control results, (c) calibration data with regression statistics 
and plotted calibration curves for each arsenic species, (d) instrument 
stability chart showing degree of consistency of internal standard peak areas 
plotted as a function of injection #, and (e) raw data (two tabs).  

23. The data processing portion on the instrument controller computer is now 
complete. At this point you may close Microsoft Excel® and TotalChrom™ 
Navigator.  

11. RECORDING OF SAMPLE AND QC DATA 

a. Transferring the Data to the Central Database  

1. Transfer the “As<yymmdd> results”.xls file (or the files representing each run) 
via encrypted USB drive or other data media to the appropriate subdirectory 
on the network drive where exported data are stored.  (Note that directories 
are named according to instrument\year\month\ and study name or ID, for 
example, 
“Q:\Nutritional\Instruments\ELAN\ELAN_DRC2H\2008\06\As080602”.)   

2. From a computer that has access to the Microsoft Access™ or MS SQL 
Server 7™ database used for tracking data start the program.  A “GoTo2 : 
Form” window should automatically open.  If it does not, you may have to 
open it manually.   
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3. Click the “Add Sample Results to Database” button. New buttons will appear. 
Click the “Import Instrument Data File” button.  For “Instrument”, choose 
“ELAN-DRC2D” (or the appropriate instrument). For “Assay”, choose “As 
Speciation 2”.  Choose the correct analyst from the drop-down list and the 
appropriate study.  It is not necessary to fill-in the “IS Lot Number” Field. Click 
“Import”.  Select the location of the data file on the network drive and press 
the “Open” button.   

4. In the “Imported Results” table, pressing the “Find X’s” button will show only 
those samples whose sample ID is not recognized as a valid QC pool ID or 
sample ID for this study.  (Sample IDs are set up when the study is logged 
into the database).  If necessary, corrections to sample IDs and dilution 
factors can be made in this table (e.g., correction of transcription errors and 
adjustment for level of dilution).  If samples were diluted for analysis, both the 
sample ID and the dilution factor need to be edited in this table before the 
values are transferred to the database.  First, change the dilution factor to 
reflect the way that the sample was analyzed then edit the sample ID to 
remove any comments about the level of dilution at which the sample was 
analyzed. (The replace command is useful here.)   

5. When corrections to sample IDs are made, press the “Recheck” button to 
evaluate the sample IDs.   Any sample or analyte row marked “Not 
Recognized” will not be transferred to the database when the “Transfer” 
button is pressed. 

6. Press the “Transfer” button to import data into the database.  

b. QC Data 

Once data is transferred to the Microsoft Access™ (or MS SQL Server 7™) database, quality 
control (QC) samples must be assessed for pass or failure through the generation of QC reports.    
The database allows for the printing of several types of QC reports.  If necessary, keep a copy of 
the report with the analysis printouts from the run (if the data needs to be printed).  The QC 
reports can be stored electronically. 

12. FINAL REVIEW OF THE DATA 

a. Analysis Printouts and Analyst Run Report 

Per the guidelines of each study, bind the analysis printouts with a printout of the 
calibration curve and curve statistics and place them in the study folder(s).  For some 
studies, this step is not necessary.     

b. Plotting QC Results 

When the Microsoft Access™ or MS SQL Server 7™ database is used, QC plots are 
updated automatically when the data are imported into the database.  Monitor these 
plots regularly for any trends in the bench QC results.  If trends are observed, contact 
the laboratory supervisor. 
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c. Supervisor Review 

The Microsoft Access™ or MS SQL Server 7™ database allows the supervisor to 
review the QC and sample results directly in the database.  After the supervisor 
reviews the data, he or she may mark results as “Ready to Report.” 

13. REPLACEMENT AND PERIODIC MAINTENANCE OF KEY 
COMPONENTS 

a. ICP-MS Maintenance 

Part numbers listed below are PerkinElmer part numbers from their 2006/2007 Consumables 
Catalog.  Equivalent high quality parts from other suppliers may be used as noted.  
 

1. Peristaltic pump tubing for sample (0.03 inch i.d., Item # 09908587), rinse 
station (can use either same tube type as for sample or 0.045-inch i.d., Item 
#N0680375) and for waste (0.125-inch i.d., Item #N8122012): Keep at least 6 
packages of 12 on hand of the sample tubing, 6 for rinse station and 2 
packages of 12 on hand of the waste tubing.  Other suppliers may offer the 
same size/type of peristaltic tubing.  

2. Autosampler probe assembly (Item # B3000161).  Keep a spare on-hand. 

3. Nebulizer capillary tubing   (0.023-inch i.d., Item #09908265 or any source of 
polyethylene tubing, 0.6 mm i.d. x 0.97 mm o.d.).  Use to connect the 
nebulizer and the peristaltic pump tubing.  Keep one pack (10 feet) on hand. 

4. Injector Support for ELAN DRC (Item # WE023951).  Keep one spare on 
hand. 

5. Ball Joint Cassette Torch Injector Support Adapter (Item # W1012406).  

6. Cassette Torch Mount for ELAN DRC II (Item # W1020672).  

7. Torch O-Ring Kit (packages of four, Item # N8120100).  Keep four spare 
packages on hand. 

8. Quartz torch.  At least two spare torches should be on hand (Item # 
N8122006). 

9. Quartz Sample Injector, 2.0mm Ball Joint (Item # WE023948).  At least two 
spare injectors should be on hand. 

10. RF coil (Item # WE021816).  One spare should be on hand. 

11. Platinum Skimmer (Item # WE027803 or equivalent) and platinum sampler 
cones (Item # WE027802 or equivalent).  Keep at least two spares of each on 
hand. 

12. Skimmer and sampler cone O-rings (Item # N8120512 and # N8120511, or 
equivalent, respectively).  Keep at least 10 spares of each on hand. 

13. Series II replacement Ion lens (Item # WE018034).  Keep two spares on hand. 

14. Pump oil for the roughing pump (Item # N8122004 or equivalent).  Keep four 
bottles on hand.  If an instrument is equipped with a Fomblin oil-based pump, 
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only one bottle of Fomblin oil (Ausimont or equivalent) is necessary to keep 
on-hand.   

15. Polyscience chiller coolant (PE Sciex Coolant, Item # WE016558A): Two 1-L 
bottles should be kept on hand. 

16. If possible, have a backup Polyscience chiller (or equivalent).  See a 
PerkinElmer sales representative for part numbers. 

14. LIMIT OF DETECTION AND LINEAR RANGE TESTED 

The limits of detection (LOD) for arsenic species in urine specimens are based on data taken 
from a minimum of 60 analytical runs.  At least four levels are used in each run with one level 
being below the LOD.  The matrix blank can be used to satisfy the criterion of having a level 
below the LOD.  Using the data from at least 60 runs, regression can be used to validly predict 
the standard deviation at the LOD concentration.  The LOD will be three times this calculated 
standard deviation, and this will represent the method detection limit.  Report results below the 
detection limit as “< LOD” (where “LOD” is the calculated lowest detection limit).  The LOD 
calculation is reevaluated once every two years.  
 

TABLE 14-1: LIMITS OF DETECTION (LOD) AND LINEAR RANGE TESTED (LRT) FOR AS 

SPECIES  

Species  
Chemical Name 

Abbreviated 
Name 

Limit of 
Detection, g/L 

Highest  Concentration for 

Linear Range Tested, µg/L 

Arsenobetaine AB 1.19 1000 

Arsenocholine AC 0.28 1000 

Trimethylarsine 
oxide 

TMAO 0.25 1000 

Monomethylarsonic 
acid 

MMA 0.89 1000 

Dimethylarsinic acid DMA 1.8 1000 

Arsenous (III) acid As(III) 0.48 1000 

Arsenic (V) acid As(V) 0.87 1000 

15. REPORTABLE RANGE OF RESULTS 

Urine arsenic results are reportable in the range of greater than the LOD, where LOD is the 
calculated limit of  detection.  When a sample result for any analyte is greater than the highest 
calibrator for the same analyte within the run, the result needs to be confirmed.  If a sample’s 
result for any analyte is greater than 110% of the Linear Range Tested (“LRT”) concentration (see 
TABLE 14-1), then the sample must be diluted with water before a repeat analysis can be 
performed.  Otherwise, the confirmation may be done without dilution in a run that includes an 
additional standard or external reference material (“Extended Range Check”) having a known 
analyte concentration equal to or greater than that measured in the sample, up to the LRT 
concentration. The Extended Range Check shall not be included in the calculation of the 
calibration curve; instead it will be analyzed like an unknown sample.  Its result will serve to check 
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the linearity of the regular calibration curve beyond the maximum calibration point. For the check 
to qualify, the measured concentration of the Extended Range Check result must be within ±10% 
of its nominal value. I f its value is within this target, the sample’s original result may be reported 
for the analyte.  If the Extended Range Check does not fall within the target specified, the sample 
must be diluted to bring its analyte concentration within the method’s regular calibration range.  

Results Greater Than Range of Linearity Tested:  Perform an extra dilution on any urine sample 
whose concentration is greater than those listed in Table 14-1 (the highest concentration for 
linear range tested).   

16. SPECIAL PROCEDURE NOTES – CDC MODIFICATIONS  

None applicable for this method.  

17. QUALITY CONTROL PROCEDURES 

The Inorganic and Radiation Analytical Toxicology Branch uses the method described in this 
protocol for environmental and occupational health screening studies.   

This analytical method uses two types of Quality Control (QC) systems:  With one type of QC 
system, the analyst inserts bench QC specimens two times in each analytical run (a set of 
consecutive assays performed without interruption) so that judgments may be made on the day of 
analysis.  With the other type of QC system, “blind” QC samples are placed in vials, labeled, and 
processed so that they are indistinguishable from the subject samples (as many as possible).  
The supervisor decodes and reviews the results of the blind specimens.  With both systems, 
taking these samples through the complete analytical process assesses all levels of the analyte 
concentrations.  The data from these materials are then used to estimate methodological 
imprecision and to assess the magnitude of any time-associated trends.  The bench QC pools 
used in this method comprise two levels of concentration spanning the “low-normal” and “high-
normal” ranges for each arsenic species.  Both of these pools are analyzed after the calibration 
standards are analyzed but before any patient samples are analyzed.  These bench QCs should 
be analyzed again at the end of the run.  If a second run of samples are analyzed using the same 
calibration curve as the first run, the QC results obtained from the second run’s own bench QC 
samples need to be analyzed and treated independent of the first run. 
  

a. Establish QC limits for each QC pool.   

A run to assess the homogeneity of the pools is performed after the pools are aliquotted into 
individual vials.  Vials are randomly chosen and randomly analyzed, and the first and last vials 
dispensed are always included in the homogeneity study.  Unlike the characterization of the QC, 
the homogeneity study can be completed in a single run.  Once analysis is complete, the data is 
evaluated in terms of QC recovery to determine whether or not trends exist in QC during the 
dispensing of the pool.  If the pool does not vary from beginning to end or problem vials can be 
identified and eliminated, the characterization of the QC is the next step.  If problems do exist, the 
source(s) of the problem has to be identified and the pool has to be re-made and dispensed 
again.   
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To complete the characterization that will allow you to assess limits for each pool, analyze a 
minimum of twenty samples of each pool (low and high) on 20 different days, preferably among 
all of the instruments that will be used to analyze this method.  During the 20 characterization 
runs, previously characterized QCs or pools with target values assigned by outside laboratories 
are also analyzed to evaluate each run’s QC.  Once analysis is complete, calculate the mean and 
standard deviation for each pool from the concentration results.  These values will be used to 
establish the limits for each pool. 

b. Precision and Accuracy 

QC Results Evaluation.  After completing a run, consult the QC limits to determine whether the 
run is “in control” for each of the seven analytes.  The QC rules apply to the average of the 
beginning and ending analyses of each of the bench QC pools.  The QC rules are as follows: 

1. If both the low-and the high-QC results are within the 2s limits, accept the run.  

2. If one of two QC results is outside the 2s limits, apply the rules below and reject the 
run if any condition is met. 

 13s – Average of both low QCs OR average of both high QCs is outside of a 
3s limit. 

 22s – Average of both low QCs AND average of both high QCs is outside of 
2s limit on the same side of the mean. 

 R4s sequential – Average of both low QCs AND average of both high QCs is 
outside of 2s limit on opposite sides of the mean. 

 10x sequential – The previous nine average QCs results (for the previous 
nine runs) were on the same side of the mean for either the low OR high QC.  

If the run is declared “out of control,” the analysis results for all patient samples analyzed during 
that run are invalid for reporting for the affected analytes. 

c. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable 
Criteria 

If an analyte fails to pass QC based upon the QC report, the following steps should be taken, if 
possible:  

 Check the chromatograms for each blank, calibrator, QC, and sample for proper peak 
integration and identification.  Check that the internal standard peak was properly integrated 
and identified. Change integration parameters or manually reintegrate peaks, if necessary, 
and reprocess the run in TotalChom™.  

 Check the ICP-DRC-MS stability during the run by examining the degree of variability and 
drift in internal standard raw peak areas over the course of the run.  Irreproducibility that 
exceeds 15% and drift >20% or sudden large changes in internal standard peak area likely 
indicates that there was a problem in plasma stability.  

 Setup a new run for the reanalysis of the patient samples affected by the previous failed run. 
Be sure to use freshly thawed calibrators and QC material.  
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 If these three steps do not result in correction of the out-of-control values for QC materials, 
consult the supervisor for other appropriate corrective actions.  No analytical results should 
be reported for runs that are not in statistical control. 

18. LIMITATIONS OF METHOD; INTERFERING SUBSTANCES AND 
CONDITIONS 

The argon chloride (ArCl) interferences on arsenic (75As) are eliminated by the operation of the 
DRC™ under the parameters noted in the sections above during the speciated arsenic analysis. 

19. REFERENCE RANGES 

The reference range for each arsenic species (see TABLE 19-1) is based on literature reports 
and from periodic review of accumulated data collected during the analysis of urine samples 
representing a normal, healthy population believed to be free of unusual exposure to arsenic. 
Where data is absent or scant, references ranges are based on the scientific literature, if 
available.  

TABLE 19-1: REFERENCE RANGES FOR ARSENIC SPECIES  

Species Chemical Name Reference Range1, µg/L  

Arsenobetaine <LOD – 7.9  

Arsenocholine <LOD  

Trimethylarsine oxide <LOD  

Monomethylarsonic acid <LOD – 7.1  

Dimethylarsinic acid 1.8 – 12.2  

Arsenous (III) acid <LOD – 2.5  

Arsenic (V) acid <LOD – 3.2  

1 There are no established reference ranges for arsenic species. Above ranges are estimates based 
on CDC unpublished data.  5-95 percentile of randomly selected NHANES 2002 samples n=48. 

20. ACTION-LEVEL RESULTS   

If a patient sample has a non-dietary arsenic concentration greater than 50 g/L, the levels will 
have to be reported by fax, telephone, or E-mail to the supervising physician or principal 
investigator.  This is not done by the reviewer(s) of the data and not the analyst. 

21. SPECIMEN STORAGE AND HANDLING DURING TESTING 

Specimens may reach and maintain ambient temperature during analysis.  Take stringent 
precautions to avoid external contamination.  After the samples are analyzed, return them to  -
20°C freezer storage as soon as possible.  
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22. ALTERNATE METHODS FOR PERFORMING TEST AND STORING 
SPECIMENS IF TEST SYSTEM FAILS 

If the analytical system fails, freezer storage ( -20°C) is recommended until the analytical system 
is restored to full functionality. 

23. TEST-RESULT REPORTING SYSTEM; PROTOCOL FOR REPORTING 
CRITICAL CALLS (IF APPLICABLE) 

Report test results as outlined in the DLS Policies and Procedures Manual.  For critical calls, the 
supervisor should notify the supervising physician or principal investigator as soon as possible.  
The most expeditious means should be used (e.g., telephone, FAX, or E-mail). 

24. TRANSFER OR REFERRAL OF SPECIMENS; PROCEDURES FOR 
SPECIMEN ACCOUNTABILITY AND TRACKING 

For select studies, the person that receives specimens or samples delivered to Inorganic and 
Radiation Analytical Toxicology Branch sets up a “Specimen Folder.”   He or she is to fill out a 
tracking form and place it in the folder to be given to the analyst performing the analysis. The 
form tracks location, status, and final disposition of the specimens.   When sample analysis is 
completed, update and place the tracking form in the Specimen folder.  

Use standard electronic record keeping means (e.g., Microsoft Access™, encrypted USB 
devices, or CD-R backups) to track specimens.  Maintain records, including related quality 
assurance (QA) and QC data, for 3 years or longer.  Keep duplicate records (off site, if sensitive 
or critical) in electronic or hard-copy format.  Use only numerical identifiers (e.g., case ID 
numbers); all personal identifiers are available only to the medical supervisor or project 
coordinator to safeguard confidentiality. 

25. BI-ANNUAL EXTENDED LINEAR RANGE VERIFICATION STUDY 

Per CLIA requirements, twice per year, the extended linear range of the method has to be 
verified.  This is accomplished by analyzing the extended calibrators for each series (i.e. S5, S6, 
S7, T5, T6, and T7) as samples.  The concentration for each species has to fall within 10% of its 
nominal value or remedial action has to be taken. 

26. BI-ANNUAL INSTRUMENT-TO-INSTRUMENT COMPARISON 

Per CLIA requirements, twice per year, if an analytical method is performed on more than one 
instrument, then an instrument-to-instrument comparison has to be performed.  This is usually 
done in conjunction with the extended linear range verification study.  The same samples have to 
be analyzed on each instrument, and the Pearson Product Moment Correlation Coefficient for the 
results for each species has to be greater than 0.95.  If not, remedial action has to be taken.   
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28. APPENDIX 

a. Macro Procedure “Extract TC Data” 

The following Microsoft Excel® macro procedure was custom written to do the final reformatting of 
the TotalChrom™ export data file so that it can be directly imported into the central Microsoft 
Access™ database. It also creates a calibration plot for each of arsenic species calibration data 
including regression statistics for archival purposes.  After all reprocessing steps are performed, 
Microsoft Excel® is opened and and the macro “Extract TC Data” is ran. It will automatically 
perform the transformation of the reprocessed data and when it is finished, the analyst will be 
prompted to save the newly created Excel® workbook using a name of his or her choice. The first 
worksheet in the new Excel workbook file contains the run’s results data that is ready to be 
directly imported into the database. Step by step instructions are described in “Data Processing 
and Analysis” in the Post-Run Data Analysis section. The entire macro can be pasted into an 
Excel macro module and saved.  

Attribute VB_Name = "Module1" 
Private Declare Sub TcInit Lib "TcAccess.dll" Alias "VbTcAccessInit" () 
Private Declare Function TcLoggedOn Lib "TcAccess.dll" Alias "VbTcAccessLoggedOn" () As Integer 
Private Declare Function TcOpenConv Lib "TcAccess.dll" Alias "VbTcAccessOpenConversation" (ByVal 
Topic As String) As Long 
Private Declare Function TcCloseConv Lib "TcAccess.dll" Alias "VbTcAccessCloseConversation" 
(ByVal Conv As Long) As Integer 
Private Declare Function TcErrorMsg Lib "TcAccess.dll" Alias "VbTcAccessErrorMessage" () As 
String 
Private Declare Function TcSet Lib "TcAccess.dll" Alias "VbTcAccessSet" (ByVal Conv As Long, 
ByVal ItemName As String, ByVal Value As String) As Integer 
Private Declare Function TcGet Lib "TcAccess.dll" Alias "VbTcAccessGet" (ByVal Conv As Long, 
ByVal ItemName As String, ByRef Value As String) As Integer 
 
Public pathToMethodParametersFile As String 
Public concIS As Variant 
Public blankName As String 
Public massName As String 
Public zeroCalibName As String 
Public injNumberPattern As String 
Public myTableName As String 
Public howManyBlanks As Variant 
Public useAlternateFormula As Boolean 
Public altFormulaCommentCode As String 
Public CommandButtonDoneClicked As Boolean 
Dim PromptForSaveAsDialog As Boolean 
Public lastCol As Integer 
 
Const PENenvironPath = "PEN_PATH" 
 
Dim dataContainingRegion As String 
Dim targetRange1 As Integer 
Dim useIntercept As Boolean 
Dim arsenicspeciesInCalibMixB 
 
Public Sub ExtractTCData() 
' Version 2.0 
' Created by Carl Verdon, 8/15/2006 
' Updated 2/21/2008 by C. Verdon 
 
    Dim x As Variant 
    Dim y As Variant 
    Dim i As Integer 
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    Dim j As Integer 
    Dim compIndexCount As Integer 
    Dim nRows As Integer 
    Dim nPoints As String 
    Dim peakRT As String 
    Dim peakHt As String 
    Dim peakArea As String 
    Dim IS_peakArea As String 
    Dim peakRatio As Double 
    Dim peakRatio_zero_calib As Double 
    Dim peakRatio_blank As String 
    Dim peakName As String 
    Dim mthConcUnits As String 
    Dim mthCompName As String 
    Dim peakStartValue As String 
    Dim mthLevelConc As String 
    Dim mthLevelCount As String 
    Dim nameOfBlk As String 
    Dim componentResult As String 
    Dim finalResultFormula As String 
    Dim finalResultName As String 
    Dim componentRawResult As String 
    Dim peakName_index As String 
    Dim peakIndex As String 
    Dim rstSampleDilFactor As String 
    Dim rstPeakCount As String 
    Dim rstNumComponents As String 
    Dim seqCreationDate As String 
    Dim seqCreationTime As String 
    Dim rstCreationDate As String 
    Dim rstCreationTime As String 
    Dim seqEditDate As String 
    Dim seqEditTime As String 
    Dim seqFileAuthor As String 
    Dim mthMethodDescription As String 
    Dim peakList As String 
    Dim resultFile As String 
    Dim rawFile As String 
    Dim rawDataPoints As String 
    Dim fileSpec As Variant 
    Dim filespec_mth As String 
    Dim destWkbookname As String 
    Dim methodFile As String 
    Dim rstSampleNotes As String 
    Dim seqLevelName As String 
    Dim mthLevelName As String 
    Dim iSeqCycleIndex As Integer 
    Dim SeqNumCycles As String 
    Dim calibCurveCoeffients As String 
    Dim mthCompStr As String 
    Dim mthCompNum As Integer 
    Dim comp_level_Name As String 
    Dim sampleRate As String 
    Dim runTime As String 
    Dim plotAddress As String 
    Dim sampleNamesAddress As String 
    Dim iSeqNumCycles As Integer 
    Dim RetVal As Integer 
    Dim numMissingFiles As Integer 
    Dim iComponentIndex As Integer 
    Dim jComponentIndex As Integer 
    Dim progressIndicator As Long 
    Dim strComponent As String 
    Dim calibCurveCoeff_0 As String 
    Dim calibCurveCoeff_1 As String 
    Dim calibCurveCoeff_5 As String 
    Dim rsp As Variant 
    Dim iRet As Variant 
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    Dim iRet2 As Variant 
    Dim iRet3 As Variant 
    Dim pkName As Variant 
    Dim originalStatusBar As Variant 
    Dim resultsSheetName As String 
    Dim rawSheetName As String 
    Dim stabilitySheetName As String 
    Dim chromeraSheetName As String 
    Dim qcResultsShtName As String 
    Dim seqSampleName As String 
    Dim seqSampleType As String 
    Dim rstSampleName As String 
    Dim rstStudyName As String 
    Dim rstMethodName As String 
    Dim workBookName As String 
    Dim thisFilename As String 
    Dim blks_seq_list As String 
    Dim c_SEQ As Variant                   'TcAccess conversation handles 
    Dim c_RAW As Variant                   'TcAccess conversation handles 
    Dim c_RST As Variant                   'TcAccess conversation handles 
    Dim c_MTH As Variant                   'TcAccess conversation handles 
    Dim ShowWarningMsg As Boolean 
    Dim thisIsTheIntStd As Boolean 
    Dim dirExist As Boolean 
    Dim itDoesExist As Boolean 
    Dim TcErroMsg As String 
    Dim useIntercept As Boolean 
    Dim breakHere As Boolean 
    Dim bIntStdWasFound As Boolean 
    Dim calib_S1_exists As Boolean 
    Dim firstLowQCSample As Boolean 
    Dim firstHighQCSample As Boolean 
    Dim internalStdWasFound As String 
    Dim tcNavProgramPath As String 
    Dim tcLCDservicePath As String 
    Dim strPenPath As String 
    Dim PEN_Service_Name As String 
    Dim strVersionNo As String 
    Dim zeroLevelName As String 
    Dim firstLevelName As String 
    Dim lowBenchQCName As String 
    Dim highBenchQCName As String 
    Dim rstIntStdConc As String 
    Dim currentDir As String 
    Dim filePathName As String 
    Dim nameSaveAsFile As String 
    Dim commandLine As String 
    Dim internalStdName As String 
    Dim equation1 As String 
    Dim equation2 As String 
    Dim macroName As String 
    Dim todaysDate As String 
    Dim currentTime As String 
    Dim savedNameSuffix As String 
    Dim columnDescription As String 
    Dim calibPrepDate As String 
    Dim stabilityShtRange As Range 
    Dim chromeraDataShtRange As Range 
    Dim btn As Object 
    Dim dLevel As Object 
    Dim dLevel2 As Object 
    Dim dCompName As Object 
    Dim dCompName_numberOfLevels As Object 
    Dim dCompName_i As Object 
    Dim dAmount As Object 
    Dim dSeqIndex_resultFile As Object 
    Dim dSeqIndex_seqSampleName As Object 
    Dim dSeqIndex_seqSampleType As Object 
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    Dim dSeqIndex_rawFile As Object 
    Dim dSeqIndex_levelName As Object 
    Dim dLevelName_iSeqCycleIndex As Object 
    Dim dPeakNameZeroLevel_peakRatio As Object 
    Dim dPeakNameBlank_peakRatio As Object 
    Dim calibCurveCoeff_array 
    Dim rawPointsArray 
     
    If Len(Environ(PENenvironPath)) > 0 Then 
        strPenPath = Environ(PENenvironPath) 
        strPenPath = strPenPath & "\" 
    Else 
        MsgBox "Cannot find the string " & Chr(34) & "%PEN_PATH%" & Chr(34) & " in the Operating 
System's environmental variables table.", _ 
            vbOKOnly + vbExclamation, "Macro Aborted" 
            Exit Sub 
    End If 
     
    strVersionNo = Mid(strPenPath, InStr(1, strPenPath, "Ver6", vbTextCompare), 8) 
    PEN_Service_Name = "PEN LCD Service for TcWS " & strVersionNo  'PEN LCD Service for TcWS 
Ver6.2.0 
    tcNavProgramPath = strPenPath & "TCNav.exe" 
    tcLCDservicePath = strPenPath & "LCD.exe" 
    ShowWarningMsg = False 
    progressIndicator = 0 
    numMissingFiles = 0 
    firstLowQCSample = True 
    firstHighQCSample = True 
     
    itDoesExist = False 
    peakRatio_blank = 0 
    peakRatio_zero_calib = 0 
'    peakRatio_minus_bk = 0 
    internalStdName = "IS"  'default name for internal standard 
    concIS = 1              'default concentration of internal standard in ppb 
     
    massName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "MassName_string", "As", True) 
    zeroLevelName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "zeroCalibName_string", 
"S0", True) 
    useIntercept = OGetSetting("VBA", "Sub_HPLCtransformVariables", "UseIntercept_boolean", True, 
True) 
    lowBenchQCName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "LowBenchQCName_string", 
"LU-03102", True) 
    highBenchQCName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "HighBenchQCName_string", 
"HU-03104", True) 
    nameOfBlk = OGetSetting("VBA", "Sub_HPLCtransformVariables", "BlankName_string", "Bk", True) 
    columnDescription = OGetSetting("VBA", "Sub_HPLCtransformVariables", 
"columnDescription_string", "not entered", True) 
    calibPrepDate = OGetSetting("VBA", "Sub_HPLCtransformVariables", "calibPrepDate_string", "", 
True) 
     
    firstLevelName = Left(zeroLevelName, Len(zeroLevelName) - 1) & "1" 
 
    todaysDate = Date 
    currentTime = Time 
     
    If useIntercept Then 
        savedNameSuffix = " Results" 
    Else 
        savedNameSuffix = " Results (calib intercept not used)" 
    End If 
     
    fileSpec = Application.GetOpenFilename(FileFilter:="Seq Files (*.seq), *.seq", Title:="Choose 
a Sequence File") 
    If fileSpec = False Then 
       Exit Sub             'assume user clicked the Cancel button 
    End If 
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    thisFilename = Right(fileSpec, Len(fileSpec) - InStrRev(fileSpec, "\", -1, vbTextCompare)) 
    workBookName = Left(thisFilename, Len(thisFilename) - 4) 
     
    originalStatusBar = Application.DisplayStatusBar 
    Application.DisplayStatusBar = True 
     
    On Error Resume Next    ' Defer error handling 
    iRet = TcLoggedOn() 
    If iRet = 0 Then 
        Application.StatusBar = "Starting PEN LCD Service, please wait..." 
        Shell "NET START " & Chr(34) & PEN_Service_Name & Chr(34)  
'C:\PenExe\TcWS\Ver6.2.0\Bin\LCD.exe 
        Pause5seconds 
        commandLine = tcNavProgramPath 
        Application.StatusBar = "Launching TotalChrom, please wait..." 
        RetVal = Shell(commandLine, vbMinimizedNoFocus) 
        Pause5seconds 
        If RetVal = 0 Then 
            MsgBox "TotalChrom could not be launched.", vbOKOnly + vbExclamation, "Macro Aborted" 
            Application.StatusBar = "" 
            Application.DisplayStatusBar = originalStatusBar 
            Application.ScreenUpdating = True 
            Exit Sub 
        End If 
    End If 
     
    Set dLevel = CreateObject("Scripting.Dictionary") 
    Set dLevel2 = CreateObject("Scripting.Dictionary") 
    Set dCompName = CreateObject("Scripting.Dictionary") 
    Set dCompName_numberOfLevels = CreateObject("Scripting.Dictionary") 
    Set dCompName_i = CreateObject("Scripting.Dictionary") 
    Set dAmount = CreateObject("Scripting.Dictionary") 
    Set dSeqIndex_resultFile = CreateObject("Scripting.Dictionary") 
    Set dSeqIndex_seqSampleName = CreateObject("Scripting.Dictionary") 
    Set dSeqIndex_rawFile = CreateObject("Scripting.Dictionary") 
    Set dSeqIndex_levelName = CreateObject("Scripting.Dictionary") 
    Set dSeqIndex_seqSampleType = CreateObject("Scripting.Dictionary") 
    Set dLevelName_iSeqCycleIndex = CreateObject("Scripting.Dictionary") 
    Set dPeakNameZeroLevel_peakRatio = CreateObject("Scripting.Dictionary") 
    Set dPeakNameBlank_peakRatio = CreateObject("Scripting.Dictionary") 
    
    Application.Workbooks.Add 
    Application.DisplayAlerts = False 
    For i = 1 To Workbooks.Count 
        Sheets(i).Delete 
    Next i 
    Application.DisplayAlerts = True 
            
    If Sheets(workBookName).Name = Empty Then 
        ActiveSheet.Name = Right(workBookName, 30) 
    Else 
        ActiveSheet.Name = Right(workBookName & " copy", 30) 
    End If 
         
    Application.StatusBar = "Extracting TotalChrom data, please wait... " 
    Application.ScreenUpdating = False 
     
    resultsSheetName = ActiveSheet.Name 
     
    Sheets.Add After:=Worksheets(Worksheets.Count) 
    stabilitySheetName = "IS Stability" 
    ActiveSheet.Name = stabilitySheetName 
    Range("A1").Select 
    Set stabilityShtRange = Selection 
    With Selection 
        .Value = "IS Area" 
        .HorizontalAlignment = xlRight 
        .Interior.ColorIndex = 15 
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        .Interior.Pattern = xlSolid 
    End With 
     
    Sheets.Add After:=Worksheets(Worksheets.Count) 
    ActiveSheet.Name = Right(resultsSheetName & " Raw", 30) 
    rawSheetName = ActiveSheet.Name 
    Range("A1").Select 
    With Selection 
        .Value = "RT (min)" 
        .HorizontalAlignment = xlRight 
        .Interior.ColorIndex = 15 
        .Interior.Pattern = xlSolid 
    End With 
    Range("B1").Select 
     
    Sheets(resultsSheetName).Select 
         
    With ActiveSheet 
        .Range("A1").FormulaR1C1 = "Run ID" 
        .Range("B1").FormulaR1C1 = "Seq No." 
        .Range("C1").FormulaR1C1 = "Sample ID" 
        .Range("D1").FormulaR1C1 = "Type" 
        .Range("E1").FormulaR1C1 = "Study ID" 
        .Range("F1").FormulaR1C1 = "Result Date-Time" 
        .Range("G1").FormulaR1C1 = "Result File" 
        .Range("H1").FormulaR1C1 = "Method File" 
        .Range("I1").FormulaR1C1 = "Dilution" 
        .Range("J1").FormulaR1C1 = "Calib Name" 
        .Range("K1").FormulaR1C1 = "Calib Conc" 
        .Range("L1").FormulaR1C1 = "Analyte ID" 
        .Range("M1").FormulaR1C1 = "Ret Time" 
        .Range("N1").FormulaR1C1 = "Peak Ht" 
        .Range("O1").FormulaR1C1 = "Peak Area" 
        .Range("P1").FormulaR1C1 = "IS Peak Area" 
        .Range("Q1").FormulaR1C1 = "Ratio" 
        .Range("R1").FormulaR1C1 = "Ratio Blk" 
        .Range("S1").FormulaR1C1 = "Ratio minus Blk" 
        .Range("T1").FormulaR1C1 = "Ratio S0" 
        .Range("U1").FormulaR1C1 = "Calib Intercept" 
        .Range("V1").FormulaR1C1 = "Calib Slope" 
        .Range("W1").FormulaR1C1 = "Calib Correl" 
        .Range("X1").FormulaR1C1 = "Calib Number" 
        .Range("Y1").FormulaR1C1 = "Raw Amount" 
        .Range("Z1").FormulaR1C1 = "Adj Amount" 
        .Range("AA1").FormulaR1C1 = "Column Desc" 
        .Range("AB1").FormulaR1C1 = "Calib Prep Note" 
        .Range("AC1").FormulaR1C1 = "Sample Note" 
 
    End With 
     
    With Range("A1:AC1") 
        .Interior.ColorIndex = 15 
        .Interior.Pattern = xlSolid 
    End With 
     
    Range("D2").Select 
    ActiveWindow.FreezePanes = True 
     
' Create a second sheet for Chromera-style export 
    Sheets.Add After:=Worksheets(Worksheets.Count) 
    chromeraSheetName = Right(resultsSheetName & " Chromera", 30) 
    ActiveSheet.Name = chromeraSheetName 
    Range("A5:J5").Select 
    Set chromeraDataShtRange = Selection 
     
    With ActiveSheet 
        .Range("A5").FormulaR1C1 = "Sample ID" 
        .Range("B5").FormulaR1C1 = "Replicate" 
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        .Range("C5").FormulaR1C1 = "Analyte" 
        .Range("D5").FormulaR1C1 = "Mass" 
        .Range("E5").FormulaR1C1 = "Species" 
        .Range("F5").FormulaR1C1 = "Retention Time" 
        .Range("G5").FormulaR1C1 = "Peak Area" 
        .Range("H5").FormulaR1C1 = "Peak Height" 
        .Range("I5").FormulaR1C1 = "Concentration" 
        .Range("J5").FormulaR1C1 = "Units" 
    End With 
     
    With Selection 
        .Interior.ColorIndex = 15 
        .Interior.Pattern = xlSolid 
    End With 
     
    Range("A6").Select 
 
' Select starting activecell on Sheet(resultsSheetName) 
    Sheets(resultsSheetName).Select 
    Range("A2").Select 
 
    Call TcInit                                                     'Initializes program with 
TcAccess.dll 
     
    c_SEQ = TcOpenConv("SEQ")                                          'c_SEQ is the first 
conversation handle.  Opens conversation with the Sequence topic in TcAccess.dll 
    If c_SEQ = 0 Then                                                  'If c_SEQ = 0 then 
conversation initiation and/or opening with SEQ Topic was not successful 
        MsgBox (TcErrorMsg)                                         'Display error that occurred, 
        End                                                         'and end the program 
    End If 
     
    iRet = TcSet(c_SEQ, "FILE_NAME", fileSpec) 
    iRet = TcGet(c_SEQ, "SEQ_NUM_CYCLES", SeqNumCycles) 
    iRet = TcGet(c_SEQ, "FH_CDATE", seqCreationDate) 
    iRet = TcGet(c_SEQ, "FH_CTIME", seqCreationTime) 
    iRet = TcGet(c_SEQ, "FH_EDATE", seqEditDate) 
    iRet = TcGet(c_SEQ, "FH_ETIME", seqEditTime) 
    iRet = TcGet(c_SEQ, "FH_FILE_AUTHOR", seqFileAuthor) 
    iRet = TcGet(c_SEQ, "FH_ETIME", seqEditTime) 
     
    Sheets(chromeraSheetName).Select 
    Range("A1").FormulaR1C1 = "Batch Name: " & workBookName 
    Range("A2").FormulaR1C1 = "Description: Data Export from TotalChrom" 
    Range("A3").FormulaR1C1 = "Date Analyzed: " & seqCreationDate & "  " & seqCreationTime 
    Range("A4").FormulaR1C1 = "Date Exported: " & todaysDate & "  " & currentTime 
 
    iSeqNumCycles = CInt(SeqNumCycles) 
     
    For iSeqCycleIndex = 0 To iSeqNumCycles - 1 
        iRet = TcSet(c_SEQ, "SEQ_CYCLE_INDEX", iSeqCycleIndex) 
        iRet = TcGet(c_SEQ, "SD_RESULT_FILE", resultFile) 
        dSeqIndex_resultFile.Add iSeqCycleIndex, resultFile 
        iRet = TcGet(c_SEQ, "SD_SAMP_NAME", seqSampleName) 
        dSeqIndex_seqSampleName.Add iSeqCycleIndex, seqSampleName 
        iRet = TcGet(c_SEQ, "SD_RAW_FILE", rawFile) 
        dSeqIndex_rawFile.Add iSeqCycleIndex, rawFile 
        iRet = TcGet(c_SEQ, "SD_TYPE", seqSampleType) 
        dSeqIndex_seqSampleType.Add iSeqCycleIndex, seqSampleType 
        If Left(seqSampleType, 4) = "Cal:" Then 
            iRet = TcGet(c_SEQ, "SD_EXPT_NAME", seqLevelName) 
        Else 
            seqLevelName = "" 
        End If 
        dSeqIndex_levelName.Add iSeqCycleIndex, seqLevelName 
        dLevelName_iSeqCycleIndex.Add seqLevelName, iSeqCycleIndex 
    Next 
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    calib_S1_exists = dLevelName_iSeqCycleIndex.Exists(firstLevelName) 
    If Not calib_S1_exists Then 
        rsp = MsgBox("Cannot find the first calibrator " & Chr(34) & firstLevelName & Chr(34) & " 
in sequence file " & Chr(34) & thisFilename & Chr(34) & "." _ 
            & vbCrLf & "Press Okay to continue without creating the calibration sheets. " & 
vbCrLf & "Press Cancel to abort this macro.", vbOKCancel + vbInformation, "MESSAGE") 
        If rsp = vbCancel Then 
            ActiveWorkbook.Close SaveChanges:=False 
            Application.StatusBar = False 
            Application.DisplayStatusBar = originalStatusBar 
            Exit Sub 
        End If 
    End If 
     
    iRet = TcSet(c_SEQ, "SEQ_CYCLE_INDEX", 1) 
    iRet = TcGet(c_SEQ, "SD_PROCESS_FILE", filespec_mth) 
     
    iRet = TcCloseConv(c_SEQ) 
     
    c_MTH = TcOpenConv("MTH") 
     
    iRet = TcSet(c_MTH, "FILE_NAME", filespec_mth) 
    iRet = TcGet(c_MTH, "FH_FILE_DES", mthMethodDescription) 
    iRet = TcGet(c_MTH, "SMP_NUM_COMPONENTS", mthCompStr) 
    iRet = TcGet(c_MTH, "SMP_RSLT_UNITS", mthConcUnits) 
    mthCompNum = CInt(mthCompStr) 
     
    For i = 0 To mthCompNum - 1 
        iRet = TcSet(c_MTH, "SMP_COMP_INDEX", i) 
        iRet = TcGet(c_MTH, "CP_COMP_NAME", mthCompName) 
        iRet = TcGet(c_MTH, "CP_IS_ISTD", internalStdWasFound) 
        bIntStdWasFound = CBool(internalStdWasFound) 
        If bIntStdWasFound Then 
            internalStdName = mthCompName  'replace default name of internal std with actual name 
            jComponentIndex = i 
            Exit For 
        End If 
    Next i 
     
    iRet = TcSet(c_MTH, "SMP_COMP_INDEX", jComponentIndex) 
    iRet = TcSet(c_MTH, "SMP_LEV_INDEX", 1) 
    iRet = TcGet(c_MTH, "LEV_NAME", mthLevelName) 
    iRet = TcGet(c_MTH, "LEV_AMOUNT", mthLevelConc) 
    concIS = mthLevelConc 
     
    iComponentIndex = 0 
     
    For i = 0 To mthCompNum - 1 
        iRet = TcSet(c_MTH, "SMP_COMP_INDEX", i) 
        iRet = TcGet(c_MTH, "CP_COMP_NAME", mthCompName) 
        If mthCompName <> internalStdName Then 
            iRet = TcGet(c_MTH, "CP_NUM_LEVELS", mthLevelCount) 
            dCompName(iComponentIndex) = mthCompName 
            dCompName_numberOfLevels(mthCompName) = mthLevelCount 
            For j = 0 To mthLevelCount - 1 
                iRet = TcSet(c_MTH, "SMP_LEV_INDEX", j) 
                iRet = TcGet(c_MTH, "LEV_NAME", mthLevelName) 
                iRet = TcGet(c_MTH, "LEV_AMOUNT", mthLevelConc) 
                dLevel2(i) = mthLevelName 
                dCompName_i(mthCompName & "|" & j) = mthLevelName 
                dLevel(mthCompName & "|" & mthLevelName) = mthLevelConc 
            Next j 
            iComponentIndex = iComponentIndex + 1 
        End If 
    Next i 
     
    iRet = TcCloseConv(c_MTH) 
     



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 84 of 107 

 

 

    c_RAW = TcOpenConv("RAW") 
    If c_RAW = 0 Then 
        MsgBox (TcErroMsg) 
        End 
    End If 
         
    c_RST = TcOpenConv("RST")        'c_RST is the second conversation handle.  Opens 
conversation with the Result File topic in TcAccess.dll. 
    If c_RST = 0 Then                'If c_RST = 0 then conversation initiation and/or opening 
with SEQ Topic was not successful. 
        MsgBox (TcErrorMsg)          'Display error that occurred and end the program. 
        End 
    End If 
         
    For iSeqCycleIndex = 0 To iSeqNumCycles - 1 
        resultFile = dSeqIndex_resultFile.Item(iSeqCycleIndex) 
        seqSampleName = dSeqIndex_seqSampleName.Item(iSeqCycleIndex) 
        seqSampleType = dSeqIndex_seqSampleType.Item(iSeqCycleIndex) 
        rawFile = dSeqIndex_rawFile.Item(iSeqCycleIndex) 
        seqLevelName = dSeqIndex_levelName.Item(iSeqCycleIndex) 
                 
        iRet = TcSet(c_RST, "FILE_NAME", resultFile) 
         
        If iRet = -1 Then 
            ShowWarningMsg = True 
            numMissingFiles = numMissingFiles + 1 
             
            With ActiveCell 
                .FormulaR1C1 = "FILE NOT FOUND" 
                .Offset(0, 1).FormulaR1C1 = resultFile 
                .Offset(1, 0).Select 
            End With 
             
        Else 
            iRet = TcGet(c_RST, "SD_SAMP_NAME", rstSampleName) 
            iRet = TcGet(c_RST, "SD_SAMPLE_FILE", rstMethodName) 
            iRet = TcGet(c_RST, "AD_DATE_STARTED", rstCreationDate) 
            iRet = TcGet(c_RST, "AD_TIME_STARTED", rstCreationTime) 
            iRet = TcGet(c_RST, "SD_STUDY_NAME", rstStudyName) 
            iRet = TcGet(c_RST, "RST_NUM_PEAKS", rstPeakCount) 
            iRet = TcGet(c_RST, "SD_CYCLE_TEXT", rstSampleNotes) 
            iRet = TcGet(c_RST, "SMP_NUM_COMPONENTS", rstNumComponents) 
            iRet = TcGet(c_RST, "AD_NUM_POINTS", nPoints) 
            iRet = TcGet(c_RST, "SD_DIL_FACTOR", rstSampleDilFactor) 
            iRet = TcGet(c_RST, "SD_ACTUAL_IS_AMT", rstIntStdConc) 
            iRet = TcSet(c_RST, "RST_FIND_PEAK_NAME", internalStdName) 
            If iRet = 0 Then 
                iRet = TcGet(c_RST, "PK_AREA", IS_peakArea) 
            ElseIf Not bIntStdWasFound Then 
                IS_peakArea = 1 
            End If 
            stabilityShtRange.Offset(iSeqCycleIndex + 1, 0).Value = IS_peakArea 
             
' check for existence of QC samples, if they exist then rename macro's QC variables 
            If firstLowQCSample Or firstHighQCSample Then 
                If seqSampleType = "Ctrl Sample" Then 
                    If LCase(Left(seqSampleName, 3)) Like "[h,l][b,u][_,-]" Then 
                        If UCase(Left(seqSampleName, 1)) = "L" Then 
                            lowBenchQCName = seqSampleName 
                            firstLowQCSample = False   ' set low QC sample check to false 
                        End If 
                        If UCase(Left(seqSampleName, 1)) = "H" Then 
                            highBenchQCName = seqSampleName 
                            firstHighQCSample = False  ' set high QC sample check to false 
                        End If 
                    End If 
                End If 
            End If 
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            For iComponentIndex = 0 To (rstNumComponents - 1) 
                strComponent = CStr(iComponentIndex) 
                 
                iRet = TcSet(c_RST, "SMP_COMP_INDEX", strComponent) 
                iRet = TcGet(c_RST, "CP_COMP_NAME", peakName) 
                iRet2 = TcSet(c_RST, "RST_FIND_PEAK_NAME", peakName) 
                 
                If iRet2 = 0 Then 
                    iRet = TcGet(c_RST, "PK_RET_TIME", peakRT) 
                    iRet = TcGet(c_RST, "PK_HEIGHT", peakHt) 
                    iRet = TcGet(c_RST, "PK_AREA", peakArea) 
                    iRet = TcGet(c_RST, "PK_RAW_AMOUNT", componentRawResult) 
                    iRet = TcGet(c_RST, "PK_RESULT", componentResult) 
                     
                    peakRatio = Val(peakArea) / Val(IS_peakArea) 
                                         
                    If seqSampleType = nameOfBlk Then 
                        dPeakNameBlank_peakRatio(peakName) = peakRatio 
                    End If 
                     
                    If dPeakNameBlank_peakRatio.Exists(peakName) Then 
                        peakRatio_blank = dPeakNameBlank_peakRatio.Item(peakName) 
                    Else 
                        peakRatio_blank = 0 
                    End If 
                     
'                    peakRatio_minus_bk = Val(peakRatio) - Val(peakRatio_blank) 
 
                    If seqLevelName = zeroLevelName Then 
                        dPeakNameZeroLevel_peakRatio(peakName) = peakRatio 
                    End If 
 
                    comp_level_Name = peakName & "|" & seqLevelName 
                    dAmount.Add comp_level_Name, peakRatio 
                     
                    equation1 = "Dilution * " & peakName & "_ConcIS * (Ratio_minus_blks - 
Intercept + Ratio_S0)/Slope" 
                    equation2 = "Dilution * " & peakName & "_ConcIS * Ratio_minus_blks/Slope" 
                     
                    If useIntercept = True Then 
                       finalResultFormula = "=If(" & equation1 & " <0, 0, " & equation1 & ")" 
                    Else 
                       finalResultFormula = "=If(" & equation2 & " <0, 0, " & equation2 & ")" 
                    End If 
                     
                    calibCurveCoeff_array = Split(calibCurveCoeffients, Chr(9), -1, 
vbBinaryCompare) 
                    calibCurveCoeff_0 = Trim(calibCurveCoeff_array(0)) 
                    calibCurveCoeff_1 = Trim(calibCurveCoeff_array(1)) 
                    calibCurveCoeff_5 = Trim(calibCurveCoeff_array(5)) 
                    peakRT = peakRT / 60 
                Else 
                    peakRT = "-" 
                    peakHt = 0 
                    peakArea = 0 
                    peakRatio = 0 
                    peakRatio_blank = 0 
'                    peakRatio_minus_bk = 0 
                    componentRawResult = 0 
                    finalResultFormula = 0 
                End If 
                 
                comp_level_Name = peakName & "|" & seqLevelName 
                mthLevelConc = dLevel.Item(comp_level_Name) 
                If dPeakNameZeroLevel_peakRatio.Exists(peakName) Then 
                    peakRatio_zero_calib = dPeakNameZeroLevel_peakRatio.Item(peakName) 
                Else 
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                    peakRatio_zero_calib = 0 
                End If 
                                 
                Sheets(resultsSheetName).Select 
                                 
                With ActiveCell 
                    .FormulaR1C1 = resultsSheetName 
                    .Offset(0, 1).FormulaR1C1 = iSeqCycleIndex + 1 
                    .Offset(0, 2).FormulaR1C1 = seqSampleName 
                    .Offset(0, 3).FormulaR1C1 = seqSampleType 
                    .Offset(0, 4).FormulaR1C1 = rstStudyName 
                    .Offset(0, 5).FormulaR1C1 = rstCreationDate & " " & rstCreationTime 
                    .Offset(0, 6).FormulaR1C1 = resultFile 
                    .Offset(0, 7).FormulaR1C1 = rstMethodName 
                    .Offset(0, 8).FormulaR1C1 = rstSampleDilFactor 
                    .Offset(0, 9).FormulaR1C1 = seqLevelName 
                    .Offset(0, 10).FormulaR1C1 = mthLevelConc 
                    .Offset(0, 11).FormulaR1C1 = peakName 
                    .Offset(0, 12).FormulaR1C1 = Format(peakRT, "0.00") 
                    .Offset(0, 13).FormulaR1C1 = Format(peakHt, "0.000") 
                    .Offset(0, 14).FormulaR1C1 = Format(peakArea, "0.000") 
                    .Offset(0, 15).FormulaR1C1 = Format(IS_peakArea, "0.000") 
                    .Offset(0, 16).FormulaR1C1 = peakRatio 
                    .Offset(0, 17).FormulaR1C1 = IIf(peakRatio_blank <> "", peakRatio_blank, 0) 
                    .Offset(0, 18).FormulaR1C1 = "= Ratio - Ratio_Blks" 
                    .Offset(0, 19).FormulaR1C1 = IIf(peakName = internalStdName, 0, 
peakRatio_zero_calib) 
                    If peakName <> internalStdName Then 
                        .Offset(0, 20).FormulaR1C1 = "=" & peakName & "_b"  ' calibCurveCoeff_0 
                        .Offset(0, 21).FormulaR1C1 = "=" & peakName & "_m"  ' calibCurveCoeff_1 
                        .Offset(0, 22).FormulaR1C1 = "=" & peakName & "_r2"  ' calibCurveCoeff_5 
                    End If 
                    .Offset(0, 23).FormulaR1C1 = "=COUNT(INDIRECT(Analyte_ID & " & Chr(34) & 
"_conc" & Chr(34) & "))"   'Number of calibrators used 
                    .Offset(0, 24).FormulaR1C1 = componentRawResult 
                    If peakName = internalStdName Then 
                        finalResultFormula = 0 
                    End If 
                    .Offset(0, 25).FormulaR1C1 = finalResultFormula 
                    finalResultName = seqSampleName & "_" & iSeqCycleIndex & "_" & peakName 
                    .Offset(0, 25).Name = finalResultName 
                    .Offset(0, 26).FormulaR1C1 = columnDescription 
                    .Offset(0, 27).FormulaR1C1 = calibPrepDate 
                    .Offset(0, 28).FormulaR1C1 = rstSampleNotes 
                    .Offset(1, 0).Select 
                End With 
                 
' now write data to chromeraDataShtName 
                Sheets(chromeraSheetName).Select 
                 
                With ActiveCell 
                    .FormulaR1C1 = seqSampleName 
                    .Offset(0, 1).FormulaR1C1 = iSeqCycleIndex + 1 
                    .Offset(0, 2).FormulaR1C1 = massName 
                    .Offset(0, 3).FormulaR1C1 = "" 
                    .Offset(0, 4).FormulaR1C1 = peakName 
                    .Offset(0, 5).FormulaR1C1 = Format(peakRT, "0.00") 
                    .Offset(0, 6).FormulaR1C1 = Format(peakArea, "0.000") 
                    .Offset(0, 7).FormulaR1C1 = Format(peakHt, "0.000") 
                    If peakName = internalStdName Then 
                        finalResultFormula = 0 
                    End If 
                    .Offset(0, 8).FormulaR1C1 = "=" & finalResultName 
                    .Offset(0, 9).FormulaR1C1 = mthConcUnits 
                    .Offset(1, 0).Select 
                End With 
                 
' finished writing data to chromeraDataShtName 
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                peakIndex = Empty 
                peakName = Empty 
                peakHt = Empty 
                peakArea = Empty 
                componentResult = Empty 
                finalResultFormula = Empty 
'                peakRatio_minus_bk = Empty 
                progressIndicator = 100 * iSeqCycleIndex / iSeqNumCycles 
                Application.StatusBar = "Extracting TotalChrom data, please wait... " & 
progressIndicator & "% done." 
            Next 
             
            Sheets(rawSheetName).Select 
            ActiveCell.Value = seqSampleName 
            Selection.HorizontalAlignment = xlRight 
            With Selection.Interior 
                .ColorIndex = 15 
                .Pattern = xlSolid 
            End With 
 
            iRet = TcSet(c_RAW, "FILE_NAME", rawFile) 
             
            If iRet = -1 Then 
                ActiveCell.Offset(1, 0).Value = "MISSING RAW DATA FILE" 
            Else 
                iRet = TcSet(c_RAW, "RAW_POINT_INDEX", 1) 
                iRet = TcSet(c_RAW, "RAW_POINT_COUNT", nPoints) 
                iRet = TcGet(c_RAW, "RAW_DATA_POINTS", rawDataPoints) 
                iRet = TcGet(c_RST, "IN_SAMP_RATE", sampleRate) 
                iRet = TcGet(c_RST, "IN_TOTAL_RUN_TIME", runTime) 
                rawPointsArray = Split(rawDataPoints, Chr(10), -1, vbBinaryCompare) 
                nPoints = nPoints - 1 
                For i = 1 To nPoints 
                    If iSeqCycleIndex = 0 Then 
                        ActiveCell.Offset(i, -1).Value = CSng(i / sampleRate) / 60 
                    End If 
                    ActiveCell.Offset(i, 0).Value = Val(rawPointsArray(i - 1)) 
                Next i 
            End If 
             
            ActiveCell.Offset(0, 1).Select 
             
        End If 
         
    Next 
     
    iRet = TcCloseConv(c_RAW) 
    iRet = TcCloseConv(c_RST) 
 
' Go to Sheets(resultsSheetName) to name ranges 
    Sheets(resultsSheetName).Select 
     
    Range("C1").Select 
    Range(Selection, Selection.End(xlDown)).Select 
    nRows = Selection.Rows.Count 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Sample_Name" 
     
    Range("D1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Sample_Type" 
     
    Range("I1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Dilution" 
 
    Range("L1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
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    Selection.Name = "Analyte_ID" 
 
    Range("O1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Peak_Area" 
 
    Range("P1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "IS_Peak_Area" 
 
    Range("Q1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Ratio" 
 
    Range("R1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Ratio_Blks" 
 
    Range("S1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Ratio_minus_blks" 
 
    Range("T1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Ratio_S0" 
     
    Range("U1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Intercept" 
     
    Range("V1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Slope" 
     
    Range("Z1").Select 
    Range(ActiveCell, ActiveCell.Offset(nRows - 1, 0)).Select 
    Selection.Name = "Adj_Amount" 
     
    ActiveCell.CurrentRegion.Select 
    Selection.Name = "TC_data" 
    Selection.AutoFilter 
    Range("A:A").HorizontalAlignment = xlCenter 
    Range("A1").Select 
   
' Create Calibration sheets 
    If calib_S1_exists Then 
         
        mthCompNum = dCompName.Count 
         
        For iComponentIndex = mthCompNum - 1 To 0 Step -1 
            peakName = dCompName.Item(iComponentIndex) 
            Sheets.Add After:=Sheets(1) 
            Sheets(2).Name = peakName 
            Range("A1").Formula = "CALIBRATION TABLE - Peak Area Ratios for " & peakName 
            With Selection.Font 
                .Name = "Arial" 
                .FontStyle = "Bold" 
                .Size = 10 
            End With 
            Range("A2").Formula = "Calib Level" 
            Range("B2").Formula = "Conc" 
            Range("C2").Formula = "Ratio Conc" 
            Range("D2").Formula = "Ratio Peak Areas" 
            Range("E2").Formula = "Deviation %" 
            Range("B2:E2").HorizontalAlignment = xlRight 
            Range("A3").Select 
             
            mthLevelCount = dCompName_numberOfLevels.Item(peakName) 



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 89 of 107 

 

 

             
            For i = 0 To mthLevelCount - 1 
                peakName_index = peakName & "|" & i 
                mthLevelName = dCompName_i.Item(peakName_index) 
                comp_level_Name = peakName & "|" & mthLevelName 
                mthLevelConc = dLevel.Item(comp_level_Name) 
                peakRatio = dAmount.Item(comp_level_Name) 
                ActiveCell.Offset(i, 0).Value = mthLevelName 
                ActiveCell.Offset(i, 1).Value = mthLevelConc 
                ActiveCell.Offset(i, 2).FormulaR1C1 = "= RC[-1]/" & peakName & "_ConcIS" 
                ActiveCell.Offset(i, 3).FormulaR1C1 = IIf(peakRatio = Empty, 0, peakRatio) 
                If i > 0 Then 
                    ActiveCell.Offset(i, 4).FormulaR1C1 = "= (" & peakName & "_ConcIS*(RC[-1] - " 
& peakName & "_b)/" & peakName & "_m)/RC[-3] - 1" 
                End If 
            Next i 
             
            Range("B3").Select 
            Range(Selection, Selection.End(xlDown)).Select 
            Selection.Name = peakName & "_conc" 
            Selection.NumberFormat = "0.00;-0.00;0.00" 
     
            Selection.Offset(0, 1).Select 
            Selection.Name = peakName & "_ratioConc" 
            Selection.NumberFormat = "0.0000;-0.0000;0.0000" 
             
            Selection.Offset(0, 1).Select 
            Selection.Name = peakName & "_ratioArea" 
            Selection.NumberFormat = "0.00000;-0.00000;0.00000" 
                      
            Selection.Offset(0, 1).Select 
            Selection.Name = peakName & "_deviation" 
            Selection.NumberFormat = "0.0%" 
                      
            Range("B20").Select 
            Range(Selection, Selection.Offset(4, 1)).Select 
            Selection.FormulaArray = "=LINEST(" & peakName & "!" & peakName & "_ratioArea" _ 
                    & "," & peakName & "_ratioConc, TRUE, TRUE)" 
            ActiveCell.Name = peakName & "_m" 
            ActiveCell.Offset(0, 1).Name = peakName & "_b" 
            ActiveCell.Offset(2, 0).Name = peakName & "_r2" 
            ActiveCell.Offset(6, 1).FormulaR1C1 = "=(R[-6]C - R[-23]C[1])/R[-6]C[-1]" 
            ActiveCell.Offset(6, 1).NumberFormat = "0.000%" 
            ActiveCell.Offset(7, 0).Value = "IS Conc -->" 
            ActiveCell.Offset(7, 1).FormulaR1C1 = concIS 
            ActiveCell.Offset(7, 1).NumberFormat = "0.0000" 
            ActiveCell.Offset(7, 1).Name = peakName & "_ConcIS" 
            Range("A19").Formula = peakName & " Regression Statistics" 
            Range("A20").Formula = "Slope, Intercept" 
            Range("A21").Formula = "SE-m, SE-b" 
            Range("A22").Formula = "r2, SE-y" 
            Range("A23").Formula = "F, df" 
            Range("A24").Formula = "SS-reg, SS-resid" 
            Columns("A:A").ColumnWidth = 15 
            Columns("B:B").ColumnWidth = 10 
            Columns("C:C").ColumnWidth = 10 
            Columns("D:D").ColumnWidth = 15 
            Columns("E:E").ColumnWidth = 10 
            Columns("F:G").ColumnWidth = 1 
             
            AddChart peakName & "_ratioConc", peakName & "_ratioArea", peakName, True 
             
            Range("A1").Select 
             
        Next iComponentIndex 
    End If 
' Done with creating Calibration sheets 
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    progressIndicator = 100 
    Application.StatusBar = "Extracting TotalChrom data, please wait... " & progressIndicator & 
"% done." 
 
' Clear dictionary objects 
    Set dLevel = Empty 
    Set dLevel2 = Empty 
    Set dCompName = Empty 
    Set dCompName_numberOfLevels = Empty 
    Set dCompName_i = Empty 
    Set dAmount = Empty 
    Set dSeqIndex_resultFile = Empty 
    Set dSeqIndex_seqSampleName = Empty 
    Set dSeqIndex_seqSampleType = Empty 
    Set dSeqIndex_rawFile = Empty 
    Set dSeqIndex_levelName = Empty 
    Set dLevelName_iSeqCycleIndex = Empty 
    Set dPeakNameZeroLevel_peakRatio = Empty 
    Set dPeakNameBlank_peakRatio = Empty 
 
' Create the IS Stability sheet 
    If Not bIntStdWasFound Then 
        Application.DisplayAlerts = False 
        Sheets(stabilitySheetName).Delete 
        Application.DisplayAlerts = True 
    Else 
        Sheets(stabilitySheetName).Select 
        Range(Selection.Offset(1, 0), Selection.End(xlDown)).Select 
        Selection.Name = "IS_area" 
         
        Charts.Add 
        ActiveChart.ChartType = xlLineMarkers 
        ActiveChart.SetSourceData Source:=Sheets(stabilitySheetName).Range("IS_area"), 
PlotBy:=xlColumns 
        ActiveChart.Location Where:=xlLocationAsObject, Name:="IS Stability" 
        With ActiveChart 
            .HasTitle = True 
            .ChartTitle.Characters.Text = "IS Peak Stability" 
            .Axes(xlCategory, xlPrimary).HasTitle = True 
            .Axes(xlCategory, xlPrimary).AxisTitle.Characters.Text = "Injection Number" 
            .Axes(xlValue, xlPrimary).HasTitle = True 
            .Axes(xlValue, xlPrimary).AxisTitle.Characters.Text = "Raw Peak Area" 
        End With 
     
        ActiveChart.Axes(xlValue).Select 
        With ActiveChart.Axes(xlValue) 
            .MinimumScale = 0 
            .MaximumScaleIsAuto = True 
            .MinorUnitIsAuto = True 
            .MajorUnitIsAuto = True 
            .Crosses = xlAutomatic 
            .ReversePlotOrder = False 
            .ScaleType = xlLinear 
            .DisplayUnit = xlNone 
            .TickLabels.NumberFormat = "0.0;-0.0;0" 
            .TickLabels.NumberFormat = "0;-0;0" 
            .TickLabels.AutoScaleFont = True 
        End With 
     
        ActiveChart.Axes(xlValue).Select 
        With Selection.TickLabels.Font 
            .Name = "Arial" 
            .Size = 8 
            .Strikethrough = False 
            .Superscript = False 
            .Subscript = False 
            .OutlineFont = False 
            .Shadow = False 
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            .Underline = xlUnderlineStyleNone 
            .ColorIndex = xlAutomatic 
            .Background = xlAutomatic 
        End With 
        ActiveChart.Axes(xlCategory).Select 
        Selection.TickLabels.AutoScaleFont = True 
        With Selection.TickLabels.Font 
            .Name = "Arial" 
            .Size = 8 
            .Strikethrough = False 
            .Superscript = False 
            .Subscript = False 
            .OutlineFont = False 
            .Shadow = False 
            .Underline = xlUnderlineStyleNone 
            .ColorIndex = xlAutomatic 
            .Background = xlAutomatic 
        End With 
        With Selection.TickLabels 
            .Alignment = xlCenter 
            .Offset = 100 
            .Orientation = xlHorizontal 
        End With 
        ActiveChart.SeriesCollection(1).Select 
        ActiveChart.SeriesCollection(1).Name = "IS" 
         
        With ActiveSheet 
            .ChartObjects(1).Height = 400 
            .ChartObjects(1).Width = 500 
            .ChartObjects(1).Left = .Columns("A").Left 
            .ChartObjects(1).Top = .Rows("1").Top 
            .ChartObjects(1).Border.LineStyle = xlLineStyleNone 
        End With 
     
        ActiveChart.Deselect 
        ActiveWindow.Zoom = 100 
    End If 
' Done with creating the IS Stability sheet 
 
' Create the pivot table 
    Sheets(1).Select 
    ActiveWorkbook.PivotCaches.Add(SourceType:=xlDatabase, 
SourceData:="TC_data").CreatePivotTable TableDestination:="", TableName:="PivotTable_TCData", 
DefaultVersion:=xlPivotTableVersion10 
    ActiveSheet.PivotTableWizard TableDestination:=ActiveSheet.Cells(3, 2) 
    ActiveSheet.Cells(3, 2).Select 
    With ActiveSheet.PivotTables("PivotTable_TCData") 
        .ColumnGrand = False 
        .HasAutoFormat = False 
        .DisplayErrorString = True 
        .ErrorString = "!error" 
        .RowGrand = False 
    End With 
    ActiveSheet.PivotTables("PivotTable_TCData").PivotCache.RefreshOnFileOpen = True 
    ActiveSheet.PivotTables("PivotTable_TCData").AddFields RowFields:=Array("Sample ID" _ 
        , "Seq No."), ColumnFields:="Analyte ID" 
    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Adj Amount") 
        .Orientation = xlDataField 
        .Caption = "Amount" 
        .Function = xlAverage 
    End With 
     
    ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Analyte ID").Subtotals = Array _ 
        (False, False, False, False, False, False, False, False, False, False, False, False) 
    ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Seq No.").Subtotals = Array _ 
        (False, False, False, False, False, False, False, False, False, False, False, False) 
    ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Sample ID").Subtotals = Array _ 
        (False, False, False, True, False, False, False, False, False, False, False, False) 
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    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Amount") 
        .NumberFormat = "0.000" 
    End With 
     
    Range("B4").Select 
    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Seq No.") 
        .Orientation = xlRowField 
        .Position = 2 
    End With 
     
    Range("A4").Select 
    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Seq No.") 
        .Orientation = xlRowField 
        .Position = 2 
    End With 
     
    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Sample ID") 
        For i = 2 To .PivotItems.Count 
            .PivotItems(i).Visible = False 
        Next i 
    End With 
     
    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Sample ID") 
        If .PivotItems(lowBenchQCName).Position > 0 Then 
            itDoesExist = True 
        End If 
        If itDoesExist Then 
            .PivotItems(lowBenchQCName).Visible = True 
            .PivotItems(highBenchQCName).Visible = True 
            .PivotItems(1).Visible = False 
        End If 
    End With 
     
    With ActiveSheet.PivotTables("PivotTable_TCData").PivotFields("Analyte ID") 
        .PivotItems("IS").Visible = False 
    End With 
     
    With ActiveSheet.PivotTables("PivotTable_TCData") 
        .PivotSelect "", xlDataAndLabel, True 
        .Format xlTable1 
        .Columns.AutoFit 
        .PivotFields("Sample ID").LayoutBlankLine = False 
    End With 
     
    ActiveWorkbook.ShowPivotTableFieldList = False 
    Application.CommandBars("PivotTable").Visible = False 
         
' Add a button that runs the macro for refreshing the pivot table 
    Set btn = ActiveSheet.Buttons.Add(3, 3, 70, 16) 
    macroName = ActiveWorkbook.Name & "!RefreshPivotTable" 
    btn.OnAction = macroName 
    btn.Placement = xlFreeFloating 
    btn.PrintObject = False 
    btn.Characters.Text = "Refresh Data" 
    With btn.Characters(Start:=1, Length:=16).Font 
        .Name = "Arial" 
        .FontStyle = "Regular" 
        .Size = 10 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
    End With 
' Done with making a button 
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    Columns("B:Z").ColumnWidth = 12 
    Range("B4").Select 
     
' Done with making the Pivot Table sheet 
 
    qcResultsShtName = "QC Results" 
    ActiveSheet.Name = qcResultsShtName 
    Sheets(qcResultsShtName).Move After:=Sheets(resultsSheetName) 
                
' Create a new module in the workbook and insert code 
    ExportCode workBookName 
     
' Make a chart showing a chromatogram 
    Sheets(rawSheetName).Select 
    sampleNamesAddress = Range(Cells(1, 1), Cells(1, iSeqNumCycles)).Address 
    plotAddress = Range(Cells(1, 1), Cells(nPoints + 1, 2)).Address 
    Charts.Add 
    ActiveChart.ChartType = xlXYScatterLinesNoMarkers 
    ActiveChart.SetSourceData Source:=Sheets(rawSheetName).Range(plotAddress), _ 
        PlotBy:=xlColumns 
    ActiveChart.Location Where:=xlLocationAsObject, Name:=rawSheetName 
    With ActiveChart 
        .HasTitle = True 
        .ChartTitle.Characters.Text = resultsSheetName 
        .Axes(xlCategory, xlPrimary).HasTitle = True 
        .Axes(xlCategory, xlPrimary).AxisTitle.Characters.Text = _ 
        "Retention Time (min)" 
        .Axes(xlValue, xlPrimary).HasTitle = True 
        .Axes(xlValue, xlPrimary).AxisTitle.Characters.Text = "Intensity (cps)" 
    End With 
    ActiveChart.Axes(xlValue).MajorGridlines.Select 
    Selection.Delete 
    ActiveSheet.ChartObjects(1).Select 
    On Error Resume Next 
    With ActiveSheet 
        .ChartObjects(1).Left = .Columns("C").Left 
        .ChartObjects(1).Top = .Rows("5").Top 
        .ChartObjects(1).Height = 500 
        .ChartObjects(1).Width = 700 
        .ChartObjects(1).Border.LineStyle = xlLineStyleNone 
    End With 
    With ActiveChart.Axes(xlValue) 
        .MinimumScale = 0 
        .MaximumScaleIsAuto = True 
        .MinorUnitIsAuto = True 
        .MajorUnitIsAuto = True 
        .Crosses = xlAutomatic 
        .ReversePlotOrder = False 
        .ScaleType = xlLinear 
        .DisplayUnit = xlNone 
    End With 
    ActiveChart.Axes(xlValue).Select 
    Selection.TickLabels.AutoScaleFont = False 
    With Selection.TickLabels.Font 
        .Name = "Arial" 
        .Size = 9 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
        .Background = xlAutomatic 
    End With 
    ActiveChart.Axes(xlCategory).Select 
    Selection.TickLabels.AutoScaleFont = True 
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    With Selection.TickLabels.Font 
        .Name = "Arial" 
        .Size = 9 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
        .Background = xlAutomatic 
    End With 
    ActiveChart.Axes(xlValue).AxisTitle.Select 
    Selection.AutoScaleFont = True 
    With Selection.Font 
        .Name = "Arial" 
        .Size = 10 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
        .Background = xlAutomatic 
    End With 
    ActiveChart.Axes(xlCategory).AxisTitle.Select 
    Selection.AutoScaleFont = True 
    With Selection.Font 
        .Name = "Arial" 
        .Size = 10 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
        .Background = xlAutomatic 
    End With 
    ActiveChart.Legend.Select 
    Selection.AutoScaleFont = True 
    With Selection.Border 
        .Weight = xlHairline 
        .LineStyle = xlAutomatic 
    End With 
    Selection.Shadow = False 
    With Selection.Interior 
        .ColorIndex = 15 
        .PatternColorIndex = 1 
        .Pattern = xlSolid 
    End With 
    ActiveChart.Legend.Select 
    Selection.AutoScaleFont = True 
    With Selection.Font 
        .Name = "Arial" 
        .Size = 9 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
        .Background = xlAutomatic 
    End With 
    ActiveChart.ChartTitle.Select 
    With Selection.Characters.Font 
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        .Name = "Arial" 
        .FontStyle = "Bold" 
        .Size = 10 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
    End With 
     
    If Not firstLowQCSample Then 
        Set c = Range(sampleNamesAddress).Find(lowBenchQCName, LookIn:=xlValues) 
        If Not c Is Nothing Then 
            thisAddress = c.Address 
        End If 
         
        Range(thisAddress, Range(thisAddress).End(xlDown)).Select 
        Selection.Copy 
        ActiveSheet.ChartObjects("Chart 1").Activate 
        ActiveChart.SeriesCollection.Paste Rowcol:=xlColumns, SeriesLabels:=True, 
CategoryLabels:=False, Replace:=False, NewSeries:=True 
        Application.CutCopyMode = False 
    End If 
     
    If Not firstHighQCSample Then 
        Set c = Range(sampleNamesAddress).Find(highBenchQCName, LookIn:=xlValues) 
        If Not c Is Nothing Then 
            thisAddress = c.Address 
        End If 
         
        Range(thisAddress, Range(thisAddress).End(xlDown)).Select 
        Selection.Copy 
        ActiveSheet.ChartObjects("Chart 1").Activate 
        ActiveChart.SeriesCollection.Paste Rowcol:=xlColumns, SeriesLabels:=True, 
CategoryLabels:=False, Replace:=False, NewSeries:=True 
        Application.CutCopyMode = False 
    End If 
     
    If (Not firstLowQCSample) Or (Not firstHighQCSample) Then 
        ActiveChart.SeriesCollection(1).Delete 
    End If 
     
    For Each s In ActiveChart.SeriesCollection 
        s.Smooth = True 
    Next s 
 
    ActiveChart.Deselect 
     
' Done making a chart showing a chromatogram 
 
' Add a button that runs the macro for adding a new series 
    Set btn = ActiveSheet.Buttons.Add(5, 25, 100, 25) 
'    ActiveSheet.Shapes(ActiveSheet.Shapes.Count).Select 
    macroName = ActiveWorkbook.Name & "!Chart_InsertNewSeries" 
    btn.OnAction = macroName 
    btn.Placement = xlFreeFloating 
    btn.PrintObject = False 
    btn.Characters.Text = "Add Chromatogram" 
    With btn.Characters(Start:=1, Length:=16).Font 
        .Name = "Arial" 
        .FontStyle = "Regular" 
        .Size = 10 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 96 of 107 

 

 

        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
    End With 
    Range("A1").Select 
' Done with making a button 
 
' Move the Chromera data sheet to the front, unless the first calibrator was 
' not found then delete the Chromera data sheet 
    If calib_S1_exists Then 
        Sheets(chromeraSheetName).Move After:=Sheets.Count 
    Else 
        Application.DisplayAlerts = False 
        Sheets(chromeraSheetName).Delete 
        Sheets(qcResultsShtName).Delete 
        Application.DisplayAlerts = True 
        Sheets(resultsSheetName).Select 
        Range("Adj_Amount").Select 
        For Each c In Selection 
            If IsError(c.Value) Then 
                c.Value = 0 
            End If 
        Next c 
    End If 
 
' Go to the first sheet, hide columns, turn on screen updating and return the status bar to it's 
original state 
    Sheets(resultsSheetName).Select 
    Range("R:X").EntireColumn.Hidden = True 
    Range("A1").Select 
     
    With ActiveWorkbook.BuiltinDocumentProperties 
        .Item("Title").Value = workBookName & savedNameSuffix 
        .Item("Subject").Value = "Results imported from TotalChrome " & strVersionNo 
        .Item("Author").Value = seqFileAuthor 
        .Item("Category").Value = "summary results" 
        .Item("Keywords").Value = "" 
        .Item("Comments").Value = "The TotalChrom sequence file used to export data " _ 
            & "to this Excel workbook was created " & seqCreationDate & "  " & seqCreationTime & 
"." _ 
            & vbCrLf & mthMethodDescription 
        .Item("Manager").Value = "" 
        .Item("Company").Value = "" 
    End With 
 
    Application.StatusBar = False 
    Application.DisplayStatusBar = originalStatusBar 
    Application.ScreenUpdating = True 
 
    If ShowWarningMsg = True Then 
        MsgBox "Data from " & CStr(numMissingFiles) & " TotalChrom files failed to be extracted. 
Check for " & vbCrLf & _ 
                "missing or renamed .RST files in the sequence file " & Chr(34) & thisFilename & 
Chr(34) & vbCrLf & _ 
                "and the source folder containing its data files.", _ 
                vbOKOnly + vbExclamation, "Warning" 
    End If 
 
' Bring up the SaveAs dialog box, if the PromptForSaveAsDialog switch is true 
    If True Then 
        currentDir = CurDir 
        filePathName = "C:\HPLC\Data\" & workBookName 
        dirExist = Dir(filePathName, vbDirectory)    ' Retrieve the first entry. 
        If dirExist <> "" Then 
            ChDir filePathName 
        Else 
            ChDir "C:\" 
        End If 
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        nameSaveAsFile = Application.GetSaveAsFilename(InitialFileName:=workBookName & _ 
            savedNameSuffix, FileFilter:="Excel normal workbook (*.xls),*.xls") 
        If nameSaveAsFile <> False Then 
            ActiveWorkbook.SaveAs fileName:=nameSaveAsFile, _ 
                FileFormat:=xlWorkbookNormal, AddToMru:=True, _ 
                ConflictResolution:=xlUserResolution 
        End If 
        ChDir currentDir 
    End If 
 
End Sub 
' 
' breakHere = IIf(componentRawResult > 0, True, False) 
' breakHere = IIf(iSeqCycleIndex = 18, True, False) 
' thisFilename = Right(filespec, Len(filespec) - InStrRev(filespec, "\", -1, vbTextCompare)) 
' workBookName = Left(thisFilename, Len(thisFilename) - 4) 
 
Sub AddChart(x_rangeToPlot, y_rangeToPlot, chartName, useIntercept) 
' Subroutine for "TransformHPLCdata" 
' Macro created 12/5/2002 
' Written by Carl P. Verdon, Ph.D. 
' 
    Charts.Add 
    ActiveChart.ChartType = xlXYScatter 
    ActiveChart.SetSourceData Source:=Sheets(chartName).Range(x_rangeToPlot, _ 
        Range(x_rangeToPlot).Offset(0, 1)), PlotBy:=xlColumns 
    ActiveChart.Location Where:=xlLocationAsObject, Name:=chartName 
    ActiveSheet.ChartObjects(1).Select 
    On Error Resume Next 
    With ActiveSheet 
        .ChartObjects(1).Left = .Columns("H").Left 
        .ChartObjects(1).Top = .Rows("1").Top 
        .ChartObjects(1).Height = 400 
        .ChartObjects(1).Width = 400 
        .ChartObjects(1).Border.LineStyle = xlLineStyleNone 
    End With 
    With ActiveChart 
        .HasTitle = True 
        .ChartTitle.Characters.Text = chartName 
        .HasLegend = False 
        .DisplayBlanksAs = xlNotPlotted 
        .PlotVisibleOnly = True 
        .SizeWithWindow = False 
        .Axes(xlCategory, xlPrimary).HasTitle = True 
        .Axes(xlCategory, xlPrimary).AxisTitle.Characters.Text = _ 
            "Concentration (Ratio [Calib]/[IS])" 
        .Axes(xlValue, xlPrimary).HasTitle = True 
        .Axes(xlValue, xlPrimary).AxisTitle.Characters.Text = _ 
            "Ratio (Peak Area/IS Peak Area)" 
    End With 
    seriesFormulaText = "=SERIES('Calib'!RC,'Calib'!" + x_rangeToPlot + _ 
            ",'Calib'!" + y_rangeToPlot + ",1)" 
    ActiveChart.SeriesCollection(1).Formula = seriesFormulaText 
    ActiveChart.SeriesCollection(1).Select 
    With Selection.Border 
        .Weight = xlHairline 
        .LineStyle = xlNone 
    End With 
    With Selection 
        .MarkerBackgroundColorIndex = 27 
        .MarkerForegroundColorIndex = 1 
        .MarkerStyle = xlDiamond 
        .Smooth = False 
        .MarkerSize = 7 
        .Shadow = False 
    End With 
    If useIntercept Then 
        ActiveChart.SeriesCollection(1).Trendlines.Add(Type:=xlLinear, Forward:=0, _ 
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            Backward:=0, DisplayEquation:=True, DisplayRSquared:=True, _ 
            Name:="Regression").Select 
    Else 
        ActiveChart.SeriesCollection(1).Trendlines.Add(Type:=xlLinear, Forward:=10, _ 
            Backward:=0, Intercept:=0, DisplayEquation:=True, DisplayRSquared:=True, _ 
            Name:="Regression").Select 
    End If 
    ActiveChart.Axes(xlValue).Select 
    With ActiveChart.Axes(xlValue) 
        .MinimumScale = 0 
        .MaximumScaleIsAuto = True 
        .MinorUnitIsAuto = True 
        .MajorUnitIsAuto = True 
        .Crosses = xlAutomatic 
        .ReversePlotOrder = False 
        .ScaleType = xlLinear 
        .DisplayUnit = xlNone 
        .TickLabels.NumberFormat = "0.00;-0.00;0" 
    End With 
     
    ActiveChart.Axes(xlValue).MajorGridlines.Select 
    Selection.Delete 
     
    ActiveChart.SeriesCollection(1).Trendlines(1).Select 
    With Selection.Border 
        .ColorIndex = 57 
        .Weight = xlThin 
        .LineStyle = xlContinuous 
    End With 
    ActiveChart.ChartTitle.Select 
    Selection.Characters.Text = chartName 
    Selection.AutoScaleFont = False 
'    With Selection.Characters(Start:=1, Length:=2).Font 
    With Selection.Characters.Font 
        .Name = "Arial" 
        .FontStyle = "Bold" 
        .Size = 12 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
    End With 
     
    ActiveChart.SeriesCollection(1).Trendlines(1).DataLabel.Select 
    With Selection.Border 
        .ColorIndex = 1 
        .Weight = xlThin 
        .LineStyle = xlContinuous 
    End With 
    Selection.Shadow = True 
    With Selection.Interior 
        .ColorIndex = 2 
        .PatternColorIndex = 1 
        .Pattern = xlSolid 
    End With 
    Selection.AutoScaleFont = True 
    With Selection.Font 
        .Name = "Arial" 
        .FontStyle = "Bold" 
        .Size = 10 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
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        .Underline = xlUnderlineStyleNone 
        .ColorIndex = xlAutomatic 
        .Background = xlAutomatic 
    End With 
    Selection.NumberFormat = "0.0000" 
    Selection.Left = 88 
    Selection.Top = 76 
    ActiveChart.Deselect 
 
End Sub 
 
Sub addCalibSheet(speciesName, useIntercept, numberOfCalibrators) 
' Subroutine for "TransformHPLCdata" 
' Macro created 12/5/2002 
' Written by Carl P. Verdon, Ph.D. 
' 
    Sheets("Calib").Copy After:=Sheets(Sheets.Count) 
    Sheets(Sheets.Count).Name = speciesName 
    Sheets(speciesName).Select 
    Range("C2").Select 
    Range(ActiveCell, Cells(ActiveCell.Row, lastCol - 1)).Select 
    ncols = Selection.Columns.Count 
    For i = 1 To ncols 
        If ActiveCell.Formula <> speciesName Then 
            ActiveCell.EntireColumn.Delete 
        Else 
            ActiveCell.Offset(0, 1).Select 
        End If 
    Next 
     
    speciesName_calibConc = speciesName + "_calibConc" 
     
    Range("B3").Select 
    Range(ActiveCell, Selection.End(xlDown)).Select 
    Selection.Name = speciesName_calibConc 
    Selection.Offset(0, 1).Name = speciesName 
     
    targetRange1 = numberOfCalibrators + 10 
    colNumber = 2 
     
    Range(Cells(targetRange1, colNumber), Cells(targetRange1 + 4, _ 
            colNumber + 1)).Select 
    Selection.FormulaArray = "=LINEST(Calib!" + speciesName + _ 
            "," + speciesName_calibConc + "," + CStr(useIntercept) + ",TRUE)" 
    ActiveSheet.Select 
    Cells(targetRange1 - 1, colNumber - 1).FormulaR1C1 = speciesName + _ 
            " Regression Statistics" 
    Cells(targetRange1 + 0, colNumber - 1).FormulaR1C1 = "Slope, Intercept" 
    Cells(targetRange1 + 1, colNumber - 1).FormulaR1C1 = "SE-m, SE-b" 
    Cells(targetRange1 + 2, colNumber - 1).FormulaR1C1 = "r2, SE-y" 
    Cells(targetRange1 + 3, colNumber - 1).FormulaR1C1 = "F, df" 
    Cells(targetRange1 + 4, colNumber - 1).FormulaR1C1 = "SS-reg, SS-resid" 
    Cells(targetRange1, colNumber).Name = speciesName + "_slope" 
    Cells(targetRange1, colNumber + 1).Name = speciesName + "_intercept" 
    Range(Cells(targetRange1, colNumber), Cells(targetRange1 + 1, _ 
            colNumber + 1)).Select 
    Selection.NumberFormat = "0.0000" 
    Cells(targetRange1 - 1, colNumber - 1).Select 
    With Selection.Font 
        .Name = "Arial" 
        .FontStyle = "Bold" 
        .Size = 10 
    End With 
     
    Cells(targetRange1 + 1, colNumber + 2).FormulaR1C1 = "=R[-1]C[-1]/R[-1]C[-2]" 
    Cells(targetRange1 + 1, colNumber + 2).NumberFormat = "0%;-0%;0%" 
     
    Columns("A:A").ColumnWidth = 14 
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    Range("A1").Select 
     
    AddChart speciesName_calibConc, speciesName, speciesName, useIntercept 
     
End Sub 
 
Sub AddMenuItems() 
 
    Dim MenuControls As Object, MenuItem As Object, menuExists As Boolean 
     
    menuExists = False 
    Set MenuControls = Application.CommandBars(1).Controls 
    For Each menuPopup In MenuControls 
        If menuPopup.Caption = "&HPLC" Then 
            menuExists = True 
        End If 
    Next 
     
    If Not menuExists Then 
        Set newMenuItem = CommandBars(1).Controls.Add(Type:=msoControlPopup, Before:=9) 
        With newMenuItem 
            .Caption = "&HPLC" 
        End With 
         
        With CommandBars(1).Controls("&HPLC") 
            .Controls.Add(Type:=msoControlButton, Before:=1).Caption = "&Create TC Sequence File" 
            .Controls("&Create TC Sequence File").OnAction = "MakeSequenceList" 
            .Controls.Add(Type:=msoControlButton, Before:=2).Caption = "Create &Summary.csv File" 
            .Controls("Create &Summary.csv File").OnAction = "LaunchSummaryExe" 
            .Controls.Add(Type:=msoControlButton, Before:=3).Caption = "Transform &HPLC Data" 
            .Controls("Transform &HPLC Data").OnAction = "TransformHPLCdata" 
            .Controls.Add(Type:=msoControlButton, Before:=4).Caption = "&Extract TC Data" 
            .Controls("&Extract TC Data").OnAction = "ExtractTCData" 
            .Controls("&Extract TC Data").BeginGroup = True 
            .Controls.Add(Type:=msoControlButton, Before:=5).Caption = "&Get Daily Performances" 
            .Controls("&Get Daily Performances").OnAction = "getDailyPerformIntensities" 
            .Controls.Add(Type:=msoControlButton, Before:=6).Caption = "&Import XY Data" 
            .Controls("&Import XY Data").OnAction = "Import_XY_data" 
            .Controls.Add(Type:=msoControlButton, Before:=7).Caption = "Set &Parameters" 
            .Controls("Set &Parameters").BeginGroup = True 
            .Controls("Set &Parameters").OnAction = "SetRegisters" 
        End With 
    End If 
 
End Sub 
 
Sub DeleteMenuItems() 
 
    Dim MenuControls As Object, MenuItem As Object, menuExists As Boolean 
     
    menuExists = False 
    Set MenuControls = Application.CommandBars(1).Controls 
    For Each menuPopup In MenuControls 
        If menuPopup.Caption = "&HPLC" Then 
            menuExists = True 
        End If 
    Next 
     
    If menuExists Then 
        CommandBars(1).Controls("&HPLC").Delete 
    End If 
 
End Sub 
 
Public Sub Auto_Open() 
     
    Application.Workbooks.Add 
    AddMenuItems 
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End Sub 
 
Public Sub Auto_Close() 
     
    DeleteMenuItems 
 
End Sub 
 
Public Sub SetRegisters() 
' 
' concIS As Variant 
' injNumberPattern As String 
' howManyBlanks As Variant 
' altFormulaCommentCode As String 
' 
    pathToMethodParametersFile = OGetSetting("VBA", "Sub_HPLCtransformVariables", 
"pathToMethodParametersFile_str", "C:\HPLC\Macro\Config.txt", True) 
    useIntercept = OGetSetting("VBA", "Sub_HPLCtransformVariables", "UseIntercept_boolean", 
False, True) 
    howManyBlanks = OGetSetting("VBA", "Sub_HPLCtransformVariables", "HowManyBlanks_integer", 3, 
True) 
    blankName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "BlankName_string", "Bk", True) 
    lowBenchQCName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "LowBenchQCName_string", 
"LU-03102", True) 
    highBenchQCName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "HighBenchQCName_string", 
"HU-03104", True) 
    massName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "MassName_string", "As", True) 
    dilFactorDelimiter = OGetSetting("VBA", "Sub_HPLCtransformVariables", 
"dilFactorDelimiter_string", "^", True) 
    columnDescription = OGetSetting("VBA", "Sub_HPLCtransformVariables", 
"columnDescription_string", "not entered", True) 
    zeroCalibName = OGetSetting("VBA", "Sub_HPLCtransformVariables", "zeroCalibName_string", 
"S0", True) 
    calibPrepDate = OGetSetting("VBA", "Sub_HPLCtransformVariables", "calibPrepDate_string", "", 
True) 
    listBoxEntries = Array(1, 2, 3, 4, 5, 6, 7) 
 
    With SetVariablesForm1 
        .TextBox1.Value = pathToMethodParametersFile 
        .TextBox2.Value = blankName 
        .TextBox3.Value = lowBenchQCName 
        .TextBox4.Value = highBenchQCName 
        .TextBox5.Value = massName 
        .TextBox6.Value = columnDescription 
        .TextBox7.Value = zeroCalibName 
        .TextBox8.Value = calibPrepDate 
        .OptionButton3.Value = useIntercept 
        .OptionButton4.Value = Not useIntercept 
        .ComboBox1.List() = listBoxEntries 
        .ComboBox1.Text = howManyBlanks 
    End With 
 
 
    SetVariablesForm1.CommandButtonDone.Default = True 
    CommandButtonDoneClicked = False 
    SetVariablesForm1.Show 
    If CommandButtonDoneClicked Then 
        CommandButtonDoneClicked = True 
        SetVariablesForm1.Hide 
    End If 
    If CommandButtonDoneCancel Then 
        CommandButtonDoneClicked = False 
        SetVariablesForm1.Hide 
    End If 
     
    If CommandButtonDoneClicked Then 
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        With SetVariablesForm1 
         
            pathToMethodParametersFile = .TextBox1.Value 
            blankName = .TextBox2.Value 
            lowBenchQCName = .TextBox3.Value 
            highBenchQCName = .TextBox4.Value 
            massName = .TextBox5.Value 
            columnDescription = .TextBox6.Value 
            zeroCalibName = .TextBox7.Value 
            calibPrepDate = .TextBox8.Value 
            howManyBlanks = CInt(.ComboBox1.Text) 
             
            If .OptionButton3.Value = True Then 
                useIntercept = True 
            End If 
            If .OptionButton4.Value = True Then 
                useIntercept = False 
            End If 
        End With 
     
    Else 
        Exit Sub 
    End If 
         
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "pathToMethodParametersFile_str", 
pathToMethodParametersFile, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "UseIntercept_boolean", useIntercept, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "BlankName_string", blankName, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "HowManyBlanks_integer", howManyBlanks, 
True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "LowBenchQCName_string", lowBenchQCName, 
True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "HighBenchQCName_string", highBenchQCName, 
True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "MassName_string", massName, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "dilFactorDelimiter_string", 
dilFactorDelimiter, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "columnDescription_string", 
columnDescription, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "zeroCalibName_string", zeroCalibName, True 
    OSaveSetting "VBA", "Sub_HPLCtransformVariables", "calibPrepDate_string", calibPrepDate, True 
 
'    prompt = "Set the search criteria for the macro Delete Rows by Criteria. " & _ 
'            "Wild card values # (any single number), ? (any single character) and * (any number 
of characters/numbers) are allowed." 
'    criteria = Application.InputBox(prompt:=prompt, Type:=2, Default:=criteria) 
        
End Sub 
 
Public Function OGetSetting(ByVal AppName As String, ByVal Section As String, ByVal KeyName As 
String, ByVal Default As Variant, Optional ByVal System As Boolean = False) As String 
    Set wshShell = CreateObject("WScript.Shell") 
    On Error GoTo errBadRead 
    OGetSetting = wshShell.RegRead(IIf(System, "HKLM", "HKCU") & "\Software\Microsoft\" & AppName 
& "\" & Section & "\" & KeyName) 
    Set wshShell = Nothing 
    Exit Function 
errBadRead: 
    OGetSetting = Default 
    Set wshShell = Nothing 
End Function 
 
Public Function OSaveSetting(ByVal AppName As String, ByVal Section As String, ByVal KeyName As 
String, ByVal Value As Variant, Optional ByVal System As Boolean = False) 
    Set wshShell = CreateObject("WScript.Shell") 
    On Error GoTo errBadWrite 
    Call wshShell.RegWrite(IIf(System, "HKLM", "HKCU") & "\Software\Microsoft\" & AppName & "\" & 
Section & "\" & KeyName, Value) 
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    Set wshShell = Nothing 
    Exit Function 
errBadWrite: 
    Set wshShell = Nothing 
End Function 
 
Public Function ODeleteSetting(ByVal AppName As String, ByVal Section As String, ByVal KeyName As 
String, Optional ByVal System As Boolean = False) 
    Set wshShell = CreateObject("WScript.Shell") 
    On Error GoTo errBadDelete 
    Call wshShell.RegDelete(IIf(System, "HKLM", "HKCU") & "\Software\Microsoft\" & AppName & "\" 
& Section & "\" & KeyName) 
    Set wshShell = Nothing 
    Exit Function 
errBadDelete: 
    Set wshShell = Nothing 
End Function 
 
Public Function Pause5seconds() 
    Dim pauseSeconds As Long 
    pauseSeconds = 5 
    newHour = Hour(Now()) 
    newMinute = Minute(Now()) 
    newSecond = Second(Now()) + pauseSeconds 
    waitTime = TimeSerial(newHour, newMinute, newSecond) 
    Application.Wait waitTime 
End Function 
 
Public Function ExportCode(ByVal wkbkName As String) 
' Macro created by Carl Verdon, 2/24/2005 
' Updated by C. Verdon 8/9/2006 
 
'   Dimension variables 
    Dim strCode1 As String 
    Dim strCode2 As String 
    Dim strProjName As String 
    Dim strChartName As String 
    Dim modObj As Object 
    Dim modObjItem As Object 
     
'   Inialize variables 
    strProjName = "VBAProject" 
    strChartName = "Chart 1" 
    strCode1 = _ 
    "Sub Chart_InsertNewSeries()" & vbCrLf & _ 
    "    " & vbCrLf & _ 
    "    Dim c as Range" & vbCrLf & _ 
    "    Dim s as Series" & vbCrLf & _ 
    "    " & vbCrLf & _ 
    "    Application.ScreenUpdating = False" & vbCrLf & _ 
    "    Range(Cells(1, ActiveCell.Column), Cells(1, ActiveCell.Column + Selection.Columns.Count 
- 1)).Select" & vbCrLf & _ 
    "    Set c = Selection" & vbCrLf & _ 
    "    If (ActiveCell.FormulaR1C1 <> Empty) And (ActiveCell.Column <> 1) Then" & vbCrLf & _ 
    "        Range(Selection, Selection.End(xlDown)).Select" & vbCrLf & _ 
    "        Selection.Copy" & vbCrLf & _ 
    "        ActiveSheet.ChartObjects(" & Chr(34) & strChartName & Chr(34) & ").Activate" & 
vbCrLf & _ 
    "        ActiveChart.SeriesCollection.Paste Rowcol:=xlColumns, SeriesLabels:=True, 
CategoryLabels:=False, Replace:=False, NewSeries:=True" & vbCrLf & _ 
    "        Application.CutCopyMode = False" & vbCrLf & _ 
    "        For each s in ActiveChart.SeriesCollection" & vbCrLf & _ 
    "             s.Smooth = True" & vbCrLf & _ 
    "        Next s" & vbCrLf & _ 
    "        ActiveChart.Deselect" & vbCrLf & _ 
    "        c.Select" & vbCrLf & _ 
    "    Else" & vbCrLf & _ 
    "        MsgBox" & Chr(34) & "This column does not contain signal data. Select a column 



Urine arsenic species HPLCICPDRCMS (Formerly Arsenic species in Urine) IRAT-DLS 
 
DLS Method Code: 3000.1(Formerly 016A/01-OD) Page 104 of 107 

 

 

header for a column that contains signal data." & Chr(34) & vbCrLf & _ 
    "    End If" & vbCrLf & _ 
    "    " & vbCrLf & _ 
    "End Sub" 
     
    strCode2 = _ 
    "Sub RefreshPivotTable()" & vbCrLf & _ 
    "    " & vbCrLf & _ 
    "    Application.ScreenUpdating = False" & vbCrLf & _ 
    "    ActiveSheet.PivotTables(" & Chr(34) & "PivotTable_TCData" & Chr(34) & 
").PivotCache.Refresh" & vbCrLf & _ 
    "    Columns(" & Chr(34) & "B:Z" & Chr(34) & ").ColumnWidth = 12" & vbCrLf & _ 
    "    " & vbCrLf & _ 
    "End Sub" 
 
'   Main 
    Set modObj = Application.VBE.VBProjects(strProjName).Collection 
    Set modObjItem = modObj.Item(modObj.Count) 
    modObjItem.VBComponents.Add (vbext_ct_StdModule) 
    modObjItem.VBComponents.Item("Module1").CodeModule.AddFromString (strCode1) 
    modObjItem.VBComponents.Item("Module1").CodeModule.AddFromString (strCode2) 
     
End Function 
 
' Macro created 4/18/2006 by Carl Verdon 
Public Function MakePivotTable( _ 
        ByVal mySourceData As Range, _ 
        ByVal myTableName As String, _ 
        ByVal myRowField As String, _ 
        ByVal myColField As String, _ 
        ByVal myDataField As String, _ 
        Optional ByVal startRow As Integer, _ 
        Optional ByVal startCol As Integer _ 
        ) 
     
    Application.ScreenUpdating = False 
 
    If startRow = Empty Then startRow = 3 
    If startCol = Empty Then startCol = 1 
    Set sourceDataArea = mySourceData 
     
    ActiveWorkbook.PivotCaches.Add(SourceType:=xlDatabase, _ 
        SourceData:=sourceDataArea).CreatePivotTable _ 
        TableDestination:="", _ 
        TableName:=myTableName, _ 
        DefaultVersion:=xlPivotTableVersion10 
                 
    ActiveSheet.PivotTableWizard TableDestination:=ActiveSheet.Cells(startRow, startCol) 
    ActiveSheet.Cells(startRow, startCol).Select 
     
    With ActiveSheet.PivotTables(myTableName) 
        .ColumnGrand = False 
        .HasAutoFormat = False 
        .DisplayErrorString = True 
        .ErrorString = "?Data" 
        .NullString = "-" 
        .PreserveFormatting = False 
        .RowGrand = False 
    End With 
     
    ActiveSheet.PivotTables(myTableName).AddFields RowFields:=myRowField, 
ColumnFields:=myColField 
    ActiveSheet.PivotTables(myTableName).HasAutoFormat = True 
     
    With ActiveSheet.PivotTables(myTableName).PivotFields(myDataField) 
        .Orientation = xlDataField 
        .Caption = "Ave Data" 
        .Function = xlAverage 
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    End With 
     
    With ActiveSheet.PivotTables(myTableName).PivotFields("Ave Data") 
        .NumberFormat = "0.0" 
    End With 
     
    With ActiveSheet.PivotTables(myTableName).PivotFields(myColField) 
        .PivotItems("(blank)").Visible = False 
    End With 
     
    With ActiveSheet.PivotTables(myTableName).PivotFields(myRowField) 
        .PivotItems("(blank)").Visible = False 
    End With 
     
    ActiveWorkbook.ShowPivotTableFieldList = False 
    Application.CommandBars("PivotTable").Visible = False 
     
    ActiveSheet.Cells(startRow, startCol).Select 
    ActiveSheet.Name = "Calib" 
     
'   Sub RefreshPivotTable1() 
'     ActiveSheet.PivotTables("PivotTable1").PivotCache.Refresh 
'   End Sub 
 
End Function 

 
End of Program Listing 
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b. Sample Chromatographic Report 

Example chromatogram of a bench QC sample below:   
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c.  Sample HPLC Batch Run “Results” File in Microsoft Excel®  
 

A screen shot of a "results” file in Microsoft Excel® after transformation by the Excel Macro 
“Extract TC Data”.  
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1. CLINICAL RELEVANCE AND TEST PRINCIPLE  

a. Clinical Relevance 

Iodine (I), an essential element for thyroid function, is necessary for normal growth, 
development, and functioning of the brain and body. Iodine-deficiency disorders (IDDs) are 
well-documented global health problems affecting more than a billion people worldwide. 
Consequences of IDD include goiter, cretinism, intellectual impairment, brain damage, mental 
retardation, stillbirth, spontaneous abortions, miscarriages, congenital deformities, and 
increased perinatal mortality.  Progress toward eliminating IDDs has been substantial; an 
estimated 70% of the world’s edible salt currently is iodized. Most excess iodine is excreted, 
and most people can tolerate fairly large amounts without experiencing problems. People 
with a tendency towards autoimmune thyroid disease are less tolerant of excess iodine. If a 
person has previously been iodine deficient, that person may be at risk for iodine-induced 
hyperthyroidism.  Excessive iodine intake by a mother can pose a reproductive risk. Since 
urinary iodine values directly reflect dietary iodine intake, urinary iodine analysis is the 
recommended and most common method for biochemically assessing the iodine status of a 
population (1). On the other hand, Mercury (Hg) is a toxic non-essential element that can 
affect various organ systems within the body but especially the central nervous system. The 
main sources of mercury intake in humans are fish, dental amalgams, and occupational 
exposure. The main organs affected by mercury are the brain and the kidneys (2). Psychic 
and emotional disturbances are the initial signs of chronic intoxication by elemental mercury 
vapors or salts. Parasthesia, neuralgias, renal disease, digestive disturbances, and ocular 
lesions may develop (3). Massive exposure over a longer period of time results in violent 
muscular spasms, hallucinations, delirium, and death (4). The determination of total Hg in 
blood and urine are both used to assess the internal exposure. Since urine can be collected 
non-invasively, it is more commonly used to assess exposure to mercury, particularly in 
occupational health settings where biomonitoring of random spot urine samples is routinely 
practiced. This method is used to achieve rapid and accurate quantification of iodine (I) and / 
or mercury (Hg) in urine.  The method can be used to analyze urine for both elements at the 
same time, or just one of the elements.     

 

b. Test Principle 

Urine iodine and mercury concentrations are determined by ICP-DRC-MS (Inductively 
Coupled Plasma Dynamic Reaction Cell Mass Spectroscopy). This multielement analytical 
technique is based on quadrupole ICP-MS technology (5) and includes DRC™ technology (6, 
7). Coupling radio frequency power into a flowing argon stream seeded with electrons creates 
the plasma, the heat source, which is ionized gas suspended in a magnetic field. 
Predominant species in the plasma are positive argon ions and electrons. Diluted urine 
samples are converted into an aerosol using a nebulizer inserted within the spray chamber. A 
portion of the aerosol is transported through the spray chamber and then through the central 
channel of the plasma, where it is exposed to temperatures of 6000-8000 K. This thermal 
energy atomizes and ionizes the sample. The ions and the argon enter the mass 
spectrometer through an interface that separates the ICP, which is operating at atmospheric 
pressure (approximately 760 torr), from the mass spectrometer, which is operating at 
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approximately 10-5 torr. The mass spectrometer permits detection of ions at each mass-to-
charge ratio in rapid sequence, which allows the determination of individual isotopes of an 
element. Once inside the mass spectrometer, the ions pass through the ion optics, then 
through DRC™, and finally through the mass-analyzing quadrupole before being detected as 
they strike the surface of the detector.  The ion optics uses an electrical field to focus the ion 
beam into the DRC™. The DRC™ component is pressurized with an appropriate reaction 
gas and contains a quadrupole. Electrical signals resulting from the detection of the ions are 
processed into digital information that is used to indicate the intensity of the ions and 
subsequently the concentration of the element. Traditionally ICP-MS has been a trace 
analysis technique and the typical measurement ranges from < 1 µg/L to around 100 µg/L. 
DRC technology can be used to provide additional control of ICP-MS sensitivity.  In this 
method, adjustments of the reaction cell parameters dampen the sensitivity of iodine (isotope 
mass 127) to extend the useful concentration measurement range to higher concentrations.  
The reaction cell parameters in this method are also used to increase the sensitivity of 
mercury (isotope mass 202) by a process known as collisional focusing.  Both of these 
processes are accomplished by filling the Dynamic Reaction Cell™ (DRC) with 100% argon. 
Urine samples are diluted 1+1+ 8 (sample+ water + diluent) with water and diluent containing 
tellurium and bismuth for internal standardization.  

2. SAFETY PRECAUTIONS 

Precautionary information that is important to protecting personnel and safeguarding 
equipment will be presented inside a box, such as this one, throughout the procedure 
where appropriate.  

 
Follow universal precautions. Wear gloves, a lab coat, and safety glasses while handling 
human blood, plasma, serum, urine or other bodily fluid or tissue. Place disposable plastic, 
glass, and paper (e.g., pipette tips, autosampler tubes and gloves) that come in contact with 
human biological fluids, such as urine, in a biohazard autoclave bag. Keep these bags in 
appropriate containers until they are sealed and autoclaved. When work is finished, wipe 
down all work surfaces where human biological fluid was handled with a 10% (v/v) sodium 
hypochlorite solution or equivalent. The use of the foot pedal on the Micromedic Digiflex™ is 
recommended because it reduces analyst contact with work surfaces that have been in 
contact with human biological fluid and also keeps the hands free to hold specimen cups and 
autosampler tubes. Dispose of all biological samples and diluted specimens in a biohazard 
autoclave bag at the end of the analysis according to CDC/DLS guidelines for disposal of 
hazardous waste. 

PerkinElmer provides safety information that should be read before operating the instrument.  
This information is found in the PerkinElmer ELAN ICP-DRC-MS System Safety Manual.  
Possible hazards include ultraviolet radiation, high voltages, radio-frequency radiation, and 
high temperatures. 

 

 

 



Iodine and Mercury in Urine ITN-DLS 
 
DLS Method Code: 3002.1 Page 3 of 34 

 

 

Caution! 
Exercise caution when handling and dispensing concentrated nitric acid and base 
Tetramethylammonium hydroxide (TMAH). Always remember to add acid to water. Nitric 
acid and TMAH are caustic chemicals that are capable of severe eye and skin damage. 
Wear powder-free gloves, a lab coat, and safety glasses. If nitric acid or TMAH comes in 
contact with any part of the body, quickly wash the exposed area with copious quantities 
of water for at least 15 minutes. 

3. DATA SYSTEM MANAGEMENT 

To maintain the integrity of specimen and analytical data generated by this method, eliminate 
hand entry of specimen identifiers or analytical results whenever possible, proofread all 
transcribed data, and regularly defragment and back up the ICP-MS computer’s hard drive. 

a. Data Entry and Transfer 

Whenever possible, use bar code scanners to enter sample identifiers into the ICP-DRC-
MS computer software to avoid errors associated with the keyboard-entry process and to 
speed up sample processing. When bar code scanners cannot be used, proofread 
transcribed data after entry.  Handle or transfer data electronically when reporting or 
moving data to other computerized data-handling software. In the Inorganic Radiation 
and Analytical Toxicology Branch, sample analysis results generated by this method are 
stored for long periods in Microsoft Access™ or MS SQL Server database software. The 
results should include at least the analysis date, analytical run number, quality-control 
(QC) results for the run, results of specimen analysis by specimen identification (ID), and 
method identifier. 

b. Routine Computer Hard Drive Maintenance 

Defragment the computer hard drive regularly by using software such as Microsoft 
Windows® Disk Defragmenter (located in Start > Programs > Accessories > System 
Tools) or an equivalent backup program to maximize computer performance and 
maintain data integrity for files on the hard drive. An entry will automatically be made in 
the Windows™ system event log when this process is done and will provide 
documentation of this step. 

c. Data Backup 

(1) Schedule of Data Backups 

Weekly. Full data backups onto one or more recordable compact discs (CD-R) or 
digital video discs (DVD).  

Daily. Full data backups onto an external hard drive.  

(2) Backup Procedures 

Whenever making a backup (daily or weekly) include the directories and 
subdirectories:  C:\elandata (include all subdirectories) 
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Before making weekly backups, saving a copy of the Windows™ event log in the 
active “elandata” directory will ensure archiving of all recent software system events 
(including communications between ICP-DRC-MS and ELAN® software, as well as 
times of hard drive defragmentation, and other Windows™ system events). 

(a) External Hard Disk Backups 

Connect the ELAN data system computer to an external hard disk with sufficient 
storage capacity to store several copies of the backup files (≥ 18 gigabytes). 
Configure Microsoft Windows® Backup™ (located in Start > Programs > 
Accessories > System Tools) program to do a daily backup of the ELAN data 
system computer’s data directories (see Backup Procedures) 

(b) Compact Disc Backups 

Use CD-R disks only (recordable compact disks), not CD-RW disks (rewritable 
compact disks). Record the CD-R so that after creation the recordable compact 
disk cannot be written to again (to prevent any accidental over-writing of stored 
data). Use Adaptec “Easy CD Creator”™ or equivalent software to backup.  

(c) Removing Data from the ICP-DRC-MS Computer Hard Drive 

When the active “elandata” directory on the ICP-DRC-MS computer hard drive 
becomes too large to fit onto a single recordable compact disk, remove the oldest 
data on the hard drive so that a regular backup can be done onto a single CD-R.  
Usually, this procedure can be done annually. 

• Back up the oldest data on the hard drive in duplicate onto two CD-R disks.  
Manually select each dataset folder (subdirectories under 
“C:\elandata\dataset” and other relevant files (i.e., optimization, tuning, and 
sample files) that are to be included on these backups.   

• Verify that backup CD-R disks operate correctly before deleting any data 
from the hard drive. To verify the operation of a CD-R disk, open any file on 
the disk by using the appropriate computer software (ICP-DRC-MS 
software).  

• After verifying that all backups are operational, delete the original data from 
the hard drive. 

• Keep one copy of the CD-R disk in a building other than the laboratory in 
case of fire (currently, the storage room is room 1011 in building 103).  Keep 
the other near the ICP-MS laboratory.  
 

(d) Backup of Sensitive Data 

Make a backup for sensitive data on duplicate, recordable compact disk. Store 
the two CD-R disks in two different buildings. 
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d. Documentation of System Maintenance  

(1) Computer Maintenance:   

Record any maintenance of computer hardware and ICP-DRC-MS software in the 
instrument logbook. Place other electronic records relating to integrity of the data and 
hard drive in the Windows™ event log. Back up the event log on a regular basis by 
saving a copy in the active “elandata” directory. The event log will then be backed up 
along with the ELAN data when backup CD-R disks and tapes are made. 

(2) Instrument Maintenance:  

Document system maintenance in hard copies of data records (i.e., daily maintenance 
checklists, PerkinElmer service records, and instrument log book) as well as in electronic 
records relating to instrument optimization (default.dac), tuning (default.tun). 

4. COLLECTING, STORING, AND HANDLING SPECIMENS; CRITERIA 
FOR REJECTING SPECIMENS 

a. Specimen Type:  Specimen type is urine. No special instructions for fasting or special diets 
are required of patient or study subjects.  

b. Specimen Collection, Handling and Storage 

(1) No special instructions for fasting, special diets are required. 

(2) The specimen type is urine with preservative (for mercury).  The preservative is a solution of 
approximately 2 M sulfamic acid and.  It is added for the purpose of preventing loss of 
mercury from the urine before analysis.  Urine should be mixed with the preservative 
as soon as possible after initial collection in the proportion of 10 µL of preservative 
solution per 1 mL of urine (example:  To a tube containing 50 µL of preservative, up to 
5 mL of urine can be added for urine mercury analysis).  Mix the urine well after 
addition of the preservative.  See Section 6.b.2 for details on preparation of the 
preservative solution.   

(3) Optimal amount of specimen is 1.8 mL; minimum amount in a cryo-vial is about 0.75 
mL. 500 µL needed for an analysis.  

(4) Acceptable containers for allotment of urine for this method include 15 mL PP 
centrifuge tubes (e.g., Becton, Dickinson and Company model number 352097). Use 
sterile collectors for specimen acquisition. 

(5) Screen specimen collection cups, containers and sample tubes for iodine and mercury 
contamination before use. 

(6) Specimen stability has been demonstrated for 1 year at ≤ -20°C.  

(7) Specimen characteristics that may compromise test results are indicated above and 
include high storage temperature or no preservative. 
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(8) Specimen handling conditions are outlined in the division protocol for urine collection 
and handling. Copies are available in the branch, laboratory and special activities 
specimen-handling offices. The protocol addresses collection, transport, and special-
equipment requirements. In general, transport and store urine specimens at ≤ -20°C. 
Upon receipt, freeze the specimens at ≤ -20°C until time for analysis. The analyst puts 
the remaining samples in the freezer after analytical aliquots are done and refreezes 
them at  ≤ -20°C.  Samples that are thawed and refrozen several times will not be 
compromised.  

c. Criteria for an Unacceptable Specimen 

The criteria for an unacceptable specimen are either a low volume (< 0.75 mL), suspected 
contamination due to improper collection procedures or collection devices, or failure to 
add the proper preservative to urine to prevent the loss of mercury.  The volume of urine 
used in a single analysis is 0.5 mL, but sample volumes <0.75 mL may not allow for 
proper pipetting.  Requested volume is >1.8mL to allow for repeat / confirmation analysis 
if necessary.  Specimen contact with dust or dirt may compromise test results. In all 
cases, request a second urine specimen.   

5. PROCEDURES FOR MICROSCOPIC EXAMINATIONS 

Not applicable for this procedure. 

6. CHEMICALS, STANDARDS, AND QUALITY CONTROL MATERIAL 

a. Chemicals  

(d) Water, high purity (≥18 MΩ⋅cm resistivity using a NANOpure Diamond Ultrapure 
Water System or equivalent).  

(e) TritonX-100™ (Aldrich Chemical Co., Milwaukee, WI, or any source whose product is 
low in trace-metal contamination).   

(f) Sulfamic Acid (Columbus Chemical Industries, Columbus, WI or equivalent).  

(g) Concentrated (16M or ~70%) nitric acid (Environmental Grade from GFS Chemicals 
Inc., Columbus, OH or equivalent).  If other stock concentrations are used, volumes 
must be adjusted accordingly. 

(h) Concentrated (12M or ~37%) hydrochloric acid (Superior Reagent HCl from GFS 
Chemicals Inc., Columbus, OH or equivalent).  If other stock concentrations are used, 
volumes must be adjusted accordingly. 

(i) Ethyl Alcohol (Ethanol) (C2H5OH), ACS/USP Absolute, Anhydrous, 200 proof 
(Aaper-Pharmco Products, Inc., Shelbyville, KY or equivalent low in trace-metal 
contamination). 

(j) Mercury (Hg) Stock Standard 1,000 mg Hg / L in 3-10% HNO3 or HCl and 10,000 mg 
Hg / L in 3-10% HNO3 or HCl (Inorganic Ventures, Lakewood, NJ or equivalent NIST 
traceable vendor / product). 
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(k) Iodide (I-) Stock Standard:  1,000 mg I / L in H2O+stabilizer (Inorganic Ventures, 
Lakewood, NJ or equivalent NIST traceable stock standard). 

(l) Tellurium (Te) Stock Standard: 1,000 mg Te / L in 2-10% HNO3 (Inorganic Ventures, 
Lakewood, NJ or equivalent NIST traceable stock solution). 

(m) Gold (Au) Stock Standard:  1,000 mg Au / L in 2-10% HCl (Inorganic Ventures,  
Lakewood, NJ or equivalent NIST traceable stock standard). 

(n) Ethylenediaminetetraacetic Acid (EDTA, Sigma-Aldrich Chemicals, St.Louis, MO or 
equivalent source). 

(o) Tetramethylammonium hydroxide (TMAH), 25% w/w, or equivalent (AlfaAesar, 30 
Bond St., Ward Hill, MA 01835). 

(p) Sodium Hypochlorite (Bleach) or equivalent for preparation of 10% bleach solution 
used for biological decontamination (i.e. ACTIVATE “Fresh Mix Bleach in a Bottle”,  
an approved equivalent product that mixes the 10% bleach solution with each spray). 

(q) Liquid argon (supplied by Speciality Gases or other contract agency) equipped with 
approved gas regulator (Matheson Gas Products, Secaucus, NJ – or equivalent). 

 

b. Reagent Preparation   

(1) Triton X-100 intermediate solution (1% v/v Triton X-100 in water) 
For ease of the regular preparation of other solutions (diluent and urine preservative), 
first prepare a 1% Triton X-100™ stock solution.  Add 20 mL of Triton X-100™ to a 
pre-acid-washed 2 L, narrow-mouth container that is partially filled with ≥18 MΩ⋅cm 
water. Fill to 2 L with ≥18 MΩ⋅cm water.  Add an acid-washed, Teflon™ coated 
stirring bar, and stir on a magnetic stirrer until the Triton X-100™ has completely 
dissolved into solution (several hours) or mix well and allow to stand overnight for 
complete dissolution. 
 

(2) Preservative for collected urine or intermediate standards 
(a) Preservative for collected urine samples  

(200 g/L sulfamic acid, 0.01% Triton X-100™).   
Partially fill a pre-screened or pre-acid-washed 50mL polypropylene centrifuge 
tube with ≥18 Mohm cm-1 water.  Add 10 g of sulfamic acid and 0.5mL of 1% 
TritonX-100 intermediate solution.  Fill to the 50mL mark with ≥18 Mohm cm-1 
water.  Dissolve the sulfamic acid by mixing well (use of a vortexer, or warm 
water bath is helpful in this process).  Store at room temperature.  Expiration is 
one year from preparation. 

(b) Preservative for intermediate standards  
(200 g/L sulfamic acid) 
Partially fill a pre-screened or pre-acid-washed 50mL polypropylene centrifuge 
tube with ≥18 Mohm cm-1 water.  Add 10 g of sulfamic acid.  Fill to the 50mL 
mark with ≥18 Mohm cm-1 water.  Dissolve the sulfamic acid by mixing well (use 
of a vortexer, or warm water bath is helpful in this process).  Store at room 
temperature.  Expiration is one year from preparation. 

 
(3) Diluent.   

(a) Internal Standard Intermediate Solution.  (100 mg/L Te in ≥18 MΩ⋅cm water) 
To facilitate the “as needed” preparation of the diluent, preparation of a supply of 
internal standard intermediate solution is recommended.  Partially fill a pre-
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screened or pre-acid-washed 50mL polypropylene centrifuge tube with ≥18 
Mohm cm-1 water.  Add 5mL Te stock (1000mg/L) then fill to the 50 mL mark 
with ≥18 Mohm cm-1 water.  Mix well and store at room temperature. To prepare 
different volumes adjust the solution constituents proportionally. 

(b) Diluent (1% (v/v) TMAH, 0.02% Triton X-100™, 25 µg/L Te, 5% (v/v) C2H5OH, 
500 µg/L Au, 0.5 g/L EDTA ). 
Acid-rinse a narrow-mouth 2 L container (Teflon™ preferred), and partially fill 
with ≥18 MΩ⋅cm water. Add the following, mixing in between each addition:  20 
mL of 25% (v/v) TMAH, 40 mL of 1% Triton X-100™, 100 mL ethanol, 1 mL of 
1,000 mg/L Au,  1g EDTA, and 0.5mL of internal standard intermediate solution 
(100 mg/L Te).  Dilute to 2 L with ≥18 MΩ⋅cm water. Store at room temperature 
and prepare as needed. To prepare larger volumes of diluent, add proportionally 
larger volumes of the solution constituents.   Use this diluent to prepare all 
standards and samples during the sample preparation / dilution process, which 
should occur just before analysis. It is important to make all calibrators, blanks, 
QC, and samples in a run from the same diluent solution so that the 
concentration of the internal standard is consistent.  Diluent homogeneity (e.g. 
internal standard concentration) is enhanced by stirring the diluent on a stir plate 
at lowest vortex speed throughout calibrator and sample preparation. 

 
(4) ICP-DRC-MS Rinse Solution ( 1% (v/v) TMAH, 0.02% Triton X-100™, 5% (v/v) 

C2H5OH and 500 µg/L Au). 
 
To prepare, acid-rinse a 4 L narrow-mouth Teflon™ container and partially fill with ≥18 
MΩ⋅cm water.  Add 40 mL of 25% (v/v) TMAH and 80 mL of 1% Triton X-100™ (see 
section 6.b.1 for preparation procedure), 200 mL C2H5OH  and 2 mL of 1,000 mg/L Au. 
Dilute to 4 L with ≥18 MΩ⋅cm water. Store at room temperature and prepare as 
needed. To prepare larger volumes of rinse solution, add proportionally larger volumes 
of the solution constituents. Pump this solution into the sample introduction system 
between samples to prevent carry over of the analytes of interest from one sample 
measurement to the next. 
 

(5) Base Urine Preparation 
The base urine used in this method is a pool of urine collected from anonymous 
donors. Collect urine in containers screened for iodine and mercury content. After 
receiving donations, analyze the urine to determine iodine and mercury 
concentrations. The final base urine pool should be ≤ 70 µg/L iodine and ≤ 0.1 µg/L 
mercury.  Donated urine specimens with acceptable concentrations of iodine and 
mercury, are pooled and then dispensed into smaller-volume tubes (i.e., 50 mL 
polypropylene tubes) for daily use. For short-term storage (a few days), store at 
approximately 2-4°C.  For long-term storage, store at ≤ -20°C.  A 2 L base urine pool 
should be enough for ~350 analysis runs (~ 14,000 samples at 40 samples per run). 
Combine this base urine with intermediate working standards prior to analysis each 
day to prepare a matrix-matched calibration curve for each run. 
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7. STANDARDS PREPARATION  

CAUTION! 
Mercury compounds are toxic! Take extra care to avoid accidental ingestion or inhalation of these 
materials. Wear appropriate personal protective gear.  Above all, wear a laboratory coat 
and latex or nitrile gloves. Clean up any spill that might occur according to applicable 
hazardous material spill procedures.   

Materials:  
Flasks:  one 500 mL (plastic or glass) for 10% v/v HCl 

 one 50mL (glass) for Hg Intermediate Stock Standard B 
 four 100 mL (glass) for other Intermediate Stock Standards  
                                                 (Hg-A, IOD-A, IOD-B, Hg-C) 
 five 100mL (glass) for Intermediate Working Standards 1-5. 
 Three 100mL (glass) for range of linearity (calibration verification) solutions 

Pipette volumes: 80-1000 µL 
Glass Bottles (~0.5oz) for final storage of standards solutions (approximately 30). 
Stock solutions: iodine (1000 mg/L) & mercury (1000 mg/L). 

 Hydrochloric acid: Concentrated (12M or 37%) HCl 
 

a. Materials preparation 

(1) Clean the flasks:   
(a) Acid-wash flasks: Rinse each with 5% (v/v) nitric acid solution followed by 

rigorous rinsing with ≥18 MΩ⋅cm water.  Repeat this process several times 
depending on prior use of the containers. After adequate acid washing, flasks 
should be clean of residual Hg and I from previous usage. 

(b) Monitoring:  This step is not usually necessary, but if performed, compare 
analysis results of water poured out of these flasks with results for water taken 
directly from the same water purification system to decide whether or not 
additional cleaning of the containers is needed.  Analysis of the water can be 
done directly without dilution or calibration using the normal ICP-DRC-MS 
method file.  Acceptable counts for clean vessels should be negligibly different 
from water blank counts.  Typical measured intensity observed for Iodine in water 
is less than 100cps and Mercury <30cps (counts vary between instruments due 
to sensitivity differences).  If background counts are too high, repeat step 7.a.1.a. 

(2) Sulfamic Acid Preservative:  Prepare 200 g/L sulfamic acid preservative as per 
Section 6.b.2. 

(3) Prepare 10% v/v HCl:  Add 25mL of concentrated HCl (12 M or 37%) to 
approximately 400mL water in an acid-washed 500 mL volumetric flask (see Section 
7. Materials: Flasks).  Dilute to the mark with ≥18 MΩ⋅cm water.  Mix well.  Store at 
room temperature.  Expiration date is 1 year from preparation. 

 

b. Intermediate Stock Standards Preparation   

(1)  Mercury Intermediate Stock Standards Preparation:  
 

(a) Hg Intermediate Stock Calibrator Solution A  
(‘Hg-A’, 1 mg/L mercury in 10% v/v HCl).  
Partially fill an acid-cleaned 100mL glass volumetric flask with 10% v/v HCl.  Add 100 
µL of 1000mg/L Hg stock standard.  Dilute to the 100 mL mark with 10% v/v HCl.  
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Mix well before use or storage.  Store an aliquot of this solution in a properly labeled 
glass bottle at refrigerated temperatures (~2-4ºC). 

(2) Hg Intermediate Stock Calibrator Solution B  
(‘Hg-B’, 0.1 mg/L mercury in 10% v/v HCl).   
Partially fill an acid-cleaned 50mL glass volumetric flask with 10% v/v HCl.  Mix the 
Hg Intermediate Stock Solution A (‘Hg-A’) well, then pipette 5mL of it into the partially 
filled, 50mL flask.  Dilute to the 50 mL mark with 10% v/v HCl.  Mix well before use or 
storage.  Store an aliquot of this solution in a properly labeled glass bottle at 
refrigerated temperatures (~2-4ºC). 

(3) Hg Intermediate Stock Calibration Verification Solution  
(‘Hg-C’, 100 mg/L mercury in 10% v/v HCl).   
Partially fill an acid-cleaned 100mL glass volumetric flask with 10% v/v HCl.  Add 
1000 µL of 10,000 mg/L Hg stock standard.  Dilute to the 100 mL mark with 10% v/v 
HCl.  Mix well before use or storage.  Store an aliquot of this solution in a properly 
labeled glass bottle at refrigerated temperatures (~2-4ºC). 
 

c. Iodine Intermediate Stock Standards Preparation:  

(1) Iodine Intermediate Stock Calibrator and Calibration Verification Solution A  
(‘IOD-A’, 100 mg/L iodine in water) 
Partially fill an acid-rinsed 100mL glass volumetric flask with ≥18 MΩ⋅cm water.  Add 
10 mL of 1000mg/L I stock standard.  Dilute to the 100 mL mark with ≥18 MΩ⋅cm 
water.  Mix well before use or storage.  Store an aliquot of this solution in a properly 
labeled glass bottle at refrigerated temperatures (~2-4ºC). 

(2) Iodine Intermediate Stock Calibrator Solution B  
(‘IOD-B’, 10 mg/L iodine in water) 
Partially fill an acid-rinsed 100mL glass volumetric flask with ≥18 MΩ⋅cm water.  Mix 
the I Intermediate Stock Solution A (‘IOD-A’) well, then pipette 10mL of it into the 
partially filled, 100mL flask.  Dilute to the 100 mL mark with ≥18 MΩ⋅cm water.  Mix 
well before use or storage.  Store an aliquot of this solution in a properly labeled 
glass bottle at refrigerated temperatures (~2-4ºC). 

 
d. Intermediate Working Standards Preparation 

(1) Partially fill five 100 mL glass volumetric flasks to a few centimeters below the 
meniscus with ≥18 MΩ⋅cm water.  Add 1mL of the 200 g/L sulfamic acid preservative 
solution to each flask and mix well.  Pipette the appropriate volume (see the table 
below) of each intermediate stock solution into the five flasks.  Mix these well, then 
dilute each to a final volume of 100mL with ≥18 MΩ⋅cm water.  Different volumes can 
be prepared by spiking with proportionally smaller or larger additions of components. 

 
Intermediate Working Standards Preparation volumes (µL). 
Working 
Standard 
Number 

Hg Interm. Stock 
STD B (‘Hg-B’) 

(0.1 mg/L) 

Hg Interm. Stock 
STD A (‘Hg-A’)  

(1 mg/L) 

I Interm. Stock 
STD B (‘IOD-B’) 

(10 mg/L) 

I Interm. Stock 
STD A (‘IOD-A’) 

(100 mg/L) 
STD 1 80  80  
STD 2 240  240  
STD 3 800  800  
STD 4  240  240 
STD 5  800  800 

 
(2) The final concentrations of iodine and mercury in each of the intermediate working 

standards can be calculated by the formula below (see table below for final 
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concentrations).  The values entered into the ICP-DRC-MS software should be the 
concentrations of the intermediate working standard.   

 
Int. Work. Std. Conc. (µg/L) = Int. Stock Std. Conc. (µg/L) x Int. Stock Std Spike (L) 
                                                                                0.100 L 
 

Intermediate Working Standards Concentrations (ug/L) 
 Mercury Iodine 

STD 1 0.08 8 
STD 2 0.24 24 
STD 3 0.8 80 
STD 4 2.4 240 
STD 5 8.0 800 

 
(3) Mix standards well and allow to equilibrate.  If time allows, test one aliquot of the 

calibrators before aliquoting into labeled glass bottles for storage with bench QC and 
reference materials (as available) before using it for patient sample analysis.  Store at 
refrigerator temperatures (~2-4ºC).  Expiration date is 6 month from preparation.   

 
e. Working Standards (Calibrators)  

The working calibrators are dilutions of the five intermediate working standards into a urine 
matrix (base urine) for the purpose of a matrix-matched external calibration of an analytical 
run (i.e. the run calibrators).  Prepare the working calibration standards along with patient 
samples and QC using the same diluent solution.  Diluent homogeneity (e.g. internal standard 
concentration) is enhanced by stirring the diluent on a stir plate at lowest vortex speed 
throughout calibrator and sample preparation.   Use the same base urine for all calibrators 
and urine blanks to be used within the run.  To prepare the working calibration standards, 
transfer 500 µL of the appropriate aqueous intermediate working standard, 500 µL of base 
urine, and 4,000 µL of diluent to a 15 mL polypropylene centrifuge tube by using the 
Micromedic Digiflex™. Cap the tube and mix well before analysis.  Section 20 describes 
procedures for situations where prepared dilutions cannot be analyzed within the same 
workday as preparation.  . 

f. Range of Linearity (RLT) / Calibration Verification Intermediate Working Standards 
Partially fill three 100 mL glass volumetric flasks to a few centimeters below the meniscus 
with ≥18 MΩ⋅cm water.  Add 1mL of the 200 g/L sulfamic acid preservative solution to each 
flask and mix well.  Pipette the appropriate volume (see the table below) of each intermediate 
stock solution into the three flasks.  Mix these well, then dilute each to a final volume of 
100mL with ≥18 MΩ⋅cm water.  Mix standards well and allow to equilibrate.  If time allows, 
test one aliquot of the calibrators before aliquoting into labeled glass bottles for storage. Test 
the solutions to verify the concentrations with bench QC and reference materials (as 
available) before using for patient sample analysis.  Store at refrigerator temperatures (~2-
4ºC).  Expiration date is 6 month from preparation. 

Range of Linearity (RLT) / Calibration Verification (CV) Intermediate Working Standards 
Preparation 
RLT / CV 
working 
standard 
number 

Spike Vol. 
Hg Intermediate 

Stock Std C 
(‘Hg-C’, 100 mg/L) 

Hg Conc. 
(ug/L) 

Spike Vol. 
I Intermediate 
Stock Std A 

(‘IOD-A’, 100 mg/L) 

Iodine Conc. 
(ug/L) 

RLT / CV 1 100 µL 100 ug/L 1,200 µL 1,200 ug/L 
RLT / CV 2 200 µL 200 ug/L 2,000 µL 2,000 ug/L 
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Different volumes can be prepared by spiking with proportionally smaller or larger additions 
of components.  Different concentrations of RLT / CV solutions can be prepared by making 
dilutions of these preparations using water immediately prior to their preparation at the 
Digiflex (i.e. a 50 ug/L Hg solution can be prepared by initially diluting the RLT / CV 
intermediate stock solution 2x using water prior to preparation of the working RLT / CV 
standard) or by spiking proportionally different volumes of the Hg or I intermediate stock 
standards when making the RLT / CV intermediate working standards.   

g. Quality Control Material 

(1) Bench QC Materials 
Analyze low and high bench QC material in each run to determine the validity of the 
concentration measurements being made. Quality control (QC) materials are made by 
spiking human urine collected from anonymous donors (see section 6.b.5) with single 
element iodide and mercury standards.  Prepare these pools periodically, as supply 
dictates, by spiking base urine to desired concentrations.  Prepare new pools far 
enough in advance so that both old and new pools can be analyzed together for a 
period of time (preferably at least 20 runs) before switching to the new QC materials.  
The two urine QC pools made for iodine and mercury assay are designated as: 

QC level QC Designation ID 

low pool LU-yy### 

high pool HU-yy### 

 

Where substitutions are: yy = the last two digits of production year, and ### = assigned 
pool identification number.  

QC material that is to be used for bench quality control run judge purposes will need to 
be “characterized” as described in the section Establish QC limits for each QC pool. 

(2) Reference Materials  
Analyze reference materials on a regular basis to evaluate / verify method 
performance.  When available, use standard reference materials (NIST).  Freeze 
dried certified reference materials (i.e. NIST SRM 2670) can be aliquoted into smaller 
volumes after reconstitution and stored at ≤ -20°C for use when needed.   

8. INSTRUMENT & SOFTWARE FOR THE ICP-DRC- MS 

a.   ICP-DRC-MS System 

(1) Inductively Coupled-Plasma Dynamic-Reaction Cell Mass Spectrometer ELAN® DRC 
Plus or DRC II (PerkinElmer Instruments, Headquarters Office, 710 Bridgeport Ave., 
Shelton, CT 06484-4794). Parameters of x-y alignment, mass calibration, autolens 
voltages, and nebulizer gas flow rates are optimized regularly. Other DRC™ 
parameters are optimized for each specific instrument. 

RLT / CV 3 250 µL 250 ug/L 3,000 µL 3,000 ug/L 
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ELAN® ICP-DRC-MS Method Parameters 
Parameter Setting 

RF Power 1.45 KW 
Argon nebulizer gas flow is the same 
as the DRC mode nebulizer gas flow Approx 0.9-1 LPM 

Detector mode Pulse 
Measurement units Cps 

Autolens On 
Blank subtraction After internal standard 

Curve type Simple Linear 
Sample units µg/L 

Sweeps/reading 90 
Readings/replicate 1 

Replicates 3 
Dwell time     30 ms for I and Te and 100 ms for Hg 
Cell gas Argon 

Cell gas flow rate  ~0.3 - 0.5 mL/min (optimize as needed) 

RPQ ~0.75 for iodine and ~0.35 for Hg 
(optimize as needed) 

Equations (on Te) 0.154312 * Xe 129 – 0.009437 * Ba 137 
 

(2) ELAN instrument control and data handling software, version 3.0 with service pack 2 
or equivalent (PerkinElmer Instruments, Shelton CT). 

(3) Cyclonic spray chamber (PerkinElmer Instruments, Shelton CT), or equivalent. 

(4) Concentric glass nebulizer, (P/N SB-50-A2, J. E. Meinhard Associates, CA) or 
equivalent.  

b.   Other equipment  

(1) Water purification system (NANOpure Diamond Ultrapure Water System, Barnstead 
International, Bedford, MA or equivalent) for providing ultrapure water with a 
resistivity ≥18 MΩ⋅cm.  

(2) Analytical balance for routine weighing of material to the nearest tenth of a gram and 
with a loading capacity of at least 200 g.  

(3) Micromedic Digiflex™ automatic pipette (or equivalent) to facilitate sample dilution / 
preparation equipped with 10.0 mL dispensing syringe, 2.0 mL sampling syringe, 
0.75 mm tip, and foot pedal (LABREPO, Inc., 101 Witmer Rd., Suite 700, Horsham, 
PA 19044). 

c.   Supplies 

(1) 5-100 µL pipette tips, 960 tips per case (Eppendorf® catalogue # 2235137-1, 
distributed by Eppendorf North America, Westbury NY), or equivalent.  

(2) 20-300 µL pipette tips, 960 tips per case (Eppendorf® catalogue # 2235144-3, 
distributed by Eppendorf North America, Westbury NY), or equivalent. 

(3) 1,000 µL pipette tips, 960 tips per case (Eppendorf® catalogue # 2249044-3, 
distributed by Eppendorf North America, Westbury NY), or equivalent. 
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(4) 5 mL pipette tips, 500 tips per case (Eppendorf® catalogue # 2235081-1, distributed 
by Eppendorf North America, Westbury NY), or equivalent. 

(5) Acid-cleaned volumetric flasks, 100 mL (qty 12) and 50 mL (qty 1) for standards 
preparation (glass preferred) and 500 mL (qty 1) for 10% HCl preparation (glass or 
plastic acceptable). To acid-wash flasks, rinse with 5% (v/v) reagent-grade nitric acid, 
followed by rigorous rinsing with ≥18 MΩ⋅cm water.  Repeat this process several 
times depending on prior use of the containers. 

(6) 2 Acid-cleaned 2 liter PE bottles.  To acid-wash containers, rinse with 5% (v/v) 
reagent-grade nitric acid, followed by rigorous rinsing with ≥18 MΩ⋅cm water.  Repeat 
this process several times depending on prior use of the containers.  

(7) 2 acid-cleaned 4 liter PE bottles.  To acid-wash containers, rinse with 5% (v/v) 
reagent-grade nitric acid, followed by rigorous rinsing with ≥18 MΩ⋅cm water.  Repeat 
this process several times depending on prior use of the containers. 

(8) Glass vials (10-30mL) for storage of calibration standards after preparation.  (i.e. 
clear Qorpak vials, All-Pak, Bridgeville, PA or equivalent). 

(9) Kay-Dry™ paper towels and Kim-Wipe™ tissues (Kimberly-Clark Corp., Roswell GA, 
or equivalent vendor). 

(10) Teflon™-coated magnetic stirs bars (2) (Catalog Number 58948-974 or equivalent), 
VWR Scientific Products, Buffalo Grove, IL. 

(11) Cotton swabs (Hardwood Products Co. ME, or equivalent vendor). 

(12) 15 mL (# 352097) and 50 mL (#352098) polypropylene centrifuge tubes or 
equivalent:  (Becton Dickinson Labware, 1 Becton Drive, Franklin Lakes, New Jersey 
07417 or equivalent). 

(13) Nitrile or Latex, powder-free examination gloves (N-Dex®, Best Manufacturing Co., 
Menlo, GA, or equivalent vendor). 

9. CALIBRATION AND CALIBRATION-VERIFICATION PROCEDURES 

 
a. Calibration Curve 

   
Generate a simple linear calibration curve for iodine & mercury by using a series of five 
external calibrators whose concentrations are defined in the calibration page of the 
quantitative analysis method software. The calibration curve plots the ratio of the 
observed intensities for iodine & mercury and the internal standards versus the 
concentration of the calibrators. Compare the ratio of the observed intensities for iodine & 
mercury and the internal standards in the patient sample to those obtained from the 
calibrators to determine the concentration of iodine & mercury in the sample. 

 
 
 

b.   Calibration Verification 
 
CLIA requires the verification of accuracy of instrument response to analyte 
concentration be completed at least every 6 months.  Each time this method is 
performed, the run contains calibration curve which meets this requirement for 
concentrations up to that of the highest calibrator.  To verify accuracy of instrument 
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response at concentrations higher than the highest calibrator take the following 
steps. 
 
(1) Bi-annual tests as defined in the DLS Policy and Procedures manual:  Analyze 

the Range of Linearity (RLT) / Calibration Verification (CV) working standard #3 
at least every 6 months.  If the observed concentrations are not within 10% of 
the target value, the lab supervisor should be notified and the issue should be 
investigated.  Verify that normal background measured intensities have been re-
achieved on the ICP-MS following analysis of elevated standards for calibration 
verification prior to performing further analysis. 

 
(2) As-needed confirmations (per supervisor discretion):  When a sample 

concentration is greater than 110% of the highest calibrator in the run, include 
an RLT / CV working standard, standard reference material, or certified 
reference material with equivalent (within 10%) or greater concentration than the 
sample.  Section 7.e. describes the preparation of three concentration levels of 
an RLT / CV working standard.  It is the analyst’s discretion which concentration 
is prepared and used so long as it is within 10% of the concentration being 
verified or higher.  In order to avoid needless contamination of the ICP-MS 
sample introduction system with high concentrations of analytes, use the lowest 
appropriate analyte concentration to meet the need. 
 
Any reference material sample from a historical proficiency testing program 
challenge can be substituted for this verification purpose IF 
 
(a) The target value has been assigned by an external source (i.e. NIST, or 

the proficiency testing program). 
(b) The concentration of the external reference material is within 10% or is 

higher than the concentration of the material you need it to confirm. 
(c) There is confidence that there is no contamination of previously used 

external reference material. 
(d) A note to file is made that this was done.  
(e) If the observed concentrations are not within 10% of the target value the 

lab supervisor should be notified and the issue should be investigated. 
 

10. OPERATING PROCEDURES; CALCULATIONS; INTERPRETATION 
OF RESULTS  

a. Preliminaries  
 

(1) For information about the reportable range of results and how to handle results 
outside this range, refer to the Reportable Range of Results section of this 
document (section 16). 

(2)  Allow frozen urine specimens, QC specimens, and base urine to reach ambient 
temperature. Vortex the sample well so that no particulates remain on the bottom 
of the tube before taking an aliquot for analysis. 
 

b.    Sample Preparation  
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(1) Thaw the frozen urine specimens; allow them to reach ambient temperature (about 
20°C). 

(2) Set up a series of 15 mL polypropylene centrifuge tubes corresponding to the 
number of blanks, standards, QCs, and patient samples to be analyzed. 

(3) Prepare the following solutions into the 15 mL polypropylene centrifuge tubes by 
using the Micromedic Digiflex™. 

 
Preparation of Samples for Analysis  (All Volumes in µL) 

ID Water 
Intermediate 
Working Std. 

Base 
Urine 

Urine 
Sample 
or QC 

Diluent 

Urine blank 500 - 500 - 4,000 
Calibration 
standards  - 500 500 - 4,000 

Aqueous blank 1,000 - - - 4,000 
Urine sample or 

QC 500 - - 500 4,000 

2x dilution of 
Urine sample* 750 - - 250 4,000 

Note:  These volumes are used because the total volume each sample this method 
consumed for is around 3,000 µL   

*  Volumes listed here are an example of how to combine the correct proportions of 
water, urine, and diluent in making a 2x dilution.  Other volumes of the same 
proportions can also be used.  Other dilutions can be prepared as needed by 
adjusting the proportion of urine to the total volume of diluted sample.  Use pipettes 
at greater than 10% volume capacity for best accuracy. 

 
(a)  Prepare an aqueous blank that consists of 1,000 µL of ≥18 MΩ⋅cm water and 

4,000 µL diluent. Use the aqueous blank for the QC pools and patient samples. 
(b)  Prepare five urine blanks that consist of 500 µL of base urine (same material 

used for preparation of the urine calibration standards), 500 µL of ≥18 MΩ⋅cm 
water, and 4,000 µL of diluent. Run one of these as the blank for the calibration 
standards.  Run two urine blanks after standard 5 (as sample IDs UrBlkChk1 
and UrBlkChk2, respectively). Analyze two urine blanks before the calibration 
blank to condition the system. 

(c)  Prepare the working calibration standards as described in section 7.d. 
(d)  Prepare dilutions (10x) of the QC and patient urine samples using manual or 

automated pipettors:  500 µL of ≥18 MΩ⋅cm water, 4,000 µL of the diluent and 
500 µL of the patient or QC urine sample. 

(e) Cap all of the blanks, standards, and samples and mix them well.  
(f)  It may be necessary to operate the instrument with cell gas flowing at the 

method flow rate for at least 30-45 minutes before the run begins. This may be 
done by analyzing the rinse solution for 8-10 sample cycles prior to anlayiss of 
the first conditioning blank.  This is to allow the conditions within the reaction 
cell to equilibrate before the run begins. Note:  The cell gas will automatically 
turn off after 1 hour of no ICP-MS DRC mode analysis. 

(g)  Uncap and place the dilution preparation of the blanks, standards, QC, and 
patient samples in the autosampler of the ELAN® ICP-DRC-MS immediately 
prior to start of the analysis run. 

(h)  Section 20 describes procedures for situations where prepared dilutions cannot 
be analyzed within the same workday as preparation. 
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c. Instrument Setup and Configuration 
 

(1) Turn on the computer, printer, peristaltic pump, and autosampler. Log into the 
computer operating system. 

(2) Start the ELAN® ICP-DRC-MS software from Windows™ and note whether all 
graphical indicators of instrument readiness are green. If not, take the 
appropriate actions described in the instrument’s software and hardware manual. 

(3) Perform necessary daily maintenance checks as described in Chapter 5 of the 
ELAN® ICP-DRC-MS Hardware Guide (e.g., argon supply, interface components, 
cleanliness, positioning and interface pump oil condition). Note the base vacuum 
pressure in the INSTRUMENT window of the software (Before igniting the 
plasma, the vacuum is typically between 8 x 10 -7 and 1.8 x 10 -6 torr). Record 
any maintenance procedures along with the base vacuum pressure in the Daily 
Maintenance Checklist (See example of daily checklist in the Appendix). 

(4) Set up the peristaltic pump tubing for the autosampler, rinse station, and spray-
chamber waste line. Position the tubing and close the pump clamps.  

(5) Start the peristaltic pump by pressing the appropriate arrow in the DEVICES 
window (Make sure that the rotational direction is correct for the way the tubing is 
set up in the peristaltic pump). Fill the rinse station reservoir quickly by pressing 
the “Fast” button in the DEVICES window. After the rinse station is filled with the 
rinse solution, type in “20” in the rpm field of the DEVICES window to set the 
pump speed. If the spray chamber rinse line is not draining the spray chamber 
correctly or the rinse solution is not flowing properly to the rinse station, adjust 
the tension screws on the peristaltic pump. 

(6) Read this step through entirely before proceeding.  It is important to get the 
tension on the autosampler tubing correct, or it will adversely affect the precision 
of the ICP-DRC-MS measurements. Through the METHOD/SAMPLING window 
in the software, press the “Probe” button, then the “Go to Rinse” button to lower 
the autosampler probe into the rinse solution.  Watch as the solution is taken up 
through the autosampler probe tubing. When the leading edge of the solution is 
visible, press “Stop” in the DEVICES window. The leading edge of solution in the 
autosampler tubing line should stop moving. If it does not stop, tighten the 
tension screw for this line on the back of the peristaltic pump. Loosen the 
peristaltic pump tubing screw for the autosampler tubing until the leading edge of 
solution in the autosampler tubing begins to move again, then tighten the screw 
just enough to make the solution edge stop. Tighten the screw another eighth to 
a quarter of a turn. Next, start the peristaltic pump by pressing the appropriate 
arrow in the DEVICES window (make sure that the rotational direction is correct 
for the way the tubing is set up in the peristaltic pump). 

(7) In the INSTRUMENT window of the software, press the “Start” button to ignite 
the plasma.  After the plasma ignites, restart the peristaltic pump. 

(8) Allow approximately 30 to 45 minutes warm-up time for the ICP-DRC-MS (with 
plasma running).  After this warm-up time, complete the appropriate daily 
optimization procedures as described in Chapter 3 of the ELAN® DRCII Software 
Guide. Include beryllium (m/z 9) in the mass calibration, autolens optimization, 
and daily performance check by using a 1-10 µg/L multielement solution. Fill in 
the Daily Maintenance Checklist according to the completed optimization 
procedures. Save new tuning (mass-calibration) parameters to the file 
“default.tun.”  Periodically, save these parameters also in a separate file 
containing the analysis date “default_YYMMDD.tun”. Save new optimization 
parameters (i.e., detector voltages, autolens values and nebulizer gas flow rate) 
to the file “default.dac”.  Periodically, save these parameters also in a separate 
file containing the analysis date “default_YYMMDD.dac” (where YY=year, 
MM=month and DD=day). 
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(9) To set up the run in the software, click on “Open Workspace” from the “File” 
menu.  Select the workspace file “CDC_Urine_ I_Hg.wrk.”. Select “Review Files” 
from the “File” menu. From this window, you will be able to set up the correct files 
and directories for data for your analysis. Select the method, report template, 
tuning, and optimization files later. There is no need to select a calibration or 
polyatomic file (If this workspace has not been created on the instrument 
computer being used, follow the directions in the ELAN ICP-DRC-MS software 
manual to set it up using the parameters described in this write-up). 

•  Data set: If this is the first run of the day, create a new data set by using 
the date as the name (Use the format 20050801 for August 1, 2005). If a 
run has already been performed today, select the data set for today’s 
date. 

• Sample: If an analysis has been performed that is similar to the one you 
are going to do, select the sample file corresponding to it. Edit it later for 
the present analysis. 

(10) In the SAMPLES/BATCH window, update the table to reflect the current sample 
set (e.g., autosampler locations, sample identification (ID), analysis methods and 
peristaltic pump speeds). Two method files (CDC_UIHg_methITU007B_urblk.mth 
and CDC_UIHg_methITU007B_aqblk.mth) will be used. These two methods 
differ only in the autosampler locations of the blank and calibration solutions. Use 
the “UR” method file to run the base urine blank and the calibration standards at 
the very beginning of the run. Because of the autosampler positions defined in 
the method file (these are editable), the urine blank must go in autosampler 
location 11 and the urine calibration standards 1-5 must go in autosampler 
locations 12-16, respectively. Use the “AQ” method file to run the aqueous blank 
before the first sample. Because of the autosampler positions defined in the 
method file (these are editable), the aqueous blank must go in autosampler 
location 19.  Except for defining the blank and calibration standards’ autosampler 
locations, it does not matter which of these files is used when analyzing a sample 
since all other analysis parameters are identical in the method files. A typical 
SAMPLE/BATCH window for this method will look like Table below. (Note: All 
other autosampler positions besides those specified above are arbitrary.) 
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Typical Sample File Setup for a Urine Iodine & Mercury Analysis Run 
A/S 

Location 
Sample ID 

Measurements 
Action 

Method File* 

37 DRC Rinse Delay Run sample CDC_UIHg_methITU007B_urblk.mth 
38 DRC Rinse Delay Run sample CDC_UIHg_methITU007B_urblk.mth 

39 Conditioning 
Urine Blank Run sample CDC_UIHg_methITU007B_urblk.mth 

 
40 

Conditioning 
Urine Blank Run sample CDC_UIHg_methITU007B_urblk.mth 

100 UrBlkChk1 
Run blank, 

standards, and 
sample 

CDC_UIHg_methITU007B_urblk.mth 

101 UrBlkChk2 Run sample CDC_UIHg_methITU007B_urblk.mth 

20 AqBlkChk Run blank and 
sample CDC_UIHg_methITU007B_aqblk.mth 

23 Low-bench QC Run sample CDC_UIHg_methITU007B_aqblk.mth 
24 High-bench QC Run sample CDC_UIHg_methITU007B_aqblk.mth 
35 Sample 1 Run sample CDC_UIHg_methITU007B_aqblk.mth 
36 Sample 2 Run sample CDC_UIHg_methITU007B_aqblk.mth 
37 Sample 3 Run sample CDC_UIHg_methITU007B_aqblk.mth 

Etc. ……   
74 Sample 40 Run sample CDC_UIHg_methITU007B_aqblk.mth 
25 Low-bench QC Run sample CDC_UIHg_methITU007B_aqblk.mth 
26 High-bench QC Run sample CDC_UIHg_methITU007B_aqblk.mth 

 
Modification of the method file is allowed for situations such as 

1. running only Hg or only I (and the internal standard) 
2. analyzing calibrators at different autosampler locations (when you want to 

perform multiple runs with different sets of calibrators). 
In such cases, any new file created should be renamed to have the original 
filenames (above) at the beginning. Examples include 
CDC_UIHg_methITU007B_urblk_Hg.mth (when only analyzing for Hg) or 
CDC_UIHg_methITU007B_urblk_calset2.mth (when performing a second run with 
a different set of calibrators). 
 
The autosampler positions of QCs and patient samples do not have to be those 
shown above, but the order in which these are run (DRC mode delay time of 
approximately 1 hour with rinse solution aspirating, followed by 2 UrBlkChk 
conditioners, a urine blank for the calibrators, calibration standards 1-5, urine blank 
checks 1 and 2, low-bench QC, high-bench QC, 40-80 patient samples including 1 
blind QC sample, low-bench QC, and high-bench QC) should be as shown in Table 
above. 
 
The settings in Table below should be used for uptake and rinse times for all 
samples, QC’s, and standards. (These values are already stored in the method 
files for the blanks and standards.) 

 
Sample File Timing Parameters for a Urine Iodine & Mercury Analysis Run 

 Pump Speed* Duration 
Sample flush -20 rpm 45 s 

Read delay and analysis -20 rpm 50 s 
Wash -48 rpm 100 s 
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The QC tab/sample tab in the method should be setup so that a 200s rinse 
time will occur after any sample whose Hg concentration exceeds 30 µg/L or 
whose I concentration exceeds 2000 µg/L. 
* Note:  Negative values for pump speed indicate direction of pump rotation.  
Make sure that pump tubing is set up appropriately to match the direction of 
pump rotation. 

 
If using the lab database for long-term recording and handling of data (Section 
10.d.(2)(d)), do not use the Elan® software to automatically correct for sample 
dilutions.  When dilutions of any sample are run, the sample ID should be edited to 
reflect the level of dilution being performed (A two-fold dilution of “Sample 1” could 
be recorded in the sample ID as “Sample 1 (2X)”. The exact wording is not critical). 
Edit this sample ID during the data-import process to the database so that it is 
recognized as the appropriate sample. (See Section 10.d.(2)(d)). 

(10) Before beginning the analysis run, start the flow of the reaction-cell gas (argon) and 
allow the cell conditions to equilibrate. Make sure that the reaction-cell gas 
pressure to the instrument is approximately 7 psi on the cell-gas cylinder regulator.  
In the “Manual Adjust” page of the “Optimization” window, enter a value of “0” in the 
appropriate cell-gas field (cell-gas A for this method). Then enter a very low, non-
zero cell gas flow rate in the same field (i.e. 0.01mL/min). A clicking should be 
heard from the ICP-DRC-MS cell-gas solenoid as the flow turns on. Flush the cell 
gas for 60 seconds by lifting the flush level at the front of the instrument (The flush 
step may not be necessary if this same gas cell was used recently and no gas 
tubing has since been disconnected). After the cell gas flush, enter the method-
appropriate cell gas flow rate in the same field.  Monitor the flow in the ELAN 
software, on the Instrument window (diagnostics tab). It is usually necessary to 
operate the instrument with cell gas flowing at the method flow rate for 30 minutes 
to 1 hour before the run begins. This is to allow the conditions within the reaction 
cell to equilibrate before the run begins. Necessity of this equilibration time can be 
determined by monitoring stability of the observed iodine and mercury 
concentration of a standard analyzed multiple times within a run. Note: The cell 
gas will automatically turn off after 1 hour of no DRC-mode analysis. 

(11) After the parameters in the SAMPLE/BATCH window are edited for the run, place 
the solutions in the autosampler tray according to the setup of the 
SAMPLE/BATCH window and method files. Highlight (click and drag with the 
mouse) the table rows of the samples that are to be included in the run, then click 
on “Analyze Batch.”  If sample analysis is to finish the run unattended after normal 
laboratory hours, the AutoStop (Instrument window- AutoStop Tab) may be 
enabled to shut off the plasma when the analysis is completed.  If the AutoStop is 
not enabled, the DRC gas will shut off approximately 1 hour after the last sample 
analysis in DRC mode, but the plasma will remain lit.  If the plasma is to remain 
operating unattended, ensure that adequate rinse solution is available for the time 
that the instrument will be unattended.  

(12) Instrument Shut Down 

(a) Rinse the sample introduction system with water, then with no liquid (dry).   

(b) Stop the peristaltic pump.   

(d) Shut off ICP-DRC-MS plasma.  

(e) Loosen tensioning bars and tubing. 

(f) At the controller computer, visit the ELAN Instrument Control Session 
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application and open the “Dataset” window. Confirm that all samples ran 
successfully and that the corresponding data for each sample is listed in this 
window.  

d. Recording of Data  
 

(1) QC Data 
 

Store the results of the QC samples analyzed in each run in the Microsoft 
Access™ (or MS SQL Server) database when all other data for the run is imported 
from the ELAN® software See Section 10.d.(2)(d) for a description of how to import 
data into the Microsoft Access™ database). 

 
(2)  Analytical Results 

 
(a) Analysis Printouts and Analyst Run Report 

Bind the analysis printouts with a printout of the calibration curve and curve 
statistics as the top page and place them in the study folder(s). Write the 
following information on the cover sheet of the analysis printouts: Run date, run 
number, study ID, and analyst ID (the Run ID from the database is also 
helpful). Store the results of the patient samples analyzed in each run in the 
Microsoft Access™ (or MS SQL Server) database when all other data for the 
run is imported from the ELAN® software. See Section10.d.(2)(b) for a 
description of how to import data into the laboratory database.  If the database 
allows for the printing of a run summary report that indicates whether any 
particular patient-sample results are outside of the normal concentration 
reference range or whether any measurement failed precision limits, it may be 
helpful to print it out after each analysis. These reports can be helpful to keep 
in a notebook for future reference (See Section 10.d.(2)(b) for a description of 
how to import data into the database to print out a customized sample report). 
 

(b) Using the Microsoft Access™ Database 
After an analysis run, export the results to a .TXT file and then import into the 
Microsoft Access™ or MS SQL Server database that handles data for the 
laboratory branch.   

 
i. Data Export Process (from ELAN® software to .TXT or .CSV file)   

In the ELAN® ICP-DRC-MS software, select “Review Files” from the “File” 
menu. From this window, you must open the files and directories that were 
used when collecting the data of the run that you wish to export (If the 
analysis has just ended, all of these files and directories will still be open). 
NOTE:  A second copy of the ELAN® software can be run as an 
Edit/Reprocess copy without affecting an ongoing analysis by the first copy 
of the software running in Windows. After you open the relevant files, go to 
the “Report” page in the METHOD window. Deselect the box that prints a 
paper copy of data and select the box that sends data to a file. Select the 
“Report Options Template” named “CDC_Database_output.rop” and type in 
a report filename using a format such as “20050801a_group55.txt” (or 
20050801a_group55.csv) to designate data from analysis of group 55 from 
August 1, 2005, run #1.  Under “Report Format”, choose the “Use 
Separator” option, and under the “File Write” section choose “Append.”  
Finally, reprocess the data of interest (See PerkinElmer ELAN® II Software 
Manual). Make sure you apply the correct blank to the correct samples and 
QCs (use the urine blank for all of the calibration standards, UrBlkChk1, 
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and UrBlkChk2. Use the aqueous blank for all analyses of patient samples 
and QC samples). 
 

ii. Data Import Process (from .TXT or .CSV file to Microsoft Access™ 
database). 
Transfer the .TXT or .CSV file to the appropriate subdirectory on the 
network drive where exported data are stored(Note that directories are 
named according to instrument/year/month/ and study name or ID, such as 
I:/Instruments/ELAN® DRCIIG/2005/08/Study 2005-xx).  From a computer 
that has access to Microsoft Access™ or MS SQL Server database used 
for tracking data, log in using your user ID#. After you log into the 
database, open the select “Import Instrument File” from the “Front End 
Set”. Enter the appropriate information to identify the run, assay, study, 
instrument, and analyst and press the “Import” button. Select the location 
of the data file on the network drive and press the “Open” button. In the 
“Imported Results” table, pressing the “Find X’s” button will show only 
those samples whose sample ID is not recognized as a valid QC pool ID or 
sample ID for this study (Sample IDs are set up when the study is logged 
into the database). Corrections to sample IDs and dilution factors can be 
made in this table (e.g., correction of transcription errors and adjustment 
for level of dilution). If samples were diluted for analysis (Section 10.c.(10)), 
both the sample ID and the dilution factor need to be edited in this table 
before the values are transferred to the database. First, change the dilution 
factor to reflect the way that the sample was analyzed then edit the sample 
ID to remove any comments about the level of dilution at which the sample 
was analyzed (The replace command is useful here). When corrections to 
sample IDs are made, press the “Recheck” button to evaluate the sample 
IDs. Any sample or analyte row marked “Not Recognized” will not be 
transferred to the database when the “Transfer” button is pressed. From 
this point, the data should be labeled with the appropriate settings for QC 
accept / reject, final value status, and comment.  
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11. FINAL REVIEW OF THE DATA 

a. Abnormal Patient Results: 

a. Boundaries Requiring Confirmatory Measurement: 

(a) Results Lower than the First Lower Boundary (1LB):  Concentrations observed less 
than the “first lower boundary” (defined in the laboratory database as the “1LB”) should be 
confirmed by repeat analysis of a new sample preparation.  The concentration assigned to 
the 1LB for an element is determined by study protocol.  The default 1LB for iodine is 10 
ug/L (there is no lower confirmation boundary for mercury).  Report the original result, as 
long as the confirmation is within 10% of the original.  Continue repeat analysis until a 
concentration can be confirmed.  

(b) Results Greater than the First Upper Boundary (1UB):  Concentrations 
observed greater than the “first upper boundary” (defined in the laboratory 
database as the “1UB”) should be confirmed by repeat analysis of a new 
sample preparation.  The concentration assigned to the 1UB for an element is 
determined by study protocol.  The default concentrations are 800 ug/L for I 
and 5 ug/L for Hg.  Report the original result, as long as the confirmation is 
within 10% of the original.    Continue repeat analysis until a concentration can 
be confirmed. 

(c) Results Greater Than Highest Calibrator:  When a sample result is greater 
than the highest calibrator, the result should be confirmed in an analysis run 
which includes a standard or external reference material with equivalent (within 
10%) or greater concentration than the sample.   

(d) Results Greater Than Range of Linearity Tested (RLT):  Perform an extra 
dilution on any urine sample whose concentration is greater than the range of 
linearity tested / calibration verification sample analyzed along with it (Section 
9.b).  See table in section 10.b for details of preparing a sample with extra 
dilution. 

b. Inadequate Precision in Confirmation of a Measurement:  If a sample is 
reanalyzed to obtain a confirmation of an initially elevated result, the confirmation 
should be within 10% of the original result.   

c. Inadequate Precision Within One Measurement:  If the range of the three replicate 
readings (maximum replicate concentration value - minimum replicate concentration 
value) for a single sample analysis is greater than 30 ug/L for I or 1 ug/L for Hg (“>Lim 
Rep Delta” in the database) and the range of the three replicate readings is greater 
than 10% of the observed concentration, do not use the measurement for reporting.  
Repeat the analysis of the sample. 
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d. Analyst Reporting of Abnormal Patient Results:  Concentrations observed for 
iodine less than the second lower boundary” (defined in the laboratory database as the 
2LB) or greater than the “second upper boundary” (defined in the laboratory database 
as the “2UB”) should be reported to the QC reviewer as an either an “abnormally low 
result” or an “elevated result”, respectively.  The concentrations assigned to the 2LB 
and the 2UB for an element is determined by study protocol.  The default second 
boundary concentrations for iodine are 10 ug/L (2LB) and 2000 ug/L (2UB).  The 
default boundaries for mercury are 5 ug/L (1UB) and 10 ug/L (2UB).  There are no 
lower boundaries for mercury.  The analyst should report any patient results confirmed 
to be greater than the second upper boundary to the QC reviewer as an “elevated 
result”.  There is no routine notification for elevated levels for the metals determined in 
this method.  The protocol for supervisors reporting elevated results to medical 
personnel is defined according to the study protocol. 

 

b. Evaluating Bench QC Results:  See sections 16.b-c for how to apply division QC rules and take 
corrective actions if necessary. 

i. Submitting Final Work for Review 
Once results have been imported, reviewed, and set as final in the database by the 
analyst,  

a. Submit an email to the QC reviewer informing them of the readiness of 
the data for final review.  The email should include 

1. Instrument ID, run Date, run number, study ID, group ID. 

2. Any bench QC failures (include reasons if known). 

3. Any patient sample results less than the 2LB or greater than the 2UB 
should be reported in the email as either an abnormally low 
concentration (<2LB) or an “elevated result” (>2UB). 

4. Anything out of the ordinary about this analytical work which could 
have a bearing on the availability (i.e. insufficient sample to analyze), 
accuracy, or precision of the results. 

b. Include all items called for by the study folder cover sheet in the study 
folder (i.e. printouts from the ICP-MS, bench QC evaluation) together in 
the study folder before submitting the folder for review when analysis is 
complete. 

12. REPLACEMENT AND PERIODIC MAINTENANCE OF KEY 
COMPONENTS 

Part numbers listed below are PerkinElmer part numbers from their 2005 Consumables 
Catalog.  Equivalent parts may be substituted. 

a. Autosampler probe assembly (part # B300-0161) or equivalent. Keep one spare on 
hand. 

b. Peristaltic pump tubing for sample (0.03 inch i.d., part #09908587), rinse station (can 
use either same tube type as for sample or 0.045 inch i.d., part #N0680375) and for 
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waste (0.125 inch i.d., part #N8122012): Keep at least 6 packages of 12 on hand of the 
sample tubing, 6 for rinse station and 2 packages of 12 on hand of the waste tubing. 
Other suppliers may offer the same size/type of peristaltic tubing.  

c. Nebulizer capillary tubing (used to connect the nebulizer and the peristaltic pump 
tubing, part #09908265 or any source of polyethylene tubing, 0.6 mm i.d. x 0.97 mm 
o.d.). Keep one pack (10 feet) on hand. 

d. Injector Support/Torch Base (part #N8120116). Keep one spare on hand. 

e. Torch O-Ring Kit (packages of four, part #N8120100). Keep four spare packages on 
hand. 

f. Quartz torch. At least two spare torches should be on hand (part #N8122006). 

g. Quartz 2mm Bore Injector (part #WE023948). 

h. RF coil Assembly, self aligning (part #WE021816). One spare should be on hand. 

i. Nickel Skimmer (part #WE021137) and sampler cones (part #WE021140). Keep at 
least two spares of each on hand. 

j. Skimmer and sampler cone O-rings (part #N8120512 and #N8120511, respectively). 
Keep at least 10 spares of each on hand. 

k. Series II replacement Ion lens (part #WE018034). Keep two spares on hand. 

l. Pump oil for the roughing pump (part #N8122004). Keep four bottles on hand. 

m. Polyscience chiller coolant (PE Sciex Coolant, part #WE016558): Two 1 L bottles 
should be kept on hand.  If possible, have a backup autosampler and chiller. See a 
PerkinElmer sales representative for part numbers. 

n. Nebulizer, quartz concentric ~1mL/min liquid flow rate like part # 500-70QQDAC 
(Precision Glass Blowing, Centennial, CO, www.precisionglassblowing.com).  This 
nebulizer is designed to use quick disconnects part # 500-QD (liquid) and # 500-AC 
(argon). 

o. Spray chamber, quartz concentric like PerkinElmer part # WE025221 (PerkinElmer, 
Shelton, CT, www.perkinelmer.com).  Available direct from manufacturer as part # 400-
20 (Precision Glass Blowing, Centennial, CO, www.precisionglassblowing.com) or from 
various distributors. 

13. LIMIT OF DETECTION 

The limits of detection (LOD) for iodine and mercury in urine specimens is based on three times 
the standard deviation of approximately 20 or more measurements of urine blanks or low 
concentration urine samples, each analyzed in a separate run. This represents the method 
detection limit. Report results below the detection limit as “< LOD” (where “LOD” is the calculated 
lowest detection limit). The LOD calculation may be reevaluated annually.  

14. REPORTABLE RANGE OF RESULTS 

Urine Iodine & Mercury results are reportable in the range of greater than the LOD, where LOD is 
the calculated lower detection limit.   

http://www.precisionglassblowing.com/�
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15. SPECIAL PROCEDURE NOTES – CDC MODIFICATIONS  

None applicable for this operation.  

16. QUALITY CONTROL PROCEDURES 

The Inorganic and Radiation Analytical Toxicology Branch uses the method described in this 
protocol for environmental and occupational health screening studies.   

This analytical method uses two types of Quality Control (QC) systems: With one type of the 
QC system, the analyst inserts bench QC specimens two times in each analytical run (a set of 
consecutive assays performed without interruption) so that judgments may be made on the day 
of analysis. With the other type of QC system, “blind” QC samples are placed in vials, labeled, 
and processed so that they are indistinguishable from the subject samples (as much as 
possible).  If it is not possible to have the blind QC inserted into the sample group before 
receipt into the lab, an additional low and high QC pool should be made available to the analyst 
so that they can manually insert the material into the run.  This type of “blind QC” should match 
the matrix of the patient samples as much as possible and the acceptable concentration limits 
(characterized limits) should be unknown by the analyst(s).  The supervisor decodes and 
reviews the results of the blind specimens. With both systems, taking these samples through 
the complete analytical process assesses all levels of the analyte concentrations. The data 
from these materials are then used to estimate methodological imprecision and to assess the 
magnitude of any time-associated trends. The bench QC pools used in this method comprise 
two levels of concentration spanning the “low-normal” and “high-normal” ranges. Both of these 
pools are analyzed after the calibration standards are analyzed but before any patient samples 
are analyzed so that judgments on the iodine and mercury calibration curves may be made 
before analysis of patient samples. These bench QCs should be analyzed again at the end of 
the run. 

  

a. Establish QC limits for each QC pool.   

Perform an analysis of the mean and standard deviation for each pool from the 
concentration results observed in at least 20 characterization runs. During the 20 
characterization runs, previously characterized QCs or pools with target values assigned by 
outside laboratories to evaluate each run’s QC. In addition to providing QC limits, the 
characterization runs also serve to establish homogeneity of the pools.  

b. Evaluating the Quality Control of a Run.  After completing a run, and importing the 
results into the database, export the QC results to the SAS program where the run will be judged 
to be in or out of control.  The QC limits are based on the average and standard deviation of the 
beginning and ending analyses of each of the bench QC pools, so it will not be possible to know if 
the run is officially accepted or rejected until it is completed.  The following is an explanation of the 
division QC rules which will be applied by the SAS program. 

(1) If both QC run means (low & high bench QC) are within 2Sm limits and individual 
results are within 2Si limits, then accept the run. 

(2) If 1 of the 2 QC run means is outside a 2Sm limit - reject run if: 
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(a) Extreme Outlier – Run mean is beyond the characterization mean +/- 4Sm 

(b) 1 3S Rule - Run mean is outside a 3Sm limit 

(c) 2 2S Rule - Both run means are outside the same 2Sm limit 

(d) 10 X-bar Rule – Current and previous 9 run means are on same side of the 
characterization mean 

(e) If one of the 4 QC individual results is outside a 2Si limit - reject run if: 

(f) R 4S Rule – Within-run ranges for all pools in the same run exceed 4Sw (i.e., 
95% range limit) 

Note: Since runs have multiple results per pool for 2 pools, the R 4S rule is pplied within 
runs only. Abbreviations: 

Si = Standard deviation of individual results (the limits are not shown on the chart unless 
run results are actually single measurements). 

Sm = Standard deviation of the run means (the limits are shown on the chart). 

Sw = Within-run standard deviation (the limits are not shown on the chart). 

 

c. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable 
Criteria 

(1) If the division SAS program declares the run out of control” for any analyte, ONLY the 
analytes which were “out of control” are invalid for reporting from the run.  Set all run 
results for those 1 or 2 analytes as “QC Rejected” in the database.  Evaluate the reason 
for QC failure and take corrective action.  Below is a list of areas to evaluate. 

(2) Check the calibration curve(s) for linearity and for an intercept near zero.  Calibration 
points not falling closely to the regression line may indicate a calibrator which was 
improperly prepared, analyzed, or needs to be made new.  Be sure to use freshly 
prepared calibrators and QC material.  Typical correlation coefficients (r2) are > 0.999.  If 
possible, prepare new dilutions or preparations of calibrators which are outliers and 
reanalyze with the run to replace the original calibrator analysis.  An individual calibration 
point may be removed from the curve if it is obviously an outlier.  If the highest calibration 
point is removed, the highest calibrator used in the analysis should be specified in the 
laboratory database when the results are imported.  If a certain calibrator is problematic 
repeatedly, investigate the problem and take corrective action to prevent the problem 
from continuing. 

(3) Check for high blanks which lead to over-subtraction from analysis results. 

(4) Check the ICP-DRC-MS stability during the run by examining the degree of variability 
and drift in internal standard raw peak areas over the course of the run. Irreproducibility 
that exceeds 15% and drift >20%, or sudden large changes in internal standard peak 
area, likely indicates that there was a problem in plasma stability.  

If these steps do point to appropriate corrective action, for the out-of-control values for QC 
materials, consult the supervisor for other appropriate corrective actions. No analytical results 
should be reported for runs that are not in statistical control. 
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17. REFERENCE RANGES 

 
Reference Ranges for Elements Measured (all units µg/L) 
 

Element/ 
Isotope 
Monitored 

Reference Ranges 
 (10th- 95th Percentile, µg/L) 

(weighted, non-creatinine 
corrected NHANES 2001 & 

2002 results)  

I-127* 41- 803 (9) 
Hg-202* < 4.63 (8) 

 

 
* Te-130 used as internal standard 

18.   ACTION-LEVEL RESULTS   

Due to the uncertainty of the health implications of elevated concentrations of these elements, 
there is no routine notification for elevated levels of urine iodine or mercury.  Action levels for 
reporting to supervising physicians are determined on a study-by-study basis. 

19.   SPECIMEN STORAGE AND HANDLING DURING TESTING 

Specimens may reach and maintain ambient temperature during analysis. Take stringent 
precautions to avoid external contamination. After the samples are analyzed, return them to ≤ -
20ºC freezer storage as soon as possible.    

20.   ALTERNATE METHODS FOR PERFORMING TEST AND STORING 
SPECIMENS IF TEST SYSTEM FAILS 

If prepared working calibrators, samples, and QC cannot be analyzed within the same workday of 
the preparation, they may be capped and stored at refrigerator temperatures (~2-4°C) for up to 48 
hours before analysis.  Samples can be stored at room temperature during this time if they will 
only be analyzed for iodine.  (see Appendix A, Parameter Test #5) 

If the analytical system fails, then store urine specimen at ≤ 4ºC until the analytical system is 
restored to functionality. If long-term interruption (longer than 4 weeks) is anticipated, then store 
urine specimens at ≤ -20ºC.  If this method is not available, a Flow Injection Mercury System 
method (FIMS) can be used as an alternative for urine mercury analysis and a 
spectrophotometric analysis method can be used as an alternative for urine iodine analysis.  
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21.   TEST - RESULT REPORTING SYSTEM; PROTOCOL FOR 
REPORTING CRITICAL CALLS (IF APPLICABLE) 

Report test results as outlined in the DLS Policies and Procedures Manual.  For critical calls, the 
supervisor should notify the supervising physician or principal investigator as soon as possible.  
The most expeditious means should be used (e.g., telephone or E-mail). 

22.   TRANSFER OR REFERRAL OF SPECIMENS; PROCEDURES FOR 
SPECIMEN ACCOUNTABILITY AND TRACKING 

Location, status, and final disposition of the specimens will be tracked at least by paper document 
in the “Study Folder” (created before analysts receive the samples).  Apart from this specimen 
tracking form, this folder will also contain the paper print outs of results from analysis of the 
specimens.  Maintain records for a minimum of 3 years.  Use only numerical identifiers for 
samples within the laboratory (e.g., case ID numbers) in order to safeguard confidentiality.  Only 
the medical supervisor (MS) or project coordinator (PC) i.e. non CDC personnel should have 
access to the personal identifiers. 
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24. APPENDIX 

Appendix A.  Ruggedness Testing Results. 
 
Parameter Test #1:  Evaluate the impact on analysis results if the set RF Power is increased to 
1600W (instrument maximum) or decreased to 1150W (by 20%) for the analytical run.  (Method 
RF Power setting described in section 8.a.1).   
 
Test Details:  
1. Three different RF power settings were tested in separately prepared, consecutive runs on 

the instrument without turning off the plasma.  At least 15 minutes stabilization time was 
allowed between each run after the RF power was changed.  “Junk urine” samples (38) were 
analyzed between the beginning and ending QC of each run.  All other method parameters 
were kept per method. 

2. Run #1 (method default, 1450W).  
3. Run #2 (Decreased RF power by 20% to 1150W).  
4. Run #3 (Increased RF power to instrument maximum, 1600W).  
 

Parameter Test 1 Results.   
Test performed 3/17-18/10 by Dana Henahan. 

QC  
Pool ID 

RF Power Tested I (ug/L) Hg (ug/L) 

LU-03250_UIHG_c 

Characterized Mean 
Characterized  2SD Range 

92.7 
88.2 – 97.2 

0.21 
0.14 – 0.29 

1150W          (Reduced) 
 

93.2 
 

 
0.15 

 

1450W       (Per Method) 
 

92.1 
 

 
0.18 

 

1600W         (Increased) 
 

92.4 
 

 
0.20 

 
 

HU-03251_UIHG_c  

Characterized Mean 
Characterized 2SD Range 

308 
293 – 322 

2.30 
2.05 – 2.54 

1150W          (Reduced) 
 

294 
 

2.15 

1450W       (Per Method) 
 

307 
 

 
2.23 

 

1600W         (Increased) 
 

315 
 

 
2.19 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #2:  Evaluate the impact on analysis results if the Cell Gas Flow Rate is 
increased or decreased by 20% for the analytical run.  (Method Cell Gas Flow Rate setting 
described in section 8.a.1).   
 
Test Details:  
1. Three different Cell Gas Flow Rates were tested in separately prepared, consecutive runs on 

the instrument without turning off the plasma.  At least 15 minutes stabilization time was 
allowed between each run after the cell gas flow rate was changed.  “Junk urine” samples 
(38) were analyzed between the beginning and ending QC of each run.  All other method 
parameters were kept per method. 

2. Run #1 (method default = 0.3 mL/min)  
3. Run #2  (decreased Cell Gas Flow Rate by 20% to 0.24 mL/min).   
4. Run #3 (increased Cell Gas Flow Rate by 20% to to 0.36 mL/min). 
 
 

Parameter Test 2 Results.   
Test performed 3/23/10 by Dana Henahan. 

QC  
Pool ID 

Cell Gas Flow Rate Tested I (ug/L) Hg (ug/L) 

LU-03250_UIHG_c 

Characterized Mean 
Characterized  2SD Range 

92.7 
88.2 – 97.2 

0.21 
0.14 – 0.29 

 
0.24 mL/min      (Reduced) 

 
92.1 0.21 

 
0.30 mL/min (Per Method) 

 
93.4 0.19 

 
0.36 mL/min    (Increased) 

 
93.9 0.19 

 

HU-03251_UIHG_c  

Characterized Mean 
Characterized 2SD Range 

308 
293 – 322 

2.30 
2.05 – 2.54 

 
0.24 mL/min      (Reduced) 

 
289           2.23 

 
0.30 mL/min (Per Method) 

 
293 2.34 

 
0.36 mL/min    (Increased) 

 
297 2.37 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #3:  Evaluate the impact on analysis results if the RPq is increased or decreased 
by 20% for the analytical run.  (Method RPQ setting described in section 8.a.1).   
 
Test Details:  
1. Three different RPQ settings were tested in separately prepared, consecutive runs on the 

instrument without turning off the plasma.  At least 15 minutes stabilization time was allowed 
between each run after DRC RPQ was changed.  “Junk urine” samples (38) were analyzed 
between the beginning and ending QC of each run.  All other method parameters were kept 
per method. 

2.   Run #1 (method default DRC RPQ:  IOD= 0.8  Te= 0.8  Hg= 0.4).  
3. Run #2 (decreased DRC RPQ 20%:  IOD= 0.6  Te= 0.6  Hg= 0.3). 
4. Run #3 (increased DRC RPQ 20% :  IOD= 0.9  Te= 0.9  Hg= 0.5). 
       (Note: 0.9 is highest RPQ instrument will allow).   
 

Parameter Test 3 Results.   
Test performed 3/24/10 by Dana Henahan. 

QC  
Pool ID 

RPQ Tested I (ug/L) Hg (ug/L) 

LU-03250_UIHG_c 

Characterized Mean 
Characterized  2SD Range 

92.7 
88.2 – 97.2 

0.21 
0.14 – 0.29 

 
DRC RPQ: (Reduced) 

IOD= 0.6  Te= 0.6  Hg= 0.3 
 

92.6 0.16 

 
DRC RPQ: (Per Method) 

IOD= 0.8  Te= 0.8  Hg= 0.4 
 

91.0 0.20 

 
DRC RPQ: (Increased) 

IOD= 0.9  Te= 0.9  Hg= 0.5 
 

93.2 0.19 

 

HU-03251_UIHG_c  

Characterized Mean 
Characterized 2SD Range 

308 
293 – 322 

2.30 
2.05 – 2.54 

 
DRC RPQ: (Reduced) 

IOD= 0.6  Te= 0.6  Hg= 0.3 
 

313 2.30 

 
DRC RPQ: (Per Method) 

IOD= 0.8  Te= 0.8  Hg= 0.4 
 

306 2.41 

 
DRC RPQ: (Increased) 

IOD= 0.9  Te= 0.9  Hg= 0.5 
 

311 2.39 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #4:  Evaluate the impact on analysis results if the axial field voltage (AFV) is 
increased or decreased by 20% for the analytical run.  (Method AFV setting described in section 
8.a.1).   
 
Test Details:  
1. Three different DRC AFV were tested in separately prepared, consecutive runs on the 

instrument without turning off the plasma.  At least 15 minutes stabilization time was allowed 
between each run after the axial field voltage was changed.  “Junk urine” samples (38) were 
analyzed between the beginning and ending QC of each run.  All other method parameters 
were kept per method.   

2. Run #1 (method default DRC AFV = 275)  
3. Run #2 (decreased DRC AFV by 20% to 220).  
4. Run #3 (increased DRC AFV by 20% to 330). 
 
 

Parameter Test 4 Results.   
Test performed 3/25/10 by Dana Henahan. 

QC  
Pool ID 

Axial Field Voltage Tested I (ug/L) Hg (ug/L) 

LU-03250_UIHG_c 

Characterized Mean 
Characterized  2SD Range 

92.7 
88.2 – 97.2 

0.21 
0.14 – 0.29 

220          (Reduced) 92.1 0.19 

275       (Per Method) 91.5 0.21 

330         (Increased) 93.3 0.18 

 

HU-03251_UIHG_c  

Characterized Mean 
Characterized 2SD Range 

308 
293 – 322 

2.30 
2.05 – 2.54 

220        (Reduced) 303 2.12 

275       (Per Method) 299 2.18 

330        (Increased) 304 2.20 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #5:  Method descriptions and SOP assume preparation and analysis on same 
day.  Evaluate the impact on analysis results if the analytical run is prepared to analyze but 
circumstances do not allow for analysis to occur until 24 or 48 hours later.  
 
Test Details:  
1. Three separate run sets (A, B, and C) including blanks, calibrators, and QC were prepared at 

one sitting from the same starting materials.  Set ‘A’ was analyzed immediately per the 
assumption of the method.  Set’s ‘B’ and ‘C’ were capped and stored for 24 and 48 hours, 
respectively, before analysis.  Room temperature (~20°C) and refrigerated (~2-4°C) were 
both tested.  All other method parameters were kept per method.  Each analytical run was 
made normal length by including 38 dummy urine samples between QC checks.     

2. On day two, a fresh run set (“D”) was prepared and analyzed immediately for comparison to 
results from set “B” (analyzed as run 2 of the day).   

3. On day two, another fresh run set (“E”) was prepared and analyzed immediately for 
comparison to results from set “C” (analyzed as run 2 of the day).  

 

 

*  Note:  Test results show that room temperature storage for 24-48hrs is NOT adequate for Hg 
analysis.  Only if samples are refrigerated can a 24-48hr delay be allowed for Hg analysis. 
 

Parameter Test 5 Results.  Test performed 4/13-15/10 by Dana Henahan. 
QC  

Pool ID 
Time From Prep  

To Analysis Tested 
I (ug/L) Hg (ug/L) 

LU-03250 
_UIHG_c 

Characterized Mean 
2SD Range 

92.7 
88.2 – 97.2 

0.21 
0.14 – 0.29 

Storage 
Temperature 

Room 
Temp 2-4 °C Room 

Temp 2-4 °C 

Run Set A (Freshly Prepared) 92.3 93.5 0.19 0.19 

Run Set B (After 24hr) 92.8 93.8 0.22 0.19 

Run Set C (After 48hr) 93.6 93.0 0.22 0.21 

 

HU-03251 
_UIHG_c 

Characterized Mean 
2SD Range 

308 
293 – 322 

2.30 
2.05 – 2.54 

Storage 
Temperature 

Room 
Temp 2-4 °C Room 

Temp* 2-4 °C 

Run Set A (Freshly Prepared) 306 309 2.31 2.23 

Run Set B (After 24hr) 304 307 2.61* 2.37 

Run Set C (After 48hr) 301 304 2.58* 2.32 



 

Division of Laboratory Sciences 
Laboratory Protocol 
  

 
Analytes:  Zinc, Copper and Selenium 
Matrix:  Serum  
Method:  Serum Multi-Element ICP-DRC-MS 

                       
Method Code: ICPDRCMS-3006.1 
Branch:        Inorganic Radiation Analytical Toxicology 

 
Prepared By:   Ge Xiao  PhD                                                       
 author's name    signature date          
 
Supervisor:       Kathleen L. Caldwell PhD 
 supervisor's name     signature date        
 
Branch Chief:  Robert L. Jones PhD 
 Branch Chief Signature and date 
 
Adopted: 19 October 2006 
                                                 date 

 
Updated: 23 October 2006 
                                                date 

 
Director's Signature Block: 
        
  Reviewed:  
 
                                                 signature                                date 

 
          
                                                 signature                                date 

                                                        
 
 
                                                 signature                                date    

 
 
 
                                                 signature                                date 

 
 
                                                signature                                date 



 

  

Procedure Change Log 
 

Procedure:  Serum Multi-Element  DLS Method Code:  3006.1 
 
 

Date Changes Made By Rev’d  
By 

(Initials) 

Date 
Rev’d 

 
11/25/2011 Use of concentrated nitric acid during preparation of 

calibrators and calibration verification standards 
documented. 

GM   

     

     

     

     

     

     

     

     

     

     

     

     

     

     

 
 
 
 

  



 

 
 
 
 
 
 
 
 
Laboratory Procedure Manual 
  

Analytes:  Zinc, Copper and Selenium 
 

Matrix:   Serum 
 

Method:     Serum Multi-Element ICP-DRC-MS  
 

Method No: ICPDRCMS-3006.1 
Revised:  

 
 

As performed by:      Inorganic Radiation Analytical Toxicology 
 Division of Laboratory Sciences 
 National Center for Environmental Health 

 
Contact:      Dr. Kathleen L. Caldwell 

Phone:  770-488-7990 
Fax:   770-488-4097 
Email: KCaldwell@cdc.gov 

 
 

Dr. James L. Pirkle, M.D., PhD 
Director, Division of Laboratory Sciences 

 
Important Information for Users 
The Centers for Disease Control and Prevention (CDC) periodically refines these 
laboratory methods.  It is the responsibility of the user to contact the person 
listed on the title page of each write-up before using the analytical method to find 
out whether any changes have been made and what revisions, if any, have been 
incorporated.



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 1 of 73 
 

 

Table of Contents 

Cross reference to DLS CLIA and Policy and Procedures . . . . . . . . . . .. . . . . . . .  5     

Index of tables and figures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6 

1) Clinical Relevance & Summary of Test Principle 

a. Clinical Relevance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .   8 

b. Test Principle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8 

2) Limitations of Method; Interfering Substances and Conditions 

a. Interferences Addressed by This Method 

i.    Correction & Elimination of Interferences (64Ni, 36Ar14N2) on Zinc (64Zn). . . 9 
 

1    Mathematical Correction for Nickel (64Ni) Interference:  
2    Elimination 36Ar14N2 Interference   
 

ii.     Elimination of Interferences (40Ar25Mg, 36Ar14N2
1H) on Copper (65Cu)  . .  . 9 

 
iii.     Correction & Elimination of Interferences (78Kr, 38Ar40Ar, 38Ar40Ca) on 

 Selenium (78Se). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9 
 

b. Limitations of Method (Interferences Remaining in Method) 

i. 48Ca16O1H Interference on Copper (65Cu). . . . . . . . . . . . . . . . . . . . . . . . . . .  9 

ii. Time between dilution of serum materials and analysis . . . . . . . . . . . . . . . . 9 

3) Procedures for Collecting, Storing, and Handling Specimens; Criteria for 

Specimen Rejection 

a. Procedures for Collecting, Storing, and Handling Specimens . . . . . . . . . . . . .  10 

b. Criteria for Specimen Rejection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10 

c. Transfer or Referral of Specimens; Procedures for Specimen Accountability          

and Tracking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. .. . . . . .  11 

4) Safety Precautions 

a. General Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . .  . . .  11 

b. Waste Disposal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . .12 

5) Instrument & Material Sources 

a. Sources for ICP-MS Instrumentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12 

b. Sources for ICP-MS Parts & Consumables . . . . . . . . . . . . . . . . . . . . . . . . . . .  13 

c. Sources for ICP-MS Maintenance Equipment & Supplies . . . . . . . . . . . . . . . . 18 



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 2 of 73 
 

 

d. Sources for General Laboratory Equipment & Consumables . . . . . . . . . . . . . . 19 

e. Sources for Chemicals, Gases, & Regulators . . . . . . . . . . . . . . . . . . . . . . . . . . 21 

6) Preparation of Reagents and Materials 

a. Diluent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22 

b. Base Serum  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23 

c. ICP-DRC-MS Rinse Solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24 

d. Standards and Calibrators 

i. Multi-Element Intermediate Stock Standard . . . . . . . . . . . . . . . . . . . . . . . .  25 

ii. Multi-Element Intermediate Working Calibration Standards . .. . . . . . . . . . . 26 

iii. Working Multi-Element Calibrators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27 

iv. Multi-Element Intermediate Working Calibration Verification Standards …    27 

v. Working Multi-Element Calibration Verification Standards…………………… 28 

vi. Internal Quality Control Materials (“Bench” QC) . . . . . . . . . . . .. . . . . . . . . . 28 

7) Analytical Instrumentation & Parameters  

a. Instrumentation & Equipment Setup 

i. ICP-DRC-MS 

1. Modifications made to ICP-DRC-MS . . . . . . . . . . . . . . . . . . . . . . . . . .  31 

2. Sample introduction system setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31 

3. Configuration of tubing for liquid handling . . . . . . . . . . . . . . . . . . . . . . 31 

4. Cones used . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33 

5. Gases & Regulators setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33 

6. Chiller / Heat Exchanger. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 

ii. Computer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 

iii. Autosampler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 

b. Parameters for Instrument and Method (see Table 1, pp. 47-49) . . . . . . . . . . . 34 

8) Method Procedures 

a. Quality Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 

i. Types of Quality Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 

ii. Calibration Verification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35 

b. Daily Analysis of Samples 

i. Preparation of the Analytical Equipment . . . . . . . . . . . . . . . . . . . . . . . . . . .  37 



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 3 of 73 
 

 

ii. Preparation of Samples for Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39 

iii. Specimen Storage and Handling during Testing . . . . . . . . . . . . . . . . . . . .  40 

iv. Starting the Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41 

v. Monitoring the Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41 

vi. Records of Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42 

vii. Transfer of Results to the Laboratory Database . . . . . . . . . . . . . . . . . . . . .  43 

viii. Analyst Evaluation of Run Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44 

ix. Submitting Final Work for Review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46 

x. Overnight operation (or Any Use of Autostop) . . . . . . . . . . . . . . . . . . . . . . . 47 

c. Equipment Maintenance 

i. ICP-MS Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47 

ii. Data Backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48 

9) Interpretation of the Results 

a. Reportable Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48 

b. Reference Ranges (Normal Values) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48 

c. Action Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48 

10)   Method Calculations 

a. Method Limit of Detection (LOD) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .   48 

b. Method Limit of Quantitation (LOQ) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49 

c. QC Limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49 

11)   Alternate Methods for Performing Test and Storing Specimens If Test System 

Fails . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49 

 

Appendix A (Ruggedness Test Results) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50 

Appendix B (Tables and Figures) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56  

References. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73 

 

 
 
 
 
 
 



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 4 of 73 
 

 

This page intentionally left blank 
 
  



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 5 of 73 
 

 

Cross reference to DLS CLIA and Policy and Procedures policy  
1.        Summary of Test Principle and Clinical Relevance  
 1) a. b. 
2.        Safety Precautions 
 4) a.b. 
3.        Computerization; Data System Management 
 8) b.vi vii ix 
4.        Specimen Collection, Storage, and Handling Procedures; Criteria for Specimen 

Rejection 
 3) a.b. 
5.        Procedures for Microscopic Examinations; Criteria for Rejection of Inadequately 

Prepared Slides 
- As no microscope used in this process there are no procedures for 
microscopic examinations; and as no slides are prepared for this analysis 
there is no criteria for rejection of inadequately prepared slides 

  
6.        Preparation of Reagents, Calibrators (Standards), Controls, and All Other 

Materials; Equipment and Instrumentation 
 5) a. i ii iii b. 6) a. b. c. d. 7) a. b. 8) c i ii  
7.        Calibration and Calibration Verification Procedures  

8) ii 
8.        Procedure Operating Instructions; Calculations; Interpretation of Results 
 8) b. i ii iv v x  
9.        Reportable Range of Results 
 9) a.  
10.      Quality Control (QC) Procedures 
 8) a. i 
11.      Remedial Action If Calibration or QC Systems Fail to Meet Acceptable Criteria 
 8) ii 1, ii 2, e 
12.      Limitations of Method; Interfering Substances and Conditions 
 2) a. b.  
13.      Reference Ranges (Normal Values) 
 9) b. 
14.      Critical Call Results ("Panic Values") 
 9) c. 
15.      Specimen Storage and Handling during Testing 
 8) b. iii  
16.      Alternate Methods for Performing Test or Storing Specimens If Test System Fails 
 11) 
17.      Test Result Reporting System; Protocol for Reporting Critical Calls (If Applicable) 
 9) c. 
18.      Transfer or Referral of Specimens; Procedures for Specimen Accountability and 

Tracking 
 3) c. 
19.      References 



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 6 of 73 
 

 

List of Tables 
 
Table 1. Instrument and Method Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .56   

Table 2. Suggested Maximum Analyte Concentrations for Base Serum . . . . . . . . . . 58 

Table 3. Concentrations of Analytes in the Multi-Element Intermediate Stock  

Standard from High Purity Standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58 

Table 4. Preparation of Multi-element Intermediate Working Standards . . . . . . . . .  59 

Table 5. Acceptable Ways to Perform Two Consecutive Analytical Runs, Bracketing  

with Bench Quality Control Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59 

Table 6. A Typical SAMPLE/BATCH Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60 

Table 7. Preparation of Multi-element Intermediate Working Standards . . . . . . . . . 61 

Table 8. Range of Reporting and Calibration Verification Requirements . . . . . . . . . 61 

Table 9. Boundary Concentrations and Replicate Range Maximums . . . . . . . . . . . . 62 

Table 10. Normal Ranges for Serum Concentrations . . . . . . . . . . . . . . . . . . . . . . . .  62 

 

  



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 7 of 73 
 

 

 

List of Figures 

 

Figure 1. Configuration of Tubing and Devices for Liquid Handling . . . . . . . . . . . . . 63 

Figure 2. ELAN ICP-DRC-MS Method Screen Shots 

a. Timing Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64 

b. Processing Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65 

c. Equations Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66 

d. Calibration Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67 

e. Sampling Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68 

f. Report Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69 

Figure 3. ESI SC4 Autosampler Screen Shots 

a. Main page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70 

b. Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71 

c. Communication. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71 

d. 5x12 Rack Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72 

e. 50mL Tube Rack Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72 

 

 

 

  



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 8 of 73 
 

 

1) Clinical Relevance & Summary of Test Principle 

 
a. Clinical Relevance: 

This method is used to achieve rapid and accurate quantification of three 
elements of toxicological and nutritional interest including Zinc (Zn), Copper (Cu) 
and Selenium (Se).  The method may be used to screen serum when people are 
suspected to be acutely exposed to these elements or to evaluate chronic 
environmental or other non-occupational exposure.   
 

b. Test Principle: 
 Inductively coupled plasma dynamic reaction cell mass spectrometry (ICP-DRC-

MS) is a multi-element analytical technique capable of trace level elemental 
analysis [1-4].  This ICP-DRC-MS method is used to measure the entire panel of 
3 elements, or any subgroup of these.  Liquid samples are introduced into the 
ICP through a nebulizer and spray chamber carried by a flowing argon stream.  
By coupling radio-frequency power into flowing argon, plasma is created in which 
the predominant species are positive argon ions and electrons and has a 
temperature of 6,000-8,000 K.  The sample passes through a region of the 
plasma and the thermal energy atomizes the sample and then ionizes the atoms.  
The ions, along with the argon, enter the mass spectrometer through an interface 
that separates the ICP (at atmospheric pressure, ~760 torr) from the mass 
spectrometer (operating at a pressure of 10-5 torr).  The ions pass through a 
focusing region, the dynamic reaction cell (DRC), the quadrupole mass filter, and 
finally are counted in rapid sequence at the detector allowing individual isotopes 
of an element to be determined.  In this method, the instrument is operated in 
‘DRC’ mode where the cell is pressurized with 99.99+% ammonia gas which 
collides or reacts with the incoming ions to eliminate interfering ions and leave 
the ion of interest to be detected.  After leaving the DRC cell, the ions are 
focused with ion optics into a quadrupole mass analyzer with a nominal mass 
resolution of 0.7amu.  The quadrupole is sequentially scanned to specific mass 
to charge ratio of each analyte and intensity is detected with a pulse detector.  
Electrical signals resulting from the detection of ions are processed into digital 
information that is used to indicate first the intensity of the ions and then the 
concentration of the element.  This method was originally based on the methods 
by Piraner and Walters [5-8] and the DRC portions of the method are based on 
work published by Tanner et al. [2, 3].  The isotopes measured by this method 
include zinc (m/z 64), copper (m/z 65) and selenium (m/z 78) and the internal 
standard gallium (m/z 71).  Serum samples are diluted 1+1+28 with water and 
diluent containing gallium (Ga) for multi-internal standardization. 
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2) Limitations of Method; Interfering Substances and Conditions 
 

a. Interferences Addressed by This Method 
 

i. Correction & Elimination of Interferences (64Ni, 36Ar14N2) on Zinc (64Zn). 
 
1. Mathematical Correction for Nickel (64Ni) Interference:                          

The correction equation (-0.035297* Ni60) is used in the “Equations” tab of 
the method to correct the counts observed as m/z 64 to exclude counts 
due to 64Ni. 
 

2. Elimination of 36Ar14N2 Interference Using DRC:  The dynamic reaction cell 
of the ELAN ICP-DRC-MS is used in this method to eliminate interference 
from 36Ar14N2 onto zinc at m/z 64.  See Section 1.b for an explanation of 
this process. 

 
ii. Elimination of Interferences (40Ar25Mg, 36Ar14N2

1H) on Copper (65Cu) Using 
DRC. The dynamic reaction cell of the ELAN ICP-DRC-MS is used in this 
method to eliminate the interference 40Ar25Mg, 36Ar14N2

1H on copper at m/z 65. 
See Section 1.b for an explanation of this process. 

 
iii. Correction & Elimination of Interferences (78Kr, 38Ar40Ar, 38Ar40Ca) on Selenium 

(78Se). 
 
1. Mathematical Correction for Krypton (78Kr) Interference:                          

The correction equation (-0.030461*Kr83) is used in the “Equations” tab of 
the method to correct the counts observed as m/z 78 to exclude counts 
due to 78Kr. 
 

2. Elimination of 38Ar40Ar, 38Ar40Ca Interference Using DRC:  The dynamic 
reaction cell of the ELAN ICP-DRC-MS is used in this method to eliminate 
interference from 38Ar40Ar, 38Ar40Ca onto selenium at m/z 78.  See Section 
1.b for an explanation of this process. 

 
 

b. Limitations of Method (Interferences Remaining in Method) 
 

i. 48Ca16O1H Interference on Copper (65Cu): 
It has been determined that a small interference remains at m/z 65 when the 
serum matrix contains very high calcium levels.  Even at extreme calcium 
levels, this interference has not been found to be significant (< 1%).  
 

ii. Time between dilution of serum materials and analysis:   
Selenium is not stable in the diluted sample for more than 7 hours.  Diluted 
serum must be analyzed within 7 hours of preparation (see Appendix A, test 5 
for details). 
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3) Procedures for Collecting, Storing, and Handling Specimens; Criteria for 
Specimen Rejection; Specimen Accountability and Tracking 
 
a. Procedures for Collecting, Storing, and Handling Specimens:  Specimen handling 

conditions, special requirements, and procedures for collection and transport are 
discussed in the division (DLS) Policies and Procedures Manual [9].  Copies are 
available in branch, laboratory, and special activities specimen-handling offices.  
An electronic copy is available at: 
http://inside.nceh.cdc.gov/dls/pdf/policiesprocedures/Policies_and_Procedures_
Manual.DLS.2006mod.pdf  In general, if more than one vacutainer of blood is to 
be drawn from an individual, the trace metals tube should be drawn second or 
later. Draw the blood through a stainless steel needle into a pre-screened 7 mL 
vacutainer.  Allow the blood in the stoppered vacutainer clot for 30-40 minutes, 
but not longer than 60 minutes.  Without opening the vacutainer, centrifuge it for 
10 minutes at 2400 rpm.  Use a pre-screened serum separator to remove the 
serum from the clot. Under a laminar flow hood, pour the serum in the serum 
separator into pre-screened polyethylene vials. Serum specimens should be 
transported and stored at  4oC. Once received, they can be frozen at  -20oC 
until time for analysis.  Portions of the sample that remain after analytical aliquots 
are withdrawn should be refrozen at  -20oC.  Samples thawed and refrozen 
several times are not compromised. 

 
i. No fasting or special diets are required. 
 

ii. Specimen type - serum 
 

iii. Acceptable containers include pre-screened polyethylene vials and pre-
screened 7 mL vacutainers should be used for specimen acquisition. 

 
iv. Specimen stability has been demonstrated for several months at approximately 

-20°C or at approximately -70°C for several years.   
 

 
b. Criteria for Specimen Rejection:  Specimen characteristics that may compromise 

test results are indicated above.  Reasons for rejection of a sample for analysis 
include 

 
i. Low volume:  Optimal amount of serum is 1-2 mL, minimum is about 0.8 mL. 

The volume of serum used for one analysis is 0.15 mL. 
 

ii. Contamination:  Improper collection procedures or collection devices can 
contaminate the serum by contact with dust, dirt, etc. 

 
In all cases, request a second serum specimen.   
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c. Transfer or Referral of Specimens; Procedures for Specimen Accountability and          
Tracking:  Location, status, and final disposition of the specimens will be tracked 
at least by paper document in the “Study Folder” (created before analysts receive 
the samples).  Apart from this specimen tracking form, this folder will also contain 
the paper print outs of results from analysis of the specimens.  Maintain records 
for a minimum of 3 years.  Use only numerical identifiers for samples within the 
laboratory (e.g., case ID numbers) in order to safeguard confidentiality.  Only the 
medical supervisor (MS) or project coordinator (PC) i.e. non CDC personnel 
should have access to the personal identifiers. 

 
4) Safety Precautions 
 

a. General Safety 
 

i. Observe all safety regulations as detailed in the Division (DLS) Safety Manual.  
Additional information can be found in your lab’s chemical hygiene plan. 

 
ii. Observe Universal Precautions when working with serum. 

 
iii. Wear appropriate gloves, lab coat, and safety glasses while handling all 

solutions.    
 

iv. Exercise special care when handling and dispensing concentrated nitric acid.  
Add acid to water.  Nitric acid is a caustic chemical that is capable of causing 
severe eye and skin damage.  If nitric acid comes in contact with any part 
of the body, quickly wash the affected area with copious quantities of 
water for at least 15 minutes. 

 
v. Use secondary containment for containers holding biological or corrosive 

liquids. 
 

vi. The use of the foot pedal on the Micromedic Digiflex™ is recommended 
because it reduces analyst contact with work surfaces that have been in 
contact serum and also keeps the analyst’s hands free to hold the specimen 
cups and autosampler tubes and to wipe off the tip of Micromedic Digiflex™. 

 
vii. Training will be given before operating the ICP-DRC-MS, as there are many 

possible hazards including ultraviolet radiation, high voltages, radio-frequency 
radiation, and high temperatures. This information is also detailed in the 
PerkinElmer ELAN® ICP-DRC-MS System Safety Manual.   

 
viii. Ammonia gas cylinders (either in use or on storage) should be placed in a 

cabinet which is well ventilated to the house exhaust.  Ammonia cylinders in 
use should not be placed on their side as the cylinder valve can become 
“frozen” in place as a result of the cooling capacity of expanding ammonia gas. 
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ix. Wipe down all work surfaces at the end of the day with bleach-rite spray or 
freshly prepared 10% (v/v) sodium-hypochlorite solution.   

 
 

b. Waste Disposal:  Operators of this method should take the CDC-OHS Hazardous 
Chemical Waste Management Course (initial and yearly refreshers). 

 
i. Waste to be Placed in Biohazard Autoclave Bags & Pans:   
 

1. All biological samples and diluted specimens (after analysis run).  
 
2. All disposable plastic and paper which contact serum (autosampler tubes, 

gloves, etc.).  Pipette tips can be placed in either autoclave pans or sharps 
containers. 

 
3. Used non-glass/quartz ICP-MS consumables (i.e. probes, tubing, cones, 

ion lenses). 
 

ii. Waste to be Placed Into Sharps Containers:  Broken glass or quartz instrument 
consumables (broken spray chambers, torches, nebulizers, etc. . .).  Pipette 
tips can be placed in either autoclave pans or sharps containers.  Large broken 
glass which will not fit in the sharps container should be placed in a separate 
autoclave pan from other waste and labeled as “broken glass” (see the 
“Autoclaving” section of the CDC safety policies and practices manual located 
in the laboratory). 
 

iii. Liquid Waste 
 

1. Waste discarded down sink:  Only liquid waste from the ICP-DRC-MS 
instrument can be discarded at the sink.  Flush the sink with copious 
amounts of water. 
 

2. Waste to be Picked up by Hazardous Waste Program: Submit request for 
hazardous waste removal of all other liquid waste. 

 
 

5) Instrument & Material Sources 
 
a. Sources for ICP-MS Instrumentation 

 
i. ICP-MS:  Inductively Coupled Plasma Dynamic Reaction Cell Mass 

Spectrometer (ELAN® 6100 DRCPlus or ELAN® DRC II) (PerkinElmer Norwalk, 
CT, www.perkinelmer.com).  

 
ii.Recirculating chiller / heat exchanger for ICP-MS:  Refrigerated chiller 

(PolyScience 6105PE for ELAN® 6100 DRCPlus instruments) or heat exchanger 
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(PolyScience 3370 for ELAN® DRC II instruments) (PerkinElmer Norwalk, CT, 
www.perkinelmer.com). 

 
iii. Autosampler: ESI SC-4 autosampler (Elemental Scientific Inc., Omaha, NE) or 

equivalent. 
 
b. Sources for ICP-MS Parts & Consumables 

 
NOTE:  The minimum number of spares recommended before reordering (if 
owning one instrument) are listed as “# Spares =” in the descriptions below.   

 
i. Adapter, plastic:  1/4-28 female threads on one side, 1.8mm barb adapter on 

the other.  Connects ¼-28 nut at flanged tubing connection to 0.045” i.d. 
peristaltic pump tubing.  Use part # B019-3342 (“Type A” adapter, PerkinElmer 
Norwalk, CT, www.perkinelmer.com) or equivalent.  # Spares = 4. 

ii. Adapter, PEEK:  Securely connects 1.6mm O.D. PFA tubing to 0.03” I.D. 
peristaltic tubing.  Composed of three PEEK parts.   

1. Female nut for 1.6mm O.D. (1/16”) tubing.  Like part P-420 (Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com). 

2. PEEK ferrule.  Like part P-260x (10pk SuperFlangeless ferrule, Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com).   

3. Conical Adapter Body.  Like part P-692 (Upchurch Scientific, Oak Harbor, 
WA, www.upchurch.com). 

iii. Coolant, for Polyscience chiller or heat exchanger:  Only PerkinElmer part # 
WE01-6558 (PerkinElmer Norwalk, CT, www.perkinelmer.com) is approved for 
use by PerkinElmer.  # Spares = 6. 

iv. Cone, sampler:  Both platinum and nickel cones have been used successfully.  
For platinum cones, Spectron part # SC2013-Pt (Spectron, Ventura, CA, 
www.spectronus.com) or equivalent.  For nickel cones, PerkinElmer part # 
WE021140 (PerkinElmer Norwalk, CT, www.perkinelmer.com) or equivalent.  # 
Spares = 4. 

v. Cone, skimmer:  Both platinum and nickel cones have been used successfully.  
For platinum cones, Spectron part # SC2014-Pt (Spectron, Ventura, CA, 
www.spectronus.com) or equivalent.  For nickel cones, PerkinElmer part # 
WE021137 (PerkinElmer Norwalk, CT, www.perkinelmer.com) or equivalent.  # 
Spares = 4. 

vi. Connector (for tubing):  Use to connect 1/8” I.D. PVC tubing to 0.125” I.D 
peristaltic pump tubing.  Use part # 3140715 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 4. 

vii. Detector, electron multiplier:  Like part # N8125001 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  Available direct from manufacturer (part # 14210, 
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SGE Incorporated, Austin, Texas, http://www.etpsci.com) or various 
distributors.  # Spares = 1. 

viii. Hose, for connection to chiller:  Push on hose.  I.D. = ½”, O.D. = ¾”.  Use part 
# PB-8 (per inch, Georgia Valve and Fitting, Atlanta, GA, www.swagelok.com) 
or equivalent.  Do not normally need spare hose (unless moving instrument 
into a new location). 

ix. Hose, for exhaust of ELAN:  Available as part of ELAN installation kit from 
Perkin Elmer (PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available 
direct from manufacturer as part # S-LP-10 air connector (Thermaflex, 
Abbeville, SC, www.thermaflex.net).  Equivalent part may be substituted.  # 
Spares = 10 feet of 4” diameter and 10 feet of 6” diameter hose.   

x. Injector, quartz with ball joint:  I.D. = 2.0 mm.  PerkinElmer part # WE023948 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available direct from 
manufacturer as part # 400-30 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or from various distributors.  # Spares = 2. 

xi. Injector support (for pass-through injector): PerkinElmer part # WE023951 
(PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available direct from 
manufacturer as part # 400-37 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or from various distributors.  # Spares = 2. 

xii. Ion Lens:  PerkinElmer part # WE018034 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  # Spares = 3. 

xiii. Nebulizer, quartz concentric:  Initial work using this method has used the 
standard Type A, 3mL/min nebulizer.  Alternatively, the Type C, 1mL/min 
nebulizer may be used to improve sensitivity and precision.  The ELAN 
supplies 30psi argon to the nebulizer.  Variations of these nebulizers may be 
substituted with or without quick connects for the gas and liquid ports.  Quartz 
nebulizers are used to avoid potential contamination from borosilicate glass 
(i.e. barium, uranium).  # Spares = 2.   

1. Type A, Standard ELAN 3mL/min nebulizer:  PerkinElmer part # 
WE024371 (PerkinElmer Norwalk, CT, www.perkinelmer.com).  Available 
directly from manufacturer as part # TQ-30-A3 (Meinhard Glass Products, 
Golden, CO, www.meinhard.com) or from various distributors.  The 
flangeless nut and ferrule assembly has been used for liquid sample back-
end connection to this nebulizer. 

2. Type C, 1 mL/min nebulizer with quick disconnects for liquid and gas ports:  
One example is part # 500-70QQDAC (Precision Glass Blowing, 
Centennial, CO, www.precisionglassblowing.com).  This nebulizer is 
designed to use quick disconnects part # 500-QD (liquid) and # 500-AC 
(argon). 

xiv. Nebulizer Connections (gas):  (for nebulizer argon side-arm).   

1. If not using quick disconnection fitting, insert nebulizer argon side-arm into 
the 1/8” i.d. vinyl tubing and secure the connection with a hose clamp for 
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¼” o.d tubing (like part # EW-06832-01, Cole Palmer Instrument Company, 
Vernon Hills, Illinois, www.colepalmer.com).  # Spares = 2.   

2. Quick disconnection fitting:  Like part # 500-AC (Precision Glass Blowing, 
Centennial, CO, www.precisionglassblowing.com).  # Spares = 2. 

xv. Nebulizer Connections (liquid): (for nebulizer 4mm o.d. liquid sample backend).  
Can use quick disconnect or flangeless nut and ferrule assembly.  

1. Quick Disconnect:  Like Part # 500-QD (Precision Glass Blowing, 
Centennial, CO, www.precisionglassblowing.com). # Spares = 2. 

2. Flangeless nut and ferrule assembly:  An assembly such as part # FIT KIT 
3 (Meinhard Glass Products, Golden, CO, www.meinhard.com) or 
equivalent.  Individual pieces of FIT KIT #3 can be purchased as follows. 

a. Nut, flangeless, 1/16”, ¼-28, Delrin® (Acetal), red.  Part # P202x (10pk, 
Upchurch Scientific, Oak Harbor, WA, www.upchurch.com).  # Spares 
= 10.   

b. Ferrule, flangeless, 1/16”, Tefzel® (ETFE), blue.  Part # P-200x (10pk, 
Upchurch Scientific, Oak Harbor, WA, www.upchurch.com).  # Spares 
= 10. 

c. Adapter, 1/4-28 internal to 5/16-24 internal, PEEK™.  Part # P-135 
(Upchurch Scientific, Oak Harbor, WA, www.upchurch.com).  # Spares 
= 2. 

d. Nut, 4mm ID PEEK.  Part of fit kit 3 for concentric nebulizers.  Part # S-
1050 (Meinhard Glass Products, Golden, CO, www.meinhard.com). # 
Spares = 2. 

e. Ferrule, 4mm ID green Delrin.  Part of fit kit 3 for concentric nebulizers.  
Part # S-1121 (Meinhard Glass Products, Golden, CO, 
www.meinhard.com). # Spares = 2. 

xvi. Nut: (for flanged connections of 1.59mm (1/16”) o.d. PFA tubing) Flanged, for 
1/16” o.d. tubing, 1/4-28 threads.   Use part # P-406x (pkg. of 10, Upchurch 
Scientific, Oak Harbor, WA, www.upchurch.com) or equivalent.  Use a Teflon-
coated Viton o-ring with this nut instead of the stainless steel washer that 
comes with part # P-406x). # Spares = 10. 

xvii. Nut:  (for bottom port of autosampler rinse station) 10-32 UMC threads for 
1/16” tubing.  Such as part # M653x (Upchurch Scientific, Oak Harbor, WA, 
www.upchurch.com) or equivalent.  # Spares = 2. 

xviii. Nut and Ferrule set, 1/8” Swagelok:  Such as part # SS-200-NFSET (stainless 
steel) or part # B-200-NFSET (brass) (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  For part numbers listed here a quantity of 1 
means 1 nut, 1 front ferrule, and 1 back ferrule.  Spares = 20. 

xix. Nut and Ferrule set, 1/4” Swagelok:  Such as part # SS-400-NFSET (stainless 
steel) or part # B-400-NFSET (brass) (Georgia Valve and Fitting, Atlanta, GA, 
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www.swagelok.com) or equivalent.  For part numbers listed here a quantity of 1 
means 1 nut, 1 front ferrule, and 1 back ferrule.  Spares = 20. 

xx. Oil, Welch Directorr Gold:  For roughing pumps.  Available direct from 
manufacturer as part # 8995G-15 (1 gallon, Welch Rietschle Thomas, Skokie, 
IL, www.welchvacuum.com) or from various distributors.  Equivalent oil may be 
substituted.  # Spares = 4. 

xxi. O-ring: (for sampler cone) PerkinElmer part # N8120511 (pkg. of 5, 
PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 20 
o-rings. 

xxii. O-ring: (for skimmer cone) PerkinElmer part # N8120512 (pkg. of 5, 
PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 20 
o-rings. 

xxiii. O-ring: (for flanged connections of 1.59mm (1/16”) o.d. PFA tubing) Teflon-
coated Viton o-ring, i.d. = 1/16", thickness = 1/16”, o.d. = 3/16”.  Such as part # 
V75-003 (O-rings West, Seattle, WA, www.oringswest.com) or equivalent. # 
Spares = 20. 

xxiv. O-ring:  (for injector support).  

1. Internal o-rings:  ID = ¼”, OD = 3/8”, thickness = 1/16”.  Need 2 o-rings per 
injector support to setup.  PerkinElmer part # N8122008 (PerkinElmer, 
Shelton, CT, www.perkinelmer.com) or equivalent (such as part # V75-010, 
O-rings West, Seattle, WA, www.oringswest.com).  # Spares = 20. 

2. External o-rings:  ID = 3/8”, OD = 1/2”, thickness = 1/16”.  Need 2 o-rings 
for each injector support setup.  PerkinElmer part # N8122009 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent (such as 
part # V75-012, O-rings West, Seattle, WA, www.oringswest.com).  # 
Spares = 20. 

xxv. O-ring:  (for inside spray chamber at nebulizer port) Such as part # 120-56 
(Precision Glass Blowing, Centennial, CO, www.precisionglassblowing.com).  
Additional o-rings can sometimes be obtained free of charge or at reduced 
price when acquired while purchasing spray chambers.  # Spares = 20. 

xxvi. O-ring:  (for inside of torch mount):  Part # WE017284 (PerkinElmer, Shelton, 
CT, www.perkinelmer.com).  Do not substitute.  The PerkinElmer o-ring is 
special metal impregnated to minimize RF leakage though the torch mount.   # 
Spares = 2. 

xxvii. Photon Stop:  PerkinElmer part # WE018278 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  Alternate “snap in” lens assembly requires 
PerkinElmer part # W1013361 (PerkinElmer Norwalk, CT, 
www.perkinelmer.com).  # Spares = 1. 

xxviii. Plugs, Quick Change for Roughing Pump Oil:  These plugs will only work on 
the Varian roughing pumps which come standard on ELAN DRC II ICPMS 
instruments.  These plugs will not fit the Leybold pumps which come standard 
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on the ELAN DRC Plus instruments.  Part # W1011013 (PerkinElmer, Shelton, 
CT, www.perkinelmer.com).  No spares typically needed. 

xxix. Probes: (for ESI autosampler)  Teflon, carbon fiber support, 0.8mm i.d., blue 
marker, 1/4-28 fittings.  Like part number SC-5037-3751 (Elemental Scientific 
Inc., Omaha, NE., www.elementalscientific.com).  # Spares = 2. 

xxx. RF coil.  PerkinElmer part # WE02-1816 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  # Spares = 2. 

xxxi. Screw, for Torch Mount:  PerkinElmer part # WE011870. (PerkinElmer, 
Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 3. 

xxxii. Spray chamber, quartz concentric:  PerkinElmer part # WE025221 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  Available 
direct from manufacturer as part # 400-20 (Precision Glass Blowing, 
Centennial, CO, www.precisionglassblowing.com) or from various distributors.  
# Spares = 2. 

xxxiii. Torch, quartz:  PerkinElmer part # N812-2006 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com) or equivalent.  Available direct from manufacturer as 
part # 400-10 (Precision Glass Blowing, Centennial, CO, 
www.precisionglassblowing.com) or various distributors.  Damaged torches 
can often be repaired for substantially lower cost than purchasing a new one by 
companies such as Wilmad LabGlass (Buena, NJ, www.wilmad-labglass.com) 
or Precision Glass Blowing (Centennial, CO, www.precisionglassblowing.com).   
# New Spares = 2. 

xxxiv. Tubing and adapter, for SC autosampler rinse station drain:  Tygon tubing and 
adapter to attach to back of SC autosampler for draining rinse station waste 
(like part # SC-0303-002, Elemental Scientific Inc., Omaha, NE., 
www.elementalscientific.com). 

xxxv. Tubing and adapters, for SC autosampler rinse station filling:  Teflon tubing 
and adapters (to attach to back of SC autosampler for filling rinse stations and  
to attach to rinse containers).  Like part # SC-0302-0500, Elemental Scientific 
Inc., Omaha, NE., www.elementalscientific.com). 

xxxvi. Tubing, argon delivery to instrument:  I.D. = 1/8”, O.D. = ¼”.  Such as part # C-
06500-02 (pkg. of 100ft, polypropylene, Fisher Scientific International, 
Hampton, NH, www.fishersci.com) or equivalent.  # Spares = 50ft. 

xxxvii. Tubing, peristaltic, 0.03” i.d. (sampling): Standard PVC, 2-stop (black / black) 
peristaltic pump tubing, i.d. = 0.03”. PerkinElmer part # 09908587 
(PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # Spares = 6 
packs of 12 tubes. 

xxxviii. Tubing, peristaltic, 0.125” i.d. (spray chamber drain): Standard PVC, 2-stop 
(black / white) peristaltic pump tubing, i.d. = 0.125”.  PerkinElmer part # N812-
2012 (PerkinElmer, Shelton, CT, www.perkinelmer.com) or equivalent.  # 
Spares = 6 packs of 12 tubes. 

xxxix. Tubing, PFA:  I.D. = 0.5mm, O.D. = 1.59mm (1/16”).  Used to transfer liquid 
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1. possibly used between nebulizer and peristaltic pump tubing (if quick 
connection is not used for liquid sample delivery) 

The Perfluoroalkoxy (PFA) copolymer is a form of Teflon®.  Such as part # 
1548 (20ft length, Upchurch Scientific, Oak Harbor, WA, www.upchurch.com) 
or equivalent.  # Spares = 20ft. 

xl. Tubing, PVC, i.d. = 1/8”, o.d. = 3/16”.  Used to transfer liquid 

1. between spray chamber waste port and peristaltic pump 

Like part # 14-169-7A (pkg. of 50ft, Fisher Scientific International, Hampton, 
NH, www.fishersci.com) or equivalent.  # Spares = 20ft. 

xli. Tubing, Stainless Steel, o.d. = 1/8”, wall thickness = 0.028”:  Used to connect 
DRC gas cylinders to ELAN DRC gas ports.  Also used to replace plastic 
tubing in the DRC gas path within the ELAN.  Like part # SS-T2-S-028-20 (20ft, 
Georgia Valve and Fitting, Atlanta, GA, www.swagelok.com) or equivalent.  
Spares = 20ft. 

xlii. Tubing, Teflon, corrugated, ¼” o.d.:  Connects to the auxiliary and plasma gas 
side-arms of the torch.  Part # WE015903 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  # Spares = 2.   

xliii. Tubing, Tygon, i.d. = 3/16”, o.d. = 5/16”:  Used to transfer liquid between rinse 
station drain port and liquid waste jug.  Like part # EW-06409-15 (50 ft, Cole 
Parmer, Vernon Hills, Illinois, www.coleparmer.com) or equivalent.  # Spares = 
20ft. 

xliv. Tubing, vinyl (argon delivery to nebulizer):  Vinyl Tubing, 1/8" ID x 1/4" OD.  
Like part # EW-06405-02 (Cole Parmer, Vernon Hills, Illinois, 
www.coleparmer.com) or equivalent.  Equivalent tubing material may be 
substituted.  # Spares = 10ft. 

xlv. Union Elbow, PTFE ¼” Swagelok:  Connects argon tubing to torch auxiliary 
gas sidearm.  Like part # T-400-9 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com) or equivalent.  Spares = 2. 

xlvi. Union Tee, PTFE, ¼” Swagelok:  Connects argon tubing to torch plasma gas 
sidearm and holds igniter inside torch sidearm.  Like part # T-400-3 (Georgia 
Valve and Fitting, Atlanta, GA, www.swagelok.com) or equivalent.  Spares = 2. 

 

c. Sources for ICP-MS Maintenance Equipment & Supplies 

i. Anemometer: Like digital wind-vane anemometer (Model 840032, SPER 
Scientific LTD., Scottsdale, AZ, www.sperscientific.com) or equivalent.  Use to 
verify adequate exhaust ventilation for ICP-MS (check with hoses fully 
disconnected). 

ii. Pan, for changing roughing pump oil: Like part # 53216 (United States Plastics 
Corporation, Lima, OH, www.usplastic.com) or equivalent.  # On hand = 1. 
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iii. Container, to hold acid baths for glassware:  Polypropylene or polyethylene 
containers with lids (must be large enough for torch, injector, or spray chamber 
submersion).  May be purchased from laboratory or home kitchen supply 
companies.  # On hand = 4.  

iv. Cotton swabs:  Any vendor.  For cleaning of cones and glassware. 

v. Cutter (for 1/8” o.d. metal tubing):  Terry tool with 3 replacement wheels.  Like 
part # TT-1008 (Chrom Tech, Inc., Saint Paul, MN, www.chromtech.com) or 
equivalent. 

vi. Getter Regeneration Kit: Part # WE023257 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com).  Use this as needed (at least annually) to clean the 
getter in the pathway of channel A DRC gas.   

vii. Magnifying glass:  Any 10x + pocket loupe for inspection of cones and other 
ICP-MS parts.  Plastic body is preferred for non-corrosion characteristics.  Like 
part # 5BC-42813 (Lab Safety Supply, Janesville, WI, www.labsafety.com). 

viii. Screw Driver, for Ion Lens Removal:  Screw driver with long, flexible shaft, and 
2mm ball-Allen end for removal of ion lens screws, part # W1010620.  Extra 
2mm bits, part # W1010598 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com). 

ix. Toothbrush:  Any vendor.  For cleaning ion lens and glassware. 

x. Ultrasonic bath: Like ULTRAsonik™ Benchtop Cleaners (NEYTECH, 
Bloomfield, CT, www.neytech.com) or equivalent. 

 

d. Sources for General Laboratory Consumable Supplies 

i. Bar Code Scanner:  Like Code Reader 2.0 (Code Corporation, Draper, UT, 
www.codecorp.com) or equivalent.  For scanning sample IDs during analysis 
setup.  Any bar code scanner capable of reading Code 128 encoding at a 3 mil 
label density can be substituted. 

ii. Carboy (for preparation of serum quality control pool and waste jug for ICPMS 
sample introduction system):  Polypropylene 10-L carboy (like catalog # 02-
960-20C, Fisher Scientific, Pittsburgh, PA, www.fischersci.com) or equivalent.  
Carboys with spouts are not advised due to potential for leaking. 

iii. Containers for diluent and rinse solution:  Two liter Teflon™ containers (like 
catalog# 02-923-30E, Fisher Scientific, Pittsburgh, PA., www.fishersci.com) 
and 4L polypropylene jugs (like catalog# 02-960-10A, Fisher Scientific, 
Pittsburgh, PA, www.fishersci.com) have both been used. Acid rinse before 
use.  Equivalent containers may be substituted. 

iv. Gloves:  Powder-free, low particulate nitrile (like Best CleaN-DEX™ 100% 
nitrile gloves, any vendor).  Equivalent nitrile or latex gloves may be 
substituted. 
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v. Paper towels:  For general lab use, any low-lint paper wipes such as 
KIMWIPES®EX-L Delicate Task Wipers or KAYDRY®EX-L Delicate Task 
Wipers (Kimberly-Clark Professional, Atlanta, GA, www.kcprofessional.com).  
For sensitive applications in cleanrooms, a wipe designed for cleanroom use 
may be desired such as the Econowipe or Wetwipe (Liberty, East Berlin, CT, 
www.liberty-ind.com). 

vi. Pipette (for preparation of serum dilutions to be analyzed): Micromedic Digiflex-
CX Automatic™ pipette equipped with 10.0-mL dispensing syringe, 2 mL 
sampling syringe, 0.75-mm tip, and foot pedal (Titertek, Huntsville, AL, 
http://www.titertek.com/).   

vii. Pipettes (for preparation of intermediate stock working standards & other 
reagents):  Like Brinkmann Research Pro Electronic pipettes (Brinkmann 
Instruments, Inc., Westbury, NY, http://www.brinkmann.com/home/).  5-100 L 
(catalog #4860 000.070), 20-300 L (catalog #4860 000.089), 50-1,000 L 
(catalog #4860 000.097), 100-5,000 L (catalog #4860 000.100).  Note:  
pipette catalog numbers are without individual chargers.  Can purchase 
individual chargers (pipette catalog numbers will differ) or a charging stand that 
will hold four pipettes (catalog #4860 000.860).  When purchasing pipette tips 
(epTips), purchase one or more boxes, then “reloads” for those boxes after 
that:  5-100 L (box catalog # 22 49 133-4, reload catalog # 22 49 153-9), 20-
300 L (box catalog # 22 49 134-2, reload catalog # 22 49 154-7), 50-1,000 L 
(box catalog # 22 49 135-1, reload catalog # 22 49 155-5), 100-5,000 L (box 
catalog # 22 49 138-5, reload catalog # 22 49 198-9, bulk bag catalog # 22 49 
208-0).  Equivalent pipettes and tips can be substituted. 

viii. Tubes for sample analysis (for autosampler):  Like polypropylene 15-mL 
conical tubes, BD Falcon model #352097 (Becton Dickinson Labware, Franklin 
Lakes, NJ, www.bd.com).  Equivalent tubes may be substituted which are 
shown by lot screening to be free of trace metal contamination.  Clear plastics 
tend to have lowest trace metal contamination.  Blue colored caps have also 
been used successfully for this method. 

ix. Tubes for storage of intermediate working stock standards:  Like polypropylene 
50-mL centrifuge tubes, Corning Incorporated #430290 (Corning, NJ, 14831. 
www.scienceproduct.corning.com).  For use in storage of intermediate working 
stock standards.  Equivalent tubes may be substituted which are shown by lot 
screening to be free of trace metal contamination. Clear plastics tend to have 
lowest trace metal contamination.  Orange colored caps have also been used 
successfully for this method. 

x. Votexer:  Like MV-1 Mini Vortexer (VWR, West Chester, PA, www.vwr.com).  
Used for vortexing serum specimens before removing an aliquot for analysis.  
Equivalent item can be substituted. 

xi. Water purification system:  Like NANOpure DIamond Ultrapure Water System 
(Barnstead International, Dubuque, Iowa, www.barnstead.com).  For ultra-pure 
water used in reagent and dilution preparations.  An equivalent water 
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purification unit capable of producing >18 Mega-ohm·cm water may be 
substituted. 

e. Sources of Chemicals, Gases, and Regulators 

i. Acid, Hydrochloric acid:  Veritas™ double-distilled grade, 30-35% (GFS 
Chemicals Inc. Columbus, OH, www.gfschemicals.com).  This is referred to as 
“concentrated” hydrochloric acid in this method write-up.  It is approximately 12 
molar in concentration.  For use in preparation of intermediate working stock 
standards.  An equivalent hydrochloric acid product may be substituted, but it 
must meet or exceed the purity specifications of this product for trace metals 
content. 

ii. Acid, Nitric acid: Veritas™ double-distilled grade, 68-70% (GFS Chemicals Inc. 
Columbus, OH, www.gfschemicals.com).  For use in diluent, rinse solution, 
intermediate working stock standards, and QC pool preparations.  This is 
referred to as “concentrated” nitric acid in this method write-up.  It is 
approximately 16 molar in concentration.  An equivalent nitric acid product may 
be substituted, but it must meet or exceed the purity specifications of this 
product for trace metals content. 

iii. Ethyl Alcohol (C2H5OH), USP dehydrated 200 proof (Pharmco Products, Inc.) 
or equivalent. 

iv. TritonX-100™ (“Baker Analyzed,” J.T. Baker Chemical Co. [www.jtbaker.com], 
or any source whose product is low in trace-metal contamination). 

v. Argon Gas (for plasma & nebulizer) and Regulator:  High purity argon 
(>99.999% purity, Specialty Gases Southeast, Atlanta, GA, www.sgsgas.com) 
for torch and nebulizer.  Minimum tank source is a dewar of liquid argon (180-
250L) but bulk tank for total building needs is preferred. 

1. Regulator for argon (at dewar, if used):  Stainless steel, single stage, 
specially cleaned regulator with 3,000 psig max inlet, 0-100 outlet pressure 
range,  CGA 580 cylinder connector, and needle valve shutoff on delivery 
side terminating in a ¼” Swagelok connector.  Part number 
KPRAFPF415A2AG10 (Georgia Valve and Fitting, Atlanta, GA, 
www.swagelok.com). An equivalent regulator from an alternate vendor may 
be substituted.  # Spares = 1. 

2. Regulator for argon (between bulk tank and PerkinElmer filter regulator):           
Single Stage 316SS Regulator, with 0-300 psi Inlet Gauge, 0-200 psi 
Outlet Gauge, Outlet Spring Range, 0-250 psi, ¼” Swagelok Inlet 
Connection, ¼ turn Shut off Valve on Outlet with ¼” Swagelok Connection 
and Teflon Seals.  Part number KPR1GRF412A20000-AR1 (Georgia Valve 
and Fitting, Atlanta, GA, www.swagelok.com). An equivalent regulator from 
an alternate vendor may be substituted.  # Spares = 1. 

3. Regulator for argon (PerkinElmer filter regulator on back of ELAN):  Argon 
regulator filter kit.  Catalog number N812-0508 (PerkinElmer, Shelton, CT, 
www.perkinelmer.com). 
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vi. Ammonia:  Anhydrous ammonia (>99.99%) for DRC channel A is typically 
purchased in cylinder size LB (2”x12”) (Matheson Tri-Gas, Montgomeryville, 
PA, 18936. www.mathesontrigas.com). 

1. Regulator for ammonia:  Stainless steel, two stage, specially cleaned 
regulator with 3,000 psig max inlet, 2-30 outlet pressure range, cylinder 
connector CGA 180 (for lecture bottle cylinder) or CGA 705 (for Airgas 
cylinder size 200), and needle valve shutoff on delivery side terminating in 
a ¼” Swagelok connector.  Like part number 3813-180 or 3813-705 
(Matheson Tri-Gas, Montgomeryville, PA, www.matheson-trigas.com). An 
equivalent regulator from an alternate vendor may be substituted.  # 
Spares = 1. 

vii. Disinfectant, for work surfaces:  Bleach-rite spray (any distributor).  On-site 
dilutions of bleach (1part bleach + 9 parts water) may be substituted, but must 
be re-made daily after dilution. 

viii. Standard, Gallium:  Like 1,000 mg/L, item # PLGA2-2Y.  (SPEX Industries, 
Inc., Edison, NJ, www.spexcsp.com).  Used as an internal standard in diluent.  
Any vendor whose standards are traceable to the National Institute for 
Standards and Technology may be substituted.  The standard must have low 
trace metal contamination. 

ix. Standard, multi-element intermediate stock standard:  Item number SM-2107-
013 (High Purity Standards, Charleston, SC, http://www.hps.net/).  This is a 
custom mix solution (see Table 3 p.49 for concentrations).  This solution is 
diluted to prepare the intermediate stock working standards, which are in turn 
diluted to prepare the working calibrators.  This solution can be prepared in-
house from NIST traceable single element stock solutions if necessary. 

x. Triton X-100™ surfactant:  Like “Baker Analyzed” TritonX-100™ (J.T. Baker 
Chemical Co., www.jtbaker.com).  Another source may be substituted, but it 
must be free of trace-metal contamination. 

 
6) Preparation of Reagent and Materials. 

 
a. Diluent 

 
i. Purpose:  All samples (blanks, calibrators, QC, or patient samples) are 

combined with the diluent during the sample preparation step before analysis.  
This is where the internal standards are added which during the analysis will 
compensate for instrumental variations on the analyte signal. 

ii. Contents:  An aqueous solution of 10 g/L Ga, 2% v/v double-distilled nitric 
acid, 5% Ethyl Alcohol, 0.01% Triton X-100TM. 

iii. Preparation (4L) & storage:  This solution does not have to be made up in a 
volumetric flask.  The important thing about the concentration of the internal 
standards is that they be consistent within all samples in one run.  To prepare 
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different volumes of diluent, add proportionally larger or smaller volumes of the 
solution constituents. 

1. Acid-rinse a 4 L container (material may be polypropylene (PP), 
polymethylpentene (PMP), or Teflon™).   

2. Partially fill (i.e. 70-80% full) the 4 L container with >18 Mega-ohm·cm 
water. 

3. Carefully add 80 mL double-distilled, concentrated nitric acid and mix. 

4. Carefully add 200 mL Ethyl Alcohol and mix. 

5. Add 4 mL each of 10 mg/L Ga. 

6. Add 20 mL 2% Triton X-100TM stock solution and mix.  

7. Make up to volume (approximately 4 L) with >18 Mega-ohm·cm water. 

8. Store at room temperature and prepare as needed.   

9. Label should include “10 µg/L Ga, 2% (v/v) HNO3, 5% Ethyl alcohol, 0.01% 
Triton X-100TM“, “Store at room temperature”, preparation date, expiration 
date (1 year from prep), and preparer’s initials. 

b. Base Serum   

i. Purpose:  This serum pool material will be mixed with the intermediate working 
calibrators just prior to analysis to matrix-match the calibration curve to the 
serum matrix of the unknown samples.   

ii. Contents: A mixture of multiple human serum sources purchased from 
Tennessee Blood Services, 807 Poplar Ave., Memphis, TN 38105. These 
serum were collected from different anonymous donors are used to 
approximate an average serum matrix. 

iii. Screening serum:  Screen all sources of serum for metal content before mixing 
together to make the base serum pool.  Keep serum at ≤ -20C whenever 
possible to minimize microbial growth.  Analyte concentrations in the final base 
serum pool should be in the low-normal population range (see Table 2, p. 49).   

iv. Preparation & Storage: 

1. Once screened, mix the serum collections together in a larger container 
(i.e. acid washed polypropylene (PP), polymethylpentene (PMP), or 
Teflon™) and stir for 30+ minutes on a large stir plate (acid wash large 
Teflon™ stir bar before use). 

2. For short term storage, store at 2-4°C.  For long-term storage, dispense 
into smaller-volume tubes (i.e., 10 mL acid-washed or lot screened 
polypropylene tubes) and store at ≤ -20°C.   

3. Labels on 10 mL tubes should include “Base Serum for Multi-Element 
Method”, “Store Long Term at ≤ 20° C”, “Store Short Term at 2-4° C”, 
preparation date, expiration date 3 years from prep date, and preparer’s 
initials. 
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c. ICP-DRC-MS Rinse Solution  

i. Purpose:  Pump this solution into the sample introduction system between 
samples to prevent carry-over of the analytes of interest from one sample 
measurement to the next. For this method, we also need to pump >18 Mega-
ohm·cm water into the sample introduction system for 30 minutes after each 
run to prevent the clog of the probe and tubing.  

ii. Contents:  An aqueous solution of 0.01% Triton X-100™ and 2% (v/v) double-
distilled nitric acid solution, 5% Ethyl Alcohol, 0.5% v/v Hydrochloric acid.   

iii. Preparation & Storage:   

1. Intermediate Triton X-100 Solution:  To avoid the process of dissolving 
pure Triton X-100 on a daily basis, prepare an intermediate 2% Triton X-
100™ / 5% (v/v) double-distilled, nitric-acid solution for daily use. 

a. To prepare 2 L of Intermediate Triton X-100 Solution:   

i. Partially fill a 2 L acid-washed bottle (PP, PMP, or Teflon™) with 
>18 Mega-ohm·cm water (approximately 1-1.5 L).  Use of 
volumetric flask is not required. 

ii. Add 20 mL of Triton X-100™ and stir until completely dissolved.  
Use a Teflon™ stir bar and stir plate if necessary (acid wash stir 
bar before use). 

iii. Carefully add 100 mL of double-distilled, concentrated nitric acid. 

iv. Fill to 2 L and stir thoroughly. 

v. Label should include “2% Triton X-100™ / 5% (v/v) HNO3”, “Store 
at room temperature”, preparation date, expiration date 1 year from 
preparation date, and preparer’s initials. 

2. Final Rinse Solution:   

a. To Prepare 4 L of the Final Rinse Solution: 

i. Partially fill a 4 L acid-washed bottle (PP, PMP, or Teflon™) with 
>18 Mega-ohm·cm water (approximately 2-3 L).  Use of volumetric 
flask is not required. 

ii. Carefully add 80 mL of double distilled concentrated nitric acid and 
mix well.  

iii. Carefully add 200 mL ethyl alcohol and mix. 

iv. Carefully add 20 mL double distilled concentrated hydrochloric 
acid. 

v. Add 20 mL of the 2% Triton X-100™ / 5% (v/v) double-distilled, 
nitric-acid intermediate stock solution and mix well.  

vi. Fill to 4 L using >18 Mega-ohm·cm water and mix well.   
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vii. Store at room temperature and prepare as needed.  To prepare 
volumes other than specified here, add proportionally larger or 
smaller volumes of the solution constituents. 

viii. Label should include “2% v/v HNO3, 5% Ethyl alcohol, 0.01% 
Triton X-100TM, 0.5% v/v Hydrochloric acid”, “Store at room 
temperature”, preparation date, expiration date (1 year from prep), 
and preparer’s initials. 

  

d. Standards and Calibrators 

i. Multi-Element Intermediate Stock Standard (calibrators and calibration 
verification) 

1. Purpose:  This is the master solution from which all working calibrators will 
be prepared.  It will be diluted to prepare intermediate working calibrators 
which are in turn diluted and included in each analytical run on the ICP-
DRC-MS.  This same stock standard will be diluted to prepare the 
intermediate working calibration verification solution which will be in turn 
diluted and analyzed at least every 6 months for calibration verification 
purposes (and as needed by supervisor request). 

2. Contents:  An aqueous solution containing all 3 elements of interest for this 
method (does not include the internal standards).  The concentrations of 
the 3 elements in the intermediate stock standard are listed in Table 3 
p.49.  The matrix is 2% v/v HNO3 in >18 Mega-ohm·cm water. 

3. Preparation (Purchase) & Storage:   

a. Purchasing from vendors:  The intermediate stock standard solution 
may be purchased as a custom mixture from any vendor which 
prepares multi-element solutions that are traceable to the National 
Institute for Standards and Technology (NIST) for their accuracy 

b. Current vendor & preparation process:  Currently it is purchased from 
High Purity Standards (Charleston, SC, part number SM-2107-013).  
Details of the HPS preparation of the multi-element stock standard is 
as follows (per statement on their literature):  

“Sub-boiled high purity acids were used to put the high purity 
metal, salts, or oxides into solution and to stabilize the 
standard.  The solution matrix is 2% (v/v) nitric acid in >18 
Mega-ohm·cm water.  The standard was made 
gravimetrically by weighing the reference material to 5 
significant figures.  Volumetric glassware was calibrated 
gravimetrically to 5 significant figures.”   

c. In-house Preparation:  If outside laboratories were not available to 
prepare the intermediate stock standard solution, it is also possible to 
make it in the laboratory from single element standards which are NIST 
traceable.   
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d. Storage:  Store the solution at room temperature.  Label these bottles 
from HPS with additional information such as “store at room 
temperature”, date received, date opened, and initials of person to first 
open. 

ii. Multi-Element Intermediate Working Calibration Standards 

1. Purpose:  Use the intermediate working standard solutions 1-5 each day of 
analysis to prepare the final working calibrators that will be placed on the 
autosampler of the ELAN® ICP-DRC-MS. 

2. Content:  The intermediate working standard solutions used in this method 
are aqueous dilutions of the multi-element intermediate stock standard 
solution in 2% (v/v) double-distilled nitric acid. 

3. Preparation & Storage:  To prepare different volumes, add proportionally 
larger or smaller volumes of the solution constituents. 

a. Cleaning flasks:  Acid-rinse five 100-mL and one 2L volumetric flasks.  
Check their cleanliness by comparing the counts observed on the ICP-
DRC-MS for 2% (v/v) HNO3 before and after contact with the flasks.  
Mark each of the flasks according to how they will be used.  These 
flasks should be dedicated to this use in this method, and not used for 
other purposes.   

b. HNO3 Diluent Preparation:  In the cleaned 2L volumetric flask, add 1-
1.5L of >18 Mega-ohm·cm water, 40 mL high purity concentrated 
HNO3.  Fill to the mark and mix thoroughly.  Use this diluent to fill the 
remaining flasks during preparation of the intermediate working 
standards. 

c. Dilutions & Storage: 

i. Partially fill the 100 mL flasks with the HNO3 diluent (50-75% full).   

ii. Using the volumes listed (Table 4 p.49) pipette the appropriate 
volume of the multi-element intermediate stock standard solution 
into each of the five volumetric flasks.  Dilute each solution to the 
mark with the HNO3 diluent using a pipette for the final drops.  Mix 
each solution thoroughly.  The final concentrations of the 5 
elements are listed in Table 4 p.49.   

iii. Once mixed, transfer to acid-cleaned, labeled, 50-mL containers 
(PP, PMP, or Teflon™) for storage.  Labels should include 
information such as “Multi-Element Serum Working Calibrators”, 
“2% (v/v) HNO3”, date of preparation, expiration date (1 year from 
date of preparation), “store at room temperature”, initials of 
preparer, and concentrations for each element. 

iv. Store at room temperature. 
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iii. Working Multi-Element Calibrators  

1. Purpose:  The working multi-element calibrators are dilutions of the 
intermediate working standards.  Analysis of these calibrators provides 
each run with a signal to concentration response curve for each analyte in 
the method.  The concentration of an analyte in a patient serum sample 
dilution is determined by comparing the observed signal from the dilution of 
the patient serum sample to the response curve from the working multi-
element calibrators.   

2. Content:  The working multi-element calibrators are 1:30 dilutions of the 
corresponding five intermediate working standards.   

3. Preparation & Use:  The working multi-element calibrators are made 
immediately prior to analysis when the intermediate working standards are 
mixed with base serum (Section 6.b) and diluent (Section 6.a) using a 
Digiflex automatic pipetter.  See Table 7 p.51 in section 8.b.ii for details of 
sample preparation. 

iv. Multi-Element Intermediate Working Calibration Verification Standards 

1. Purpose:  Use the intermediate working calibration verification standard to 
satisfy calibration verification requirements for the method (see section 
8.a.ii). 

2. Content:  The intermediate working standard calibration verification 
solution used in this method is an aqueous dilution of the multi-element 
intermediate stock standard solution (same as that used to prepare the 
intermediate stock calibration standards) in 2% (v/v) double-distilled nitric 
acid. 

3. Preparation & Storage:  To prepare different volumes, add proportionally 
larger or smaller volumes of the solution constituents. 

a. Cleaning flasks:  Acid-rinse one 100-mL and one 2L volumetric flask 
(the same 2L flask as was used in preparing the intermediate working 
calibration standards can be used here).  Check their cleanliness by 
comparing the counts observed on the ICP-DRC-MS for 2% (v/v) 
HNO3 before and after contact with the flasks.  Mark the flasks 
according to how they will be used.  This flask should be dedicated to 
this use in this method, and not used for other purposes.   

b. HNO3 Diluent Preparation:  In the cleaned 2L volumetric flask, add 1-
1.5L of >18 Mega-ohm·cm water, 40 mL high purity concentrated 
HNO3.  Fill to the mark and mix thoroughly.  Use this diluent to fill the 
remaining flasks during preparation of the intermediate working 
standards. 

c. Dilutions & Storage: 

i. Partially fill the 100 mL flask with the 2% v/v HNO3 diluent (50-75% 
full).   



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 28 of 73 
 

 

ii. Using the volumes listed (Table 4 p.49) pipette the appropriate 
volume of the multi-element intermediate stock standard solution 
into the 100mL volumetric flask.  Dilute the solution to the mark 
with the 2% v/v HNO3 diluent using a pipette for the final drops.  
Mix thoroughly.  The final concentrations of the 5 elements are 
listed in Table 4 p.49 (also Table 8).   

iii. Once mixed, transfer to acid-cleaned, labeled, 50-mL containers 
(PP, PMP, or Teflon™) for storage.  Labels should include 
information such as “Multi-Element Serum Working Calibration 
Verification Standard”, “2% (v/v) HNO3”, date of preparation, 
expiration date (1 year from date of preparation), “store at room 
temperature”, initials of preparer, and concentrations for each 
element. 

v. Working Multi-Element Calibration Verifcation Standards  

1. Purpose:  The working multi-element calibration verification standard is a 
dilution of the intermediate working calibration verification standard.  
Analysis of this standard meets the calibration verification requirements 
detailed in section 8.a.ii. 

2. Content:  The working multi-element calibration verification standard is a  
1:30 dilution of the corresponding intermediate working calibration 
verification standard.   

3. Preparation & Use:  The working multi-element calibration verification 
standards are made immediately prior to analysis when the intermediate 
working calibration verification standards are mixed with base serum 
(Section 6.b) and diluent (Section 6.a) using a Digiflex automatic pipetter.  
See Table 7 p.51 in section 8.b.ii for details of sample preparation. Store at 
room temperature. 

vi. Internal Quality Control Materials (“Bench” QC) 

1. Purpose:  Internal (or “bench”) quality control (QC) materials are used to 
evaluate the accuracy and precision of the analysis process, and to 
determine if the analytical system is “in control” (is producing results that 
are acceptably accurate and precise).  They are included in the beginning 
and at the end of each analytical run.  These pools will need to be 
prepared periodically, as supply indicates, by spiking base serum. 
Preparation of new pools should be made far enough in advance so that 
both old and new pools can be analytes together for a period time 
(preferably at least 20 runs) before switching to the new quality control 
materials. 

2. Content:  The internal (or “bench”) quality control (QC) materials used in 
this method are pooled human serum and may have been spiked to reach 
a desired concentration.  The analyte concentrations in the “low QC” are in 
the low-normal concentration range.  The analyte concentrations in the 
“high QC” are in the high-normal concentration range. 
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3. Preparation & Storage: Quality control materials can be either prepared by 
and purchased from an external laboratory or prepared within the CDC 
laboratories.  Quality control must always be traceable to the National 
Institute for Standards and Technology (NIST).  The CDC laboratory 
currently prepares its own bench QC materials using the following 
procedures: 

a. Collection of serum: Human serum can be purchased from blood 
services companies such as Tennessee Blood Services, 807 Poplar 
Ave., Memphis, TN 38105. 

b. Screening serum:  Screen different bottles for metal content before 
mixing together to make 2 separate base serum pools (for preparing 
the low and high bench QC materials). 

i. Keep serum at ≤ -20C whenever possible to minimize microbial 
growth. 

ii. Analyte concentrations in the final serum pool to be spiked for the 
low bench QC pool should be in the low-normal population range 
(see Table 2, p. 49).  Analyte concentrations in the final serum pool 
to be spiked for the high bench QC pool should be less than some 
pre-selected target concentration values in the high normal 
population range.   

c. Spiking of serum 

i. Analyze a sample of each serum pool.  Record these results for 
future recovery calculations. 

ii. Use these results to determine target analyte concentrations 
possible for the pools 

iii. Calculate the volume of single element standards needed to spike 
each pool to the desired concentrations.   

iv. While stirring the pools on large stir plates, spike each pool with 
calculated volumes of single element standards (all spiking 
standards used must be traceable to NIST).   

v. Continue to stir pools for 30+ minutes after spiking, then reanalyze.   

vi. Repeat steps 4 and 5 until all analytes reach target concentrations 
keeping track of the total volume of spiking solution added to each 
serum pool. 

d. Dispensing and Storage of serum 

i. Container Types:  Dispense serum into lot screened containers 
(i.e. 2 mL polypropylene cryovials).  If possible, prepare tubes of 
QC which have only enough volume for one typical run + 1 repeat 
analysis.  This allows for one vial of QC to be used per day of 
analysis, reducing chances of contamination of QC materials due 
to multi-day use. 
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ii. Labels:  Place labels on vials after dispensing and capping if the 
vials are originally bagged separately from the caps.  This 
minimizes the chance for contamination during the process.  
Include at least the name of QC pool (text and bar code), date of 
preparation, and a vial number on the labels. 

iii. Dispensing:  Dispensing can be accomplished most easily using a 
Digiflex automatic pipette in continuous cycling dispense mode. 
This process should be done in a clean environment (i.e. a class 
100 cleanroom area or hood). 

1. Allow serum pool to reach room temperature before 
dispensing (to prevent temperature gradients possibly causing 
concentration gradients across the large number of vials being 
dispensed and to prevent condensation problems during 
labeling of vials).   

2. Replace the tubing attached to the dispensing syringe (left 
when looking at front of Digiflex) with a length of clean 
Teflon™ tubing long enough to reach into the bottom of the 
carboy while it is sitting on the stir plate. 

3. Check cleanliness of Digiflex before use by analyzing 1-2% 
(v/v) HNO3 which has been flushed through the Digiflex with a 
portion of the same solution which has not been through the 
Digiflex. 

4. Approximately one hour before dispensing begins,  

a. With the large stir plate close to the left side of the Digiflex, 
begin stirring the serum pool to be dispensed.   

b. Also during this time, flush the Digiflex with serum from the 
pool to be dispensed.  Place the ends of the tubing 
attached to both the sample and dispensing syringes into 
the carboy of serum so that serum won’t be used up during 
this process.  Be sure to secure both ends of tubing in the 
carboy with Parafilm so they will not come out during the 
flushing process. 

5. After dispensing the serum into the vials, cap the vials and 
label them.  Placing labels on vials after capping minimizes the 
chance for contamination during the process.   

iv. Homogeneity Testing:  After dispensing, check homogeneity of 
analyte concentrations in pool aliquots by analysis of every Nth 
sample dispensed (where N ~ 20 - 50 depending on the pool size).  
Sample more heavily from the beginning and the ending portions 
of the tubes dispensed (these are the regions where most 
homogeneity problems occur).  Keep samples pulled for 
homogeneity analysis in the sequence that they were dispensed 
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for the purpose of looking for trends in concentrations.  Once 
dispensed and homogeneity has been shown to be good 
throughout the tubes of a pool, store tubes at ≤ -20°C and pull 
tubes out as needed for analysis. 

v. Storage:  Serum pools should be stored long term at ≤ -20°C.  
Short term storage (several days) at refrigerator temperature (~ 2-
4°C). 

 
7) Analytical Instrumentation & Parameters  

(see Section 5 for details on hardware used, including sources) 
 
a. Instrumentation & Equipment Setup: 

 
i. ICP-DRC-MS:  Inductively Coupled Plasma Dynamic Reaction Cell Mass 

Spectrometer ELAN® 6100 DRCPlus or ELAN® DRC II. 
 
1. Modifications made to ICP-DRC-MS 
 

a. All plastic tubing for DRC reaction gases have been replaced with 1/8” 
O.D. stainless steel. 

 
2. Sample introduction system setup: 

(See Figure 1 in the Appendix for diagram of generic sample introduction 
system.  Adjustments of connections for the ESI SC4 autosampler are 
described below.  See figures 3a through 3e in Appendix B for other default 
autosampler settings). 
 

a. Concentric quartz nebulizer (quick connect arrangement for liquid and 
gas connections available from some vendors). 

b. Quartz cyclonic spray chamber. 
c. Quartz injector, 2 mm ID, ball joint end (not shown in Figure 1). 

 
3. Configuration of tubing for liquid handling: 

(See Figure 1 in the Appendix for diagram of tubing setup.  This is a 
recommended setup, but other similar arrangements are usable. See 
Section 5.b. for part numbers and ordering details.) 

 
a. Tubing for liquid sample uptake: 

 
i. Probe-to-peristaltic pump tubing:  PFA tubing from ESI SC4 

autosampler probe connects either directly to sample peristaltic 
tubing or through a connection adaptor.   

 
ii. Nebulizer-to-peristaltic pump tubing:   
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1. 3mL/min nebulizer (TQ-30-A3):  Hold square-cut end of 0.5mm 
x 1.59mm PFA tubing against the inside tapered nebulizer 
capillary using a flangeless nut and ferrule assembly.  Angle-
cut opposite end of tubing before inserting into end of black / 
black peristaltic pump tubing.  

 
2. 1mL/min nebulizer (500-70QQDAC):  Quick connect fitting fits 

inside back side of nebulizer.  Use a PEEK adapter to securely 
connect the PFA tubing to the peristaltic tubing.  Higher back-
pressure from the 1mL/min nebulizer is likely to cause tubing 
become disconnected if the PFA tubing is merely inserted into 
the peristaltic pump tubing. 

 
b. Tubing for autosampler rinse solution:  

 
i. SC autosampler setup for non-FAST applications:   

See Appendix B, Figure 1b for generic autosampler flow diagram.  
Differences to Figure 1b for the ESI SC4 autosampler include  

1. Autosampler Probe: (SC4 probe has built-in PFA tubing 
extending from the Teflon-coated probe, so no nut and flanged 
tubing connection is necessary).   

2. Rinse station filling:  ESI SC4 autosampler may have a built-in 
vacuum pump which pumps rinse solution from the rinse jug to 
the rinse station ports.  If so, rinse solution will not need to be 
routed through the peristaltic pump.   

3. Rinse station waste:  ESI SC4 autosampler liquid waste may 
be setup to drain by gravity (see comment below). 

 
ii. Tubing connection between autosampler rinse station and rinse 

solution reservoir:  Tubing of different inner diameters can be 
obtained from Elemental Scientific, their distributors, or custom 
built in the lab to optimize the rinse station fill rate between 
samples.  Rinse station should not go empty at any point. 

 
iii. Tubing for autosampler rinse station waste removal: Use minimum 

drain tubing to make this connection.  If this tube is too long, the 
rinse station will not drain properly. 

 
iv. Rinse solution jug:  Leave one of the caps on the top of the rinse 

jug loose to allow air venting into the jug as liquid is removed.  
Otherwise the jug will collapse on itself as the liquid is removed 
and a vacuum is created inside. Use secondary containment tray 
and label appropriately (see solution preparation instructions). 

 
v. Waste solution jug:  Use secondary containment tray and label 

appropriately (see solution preparation instructions). 
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c. Configuration of tubing for spray chamber waste removal: 
 

i. Chamber-to-peristaltic pump tubing:  Connect 1/8” i.d. x 1/4 inch 
o.d. PVC tubing directly to the waste port on the spray chamber.  
Connect other end of PVC tubing to the white / black peristaltic 
pump tubing using a tubing connector (PerkinElmer item # 
B3140715). 

 
ii. Waste Jug-to-peristaltic pump tubing:  Connect 1/8” i.d. x ¼” o.d. 

PVC tubing to the white / black peristaltic pump tubing using a 
tubing connector (PerkinElmer item # B3140715).  Place the free 
end of the PVC tubing through the lid of the waste jug (be sure it is 
secure).  Waste jug should be sitting in a secondary containment 
tray in case of overflow. 

 
4. Cones used 

Nickel or platinum cones from either PerkinElmer or Spectron have been 
used successfully.  Platinum cones are preferred for durability. 
 

5. Gases & Regulators setup: 
 

a. Argon:  Argon stored as liquid in a dewar (180-250L) or bulk tank.  
Gaseous argon used for plasma and nebulizer.   

 
i. Regulator for argon source (if a dewar):  Keep the inlet pressure 

(headspace pressure of liquid argon dewar) above 100 psi.  Set 
delivery pressure to 60-100psi to allow for pressure drop across 
tubing that stretches to the instrument.  See Section 5.e. for part 
numbers and details. 

 
ii. Step down regulator (if source of argon is a bulk tank):  Place this 

single stage regulator in the lab so that incoming argon pressure 
can be monitored and adjusted.  Set delivery pressure to 70-100 
psig.  See Section 5.e. for part numbers and details. 

 
iii. Regulator at ICP-DRC-MS:  Single stage “argon regulator filter kit” 

supplied with the ICP-DRC-MS.  If the delivery pressure gauge 
range is 0-60psi, set the delivery pressure to 52±1 psig.  If the 
delivery pressure gauge range is 0-100psi, set the delivery 
pressure to 60±1 psig.  See Section 5.e. for part numbers. 

 
b. Ammonia gas for DRC channel A.   
 

i. Regulator for NH3 gas:  Set delivery pressure to 5-7 psig.  See 
Section 5.e. for part numbers and details. 
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6. Chiller / Heat Exchanger: Refrigerated chiller (for ELAN® 6100 DRCPlus 
instruments) or heat exchanger (for ELAN® DRC II instruments).  For 
refrigerated chiller, set temperature control to 18°C.   

 
ii. Computer:  Dell Optiplex GX150, GX270, or GX280 have all been used.  

Processors used have included Pentium III (1 GHz) through Pentium IV (2.8 
GHz).  Recommend 512Mb - 1Gb RAM.  External hard disk drive for nightly 
backups of data connects via USB port.  Software used includes Windows XP 
Professional, service pack 2 and ELAN v3.3. 

 
iii. Autosampler:  ESI SC4 autosampler without FAST sample introduction.  Rack 

calibration, tubing ID for rinse supply, additional rinse time, probe movement 
speeds, and probe depth is optimized per autosampler (see Table 1 in 
Appendix B for default settings). 

 
b. Parameters for Instrument and Method:  See Table 1 pp 46-48 for a complete 

listing of the instrument and method parameters.  Also, see Figures 2a-2g for 
images of the ELAN method screens. 

 
8) Method Procedures 

a. Quality Control:  Quality control procedures implemented in this method are 
defined by the Division Procedures and Practices Guidelines and include two 
types of QC systems which are both subjected to the complete analytical 
process.  The data from these materials are then used to estimate 
methodological imprecision and to assess the magnitude of any time-associated 
trends.  The concentrations of these materials should cover the expected 
concentration range of the analytes for the method.  Before QC materials can be 
used to judge patient analytical runs, acceptable QC concentration limits must be 
calculated from the concentration results observed in at least 20 characterization 
runs.  During the 20 characterization runs, previously characterized QCs or pools 
with target values assigned by outside laboratories should be included to 
evaluate the analysis.  The process of limits calculation is performed using the 
laboratory database and the SAS division QC characterization program. 

i. Types of Quality Control:   
1. “Bench QC”:  The bench QC pools used in this method comprise two levels 

of concentration spanning the “low-normal” and “high-normal” ranges of the 
analyte of interest.  The intent of bench QC is for the analyst to evaluate 
the performance of the analytical system on the day of analysis.  The 
analyst inserts both the “low” and the “high” bench QC specimens two 
times in each analytical run (a set of consecutive assays performed without 
interruption) so that judgments may be made on the day of analysis.  The 
first analysis of the two bench QC pools is done after the calibration 
standards are analyzed but before any patient samples are analyzed (so 
that judgments on the calibration curves may be made before analysis of 
patient samples).  The second analysis of the two bench QC pools is done 
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at the end of the run (approximately 20 patient samples total).  If more 
patient samples are analyzed on the same calibration curve after the 
second run of the bench QC, both the low-normal and high-normal bench 
QC must be reanalyzed before and after the additional samples.  For 
example, the schemes shown in Table 5 p.50 are both acceptable ways to 
analyze multiple consecutive “runs”.   
 

2. “Blind QC”:  When possible, “blind” QC samples are QC materials placed in 
vials, labeled, and processed so that they are indistinguishable from the 
subject samples handled by the analyst.  Ideally, the supervisor decodes 
and reviews the results of the blind specimens without the analyst knowing 
of their presence in the runs.  When it is not possible to have blind QC 
materials processed so that they are indistinguishable by the analyst from 
the patient samples, it is acceptable for the analyst to randomly insert into 
the run a QC material which only the QC reviewer knows the acceptable 
concentration limits for.  At least one low-normal concentration and one 
high-normal concentration QC material should be kept in the laboratory for 
this purpose. 

3. External Reference Materials:  Materials produced by laboratories outside 
of the CDC which have assigned target concentrations can be helpful in 
verifying method performance.  Some examples include Standard 
Reference Materials (SRM) from the National Institute of Standards and 
Technology (NIST) (i.e. SRM 1598a) and samples from previous 
challenges of proficiency testing programs (i.e. Centre de Toxicologie du 
Quebec (CTQ)).  However, only the results for the bench and blind QC 
materials are used to determine if the run results can be used. 

ii. Calibration Verification:   

1. Bi-annual tests as defined in the DLS Policy and Procedures manual:  
CLIA requires the verification of accuracy of instrument response to analyte 
concentration be completed at least every 6 months.  NIST traceable 
calibrators are analyzed in each run to define this response up to the 
concentration of the highest calibrator in the run.  To verify accuracy of 
instrument response at concentrations higher than the highest calibrator in 
each run, analyze a NIST traceable standard with very high concentrations 
(see Table 8 p.52 in the Appendix for concentrations) at least every 6 
months.  Prepare the Calibration Verification Standard for analysis just as a 
working calibrator is prepared.  Use the “Serum Blank” as the blank when it 
is analyzed.  If the observed concentrations for the Calibration Verification 
Standard are not within 10% of the target value (see Table 8 p.52 in the 
Appendix) the lab supervisor should be notified and the issue should be 
investigated.  Do not substitute external reference materials (i.e. biological 
samples from a PT program) for the Calibration Verification Standard when 
performing this.  Solutions needed for the Calibration Verification checks 
can be purchased from standards vendors (i.e. SPEX, High Purity 
Standards, etc . . .) or prepared in-house from NIST traceable single 
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element standards.  Always verify that normal background levels have 
been re-achieved through adequate rinse time following analysis of 
elevated standards for calibration verification. 

2. As-needed confirmations (per supervisor discretion):  When a sample 
result is greater than the highest calibrator in the run by more than 10%, 
the supervisor may request that the result be confirmed in an analysis run 
which includes a standard or external reference material with equivalent 
(within 10%) or greater concentration than the sample.  In order to avoid 
needless contamination of the instrument with high concentrations of 
analytes, the analyst should use the lowest appropriate calibration 
verification solution concentrations to meet the need. 
 
For infrequent verification needs, the calibration verification stock solutions 
can be used to prepare verification standards to appropriate 
concentrations.  This will, however, introduce elevated concentrations of all 
elements in the method to the sample introduction system.  Frequent 
measurement of these very high concentrations can result in high 
background levels in the instrument which are difficult to rinse out and 
which may limit the ability to measure low concentrations.   
 
For frequent verification needs (i.e. when certain studies have many 
elevated results on particular elements) or when a concentration higher 
than those shown in Table 8 p.52 needs to be verified,  use NIST-traceable 
single element stock standards to prepare single element verification 
standards.  This will limit the exposure of the instrument to elevated 
concentrations of only the elements needing verification. 
 
Always verify that normal background levels have been re-achieved 
through adequate rinse time following analysis of elevated standards for 
calibration verification. 
 
An external reference material (i.e. historical proficiency testing sample) 
can be used to verify the linearity of calibration within a run in these 
situations IF 

a. The target value has been assigned by an external source (i.e. NIST, 
or the proficiency testing program). 

b. The concentration of the external reference material is within 10% or is 
higher than the concentration of the material you need it to confirm. 

c. There is confidence that there is no contamination of previously used 
external reference material. 

d. A note to file is made that this was done.  

e. If the observed concentrations are not within 10% of the target value 
the lab supervisor should be notified and the issue should be 
investigated. 
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b. Daily Analysis of Samples 

i. Preparation of the Analytical Equipment 

For further details on any part of this description, see the ITN Daily Startup 
SOP for ELAN ICPMS instruments. 

1. Power on the computer, printer, peristaltic pump, and autosampler, and log 
into the operating system. 

2. Peristaltic pump:  Set up the peristaltic pump tubing with proper tension for 
the sample rinse station. 

a. If using an external peristaltic pump, after lighting the plasma go to the 
DEVICES window of the software and press the “Connect” button to 
establish communication between the computer and the autosampler.  
Next, start the peristaltic pump by pressing the appropriate arrow in the 
DEVICES window (make sure that the rotational direction is correct for 
the way the tubing is set up in the peristaltic pump).  Set the pump 
speed to 10 rpm in the DEVICES window. 

b. If using the on-board ICP-MS peristaltic pump, start the peristaltic 
pump by pressing the appropriate arrow in the DEVICES window 
(make sure that the rotational direction is correct for the way the tubing 
is set up in the peristaltic pump).  Set the pump speed to a slow flow 
rate (6 to 10 rpm) in the DEVICES window. 

3. Software:  Starting the ESI software before starting the ELAN software may 
improve stability of software. 

4. Daily Pre-Ignition Maintenance Checks: Perform daily maintenance checks 
as described in the ITN Daily Startup SOP for ELAN instruments (i.e., Ar 
supply pressure, interface components cleanliness and positioning, 
interface pump oil condition, vacuum pressure, etc.).  Make appropriate 
notes in the Daily Maintenance Checklist and Instrument Log Book.  

5. Start the Plasma:  In the INSTRUMENT window of the software (or on the 
front of the ELAN), press the “Start” button to ignite the plasma.  

6. Send Probe to Rinse Station:  Through the METHOD/SAMPLING window 
in the software, press the “Probe” button, then the “Go to Rinse” button to 
lower the autosampler probe into the rinse solution. 

7. Start the peristaltic pump: 

8. Warm-up time:  Allow at approximately 30 to 45 minutes warm-up time for 
the ICP-DRC-MS after igniting the plasma.  This warm-up time is for the 
RF generator.  There will be another “Stability time” for the DRC later in 
this procedure. 

9. Optimizations and Daily Performance Check:  After this warm-up time, 
perform a daily performance check and any optimizations necessary (as 
described in the ITN Daily Startup SOP for ELANs).  Include Be (m/z 9) in 
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the daily performance check.  Fill in the Daily Maintenance Checklist 
according to the optimization procedures performed. 

a. Magnesium (24Mg) may have high RSDs due to the use of Triton-X100 
in the rinse solution.  Avoid this problem by either temporarily using 
non-Triton-containing rinse solution during the daily check, or repeating 
the daily check multiple times in succession with no rinse time 
between.   

i. Saving the Files:  Save new tuning (mass calibration) parameters 
to the file “default.tun.”  Save new optimization parameters (i.e., 
detector voltages, autolens values, nebulizer gas flow rate) to the 
file “default.dac.” monthly, or any time large changes are made in 
optimization parameters, save a separate copy of these 
optimization files under a different name (i.e. – 
default_070706.dac). 

10. Software setup for Analysis: 

a. Workspace (files & folders):  Click on “Open Workspace” from the 
“File” menu.  Select the workspace file “CDC_Serum multi-
element.wrk” (or one customized for user preferences).  Select 
“Review Files” from the “File” menu.  Verify & set up the correct files 
and data directories for your analysis (See Table 1 p.47-49 “File 
Names & Directories“). 

b. Samples / Batch Window:  Update the window to reflect the current 
sample set.  The only fields which need to be filled in include the 
autosampler location, sample identification (id), measurement action, 
method, sample flush time, sample flush speed, read delay time, read 
delay & analysis speed, wash time, wash speed. Use a bar code 
scanner to input data whenever possible.  See Table 1 pp 47-49 for 
times and speeds.  Save the Sample window file and re-use it on other 
days by simply replacing the sample IDs for the patient samples. 

 
1. DRC Stability Time:  Best analyte-to-internal standard ratio 

stability is obtained after 1 hrs of analysis of serum samples 
using the DRC method.  Analyze enough base serum sample 
dilutions prior to any DRC analysis run to fill at least one hours 
of analysis time. If analyzing the full set of method analytes, 10 
samples will be sufficient.  See Table 5 p.50 for example of 
setup in the Samples / Batch window. 

 
2. Serum vs. Aqueous Method Files:   

a. The difference: There are two method files for this one 
method (see Table 1 p.47-49).  It is necessary to use both 
to accomplish each run because the current PerkinElmer 
software will not allow for more than one blank per method 
file.  The ONLY DIFFERENCE between these two files is 
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on the Sampling tab where one lists the autosampler 
positions of the serum blank and serum calibrators (the 
“sblk” method file) and the other lists the autosampler 
position of the aqueous blank (the “aqblk” method file).   

b. Use:  The ONLY TIME when it matters which of these files 
is used is when the measurement action includes “Run 
blank” or “Run standards”.  When the measurement action 
is only ‘run sample’, it does not matter whether the “sblk” or 
“aqblk” method file is used.  Analysts typically follow the 
pattern below, however, for the sake of consistency and as 
a reminder of which blank must be used for which type of 
sample.  See Table 6 p.50. 

i. The “sblk” method file:  Use to analyze the initial serum 
blank (blank for the calibration curve), the serum 
calibrators, and the serum blank checks (sblkchk1 & 
sblkchk2) at the very beginning of the run.  The serum 
blank method (set up for a ESI SC4 autosampler 
defines the serum blank in autosampler location 109 
and the serum calibration standards 1-5 in autosampler 
locations 101-106, respectively. 

ii. The “aqblk” method file must be used to analyze all QC 
materials and patient samples.  The aqueous blank 
method (set up for a ESI SC4 autosampler) defines the 
aqueous blank in autosampler location 109.  

3. Notation of Dilutions:  To designate an extra dilution of a 
sample, edit the sample ID to reflect the level of dilution being 
performed (i.e., A 1:2 dilution of sample 1 would be reflected in 
the sample ID “sample 1 (2x dilution)”.  This sample ID will be 
edited during the data-import process to the database so that 
it is recognized as the appropriate sample.  Do not use the 
ELAN® software to automatically correct for sample dilutions.  
Extra dilution is performed on serum samples whose 
concentration is greater than the concentrations listed in Table 
8 p.52 in the Appendix (linearity of the method has been 
documented up to these concentrations). 

ii. Preparation of Samples for Analysis  (See Table 7 p.51) 

1. Thaw the frozen serum specimens; allow them to reach ambient 
temperature. 

2. Prepare diluted serum for analysis during the DRC stability period.  A 40-
minute DRC stability period will consume approximately 36mL of 
solution.  Prepare the necessary volume according to the “patient 
sample constituent proportions listed in Table 7, p. 51.  This can be 
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prepared in a 50mL polypropylene tube or a wide-mouth bottle (which 
can be put on the autosampler in place of one of the tube trays). 

NOTE:  Selenium is not stable in the diluted sample for more than 7 
hours.  Diluted serum must be analyzed within 7 hours of 
preparation (see Appendix A, test 5 for details) 

3. Set up a series of 15-mL polypropylene tubes corresponding to the 
number of blanks, standards, QCs, and patient samples to be analyzed. 

4. Prepare the following solutions in the 15-mL falcon tubes using the 
Micromedic Digiflex™ (see Table 3 p.49 for a summary). 

a. Aqueous Blank:  Prepare two aqueous blanks consisting of 300 L of 
>18 Mega-ohm·cm water and 4,200 L of diluent (2 x 2100 L).  One 
will be the actual aqueous blank and the other will be a backup 
(“Aqueous Blank Check”) in case the original aqueous blank gets 
contaminated…. 

b. Serum Blank:  Prepare three serum blank dilutions consisting of 150 
L of base serum (same material used to prepare the serum calibration 
standards), 150 L of >18 Mega-ohm·cm water, and 4,200 L of 
diluent (2 x 2100 L).  One of these serum blanks will be the blank for 
the calibration standards; the others will be analyzed after standard 5 
as sblkchk1 and sblkchk2, respectively.  Results from sblkchk1 and 
sblkchk2 will be stored for periodic verification of the method limit of 
detection. 

c. Calibrators or Calibration Verification Standards:  Prepare the working 
calibration standards or the working calibration verification standards 
as 150 L of the appropriate aqueous intermediate working solution, 
150 L of base serum, and 4,200 L of diluent (2 x 2100 L). To avoid 
carryover from working calibration standards and the working 
calibration verification standards to other samples, rinse tip of digiflex 
once with concentrated nitric acid. 

d. Patient & QC Samples:  Before taking an aliquot for analysis, mix the 
sample so that no particulates remain on the bottom of the tube.  
Prepare serum sample dilutions as 4,200 L of diluent (2 x 2100 L), 
150 L of the serum sample and 150 L of >18 Mega-ohm·cm water. 

e. Cap all of the blanks, standards, and samples and mix them well.  
Uncap them and place them in the autosampler of the ELAN® ICPMS 
in the order that was entered in the Samples / Batch window of the 
ELAN software. 

iii. Specimen Storage and Handling during Testing:  Specimens may be left at 
room temperature during analysis in case confirmation analyses must be 
made.  Take stringent precautions to avoid external contamination by the 
metals to be determined.  Specimens may be stored short term at refrigerated 
temperatures, but should be stored long term (>4 weeks) at ≤ -20 °C. 
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iv. Starting the Analysis:  To begin analysis, highlight (click and drag with the 
mouse) the table rows of the samples that should be included in the run, and 
then click on “Analyze Batch.” 

v. Monitoring the Analysis:  Initiate work in a timely manner so that the run may 
be monitored.  Make every effort to complete analysis within the work day so 
that the entire run can be monitored.  If it is not possible to complete the 
analysis by the end of the work day, the run may be left to complete itself 
unattended as long as appropriate planning is made for either overnight 
operation or Auto Stop (see below).   

Monitor the analysis for the following: 

1. DRC stability (analyte / internal standard ratio stability) 

After the analysis of the DRC stability base serum samples, these results 
can be reviewed to determine if sufficient stability of the analyte-to-internal 
standard ratio has been reached before beginning analysis.  Importing data 
into an MS Excel template file is useful to simplify this procedure. 

2. Proper operation of the instrument. 

3. Contaminated blanks. 

4. Linear calibration curves. 

a. Typical correlation coefficients will be 0.999 to 1.000. 

b. The ELAN software generates a “simple linear” calibration curve (using 
a least squares calculation) for each of the 3 elements in this method.  
The curves are generated using the results from analysis of the serum 
blank and the 5 external serum calibrators whose concentrations are 
defined in the Calibration tab of the Method file.  Specifically, the 
software plots the “net intensity” (y-axis) versus the analyte 
concentration (x-axis).  The “net intensity” is the blank subtracted ratio 
of the measured intensity for the analyte to the measured intensity of 
the associated internal standard and is calculated as follows:  

 

Blank

Blank

sample

sample

IntensityMeasStdInternal

IntensityMeasAnalyte

IntensityMeasStdInternal

IntensityMeasAnalyte
ensitynet 

.
int

` 

5. Bench QC results within the acceptable limits.   

If an analyte result for the beginning QC material(s) falls outside of the 3SD 
(i.e. 99 percentile) limits, then the following steps are recommended:  

a. If a particular calibration standard is obviously in error, remake a new 
dilution at the Digiflex of that working calibrator, reanalyze it, and 
reprocess the sample analyses using this new result as part of the 
calibration curve. 
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b. Prepare a fresh dilution of the failing QC material and reanalyze it. 

c. Prepare fresh dilutions at the Digiflex of all of the calibration standards 
(working serum multi-element standards) and reanalyze the entire 
calibration curve using the freshly prepared standards. 

If these three steps do not result in correction of the out-of-control values 
for QC materials, consult the supervisor for other appropriate corrective 
actions. Do not report analytical results for runs that are not in statistical 
control. 

6. Good precision among replicates. If “air” was sampled into the system, the 
precipitated serum protein might be coated within the probe, tubing and the 
introduction system which might cause the bad precision among replicates 
and/or reduced sensitivity of the instrument. Use >18 Mega-ohm·cm water 
to rinse the system for recovering the instrument performance.    

7. Consistent measured intensities of the internal standards.   

Some sample-to-sample variations are to be expected.  However the 
intensities should be within a few percent of one another, and should 
fluctuate around an average value (not drift continuously in one direction). 

8. Elevated patient results. 

 

vi. Records of Results:  Run results will be documented daily in both electronic 
and paper form. 

1. Electronic Records: 

a. Transfer of Results to the Laboratory Information System / Database:  
Transfer data electronically between computers or software to reduce 
errors.  When keyboard entry must be used, proofread transcribed 
data after entry. 

b. Long-Term Storage of ELAN software files:  Files used and produced 
by the ELAN software in analyzing samples will be backed up long 
term on compact disk and kept a minimum of three years. 

2. Paper Records:  The paper copy of the results from the run should be put 
into the study folder(s) and should include  

a. A summary of the calibration curve statistics. 

b. A printout of analysis of each measurement made during the run. 

c. Optional, but helpful, is a printout of the DRC stability check 
measurements in graphical form. 

d. On the front sheet of the printed records, write the following 

i. Analyst initials 

ii. Instrument ID 
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iii. Date of Analysis 

iv. Run # for the day on this instrument 

v. Study ID and Group Number 

vi. Database batch ID (Not known until the run is imported into the 
database) 

vii. Transfer of Results to the Laboratory Database:  Every analytical run 
performed for the analysis of patient samples should be entered into the 
laboratory results database unless the run is not useable for obvious reasons 
(i.e. the run is stopped for some reason before ending QC is analyzed, no 
internal standard spiked into the diluent, etc. . . ). 

1. Data Export Process (from ELAN® software to .TXT file):  If the data file 
was not created during the initial analysis, reprocess the data of interest 
either with “original conditions” option, or by loading the files and folders 
used during the analysis.  In the ELAN® ICP-DRC-MS software, select 
“Review Files” from the “File” menu.  From this window, you must open the 
files and directories that were used when collecting the data of the run that 
you wish to export.  (If the analysis has just ended, all of these files and 
directories will still be open.)  NOTE:  A second copy of the ELAN® 
software can be run as an Edit/Reprocess copy without affecting an 
ongoing analysis by the first copy of the software running in Windows.  
After you open the relevant files, go to the “Report” page in the METHOD 
window.  Deselect the box that prints a paper copy of data and select the 
box that sends data to a file.  Select the “Report Options Template” named 
“CDC_Database Output.rop” and type in a report filename using a format 
such as “2006-0714a_group55.txt” to designate data from analysis of 
group 55 from July 14, 2006, run #1.  Under “Report Format”, choose the 
“Use Separator” option, and under the “File Write” section choose 
“Append.”  Finally, reprocess the data of interest.  (See PerkinElmer 
ELAN® ICPMS Software Manual.)  Make sure you apply the aqueous 
blank to all sample and quality control material analyses.  

2. Data Import Process (from .TXT file to Microsoft Access™ database):   

a. Move the .TXT file to the appropriate subdirectory on the network drive 
where exported data are stored.  Directories for data storage are 
named according to instrument \ year \ month\, such as 
I:\Instruments\ELANDRCC\2006\07\. 

b. Using the ITN Database Frontends, import the instrument file into the 
database.  On the GoTo window, click on “Add Sample Results to 
Database”, then “Import Instrument Data File”. 

c. Enter the appropriate information to identify the instrument, assay, 
analysis date & time, run number, analyst, calibrator lot number and 
prep date used (use the “IS Lot Number” field) and study.  If other than 
default values for Method LOD, High Calibrator, Rep Delta Limit, and 
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units were used in the run, document what was used by clicking on the 
“View/Set Batch Parameters” button, changing the appropriate values, 
and then clicking “Back”. 

d. Press the “Import” button and then browse to the correct network folder 
to select the file which contains the results from the run.  Select the file 
and click “OK”. 

e. In the “Import Instrument Results” table, pressing the “Find X’s” button 
will show only those samples whose sample ID is not recognized as a 
valid QC pool ID or sample ID for this study.  (Sample IDs are set up 
when the study is logged into the database.)  Corrections to sample 
IDs and dilution factors can be made in this table (e.g., correction of 
transcription errors and adjustment for level of dilution).  If samples 
were diluted for analysis, both the sample ID and the dilution factor 
need to be edited in this table before the values are transferred to the 
database (the Replace command under the Edit window is helpful in 
this case).  When corrections to sample IDs are made, press the 
“Check IDs” button to re-evaluate the sample IDs.  Any sample or 
analyte row marked “Not Recognized” will not be transferred to the 
database when the “Transfer” button is pressed.   Once transferred 
into the database, the data should be evaluated for QC pass / fail, then 
set with the appropriate settings for QC accept / reject, final value 
status, and comment(s).  See the database programmers for more 
detail on working in the database. 

viii. Analyst Evaluation of Run Results: 

1. Bench Quality Control:  After completing a run, and importing the results 
into the database, export the QC results to the SAS program where the run 
will be judged to be in or out of control.  The QC limits are based on the 
average and standard deviation of the beginning and ending analyses of 
each of the bench QC pools, so it will not be possible to know if the run is 
officially accepted or rejected until it is completed.   

a. Quality Control Rules:  The SAS program applies the division QC rules 
to the data as follows:  

i. If both QC run means (low & high bench QC) are within 2Sm limits 
and individual results are within 2Si limits, then accept the run. 

ii. If 1 of the 2 QC run means is outside a 2Sm limit - reject run if: 

1. Extreme Outlier – Run mean is beyond the characterization 
mean +/- 4Sm 

2. 1 3S Rule - Run mean is outside a 3Sm limit 

3. 2 2S Rule - Both run means are outside the same 2Sm limit 

4. 10 X-bar Rule – Current and previous 9 run means are on 
same side of the characterization mean 
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iii. If one of the 4 QC individual results is outside a 2Si limit - reject 
run if: 

1. R 4S Rule – Within-run ranges for all pools in the same run 
exceed 4Sw (i.e., 95% range limit) 

Note: Since runs have multiple results per pool for 2 pools, the R 4S 
rule is applied within runs only.  

Abbreviations: 

Si = Standard deviation of individual results (the limits are not shown 
on the chart unless run results are actually single 
measurements). 

Sm = Standard deviation of the run means (the limits are shown on the 
chart). 

Sw = Within-run standard deviation (the limits are not shown on the 
chart). 

b. Implications of QC Failures:  If the division SAS program declares the 
run out of control” for any analyte, use the following to determine the 
implications on usability of the data from the run.   

i. If only one analyte of the three fails bench QC, then the other two 
which passed bench QC may be reported. 

ii. If two analytes of the three fail bench QC, then none of the results 
from the run should be used for reporting.  The cause of the QC 
failures should be investigated and then the entire run should be 
repeated. 

2. Patient Results: 

a. Results Outside the Normal Range:  The normal range of 
concentrations observed for these elements in serum is listed in Table 
10. 

i. Boundaries Requiring Confirmatory Measurement: 

1. Results Lower than the First Lower Boundary (1LB) or Higher 
than the First Upper Boundary (1UB):  Concentrations 
observed less than the “first lower boundary” (defined in the 
laboratory database as the “1LB”) or greater than the “first 
upper boundary (defined as the “1UB” in the laboratory 
database) should be confirmed by repeat analysis of a new 
sample preparation.  The concentration assigned to the 1LB 
for an element is determined by study protocol but default 1LB 
concentrations for elements in this method can be found in 
Table 9 p.52 in the Appendix.  Report the original result, as 
long as the confirmation is within 10% of the original.  Continue 
repeat analysis until a concentration can be confirmed.  
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2. Results Greater than Highest Calibrator:  When a sample 
result is greater than the highest calibrator in the run, the 
supervisor may request that the result be confirmed in an 
analysis run which includes a standard or external reference 
material with equivalent (within 10%) or greater concentration 
than the sample.   

3. Results Greater than Range of Linearity Tested:  Perform an 
extra dilution on any serum sample whose concentration is 
greater than those listed in Table 8 p.52 in the Appendix (the 
linearity of the method has been documented up to these 
concentrations).  See Table 7 p.51 for description of sample 
preparation with extra dilution. 

ii. Analyst Reporting of Abnormally Low or Abnormally High Results:  
Concentrations observed lower than the “second lower boundary” 
(defined in the laboratory database as the “2LB”) or greater than 
the “second upper boundary” (defined in the laboratory database 
as the “2UB”) should be reported to the QC reviewer as an 
“abnormally low result” or an “elevated result”, respectively.  The 
concentration assigned to the 2LB and 2UB for an element is 
determined by study protocol but default concentrations are in 
Table 9 p.52 in the Appendix.  There is no routine notification for 
elevated levels for the metals determined in this method.  The 
protocol for supervisors reporting elevated results to medical 
personnel is defined according to the study protocol. 

b. Inadequate Precision Within One Measurement:  If the range of the   
three replicate readings (maximum replicate concentration value - 
minimum replicate concentration value) for a single sample analysis is 
greater than the criteria listed in Table 9 p.52 in the Appendix and the 
range of the three replicate readings is greater than 10% of the 
observed concentration, do not use the measurement for reporting.  
Repeat the analysis of the sample.  This type of inadequate precision 
is noted in the database by an ‘X’ in the “>Lim Rep Delta” field. 

ix. Submitting final work for Review:  Once results have been imported, reviewed, 
and set as final in the database by the analyst,  

1. Submit an email to the QC reviewer informing them of the readiness of the 
data for final review.  The email should include 

a. Instrument ID, run Date, run number, study ID, group ID. 

b. Any bench QC failures (include reasons if known). 

c. Any patient sample result less than the 2LB or greater than the 2UB 
(see Table 9 p.52 in the Appendix). 
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d. Anything out of the ordinary about this analytical work which could 
have a bearing on the availability (i.e. insufficient sample to analyze), 
accuracy, or precision of the results. 

2. Include all items called for by the study folder cover sheet in the study 
folder (i.e. printouts from the ICP-MS, bench QC evaluation) together in the 
study folder before submitting the folder for review when analysis is 
complete. 

x. Overnight operation or Using Auto Stop:  Make every effort to complete 
analysis within the work day so that the entire run can be monitored.  If it is not 
possible to complete the analysis by the end of the work day, the run may be 
left to complete itself unattended as long as appropriate planning is made for 
either overnight operation or Auto Stop. 

1. 24 hrs / day operation in DRC mode: 

a. To reduce startup time in the mornings, the analyst is encouraged to 
operate the ELAN in DRC mode 24hrs/day during the work week.  This 
eliminates the need for daily 45 minute RF generator warm-up, and 
possibly the need for DRC stability time (if the DRC gas is not off for 
extended periods of time before analysis).  To maintain the instrument 
in DRC mode when not analyzing patient samples, setup multiple 
sample rows in the Samples / Batch window with autosampler position 
n zero (rinse station of autosampler) and wash time of 1800s (30 
minutes).  Repeat this sample row enough times to keep the 
instrument in analysis mode overnight (1 sample with 15 minute wash 
will take ~ 20 minutes). 

2. AutoStop:  If 24 hrs / day ELAN operation is not desired, the instrument 
can shut the plasma off unattended after analysis.  Setup this as follows: 

a. On the “Auto Start / Stop” tab of the Instrument window, enable the 
Auto Stop feature. 

b. Press the “Change” button within the Auto Stop box and set the 
Delayed shutdown time to 5 minutes.  This will rinse the sample 
introduction system of serum matrix before turning off the plasma. 

c. It will be necessary to replace the sample peristaltic pump tubing the 
next day since it will have been clamped shut overnight. 

c. Equipment Maintenance:  Analysts are expected to follow a 4-day analysis / 1-
day maintenance schedule in the laboratory.   

i. ICPMS Maintenance:  On the maintenance day, perform all maintenance per 
the Inorganic Toxicology and Nutrition Branch ELAN ICP-MS Weekly 
Maintenance SOP.  All equipment maintenance should be documented in the 
instrument logbook. For this method we can not use straight ethanol to rinse 
the sample introduction system, otherwise the probe and tubing will be clogged 
because of the precipitation of the serum protein. Use the >18 Mega-ohm·cm 
water to rinse the whole system whenever it is necessary.   



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 48 of 73 
 

 

ii. Data Backup:  Data on the ELAN computer will be backed up via two backup 
routines.   

1. Daily Backups to External Hard Drive:  Automatic backups of the “elandata” 
directory and all subdirectories should be programmed to occur each night 
onto an external hard disk. 

2. Weekly Backup to CD:  Backup all files in the active “elandata” directory 
and all subdirectories onto one recordable compact disc during the weekly 
maintenance SOP.  When the active “elandata” directory on the ICP-DRC-
MS computer hard drive becomes too large to fit onto a single recordable 
compact disk, the oldest data can be removed from the computer to make 
it easier to backup the entire directory weekly.  This can usually be done 
annually. 

a. Backup the oldest data on the hard drive to two duplicate compact 
disks and verify that the files on the CD are readable 

b. Label them with the name of the instrument, the date range of the data, 
the current date, your name, and “Copy 1 of 2” or “Copy 2 of 2” 

c. After verifying that the CDs are readable, the oldest, backed up data 
can be deleted from the ICP-MS computer hard drive. 

d. It is best to not store duplicate copies in the same location. 

 

9) Interpretation of the Results 

a. Reportable Range:  Serum multi-element values are reportable in the range 
between the method LOD and the highest concentration verified accurate by bi-
annual calibration verification tests (see Table 8 p.52 in the Appendix). For 
example, if a serum Se value is less than the method LOD, report it as < “LOD” 
g/L where “LOD” is the numerical LOD.  Above the highest concentration 
verified, extra dilutions are made of the serum sample to bring the concentration 
within the verified range.  

b.  Reference Ranges (Normal Values):  In this method the normal reference 
ranges (see Appendix, Table 10 p.53) for these elements in serum fall within the 
range of the calibrators. 

c. Action Levels:  There is no routine notification for levels of every analyte 
determined with this method.  The protocol for supervisors reporting elevated 
results to medical personnel is defined according to the study protocol. 

10)   Method Calculations 

a. Method Limit of Detection (LODs):  The detection limits for elements in serum 
specimens are based on 3 times the concentration standard deviation of serum 
blanks (named sblkchk1 or sblkchk2) analyzed in at least 20 separate runs.  
Method LODs are re-evaluated periodically.  
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b. Method Limit of Quantitation (LOQ):  The Division of Laboratory Sciences does 
not currently utilize limits of quantitation in regards to reporting limits [9]. 

c. QC Limits:  Quality control limits are calculated based on concentration results 
obtained in at least 20 separate runs.  It is preferable to perform separate 
analyses on separate days and using multiple calibrator lot numbers, 
instruments, and analysts to best mimic real-life variability.  The statistical 
calculations are performed using the SAS program developed for the Division of 
Laboratory Sciences (DLS_QC_compute_char_stats.sas). 

 

11)   Alternate Methods for Performing Test and Storing Specimens If Test System 
Fails: 

If the analytical system fails, the analysis may be setup on other ELAN DRC 
instruments in the laboratory.  If no other instrument is available, store the 
specimens at ≤ 4°C until the analytical system can be restored to functionality.  If 
interruption longer than 4 weeks in anticipated, then store serum specimens at           
≤ -20°C. 
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Appendix A.  Ruggedness Testing Results. 
 
Parameter Test#1: Evaluate the impact on analysis results if the set RF power is 
increased to 1600W (instrument maximum) or decreased to 1150W (by 20%) for the 
analytical run. 
Test Details:  
1. Three different PF power settings were tested in separately prepared, consecutive 

runs on the instrument without turning off the plasma. At least 15 minutes stabilization 
time was allowed between each run after the RF power was changed. “Junk urine” 
samples (20) were analyzed between the beginning and ending QC of each run. All 
other method parameters were kept per method. 

2. Run #1 (method default, 1450W). 
3. Run #2 (decreased RF power by 20% to 1150W). 
4. Run #3 (increased RF power to instrument maximum, 1600W). 
5. Run #4 (increased RF power to instrument maximum, 1525W). 
 

  

Parameter Test 1 Results.  
Test performed 4/2-5/17/2010; by Gulchekhra Shakirova.  

QC 
Pool ID 

RF Power Tested Zn (µg/dL) Cu (µg/dL) Se (µg/L) 

LS-03601b 

Characterized Mean 
2SD Range 

50.7 
41.9 - 59.5 

64.9 
61.9 – 67.9 

75.0 
66.7 – 83.3 

1150W (Reduced) 52.5 63.1 75.6 

1450W  (Per Method) 49.0 62.7 70.1 

1525W (Increased) 43.3 63.4 75.7 

1600W (Increased) 54.1 63.9 75.6 

HS-03601b 

Characterized Mean 
2SD Range 

175 
142 – 209 

203 
191 – 215 

144 
130 – 157 

1150W (Reduced) 178 197 145 

1450W (Per Method) 168 196 146 

1525W (Increased) 157 201 145 

1600W (Increased) 178 199 149 
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Appendix A.  Ruggedness Testing Results (continued). 
 
Parameter Test#2: Evaluate the impact on analysis results if the Cell Gas Flow Rate is 
increased or decreased by 20% for the analytical run. 
 
Test Details: 
1. Three different Cell Gas Flow Rates were tested in separately prepared, consecutive 

runs on the instrument without turning off the plasma. At least 15 minutes stabilization 
time was allowed between each run after the axial field voltage was changed. “Junk 
urine” samples (20) were analyzed between the beginning and ending QC of each 
run. All other method parameters were kept per method. 

2. Run #1 (method default = 0.5mL/min). 
3. Run #2 (decreased Cell Gas Flow Rate by 20% to 0.4mL/min). 
4. Run #3 (increased Cell Gas Flow Rate by 20% to 0.6mL/min). 

 

 
  

Parameter Test 2 Results.  
Test performed 5/6/-5/17/2010 by Gulchekhra Shakirova.  

QC 
Pool ID 

Cell Gas Flow Rate  Tested Zn (µg/dL) Cu (µg/dL) Se (µg/L) 

LS-03601b 

Characterized Mean 
2SD Range 

50.7 
41.9 - 59.5 

64.9 
61.9 – 67.9 

75.0 
66.7 – 83.3 

0.40 mL/min (Reduced) 49.5 65.3 80.7 

0.50 mL/min (Per Method) 49.5 67.6 73.8 

0.60 mL/min (Increased) 47.8 63.4 75.6 

HS-03601b 

Characterized Mean 
2SD Range 

175 
142 – 209 

203 
191 – 215 

144 
130 – 157 

0.40 mL/min (Reduced) 167 204 152 

0.50 mL/min (Per Method) 169 205 146 

0.60 mL/min (Increased) 171 203 147 
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Appendix A.  Ruggedness Testing Results (continued). 
 
Parameter Test#3: Evaluate the impact on analysis results if the RPq is increased or 
decreased by 20% for the analytical run. 
 
Test Details: 
1. Three different RPq settings were tested in separately prepared, consecutive runs 
on the instrument without turning off the plasma. At least 15 minutes stabilization time 
was allowed between each run after the axial field voltage was changed. “Junk urine” 
samples (20) were analyzed between the beginning and ending QC of each run. All 
other method parameters were kept per method. 
2. Run #1 (method default DRC RPq: 0.56). 
3. Run #2 (decreased DRC RPq 20%: 0.70). 
4. Run #3 (increased DRC RPq 20%: 0.84). 
 

Parameter Test 3 Results.  
Test performed 5/6-5/17/2010 by Gulchekhra Shakirova.  

QC 
Pool ID 

RPq Tested Zn (µg/dL) Cu (µg/dL) Se (µg/L) 

LS-03601b 

Characterized Mean 
2SD Range 

50.7 
41.9 - 59.5 

64.9 
61.9 – 67.9 

75.0 
66.7 – 83.3 

DRC RPq:0.56 
(Reduced by 20%) 

52.5 63.1 70.8 

DRC RPq:0.70 
(Per Method) 

49.0 62.7 70.1 

DRC RPq:0.84 
(Increased by 20%) 

54.1 63.9 75.9 

HS-03601b 

Characterized Mean 
2SD Range 

175 
142 – 209 

203 
191 – 215 

144 
130 – 157 

DRC RPq:0.56 
(Reduced by 20%) 

178 197 129 

DRC RPq:0.70 
(Per Method) 

168 196 131 

DRC RPq:0.84 
(Increased by 20%) 

178 199 145 
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Appendix A.  Ruggedness Testing Results (continued). 
 
Parameter Test#4: Evaluate the impact on analysis results if the axial field voltage 
(AFV) is increased or decreased by 20% for the analytical run. 
 
Test Details: 
1. Three different DRC AFV were tested in separately prepared, consecutive runs on 
the instrument without turning off the plasma. At least 15 minutes stabilization time was 
allowed between each run after the axial field voltage was changed. “Junk urine” 
samples (20) were analyzed between the beginning and ending QC of each run. All 
other method parameters were kept per method. 
2. Run #1 (method default DRC AFV = 450). 
3. Run #2 (decreased DRC AFV to 360) 
4. Run #3 (increased DRC AFV to 500) 
 

 
  

Parameter Test 4 Results.  
Test performed 5/6/-5/17/2010 by Gulchekhra Shakirova.  

QC 
Pool ID 

Axial Field 
Voltage Tested 

Zn (µg/dL) Cu (µg/dL) Se (µg/L) 

LS-03601b 

Characterized Mean 
2SD Range 

50.7 
41.9 - 59.5 

64.9 
61.9 – 67.9 

74.9 
66.7 – 83.3 

AFV-360 
(Reduced) 

46.9 61.5 72.8 

AFV-360 
(Per Method) 

47.2 64.0 75.0 

AFV-500 
(Increased) 

48.6 63.5 74.1 

HS-03601b 

Characterized Mean 
2SD Range 

175 
142 – 209 

203 
191 – 215 

144 
130 – 157 

AFV-360 
(Reduced) 

163 195 142 

AFV-360 
(Per Method) 

170 205 147 

AFV-500 
(Increased) 

168 200 146 



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 54 of 73 
 

 

Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #5:  Method descriptions and SOP assume preparation and analysis on 
same day.  Evaluate the impact on analysis results if the analytical run is prepared to 
analyze but circumstances do not allow for analysis to occur until 24 or 48 hours later.  
 
Test Details (Part 1):  
1. Three separate run sets (A, B, and C) were prepared at one sitting from the same 

starting materials.  Set ‘A’ was analyzed immediately.  Set’s ‘B’ and ‘C’ were stored 
at room temperature for 24 and 48 hours, respectively before analysis.  “Junk serum 
samples (20) were analyzed between the beginning and ending QC of each run, 
making each a normal length run.  All other method parameters were kept per 
method.  Results in table are average of beginning and ending QC. 

2. On day two, a fresh run set (“D”) was prepared and analyzed immediately for 
comparison to results from set “B” (Run 2 of the day.  Results not shown).   

3. On day three, another fresh run set (“E”) was prepared and analyzed immediately for 
comparison to results from set “C” (Run 2 of the day.  Results not shown). 

 
Parameter Test 5 Results (Part 1).  Test performed 3/11/2010 to 3/15/2010 
by Gulchekhra Shakirova using ELAN DRC-2R. 
QC 
ID 

Time from 
Preparation 

Zn (µg/dL) Cu (µg/dL) Se (µg/L) 

LS
-0

36
01

b 

Characterized Mean 
±2SD Range 
±3SD Range 

50.7 
41.9 – 59.5 
37.5 – 63.9 

64.9 
61.9 – 67.9 
60.4 – 69.4 

74.9 
66.7 – 83.3 
52.5 – 87.4 

Fresh Preparation 47.2 65.7 74.7 

After 24 hours 51.9 67.1 
102 

(150, 54.5) 

After 48 hours 51.0 66.2 
57.1 

(123, -8.8) 
 

H
S

-0
36

02
b 

Characterized Mean 
±2SD Range 
±3SD Range 

175 
142 – 209 
126 - 225 

203 
191 – 215 
185 - 221 

144 
130 – 157 
124 – 164 

Fresh Preparation 160 203 143 

After 24 hours 167 203 145 

After 48 hours 174 207 
130 

(98.2, 161) 
 
Note: The serum ICP-MS method is rugged for Zn and Cu to delays in analysis of 
samples after preparation for up to 48 hrs. and not rugged for Se to delay in analysis of 
samples after preparation for even 24 hrs. Suggested maximum amount of time from 
sample prep to end of the run is 450 min, which consists of 3 analytical runs. 
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Appendix A.  Ruggedness Testing Results. (continued) 
 
Parameter Test #5: 
 
Test Details (Part 2): Due to the observations in test one for selenium, a shorter time 
frame was examined in part two of this test. 
 

1. Seven preparations of the low bench QC serum material were made at the 
beginning of the experiment.  Each of these seven preparations were 4x the 
normal preparation volume (4 preparations into each vial).   

2. Four consecutive runs of the serum method were then carried out.  Each run 
included 

a. blanks, calibrators, and run judge QC (beginning and ending) which were 
prepared immediately prior to the beginning of each run. 

b. Seven preparations of the low bench QC which were prepared 
immediately prior to the beginning of each run. 

c. Measurements of the seven preparations of the low bench QC pool which 
were prepared before the first run (these were alternated with the freshly 
prepared low bench QC sequentially throughout the run). 

 

 
Note: The serum ICP-MS method is rugged for Zn and Cu to delays in analysis of 
samples after preparation for up to 48 hrs (see part 1). The method is only rugged to 
delays in analysis for selenium for up to approximately 7 hours (one 90 patient sample 
run, or two 40 patient sample runs). 
  

Parameter Test 5 Results (Part 2).  
Test performed 5/6/2010 to 5/17/2010 by Gulchekhra Shakirova, DRC2-R.  

QC 
Pool ID 

Axial Field 
Voltage Tested 

Zn (µg/dL) Cu (µg/dL) Se (µg/L) 

LS-03601b 

Characterized Mean 
2SD Range 
3SD Range 

50.7 
41.9 – 59.5 
37.5 – 63.9 

64.9 
61.9 – 67.9 
60.4 – 69.4 

74.9 
66.7 – 83.3 
52.5 – 87.4 

Run 1  
(up to 139 min elapsed) 

41.8 58.3 72.5 

Run 2 
(up to 303 min elapsed) 

43.1 60.0 71.3 

Run 3 
(up to 427 min elapsed) 

51.4 65.9 71.0 

Run 4 
(up to 576 min elapsed) 

43.5 59.1 54.7 
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Appendix B.  Tables and Figures. 
 

Table 1.  Instrument and Method Parameters 
 
Instrument:  PerkinElmer ELAN DRCPlus or DRC II ICP-MS 
                      CETAC ASX 500 series autosampler (tray B) 
Optimization Window Parameters 
RF power 1.45 KW 
Plasma Gas Flow (Ar) 15 L/min 
Auxiliary Gas Flow (Ar) 1.2 L/min 
Nebulizer Gas Flow (Ar) 0.90 – 1.0 L/min (optimized as needed for sensitivity) 
Ion Lens Voltage(s) AutoLens (optimized as needed for sensitivity) 
QRO, CRO, CPV, 
Discriminator Threshold 

Optimized per instrument by service engineer, or advanced 
user. 

Parameters of x-y alignment, nebulizer gas flow, AutoLens voltages, mass calibration, 
and detector voltages are optimized regularly.  Optimization file name = default.dac. 
Configurations Window Parameters 
Cell Gas Changes 
Pause Times 

Pressurize Delay (From Standard to DRC mode) = 60 
Exhaust Delay (From DRC to Standard mode) = 60 
Flow Delay (Gas changes while in DRC mode) = 25 
Channel Delay (Gas channel change in DRC mode) = 25 

File Names & Directories 
Method file names Serum panel 1_methITS005A_sblk.mth 

 
Serum panel 1_methITS005A_aqblk.mth 

Dataset Create a new dataset subfolder each day. Name as “2006-
0718” for all work done on July 18, 2006 

Sample File Create for each day’s work 
Report file name For sample results printouts 

cdc_quant comprehensive.rop 
 
For calibration curve information 
CDC_Quant Comprehensive (calib curve info).rop 

Tuning Default.tun 
Optimization Default.dac 
Calibration N/A 
Polyatomic elan.ply 
Report Options 
Template (transferring 
results to the database) 

CDC_Database Output.rop 
Report Format Options:  select only “Use Separator” 
File Write Option:  Append 
Report File name:  include date, instrument, and group 
being analyzed in file name (i.e. 20060724a_DRCC_HM-
0364.txt) 
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Method Parameters 
 
Method Parameters:  Timing Page (see Figure 1 in the Appendix) 
Sweeps/reading 90 
Readings/replicate 1 
Replicates 3 
Enable QC Checking Off 
Isotopes Monitored   
and Internal Standard 
Associations 
(Exact Mass) 

use 71Ga as an internal standard 
64Zn (63.9291), 65Cu (64.9278), 71Ga (70.9247), 78Se 
(77.9173) 
 

Dwell Times 30 ms for 64Zn, 65Cu, 71Ga (70.9247), 78Se (77.9173) 
Scan Mode Peak Hopping for all isotopes (1 MCA channel) 
DRC channel A Gas 
Flow Rate 

Ammonia (5-7 psig delivery pressure) 
0.5 L/min * 
(*Optimized per instrument, every 6-12 months) 

RPa 0 for all isotopes 
RPq 0.7 for all isotopes 
     Method Parameters:  Processing Page (see Figure 2 in the Appendix) 
Detector mode Pulse 
Process Spectral Peak N/A 
AutoLens On 
Isotope Ratio Mode Off 
Enable Short Settling 
Time 

Off 

Blank subtraction After internal standard 
Measurement units Cps 
Process Signal Profile N/A 
      
     Method Parameters:  Equations Page (see Figure 3 in the Appendix) 
Equations On 64Zn, use “-0.035297 * Ni60” 

On 78Se, use “-0.030461 * Kr83” 
     Method Parameters:  Calibration Page (see Figure 4 in the Appendix) 
Calibration Type External Std. 
Curve type Simple Linear  
Sample units g/L 
Calibration Standard 
Concentrations (g/L) 

Zn:  30, 90, 300, 900, 3,000 
Cu:  30, 90, 300, 900, 3,000 
Se:  3, 9, 30, 90, 300 

     Method Parameters:  Sampling Page (see Figure 5 in the Appendix) 
“Peristaltic Pump Under 
Computer Control” 

On 

Sample Flush ~35s at 24 rpm (optimize time so that solution reaches 
nebulizer before Read Delay begins) 
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Read Delay 40s at 18 rpm 
Wash 60s at 24 rpm 
Autosampler Locations 
of Blanks and Standards 

For calibration curve (points to serum blank) 
Serum panel 1_methITS005A_sblk.mth 
Serum Blank and Calibration Stds 1 – 5 in autosampler 
positions 101 – 106. 
 
For QC & patient sample analysis (points to aqueous blank) 
Serum panel 1_methITS005A_aqblk.mth 
Aqueous Blank in autosampler position 109.  
 
See figures 3a through 3e in Appendix B for other default 
autosampler settings. 

 
 

Table 2. Suggested Maximum Analyte 
Concentrations for Base Serum. 

Analyte Concentration (µg/L) 
Zn 400 (40 ug/dL) 
Cu 500 (50 ug/dL) 
Se 70 

 
 

 
  

Table 3.  Concentrations of Analytes in the Multi-Element Intermediate Stock 
Standard from High Purity Standards. 
 

Analyte 

Intermediate Stock Standard 
Concentrations (mg/L) 
High Purity Standards 

Item # SM-2107-013 (2% HNO3) 
Cu 300 
Zn 300 
Se 30 

 V and Mn are also in the mix at 1 and 2 mg/L for future R&D work 
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Table 5.  Acceptable ways to perform two consecutive analytical runs, 
bracketing with bench quality control samples. 
Setup 1* Setup 2 (typical)* 

Run #1 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 

Run #2 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 
 
* Use >18 Mega-ohm·cm water to 
rinse the system for 30 min. 
between the two runs. 

Run #1 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 

Run #2 
Calibration Standards 
Low Bench QC 
High Bench QC 
     patient samples 
Low Bench QC 
High Bench QC 
 
* Use >18 Mega-ohm·cm water to 
rinse the system for 30 min. 
between the two runs. 
 

 
 
 
 
 
 

Table 4.  Preparation of Multi-Element Intermediate Working Standards  
               (for calibrators and calibration verification).

Standard # Units 1 2 3 4 5 
Calib 

Verification 
Vol of Flask 

(mL) 
 100 100 100 100 100 100 

Vol Spike of  
Int. Stock  
Std. (mL) 

 0.010 0.030 0.100 0.300 1.00 3.00 

 Concentrations  

Zn 
ug/L 

ug/dL* 
30 
3 

90 
9 

300 
30 

900 
90 

3,000 
300 

9,000 
900 

Cu 
ug/L 

ug/dL* 
30 
3 

90 
9 

300 
30 

900 
90 

3,000 
300 

9,000 
900 

Se ug/L 3 9 30 90 300 900 
* Use ug/dL units for Zn and Cu in the ELAN software and for reporting. 
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Table 6.  A typical SAMPLE/BATCH window. 
AS 
Location* 

Sample ID Measurements Action Method 

5 DRCstability1 Run sample . . ._sblk.mth 
5 DRCstability2 Run sample . . ._sblk.mth 
5 DRCstability3 Run sample . . ._sblk.mth 
5 DRCstability4 Run sample . . ._sblk.mth 
                          Continue DRC stability samples  . . .  
5 DRCstability9 Run sample . . ._sblk.mth 
5 DRCstability10 Run sample . . ._sblk.mth 
100 Sblkchk1 Run blank, standards, and sample ** . . ._sblk.mth 
101 Sblkchk2 Run sample . . ._sblk.mth 
127 Aq Blk Check Run blank and sample ¥   . . ._aqblk.mth 
138 L Bench QC Run sample . . ._aqblk.mth 
134 H Bench QC Run sample . . ._aqblk.mth 
46 Sample 1 Run sample . . ._aqblk.mth 
47 Sample 2 Run sample . . ._aqblk.mth 
48 
. 
. 
. 

Sample 3 
. 
. 
. 

Run sample 
. 
. 
. 

. . ._aqblk.mth 

. 

. 

. 
140 Blind QC Run sample . . ._aqblk.mth 
139 L Bench QC Run sample . . ._aqblk.mth 
135 H Bench QC Run sample . . ._aqblk.mth 
* The exact autosampler positions of QCs and patient samples do not have to be those 
shown above, but the order in which these are run should be as shown above. 
 
** When executing this row, the ELAN will first analyze the serum blank at AS position 101, 
then standards 1-5 at autosampler positions 102-106, then the “sblkchk1” sample at A/S 
position 100.  The sampling information about AS positions 101-106 are stored in the “sblk” 
method file.   
 
¥  When executing this row, the ELAN will first analyze the aqeous blank at AS position 109, 
then the “Aq Blk Check” at AS position 20.  The sampling information about AS positions 
109 is stored in the “aqblk” method file.   
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Table 7.  Preparation of Multi-Element Intermediate Working Standards 

Dilution ID 
Water 
(L) 

Base Serum 
(L) 

AQ Intermediate 
Working Standard 

(L) 

Patient or QC 
Serum sample 

(L) 

Diluent * 
(L) 

AQ Blank 300 - - - 4,200 
Serum Blank and 

sblkchk 
150 150 - - 4,200 

Working Calibrators  
 

or 
 

Working Calibration 
Verification Standards 

- 150 150 - 4,200 

Patient Serum or  
Serum-Based QC 

150 - - 150 4,200 

Patient Serum 
2x Dilution H 

225 - - 75 4,200 

Patient Serum 
10x Dilution H 

570 - - 30 8,400 

 
H Extra dilution is performed on serum samples whose concentration is greater than the concentrations listed in 
Table 8 in the Appendix (linearity of the method has been documented up to these concentrations).  Any extra 
level of dilution can be prepared as long as the 14:15 ratio of diluent to total dilution volume is maintained.  Use 
of the lowest possible dilution level is preferred because matrix differences may lead to different observed 
concentration results as the sample dilution becomes greater (i.e. 2x dilution is preferred over 10x if 2x is 
sufficient to dilute analyte into the documented linearity range).  

 
* Dispense diluent using the Digiflex as 2 portions which add to the total volume required.  For example, when 
preparing a serum blank above, do the preparation in 2 steps.  Step 1:  150 L water + 2100 L diluent.  Step 
2:  150 L base serum + 2100 L diluent.  This method of dispensing helps flush the smaller volume being 
added from the pipette with diluent. 

 
 
 

 
 
 
 
 

Table 8.  Range of Reporting and Calibration Verification Requirements. 

Analyte 
Highest  Conc. (g/L) Verified in 

Calibration Verification 
(“Range of Linearity Tested”, or “RLT”)  * 

Zn 9,000 (900 ug/dL) 
Cu 9,000 (900 ug/dL) 
Se 900 

* If observed results are not within 10% of target, investigate the problem with 
the involvement of the lab su ervis r. 
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Table 9.  Boundary Concentrations for Serum. 

Analyte 
(units) 

2nd Lower 
Boundary 
(“2LB”)** 

1st Lower 
Boundary 
(“1LB”)* 

1st Upper 
Boundary  
(“1UB”) * 

2nd Upper 
Boundary 
(“2UB”) ** 

Range  
Maximum 

(“Lim Rep Delta”) † 
Zn (g/dL) 35 35 120 240 17 
Cu (g/dL) 10 10 300 600 20 
Se (g/L) 45 45 165 330 20 

* Typically, the 1st upper boundaries (1LB and 1UB) are based on percentiles of non-
weighted, non-creatinine corrected concentration results from NHANES.  In the absence of 
that data, these boundaries can be based on normal ranges reported in the literature.   The 
concentrations assigned to these boundaries is determined by study protocol but default 
concentrations are listed in this table.  Report the original result, as long as the confirmation is 
within 10% of the original.  Continue repeat analysis until a concentration can be confirmed. 
 
** These 2nd boundaries (2LB and 2UB) are set to 0.5x the 1LB and 2x the 1UB, respectively.   
The concentrations assigned to these boundaries is determined by study protocol but default 
concentrations are listed in this table.  Regardless of the study, the analyst should specifically 
address patient results confirmed to be less than the 2LB or greater than the 2UB to the QC 
reviewer as unusually low or high results.   
 
† Range maximum is the range of the three replicate readings for a single sample analysis.  
This value is also called the “Lim Rep Delta” in the database which handles data for the 
Inorganic Toxicology and Nutrition Branch.  If the range of replicate readings is greater than 
the range maximum, and represents greater than a 10% relative standard deviation for the 
measurement, do not use the measurement for reporting.   

 

Table 10.  Reference Ranges for Serum Concentrations Se in 
g/L; Zn and Cu in g/dL.  

Analyte Reference Ranges 
Zn 70-120 [10] 
Cu 20-302 [10] 
Se 95-165 [11], [14] 
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Appendix (continued):  Figures 
 

Figure 1.  Suggested configuration of 
tubing and devices for liquid handling. 
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Appendix B (continued) 
Figure 2a.  ELAN ICP-DRC-MS Method Screen Shots (timing page). 
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Appendix B (continued) 
Figure 2b.  ELAN ICP-DRC-MS Method Screen Shots (processing page). 
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Appendix B (continued). 
Figure 2c.  ELAN ICP-DRC-MS Method Screen Shots (equation page). 
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Appendix B (continued). 
Figure 2d.  ELAN ICP-DRC-MS Method Screen Shots (calibration page). 
 

 

V
 a

nd
 M

n 
ar

e 
on

ly
 R

es
ea

rc
h 

an
d 

D
ev

el
op

m
e

nt
.  

N
ot

 fo
r 

C
lin

ic
a

l 
R

ep
or

tin
g.

  
R

em
ov

e 
th

es
e 

ro
w

s 
w

he
n 

an
al

yz
in

g 
an

y 
cl

in
ic

al
 

sa
m

pl
es

 (
no

n-
P

ro
fic

ie
nc

y 
T

es
tin

g)
. 



Serum Multi-Element ICP-DRC-MS             
 
IRAT-DLS Method Code:  ICPDRCMS-3006.1                                    Page 68 of 73 
 

 

 
Appendix B (continued). 
Figure 2e.  ELAN ICP-DRC-MS Method Screen Shots (sampling page). 
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Appendix B (continued). 
Figure 2f.  ELAN ICP-DRC-MS Method Screen Shots (report page). 
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Appendix B (continued). 
Figure 3a.  ESI SC4 Autosampler Screen Shots used (Main page).   
 
Additional flush times and “Max Rinse Time” are default, but can be optimized for best 
reduction of elemental carry-over between samples.  Tray types can be changed to 
allow for different volumes of diluted sample digests.  ‘FAST control’ should be 
unchecked.  Rinse and additional flush times for eliminating carry-over from one sample 
to the next while using the minimum amount of rinse solution. 
 
A rinse time of -1 causes the rinse station to be skipped. 
A rinse time of 0 causes the probe to only dip into the station, but spends no time there. 
 
Additional flush times can be optimized to keep the rinse station full while not using too 
much rinse solution.  The inner diameter size of the tubing providing the rinse solution to 
the rinse station determines how quickly the station will fill.  Various sizes are available 
for purchase or can be made in the laboratory. 
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Appendix B (continued). 
Figure 3b.  ESI SC4 Autosampler Screen Shots used (Configuration).   
Appendix B (continued). 
  “High Speed” option is to only be used for ‘High Speed’ models of the SC4 (look for 
“HS” in serial number).  Speeds and accel / decel values can be optimized per analyst 
preference and to minimize droplet splatter off of probe. 

 
 
Figure 3c .  ESI SC4 Autosampler Screen Shots used (“Communication” page).  
Communication ports will differ depending on available ports on instrument control 
computer. 
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Appendix B (continued). 
Figure 3d.  ESI SC4 Autosampler Screen Shots (5x12 Rack Setup window). 
Settings are approximate.  To be sure the loop is filled, the probe should go down close 
to the bottom of the cup, but not touch. Optimize retraction speed for least droplet 
splatter. 

 
 
Figure 3e.  ESI SC4 Autosampler Screen Shots (50mL Tube Rack Setup window). 
Settings are approximate.  To be sure the loop is filled, the probe should go down close 
to the bottom of the cup, but not touch. Optimize retraction speed for least droplet 
splatter. 
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Navajo Birth Cohort Study Protocol for Cellular immunological laboratory protocol 

 Flow cytometry protocol for lymphocyte phenotypization 

1. For each sample, label six 12 x 75 mm or 15 ml Falcon tubes, A through F. Also label 
each tube with sample identification number or barcode. 

2. Place 20 μl of reagent A into tube A, 20 μl of reagent B into tube B, 20 μl of reagent C 
into tube C, 20 μl of reagent D into tube D, 20 μl of reagent E into tube E, and 20 μl of 
reagent F into tube F. 

3. For each sample, use a fresh micropipette tip and add 100 μl of anticoagulated whole 
blood sample into the bottom of each of the six labeled tubes. The required WBC 
concentration is 3,500-9,800 cells/ μl blood.  Vortex thoroughly at low speeds for 3 
seconds and incubate for 15 to 30 minutes at room temperature (20-25 oC). During this 
incubation protect samples from direct light. Prevent blood from running down the side of 
the tube, pipette directly into the staining reagents.  

4. Dilute 10X Lysing Solution to 1X following the instructions for Reagent G. The 1X 
solution is stable at room temperature for 1 month. Add 2 mL of this 1X lysing solution to 
each tube. Immediately vortex them at low speed for 3 seconds and incubate for 10 to 
12 minutes at room temperature in the dark. Do note exceed 12 minutes as the lysis can 
destroy the stained lymphocytes as well.  

5. Immediately after incubation, centrifuge tubes at 300x g for 5 minutes at room 
temperature.  

6. Aspirate the supernatant, leaving approximately 50 μl of residual fluid in each tube to 
avoid disturbing the pellet. 

7. Vortex thoroughly at low speed to resuspend the cell pellet in the residual fluid and then 
add 2 mL PBS to each tube. Vortex thoroughly at low speed for 3 seconds. Centrifuge at 
200 x g for 5 minutes at room temperature. 

8. Aspirate the supernatant, leaving appr. 50 μl of residual fluid in the tube to avoid 
disturbing the pellet. 

9. Vortex thoroughly at low speed to resuspend the cell pellet in the residual fluid and then 
add 0.5 mL of 1% paraformaldehyde to each tube. Vortex thoroughly for 3 seconds. 
Make sure that the cells are mixed well with the fixing solution. 

10. The cells are ready to be analyzed on the flow cytometer. Cap or cover tubes and store 
them at 2- 8 oC in the dark till analysis. Analyze the fixed cells within 24 hours after 
staining. 

 

Principles of procedure 

When the monoclonal antibody reagents are added to human whole blood, the flurorochrome-
labeled antibodies bind specifically to antigens on the surface of leucocytes. The stained 
samples then treated with Lysing Solution to lyse erythrocytes and washed prior to flow 
cytometry analysis. 

An aliquot of the stained participant sample is introduced into the flow cytometer and passed in 
a narrow stream through the path of a laser beam. The stained cells fluoresce when excited by 
the laser beam and the emitted light is collected and processed by the flow cytometer. The use 
of two fluorochromes permits simultaneous two-color analysis because each fluorochrome emits 
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light at different wavelength when excited at 488 nm by an argon-ion laser. The FITC-stained 
lymphocytes emit yellow-green light (maximum 515 nm) while the PE-stained lymphocytes emit 
red-orange light (580 nm).  

For each sample, the lymphocyte acquisition gate set with LeucoGATE (tube A) and the 
fluorescence markers determined using the Control (tube B) are used to analyze the 
subsequent tubes (C through F). The software uses quadrant correction option; the lymphocyte 
subpopulations in tube C through F are enumerated and then expressed as percentages of 
lymphocytes in the acquisition gate. 

Reagents 

Reagent A – LeucoGATE (CD45/CD14) LeucoGATE is used to define and evaluate the light-
scatter gate that distinguishes lymphocytes from granulocytes, monocytes, unlysed or nucleated 
red blood cells and debris. The reagent contains FITC-labeled CD45 for identification of 
leucocytes, and PE-labeled CD14 for identification of monocytes. 

Reagent B – Control This isotype IgG control is used to set the lowest quadrant markers around 
unstained (negative) lymphocytes. This reagent helps to establish nonantigen-specific antibody 
binding, in particular that caused by Fc receptors. 

Reagent C – CD3/CD19 This reagent is used to enumerate T and B lymphocytes. It contains 
FITC-labeled CD3 for identification of T lymphocytes and PE-labeled CD19 for identification of B 
cells. 

Reagent D – CD4/CD8. This stain is used to simultaneously characterize helper/inducer and 
suppressor/cytotoxic lymphocytes. It contains FITC-labeled CD4 for identification of 
helper/inducer T lymphocytes and PE-labeled CD8 for identification of suppressor/cytotoxic T 
lymphocytes. 

Reagent E – CD+/Anti-HLA-DR This reagent is used to enumerate T lymphocytes, DR+ non-T 
lymphocytes (mostly and primarily B cells) and activated T lymphocytes. It contains FITC-
labeled CD3 for identification of T lymphocytes and PE-labeled anti-HLA-DR for identification of 
DR+ non-T cells and activated T lymphocytes. 

Reagent F – CD3/CD16+CD56 This stain is applied to identify T and NK lymphocytes. It 
contains FITC-labeled CD3 for identification of T lymphocytes. It also contains PE-labeled CD16 
and PE-labeled CD56 for identification of NK cells as well T-lymphocyte subsets. 

Reagent G – 10X Lysing Solution. This reagent contains 10X buffered Lysing Solution, with less 
than 50% diethylene glycol and less than 15% formaldehyde. When stored at room temperature 
this solution is stable until expiration date. 

The reagents are under the US Patent No. 4,895,796. 

Detection: fluorescence activity will be detected by flow cytometer, Becton Dickinson FACScan 
machine BD Catalog #34001010 or Accuri portable flow cytometer machine, Accuri, Ann Arbor, 
MI).  



Humoral immunological measurements 

Serum cytokine measurements 

We will address inflammatory and/or hypersentitivity conditions among NBC participants 
applying comprehensive multiplexing technology and Luminex 100™ detection system 
(Luminex Co. Austin, TX) for serum cytokine production.  

Cytokines play a central role in mediating both cellular and humoral immune responses against 
invading pathogens and tumor cells. Many of them also control the growth differentiation, 
effector function and survival of all cells in the body. Human 10-plex high sensitivity 
cytokine/chemokine panel (IL-1β, IL-2, IL-4, IL-5, IL-6, IL-8, IL-10, INF-γ, TNF-α, and GM-CSF) 
will be used to detect presence or absence of inflammatory cytokines, with special attention paid 
to uncovering potential imbalances in Th1/Th2 immune responses. 

 

Assay methodology Cytokine measurements using multiplexing technique 

Figure of the assay of determination of cytokines using flow cytometry technique 

 



This methodology is the most advanced technology  of using very small amount of 
patient samples. The assay requires only 50 µl of serum samples and measures the 
entire panel of cytokines parallel from only 1 sample.  This is not only saves a lot of 
smaples, requires less blood donation from participants, but also the mosts ensitve 
technique. The serum cytokines deetcted at the pg/ml detection limits.  

 

Assay detection 

At the UNM Flow Cytopmetry Core Facility xMAP multiplexing technology is readily 
available for this project. The UNM Research Team will use Luminex 100™ detection 
system to quantitate immonoassays  in a 96 well format.   
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	a. Interferences Addressed by This Method
	a. Clinical Relevance:
	This method is used to achieve rapid and accurate quantification of fifteen elements of toxicological and nutritional interest including Antimony (Sb), Arsenic (As), Barium (Ba), Beryllium (Be), Cadmium (Cd), Cesium (Cs), Cobalt (Co), Lead (Pb), Manganese (Mn), Molybdenum (Mo), Platinum (Pt), Strontium (Sr), Thallium (TI), Tin (Sn), Tungsten (W), and Uranium (U).  The method may be used to screen urine when people are suspected to be acutely exposed to these elements or to evaluate chronic environmental or other non-occupational exposure. [1-4].  
	Inductively coupled plasma dynamic reaction cell mass spectrometry (ICP-DRC-MS) is a multi-element analytical technique capable of trace level elemental analysis [1-4].  This ICP-DRC-MS method is used to measure either arsenic, a 15 element panel (Antimony, Barium, Beryllium, Cadmium, Cesium, Cobalt, Lead, Manganese, Molybdenum, Platinum, Strontium, Thallium, Tin, Tungsten, and Uranium), or any subgroup of the 15 element panel.
	Liquid samples are introduced into the ICP through a nebulizer and spray chamber carried by a flowing argon stream.  By coupling radio-frequency power into flowing argon, plasma is created in which the predominant species are positive argon ions and electrons and has a temperature of 6000-8000 K.  The sample passes through a region of the plasma and the thermal energy atomizes the sample and then ionizes the atoms.  The ions, along with the argon, enter the mass spectrometer through an interface that separates the ICP (at atmospheric pressure, ~760 torr) from the mass spectrometer (operating at a pressure of 10-5 torr).  The ions pass through a focusing region, the dynamic reaction cell, the quadrupole mass filter, and finally are counted in rapid sequence at the detector allowing individual isotopes of an element to be determined.  The dynamic reaction cell operates in one of two modes.  In ‘standard’ mode the cell is not pressurized and ions pass through the cell to the quadrupole mass filter unaffected.  In ‘DRC’ mode the cell is pressurized with a gas which will collide or react with the incoming ions to either eliminate an interfering ion or change the ion of interest to a new mass which is free from interference.  In this method the instrument is operated in DRC mode when analyzing for cadmium, manganese and arsenic, but in standard mode when analyzing for all of the other analytes.  For arsenic, the reaction cell is pressurized with a mixture of hydrogen (10%) and argon (90%) which causes the breakup of the 40Ar35Cl+ ion which would otherwise interfere with detection of 75As at m/z 75.  When analyzing for cadmium, the reaction cell is pressurized with oxygen.  The 98Mo16O+ ions which would normally interfere with detection of 114Cd at m/z 114 react with the oxygen in the cell creating 98Mo16O2+ and 98Mo16O3+ at masses which no longer represent an interference to 114Cd analysis.  The DRC is also pressurized with oxygen gas when analyzing for 55Mn.  The 39K16O+ ions which would normally interfere with the detection of 55Mn at m/z 55 react with the oxygen in the cell and no longer represent interference to 55Mn analysis.  Electrical signals resulting from the detection of ions are processed into digital information that is used to indicate first the intensity of the ions and then the concentration of the element.  This method was originally based on the method by Mulligan et al. [5].  The DRC portions of the method are based on work published by Tanner et al. [2, 3].  Urine samples are diluted 1+ 9 with 2% (v/v) concentrated nitric acid (and 1.5% ethanol in the case of arsenic).  The diluent for the 15 element panel contains iridium (Ir), rhodium (Rh) for multi-internal standardization.  The diluent for arsenic contains gallium (Ga) for internal standardization.  Nitric acid is used for the purpose of solubilizing and stabilizing metals in solution.  Internal standards are a constant concentration in all blanks, calibrators and samples.  Monitoring the instrument signal ratio of a metal to its internal standard allows correction for instrument noise and drift, and sample-to-sample matrix differences.  Ethanol is used in the case of arsenic for the purpose of providing a constant amount of signal enhancement (carbon effect) across all blanks, calibrators, and samples. 
	It has been determined that a small interference remains at m/z 75 when the urine matrix contains both high chloride and high calcium levels [6].  Even at extreme calcium and chloride levels, this interference is has not been found to be significant (approximately 0.4 g/L).  
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	d. Documentation of System Maintenance
	(1) Computer Maintenance:
	Record any maintenance of computer hardware and ICP-DRC-MS software in the instrument logbook. Place other electronic records relating to integrity of the data and hard drive in the Windows™ event log. Back up the event log on a regular basis by savin...

	(2) Instrument Maintenance:
	Document system maintenance in hard copies of data records (i.e., daily maintenance checklists, PerkinElmer service records, and instrument log book) as well as in electronic records relating to instrument optimization (default.dac), tuning (default.t...



	4. Collecting, Storing, and Handling Specimens; Criteria for Rejecting Specimens
	a. Specimen Type:  Specimen type is urine. No special instructions for fasting or special diets are required of patient or study subjects.
	b. Specimen Collection, Handling and Storage
	(1) No special instructions for fasting, special diets are required.
	(2) The specimen type is urine with preservative (for mercury).  The preservative is a solution of approximately 2 M sulfamic acid and.  It is added for the purpose of preventing loss of mercury from the urine before analysis.  Urine should be mixed with t�
	(3) Optimal amount of specimen is 1.8 mL; minimum amount in a cryo-vial is about 0.75 mL. 500 µL needed for an analysis.
	(4) Acceptable containers for allotment of urine for this method include 15 mL PP centrifuge tubes (e.g., Becton, Dickinson and Company model number 352097). Use sterile collectors for specimen acquisition.
	(5) Screen specimen collection cups, containers and sample tubes for iodine and mercury contamination before use.
	(6) Specimen stability has been demonstrated for 1 year at ( -20 C.
	(7) Specimen characteristics that may compromise test results are indicated above and include high storage temperature or no preservative.
	(8) Specimen handling conditions are outlined in the division protocol for urine collection and handling. Copies are available in the branch, laboratory and special activities specimen-handling offices. The protocol addresses collection, transport, and spe�

	c. Criteria for an Unacceptable Specimen

	5. Procedures for Microscopic Examinations
	6. Chemicals, Standards, and Quality Control Material
	a. Chemicals
	b. Reagent Preparation

	7. Standards Preparation
	a. Materials preparation
	b. Intermediate Stock Standards Preparation
	c. Iodine Intermediate Stock Standards Preparation:
	d. Intermediate Working Standards Preparation
	e. Working Standards (Calibrators)  The working calibrators are dilutions of the five intermediate working standards into a urine matrix (base urine) for the purpose of a matrix-matched external calibration of an analytical run (i.e. the run calibrators). �
	f. Range of Linearity (RLT) / Calibration Verification Intermediate Working Standards Partially fill three 100 mL glass volumetric flasks to a few centimeters below the meniscus with ≥18 M((cm water.  Add 1mL of the 200 g/L sulfamic acid preservative solut�
	g. Quality Control Material

	8. Instrument & Software for the ICP-DRC- MS
	a.   ICP-DRC-MS System
	b.   Other equipment
	c.   Supplies

	9. Calibration and Calibration-Verification Procedures
	10. Operating Procedures; Calculations; Interpretation of Results
	11. Final Review of the Data
	a. Abnormal Patient Results:
	a. Boundaries Requiring Confirmatory Measurement:
	(a) Results Lower than the First Lower Boundary (1LB):  Concentrations observed less than the “first lower boundary” (defined in the laboratory database as the “1LB”) should be confirmed by repeat analysis of a new sample preparation.  The concentration as˛
	(b) Results Greater than the First Upper Boundary (1UB):  Concentrations observed greater than the “first upper boundary” (defined in the laboratory database as the “1UB”) should be confirmed by repeat analysis of a new sample preparation.  The concentrati˛
	(c) Results Greater Than Highest Calibrator:  When a sample result is greater than the highest calibrator, the result should be confirmed in an analysis run which includes a standard or external reference material with equivalent (within 10%) or greater co˛
	(d) Results Greater Than Range of Linearity Tested (RLT):  Perform an extra dilution on any urine sample whose concentration is greater than the range of linearity tested / calibration verification sample analyzed along with it (Section 9.b).  See table in˛
	b. Inadequate Precision in Confirmation of a Measurement:  If a sample is reanalyzed to obtain a confirmation of an initially elevated result, the confirmation should be within 10% of the original result.
	c. Inadequate Precision Within One Measurement:  If the range of the three replicate readings (maximum replicate concentration value - minimum replicate concentration value) for a single sample analysis is greater than 30 ug/L for I or 1 ug/L for Hg (“>Lim˛
	d. Analyst Reporting of Abnormal Patient Results:  Concentrations observed for iodine less than the second lower boundary” (defined in the laboratory database as the 2LB) or greater than the “second upper boundary” (defined in the laboratory database as th˚

	b. Evaluating Bench QC Results:  See sections 16.b-c for how to apply division QC rules and take corrective actions if necessary.
	i. Submitting Final Work for Review Once results have been imported, reviewed, and set as final in the database by the analyst,
	a. Submit an email to the QC reviewer informing them of the readiness of the data for final review.  The email should include
	1. Instrument ID, run Date, run number, study ID, group ID.
	2. Any bench QC failures (include reasons if known).
	3. Any patient sample results less than the 2LB or greater than the 2UB should be reported in the email as either an abnormally low concentration (<2LB) or an “elevated result” (>2UB).
	4. Anything out of the ordinary about this analytical work which could have a bearing on the availability (i.e. insufficient sample to analyze), accuracy, or precision of the results.
	b. Include all items called for by the study folder cover sheet in the study folder (i.e. printouts from the ICP-MS, bench QC evaluation) together in the study folder before submitting the folder for review when analysis is complete.


	12. Replacement and Periodic Maintenance of Key Components
	13. Limit of Detection
	14. Reportable Range of Results
	15. Special Procedure Notes – CDC Modifications
	16. Quality Control Procedures
	a. Establish QC limits for each QC pool.
	b. Evaluating the Quality Control of a Run.  After completing a run, and importing the results into the database, export the QC results to the SAS program where the run will be judged to be in or out of control.  The QC limits are based on the average and  
	c. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable Criteria
	(1) If the division SAS program declares the run out of control” for any analyte, ONLY the analytes which were “out of control” are invalid for reporting from the run.  Set all run results for those 1 or 2 analytes as “QC Rejected” in the database.  Evalua!
	(2) Check the calibration curve(s) for linearity and for an intercept near zero.  Calibration points not falling closely to the regression line may indicate a calibrator which was improperly prepared, analyzed, or needs to be made new.  Be sure to use fres!
	(3) Check for high blanks which lead to over-subtraction from analysis results.
	(4) Check the ICP-DRC-MS stability during the run by examining the degree of variability and drift in internal standard raw peak areas over the course of the run. Irreproducibility that exceeds 15% and drift >20%, or sudden large changes in internal standa!
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